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 Notice to Reader
 f It is prohibited to copy a part or all of this product without prior permission.
 f The contents or specifications of this product may be changed without prior notice.
 f We have prepared the contents of this product to the best of our ability; however if you have any questions about the contents, or if there 
are any errors or missing items, please contact Grass Valley.

 f However we do not take any responsibility for malfunctions arising from use, irrespective of the points outlined in the preceding 
paragraph.

 f Irrespective of whether it was due to a usage error, Grass Valley takes no responsibility for extraordinary, incidental or derivative claims, 
including those for lost earnings generated by the application of this product.

 f It is prohibited to analyze, reverse engineer, decompile, or disassemble any of the items included with this product, including the software, 
hardware, and manuals.

 f Grass Valley, GV STRATUS, K2, Aurora, Summit, EDIUS, and EDIUS MYNC are either registered trademarks or trademarks of Grass 
Valley USA, LLC in the United States and/or other countries.

 f Microsoft, Windows, and Internet Explorer are trademarks or registered trademarks of Microsoft Corporation in the United States and 
other countries.

 f Intel, Xeon, and Core Duo are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other 
countries.

 f QuickTime and QuickTime logo are trademarks used under licenses. QuickTime is a trademark registered in the United States and other 
countries.

 f Final Cut Pro, Macintosh, and ProRes are trademarks of Apple Inc., registered in the U.S. and other countries.
 f Adobe, Adobe logo, Adobe Reader, Photoshop, Adobe PDF and Adobe PDF logo, After Effects, Flash and Flash logo, and Adobe Flash 
Player are trademarks of Adobe Systems Incorporated.

 f Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of Dolby Laboratories. Unpublished 
work. Copyright 2003-2012 Dolby Laboratories, Inc. and Dolby Laboratories Licensing Corporation. All right reserved.

 f HDV is a trademark of Sony Corporation and JVC KENWOOD Corporation.
 f XDCAM, XDCAM EX, XAVC, XAVC S, and SxS are trademarks of Sony Corporation.
 f The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Logo are trademarks or registered trademarks of HDMI 
Licensing Administrator, Inc. in the United States and other countries.

 f P2, AVCCAM, AVC-Intra, and AVC-Ultra are trademarks of Panasonic Corporation.
 f AVCHD is a trademark of Panasonic Corporation and Sony Corporation.
 f EOS is a trademark of Canon Inc.
 f Blu-ray is a trademark of Blu-ray Disc Association.
 f SD card is a trademark of SD Association.
 f Google Chrome, YouTube, and YouTube logo are trademarks or registered trademarks of Google Inc.
 f Vimeo is a trademark or registered trademark of Vimeo, LLC.
 f The trademark, service mark, product name logo, and product name of RED are trademarks or registered trademarks of Red.com, Inc. in 
the United States and other countries.

 f Avid, Pro Tools, Media Composer, Avid DNxHD, and Avid DNxHR are trademarks or registered trademarks of Avid Technology, Inc. or its 
subsidiaries in the United States.

 f AMD is a trademark of Advanced Micro Devices, Inc.
 f Firefox is a trademark or registered trademark of Mozilla Foundation in the U.S. and other countries.
 f GoPro is a trademark or registered trademark of GoPro, Inc. in the U.S. and other countries.
 f Other product names or related brand names are trademarks or registered trademarks of their respective companies.
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 Manual Explanation
 f If there are any variations between the explanation in this manual and the actual application method, priority is given to the actual 
application method.

 f The images and illustrations used in this manual are prototypes and they may be different from the screens of the actual product.
 f This manual is written for people who have a basic knowledge of how to use a computer. If there are no special instructions, perform the 
same operation as a normal computer operation.

 f The procedures in this manual are described based on an assumption that the OS of the computer in use is Windows 10.
 f In this manual, EDIUS Workgroup, EDIUS Pro, and EDIUS series are called “EDIUS”.
 f In this manual, Microsoft® Windows® operating system products are called as follows.

 g Microsoft®Windows® 7 operating system: Windows 7 (collective term for Ultimate, Enterprise, Professional, Home Premium, and Home 
Basic)

 g Microsoft® Windows® 8.1 operating system: Windows 8.1 (collective term for Enterprise, Pro, and Core Edition)
 g Microsoft® Windows® 10 operating system: Windows 10 (collective term for Enterprise, Education, Pro, and Home)

 f The signs and definitions in this manual are as follows.

Signs Definitions
2 This sign indicates the important point of the operation.

1 Alternative This sign indicates an alternative method for the same operation that differs from the one in the 
procedure.

3 Note This sign indicates cautions and restrictions on the operation.

 DANGER

Health Precautions
In rare cases, flashing lights or stimulation from the bright light of a computer display or TV monitor may trigger temporary epileptic seizures 
or loss of consciousness. It is believed that even individuals whom have never experienced such symptoms may be susceptible. If you or 
close relatives have experienced any of these symptoms, consult a doctor before using this product.
If you edit 3D video more than an hour continuously, take a rest of 10 to 15 minutes per hour. If you feel tired or uncomfortable, stop using 
the product.

Copyright
Do not use captured image/sound data created by other ones without authorization of the right holder regardless of whether it is moving or 
still image, except for personal fun. Also, duplication of such data is sometimes limited even for personal hobby. Please notice that we are 
exempted from responsibility for the use of captured data.

Copyright Copyright © 2020 Grass Valley. All rights reserved. Portions of software © 2000 - 2020, 
Microsoft Corporation. All rights reserved. This document may not be copied in whole or 
in part, or otherwise reproduced except as specifically permitted under U.S. copyright law, 
without the prior written consent of Grass Valley USA, LLC, P.O. Box 59900, Nevada City, 
California 95959-7900. This product may be covered by one or more U.S. and foreign patents.
Grass Valley is a trademark of GVBB Holdings S.a.r.l.

Disclaimer Product options and specifications subject to change without notice. The information in this 
manual is furnished for informational use only, is subject to change without notice, and should 
not be construed as a commitment by Grass Valley USA, LLC. Grass Valley assumes no 
responsibility or liability for any errors or inaccuracies that may appear in this publication.

U.S. Government Restricted Rights 
Legend

Use, duplication, or disclosure by the United States Government is subject to restrictions as set 
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause 
at DFARS 252.277-7013 or in subparagraph c(1) and (2) of the Commercial Computer Software 
Restricted Rights clause at FAR 52.227-19, as applicable.

Trademarks and Logos Grass Valley is a trademark of GVBB Holdings S.a.r.l. Grass Valley USA, LLC products are 
covered by U.S. and foreign patents, issued and pending. Additional information regarding 
Grass Valley USA, LLC trademarks and other proprietary rights may be found at the following 
URL.
http://www.grassvalley.com/

Grass Valley Web Site This public Web site contains all the latest manuals and documentation, and additional support 
information. Use the following URL.
http://www.grassvalley.com/
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Chapter 1
EDIUS
This chapter explains the outline of EDIUS and function and screen structure of each product.
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EDIUS

EDIUS X Pro
EDIUS X Pro is nonlinear video editing software that provides high-speed real time editing and smooth operability and enables handling of 
data in various camera formats by their native data. Even the newest formats supporting 4K, 60p/50p, and 10-bit such as XAVC or AVC-
Ultra can be handled in the native formats without conversion, and you can make use of them for wide range of usage such as broadcasting, 
movies, commercial films, documentaries, promotion videos, and personal production. This software provides wide variety of functions 
required for high quality video editing, such as multi-format mixed editing, multicam editing, proxy editing, composition, effects, titles, source 
management, and Blu-ray/DVD authoring, to enable video finishing that realizes free expression of the editors’ creativity.
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Operating Environment/Specifications
To use EDIUS, the following environment and specifications are required.

Operating Environment

OS
 f Windows 10 64-bit (Version 1903 or later)

2
 f Not available on Windows 8.1 and Windows 7.
 f See “Memory” for physical memory limits of each OS. 
“Memory” (w page 25)

CPU
 f 4th or later generation Intel CPU that supports AVX2 or equivalent AMD CPU

Memory
 f 4 GB or more (For 4K editing, 32 GB or more is recommended)
The minimum system requirement of PC memory capacity differs depending on the project.

Project format PC memory capacity Video memory capacity
Resolution Video quantization 

bitrate
Minimum Recommended Minimum Recommended

SD 8-bit 4 GB 8 GB 256 MB 512 MB
10-bit 4 GB 8 GB 512 MB 1 GB

HD 8-bit 8 GB 16 GB 512 MB 1 GB
10-bit 8 GB 16 GB 1 GB 2 GB

4K or higher 8-bit 16 GB 32 GB or more 2 GB 2 GB or more
10-bit 16 GB 32 GB or more 2 GB 2 GB or more

3 Note
 f The maximum amount of PC memory that can be equipped differs depending on the OS.

 g Windows 10 Enterprise/Windows 10 Education/Windows 10 Pro, 64-bit: 512 GB
 g Windows 10 Home, 64-bit: 128 GB

Other Specifications

Graphics
 f GPU compatible with Direct3D 9.0c and later, and PixelShader Model 3.0 and later

2
 f For 4K editing, 2 GB or more video memory is required.
 f See “Memory” for minimum and recommended system requirements of video memory for each project.
“Memory” (w page 25)

Hard Disk
 f To install EDIUS, 6 GB or more hard disk space is required for installation.
 f An SSD drive or a drive with at least SATA/7200 rpm is required for video editing.



Chapter 1   EDIUS — Operating Environment/Specifications

26

2
 f RAID-0 is recommended.

Optical Drive
 f To create Blu-ray or DVD discs, compatible drives are required.

Sound Card
 f A sound device that is compliant with WDM is required.

Display
 f HiDPI display is supported.

Internet Environment
 f Internet environment is required for installation, update, license authorization, user registration, and support.

2
 f EDIUS requires constant Internet connection for license authorization.

Support
 f For details on support, see “Grass Valley Product Support”.
“Grass Valley Product Support” (w page 494)

3 Note
 f Operation is not guaranteed for all environment that meet the operating environment and specifications described in this section.
 f Visit our website for the latest operating environment/specifications.
“Our Website” (w page 494)
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Comparison Table for Functions of Each EDIUS 
X Product
l: Supported
―: Not supported
Optional: Can be supported by using options.

 r Input

Function EDIUS X Workgroup EDIUS X Pro
Import from ordinary cameras, including video cameras and 
digital single-lens cameras

l l

Import from cameras that support 4K and 2.5K l l

Import of professional camera formats (MXF) l l

Cinema RAW source browser and decoding supported l l

Cinema RAW Light source browser and decoding supported l l

Sony RAW/Sony X-OCN source browser and decoding 
supported

l l

H.265/HEVC decoding l l

H.265/HEVC high-speed decoding l l

Canon XF-HEVC (H.265) decoding l l

Import from 3D (stereoscopic) cameras l l

Import of still images, including photographs and illustrations l l

Import of consecutive still image files l l

Import of audio materials l l

Import of Final Cut Pro XML l l

Capture l l

Source browser l l

Avid DNxHD codec supported l Optional
Import of Dolby Digital Professional and Dolby Digital Plus 
formats

Optional ―

 r Settings

Function EDIUS X Workgroup EDIUS X Pro
8K supported l ―
4K, 10-bit supported l l

High-definition supported l l

1080/60p supported l l

Color space selection using project settings l l

Editing function for color space list l l

Selection of rendering format during editing work l l

TC preset l l

User profiles l l

FTP uploading and downloading l ―
Timecode display for 60p/50p l l

 r Editing

Function EDIUS X Workgroup EDIUS X Pro
HDR editing l l

Real-time mixed editing of multiple formats l l

Intel Quick Sync Video hardware decoding l l

Refined user interface l l

Multicam editing l l

Stereoscopic (3D) editing l l

Various editing modes l l
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Function EDIUS X Workgroup EDIUS X Pro
Proxy editing l l

Preroll editing l l

Title Insertion Mode l ―
Editing while recording capture l ―
Multiple sequences in projects l l

Nested sequences l l

Draft previews l l

Playback image quality settings for RED files l l

Full-screen previews l l

Preview window rotation l l

Zebra preview l l

Monitor control l ―
Time remapping l l

High-quality slow-motion l l

High-quality slow-motion advanced matching mode l l

Vector scopes and waveforms l l

Videoscopes l l

Primary color correction l l

Marker function l l

Closed Caption view  (CEA-708/CEA-608) l l

 r Audio

Function EDIUS X Workgroup EDIUS X Pro
Audio monitoring mode l ―
Loudness meter l ―
Audio mixer l l

Audio channel mapping l l

Audio bitstream pass-through l ―
Normalization l l

Audio waveform (speech waveform display) generation l l

Voiceovers l l

 r Effects

Function EDIUS X Workgroup EDIUS X Pro
Video filters l l

Transitions l l

Audio effects l l

Quick Titler l l

Alpha channels l l

Mask filters l l

Track matte keyer l l

Combined filters l l

VST plug-in bridge l l

GPUfx l l

Chromakey and luminancekey l l

Compositing (addition, multiplication, etc.) l l

Shake stabilizer (blur correction) l l

Gaussian blurring l l

Effect customization l l
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 r Output

Function EDIUS X Workgroup EDIUS X Pro
Output in Windows Media, QuickTime and other common 
formats

l l

Output in Dolby Digital Professional and Dolby Digital Plus 
formats

Optional ―

High-speed, high-resolution output of XAVC formats including 
4K

l l

XAVC/MP4 clip exporting with HDR metadata l l

Generic MXF file exporting l ―
Blu-ray/DVD output (authoring) l l

High-speed encoding of Blu-ray/H.264 using Intel Quick Sync 
Video

l l

High-speed encoding of H.265/HEVC (MP4) using Intel Quick 
Sync Video

l l

Output l l

Batch exporting l l

Tape output l l

Video-out conversion l ―

 r Other features

Function EDIUS X Workgroup EDIUS X Pro
Mync (contents management application) l l

Quick start up l l

EDIUS OFX Bridge l l

Titler Pro 5 for EDIUS 9 l l

eID l*1 l

Simultaneous installation of EDIUS X and EDIUS 9 l l

Offline editing l ―
Support for third-party plug-in l l

64-bit native OS support l l

Automatic update notification function ― l

GV STRATUS Optional ―
EDIUS XRE Optional ―
K2 connection (SAN) Optional ―
K2 connection (FTP) Optional ―

*1 Registration of eID is optional.

 r Supported devices

Function EDIUS X Workgroup EDIUS X Pro
STORM 3G l l

STORM Pro l l

Third-party I/O hardware support l l

2
 f For the supported hardware, visit our website.
“Our Website” (w page 494)

 f For the supported plug-in, visit our website.
“Our Website” (w page 494)
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Grass Valley HQX Codec
With EDIUS, you can import 4K and 60p videos in their native formats and edit them by frame units. However, editing operations of such 
large video data put heavy load on the PC, which may prevent not only smooth editing operations but even normal playback operations, 
depending on the PC specifications. In such cases, convert the data into an intermediate codec to be suitable for editing and to improve 
work efficiency.
Grass Valley HQX Codec is an intermediate codec that enables the maximum editing performance of EDIUS. It supports 8K/60p/10-bit 
at the maximum, and any source can be converted into this codec with the master format retained. Since this codec can be used on both 
Windows and Macintosh, and supports alpha, it can be utilized for flexible editing in color grading and composition.
The potentiality of the Grass Valley HQX Codec is not limited to editing operations, but it can intermediate between any workflow.

 r Supported Format

Frame size 24x24 to 8192x4320 (pixels)
Frame rate 60 fps maximum
Depth 8-bit/10-bit
Alpha channel Supported
Wrapper QuickTime/AVI/MXF
OS Windows/Macintosh

While conversion into intermediate codec generally deteriorates the video image quality and is avoided in many cases where quality is 
important, the Grass Valley HQX Codec can reduce the deterioration to the minimum level and keeps good quality of the master image. Due 
to its 4:2:2 color space, VBR that maintains the balance of the quality for the data size even after the compression rate has been changed 
to fit the flame images, and its durability for deterioration even after repetitive conversion, it maintains the quality that is high enough for live 
events and broadcasting.

 r Specifications

Color space 4:2:2
Bitrate VBR (7680 MB/s maximum)
Frame compression Intra-frame compression

3 Note
 f Since the Grass Valley HQX Codec uses VBR where the bitrates varies according to the image and thus the data size may increase 
depending on the video to be converted, use hard disk drive that is high-speed and with large disk space to a maximum possible.
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Screen Configuration
This section explains the overall EDIUS screen configuration as well as each window and palette.

EDIUS Screen Configuration
Various windows are displayed when using EDIUS, and basically you use 7 windows for editing video. You can easily edit video in dual 
monitor, as each window can be placed without overlapping with each other.
Each window can be resized by dragging its side line or the corner edge. As the windows snap to each other, you can place windows 
aligned by side line or corner edge. The window layout can also be saved.

Layout in Dual Monitor
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100%
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(1)
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(1) Preview window This window is used to check video. Player appears on the left, and Recorder on the right.
(2) Bin window/source 

browser window
Bin window and source browser window can be switched by clicking the tabs.
Bin window
This window is used to manage clips imported to EDIUS.
Source browser window
This window is used to check source files in external devices such as AVCHD video cameras 
or professional-use video cameras to which file-based video or audio are recorded.

(3) Timeline window This window is used to place the clips on the track or apply effects.
(4) Palette window There are 3 types of palettes: [Information] palette, [Effect] palette, and [Marker] palette.
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Layout in Single Monitor
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(1)
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(1) Preview window
(2) Bin window/[Effect] palette/[Marker] palette/source browser window
(3) Timeline window
(4) [Information] palette

2
 f When multiple windows are placed in alignment, all the snapped windows can be resized at one time by resizing one of them. Resize 
operation with [Shift] on the keyboard held down resizes only the selected window. However, this function may be unable depending on 
the setting of Windows.

Preview Window
You can switch the preview window between the single mode and dual mode.
Click [View] on the menu bar, and click [Single Mode] or [Dual Mode] to switch the preview window display between single mode and dual 
mode.
“Menu Bar” (w page 33)

3 Note
 f Even if a video card that supports 8K format is installed, the preview cannot show images of the video being edited in 8K with the 
resolution of the native file maintained.

Dual Mode
Player appears on the left, and Recorder on the right in the dual mode.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00 Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00

(1) (2)
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(1) Player This window is used to check clips. You can view clips in the bin window and sources being 
captured, and set In and Out points on this window.

(2) Recorder This window is used to check the timeline. You can view video on which effects are applied and 
composite video in real time.

Single Mode
Display either one of the Player or Recorder on the preview window and use them by switching the display.

Out -- : -- : -- ; --In -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00Cur 00:00:00;00

(1) (2)

(1) [Change to Player] Display the Player.
(2) [Change to Recorder] Display the Recorder.

1 Alternative
 f Switching to the Player/Recorder: [Tab]

Menu Bar
You can execute most of the operations from the menu bar. Click and select an item.

(1) [File] Use it to create or save projects, manage projects or clips, output edited video, and exit EDIUS.
(2) [Edit] Use it to add cut points, delete clips, and execute editing functions such as undoing, redoing, 

etc.
(3) [View] Use it for display settings such as show/hide of windows, palettes, and functions, managing 

window layouts, switching dual/single modes, and full screen previewing.
(4) [Clip] Use it for clip operations such as creating new clips, linking or hiding clips, starting up layouter, 

configuring [Time Effect] settings, etc.
(5) [Marker] Use it for settings of markers such as adding/deleting markers or importing/exporting marker 

lists.
(6) [Mode] Use it to set editing mode such as trim mode and multicam mode.
(7) [Capture] Use it to start up the [Capture] dialog box or [Voice Over] dialog box, to select devices, etc.
(8) [Render] Use it to render the clip being edited in various methods.
(9) [Tools] Use it to start up tools such as Disc Burner, Mync, GV Job Monitor, etc.
(10) [Settings] Use it to open setting menus such as [System Settings] where you can set project presets 

and hardware device presets, [On Screen Display] where you can set timecode display, [User 
Settings] where you can set [Keyboard Shortcut], etc.

(11) [Help] Use it to display online FAQ or perform user registration.

2
 f Click [Help] on the menu bar, and click [User Registration] to perform user registration after installation.
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 f Click [Help] on the menu bar, and click [Serial number registration] to register the serial number. After registering the serial number, 
restart EDIUS to enable the functions.

 f Perform the following to display the online manual:
 g Click [Help] on the menu bar, and click [Help].
 g Online manual display: [F1] 

 f Click [Help] on the menu bar, and click [Version Info] to refer to the version information.

Player
This window is used to play back or edit a source clip.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00

(1) (2) (3) (4) (5) (6) (7) (8) (9) (10) (11) (12) (13) (14) (15)

(1) Timecode area Display the playback position, In point, Out point, duration and the total length of the source 
data.
If the setting is defined incorrectly, such as the setting that Out point is set before In point, the 
timecode turns red.
The value can be changed by clicking the timecode.
Copy and paste are also available by right-clicking the timecode.

(2) [Input Preset 1] - [Input 
Preset 8]

If a device preset is assigned as an input preset, you can display the device preset simply by 
clicking.

(3) [Set In Point] Set the In (start) point of the source.
[I]

(4) [Set Out Point] Set the Out (end) point of the source.
[O]

(5) [Stop] Stop playback.
[K], [Shift] + [↓]

(6) [Review] Fast rewind playback.
Each click switches the playback speed in the reverse direction between 4 times and 12 times.
[J]

(7) [Previous Frame] Each click rewinds one frame at a time in the reverse direction. Keeping this button clicked 
plays back the source at the normal speed in the reverse direction.
In the case of deck operation, frame reverse is performed.
[←]

(8) [Play] Play back the source in the forward direction. Clicking this during playback pauses playback. 
Clicking it again resumes playback.
[Enter], [Space]

(9) [Next Frame] Each click forwards one frame at a time in the forward direction. Keeping this button clicked 
plays back the source at the normal speed in the forward direction.
In the case of deck operation, frame advance is performed.
[→]

(10) [Fast Forward] Fast forward playback.
Each click switches the playback speed in the forward  direction between 4 times and 12 times.
[L]
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(11) [Loop] Repeatedly play back between In and Out points.
[Ctrl] + [Space]

(12) [Insert to Timeline] Insert and place a clip at the position of the timeline cursor.
[[]
“Insert/Overwrite Mode” (w page 225)

(13) [Overwrite to Timeline] Overwrite and place a clip at the position of the timeline cursor.
[]]
“Insert/Overwrite Mode” (w page 225)

(14) [Add Clip on Player to 
Bin]

Register the clip displayed on the Player to the bin.
[Shift] + [Ctrl] + [B]

(15) [Add Subclip to Bin] Copy the range between In and Out points set on a clip as a subclip and register it to the bin.
A subclip refers to the same source as that of the original clip (master clip).

Recorder
This window is used to play back the timeline or edit a clip.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00

(1) (2) (3) (4) (5) (6) (7) (8) (9) (10) (11) (12) (13) (14)

(1) Timecode area Display the current playback position, In point, Out point, duration, and the total length of the 
source data in timecode.
If the setting is defined incorrectly, such as the setting that Out point is set before In point, the 
timecode turns red.
The value can be changed by clicking the timecode.
Copy and paste are also available by right-clicking the timecode.

(2) [Set In] Set the In point to any position on the timeline.
[I]

(3) [Set Out] Set the Out point to any position on the timeline.
[O]

(4) [Stop] Stop playing back the timeline.
[K], [Shift] + [↓]

(5) [Review] Rewind the timeline. Each click switches the playback speed in the reverse direction between 4 
times and 12 times.
[J]

(6) [Previous Frame] Each click rewinds the timeline one frame at a time in the reverse direction. Keeping this button 
clicked plays back the source at the normal speed in the reverse direction.
[←]

(7) [Play] Play back the timeline in the forward direction. Clicking this during playback pauses playback. 
Clicking it again resumes playback.
[Enter], [Space]

(8) [Next Frame] Each click advances the timeline one frame at a time in the forward direction. Keeping this 
button clicked plays back the source at the normal speed in the forward direction.
[→]
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(9) [Fast Forward] Fast forward the timeline. Each click switches the playback speed in the forward direction 
between 4 times and 12 times.
[L]

(10) [Loop] Repeat playback between In and Out points of the timeline. Loop playback of the entire timeline 
can also be performed.
[Ctrl] + [Space]

(11) [Previous Edit Point] Move the timeline cursor to the edit point (e.g. the border of clip, In and Out points of the 
timeline) at the left side of the timeline cursor position.
[A], [Ctrl] + [←]

(12) [Next Edit Point] Move the timeline cursor to the edit point at the right side of the timeline cursor position.
[S], [Ctrl] + [→]

(13) [Play the Current Area] Play back the area before and after the timeline cursor.
(14) [Export] Display output (export) related menus.

Timeline Window
This window is used to place the clips on the track or apply effects.
Clips are placed from left to right of the timeline in time series.

Untitled

00:00:00;00
XXXXX

XXXXX
00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00 00:00:30;00

3V

1T

1A

1VA

2VA

2A

3A

4A

V
A

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX

XXXX

XXXX

(1) (2) (3) (4)

(5)

(6)

(7)

(8)

(9)

(11)

(10)

(12)

(1) Mode bar These buttons are used to switch the editing modes. The button types and sort order can be 
customized.
“Switching the Editing Mode” (w page 225)
“Operation Button Settings” (w page 147)

(2) Sequence tab Tab for using clips on the timeline as a set 
(3) Operation buttons These buttons are used for editing operations. The button types and sort order can be 

customized.
“Operation Button Settings” (w page 147)

(4) Time scale Indicate the scale for the time on the timeline.
(5) Time scale settings Change the display unit for time scale.

“Time Scale Settings” (w page 222)
(6) Track header Configure various settings including muting and locking each track, mapping channels, 

synchronizing channels. It can be used to add and delete tracks.
“Track Header” (w page 217)

(7) Timeline Place clips in this area. It can also be used to add and delete tracks.
“Placing Clips” (w page 230)
“Track Operations” (w page 220)

(8) Status bar Display the number of imported files when a project is opened/number of all files, the number 
of offline clips, clip playback status, editing mode, and background job status, etc. Move the 
cursor over the mode bar or timeline operation buttons to display the button names on lower 
left.
Double-click the GV Job Monitor icon to start GV Job Monitor. The icon color turns to purple 
while a file is being exported or a batch export rendering job is being processed.
“GV Job Monitor Icon Indication” (w page 332)

(9) Timeline cursor Indicate the playback position or edit position of the timeline.
(10) Video part Indicate the presence of video in the clip.
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(11) Audio part Indicate the presence of audio in the clip. Expand it to display a rubber band to adjust the 
volume or pan.
“Adjusting the Volume and Pan of a Clip” (w page 414)

(12) Mixer area Configure keying and other settings.

Time Scale Settings/Track Header
Time scale settings and track settings of timeline are performed in this area.

2 V

1 T

1 A

2 A

3 A

4 A

V
A XXXXXX

A3
4

A5
6

A7
8

1 VA
V

A1
2(1)

(2) (3)

(4)

(5)
(6)
(7)
(8)

(11)

(12)

(9)
(10)

(1) Track patch When a clip is displayed on the Player or a clip is selected in the bin, the channels that the clip 
has (source channels) are displayed on the track patch.
“Connecting/Disconnecting the Source Channel” (w page 230)

(2) Time scale slider Change the display unit by dragging the slider. Move the slider to the left to reduce the display 
unit, or to the right to increase it.

(3) Time scale settings Change the display unit for time scale. Click the center area to toggle the specified display unit 
and [Fit].
 f Setting [Fit] adjusts the display unit automatically and displays all the clips on the timeline.

(4) Batch lock panel Click this to set sync-lock for all tracks on/off.
“Sync-lock (Synchronization)” (w page 225)

(5) Audio expand button Click this button to display the rubber band for the audio.
[Alt] + [S]
“Adjusting the Volume and Pan of a Clip” (w page 414)

(6) [Video Mute] When mute is set, the video part of the track is not played back. The video part and mixer area 
of the clip on a muted track is displayed in gray.
[Shift] + [W]

(7) [Audio Mute] When mute is set, the audio part of that track is muted. The audio part and volume/pan part of 
the clip on a muted track is displayed in gray.
[Shift] + [S]

(8) [Volume/Pan] Switch between the volume adjustment mode and the pan adjustment mode.
“Adjusting the Volume and Pan of a Clip” (w page 414)

(9) [Mixer] Switch the transparency adjustment mode on/off.
“Transparency” (w page 370)

(10) Mixer expand button Click this button to display the rubber band for the transparency.
“Transparency” (w page 370)

(11) Track panel Click this to switch the select/deselect setting for the track.
(12) Lock panel Click this to set sync-lock on/off for a specified track.

“Sync-lock (Synchronization)” (w page 225)
Right-click on the lock panel, and click [Track Lock] to lock the track.

Track Type
For details on adding, deleting, or moving tracks, see “Tracks”.
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“Tracks” (w page 217)

Untitled

2 V

1 T

2 T

1 A

1 VA

2 A

3 A

4 A

V
A XXXXXX

(1)

(2)

(3)

(4)

(1) V track Place video, still image, or title clips on this image-only track. If a video clip with audio is 
placed, the audio part will be cut.

(2) VA track Video and audio are kept together on this track. Place video, audio, still image, and title clips.
(3) T track This track is for title clips. Place video, still image, and title clips. Create and place a title clip on 

this track to overlay the title on the video.
“Title” (w page 387)

(4) A track Place audio clips on this audio-only track. If a video clip with audio is placed, the video part will 
be cut.
“Audio” (w page 413)

Bin Window
This window is used to manage clips imported with EDIUS.
You can switch the show/hide setting for the folder view. You can switch the display method such as thumbnail, detailed information, and 
other information for the clip view.
Management, display of the list, and search for captured clip are available.
Clip information (such as aspect ratio, frame rate, poster frame) can be checked or modified.
“Managing Clips” (w page 208)
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(1) Folder view Structurize folders and organize clips in this area. Folders can be created and structurized from 
the [root] folder, and the entire folder in which the sources are stored on a PC can be registered 
to the bin.
“Operations in the Folder View” (w page 211)

(2) Operation buttons Perform operations in the bin window such as registering or copying sources and creating 
clips.

(3) Clip view Display clips in the folder as a list.
“Operations in the Clip View” (w page 208)

(4) Metadata view Display the clip metadata in a list.
(5) Simple search bar Press [F3] on the keyboard to display this bar. Clips in this folder can be searched.

2
 f The upper and lower parts of the bin window are extended, by every double-click on a position of the title bar (without any button) in the 
bin window.

XXXX XXXX/XXXX (0/4) 100%

Source Browser Window
This window is used to check source files in external devices such as AVCHD video cameras or professional-use video cameras to which 
file-based video or audio are recorded.
You can switch the show/hide setting for the folder view. You can switch the display method such as thumbnail, detailed information, and 
other information for the clip view.
Display of the list, transfer to the bin, and search for the sources in external devices are available.

XXXX XXXXXX 100%

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX
XXXXXX

XX:

XXXXXX

XXX XXXXXX XXXXXX XXXXXX

(1) (2) (3) (4)

(5)

(1) Folder view Display devices and drives connected to the PC in a tree. When the media is inserted into the 
device or drive, the media name is displayed in the tree. Click the media name to display the 
stored files in the clip view. To browse the local disk, you can register the folder to display in the 
folder view through System Settings in advance.
“[Importer/Exporter]” (w page 104)

(2) Operation buttons Perform various operations. The button types and operations differ from device to device.
“Source Browser” (w page 174)

(3) Clip view Displays a list of source files in the external devices.
(4) Metadata view Display a list of source file metadata.
(5) Simple search bar Press [F3] on the keyboard to display this bar. Search source files in the external devices.



Chapter 1   EDIUS — Screen Configuration

40

2
 f The upper and lower parts of the source browser window are extended, by every double-click on a position of the title bar (without any 
button) in the source browser window.

XXXX XXXXXX 100%

Palette Window
There are 3 types of palettes: Information palette, Effect palette, and Marker palette.

[Information] Palette
You can view the information on clips placed on the timeline or adjust the applied effects.
 f Display the information of the clip placed on the timeline.
 f Display information on the set effects and set whether to apply effects or the order.
 f Adjust the set effects.
 f Configure the video layout if a clip has a video part.

“Showing/Hiding [Information] Palette” (w page 377)

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

2/2 1

XXXXXX

XXXXXX

(1)

(2)

(3)

(4)

(1) Information area Display information such as the file name, duration, and color space. The displayed contents 
differ depending on the object selected on the timeline.

(2) Effect list Display applied effects in a list. Also register the set effects as a preset.
“Registering Effects to [Effect] Palette” (w page 383)
 f For a clip with video part, [Layouter] is always displayed.

(3) [Open Setup Dialog] Display a settings dialog box to adjust each effect or the [Layouter] dialog box.
(4) [Delete] Delete the effect. [Layouter] items cannot be deleted.

[Effect] Palette
Effects are used to adjust the brightness and color of images, add special effects, and create composite videos.
 f Video or audio effects to add to clips are registered.
 f Register or delete customized effect.
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“Showing/Hiding [Effect] Palette” (w page 336)

XXXXXX

XXX XXXXXX XXXXXX XXXXXX

XXXX

XXXXXXX

XXXXXXX

XXXXXXX

XXXXXXX

XXXXXXX

XXXXXXX

XXXXXXX
XXXXXX XXXXXX

XXXXXX XXXXXX

XXXXXX XXXXXX

(2)

(1)

(1) Folder view Display the effect folder in tree structure.
(2) Effect view Display the contents of effects in the selected folder. If an effect with animation is selected, the 

animation is displayed.

[Marker] Palette
Manage the sequence markers appended to the timeline and clip markers appended to a clip. The [Sequence Marker] and [Clip Marker] lists 
can be switched by clicking the button.

XXXXXX

XXXX:2

XXX XXX In Out XXXXXX XXXXXX

 r [Sequence Marker] List
 f Set and delete a sequence marker.
 f Jump to a desired sequence marker or add comments.
 f Import or export a sequence marker list.

“Displaying the [Sequence Marker] List” (w page 285)

XXX XXXXXXXXXXXX

XXXX:2

XXX

002

In Out XXXXXX XXXXXX

00:00:14;24

001 00:00:09;08

XXXXXX

XXXXXX

XXX
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 r [Clip Marker] List
 f Set and delete a clip marker.
 f Jump to a desired clip marker or add comments.
 f Import or export a clip marker list.

“Displaying the [Clip Marker] List” (w page 279)

XXX XXXXXXXXXXXX XXXXXX

XXXX:3

XXX

002

In Out XXXXXX XXXXXX

00:00:05;01

001 00:00:00;20

003 00:00:08;13

XXX

2
 f Follow the step below to show/hide 3 palettes together.

 g Click [View] on the menu bar, and click [Palette] → [Show All] ([Hide All]).
 g Displaying all: [H]

 f You can combine 3 palettes into 1 palette. All palettes can be combined to the bin window or the source browser window.
“Combining Bin Window/Source Browser Window with a Palette” (w page 145)

 f Every double-click on the title bar of a palette expands and contracts the palette vertically.

XXXX XXXXXX
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Entry of Values

Entering Values Using Keyboard and Mouse
This section explains the setting operation for the values in each settings dialog box.

Direct Input of Value
You can directly enter values with [0] to [9] on the keyboard.

1) Select the input field and enter the value on the keyboard.
 f You can enter the value in the HHMMSSFF format (H = hour; M = minute; S = second; and F = frame). For example, enter “43S21F” or 
“4321” in only numerics for 43 seconds and 21 frames. Enter “10M” or “100000” for 10 minutes. If entering “3H2M1S0F”, the value will be 
“03:02:01:00”.

2) Press [Enter] on the keyboard.

Offset Input
You can enter variation values in the input field.

1) Select the input field and enter the variation value from the current set value.

2) Press [Enter] on the keyboard.
 f Enter “-” before the value to decrease the set value.
 f Enter “+” before the value to increase the set value.

2
 f Offset input is only available for entering the timecode.

Setting with Arrow Keys
You can enter values with keys on the keyboard.

1) Select the input field and change the value with arrow keys on the keyboard (↑, ↓, ←, →).

2) Press [Enter] on the keyboard.

Entering with Mouse Wheel
The set values can be changed with the mouse wheel. The mouse wheel is in the center of the mouse.

1) Move the mouse cursor near the input field.
 f The shape of the mouse cursor changes.

2) Click the value and rotate the mouse wheel.

1 Alternative
 f Hold the right button of the mouse in the settings input field, and drag the mouse upward to increase the value. The value continues to 
increase while the mouse is dragged. The value increases accordingly, when the mouse is moved away from the initial drag position.

 f In the same way, hold the right button of the mouse and drag downward to decrease the value.
 f Hold the left button of the mouse and drag upward to increase the value by the movement of the mouse. In the same way, drag downward 
to reduce the value. In this case, the value does not change unless you move the mouse.
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Chapter 2
Installation
This chapter explains installation/uninstallation of EDIUS, registration of eID, etc.
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Installation/Activation
3 Note

 f If you use EDIUS Workgroup or EDIUS Pro version 8 or later, Mync (Mync Standard) will be installed automatically at the installation of 
EDIUS.

 f To use a Grass Valley product such as EDIUS or Mync, the PC to which they are to be installed must be connected to the Internet. 
Note that you may not be able to operate them in an environment where Internet connection is not available.

 f Confirm that the PC to be used satisfies the conditions of the operating environment for the product.
“Operating Environment/Specifications” (w page 25)

 f This section explains how to install on Windows 10.

Before Installation
Activation of the serial number and eID is required at the startup of a Grass Valley product such as EDIUS or Mync. At the first startup after 
installation, the activation screens for the serial number and eID will be displayed. The software starts up after successful activation.

3 Note
 f Activation of eID is optional when you use EDIUS Workgroup.
 f Before starting installation, close all other applications including resident software.
 f Installation requires the account authorized for the administrator (such as PC administrator).
 f Applications to be installed and setup files necessary for installation may differ depending on model.
 f Make a backup of the customized settings such as keyboard shortcuts and then uninstall EDIUS before installing the latest version.
 f If antivirus software (security software) is running, you may need to stop the software operation.

Creating eID
Create eID.

 r What is eID?
eID is an online ID function to link the license of Grass Valley products in possession to the user. The license will be more secure and the 
uniqueness of the license will be established by linking the serial number and eID at the time of first activation of the serial number.
Also, the information of the serial number in possession can be browsed or products can be downloaded on the membership website “eID 
Web” that can be logged in with eID.
“eID Web” (w page 50)

3 Note
 f Use eID after fully understanding this manual and the precautions on the website.
 f Recommended environment of eID Web is as follows.

 g Browser: Internet Explorer, Mozilla Firefox, or Google Chrome

1) Go to the [Login] page in eID Web.
 f Access the following URL.
https://ediusid1.grassvalley.com/
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2) Click [eID registration].

XXXXXXXXXXXXXXX

XXXXXXXXXXXXXXX

XXXXXXXXXX

Login

Email address

Password

Login

eID registration

 f The [Enter e-mail address] screen appears.

3) Enter an e-mail address to register.
 f Be sure to read the privacy policy and check [I have read the privacy policy and agree to its terms and conditions.].

3 Note
 f Make sure to use an e-mail address and password to register different from the ones for other ID services. The e-mail address and 
password used in multiple services will have higher risk for unauthorized access.

 f The e-mail address that has been registered in the past cannot be used.

4) Click [Send].
 f When the screen indicating preliminary registration completion appears, close the window. Preliminary registration completion e-mail 
describing the procedure to permanently register is delivered to the registered e-mail address.

3 Note
 f The registered e-mail address and password are sensitive information that should never be disclosed to others. In case they have 
leaked, immediately change your e-mail address and password. We are not liable for the leakage of the e-mail address and password 
not related to this system.

 f Complete the permanent registration within the expiry date which is written in the preliminary registration completion e-mail. The 
information registered with preliminary registration is deleted if it is not completed within the expiry date.

5) Click the permanent registration URL described in the preliminary registration completion e-mail.
 f The [Registration] screen appears.

6) Enter registration information such as [Password], [Date of birth], and [Country/Region of 
residence].

7) Click [Confirm].
 f The [Confirm registration] screen appears.

8) Confirm the details to be registered, and click [Register].
 f The [Registration completed] screen appears. Registration of eID is completed.

Installing EDIUS
Install EDIUS.
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3 Note
 f It is necessary to agree to the End User License Agreement displayed during the installation to use this software. If you do not agree to 
the license agreement of this software, click [Close] to cancel the installation.

 f Be sure to read through terms and conditions by scrolling whole description.
 f Check [Automatically send diagnostic and usage data to Grass Valley] to automatically send the data for a diagnosis result and usage 
conditions of the software to be installed to Grass Valley.
The sent data is used for the purposes of improving the quality, reliability, and performance of the software.

 f When installation does not succeed, please check with the website of the manufacturer of the antivirus software (security software) in 
your system or our website for the latest updates.
“Our Website” (w page 494)

1) Uninstall the older version of EDIUS.
 f You can install EDIUS X to a PC on which EDIUS 9 has already been installed, which makes two versions of EDIUS available on the 
same PC.

 f Do not deactivate the license when uninstalling EDIUS. Restart your PC as necessary.

2) Double-click the setup file of EDIUS (exe format).
 f Follow the on-screen instructions for installation.

Activating EDIUS
Activation of the serial number and eID is required at the first startup of EDIUS. EDIUS cannot be started if the serial number or eID is not 
activated.

3 Note
 f Online environment is required for activation of the serial number or eID.

1) Double-click the EDIUS icon on the desktop.
 f The entry screen for the serial number is displayed only when EDIUS is started for the first time.

1 Alternative
 f If the EDIUS icon is not on the desktop, click the Windows logo at the lower left of the start screen to display the start menu, and then 
click [Grass Valley] → [EDIUS X].

2) Enter the serial number, and click [Register].

XXXXXXXXXXXXXXXXX

-

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX

XXXX

XXXXXXX XXXRegister

 f If the serial number is correctly activated, a confirmation screen appears.

2
 f Enter a 6-digit character string in the left field and a 16-digit character string in the right field for the serial number.
 f Please note that the serial number cannot be reissued. Keep the number securely.
 f The serial number can also be registered with the following procedure.

 g Click the Windows logo at the lower left of the start screen to display the start menu, click [Grass Valley] → [GV LicenseManager] to 
start up GV LicenseManager, and then click [Online activation].

3) Click [OK] on the confirmation screen.
 f The entry screen for eID appears.

3 Note
 f The screen to enter the serial number of the previous version of EDIUS may display during the installation of the upgrade version. If 
necessary, enter the serial number of EDIUS you have.
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4) Enter the registration information for eID, and then click [Login] .

XXXXXXXXXXXXXXXXX

XXXXXXXXXXXXXXXXX

XXX

E-mail

Password

Manage eID Login

eID

 f Once the eID is correctly activated, the serial number and eID will be linked, and EDIUS will be started.

2
 f For [E-mail] and [Password], enter the registration information for eID.
 f For details on eID, see “Creating eID”.
“Creating eID” (w page 45)

 f All the serial number information for the eID target products registered to the PC are linked to eID.
 f If your eID has not been registered, click [Manage eID] and then [Don't have an eID?], and register eID.
 f If you have forgotten your e-mail address or password, click [Manage eID] and then [Forgot your email address?]/[Forgot your 
password?], and reset them following the on-screen instructions.
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Uninstallation
3 Note

 f Close all other applications including resident software before uninstallation.
 f Uninstallation requires the account authorized for the administrator (such as PC administrator).
 f This section explains how to uninstall on Windows 10.
The operation may differ depending on the type or version of OS on your PC.

1) Click the Windows logo at the lower left of the start screen to display the start menu, and click 
[Settings].

2) Click [Apps].

3) Select [EDIUS X], click [Uninstall], and uninstall according to the on-screen instructions.

3 Note
 f Uninstalling EDIUS does not uninstall Mync that has come with EDIUS. To uninstall Mync, you must uninstall Mync separately.
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eID Web
Various membership functions such as confirmation of serial number and acquiring of trial version can be used by logging in to eID Web.

[Login]

1) Go to the [Login] page in eID Web.
 f Access the following URL.
https://ediusid1.grassvalley.com/

2) Enter [Email address] and [Password], and click[Login].
 f [My page top] is displayed after successful login, allowing to use the various membership website functions.
 f Selecting an item on the sidebar on the left of the screen displays the respective menu.
“[News]” (w page 50)
“[Licence List]” (w page 50)
“[EDIUS]” (w page 51)
“[Mync]” (w page 51)
“[My account]” (w page 51)

2
 f For [Email address] and [Password], enter the registered information for eID.
 f If you have forgotten the e-mail address or the password, click [Forgot your email address?] or [Forgot your password?] and reset them 
following the on-screen instructions.

[News]
The latest information on the Grass Valley product will be displayed.

[Licence List]
In [Licence List], the serial number information on the Grass Valley product linked to eID can be confirmed.

[Product name - 
Version]

Displays the product name and version information.

[Serial number] Displays the serial number.
[Initial activation date] Displays the date the activation is first performed.
[Expiration] Displays the validity date.
[Download] Clicking the icon downloads the trial version of EDIUS or the trial version of Mync Standard that has been 

acquired from the eID Web. (As of September 2020)
[Note] This is a free entry field. Enter text and click [Save] to save the entered content.

2
 f The product linked to eID are as follows.

 g Mync (Mync Basic, Mync Standard)
 g EDIUS X (EDIUS X Workgroup, EDIUS X Pro)
 g EDIUS 9 (EDIUS Workgroup 9, EDIUS Pro 9)
 g EDIUS 8 (EDIUS Workgroup 8, EDIUS Pro 8)
 g EDIUS 7 (EDIUS Elite 7, EDIUS Pro 7)
 g EDIUS 6.5 (EDIUS Elite, EDIUS Pro 6.5)
 g EDIUS Neo 3.5
 g EDIUS Express
 g Optional licenses for above generations

 f The trial version products of Grass Valley are also be linked to eID.

3 Note
 f Information of each product and the linked serial numbers are locked as a unique license.
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[EDIUS]
The trial version of EDIUS can be acquired.
Click the list button and select a desired product, and then click [Send]. A guidance e-mail describing the information such as the URL for 
download and serial number is delivered to the registered e-mail address.

3 Note
 f The trial versions of EDIUS can be downloaded only once per one product.

[Mync]
The trial version of Mync Standard can be acquired. (As of September 2020)
Click the list button and select a desired product, and then click [Send]. A guidance e-mail describing the information such as the URL for 
download and serial number is delivered to the registered e-mail address.

3 Note
 f The trial versions of Mync Standard can be downloaded only once per one product.

[My account]
Various information registered in eID can be viewed and edited.

 r Editing registration information of eID

1) On the [My account] screen, click [Edit information].

2) Change the registration information, and click [Change].
 f The password entry screen appears.

3) Enter the current password, and then click [Change].
 f Registration change is completed. An e-mail for confirmation of change in the registration information will be delivered to the registered 
e-mail address.

3 Note
 f When the registration information is changed, reactivation of eID may be necessary at the start up of EDIUS.

[Log out] 

1) Click [Log out] at the top of the screen.
 f It will logout from eID Web.

User Registration
You can register a user after installation. Your system is required to connect to the network for user registrations.

User Registration

1) Start up EDIUS.

2) Click [Help] on the menu bar, and click [User Registration].
 f Web browser starts up and a user registration page appears. Register a user according to the on-screen instructions.
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Chapter 3
Startup/Project
This chapter explains the start up method of EDIUS and creation of project.
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Startup
This section explains how to start up EDIUS and how to operate it at initial start-up.

How to Start up
The following explains how to start up EDIUS.

1) Double-click the EDIUS icon on the desktop.
 f The [Start Project] dialog box appears.
“[Start Project] Dialog Box” (w page 53)

1 Alternative
 f For Windows 10, click the Windows logo at the lower left of the start screen to display the start menu, and click [Grass Valley] → [EDIUS 
X].

2
 f A dialog box to notify the latest updater may appear at the startup of EDIUS.
“[Update Notification] Dialog Box” (w page 104)

[Start Project] Dialog Box

Profile list Manage the window layouts, user settings, etc., by profile to be used by switching.
“Editing Environment Management” (w page 125)

[New Project] When you start EDIUS for the first time, click this button to start up the [Create Project Presets] 
wizard. After you create a new project preset, a new project file can be created.
“Creating New Project Presets at Initial Start-up” (w page 56)
When project presets have been registered, clicking this button displays the [Project Settings] 
(Simple Settings) dialog box, and a new project file can be created.
“Creating a New Project (Simple Settings)” (w page 57)

[Open Project] Click this button to display the [Open] dialog box to open an existing project file.
[Recent Project] Displays the recently worked project files from the latest one. Double-click the file to open the 

project file.
Every click switches the sorting order to be ascending or descending. Right-click the item 
name and click the items you want to display or hide.
To delete the project history, select and right-click the file and click [Clear history] or [Clear All 
History].
No project name is displayed if no project file is saved.

[Open] Open the project file.
[Close] Exit EDIUS.

Initial Start-up
When you start up EDIUS for the first time after installation, register the serial number, specify a folder where the project files you use for 
editing are saved, and set up other items.

1) Perform steps 1) to 4) in “Activating EDIUS”.
 f “Activating EDIUS” (w page 47)
 f When activation completes, the [Folder Settings] dialog box appears.

2) Click [Browse] to specify the folder where the project files are to be saved, and click [OK].
 f Set the destination to save the project files. The next time and later you create projects, they are saved in the specified folder.

2
 f It is recommended that the project file saving destination is specified outside the drive where OS or system is installed.

3) Click [OK].
 f The [Start Project] dialog box appears.
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 f At the first start-up, create project presets (project formats) subsequently. Proceed to “Creating New Project Presets at Initial Start-up”.
“Creating New Project Presets at Initial Start-up” (w page 56)

2
 f You can change the save destination of the project folder by using [Application] in [User Settings] → [Project file].
“[Project file]” (w page 117)
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Exit
This section explains how to exit EDIUS.

Exiting Project
Close the project file you edited, and return to the [Start Project] dialog box.

1) Click [File] on the menu bar, and click [Exit Project].

2) Click [Yes].
 f Click [No] if you do not want to save the project. Click [Cancel] to cancel the operation.

Exiting EDIUS
The following explains how to exit EDIUS.

1) Click [File] on the menu bar, and click [Exit].

2) Click [Yes].
 f Click [No] if you do not want to save the project. Click [Cancel] to cancel the operation.

1 Alternative
 f Click [×] in the preview window.
 f Exiting EDIUS: [Alt] + [F4]
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Creating a Project

Creating a New Project
This section explains how to create a new project when or after EDIUS starts.
Use a preset to create a new project. There are two types of presets, project preset and project template.

2
 f You can also specify an existing project to use it as a template.
“Creating a New Project Using Existing Project as Template” (w page 57)

Project Preset
A project preset is a preset of project settings.
Set the project format according to the format of the output destination. At initial start-up, register a project preset by the [Project Preset] 
wizard.
“Creating New Project Presets at Initial Start-up” (w page 56)
Project presets are registered in advance, depending on the application. If this happens, select a project preset according to the format for 
the export destination.

Project Template
A project template is a preset that saves all information of another project as a template, which includes project settings, sources (video, 
audio, still image, and title files), effects, sequences, bin, etc.
A project template can be created by editing a project to be reused and saving it as a template.
“Saving as Project Template” (w page 73)

3 Note
 f Sources can be reused only when they are saved in the project folder.
If the sources are saved outside the project folder, they will become offline clips when the project template is to be edited on a different 
PC from the one the project template was created.

Creating New Project Presets at Initial Start-up
When you first start up EDIUS after installation, you need to register a project preset. Configure the settings of a project preset to create and 
register it.
Set the project format according to the format of sources to be used and the final export format.

1) Click [New Project] in the [Start Project] dialog box.
 f The [Create Project Presets] wizard will start up.

2) Check more than one item for each of [Size], [Frame Rate], [Bit], and [Audio Channels], and then 
click [Next].

 f Configure the video size, frame rate, video quantization, and audio channel for the project format to create with EDIUS. Multiple check 
boxes can be selected for each item.

 f Checking [Set Over Scan Size to 0%.] will set [Overscan Size] of the project preset to [0%].

2
 f Set a video quantization bitrate to 10-bit to edit with 10-bit precision retained. However, it may result in 8-bit precision depending on the 
effects you use.

3) Check the content.
 f A list of formats corresponding to the setting configured in step 2) is displayed.
A preset of the checked formats will be created. Uncheck the formats you do not use.
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2
 f You can click [Back] to redo the settings.

4) Click [Completed].
 f The [Project Settings] (Simple Settings) dialog box appears. The newly created project preset is displayed as an icon for [Project Preset] 
on [Presets List] in [Use Preset/Template].
“[Project Settings] (Simple Settings) Dialog Box” (w page 58)

3 Note
 f To change the project preset you created, perform through [Application] in [System Settings] → [Project Preset]. You can also create 
additional project presets in the system settings. Note that the changes will not be reflected to the presets even when you check 
[Customize] in step 4) and change the settings.
“[Project Preset]” (w page 103)

Creating a New Project (Simple Settings)
Create a new project when starting up EDIUS.
To create a new project, you can either select a project preset or project template, or open an existing project as a template.

Creating a New Project Using Project Preset/Project Template
When EDIUS has started up, select a project preset or project template to create a new project.
 f To use a project template, the project template to be used must be prepared in the specified folder in advance.
“Saving as Project Template” (w page 73)

1) Click [New Project] in the [Start Project] dialog box.
 f The [Project Settings] (Simple Settings) dialog box appears.
“[Project Settings] (Simple Settings) Dialog Box” (w page 58)

2
 f The [Create Project Presets] wizard will start up.
“Creating New Project Presets at Initial Start-up” (w page 56)

2) Enter a project name in [Project name] of [Project file].

3) Select [Use Preset/Template].

4) Select a project preset or project template.
 f The project templates displayed in [Project template] of [Use Preset/Template] are the files stored in the save destination specified by 
[Application] in [System Settings] → [Template File Folder] in [Project Preset].
“[Project Preset] Screen” (w page 69)

5) Click [OK].

2
 f Click [Cancel] to return to the [Start Project] dialog box.

Creating a New Project Using Existing Project as Template
When EDIUS has started up, select an existing project as a template to create a new project.
In the same way as using a project template, all the information included in the specified project can be reused.
“Project Template” (w page 56)

1) Click [New Project] in the [Start Project] dialog box.
 f The [Project Settings] (Simple Settings) dialog box appears.
“[Project Settings] (Simple Settings) Dialog Box” (w page 58)
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2
 f At initial start-up, the [Create Project Presets] wizard will start up.
“Creating New Project Presets at Initial Start-up” (w page 56)

2) Enter a project name in [Project name] of [Project file].

3) Select [Use existing project as template].

4) Click [...], specify a project file, and click [OK].

5) Click [OK].

[Project Settings] (Simple Settings) Dialog Box

[Project file] [Project name]
Click the input field to enter a project name.
[Folder]
Set the destination to save the project. To change the destination, click [...] and select a folder. 
Alternatively you can click the [...] list button and select a destination from the list of recent 
histories. A maximum of 10 histories are displayed.
Check [Create folder with project name] to create a folder with the project name in the 
destination folder.

[Use Preset/Template] [Project Preset]
Display registered project presets in a list. Double-click the icon to open a new project file with 
the selected project preset setting.
[Project template]
Display project templates that can be used in a list. Double-click the icon to open a new project 
file using the selected project template.
“Creating a New Project Using Project Preset/Project Template” (w page 57)

[Customize] This can be used only when a project preset is selected in [Use Preset/Template].
Check this item to change the detailed project preset settings (rendering format, and the 
number of tracks and so on) and create a new project file. The settings of the existing project 
preset will not be changed.
“Creating a New Project (Detailed Settings)” (w page 58)
If you use the restricted user profile, the detailed settings of a project preset cannot be 
changed.

[Use existing project as template] Use an existing project as a project template and open a new project file.
“Creating a New Project Using Existing Project as Template” (w page 57)

[Description] When [Use Preset/Template] is selected,the setting details of the project preset or project 
template are displayed.
When [Use existing project as template] is selected, the setting details of the specified project 
are displayed.

Creating a New Project (Detailed Settings)
When starting up EDIUS, you can create projects with different settings from that set in detail as a project preset (rendering formats, track 
numbers, etc.)

3 Note
 f This section describes how to customize project preset settings to create a project. This procedure does not change the original 
project preset. To create project presets or change project presets, perform through [Application] in [System Settings] → [Project 
Preset].
“[Project Preset]” (w page 103)

1) Enter a project file name in [Project name] of [Project file] in the [Project Settings] (Simple Settings) 
dialog box.

 f “[Project Settings] (Simple Settings) Dialog Box” (w page 58)

2) Select a project preset.
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3) Check [Customize], and click [OK].
 f The [Project Settings] (Detailed Settings) dialog box appears.
“[Project Settings] (Detailed Settings) Dialog Box” (w page 59)

4) Configure a project, and click [OK].

[Project Settings] (Detailed Settings) Dialog Box

[Video Preset] Display a list of commonly used video formats. From this list, select a video format that suits 
the export environment.

[Audio Preset] Display a list of commonly used audio formats. From this list, select an audio format that suits 
the export environment.

 (Expand button) Click this button for detailed settings.

[Advanced] Click the expand button to customize detailed settings based on the format selected in [Video 
Preset] and [Audio Preset]. You cannot change the items displayed in gray.
[Frame Size]
Select a frame size from the list.
Select [Custom] to enter a setting value in pixel. (The width must be a multiple number of 4. 
The maximum value is 4096x2160 pixel.)
[Aspect Ratio]
Select an aspect ratio from the list.
[Frame Rate]
Select a frame rate from the list.
[Field Order]
For interlace, a field order can be selected.
[Video Channel]
Select the channel to be exported (color channel/alpha channel) from the list. Select [YCbCr] 
to export only color channel. Select [YCbCr + Alpha] to export both color channel and alpha 
channel.
[Video Bit Depth]
Select a video quantization bitrate from the list.
[Pulldown Type]
This setting is only available for a frame rate of 24p or 23.98p. Select a convert format to 
convert a 23.98p video to a 59.94i or 59.94p video signal. [Pulldown(2-3-2-3)] enables a 
smooth playback, but is not appropriate for re-editing. Select this item for the final export. 
[Advanced pulldown(2-3-3-2)] does not provide a smooth playback. Select this item to create a 
temporary file to edit.
[Color Space]
Select the color space of the project.
[Stereoscopic Editing]
For 3D editing, select [Enable]. The stereoscopic edit mode is set.
“Stereoscopic Edit Workflow” (w page 325)
[Sampling Rate]
Select an audio sampling rate from the list.
[Audio channel]
Select the number of audio channels from the list.
[Audio Bit Depth]
Select an audio quantization bitrate from the list.
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[Setup] [Render format]
Select the default codec to be used for rendering and file export during editing. RGB, UYVY, 
YUY2, RGBA and v210 are uncompressed AVI.
For some codec, the rendering quality can be configured by clicking [Detail].
“Detailed Settings for Codec” (w page 61)
[Overscan Size]
Enter the ratio when you use overscan. The value range is between “0” and “20”. If you do not 
use overscan, enter “0”.
[Audio reference level]
Set the audio reference level. If you switch the display of the [Audio Mixer] dialog box to a VU 
meter, a scale with the specified audio reference level at “0” is displayed.
[Resampling method]
Select a resampling method when transforming video with the layouter.
“Video Layout” (w page 257)
[HDR/SDR gain]
Set the gain value to be applied when the color space of either HDR or SDR is converted to/
from the other.
In some conditions, the brightness of the reference white of HDR may differ from that of SDR. 
In this case, a video converted from HDR to SDR will appear brighter, and that converted from 
SDR to HDR will appear darker.
Setting [HDR/SDR gain] will apply the gain value when the color space of either HDR or SDR 
is converted to/from the other, preventing the variation in brightness.
Set the gain value to the conversion value for the display light. Select an item from [Disable], 
[0.00 dB], [3.00 dB], [6.00 dB], [6.15 dB], [9.00 dB] and [12.00 dB]. Select [6.15 dB] to comply 
with ITU-R BT.2408.
You can also directly enter a value (unit: dB) within a range from “0.00” to “20.00”.
 f [6.15 dB] is set by default.
 f This setting is reflected in the [HDR/SDR Gain] setting in the [Primary Color Correction] 
dialog box.
“[Primary Color Correction] Dialog Box” (w page 350)

 f For details on [HDR/SDR gain], the information will be released in the FAQ on our website.
“Our Website” (w page 494)

[Tone mapping]
This setting is applied to conversion in which the dynamic range of the color space gets 
smaller, such as when a HDR source is used as SDR.
Setting [Disable] will not apply the tone mapping. Areas with brightness that exceeds the 
luminance range of SDR will be replaced to 100% white. Setting [Soft Clip] will compress the 
high-luminance areas to show smooth gradation so that they will not be clipped easily.
 f [Soft Clip] is set by default.
 f This setting is reflected in the [Tone mapping] setting in the [Primary Color Correction] dialog 
box.
“[Primary Color Correction] Dialog Box” (w page 350)

[Sequence setup (Default)] Default settings for creating a sequence.
[TC preset]
Enter the start timecode of the timeline.
[TC Mode]
When NTSC has been selected for the project setting, select either drop frame or non drop 
frame timecode display.
[Total length]
Set the length of the timeline by entering a number when the final total length is fixed. When the 
project exceeds this length, the color of the timeline section that is over the limit change.

[Track (Default)] Default settings of a number of tracks and a channel map for creating new projects or 
sequence.
[V Tracks]/[VA Tracks]/[T Tracks]/[A Tracks]
Set the number of tracks in which you place clips.
You can add or delete any tracks after opening a project.
[Channel map]
In the [Audio Channel Map] dialog box, configure the audio output channel of each track.
“Configuring Audio Channel Map” (w page 63)

“Entry of Values” (w page 43)

2
 f Formats that can be exported with alpha channel retained when [Video Channel] is set to [YCbCr + Alpha] are as follows.

 g Grass Valley HQ AVI
 g Grass Valley HQ QuickTime
 g Grass Valley HQX AVI
 g Grass Valley HQX QuickTime
 g Uncompressed RGBA AVI
 g ProRes 4444 MOV
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3 Note
 f If a correct rendering format is not selected for the project settings, the item in [Render format] is displayed in red and the setting 
cannot be completed.

 f In the following conditions, [Disable] is set by default for [HDR/SDR gain] and [Tone mapping].
 g When a project file created with Version 9.31 or older is imported
 g When a project template created with Version 9.31 or older is used to create a project file

Detailed Settings for Codec
You can configure the rendering quality for each codec in the [Project Settings] (Detailed Settings) dialog box.
“[Project Settings] (Detailed Settings) Dialog Box” (w page 59)

Grass Valley HQ AVI/Grass Valley HQX AVI/Grass Valley HQ MOV/Grass Valley HQX MOV/HQ MXF/HQX 
MXF

For the details of the items, see the [Settings - Grass Valley HQ]/[Settings - Grass Valley HQX] dialog box of [Preset Wizard], by clicking 
[Hardware] in [System Settings] → [Device Preset]. Click [Save as default] to save the current settings as defaults.
“[Settings - Grass Valley HQ]/[Settings - Grass Valley HQX] Dialog Box” (w page 133)

MPEG2 Program Stream

 r [Basic Settings] tab

[Segment Encode] Check this item to export a clip of a raw source without re-encoding. Output speed is fast.
[Size] Select an image quality.
[Quality/Speed] Select quality from the list. The higher the quality, the more time it takes to be encoded.
[Bit Rate] Select a bitrate type.

[CBR] sets a fixed transfer rate, allocating a fixed number of bits during the encoding process. 
Select a bitrate from the [Average(bps)] list. You can also enter a value directly.
[VBR] sets a variable transfer rate, altering the number of assigned bits according to the 
complexity of the movement or image quality. Compared with [CBR], the media volume can be 
used more efficiently, and this enables more consistent image quality overall. Select a bitrate 
from the [Average(bps)] and [Maximum(bps)] lists. You can also enter a value directly.

 r [Extended Settings] tab

[Field Order] For interlace, a field order can be selected.
[Chroma Format] Select a YUV pixel format from the list.
[Profile & Level] Select a profile & level. If [Chroma Format] is [4:2:0] and [4:2:2], the profile will be set to Main 

Profile and 422Profile, respectively. The level for SD image quality will be Main Level, and 
the level for HD image quality will be High Level. The profile & level changes according to the 
format selected in [Chroma Format].

[GOP Structure] For MPEG, a certain number of frames is considered as a group, and operations such as 
compression/enlargement and cut editing are performed on a GOP basis. A GOP comprises 
“I frame”, “P frame” and “B frame”. The I frame allows images to be reproduced independently, 
the P frame is for recording and reproducing only the differences with the preceding image, 
and the B frame reproduces images from the differences in the preceding and following 
images. Select I, P and B frame patterns of the GOP from the list. Normally, select [IBBP].
[I-Frame Only] is comprised of only I-pictures. Editing is made easier, but the amount of data 
increases in size.

[Picture count] Set the number of frames included in a group.
[Closed GOP] Check this item to complete information within each GOP. Although the amount of data 

increases, the video can be re-edited using software that supports GOP-based editing. 
Normally, leave this item unchecked.

[Emphasis] Select an item from the list for high-frequency compensation that saves while emphasizing the 
high range. [None] is a setting without high-frequency compensation. [50/15 us] is an emphasis 
setting employed by some audio CDs, etc. [CCITT J.17] is a telecommunications standard 
recommended by CCITT.

[Protection] The “protection_bit” indicates whether redundancy is added to an audio bit stream in order to 
make error detection and correction possible. Check this item to change it to “1”, indicating that 
redundancy is being added.
Uncheck this item to change it to “0”, indicating that redundancy is not being added.
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[Original Flag] Check this item to change the “original_copy” bit to “1”, indicating the original copy.
If it is unchecked, it becomes “0”, indicating a duplication.

[Copyright Flag] Check this item to change the “copyright” bit to “1”, indicating that the copyright is protected.
If it is unchecked, it becomes “0”, indicating there is no copyright.

MPEG2 for XDCAM HD422/MPEG2 for XDCAM HD LP/MPEG2 for XDCAM HD SP/MPEG2 for XDCAM HD 
HQ

Items that can be configured are the same as [MPEG2 Program Stream].
“MPEG2 Program Stream” (w page 61)

MPEG2 MXF

[Segment Encode] Check this item to export a clip of a raw source without re-encoding. This increases the output 
speed.

[Bit Rate] Select a bitrate type.
[CBR] sets a fixed transfer rate, allocating a fixed number of bits during the encoding process. 
Select a bitrate from the [Average] list. You can also enter a value directly.
[VBR] sets a variable transfer rate, altering the number of assigned bits according to the 
complexity of the movement or image quality. Compared with [CBR], the media volume can be 
used more efficiently, and this enables more consistent image quality overall. Select a bitrate 
from the [Average] and [Max] lists. You can also enter a value directly.

[Quality/Speed] Select quality from the list. The higher the quality, the more time it takes to be encoded.
[Field Order] For interlace, a field order can be selected.
[GOP Structure] For MPEG, a certain number of frames is considered as a group, and operations such as 

compression/enlargement and cut editing are performed on a GOP basis. A GOP comprises “I 
frame”, “P frame” and “B frame”; the I frame allows images to be reproduced independently, the 
P frame is for recording and reproducing only the differences with the preceding image, and 
the B frame reproduces images from the differences in the preceding and following images. 
Select I, P and B frame patterns of the GOP from the list. Normally, select [IBBP].
[I-Frame Only] is comprised of only I-pictures. Editing is made easier, but the amount of data 
increases in size.

[Picture count] Set the number of frames included in a group.
[Closed GOP] Check this item to complete information within each GOP. Although the amount of data 

increases, the video can be re-edited using software that supports GOP-based editing. 
Normally, leave this item unchecked.

[Chroma Format] Select a YUV pixel format from the list.
[Profile/Level] Select a profile & level. If [Chroma Format] is [4:2:0] and [4:2:2], the profile will be set to Main 

Profile and 422Profile, respectively. The level for SD image quality will be Main Level, and 
the level for HD image quality will be High Level. The profile & level changes according to the 
format selected in [Chroma Format].

AVCUltra MXF

[Format] Select a format from the list.

DNxHR MXF/DNxHR MOV

[Format] Select a format from the list.
[VBR] Check this item to change the bitrate to be assigned in accordance with the complexity of the 

movement or image quality.

ProRes MXF

[Format] Select a format from the list.

ProRes MOV

[ProRes CODEC settings] Select a format from the list.
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XAVC MXF

[Format] Select a format from the list.
[Quality/Speed] Select quality from the list. The higher the quality, the more time it takes to be encoded.
[ClosedGOP] Check this item to complete information within each GOP. Although the amount of data 

increases, the video can be re-edited using software that supports GOP-based editing.
[Segment Encode] Check this item to export a clip of a raw source without re-encoding. This increases the output 

speed.

JPEG2000 MXF/D10 MXF

[Bit Rate] Select a bitrate from the list.

HDV

[Segment Encode] Check this item to export a clip of a raw source without re-encoding. Output speed is fast.
If the frame rate of the export format is 23.98p, segment encode is not available.
[Quality/Speed]
Select the quality of the part to be re-encoded from the list. The higher the quality, the more 
time it takes to be encoded.

DV AVI

Check [Use MSDV codec] to export the content to an MSDV codec AVI.

Other Codecs

The following codecs can also be selected.
[Detail] will not be available.
 f AVCIntra MXF
 f DVCPROHD MXF
 f DVCPRO25 MXF
 f DVCPRO50 MXF
 f DV MXF
 f Uncompressed RGB AVI
 f Uncompressed RGBA AVI
 f Uncompressed UYVY AVI
 f Uncompressed YUY2 AVI
 f Uncompressed v210 AVI
 f Grass Valley Lossless AVI
 f DVCPRO50 AVI

Configuring Audio Channel Map
Select the final output channel for the output from the track.

1) Click [Channel map] in the [Project Settings] (Detailed Settings) dialog box.
 f “[Project Settings] (Detailed Settings) Dialog Box” (w page 59)
 f The [Audio Channel Map] dialog box appears.
“[Audio Channel Map] Dialog Box” (w page 64)

2) Click the point where the track and the channel to output intersect to configure the audio channel 
map.

 f Every click switches between [Stereo], [Mono], and [No Output folder].
 f For stereo output, use a combination of an odd number channel and an even number channel and set this option to [Stereo]. If you output 
in monaural, select [Mono], and if you do not output anything, select [No Output folder]. If the setting is invalid, “-” is displayed.
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[Audio Channel Map] Dialog Box

(1) Tracks The number or type of track to be displayed differs depending on the [Track (Default)] settings 
in the project settings.

(2) Output channels The number of channels to be displayed differs depending on the [Audio Preset] or [Audio 
Channels] settings in the project settings.

(3) Audio channel map 
settings

Select the output channel for the output from the track. Every click switches between [Stereo], 
[Mono], and [No Output folder].

(4) [Change Display Style] Click this item to switch the display view of the [Audio Channel Map] dialog box.
(5) [Preset] Register the settings as a preset.

“Creating Audio Channel Map Preset” (w page 64)

2
 f Use the track header to place an audio channel of the source clip to a desired track.
“Connecting/Disconnecting the Source Channel” (w page 230)

3 Note
 f To export a project with 8ch audio to Dolby Digital (AC-3), you can select the format for 5.1 channel. When you select formats for 
multiple channels to output as in the case mentioned, set the export destination of each track with the audio channel map in advance. 
If the export destination is not specified, the sound is muted. To play the sound in 5.1 channel surround, the sound is required to be 
created to be suitable for surround play. Note that the surround effect is not applied automatically only by setting the audio channel 
map and selecting 5.1 channel for the export format.

Creating Audio Channel Map Preset
You can register frequently used audio channel map settings as presets.

1) Configure the audio channel map in the [Audio Channel Map] dialog box.
 f “[Audio Channel Map] Dialog Box” (w page 64)

2) Click [Preset], and click [Save].

3) Enter a preset name, and click [OK].

2
 f You can overwrite an existing audio channel map preset with the current settings. In step 2), click [Preset], and click [Update] → [Preset 
Name]. Confirm the preset name, and click [OK].

 f To display a list of the audio channel map presets, click [Preset] in the [Audio Channel Map] dialog box, and click [Properties].

Switching Audio Channel Map Presets
Switch the audio channel map presets to use.

1) Click [Preset] in the [Audio Channel Map] dialog box, and click [Load].
 f “[Audio Channel Map] Dialog Box” (w page 64)
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 f A list of the audio channel map presets is displayed.

2) Select a preset, and click [OK].

Deleting Audio Channel Map Preset
You can delete audio channel map presets you created.

1) Click [Preset] in the [Audio Channel Map] dialog box, and click [Properties].
 f “[Audio Channel Map] Dialog Box” (w page 64)
 f A list of the audio channel map presets is displayed.

2) Select a preset, and click [Delete].

3) Click [Yes].

Importing Audio Channel Map Preset (Import)
Import an audio channel map preset.

1) Click [Preset] in the [Audio Channel Map] dialog box, and click [Properties].
 f “[Audio Channel Map] Dialog Box” (w page 64)
 f A list of the audio channel map presets is displayed.

2) Click [Import].

3) Select a file, and click [Open].

Exporting Audio Channel Map Preset (Export)
Export an audio channel map preset you created.

1) Click [Preset] in the [Audio Channel Map] dialog box, and click [Properties].
 f “[Audio Channel Map] Dialog Box” (w page 64)
 f A list of the audio channel map presets is displayed.

2) Select a preset, and click [Export].
 f The [Save As] dialog box appears.

3) Set a file name and save destination, and click [Save].

Creating a New Project after Start-up
You can create a new project after starting up EDIUS.

1) Click the [Create New Sequence] list button on the timeline.
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2) Click [New Project].
 f If you create a new project during the editing operation, a confirmation dialog box appears to ask if you want to save the current project 
file.

 f The [Project Settings] (Simple Settings) dialog box appears.
“[Project Settings] (Simple Settings) Dialog Box” (w page 58)
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1 Alternative
 f Click [File] on the menu bar, and click [New] → [Project].
 f Creating a new project after start-up: [Ctrl] + [N]

2
 f When a new project is created, the clips in the bin are initialized (all deleted).

3) Enter a project name in [Project name] of [Project file].

4) Select a project preset or project template, and click [OK].

2
 f Check [Customize] to change the detailed project preset settings (rendering format and the number of tracks and so on) and create a new 
project.
“[Project Settings] (Detailed Settings) Dialog Box” (w page 59)

 f You can also specify an existing project to use it as a template.
“Creating a New Project Using Existing Project as Template” (w page 57)
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Changing the Project Setting
This section explains how to change the project settings during the editing operation.

Changing the Project Setting (Simple Settings)
You can change project settings while editing by switching project presets.

2
 f To create a new project preset or change the existing project preset settings, use [Application] in [System Settings] → [Project Preset].
“Project Preset/Project Template” (w page 69)

1) Click the [Save Project] list button on the timeline.
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2) Click [Project Settings].

1 Alternative
 f Click [Settings] on the menu bar, and click [Project Settings].

3) Select a project preset, and click [OK].

Changing the Project Setting (Detailed Settings)
Change the project settings by modifying the detailed settings of an existing project preset.

3 Note
 f The settings of the original preset will not be changed if you change the project settings of a project you are currently editing.
To create a new project preset or change the existing project preset settings, use [Application] in [System Settings] → [Project Preset].
“Project Preset/Project Template” (w page 69)

 f When changing the settings for [TC preset], [TC Mode], [Total Length], and [Channel map] in the project settings while editing a 
project, the change is not reflected in the created sequence. Change the settings of the created sequence in the [Sequence settings] 
dialog box for each sequence.
“Sequence Settings” (w page 68)

1) Click the [Save Project] list button on the timeline.
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2) Click [Project Settings].

1 Alternative
 f Click [Settings] on the menu bar, and click [Project Settings].

3) Select a project preset, and click [Change current setting].
 f The [Project Settings] (Detailed Settings) dialog box appears.
“[Project Settings] (Detailed Settings) Dialog Box” (w page 59)

4) Change the settings, and click [OK].
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Sequence Settings
You can change the settings of the sequence settings in the [Sequence settings] dialog box.

1) Click the [Save Project] list button on the timeline.
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2) Click [Sequence settings].
 f The [Sequence settings] dialog box appears.
“[Sequence settings] Dialog Box” (w page 68)

1 Alternative
 f Click [Settings] on the menu bar, and click [Sequence settings].
 f Right-click the sequence tab, and click [Sequence Settings].
 f Right-click a sequence clip in the bin, and click [Sequence Settings].

3) Change the settings, and click [OK].

[Sequence settings] Dialog Box

[Sequence name] Enter the name of the sequence.
[TC preset] Set the start timecode of the timeline.
[TC Mode] When NTSC has been selected for the project setting, select either drop frame or non drop 

frame timecode display.
[Total Length] Set the total length of the timeline of sequence by directly entering the value. When the timeline 

exceeds this length, the color of the timeline section over the limit changes.
[Preserve Ancillary data] Check this item to set the sequence to hold ancillary data.
[Channel map] Set audio output channel for each track.

“Configuring Audio Channel Map” (w page 63)

“Entry of Values” (w page 43)
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Project Preset/Project Template

Creating a Project Preset

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Project Preset].
 f The [Project Preset] screen appears.
“[Project Preset] Screen” (w page 69)

3) Click [New Preset].
 f The [Project Settings] dialog box (for creating new project presets) appears.
“[Project Settings] Dialog Box (for creating new project presets)” (w page 69)

3 Note
 f Clicking the [Default Icon Folder] checkbox in the [Select Icon] dialog box does not uncheck the item while default icon folder is 
displayed. The display returns to the default icon folder display by clicking [...] and checking the item while a different folder is 
displayed.

4) Set each item and click [OK].
 f The newly created preset is displayed as an icon in [Presets List].

[Project Preset] Screen

[Presets List] Display registered project presets and project templates in a list. The list can be resorted by 
dragging the icon.
Project templates cannot be resorted.

[Description] Display the setting details of the project preset or project template selected in [Presets List].
[Preset Wizard] Start up the [Create Project Presets] wizard so that new project presets can be easily created.

“Simple Creation of Project Presets” (w page 70)
[New Preset] Create new project presets.
[Copy] Duplicate the selected project preset.
[Modify] Change the settings of the selected project preset. Click this item to display the [Project 

Settings] dialog box (for creating new project presets).
“[Project Settings] Dialog Box (for creating new project presets)” (w page 69)

[Delete] Delete the selected project preset or project template.
[Template File] Set the default value when saving project templates.

“[Save As Template] Dialog Box” (w page 74)
[Template File Folder]
Set the destination to save the project template. Click [Browse], and specify a folder.
[Template Name]
Enter the name of the project template.

[Project Settings] Dialog Box (for creating new project presets)

[Folder] Set the destination to save a project preset. To change the save destination, click [...], and 
specify a folder.

[Name] Enter the name of the project preset.
[Select Icon] Displays the [Select Icon] dialog box to select the preset icons.

To use any image you like, click [...] in the [Select Icon] dialog box, and select a file.
[Preset] Click this item to call up existing project presets.

Setting items other than the above are the same as those for the project presets (Detailed Settings).
“[Project Settings] (Detailed Settings) Dialog Box” (w page 59)
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Simple Creation of Project Presets

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Project Preset].

3) Click [Preset Wizard].

4) Check more than one item for each of [Size], [Frame Rate], [Bit],and [Audio Channels], and then click 
[Next].

 f Configure the video size, frame rate, video quantization, and audio channel for the project format to create with EDIUS. Multiple check 
boxes can be selected for each item.

 f Checking [Set Over Scan Size to 0%.] will set [Overscan Size] of the project preset to [0%].

2
 f Set a video quantization bitrate to 10-bit to edit with 10-bit precision retained. However, it may result in 8-bit precision depending 
on the effects you use. The formats that can be imported with 10-bit are Grass Valley, HQX AVI, uncompressed AVI, AVC-Intra, 
QuickTime, Grass Valley HQX MOV, and XAVC. The formats that can be exported with 10-bit are Grass Valley HQX AVI, AVC-Intra, and 
uncompressed (v210) AVI, and MP4.

5) Check the details.
 f A list of formats corresponding to the setting configured in step 4) is displayed.
 f A preset of the checked formats will be created, uncheck the formats you do not use.

2
 f You can click [Back] to redo the settings.

6) Click [Done].
 f The newly created preset is displayed as an icon in [Presets List].

Deleting Project Presets/Project Templates
Delete project presets or project templates.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Project Preset].

3) Select the project preset or project template to be deleted in [Presets List], and click [Delete].

1 Alternative
 f Right-click a project preset or project template in the project preset list, and click [Delete].

4) Click [Yes].

3 Note
 f Project presets registered by default cannot be deleted.

Copying Project Presets

1) Click [Settings] on the menu bar, and click [System Settings].
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2) Click the [Application] tree, and click [Project Preset].

3) Select the project preset to be copied in [Presets List], and click [Copy].

1 Alternative
 f Right-click a project preset in [Presets List], and click [Copy].

3 Note
 f Project templates cannot be copied.

Changing Project Presets
Change project preset settings.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Project Preset].

3) Select the project preset to be changed in [Presets List], and click [Modify].
 f The [Project Settings] dialog box (for creating new project presets) appears.
“[Project Settings] Dialog Box (for creating new project presets)” (w page 69)

1 Alternative
 f Right-click a project preset in [Presets List], and click [Modify].

4) Set each item and click [OK].

2
 f Even when you change the project preset used in the project being edited, the settings of the project being edited are not changed. To 
reflect the changes, switch the setting to the project preset changed.
“Changing the Project Setting (Simple Settings)” (w page 67)

3 Note
 f Project presets registered by default cannot be changed.
 f The setting details of project templates cannot be changed.

Importing Project Presets (Import)

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Project Preset].

3) Right-click [Presets List], and click [Import].

4) Select a project preset, and click [Open].

3 Note
 f Project templates cannot be imported.
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Exporting Project Presets (Export)

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Project Preset].

3) Select and right-click a preset in [Presets List], and click [Export] → [All] or [Selected preset].

4) Specify a save destination, and click [Save].

3 Note
 f Project templates cannot be exported.
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Saving a Project
A project file is saved as an ezp file. The file name of the project currently being edited is displayed in the timeline operation area.
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00:00:00;00 00:00:05;V
XXXXXX

The following explains how to save project files and about auto save/backup files.

3 Note
 f After saving the project file, do not move or delete the source that is used for reference in the project. However, if the source is in the 
folder where the project file is created, the folder as a whole can be moved.

Overwrite Saving
You can save the project with the project name entered when creating the project.

1) Click [Save Project] on the timeline.

album1

1 Alternative
 f Click the [Save Project] list button, and click [Save Project].
 f Click [File] on the menu bar, and click [Save Project].
 f Overwrite saving a project: [Ctrl] + [S]

Saving in Another Name
You can save the current project file (the one being edited) with another name.

1) Click the [Save Project] list button on the timeline.

album1

2) Click [Save As].

3) In the [Save As] dialog box, specify a file name and save destination, and click [Save].

1 Alternative
 f Click [Save Project] with [Shift] on the keyboard held down.
 f Click [File] on the menu bar, and click [Save As].
 f Saving a project in another name: [Shift] + [Ctrl] + [S]

Saving as Project Template
A project template is saved as an ezpt file.

1) Edit a project.

2) Click [File] on the menu bar, and click [Save As Template].
 f The [Save As Template] dialog box appears.
“[Save As Template] Dialog Box” (w page 74)
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1 Alternative
 f Click the [Save Project] list button on the timeline, and click [Save As Template].

3) Set each item, and click [OK].

[Save As Template] Dialog Box

[Template Folder] Set the destination to save a project template. To change the save destination, click [...], and 
specify a folder.

[Template Name] To change the name, click the input field to enter a project template name.

2
 f By default, the save destination of project templates is set to the “Project Templates” folder on the same level as the project folder.
 f You can change the default setting of [Template Folder] and [Template Name] using [Application] in [System Settings] → [Template File] in 
[Project Preset].
“[Project Preset] Screen” (w page 69)

Auto Save/Backup
If the auto save function is enabled, an auto save file is created at a specified interval.
A backup file is created when a project file is saved if the backup function is configured. This file is used as a backup when the project file is 
corrupted or the system failed during the editing operation.
To configure auto save/backup, use [Application] in [User Settings] → [Project file].
“[Project file]” (w page 117)
By default, an auto save/backup file is automatically saved, with a “Project name-Year, Month, Day-Hour, Minute, Second .ezp” file name, in 
the project folder where the corresponding project file is saved.
 f Destination of an auto save file → “Project folder”/“Project”/“AutoSave”
 f Destination of a backup file → “Project folder”/“Project”/“Backup”

3 Note
 f Copy (transfer) the auto save/back up file to the folder where the project file is originally saved and import the file, to recover the 
project from the auto save/back up file.

 f Auto save/back up files are in the attributes of read-only and cannot be overwritten. Change the attributes of the file from Windows 
Explorer in advance, or save as the different file.
“Restarting a Project (After Startup)” (w page 75)
“Saving in Another Name” (w page 73)
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Importing/Exporting a Project
This section explains how to import project files edited with EDIUS, how to consolidate a project, and how to export to an AAF or EDL file.

Restarting a Project (At Startup)
Select a project to import when EDIUS starts up.

1) Double-click a project file from [Recent Project] in the [Start Project] dialog box.
 f In [Recent Project], previously worked project files from the latest are displayed.

1 Alternative
 f Click [Open Project], specify a file and click [Open].
 f Select a project file from the [Recent Project] list, and click [Open].

2
 f If you open a project file that is currently open for editing from another PC, the project file opens as a read-only file.
 f When you open a project with a large number of clips, “the number of imported files/number of all files” is displayed.

Restarting a Project (After Startup)
You can open a new project file after EDIUS starts up.

1) Click [Open Project] on the timeline.

album1

 f A confirmation dialog box appears to ask if you want to save the current project file.

2) Select a project file to import in the [Open Project] dialog box, and click [Open].

1 Alternative
 f Click the [Open Project] list button, and select a file from the list of recent files.
 f Click [File] on the menu bar, and select a file from [Recent Project] → the recent files.
 f Click [File] on the menu bar, and click [Open Project] to select a project.
 f Opening project file after start-up: [Ctrl] + [O]

2
 f If you edit a project file using multiple PCs over the network, while one PC can open and edit the project file, other PCs can open the 
same project file as a read-only file.

Importing Sequence (Sequence Import)
You can import the sequence created in other project.

1) Click the [Open Project] list button on the timeline.
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2) Click [Import Sequence].
 f The [Import Sequence] dialog box appears.
“[Import Sequence] Dialog Box” (w page 76)

1 Alternative
 f Click [File] on the menu bar, and click [Import Sequence].
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3) Set each item and click [OK].

[Import Sequence] Dialog Box

[Import Project] Select a recent file from the list. Click [Browse] to select a file using the [Open] dialog box. 
When you select a project file, detailed information including the project names and updated 
date. The information is displayed in red when the frame size or the aspect ratio differs.

[Import Bin] Check this item to merge the bin contents. To [Folder name], enter a folder name to manage 
the imported bin clips. The folder will be created under the [root] folder in the bin.
When imported with the folder name “album1”, the following be displayed.

Uncheck this item to import only the sequence.
[Copy Files] [Copy clips in project folder]

Copy the files in the source project folder.
[Copy rendered files]
Copy the rendered files.
[Folder name]
Enter a folder name to manage the copied files. The folder is created under the project folder.

3 Note
 f You cannot copy files if the project folder is same as the source.
 f If the frame rates are different, the merge process fails.
 f If you merge projects with different project settings, the original project and video may be changed due to the differences of the frame 
size, aspect ratio, and overscan size. In addition, the rendered files cannot be copied.

Consolidating Project (Consolidate Project)
You can remove unnecessary clips from the project folder, and extract a portion to use.

1) Click the [Save Project] list button on the timeline.
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2) Click [Consolidate Project].
 f The [Consolidate Project] dialog box appears.
“[Consolidate Project] Dialog Box” (w page 77)

1 Alternative
 f Click [File] on the menu bar, and click [Consolidate Project].

3) Set each item and click [OK].
 f When you delete unnecessary files, a confirmation message is displayed, and click [Yes].

2
 f When a message indicating there is not enough disc space for consolidating is displayed, change the destination.
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[Consolidate Project] Dialog Box

[Project File Location] [Current Project Location]
Overwrite and save the current project.
[Save Project to Folder]
Specify a folder to save the project.
[Drive Space]/[Required Space]
Display the available disc space of the selected drive and the whole file size to be created 
(copied) by consolidating. They are displayed in red when the required space is larger than the 
available disc space.

[Settings] Select the operation to be performed at execution of consolidation, and select [Trim margin] or 
options as required. Select execution options from the following.
[Cleanup]
Select this item to delete unnecessary files in the project.
Release clips that are registered to the bin but not used in the timeline and delete them from 
the hard disk.
[Backup]
Select this item to create a backup of the portion used in the project. You need to specify a trim 
margin.
Only the clip portion used in the timeline is saved as a separate file, and all the clips used in 
the project is copied to the project folder. However, if the clip used in the timeline is registered, 
the entire file is copied.
[Backup(no trimming)]
Select this item to back up the entire project.
Copy all the clips used in the project to the project folder.
[Backup  Cleanup]
Perform an operation of both [Cleanup] and [Backup] together. You need to specify a trim 
margin.
[Backup  Cleanup(no trimming)]
Perform an operation of both [Cleanup] and [Backup(no trimming)] together.
[Custom]
Configure the consolidation settings manually.
 f [Remove unused clips in Timeline]

Release the clips not used in the timeline from the bin.
 f [Leave only areas used in Timeline]

Save the areas used in the timeline as another file, and then switch the file in the timeline with 
the new file. You need to specify a trim margin.
The new files are saved in the created folder in the project folder.
 f [Copy used files to Project Folder]

Copy all the clips used in the project to the project folder.
 f [Delete unused files in Project]

Delete the unnecessary files from the project folder when consolidating. You can set this option 
only when any of the other optional items is selected.

[Proxy clip] If any proxy clip is used, select the data type to be consolidated from the list.
[Output log] Check this item to export a log file containing the result of consolidation. Click [Browse] to 

specify a destination and a file name.

2
 f If you select a back up option and if there is any clip that cannot be copied, a confirmation message is displayed to ask if you want to 
continue the process before consolidation.

 f If you select a cut option and if there is any clip that cannot be copied, a confirmation message is displayed to ask if you want to continue 
the process before consolidation.

3 Note
 f Even if an option to delete unnecessary files is selected, some files may not be deleted due to the access right to the folder or file. In 
that case, no message appears. Check the user authorization when logging in.

 f If an option to delete unnecessary files is selected, the deleted files cannot be restored after consolidation.
 f The name of the copied file is changed.

Deleting Clips Not Used in Project from Bin

1) Click the [Save Project] list button on the timeline.
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2) Click [Consolidate Project].
 f The [Consolidate Project] dialog box appears.

3) Select [Custom] from the [Consolidate option] list of [Settings].

4) Check [Remove unused clips in Timeline].

5) Click [OK].

2
 f When a message is displayed indicating there is not enough disk space to execute consolidation, change the save destination.

Exporting AAF Files (AAF Export)
You can export a project file that you edited with EDIUS as an AAF file.

3 Note
 f Only active sequences will be exported.
 f The following information will not be exported.

 g Tracks with no clip
 g Audio tracks with no channel map setting
 g Title track
 g Tracks with mute setting
 g All effects (As for the pan and volume settings, source files that reflect their settings will be exported.)

 f Transition/cross fade sections will be exported as clips.
 f You cannot add an In point side margin to a clip that is positioned at the top of the timeline.
 f You cannot specify network drives as export destination. However, you can mount network drives to use as export destination.
 f When you select an exporter which does not support the export of the timecode, the file is not exported properly.
 f Clips that are grouped, share a same clip name, and reference the same source are exported as a grouped clips.

1) Click the [Save Project] list button on the timeline.
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2) Click [Export Project] → [AAF].
 f The [Project Exporter (AAF)] dialog box appears.
“[Project Exporter (AAF)] Dialog Box” (w page 79)
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1 Alternative
 f Click [File] on the menu bar, and click [Export Project] → [AAF].

3) In the [Project Exporter (AAF)] dialog box, specify a file name and save destination.

4) Select a preset, and click [Save].
 f The export of the AAF file is started.
 f If you want to check the preset settings or change export settings, click [Detail].
The [AAF Export Detail Settings] dialog box appears.
“[AAF Export Detail Settings] Dialog Box” (w page 79)

2
 f You can use the Render Service to export an AAF file in the background.
“AAF Format” (w page 447)

[Project Exporter (AAF)] Dialog Box

[Preset] [Type : 1] Pro Tools preset*1

The information of the video and audio clips is written in an AAF file. The source that the video 
clip is referring to is exported as QuickTime (H.264) in the NTSC format. The source that the 
audio clip is referring to is exported as an AIFF file.
Select type 1 when you import the AAF file with audio editing software.
[Type : 2] After Effects preset*1

The video clip information is written in an AAF file, and the source that the video clip is 
referring to is not copied or exported.
The audio information of the audio corresponding to the range that is exported to an AAF file is 
exported as an AIFF file, and the information is written in an AAF file as a single clip.
Select type 2 when you import the AAF file with composition software.
[Type : 3] Other NLE preset
The information of the video and audio clips is written in an AAF file by frame unit. The source 
that the clips are referring to is not copied or exported.
[Type : 4] DaVinci Resolve preset*1

The information of the video and audio clips is written in an AAF file. The source that the clips 
are referring to is exported in the QuickTime (Grass Valley HQX) format.
[Type : 5] Media Composer preset*1*2

The information of the video and audio clips is written in an AAF file. The source that the clips 
are referring to is exported in the MXF (DNxHD, 1080p/i, or 720p) format.

[Export between In and Out] Check this item to export only between In and Out points of the timeline.
[Detail] The [AAF Export Detail Settings] dialog box appears.

“[AAF Export Detail Settings] Dialog Box” (w page 79)

*1 Visit our website for the latest information on supported formats.
*2 EDIUS Workgroup or DNxHD optional license is required.

3 Note
 f If you export a project using [Type : 1] in [Preset], you must import the video manually depending on the version of Pro Tools.
 f If you use Pro Tools 7.3 or older to import the file exported using [Type : 1] in [Preset], you must change [File path] to [RFC1738] in the 
[AAF Export Detail Settings] dialog box.
“[AAF Export Detail Settings] Dialog Box” (w page 79)

[AAF Export Detail Settings] Dialog Box

[Legacy] Check this item to export in the older format of AAF.
[Separate video and audio] Check this item to export with audio and video separated. Uncheck this item to export as a 

video source containing audio.
[File path] Select [RFC1738], [RFC2396], or [Unicode] to specify the description method for the source file 

path to which the clip refers.
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[Video Clip] Specify how video clips will be handled.
[Output AAF]
Check this item to add video clip information to AAF files.
[Clips]
 f [Copy clips]

Copy (or export) the source used for the clips so that the copied source will be referenced.
 f [Compress and copy a clip]

Handle the video clips of the timeline as one clip. The clip and file names of the first clip with 
the smallest track number will be used as the clip and file names of the exported files.
 f [Use original clips]

Reference the original source directly without copying.
[Audio clip] Specify how audio clips will be handled.

[Output AAF]
Check this item to add video clip information to AAF files.
[Clips]
 f [Copy clips]

Copy (or export) the source used for the clips so that the copied source will be referenced.
 f [Compress and copy a clip]

Handle the audio clips of the timeline as one clip. The clip and file names of the first clip with 
the smallest track number will be used as the clip and file names of the exported files. If both 
the VA and A tracks have audio, the first clip and file names of the A track will be used.
 f [Use original clips]

Reference the original source directly without copying.
 f [Enable Pan setting]

Check this item to export the stereo tracks as monaural tracks of individual channels. If 
unchecked, the stereo tracks will be downmixed and exported as monaural clips. For the 
channel map, if the track number is an odd number, 1ch (L side) of the track will be used, and if 
the track number is an even number, 2ch (R side) of the track will be used. The clip names will 
be “clip name + .L” for odd number tracks and “clip name + .R” for even number tracks.

[Copy option] Specify how the source will be copied when you select [Copy clips] in [Video Clip] and/or 
[Audio clip].
[Copy used clips]
Copy source files that are used by the clips on the timeline.
[Export the used area to a file]
Export only the ranges that are used by the clips on the timeline. In this case, the setting of 
[Margin] is enabled to export the file adding the specified time margins at In/Out points.
If you select [Copy clips] in [Audio clip], the source will be downmixed and exported as a 
monaural clip.
[Output folder]
Select a source file export destination.
If you select [Create a folder], a folder with the same name of the AAF file folder in the 
destination to which the AAF file is exported, and the source files will be exported to that folder.
If you select [Same folder], the source files will be exported to the destination of the AAF file.
[Exporter]
 f [Video]

Select the exporter to export video files.
 f [Display timecode]

Check this item to display the timeline timecode in the exported video.
 f [Audio]

Select the exporter to export audio files.
 f [Export in 16bit]

Check this item to convert the source to the 16-bit format audio, regardless of the project 
settings.

[Save preset] Register the current settings as a new preset.
Enter a preset name, and click [OK].

[Delete] Delete the currently selected preset. Presets registered in advance cannot be deleted.
[OK] Click this button to change the settings for the selected AAF export preset temporarily. Click 

[Save preset] and save the changed settings to register the preset, as the changes are not 
saved by this operation.

[Cancel] Cancel the settings and return to the [Project Exporter (AAF)] dialog box.

Exporting EDL Files (EDL Export)
You can export a project file that you edited with EDIUS as an EDL file.
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Items to Be Exported

 r Tracks
Export the following tracks. The clips placed on other tracks not mentioned below are not exported.
 f 1 - 2VA (1 - 2V) tracks
 f 1 - 4A tracks
 f T tracks (All tracks)

 r Audio
Audio clips in 1 - 2VA track are not exported. Export channel range for 1 - 4A tracks is different depending on EDL type.

EDL types Tracks
BVE5000
BVE9100
CMX340
CMX3600

1 - 2A
1 - 4A
1 - 2A
1 - 4A

1) Click the [Save Project] list button on the timeline.
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2) Click [Export Project] → [EDL].

1 Alternative
 f Click [File] on the menu bar, and click [Export Project] → [EDL].

3) In the [Project Exporter (EDL)] dialog box, specify a file name and save destination.

4) Click [Detailed Settings].
 f The [EDL Exporter Detailed Settings] dialog box appears.
“[EDL Exporter Detailed Settings] Dialog Box” (w page 81)

5) Set each item and click [OK].

6) Click [Save].

[EDL Exporter Detailed Settings] Dialog Box

[EDL Type] Select the EDL format to export.
[Export Format] [Mode1]

Comment lines are not added.
[Mode2]
Comment lines are added. Select this format when you cannot correctly import EDL files by 
third-party products.

[Handle empty clips as black clips] Handle the empty spaces on timeline are as black clips. Check [Use longest clip as reference] 
to handle Out point at the end edge of the timeline as the end edge of the timeline; the empty 
spaces between them are handled as black clips.

[Link clips with sequential time codes] Handle a series of multiple clips as one clip when their timecodes are sequential. However, 
they are not linked when transition is set between them.

[Export EDL for each track] Export the project file for each track. The following characters are added to the end of each file 
name.
 f 1VA (1V) track video: “_V”
 f A track: “_A”
 f 2VA (2V) track video: “_INSERT”
 f T track: “_T”

The audio of both 1VA, 2VA, and A tracks is output together to a “file name_A.edl” file.
When 2VA (2V) track has a transition, it will be replaced with a center cut.

[Replace transitions with center cuts] Replace all places with transitions or audio cross fade configured with the center cuts.
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[No split information] Release the grouping of video and audio, and handle the video clips and audio clips separately. 
Check this item when you cannot correctly import EDL files by third-party products.
If you check this item, [Handle split clips separately] cannot be set.
“Splitting Clips to Handle Separately” (w page 82)

[Handle split clips separately] Divide the split part of the clip with split to eliminate the split. Note that when the speed of 
clips is changed, the split part is not fragmented. This item cannot be set if you check [No split 
information].
“Splitting Clips to Handle Separately” (w page 82)

[When in reverse play, reverse player 
In/Out timecodes]

Display the reverse playback in the direction from the Out point to In point. The reverse 
playback is normally displayed from the In point to Out point. This item is available when you 
set CMX type for EDL type.

[When in reverse play, move one 
frame in the In direction]

Add a frame to the Player In point at reverse playback. Check this item when you cannot 
correctly import EDL files by third-party products. It prevents the original timecode from 
slipping off 1 frame forward. Normally, 1 frame is added to Out point of the Player at reverse 
playback.

[Combine Insert Tracks] Check this item to overwrite a 1VA (or 1V) track with images of a 2VA (or 2V) track and to 
export both tracks as a 1VA (or 1V) track together.

[Create Reel List] Create the list of reel numbers.
[Add Reel No. to clip name in 
comment]

This item can be changed only when [Mode2] (output format to add comment lines) is selected 
in [Export Format].
Check this item to add a reel name to the clip name output to the comment lines.

[Master reel number] Set the master reel number used in BVE9100. The value range is between “0” and “9999”.
[Block number] Set the block number used in BVE5000 or BVE9100. The value range is between “0” and 

“999”.
[Adjusted Data Settings] [Master reel number]

When A/A roll (transition among the clips with the same reel number) exists, this reel number 
is to use the location in the replaced file. When the original clips have the same reel number, 
decrease the number one by one to avoid the number duplication.
[Block number]
Set the block number used in BVE5000 or BVE9100. The value range is between “0” and 
“999”.
[Preroll area]
Specify the margin added to In/Out points of the clips.
[Offset time code]
Enter the start timecode (optional).
[Regenerate setting]
Set the start timecode to the In point of the first clip.
[Jam sync setting]
Set the In/Out points of the clip to the In/Out points of the timeline.

Splitting Clips to Handle Separately
When clips placed on different tracks are grouped and the clips have a gap within 3 seconds between the clips, they are split when 
exporting the EDL file.
When the clips have split information, the export result of EDL files differs depending on the settings in the [EDL Exporter Detailed Settings] 
dialog box. Here explains an example when the clips placed in 3 different tracks are grouped.

XXXX

XXXX

XXXX

c1b1

00:00:00;00

A

B

C

D

00:00:01;00 00:00:06;00
00:00:05;00

c1b1

 r If [No split information] is checked:
The grouping of the clips is released to handle each clip separately. They are fragmented in 3 periods of time (A, B, and C in the figure 
above).
1 Information of A (00:00:01;00 - 00:00:05;00)
2 Information of B (00:00:00;00 - 00:00:05;00)
3 Information of C (00:00:01;00 - 00:00:06;00)
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 r If [No split information] is unchecked:
Gaps between the clips are split. Areas of b1 and c1 in the figure are split, and the information is fragmented into 1 period of time as range 
D.
1 Information of D (00:00:01;00 - 00:00:05;00) (including the split information of b1 and c1)

 r If [Handle split clips separately] is checked:
The gap between tracks is fragmented to eliminate the split. The information is fragmented in 3 periods of time (b1, c1, and D in the figure 
above).
1 Information of b1 (00:00:00;00 - 00:00:01;00)
2 Information of c1 (00:00:05;00 - 00:00:06;00)
3 Information of D (00:00:01;00 - 00:00:05;00)

3 Note
 f The clips with the speed changed are not split or handled separately, because their grouping becomes released.

Importing AAF Files (AAF Import)
You can import an AAF file to edit with EDIUS.

3 Note
 f If you import an AAF file to EDIUS, the condition below must be met:

 g The AAF file is output by frame unit
 g The source file and the AAF file are separate (an embedded AAF file is not supported)

1) Click the [Open Project] list button on the timeline.
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2) Click [Import Project] → [AAF].

1 Alternative
 f Click [File] on the menu bar, and click [Import Project] → [AAF].

3) Select an AAF file to import in the [Project Importer (AAF)] dialog box, and click [Open].

2
 f Check [New sequence] to create a new sequence and import an AAF file. If this item is unchecked, the AAF file is imported to the blank 
track of the currently selected sequence. If there is no blank track, a new track will be created.

 f For an audio clip with monaural settings, the audio channels are set as below and the clip will be imported as monaural.
 g A1: channel 1
 g A2: channel 2
 g A3: channel 3
 g A4: channel 4

For an audio clip with monaural setting, the even number tracks on which the clip is placed are sorted to L, the odd number tracks to R.

Importing EDL Files (EDL Import)
You can import an EDL file (Edit Decision List) to perform online edit.

1) Click the [Open Project] list button on the timeline.

album1

2) Click [Import Project] → [EDL].
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1 Alternative
 f Click [File] on the menu bar, and click [Import Project] → [EDL].

3) Select an EDL file to import in the [Project Importer (EDL)] dialog box.

4) Click [Detailed Settings].
 f The [EDL Importer Detailed Settings] dialog box appears.
“[EDL Importer Detailed Settings] Dialog Box” (w page 84)

2
 f Check [New sequence] to create a sequence and import an EDL file.

5) Set each item and click [OK].

6) Click [Open].
 f The EDL file is imported and the [Restore and transfer clip] selected dialog box is displayed. Restore the offline clip.
“Restoring Offline Clips” (w page 90)

2
 f For an audio clip with monaural settings, the audio channels are set as below and the clip will be imported as monaural.

 g A1: channel 1
 g A2: channel 2
 g A3: channel 3
 g A4: channel 4

For an audio clip with monaural setting, the even number tracks on which the clip is placed are sorted to L, the odd number tracks to R.

3 Note
 f Information below cannot be imported from BVE5000/BVE9100.

 g EditMode Filed:ASMBL, ASSY1
 g EditType Filed: other than C, W, and D
 g GPI data line
 g Learn data line

 f Information below cannot be imported from CMX340/CMX3600.
 g EditType Filed: other than C, W, and D

[EDL Importer Detailed Settings] Dialog Box

[EDL Type] Select the EDL type to input.
[Import Format] This setting is available when you select CMX type in [EDL Type].

Select the calculation method of Out point for the source file with a speed specified.
[Mode1]
Add (subtract) the value of source duration multiplied by the speed to the timecode at In point, 
and calculate the timecode at the Out point. Using the timecode at Player In point as reference, 
add for the + direction or subtract for the - direction.
[Mode2]
Use the timecode of Player Out point, not calculating Out point when Player In and Out points 
become the timecodes of source In and Out points.

[Handle black clips as empty clips] When the reel name is BL/BLK/BLACK, handle the clip as a black clip, and handle the black 
clip as an empty clip.

[Overwrite clips that are stacked on 
top of each other in the timeline video 
track]/[Overwrite audio clips that are 
stacked on top of each other in the 
timeline audio track]

If importing a file without checking [New sequence] in the [Open] dialog box, the current clips 
are overwritten when the clips are stacked on the timeline of the 1VA (1V, 1A) track. If this item 
is unchecked, the clips are not overwritten, but the clips are placed on 2VA, 3VA (2V, 3V, 2A, 
3A) tracks. If there is no 2VA, 3VA (2V, 3V, 2A, 3A) tracks, a new track is created.

[Match channels when the channels 
in a transition's "from" side and "to" 
side is different]

If the number of video or audio are determined to be different between the From side and To 
side, the number information of the video and audio on the To side is copied to the From side 
for alignment. This setting is available when you select CMX type in [EDL Type].

[Force reel name as clip name] Uses the reel name as the clip name when importing.
[Export Error Log] Export a file containing error information if an error occurs at import. [Export File Format] and 

[Export Type] can be set. If [All] is selected in [Export Type], the imported contents and error 
location are shown.
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Importing Final Cut Pro XML Files (FCP XML Import)
You can import an XML file exported from Final Cut Pro to edit with EDIUS.

2
 f Bin information loading of Final Cut Pro 7 project files is also supported.
However, bin information loading is limited to clips and sequence clips. Clips in the “Color bar and tone” folder and “Matte” folder, and 
“Blackish” clips cannot be loaded.

 f In Final Cut Pro 7, clips of “Digital color bar (100/0/100/0)” or “Digital color bar (100/0/75/)” in “Color bar signal details” are replaced with 
EDIUS color bar clips of [100/x/100/x Color Bar] or [100/x/75/x Color Bar]. Other color bars are replaced with [SMPTE Color Bar] of 
EDIUS.

 f Color bar tone levels for Final Cut Pro 7 are supported.
 f If clips with colors specified by “Color Matte” and “Plain” of Final Cut Pro 7 are used, they are replaced with color matte clips of EDIUS. 
However, alpha of “Color Matte” and “Plain” of Final Cut Pro 7 is not supported.

3 Note
 f For the Final Cut Pro multi-clip, those selected in the multi-clip are placed to the EDIUS timeline.
 f The following items cannot be restored in EDIUS.

 g Title (text) clip
 g Transition applied to the clip and a blank
 g All transitions other than dissolve (all transitions are replaced with dissolve)
 g Key frame
 g Video filter

In addition, the same sequence clips may be imported as different sequence clips. The sequence clips are imported as the same 
sequence clips only if the sequence IDs are included and the internal tags are empty.

1) Click the [Open Project] list button in the timeline.
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2) Click [Import Project] → [FCP XML].

1 Alternative
 f Click [File] on the menu bar, and click [Import Project] → [FCP XML].

3) Select an XML file in the [Project Importer (FCP XML)] dialog box, and click [Open].
 f The XML file is imported and the [Restore and transfer clip] selected dialog box is displayed. Restore the offline clip.
“Restoring Offline Clips” (w page 90)

Importing P2 PLAYLIST (P2 PLAYLIST Import)
You can import a playlist edited in P2 mobile recorder (AJ-HPM100/AJ-HPM110/AJ-HPM200) to edit with EDIUS.

1) Click the [Open Project] list button on the timeline.
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2) Click [Import Project] → [P2 PLAYLIST].

1 Alternative
 f Click [File] on the menu bar, and click [Import Project] → [P2 PLAYLIST].

3) In the [Project Importer (P2 PLAYLIST)] dialog box, select an XML file in the “EDITLIST” folder, and 
click [Open].

 f The clip will be placed on the timeline.
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2
 f If [New Sequence] is checked, a new sequence is created to import an XML file. The start timecode is set with priority for the imported 
playlist.
If this item is unchecked, the XML is imported to the currently selected sequence. The start timecode is set with priority for the selected 
sequence.

 f If [FileCopy] is checked, the source files are copied to a folder specified by clicking [Browse], and the copied source files are referenced.
If this item is unchecked, the original source will be referenced.

 f The audio clips are placed to A track.

Importing XDCAM Files (XDCAM Import)
An edit list created by the XDCAM HD deck or software accompanied to XDCAM can be imported to and edited with EDIUS.

1) Click the [Open Project] list button on the timeline.
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2) Click [Import Project] → [XDCAM].

1 Alternative
 f Click [File] on the menu bar, and click [Import Project] → [XDCAM].

3) Select an SMI file in the [Project Importer (XDCAM)] dialog box, and click [Open].
 f For an XDCAM disk, select an SMI file in the “Edit” folder.
 f For a PDZ-1 extended clip list, select an SMI file in the “General” folder.
 f If a PDZ-1 extended clip list (consists of a single disk) is written back to the disk, select an SMI file in “General” → “ExtClipList” folder.
 f For PDW-U1 (SAM format), select an SMI file in “EDTR” → “EDITLIST name” folder.
 f For a PDW-U1 (SAM format) extended clip list, select an SMI file in “General” → “ExtClipList” folder.

2
 f Check [New Sequence] to create a sequence and import an SMI file. If this item is unchecked, the SMI is imported to the currently 
selected sequence. The start timecode is the timecode described in the XML file within the same folder where SMI file is saved.

 f If [FileCopy] is checked, the source files are copied to a folder specified by clicking [Browse], and the copied source files are referenced.
If this item is unchecked, the original source will be referenced.

 f The audio clips are placed to A track.
 f The settings to import an XDCAM file can be changed through [Importer/Exporter] in [System Settings] → [XDCAM].
“XDCAM Importer Settings” (w page 108)

3 Note
 f If a paired XML file does not exist in the same folder as the selected SMI file, the file cannot be imported correctly. This XML file 
contains the start timecode of the timeline and TC mode settings (drop/non drop).
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Field Editing a Project
The “field editing function” can be used to ensure that projects move smoothly when, for example, checking out projects edited on a desktop 
PC and editing them in a limited manner on a laptop PC. When a project that has been checked out by field editing is opened, a message is 
displayed to prevent duplicate editing of the project.

Checking Out Projects (Check-out)
Collect the project and source clips referenced by the project in a specified folder on a removable USB storage media. Instead of the original 
source files, proxy files for limited editing also can be checked out.

2
 f From [System Settings] → [Application] → [Proxy], you can set the size of proxy files to be created at the time of checkout.
“[Proxy]” (w page 101)

1) Click [File] on the menu bar, and click [Field Editing] → [Check out].
 f The [Check Out] dialog box appears.
“[Check Out] Dialog Box” (w page 87)

2) Click [Browse], and specify the checkout destination.

3) Set each item and click [OK].

4) Click [Yes].
 f When checkout is completed, the project is closed, and the [Start Project] dialog box appears. [Check out] is displayed in [Status] of 
checked out projects.

2
 f You can check the detailed information of clips transferred by project checkout by the following operation. Right-click a clip on the timeline 
or in the bin, and click [Properties]. You can confirm the directory of the checkout source file and the clip type (proxy/high-resolution) at 
checkout by clicking the [Check out] tab.

[Check Out] Dialog Box

[Checked Out] Click [Browse], and specify the collection point (e.g. removable USB storage media) of the 
project or source clips. Check [Create folder with project name] to create a folder with the 
project name in the destination folder.
You can enter a comment in the [Comments] field.
You can check the amount of free space at the checkout destination and the size of the project 
data for checking out and field editing at [Drive Space] and [Required Space]. The numerical 
value of [Required Space] differs according to the [Check Out Source Files] and [Check Out 
Target] setting.

[Check Out Source Files] [Proxy]
Check this item to collect the proxy at the checkout destination. The checked out project 
references the proxy. A proxy will be automatically generated if there is not proxy.
[HiRes]
Check this item to collect the original source files at the checkout destination. When copying 
only parts currently used on the timeline, set the margin.

[Copy only L clip for stereo clips] Displayed only in the stereoscopic edit mode. Check this item to collect the L side of the 
stereoscopic clip at the checkout destination. When both L and R sides is included in a single 
file, the clips are copied as they are.

[Check Out Target] Select the clips to be collected at the checkout destination. When [Only timeline (Opened 
Sequence)] is selected, only the clips currently used on the timeline of the currently open 
sequence are collected. When [All] is selected, both the clips currently used on the timeline 
and the clips registered to the bin are collected.
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Editing at the Checkout Destination

1) Start up EDIUS, and open the checked out project.
 f The checked out project is displayed as [Checked out] at [Status] in the [Start Project] dialog box.

2) Edit and save the project.

2
 f It is recommended to set automatically run partial transfer so that clips added in editing at the checkout destination are automatically 
transferred to the project folder. Auto-run of partial transfer can be set by [Source] in [User Settings] → [Partial Transfer]. Select [From 
Removable Media and Hard Drive] in [Target Clip], and check the required 2 items in [Auto Transfer].
To execute auto-run of partial transfer, the clip must be displayed on the Player, the In and Out points must be set, and the clip must be 
imported to the timeline or bin by button operation.
“Transferring Only Necessary Part” (w page 185)

 f When only the proxy or source including the proxy has been checked out, the project automatically opens in the proxy mode.
“Switching to the Proxy Mode” (w page 320)

 f Project settings can be changed also in checked out projects.
 f Additional checkouts are not possible at checkout destinations.
 f When the proxy mode is canceled on a project from which only the proxy was checked out, a diagonal line is displayed on the clip on the 
timeline and the clip is displayed as a partial offline clip.

3 Note
 f When only the proxy is checked out for editing, the frame display during trimming and the background during title clip editing appear as 
a checkered pattern.

Returning Checked Out Projects (Check-in)

1) Start up EDIUS, and open the checkout source project.
 f The checkout source project is displayed as [Check out] at [Status] in the [Start Project] dialog box.
 f The [Check Out Status] dialog box appears.

2) Click [Check in].
 f The [Check In] dialog box appears.
“[Check In] Dialog Box” (w page 88)

1 Alternative
 f Open the checkout source project file, and click [Open as read-only] in the [Check Out Status] dialog box. Click [File] on the menu bar, 
and click [Field Editing] → [Check in].

3) Click [OK].

4) Click [Yes].
 f The project opens with editing details reflected.

2
 f The checkout source project cannot be renamed even if a project file with a different name has been checked in.
 f The proxy that was used at the checkout destination is not copied when it is checked in.

5) Save a project.

[Check In] Dialog Box

[Project file] Displays the project file to check in. By default, the checkout destination and project name 
set in the [Check Out] dialog box at the time of checkout are displayed. Any project file can be 
selected by clicking [Browse].
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[Add/Update file] Displays any files updated at the checkout source and files added or updated at the checkout 
destination from checkout onwards in a list. Select from the list how to process additional or 
updated files.
When [Use Original] is selected from the [Processing] list, the files are linked to the source 
files at the checkout source. When [Copy to Project Folder] is selected, the source files at the 
checkout source are copied and linked to the project folder at the checkout source.
File properties can be confirmed by clicking .

Canceling Checkout
You can discard checkout information.

1) Start up EDIUS, and open the checkout source project.
 f The checkout source project is displayed as [Check out] at [Status] in the [Start Project] dialog box.
 f The [Check Out Status] dialog box appears.

2) Click [Undo check out], and click [Yes].
 f The project file opens.

1 Alternative
 f Open the checkout source project file, and click [Open as read-only] in the [Check Out Status] dialog box. Click [File] on the menu bar, 
and click [Field Editing] → [Undo check out] → [Yes].

3 Note
 f When the checkout source project is not saved after checkout is canceled, the file is recognized as the one whose checkout has been 
canceled.
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Restoring Offline Clips

Restoring the Source Link
If a source used in EDIUS is moved/deleted, the link between the source and EDIUS is lost, and the source cannot be referred from the 
clip. Clip that cannot refer to source will become an offline clip that video and audio are not displayed. The following section describes the 
method for supporting restoration of an offline clip.
If there are offline clips on the timeline, an icon to indicate the presence of offline clips and the number of the offline clips are displayed on 
the timeline status bar.

XXXX1

The offline clips on the bin and the timeline are displayed as below, and the video and audio are both muted during the playback.

Example:

Offline clip in the bin

clip_XXXXX

Example:

Offline clip in the timeline

XXXX

XXXX

XXXX

XXXX

Restoring an Offline Clip
Select a restoration method for the offline clips.

1) Click the [Open Project] list button on the timeline.
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2) Click [Restore Offline Clip].
 f The [Restore and transfer clip] selected dialog box appears.
“[Restore and transfer clip] Selected Dialog Box” (w page 91)

1 Alternative
 f Click [File] on the menu bar, and click [Restore Offline Clip].

3 Note
 f Registered clips that are reference AVI files will be marked as offline clips if any part of the source is moved. In such cases, the offline 
clips cannot be restored.
The reference AVI is a file containing only the audio data entity and destination information, developed by Grass Valley with its own 
extension within a range of the specification. It is different from regular AVI files.

 f Files can be captured or restored only when matching the following conditions:
 g Video information exists.
 g The reel name is set.
 g Source file extensions are *.avi, *.m2t, *.mov, or *.mxf.
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[Restore and transfer clip] Selected Dialog Box

[Capture entire clip] The [Batch Capture] dialog box appears. Capture the entire source.
“Capturing and Restoring” (w page 92)

[Capture only the area used in 
timeline]

The [Batch Capture] dialog box appears. Capture only the part used in the timeline. If there are 
multiple offline clips, replace each offline clip with the captured source.
“Capturing and Restoring” (w page 92)

[Find from captured files] Search the source by reel number (Ubit) and timecode (between In and Out points) in already 
captured files.
“Searching File by Reel Number to Restore” (w page 93)

[Open the clip restoration dialog] The [Restore and transfer clip] dialog box appears. Restore the offline clips by reestablishing 
a link to the disconnected source, by retransfer the source that cannot reference a part of the 
clip, or by replacing a camera proxy file with a high-resolution source.
“Re-link and Restoration” (w page 91)

[Close] Click [Close], and click [Yes] to display the operation screen without restoring the offline clip.

Re-link and Restoration
You can search the source from the hard disk drive to re-link.

1) Click [Open the clip restoration dialog] in the [Restore and transfer clip] selected dialog box.
 f The [Restore and Transfer Clips] dialog box appears.
“[Restore and Transfer Clips] Dialog Box” (w page 92)

1 Alternative
 f To restore the clips on the timeline, double-click the offline clip icon on the status bar. In this case, only the offline clips on the timeline are 
displayed in the clip list in the [Restore and Transfer Clips] dialog box.

2) Select the target range of the clip from the [Range] list.

3) Select a clip (or clips) from [Clip list], and select either [Relink (select file)] or [Relink (select folder)] 
from the [Restoration Method] list.

4) Select the source from the [Open] dialog box, and click [Open].
 f Selecting a file to be re-linked in the [Open] dialog box will show the check result of consistency with the original file.
Checking [link only files that perfectly match] will re-link only files that have exactly the same information as the original files.

 f Clips with different frame rates can also be re-linked.
 f If [Relink (select folder)] is clicked in step 3), select a folder in the [Browse For Folder] dialog box and click [OK].

5) Click [OK].

6) Click [Close] in the [Restore and transfer clip] selected dialog box.

1 Alternative
 f Double-click a offline clip on the timeline or in the bin window, and perform operations after step 3).
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[Restore and Transfer Clips] Dialog Box

(1) [Refresh] Restore clips to which the restoration method is set.
(2) [Range] Select the target range of the clips from the list.
(3) Clip list : Offline clips

Clips whose links to the source are disconnected.
: Clips with restored links

Clips whose links to the source are restored.
(4) [Restoration Method] [Relink (select file)]

The [Open] dialog box appears. Select the source to re-link.
[Relink (select folder)]
The [Browse For Folder] dialog box appears. Search the source with the same name in the 
specified folder to re-link.
[Undo transfer]
Re-link the original source prior to the transition to the project folder.
[Capture all]
Click [Start batch capture] to display the [Batch Capture] dialog box to register the information 
of the entire source.
“Importing Sources All Together (Batch Capture)” (w page 166)
[Capture only areas used in timeline]
Click [Start batch capture] to display the [Batch Capture] dialog box to register the clip 
information used in the timeline.
[Do nothing]
Offline clips are not re-linked or captured.

(5) [Link only files that 
match exactly]

Check this item to specify only the files with exactly the same information in the original file to 
be re-linked.

(6) [Ignore file extension] Check this item to include files with different extensions for re-link.
(7) [Start batch capture] This item is enabled when either [Capture all] or [Capture only areas used in timeline] is 

selected from the [Restoration Method] list.
Click this button to display the [Batch Capture] dialog box.

(8) [OK] Restore the offline clips with the specified settings.
(9) [Cancel] Close the dialog box without restoring the offline clips.

2
 f You can change the default setting of [Restoration Method].
“[Restore Offline Clip]” (w page 122)

Capturing and Restoring
If the source of the offline clips does not exist in the hard drive, you can restore the clips by recapturing from the original source (recorded 
tapes).
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1) In the [Restore and transfer clip] selected dialog box, click [Capture entire clip] or [Capture only the 
area used in timeline].

 f The [Batch Capture] dialog box appears.
“Importing Sources All Together (Batch Capture)” (w page 166)

1 Alternative
 f In the [Restore and Transfer Clips] dialog box, select either [Capture all] or [Capture only areas used in timeline] from the [Restoration 
Method] list, and click [OK].

2) Execute the batch capture.

Searching File by Reel Number to Restore
Search the source by reel number (Ubit) and timecode (between In and Out points) in already captured files.

1) Click [Find from captured files] in the [Restore and transfer clip] selected dialog box.
 f The [Restore Offline Clip] dialog box appears.
 f Search a file in a folder where the project is saved. If you cannot find the file, click [Select Folder] and select a folder where the captured 
files are stored, and click [OK].

2) Click [Restore All].
 f To restore selected files only, select a clip from [Find clip list] and click [Restore].

Restoring Clip That Cannot Reference Part of a Clip
The clips will be partial offline clips under the following conditions: when a portion that forms a clip containing a proxy, when the proxy 
created with EDIUS cannot be referenced, when a portion of the partially transferred clip cannot be referenced, or when either L or R side of 
the stereoscopic clip that has the stream of both L and R sides in 2 files.
In EDIUS, you can proceed with “Proxy originated editing” in which you use a proxy source when editing, and replace it with a high-
resolution source before final exporting. A proxy clip used in this proxy originated editing (a proxy clip with reference information in high-
resolution) is a “temporary editing clip”. A temporary editing clip can be easily replaced with a high-resolution clip using the source browser.

Example:

Partial offline clip in the bin

clip_XXXXX

Example:

Temporary editing clip in the bin

clip_XXXXX

Example:

Partial offline clip in the timeline

XXXX

XXXX

If there are partial offline clips or temporary editing clips on the timeline, icons and the total number of the offline clips, partial offline clips, 
and temporary editing clips (or untransferred clips) are displayed on the timeline status bar.
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For P2, if a source file that only has a proxy (XML) is imported from the source browser, it will be recognized as an untransferred clip.

XXXX1

3 Note
 f If offline clips, partial offline clips, and temporary editing clips exist on the timeline when you export the project to a file or tape or when 
consolidating or exporting the project, a message is displayed. Restore the offline clips, partial offline clips, or temporary editing clips. 
Otherwise, they will be exported as offline clips.

Restoring Partial Offline Clips
Restore the partial offline clips by retransfer the missing source or recreating the proxy. If needed, connect the device where the original 
source is stored.
If either the L or R side of the stereoscopic clip cannot be referenced, perform the same restoration operations for offline clips.
“Restoring an Offline Clip” (w page 90)

1) Click the [Open Project] list button on the timeline.

album1

2) Click [Restore Offline Clip].

1 Alternative
 f Click [File] on the menu bar, and click [Restore Offline Clip].

3) Click [Open the clip restoration dialog] in the [Restore and transfer clip] selected dialog box.
 f The [Restore and Transfer Clips] dialog box appears.
“[Restore and Transfer Clips] Dialog Box” (w page 95)

1 Alternative
 f To restore the clips on the timeline only, double-click the offline clip icon on the status bar.

4) Select the target range of the clip from the [Range] list.

5) Select a clip (or clips) from [Clip list], and select a restoration method from the [Restoration Method].

6) Click [OK].
 f The process is executed with the restoration method selected in [Restoration Method].

7) Click [Close] in the [Restore and transfer clip] selected dialog box.
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[Restore and Transfer Clips] Dialog Box

* The screen shown is an example The displayed restoration method varies according to the type of offline clips.

(1) [Refresh] Click this button to refresh the clip list.
Restore clips to which the restoration method is set.

(2) [Range] Select the target range of the clips from the list.
(3) Clip list : Offline clip/Partial offline clip

Clips whose links to the source are disconnected.
: Temporary editing clip

Camera proxy clips that have not been replaced by high-resolution clips.
: Untransferred clip

Clips where high-resolution/proxy streams exist on a camera (or card) and which have not 
been transferred to a local terminal.

: Clips with restored links
Clips whose links to the source are restored.

(4) [HiRes/Proxy] Display the type (high-resolution or proxy) of the offline clips, partial offline clips, and 
temporary editing clips.

(5) [Restoration Method] [Transfer the Missing Area]
Retransfer the missing portion from the device where the source file prior to the partial transfer 
is stored.
[Undo transfer]
Re-link to the source files prior to the partial transfer.
[Create Proxy]
Recreate the proxy from high-resolution.
[Delete proxy]
Delete the proxy information of the clip.
[Relink (select file)]
The [Open] dialog box appears. Select the source to re-link.
[Relink (select folder)]
The [Browse For Folder] dialog box appears. Search the source with the same name in the 
specified folder to re-link.
[Transfer All]
Transfer the whole high-resolution clip, regardless of the used range on the timeline.
[Transfer Only Used Area]
Transfer the untransferred high-resolution clip to the used range on the timeline.
[Capture all]
Restore clips with the batch capture function.
“Importing Sources All Together (Batch Capture)” (w page 166)
[Capture only areas used in timeline]
Restore only the area of the source in use with the batch capture function.
“Importing Sources All Together (Batch Capture)” (w page 166)
[Do nothing]
The offline clips, partial offline clips, and temporary editing clips are not restored.

(6) [OK] Restore the partial offline clips or temporary editing clips with the specified settings.
(7) [Cancel] Close the dialog box without restoring the partial offline clips or temporary editing clips.
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2
 f If [Transfer the Missing Area], [Transfer All], or [Transfer Only Used Area] has been selected as the restoration method, the process is 
registered to the background job. Until the job is completed, the target clips remain partial offline clips or temporary editing clips.

 f If [Create Proxy] has been selected as the restoration method, the proxy creation rendering job is registered to the Render Service. The 
proxy remains offline until the job is completed.

 f If you double-click the icon on the timeline status bar to display the [Restore and Transfer Clips] dialog box, only the offline clips, partial 
offline clips, and temporary editing clips or untransferred clips on the timeline are displayed in [Clip list].

 f You can use [Capture all] and [Capture only areas used in timeline] only when clips to be restored are capture-enabled formats and reel 
names are set to clips.

 f You can change the default setting of [Restoration Method].
“[Restore Offline Clip]” (w page 122)

Restoring Temporary Editing Clips
A temporary editing clip can be easily replaced with a high-resolution clip using the source browser.

1) Import the media recording a high-resolution clip in the source browser.
 f “Source Browser” (w page 174)

2) A message [Hi-res clips that match the proxy-only clips were found.  Do you wish to replace them?] 
appears, then click [Yes].

 f A temporary editing clip is replaced with a high-resolution clip automatically.

1 Alternative
 f To restore the clips on the timeline only, double-click the offline clip icon on the status bar.
“[Restore and Transfer Clips] Dialog Box” (w page 95)
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Chapter 4
Setting
This chapter explains how to change editing operation and screen display settings, register the editing environment, and register external 
devices used for capturing, as well as other operations.
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List of Setting Descriptions

Relationship between Project Settings/Sequence Settings/Device 
Preset
The following diagram illustrates the settings available in each setting and their descriptions:



Chapter 4   Setting — [System Settings]

99

[System Settings]
System settings allow you to manage project presets and profiles, set input/output hardware, set input of sources and input/output of project 
files, and other operations.
If you use the restricted user profile, the system settings cannot be changed.
“Restricted user profile” (w page 128)
The following explains the items that can be set in the system settings.
The settings can be changed even during editing.

[Application]
Set EDIUS operations.

[Color Space]
Set show/hide or sorting order of color space, etc. used on EDIUS.
[Color Space] setting is reflected in the following contents.
 f [Primary Color Correction] dialog box
“[Primary Color Correction] Dialog Box” (w page 350)

 f [Clip Properties] dialog box for clips in bin/source browser
 f Display items in clip view of bin

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Color Space].
 f The [Color Space] screen appears.
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3) Set each item.
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Color Space

Preset List

Import

Export

Duplicate

Delete

Up

Down

Back to default

Color Space

System Settings

Application

(1) [Preset List] Display color space presets in a list.
 f Right-clicking on an item line enables to set items displayed in [Preset List].
 f Pointing the mouse cursor on a preset displays the information on the preset on the tooltip.

[Use]
Switch the show/hide setting of presets.
[Name]
The names and types of presets are displayed. There are the following two types of presets.

: Indicated for system preset color spaces preinstalled on EDIUS. Editing is only allowed for 
preset names, and the presets cannot be deleted.

: Indicated for user preset color spaces added by the user.
 f Setting a preset shows  that allows editing of the preset name.
A system preset color space name that has been edited has “*” in the end of the preset 
name.

 f To restore its original name, click on , leave the text entry field blank, and press [Enter] on 
the keyboard.

[Gamma]*1

Display the preset gamma.
[Gamut]*1

Display the preset gamut.
[Matrix]*1

Display the preset matrix.
[Default Range]*1

Display the preset range.
(2) [Import] Import the setting file (XML format) of [Preset List].
(3) [Export] Export [Preset List] to a setting file (XML format).
(4) [Duplicate] Copy a preset.

 f Select a preset to copy, and click [Duplicate]. A new user preset color space is created with 
the name “Copy - Original preset name”.



Chapter 4   Setting — [System Settings]

101

(5) [Delete] Delete a preset.
 f Select a preset to delete, and click [Delete].
 f System preset color spaces cannot be deleted.

(6) [Up]/[Down] Sort the presets.
 f Selecting a preset from [Preset List] and clicking [Up] or [Down] moves up or down the 
selected preset.

 f Dragging and dropping a preset to move to a destination can also change the sort order.
(7) [Back to default] Restore the default setting.

*1 The setting of a user preset color space can be changed by clicking .
For [Matrix] and [Default Range], when an item except for [Default] is selected, “*” appears in the end of the setting value.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Proxy]
You can select the size of the proxy file that is created when proxy is edited.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Proxy].
 f The [Proxy] screen appears.

3) Set each item.

[Proxy Size] Proxy size can be selected from three types: [Large], [Medium], and [Small].
[Large]
The proxy size is 1920x1080.
[Medium]
The proxy size is 960x540.
[Small]
The proxy size is 480x270.

 f The default proxy size is [Medium].
 f Proxy files created in Version 8.22 or older will be loaded as [Small].

3 Note
 f Proxy file can be created only once. It cannot be re-created with different setting.
 f If the setting has been changed while creating the proxy file, the changed setting will be applied at the time, and the creation of the file 
will be continued.

[Playback]
Set playback operations.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Playback].

3) Set each item.

[Stop Playback at Frame Drop] Stop the playback when playback processing cannot keep up with the playback speed.
[Playback Buffer Size] Specify the size of the buffer used for realtime playback.
[Buffered Frames Before Playback] Set the number of frames buffered when starting playback. When playback stops because it 

cannot keep up with the speed just after playback is started, the situation may be improved by 
increasing the number of frames.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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[Capture]
Set EDIUS capture operations, processing at automatic detection of events, and other operations.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Capture].

3) Set each item.

[Margin] Set the length of the margin added at In and Out points at capture operation.
[Confirm Reel Name Setting after 
Setting Device Preset]

After a device preset is selected in the [Select Input Device] dialog box at a capture operation, 
the dialog box for setting the reel name appears.

[Confirm File Name at Capture] Check and set the file name at a capture operation. If you select [Before Capture], you can set 
the destination and file name before performing capture. If you select [After Capture], you can 
set the destination and file name after capture is finished.

[Load to Player after Capture] Play back the file created after capture automatically.
[Correct Audio Errors Automatically] Correct audio errors automatically at a capture operation.
[Set file names for 2 file Capture] If you create 2 files for the L side (for left eye) and the R side (for right eye) with 2 streams at 

stereoscopic source capture, set the suffix for the file name for L and R sides.
[Automatic Detection of Capture 
Events]

Select the conditions for automatically inserting cuts in files at capture operation. Cut insertion 
conditions are as follows:
 f [At Timecode Break]
 f [When Aspect Ratio Changes]
 f [When Sampling Rate Changes]
 f [When the recorded Time Date Changes]

[When an Event is Detected]
Select how cut positions are processed.
If you select [Divide Files], files are divided at the cut position. If you check [Group Divided 
Files as Sequence], multiple divided files are registered to the bin as a single sequence clip.
If you select [Add Marker], a clip marker is set at the cut position.

[Deck Control after Capture] Select the deck state after capture operation from the list.

2
 f Set voice over margins at [Margin] under [Capture].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Render]
Set the reference of rendering options or the timing to delete rendering files.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Render].

3) Set each item.
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[Render Options] Set the conditions of a rendering option (load area). For example, if you check [Filters] and a 
rendering option is set, when a filter is applied to a clip placed on the timeline, the area of that 
clip changes color to orange. By unchecking [Filters], the area will not change color to orange. 
By default, all items below are checked.
“Color Coding of Time Scale” (w page 298)
[Filters]
Select video filters as the rendering target.
[Transition/CrossFades]
Select transitions and title mixers as the rendering target.
[Key/Transparency]
Select key effect and transparency (when changed from the default) as the rendering target.
[Speed Change]
Select clips that feature any speed adjustments from the default value of 100% as the 
rendering target.
[Contents that are not in the Project Format]
Select clips matching any of the following formats as the rendering target:
 f Frame size different from that in the project
 f Aspect ratio different from that in the project
 f Frame rate different from that in the project
 f Field order different from that in the project
 f Compression format different from format handled by codec specified in the project settings
 f Clip including alpha information

[Render Decisions] A loaded area is determined when the buffer becomes less than the set value in [Buffer Left: 
Fewer than] while playback.
[Buffer Left: Fewer than]
Set the left of buffer value to be referenced for rendering decisions.

[Delete Invalid Rendered Files] Select the timing to delete rendering files.

 f “Rendering Overload Areas of the Entire Sequence” (w page 299)
 f “Rendering Overload Areas between In and Out Points” (w page 300)

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Profile]
Register editing environments as profiles and manage these profiles.
“Editing Environment Management” (w page 125)

[Project Preset]
Create new project presets and manage project presets or project templates.
“Project Preset/Project Template” (w page 69)

[Source Browser]
Set the transfer destination used when importing a file from the source browser.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Source Browser].

3) Set each item.

[File transfer folder] Specify the transfer destination of the file. If [Custom folder] is selected, click [Browse] and 
specify a transfer destination.

[Create folder with date] Check this item to create the date folder in the folder set in [File transfer folder].
[File transfer folder path] Display the path of the transfer destination. “%MediaType%” is the name of the source media to 

be transferred by the source browser.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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[File export]
Make a setting to delete the last frame when exporting a file in 720/60p or 720/50p so that the number of the frames will be even. This 
setting is applied to export and batch export operations.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [File export].

3) Set each item.

[Round off to even frame when 
exporting 60p/50p.]

Check this item to delete the last frame when exporting a file in 60p/50p so that the number of 
the frames will be even.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Check for updates]
If the latest EDIUS is released, the update information for EDIUS is automatically notified at the startup of EDIUS.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Application] tree, and click [Check for updates].

3) Set each item.

[Check for online EDIUS updates.] Check this item to automatically notify of the release of the updated EDIUS at the startup.
“[Update Notification] Dialog Box” (w page 104)

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Update Notification] Dialog Box

[To update, click here.] Click this item to download the updater.
[Do not show this message for 30 
days.]

Check this item not to automatically notify of the release of the updated EDIUS for the next 30 
days.

1 Alternative
 f When an updated EDIUS has been released, the [Update Notification] dialog box can be displayed by starting up EDIUS, and then 
clicking [Help] → [Check for updates] on the menu bar.
If the [Update Notification] dialog box is not displayed, you are using the updated EDIUS.

[Hardware]
You can register external devices used for capturing, or set external devices that are used for preview during editing.
“Setting an External Device” (w page 130)

[Importer/Exporter]
Make the settings for import and export.
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[AVCHD]
Set faster seeking of AVCHD files.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [AVCHD].

3) Set each item.

[Use Accel. Seek] Set faster seeking of AVCHD files. To speed up seeking, check this item first, and then check 
the following items if necessary.
[Create Seek Information in Background]
Collect the time stamp information of AVCHD files at idling to speed up the seek.
[Save Seek Information to File]
Save the seek information as a reusable file.

[Get timecode from Picture Timing 
SEI]

Check this item to acquire the timecode information from Picture Timing SEI.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Still Image]
Make the settings for exporting still images.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [Still Image].

3) Set each item.

[Capture Field] Though highest quality images are [Frame], rapid-moving images sometimes are blurred into 
vertical comb-like stripes. If this happens, select [Upper Field] or [Lower Field].
To output in a display method set in the pause field, select [Follow pause field setting].
“Switching the Screen Display when Stopping Playback” (w page 153)

[Filtering] Compensate for deteriorated image quality when [Upper Field] or [Lower Field] is selected 
at [Capture Field]. [Motion Only] is suitable for partially blurred images, and [Full Screen] is 
suitable for completely blurred images.

[Adjust Aspect] The aspect ratio differs for moving images handled in editing and still images handled on the 
PC. Check this item to adjust the aspect ratio when displaying on a PC screen.

[File Type] Set the default file format for saving still images.

 f “Exporting Still Image Clips from the Timeline” (w page 302)
 f “Still Image Format” (w page 441)

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[RED]

GPU Settings

By utilizing GPU, you can decode RED source data in high-speed.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [RED] → [GPU].
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3) Set each item.

[GPU Mode] Selects the GPU process method.
GPU list Shows available GPU when [OpenCL] or [CUDA] is selected for [GPU Mode]. Check GPU to be 

used.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

RED Browser Settings

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [RED] → [Browser].

3) Set each item.

[Source Folders] This is the list of references that is displayed in the source browser folder view.
RED sources can be handled as clips on the source browser by copying them to the hard disk 
with the folder structure in the device held intact.
Click [Add] to set the reference folder. To delete a reference folder that has been set, select the 
folder and click [Delete].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Importer]

Set an image quality for playback of sources in RED format.

1) Click [Settings] on the menu bar, and click [System Settings].
 f The [System Settings] dialog box appears.

2) Click the [Importer/Exporter] tree, and click [RED].

3) Set each item.

[Preview Quality] Set the playback image quality.
Select [1/1] to retain the source resolution.
Select [1/2], [1/4], [1/8], or [1/16] to reduce the image quality to 1/2, 1/4, 1/8, or 1/16 of the 
source horizontal resolution respectively.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[MPEG]
Set faster seeking of MPEG files.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [MPEG].

3) Set each item.
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[Use Accel. Seek] Set faster seeking of MPEG files. To speed up seeking, check this item first, and then check 
the following items if necessary.
[Create Seek Information in Background]
Collect the time stamp information of MPEG files at idling to speed up the seek.
[Save Seek Information to File]
Save the seek information as a reusable file.

[A/V Synchronization Using PTS] Check this item to use the PTS (time stamp information) for synchronization of audio and video.
[Get Timecode from GOP Header] Some MPEG files may have timecode information in their header. Check this item to use 

timecode information.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[MXF]

MXF Decoder Settings

You can set the layer and downsample coefficient to be decoded when importing MXF files in the JPEG2000 format.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [MXF] → [Decoder].

3) Set each item.

[Quality] Specify a layer to decode.
[High]
Decode all layers.
[Middle]
Decode half of the layers.
[Low]
Decode single layer.

[Downsampling Ratio] Specify a downsample (scaling) coefficient at decoding.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[P2]

P2 Browser Settings

Set the reference folder when source files in P2 devices are imported from the source browser window.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [P2] → [Browser].

3) Set each item.

[Source Folders] This is the list of references that is displayed in the source browser folder view.
P2 sources can be handled as clips by the source browser by copying them to the hard disk 
with the folder structure in the device held intact.
Click [Add] to set the reference folder. To delete a reference folder that has been set, select the 
folder and click [Delete].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].



Chapter 4   Setting — [System Settings]

108

[Removable Media]
Set the reference folder when source files in removable media are imported from the source browser window.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [Removable Media].

3) Set each item.

[Source Folders] This is the list of references that is displayed in the source browser folder view.
Source files can be handled as clips by the source browser by copying them to the local disk 
(hard disk) with the folder structure in the media held intact.
Click [Add] to set the reference folder. To delete a reference folder that has been set, select the 
folder and click [Delete].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[XDCAM EX]
Set the reference folder when source files in XDCAM EX devices are imported from the source browser window.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [XDCAM EX].

3) Set each item.

[Source Folders] This is the list of references that is displayed in the source browser folder view.
Source files can be handled as clips by the source browser by copying them to the local disk 
(hard disk) with the folder structure in the device held intact.
Click [Add] to set the reference folder. To delete a reference folder that has been set, select the 
folder and click [Delete].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[XDCAM]

XDCAM Importer Settings

Set whether to use high-resolution audio to edit proxy.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [XDCAM] → [Importer].

3) Set each item.

[When proxy is edited, high-resolution 
audio is used if available.(VFAM drive 
only)]

For data on VFAM drive, use high-resolution audio data to edit proxy.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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XDCAM Browser Settings

Set the clip type, clip name and other settings when clips are imported before importing XDCAM sources.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [XDCAM] → [Browser].

3) Set each item.

[Download] Select the data (proxy/high-resolution) to be downloaded from the source browser.
“Importing from XDCAM Devices” (w page 179)
[When Transfer to Bin]
Select the data to be downloaded when transferring to the bin. Select [All] to download both 
high-resolution and proxy.
[When Add to Timeline]
Select the data to be downloaded when placing clips on the timeline. Select [All] to download 
both high-resolution and proxy.

[Source Folders] This is the list of references that is displayed in the source browser folder view.
XDCAM sources can be handled as clips by the source browser by copying them to the hard 
disk with the folder structure in the device held intact.
Click [Add] to set the reference folder. To delete a reference folder that has been set, select the 
folder and click [Delete].

[Thumbnail] Set whether to display thumbnails in the clip list in the source browser.
[Show Thumbnails when Connecting to XDCAM Drive]
Display thumbnails when making a connection to the XDCAM device.

[Register Name] Select the name to register to the bin from [Clip Title] or [Clip Name].

2
 f Even when [Thumbnail] is unchecked, thumbnails are sometimes displayed for clips, etc. that have been displayed as thumbnails even 
once.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[XF]
Set the reference folder when source files in XF devices are imported from the source browser window.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [XF].

3) Set each item.

[Source Folders] This is the list of references that is displayed in the source browser folder view.
XF sources can be handled as clips by the source browser by copying them to the hard disk 
with the folder structure in the device held intact.
Click [Add] to set the reference folder. To delete a reference folder that has been set, select the 
folder and click [Delete].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Mync]
Set the details of Mync displayed on the source browser.

1) Click [Settings] on the menu bar, and click [System Settings].
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2) Click the [Importer/Exporter] tree, and click [Mync].

3) Set each item.

[Folder] [Show "All Clips"]
Check this item to display the [All Clips] folder of Mync on the source browser.
[Show "Favorites"]
Check this item to display the [Favorites] folder of Mync on the source browser.

[Thumbnail] [Show hidden clips]
Check this item to display the clips hidden on Mync as thumbnails on the source browser.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Cinema RAW]

GPU Settings

By utilizing GPU, you can decode the data in Cinema RAW or Cinema RAW Light format with high-speed.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [Cinema RAW] → [GPU].
 f Available GPU appears.

3) Check GPU to be used.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

Cinema RAW Browser Settings

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [Cinema RAW] → [Browser].

3) Set each item.

[Source Folders] This is the list of references that is displayed in the source browser folder view.
Cinema RAW or Cinema RAW Light sources can be handled as clips in the source browser by 
copying them to the hard disk with the folder structure in the device held intact.
Click [Add] to set the reference folder. To delete a reference folder that has been set, select the 
folder and click [Delete].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[HEVC]
By utilizing hardware supporting the Quick Sync Video, you can decode the data with the video compression standards HEVC (H.265) with 
high-speed.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [HEVC].
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3) Set each item.

[Use Hardware decoder] Check this item to use hardware decoding such as Quick Sync Video.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Sony RAW]

GPU Settings

By utilizing GPU, you can decode the data in Sony RAW format with high-speed.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [Sony RAW] → [GPU].
 f Available GPU appears.

3) Check GPU to be used.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

Sony RAW Browser Settings

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [Sony RAW] → [Browser].

3) Set each item.

[Source Folders] This is the list of references that is displayed in the source browser folder view.
Sony RAW sources can be handled as clips in the source browser by copying them to the hard 
disk with the folder structure in the device held intact.
Click [Add] to set the reference folder. To delete a reference folder that has been set, select the 
folder and click [Delete].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[ProRes RAW]

GPU Settings

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Importer/Exporter] tree, and click [ProRes RAW] → [GPU].
 f Available GPU appears.

3) Check GPU to be used.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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3 Note
 f To decode ProRes RAW data, a compatible GPU is required.
 f When ProRes RAW data is imported, its color space will be converted to that of HLG.

[Effects]
Set up effect plug-ins.

[GPUfx]
Make settings for GPUfx.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Effects] tree, and click [GPUfx].

3) Set each item.

[Multisample] Set antialiasing (processing to make jaggies less conspicuous) when GPUfx is applied.
[Multisample Type]
Select an available multisample type.
[Quality Level]
Set the quality level of the type selected at [Multisample Type].
Selectable items differ according to the type of GPU.

[Render Quality] Set the image quality at editing of parts where GPUfx is applied.
When [Full Quality] is selected, GPU is used and displayed at its maximum.
When [Draft Quality] is selected, the load at editing can be reduced though this results in lower 
quality.

[GPU] Select the graphic card to use in [Graphics Card].
GPU performance Displays the GPU of your PC.

“GPUfx Transition Operating Environment” (w page 112)

3 Note
 f GPUfx cannot be used if video memory on your PC is smaller than 256 MB. The [GPU] folder also will not be displayed on the [Effect] 
palette.

 f Editing is possible at HD size even in environments where only the SD size can be used. In this case, GPUfx transition becomes 
offline display.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

GPUfx Transition Operating Environment

To use GPUfx transition, the following conditions are required:
 f Display capability of 1024x768 pixels 32-bit or higher
 f Direct3D 9.0c or later
 f PixelShader3.0 or higher
 f For details on the capacity of video memory, refer to “Memory”.
“Memory” (w page 25)

[VST Plug-in Bridge]
In EDIUS, as well as plug-ins by third parties that support EDIUS, other plug-ins that support VST can be added using the VST plug-in 
bridge function.
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3 Note
 f Not all VST plug-in operations are guaranteed.
 f Only 64-bit VST plug-ins are supported. If EDIUS has been upgraded from an older version, add a 64-bit VST plug-in.

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Effects] tree, and click [VST Plug-in Bridge].

3) Set each item.

[Add] Specify the folder containing the VST plug-in to add to [Add VST Plug-ins]. Restart EDIUS after 
registering the folder.

[Delete] Delete folders from [Add VST Plug-ins].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

VST Plug-in Registration

Save the DLL file of the VST plug-in in any folder on your PC.

1) Click [Add] at [VST Plug-in Bridge].

2) In the [Browse For Folder] dialog box, select the folder containing the VST plug-in and click [OK].
 f The folder is registered, and is displayed at [Add VST Plug-ins].

3) Click [OK], and restart EDIUS.
 f The VST folder is registered to [AudioFilters] on the [Effect] palette.
You can select VST plug-ins from the VST folder.

 f When new DLL files for VST plug-ins have been added to the folder registered in step 2), you do not need to register the folder again.
 f To delete a registered folder, select a folder to be deleted in step 1), and click [Delete].

1 Alternative
 f Directly copy the DLL file of VST to the folder of “EDIUS X” → “PlugIn” → “VST” on the hard disk where EDIUS is installed.
Normally, the “EDIUS X” folder is located in “C drive” → “Program Files” → “Grass Valley”.

[Color Correction]

[Primary Color Correction]

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Effects] tree, and click [Color Correction] → [Primary Color Correction].

3) Set each item.

[GPU] Available GPU appears. Check GPU to be used.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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[Input Controller]

[Fader]/[Jog Device]
Assign ports to use the option fader controller and jog controller.
The following products are also supported in addition to the option products:
 f Behringer fader controller “BCF2000”
 f HDWS/REXCEED series option “MKB-88 for EDIUS”

2
 f Assign keys to controller buttons in the user settings.
“[Input Controller]” (w page 123)

1) Click [Settings] on the menu bar, and click [System Settings].

2) Click the [Input Controller] tree, and click [Fader] or [Jog Device].

3) Set each item.

[Device] Select the controller to use.
[Port] Select the port to assign to the controller. After selecting a port, click [Reconnect].

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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[User Settings]
Change how clips are handled on the timeline, or change the user editing environment, for example, by customizing screens or buttons.
Both restricted users and administrator users can change and save settings in profiles from any user profile.
The following explains the items that can be set in the user settings.
The settings can be changed even during editing.

[Application]
Set EDIUS operations.

[Timeline]
Set operation or display on timeline.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Application] tree, and click [Timeline].

3) Set each item.

[Extend Clips when Applying 
Transition/Cross Fade]

When a clip transition/audio cross fade has been set to the clip on the timeline, right and left 
clips extend and overlap with each other. The total length remains unchanged.
“Extend/Fix mode” (w page 227)

[Insert Default Crossfade in 
Transition]

When a transition has been set to a video clip on a VA track, the default audio cross fade of the 
same length is simultaneously added to the audio clip at the same position.
“Changing Default Effects” (w page 366)

[Insert Default Transition in 
Crossfade]

When a cross fade has been set to an audio clip on a VA track, the default transition of the 
same length is simultaneously added to the video clip at the same position.
“Changing Default Effects” (w page 366)

[Set the Cut Point of Transition/Cross 
Fade to Front when at Middle of a 
Frame]

Set the cut points of clip transitions or audio cross fades to forward. For example, when the 
transition for 7 frames has been set, the cut points are set between the third and fourth frames.

3 4

[Hold the Next Clip when Trimming a 
Clip (except at ripple trim)]

Disable extension of clips across the edge of the clips on the left and right when trimming a clip 
with ripple mode off.

[Show Tool Tip During the Trim] Display timecode information on the tooltip while dragging to trim the cut point of clips.
[Reset Pan Settings when Audio Clips 
are Moved to Other Tracks]

When an audio clip has been moved or copied to another track, the pan setting is reset aligned 
with the destination track. For example, when a clip on the 1A track has been moved to the 
2A track, the pan that was set on the 1A track is reset on the 2A track with the L and R sides 
inverted.

[Select the Left Clip when Cutting a 
Clip]

Set which one of the previous and next clips will be selected when clip cutting has been 
performed.

[Include the Preview Frame in the Out 
Marker]

When an Out point is set on a clip or timeline, the frame displayed in the preview window is to 
be included in the range of In and Out points.

[Snap Event] Enable the snap function.
Check the event to be used as the snap point. When [Snap to Events Inside the Selected Area] 
is checked, all edit points of the clip in the selection area are snapped to.

[Default] Change the default setting for the editing mode when creating a new project file.
“Switching Mode when Placing/Moving Clips” (w page 225)

[Waveform] Set the display method for the waveform of the timeline to either [Log (dB)] or [Linear (%)].
[Clip Timecode] Display the checked timecode on the clip.
[Clip Thumbnail] Display the thumbnails of In/Out points at the clip edge on the timeline. Select [All] to display 

thumbnails in succession. To hide thumbnails, uncheck this item.
[Alt] + [H]

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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[Match Frame]
Set the search direction or track.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Application] tree, and click [Match Frame].

3) Set each item.

[Search Direction] Select the direction for searching clips when [Match Frame (Player to Recorder)] is clicked. On 
the end of the search, it restarts the search from the beginning.

[Target Tracks] Specify the track to be searched. Each track can be specified by selecting [Choose Tracks] or 
[Selected Tracks].

[Transition] When you execute a match frame at the point where a transition is set, set whether to use a 
front side clip or back side clip.

 f “Match Frame” (w page 296)

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Background Job]
Set background processing during playback.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Application] tree, and click [Background Job].

3) Set each item.

[Default Settings for Background Job] [Pause Background Jobs During Playback]
Check this item to pause the execution of the job when the Player or timeline is played back 
during execution of a background job.

3 Note
 f Copying is paused depending on settings even if multiple drives are connected and the drive that is copying is different from the drive 
that is playing back.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Proxy Mode]
Set operations in the proxy mode.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Application] tree, and click [Proxy Mode].

3) Set each item.

[Proxy Mode] [When there is No Proxy, Use HiRes]
Check this item to use high-resolution when there are no proxies in the clip.
[Automatically Generate Proxy]
Check this item to register the rendering job for proxy creation to the Render Service and 
create a proxy automatically in the background if no proxy is found when the proxy mode is set.
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4) Click [OK].
 f You can continue to set other items by clicking [Apply].

3 Note
 f When both [When there is No Proxy, Use HiRes] and [Automatically Generate Proxy] are unchecked, operation is as follows:

 g When the proxy mode is set, clips without a proxy become offline clips.
 g When a project file that has been checked out only with its proxies using the field editing function of project is opened on a PC that 
does not have EDIUS license, all clips become offline clips.

[Project file]
Set project file save destinations, backup/auto save, and other settings.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Application] tree, and click [Project file].

3) Set each item.

[Project File] [Project File Folder]
Change the folder currently selected as the save destination for project files. Select the folder 
from the [Browse For Folder] dialog box displayed by clicking [Browse].
[File Name]
Change the default project file name that is given when a new project is created. To rename the 
file, enter a new name in the text box.

[Recent Project] [Show the MRU List]
Display the list of history files from the [Recent Project] list in the [Start Project] dialog box, 
or by clicking the [Open Project] list button, or by clicking [File] on the menu bar → [Recent 
Project]. Set the number of history files to display by [Number of Files].

[Backup] [Destination]
Check this item to automatically create a backup file.
When [Project Folder] is checked, a backup file is saved in “Project” → “Backup” in the project 
folder.
When [Select a Folder] is checked and [Browse] is clicked, another save destination can 
also be specified. In this case, the backup file will be saved in “specified save destination” → 
“project name” → “Backup”.
[Number of Files]
Set the maximum number of backup files that are created.

[Auto Save] [Destination]
Check this item to automatically save project files.
Check [Project Folder] to save an auto save file in “Project” → “AutoSave” in the project folder.
When [Select a Folder] is checked and [Browse] is clicked, another save destination can 
also be specified. In this case, the backup file will be saved in “specified save destination” → 
“project name” → “AutoSave”.
[Number of Files]
Set the maximum number of auto save files that are created.
[Interval]
Specify the time interval for executing auto-save.
[Delete All Auto Save Files when the Project File is Saved.]
Check this item to delete the auto save file after the project file is saved.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Other]
Set how to display the history file or set existing titlers.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Application] tree, and click [Other].
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3) Set each item.

[Recent clip] [Show the Recently Used List]
Click [File] on the menu bar → [Recent clip] to display the list of history clips. Set the number of 
history clips to display by [Number of Files].
[Show Thumbnail in the MRU List]
Click [File] on the menu bar → [Recent clip] to display thumbnails. To display thumbnails, select 
the size from [Large] or [Small].

[Save Window Positions] Reproduce the last window and palette positions at the next start-up.
[Show Tooltip] Displays the tooltip when the mouse cursor is moved over effect names.
[Create Waveform cache when 
registering clip]

Check this item to create waveform cache (waveform representation of audio) when registering 
a clip.

[Create waveform cache files in 
Project folder (for files in removable 
or network drives)]

Check this item to copy wave form cache (waveform representation of audio) on the removable 
drive or network drive to the project folder.

[Set anchor setting to ON when 
adding a new sequence marker.]

Check this item to enable the anchor setting when adding sequence markers.
“Sync-Lock Setting of Sequence Marker” (w page 287)

[Player Format] Select the format ([Source Format]/[Timeline Format]) for the Player to be used in file playback. 
On HD video monitors, SD signals may not be displayed.

[Default Titler] Select the titler (software for creating titles) that is started up when [Create Title] for the bin or 
timeline is clicked.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Preview]
Set up display of the preview window.

[Playback]
Set the preliminary operation time during playback or playback operation.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Preview] tree, and click [Playback].

3) Set each item.

[Preroll] Set preliminary operation (preroll), for example, when playing back near the timeline cursor or 
when starting recording on a voice recorder.
“Playing Back the Area around the Timeline Cursor” (w page 295)
“Addition of Speech with Voice Over” (w page 424)

[Continue Playback when Editing]/
[Continue Playback when Adding to 
the Timeline from Player]/[Continue 
Playback when Trimming Clip]

Continue playback even when each editing operation is executed during timeline playback.

[Show Correct Frame when 
Scrubbing]

Display the image of the specified frame at all times even while scrubbing (dragging the 
timeline cursor with the mouse). When this item is unchecked, some of the frame images are 
displayed skipped. This setting is effective when scrubbing MPEG files or Windows Media 
Video files.

[Combine Filter Layers and Track 
Layers (for effect settings)]

Check this item to display composite clips with effects when previewing in the effect setting 
dialog box. For example, if this item is checked, the composite image of 1V and 2V video will 
be displayed when you place clips in the 1V and 2V tracks and open the setting dialog box for 
the video filter that is applied to the 1V track. If this item is unchecked, only the image of the 1V 
track is displayed.
“Setting Effects” (w page 341)

[Output Timecode] Select the timecode that is output when outputting files or tapes.
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[Source Timecode Priority] When the source timecode is output or displayed, set the track to display the timecode for from 
the tracks that have clips with timecode information placed on them, including T tracks.
[Upper Track]

[Lower Track]

[Ancillary data priority] When exporting ancillary data (except for closed caption), set a track to export among the 
tracks on which clips with ancillary information have been placed (including T track).

3 Note
 f Even when [Lower Track] is selected in [Source Timecode Priority], the source timecode of the lower track is not displayed if the 
transparency of the upper track is not set (i.e. transparency is 100%).

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Monitor]
Set the display content in full screen view on the monitor or in stereoscopic edit mode.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Preview] tree, and click [Monitor].

3) Set each item.
 f Once the display content of each monitor is set, no further setting is needed from the next time.

[No.] Enter the monitor number. Monitor numbers from “2” onwards are external monitors.
[Full Screen Preview Contents] Displays content of the full screen view.

Click the list to display a menu and change display content for each monitor.
[No full screen preview]
Disable the full screen view.
[Player/Multicam Source]
Display the Player screen in full screen view. In the multicam mode, the videos of each track 
with camera assigned are displayed in full screen view.
[Recorder/Selected Camera]
Display the Recorder screen in full screen view. In the multicam mode, the video of the 
selected camera is displayed in full screen view.
[Auto]
Display the same screen as video output in full screen view.

[Stereoscopic flip horizontal] Check this item to display video with the L side (for left eye) and R side (for right eye) swapped.
[Using NVIDIA 3D VISION/Intel InTru 
3D]

If your system supports NVIDIA 3D VISION or Intel Intru 3D, check this item to enable the 
stereoscopic view ([L/R Dual Stream]) using NVIDIA 3D VISION or Intel Intru 3D on the 
primary monitor.

[Monitor Check] Click this item to display the monitor number on the respective monitor.

3 Note
 f NVIDIA 3D VISION or Intel Intru 3D can be used only in D3D full screen mode.
It takes a while to display the stereoscopic video on the monitor.

 f 3D VISION is applied only to the primary monitor.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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[On Screen Display]
Set display of the timecode and level meter on the status area.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Preview] tree, and click [On Screen Display].

3) Set each item.

[Show Normal Edit]/[Show Trim]/
[Show Export]

Check the timecodes or information to display at each operation.

[View] [Position]
Click the display position inside the monitor on the status bar to select the position.
[Size]
Select the font size of the status bar.
[Background]
Check this item to display the background on the status bar display area.

[Select Source Information] For captured clips, display information such as recording date. Select the information to display 
from the list.

[Show Level Meter] Switch the show/hide setting for the level meter. Click [Back to default] to return to the default 
settings.
[Color and Threshold]
Set the color and threshold value of the level meter. Click a color sample to open the [Color 
Select] dialog box.
[Invert Meter at Peak]
Select whether to invert the level meter when it peaks.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

2
 f The source timecodes of muted tracks are not displayed.

[Overlay]
Set the screen refresh rate, zebra preview (warning indication for brightness level) and display of the safe area.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Preview] tree, and click [Overlay].

3) Set each item.

[Update Frequency] Set the refresh rate for the video preview screen. When displaying interlaced images, 
movement of subjects may be smoothed and accidents (such as reversed field orders) can then 
be checked visually by refreshing the screen at the field rate (twice as fast as the frame rate). 
(There is no difference between both settings when displaying progressive images.)
[Field]
For example, in the case of 29.97 fps frame rate, the screen is refreshed 59.94 times per 
second.
[Frame]
For example, in the case of 29.97 fps frame rate, the screen is refreshed 29.97 times per 
second.

[Zebra Preview] A striped pattern is displayed at relevant parts of the screen when the brightness level set at 
this item is exceeded.
[Over]
Set the upper limit of the brightness level. Select [Color] of the stripe pattern that is displayed 
when the upper limit of the brightness level is exceeded.
[Under]
Set the lower limit of the brightness level. Select [Color] of the stripe pattern that is displayed 
when the lower limit of the brightness level is exceeded or brightness falls to 0 IRE or below.
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[Show Safe Area] Display the safe area on the Player and Recorder.
Switch the show/hide setting for [Action Safe] and [Title Safe]. The action safe area can be set 
as desired.
[Guide Lines for 16:9 Monitor]
Select the guideline to display when the frame aspect ratio of the video is 16:9. When [Darken 
the Outside] is checked, the outside of the guideline is displayed darker.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Source]
Set operations when capturing sources.

[Duration]
Set the duration when still image clips or title clips, for example, are placed.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Source] tree, and click [Duration].

3) Set each item.

[Still Image] Set the default duration when placing still image clips.
[Add between In/Out]
Check this item to place color bars, color mattes and title clips for focus tracks (other than title 
tracks) between In and Out points on the timeline. Note, however, that this setting is not applied 
when those are placed by dragging and dropping.

[Title] Set the default duration when placing title clips.
[Automatically Add Title Mixer]
Check this item to add the default title mixer automatically when the title is inserted into the 
track.
[Add between In/Out]
Check this item to place color bars, color mattes and title clips for focus tracks (title tracks only) 
between In and Out points on the timeline. Note, however, that this setting is not applied when 
those are placed by dragging and dropping.

[V-mute] Set the default duration for V-mute. The V-mute function eliminates audio in individual frame 
units, and is ideal for deleting small audio noise.

[Rubber Band Point] Set how many frames inside the original two rubber band points the additional rubber band 
points will be added when the mouse is dragged between two rubber band points with [Alt] on 
the keyboard held down.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Automatic Correction]
Set whether to adjust the frame rate when importing sources.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Source] tree, and click [Automatic Correction].

3) Set each item.
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[Adjust Frame Rate when Loading 
Clip]

Automatically adjust the frame rate of clips when importing the clips to bin (or timeline). 
Playback no longer requires frame rate conversion, reducing the load on playback operation. 
The frame rate is adjusted only when the project settings and the clip have the following 
pairing:
 f 29.97 : 30.00
 f 59.94 : 60.00
 f 23.976 : 24.00

[Color Range for RGB Clip]/[Color 
Range for YCbCr Clip]

Select which kind of color expression range is assumed for RGB color space sources and 
YCbCr color space sources.
When [Super White] is selected, RGB values (16, 16, 16) and RGB values (235, 235, 235) 
are handled as sources corresponding to 0 IRE black and 100 IRE white, respectively. When 
[White] is selected, RGB values (0, 0, 0) and RGB values (255, 255, 255) are handled as 
sources corresponding to 0 IRE black and 100 IRE white, respectively.

[Normalize] Set the sampling time used for calculating normalized values.
[Subclip] Set the margins to add when creating subclips.

2
 f The frame rate of the clips can be changed in the [Clip Properties] dialog box for those clips.
“Correcting Properties” (w page 202)

 f The default color expression range set at [Color Range for RGB Clip] or [Color Range for YCbCr Clip] can be changed according to the 
source.
“Correcting Properties” (w page 202)

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Restore Offline Clip]
Set restoration of offline clips.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Source] tree, and click [Restore Offline Clip].

3) Set each item.

[Margin when restoring from batch 
capture]

When capturing only necessary areas (parts used in the timeline), set the margin to use for 
optimization (combining of capture areas). When multiple offline clips are placed in closer 
position than the docking margin time, they are combined into 1 clip (i.e optimized).

[Restore Default] Set the default displayed restoration method for [Restoration Method] in the [Restore and 
Transfer Clips] dialog box when opening project files and importing EDL.
[Can be Transferred :]
Select from [Transfer All], [Transfer Only Used Area], or [Do nothing].
[No file information :]
Select from [Capture all], [Capture only areas used in timeline], or [Do nothing].
[Can be Captured]
Select from [Capture all], [Capture only areas used in timeline], or [Do nothing].
“Restoring Offline Clips” (w page 90)

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Partial Transfer]
Set partial transfer.
“Automatic Partial Transfer at Addition to the Timeline/Registration to the Bin” (w page 185)
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[Input Controller]

Fader/Jog Controller
Assign keys to controller buttons when using the option fader controller and jog controller.

3 Note
 f When you set Behringer BCF2000 for this first, a message will appear to notify you that the preset must be installed. Select the preset 
No. to be installed from the [Preset No.] list, and click [Next]. Click [Start] to start the installation.
This operation is needed only once and need not be performed from the next time onwards.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Input Controller] tree, and click the fader controller or jog controller to be used.

3) Set each item.
Example:

For [MKB-88 for EDIUS]

Controller display [Control] tab
Displays an overview of the controller. Buttons assigned an operation are displayed in yellow. If 
you click a button to assign an operation to, the [Select Operation] dialog box appears.
[List] tab
Displays the buttons, assigned operations, and repeat enable/disable setting in a list. Click 
the list and [Assign] to open the [Select Operation] dialog box. Click [Not Assign] to cancel 
operation assignments.
“[Select Operation] Dialog Box” (w page 123)

[Import]/[Export] Import and export controller settings.
[Back to default] Return settings to their defaults.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

[Select Operation] Dialog Box

[Category] Select operation categories from the list to narrow down the items.
[Filter] Enter a keyword to narrow down the items.
Operation list Displays operations available for assignment. You can also assign operations by dragging 

operations and dropping onto the buttons in the [Control] tab or the list in the [List] tab.
[Use Key Repeat] Check this item to repeatedly perform an operation when a key is held down.
[Find Short Cut] Click this item and press any key on the keyboard to select the shortcut operation assigned to 

the key.
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How to Use the Behringer BCF2000

(1)

(2)
(3)

(4)

(5)

(6)

(1) Encoder knobs Encoder knobs can be used as buttons. Select the operation that is performed when a button 
is pressed by the encode selection buttons. No functions are assigned to the rotation direction 
of the encoder knobs.

(2) Upper buttons These buttons function as the SELECT button for selecting the learning mode.
(3) Lower buttons These buttons are used for emulating touch operations. The touch sensor part for the fader is 

emulated. Press a button to set a break state, and release the button to set a release state.
(4) Encode selection 

buttons
Upper left: SELECT
Upper right: AUX
Lower left: SOLO
Lower right: MUTE

(5) Preset selection 
buttons

Select a preset No. To use this function from EDIUS, presets must be installed.

(6) Function buttons These buttons can be customized with key assignments.
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Editing Environment Management

Switching an Editing Environment with Profile
You can register editing environment including window layout and user settings as a profiles, and switch them for use.

Registering Profiles
If you register profiles in advance, you can switch the following settings for each individual profile:
 f Window layout
 f Preview window display in stereoscopic edit mode
 f User settings*

 f The state of the following check boxes in the [Open] dialog box that is displayed when clips are imported to the bin
 g [Transfer to Project folder]
 g [Detect captions file]

 f Default effect and default duration settings of transitions, audio cross fades and title mixers
 f States of the [Import Bin]/[Copy clips in project folder]/[Copy rendered files] checkboxes in the [Import Sequence] dialog box
 f Settings in the [Layouter] dialog box that is used for adjusting the position of title clips
 f Customized [Effect] palettes

* Settings made at [Number of Files] of [Recent Project] in [Project file] are not included in profiles.
Note, however, that the following settings and information are not included in profiles:
 f Project presets
 f Exporter preset

1) Click [Settings] on the menu bar, and click [System Settings].

3 Note
 f If you use the restricted user profile, the system settings cannot be changed.
“Restricted user profile” (w page 128)

2) Click the [Application] tree, and click [Profile].
 f The [Profile] screen appears.
“[Profile] Screen” (w page 125)

3) Click [New Profile].
 f The [Profile] dialog box appears.
“[Profile] Dialog Box” (w page 126)

2
 f Profiles can also be set as read-only or for restricted user in the [Start Project] dialog box. To do this, select and right-click the profile in 
the [Start Project] dialog box, and click [Read only] or [Restricted User].
“[Start Project] Dialog Box” (w page 53)

3 Note
 f Items cannot be unchecked while the default icon folder is displayed even by clicking the [Default Icon Folder] checkbox in the [Select 
Icon] dialog box. The display returns to the default icon folder display by clicking [...] and checking while a different folder is displayed.

4) Set each item.

5) Click [OK].
 f The profiles you created are displayed in the [Profile] screen.

[Profile] Screen

Profile list Display a list of currently registered profiles. The list can be resorted by dragging the icons.
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[New Profile] Register a new profile.
[Copy] Duplicate the selected profile.

“Duplicating Profiles” (w page 126)
[Modify] Rename selected profiles or change their icons.

“Changing Profiles” (w page 126)
[Delete] Delete the selected profile.

“Deleting Profiles” (w page 126)
[Profile] Select the profiles to display in the profile list.
[Shared Server] Select the folder in which the shared profile is stored.

“Using Shared Profiles on Local Terminals” (w page 129)

[Profile] Dialog Box

[Name] Enter the name of the profile.
[Change Icon] Click this item to display the [Select Icon] dialog box and select the profile icons.

To use any image you like, click [...] in the [Select Icon] dialog box, and select a file.
[Read only] This is a read-only profile. The settings of profiles that are changed while they are still in use 

are not overwritten.
Also, read-only profiles cannot be renamed, and their icons cannot be changed or deleted. The 

 icon is displayed at the top right of read-only profiles.
“Profile Types” (w page 128)

[Restricted User] This is a restricted user profile. The system settings cannot be changed while the restricted 
user profile is in use. The  icon is displayed at the top right of restricted user profiles.
“Profile Types” (w page 128)

Changing Profiles
You can rename registered profiles or change their icons.

1) Select a profile in the profile list, and click [Modify].
 f “[Profile] Screen” (w page 125)

1 Alternative
 f Right-click a profile in the profile list, and click [Modify].

2) Change the settings, and click [OK].

Duplicating Profiles
Duplicate registered profiles.

1) Select a profile in the profile list, and click [Copy].
 f “[Profile] Screen” (w page 125)
 f The duplicated profile appears in the profile list.

1 Alternative
 f Right-click a profile in the profile list, and click [Copy].

Deleting Profiles
Delete registered profiles.

1) Select a profile in the profile list, and click [Delete].
 f “[Profile] Screen” (w page 125)

1 Alternative
 f Right-click a profile in the profile list, and click [Delete].

2) Click [Yes].
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3 Note
 f You cannot delete the profile currently in use (current setting).

Switching Profiles
Switch the profile while editing a project, and continue editing as you are.

1) Click [Settings] on the menu bar, and click [Change Profile].
 f The [Change Profile] dialog box appears.

2) Select a profile and click [OK].

2
 f The profile currently in use is displayed at [Current profile].

3 Note
 f Operations such as registering new profiles and changing profiles are not available in the [Change Profile] dialog box.

Importing Profiles (Import)
Import profiles.

3 Note
 f Some profile settings are not reflected when profiles created by an old version of EDIUS are imported.

1) Right-click a profile in the profile list, and click [Import].
 f “[Profile] Screen” (w page 125)

2) Select a file, and click [Open].
 f The imported profile is displayed in the profile list.

Exporting Profiles (Export)
Export profiles.

1) Right-click a profile in the profile list, and click [Export] → [Selected profile].
 f “[Profile] Screen” (w page 125)
 f Click [All] to export all registered profiles.

2) Select a save destination and click [Save].

Managing Editing Environments on the Server
Manage profiles on the server when using EDIUS on multiple terminals. The profile managed on the server (i.e. shared profile) is shared 
between and used by each of the terminals.

Creating a Shared Profile
To share a profile on multiple terminals, install EDIUS on the management server or PC, and create a shared profile using the profile 
management tool.
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3 Note
 f First, install EDIUS on the server or PC where the shared profile is to be managed.
 f While the profile management tool is in use, EDIUS on all terminals that are referencing the profile management server must be 
ended.

1) Double-click ConfigProfile.exe in the “EDIUS X” folder of the hard disk where EDIUS is installed.
 f Normally, the “EDIUS X” folder is located in “C drive” → “Program Files” → “Grass Valley”.
 f The profile management tool will start up.

2) Click [...] to specify the destination to save the shared profile to, and click [OK].

3) Click [Config], and click [OK].
 f The [Change Profile] dialog box appears.
 f New profiles can be registered, changed, deleted, duplicated, imported, and exported in the same way as system settings.
“Switching an Editing Environment with Profile” (w page 125)

4) Create the shared profile, and click [Close].

5) Click [Close].
 f To use the shared profile on each terminal, the references and other information of the shared profile must be set in the system settings 
on each terminal.
“Using Shared Profiles on Local Terminals” (w page 129)

Profile Types

 r Local profile

This is the profile created on each local terminal. The settings of profiles that are changed while they are in use are overwritten.

 r Read-only profile

This is a read-only profile. The settings of profiles that are changed while they are still in use are not overwritten.
Also, read-only profiles cannot be renamed, and their icons cannot be changed or deleted.

 r Restricted user profile

This is a restricted user profile. The system settings cannot be changed while the restricted user profile is in use.

 r Shared profile

This is the profile created using the profile management tool. The settings of profiles that are changed while they are in use are overwritten 
as long the profile is not changed to read-only.
Also, shared profiles cannot be renamed, and their icons cannot be changed or deleted on local terminals.
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 r Shared profile in offline state

This is the shared profile in an offline state. This is displayed when a connection cannot be made to the reference server from the local 
terminal that was using the shared profile.

2
 f When a shared profile is in use, profile settings sometimes cannot be saved to the server if the connection to the reference server is 
broken off midway or when another terminal is executing save processing on the same shared profile. When the connection to the 
server is recovered when EDIUS is next started up, if the shared profile with the same name is still in the server, a message will appear 
to confirm whether the profile settings, which could not be saved in the last session, should be written back to the server at the current 
session.

Using Shared Profiles on Local Terminals
Enable use of the shared profile on each terminal.

1) Click [Settings] on the menu bar, and click [System Settings].

3 Note
 f If you use the restricted user profile, the system settings cannot be changed. To change system settings, the profile must be switched.
“Switching Profiles” (w page 127)

2) Click the [Application] tree, and click [Profile].

3) Select [Shared Server] or [Local and Shared Server] in [Profile].
 f If you select [Shared Server], only the shared profile can be used. New profiles on local terminals cannot be registered, changed, deleted, 
duplicated, and imported.

 f If you select [Local and Shared Server], both local profiles and the shared profile can be used.
 f If you select [Local], only local profiles can be used.

4) Click [...] at [Shared Server Folder] to specify the destination to reference the shared profile, and 
click [OK].

 f Specify where to save the shared profile that you created using the profile management tool.

5) Click [Sync], and click [OK].
 f The shared profile is displayed on the [Profile] screen synchronized with the profiles at the network references.
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Setting an External Device

Using a Device
It is necessary to set up editing environment before you start editing if you make EDIUS interact with other devices, in such a way as 
capturing from a video camera or output using video input/output hardware.

2
 f Hardware by other manufacturers are supported. For camera and hardware products that the operation have been confirmed, visit our 
website.
“Our Website” (w page 494)

Capturing and Recording using a Camera or a VTR
To set up the environment to use EDIUS with other devices for capturing from a camera or exporting to tape, the devices to be used with 
EDIUS must be registered.

Capture and Monitor Output Using a Hardware
You can use video input/output hardware to perform capturing and monitor output. With EDIUS, it is possible to output the video being 
edited to a monitor in full frame and full resolution in real time, which enables to adjust the color or timing for cut while comfortably 
previewing the video.
For the method of hardware installation or connection to a monitor, see the instruction manual attached to the device.
Also, some hardware may require setting by EDIUS and and application supplied with the product to be recognized by EDIUS. For details, 
visit our website or see the instruction manual attached to the product.
“Our Website” (w page 494)

Supported Hardware
 f STORM 3G
 f STORM Pro
 f Hardware products by other manufacturers (visit our website for the operation confirmed hardware products.)
“Our Website” (w page 494)

3 Note
 f Supported hardware or available functions differs depending on used EDIUS. For details, visit our website.

Registering Device Presets
The connection information for an external device used for capturing or exporting (camera, deck, web camera, microphone, video input/
output hardware, etc.) is registered and managed as a preset in the device presets. Capturing or exporting operation can be performed 
smoothly by loading the registered device preset.
Before registering device presets, connect the external device (e.g. camera) used for input/output to your PC, and turn it on.
“Connecting to External Devices” (w page 162)

2
 f It is not necessary to register external devices in which file-based video or audio are recorded (e.g. AVCHD video camera, professional-
use video camera, removable media such as SD memory card, XDCAM EX device) as device presets.

1) Click [Settings] on the menu bar, and click [System Settings].

3 Note
 f If you use the restricted user profile, the system settings cannot be changed.
“Restricted user profile” (w page 128)
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2) Click the [Hardware] tree, and click [Device Preset].

 f The [Device Preset] screen appears.
“[Device Preset] Screen” (w page 132)

3) Click [New].

 f [Preset Wizard] will start up.

1 Alternative
 f Right-click a blank area in the device preset list, and click [New].

4) Enter the name of the device preset.

5) Click [Select Icon], select the icon image, and click [OK].
 f To use any image you like, click [...] and select a file.
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6) Click [Next].

 f The [Input H/W, Format Settings] screen appears.
“[Input H/W, Format Settings] Screen” (w page 132)

7) Set each item and click [Next].
 f The [Output H/W, Format Settings] screen appears.
“[Output H/W, Format Settings] Screen” (w page 134)

2
 f The output target device (such as a tape deck) that can be controlled from EDIUS is setup with [Output H/W, Format Settings] in 
the device preset. The video is always output according to the project setting when the output is performed from the output terminal 
unavailable for the deck control. Configure the setting in [Preview Device] for the output from the output terminal unavailable for the deck 
control.
“Setting Preview Devices” (w page 143)

8) Set each item and click [Next].

9) Confirm the details, and click [Done].
 f The icon of the newly created preset is displayed in the device preset list.

[Device Preset] Screen

Device preset list Displays a list of device presets. The list can be resorted by dragging the icons.
The list is not displayed when there are no device presets registered.

[New] Create new device presets.
[Modify] Change the settings of the selected device preset.

“Changing Device Presets” (w page 142)
[Delete] Delete the selected device preset.

“Deleting Device Presets” (w page 142)

[Input H/W, Format Settings] Screen

This section explains settings when video is input from a DirectShow capture device.
For more information on settings when using Grass Valley products for input, see the user manual included with the product.

[Interface] Click this item to select the interface to use for input.
To input from a DirectShow base video capture device or audio capture device, select 
[DirectShow Capture].
When the interface to use for input is selected from the list, the content of each of the items 
such as [Stream] switches to match the selected interface.
To disable use of an interface for input, select [Not Select].

[Stream] When [DirectShow Capture] is selected at [Interface], select your device. The displayed device 
name varies depending on your product.
You can make device settings by clicking [Settings].
When your device is a video capture device, you must set the associated audio capture device.
“[Settings - Device Setting] Dialog Box (DirectShow Capture)” (w page 133)
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[Video Format] Select the video format for the source to capture.
[Codec] Select the codec to use for capture depending on the video format. You can make codec 

settings by clicking [Settings].
“[Settings - Grass Valley HQ]/[Settings - Grass Valley HQX] Dialog Box” (w page 133)
“[Settings - MPEG2 Custom] Dialog Box” (w page 134)
“[Settings - XDCAM HD422 Compatible] Dialog Box” (w page 134)
“[Settings - XDCAM EX Compatible] / [Settings - XDCAM HD Compatible] Dialog Box” 
(w page 134)
“[Settings - MPEG IMX] Dialog Box” (w page 134)

[File Format] Select the file format of the captured clip depending on the video format.
[Proxy File] Select a file (only high-resolution/high-resolution and proxy) to be created when capturing.
[Audio Format] Select the audio format of the source to capture depending on the video format.
[Audio Input] Select the audio input interface depending on the video format.
[Convert 16Bit/2ch] Select whether to import audio by 16-bit/2ch depending on the video formats.
[Stereoscopic] Select [Separate L/R Clips] to capture the L side and the R side of the input video separately 

using the batch capture function. The recorded L and R side files are registered to the bin as 
stereoscopic clips. (The [Separate L/R Clips] setting is enabled while batch capturing.)

* Selectable items differ according to the setting.

 r [Settings - Device Setting] Dialog Box (DirectShow Capture)

[Video Device] Displays the video capture devices connected to the system.
Click [Video Setting] to display detailed settings depending on your video capture device. For 
more information on settings, see the manual for your device.

[Audio Device] Displays the audio capture device connected to the system.
Select the audio capture device corresponding to the video capture device from the list. To 
cancel this setting, select [Not assigned].

[Set video frame rate from audio 
sampling rate.]

Check this item to calculate the frame rate from the number of samples and duration time of the 
audio. Uncheck this item to calculate the frame rate from the frame rate provided by the video 
capture device, and convert the audio sampling rate to match the frame rate.

 r [Settings - Grass Valley HQ]/[Settings - Grass Valley HQX] Dialog Box

Codec settings [Online(SuperFine)]
This item can be selected for a Grass Valley HQX codec. This setting provides the highest 
image quality, though the file size increases. Select this when importing at high image quality is 
needed.
This item cannot be selected for a Grass Valley HQ codec.
[Online(Fine)]
This setting provides high image quality, though the file size increases. Select this when 
importing at high image quality is needed.
[Online(Standard)]
Normally, you can get sufficient image quality at this setting.
[Offline]
Select this item to encode at a lower bitrate.
[Custom]
[Q] and [Max size] can be adjusted.
[Q] adjusts image quality. Set within the range 4 to 19 (0 to 18 in the case of a Grass Valley 
HQX).Setting a smaller value results in higher image quality.
[Max size] sets the maximum bitrate. You can set to limit the file size that increases 
inadvertently as a result of excessive noise in the video. Setting value “100” % means the same 
bitrate before codec compression. For example, 100% for 1440x1080 59.94i is a bitrate of 
approximately 750 Mbps. To set the upper limit to 200 Mbps, set “27” % as the maximum size.

3 Note
 f The [Settings - Grass Valley HQ]/[Settings - Grass Valley HQX] dialog box shows the settings when importing video by Grass Valley 
HQ/Grass Valley HQX capture. These are not the settings for Grass Valley HQ/Grass Valley HQX file export or for rendering when 
Grass Valley HQ/Grass Valley HQX is selected in the project settings.
“Capturing and Importing Sources” (w page 162)
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 r [Settings - MPEG2 Custom] Dialog Box

[Bit Rate] Select a bitrate type.
[CBR] sets a fixed transfer rate, allocating a fixed number of bits during the encoding process. 
Select a bitrate from the [Average] list.
You can also enter a value directly.
[VBR] sets a variable transfer rate, altering the number of assigned bits according to the 
complexity of the movement or image quality. Compared with [CBR], the media volume can be 
used more efficiently, and this enables more consistent image quality overall. Select a bitrate 
from the [Average] and [Max] lists. You can also enter a value directly.

[Quality/Speed] Select quality from the list.
[GOP Structure] For MPEG, a certain number of frames is considered as a group, and operations such as 

compression/enlargement and cut editing are performed on a GOP basis. A GOP comprises 
“I frame”, “P frame” and “B frame”. The I frame allows images to be reproduced independently, 
the P frame is for recording and reproducing only the differences with the preceding image, 
and the B frame reproduces images from the differences in the preceding and following 
images. Select I, P and B frame patterns of the GOP from the list. Normally, select [IBBP].
[I-Frame Only] is comprised of only I-pictures. Editing is made easier, but the amount of data 
increases in size.

[Picture count] Set the number of frames included in a group.
[Closed GOP] Check this item to complete information within each GOP. Although the amount of data 

increases, the video can be re-edited using software that supports GOP-based editing. 
Normally, leave this item unchecked.

[Chroma Format] Select a YUV pixel format from the list.
[Profile/Level] Select a profile & level. If [Chroma Format] is [4:2:0] and [4:2:2], the profile will be set to Main 

Profile and 422Profile, respectively.
The level for SD image quality will be Main Level, and the level for HD image quality will be 
High Level. The profile & level changes according to the format selected in [Chroma Format].

[VBV Buffer Size] Select the setting method for the VBV buffer upper limit value. When [Default] is selected, the 
VBV buffer upper limit value is set using current settings.

 r [Settings - XDCAM HD422 Compatible] Dialog Box

[Quality/Speed] Select quality from the list.
[Closed GOP] Check this item to complete information within each GOP. Although the amount of data 

increases, the video can be re-edited using software that supports GOP-based editing. 
Normally, leave this item unchecked.

 r [Settings - XDCAM EX Compatible] / [Settings - XDCAM HD Compatible] Dialog Box

[Bit Rate] Select a bitrate from the list.
[Quality/Speed] Select quality from the list.
[Closed GOP] Check this item to complete information within each GOP. Although the amount of data 

increases, the video can be re-edited using software that supports GOP-based editing. 
Normally, leave this item unchecked.

 r [Settings - MPEG IMX] Dialog Box

[Bit Rate] Select a bitrate from the list.

[Output H/W, Format Settings] Screen

For more information on settings when using Grass Valley products for output, see the user manual included with the product.

[Interface] Click this item to select the interface to use for output.
When the interface to use for output is selected from the list, the content of each of the items 
such as [Stream] switches to match the selected interface.
When the output interface is not to be used or when video is output to tape on a device not 
controlled by a deck, select [Not Select].

[Stream] You can make output settings by clicking [Settings].
[Video Format] Select the video format to output from the list.
[Audio Format] Select the audio format to output from the list depending on the video format.
[Audio Output] Select the audio output interface depending on the video format.
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[Stereoscopic   Separate L/R Clips] To export the video of the L side (for left eye) and the R side (for right eye) in the project 
created in the stereoscopic edit mode separately, select [Yes].
To export the video of the L side and the R side as a single file, select [No]. Click [Settings] 
at the right side of [Stream], and select a stereoscopic processing format in the [Settings - 
Stereoscopic Setting] dialog box.
“[Settings - Stereoscopic Setting] Dialog Box” (w page 135)

* Selectable items differ according to the setting.

 r [Settings - Stereoscopic Setting] Dialog Box

[Stereoscopic Mode] Select a stereoscopic processing format when outputting the video of the L side and the R side 
in the project created in the stereoscopic edit mode.
When [L Only]/[R Only] is selected, export the video of either the L side or the R side.
When [Side by Side]/[Top and Bottom]/[Line Interleave]/[Blend]/[Anaglyph]/[Difference]/[Split 
Grid] is selected, export the composite video of the L side and the R side.
“Stereoscopic Processing Type” (w page 153)

[Follow stereoscopic preview mode] Export the project in the same format as the preview window display in the stereoscopic edit 
mode.
“Displaying Preview Window in Stereoscopic Edit Mode” (w page 153)

[Swap L/R] Check this item to display video with the L side (for left eye) and R side (for right eye) swapped.
[Default] Restore the settings of items marked with * to their defaults.

Detailed Setting of Device Preset

[Sync Settings] (STORM 3G)

This is a synchronization setting between the monitor output device used for the capture and the Grass Valley hardware, or the output 
device used for tape output and the Grass Valley hardware.
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[Sync Mode] Select a sync signal from [REF Input Sync] and [Input Sync].
[NO SIGNAL]/[SIGNAL OK] indicates whether a reference signal which can be synchronized 
with the current output video format is detected.
It will switch to internal sync system when the reference signal is not input ([NO SIGNAL]).
It can be synchronized to both [Tri-Level] (tri-level sync) and [BB] (Black Burst) signals when 
[REF Input Sync] is selected and the output format is HD. The box next to the corresponding 
signal ([Tri-Level] or [BB]) will light in green when either signal is input. It can only 
synchronized against the [BB] signal when the output format is SD.
[Tri-Level HD H-shift]
Enter the horizontal-shift adjustment value for the tri-level sync signal during HD format 
output.
[BB HD H-shift]
Enter the horizontal-shift adjustment value for the BB signal during HD format output.
[SD H-shift]
Enter the horizontal-shift adjustment value for the BB signal during SD format output.

[REF Signal Output] Selects the format to output the REF signals from [BB NTSC], [BB PAL], [Tri-Level 
1080/59.94i], [Tri-Level 1080/50i], [Tri-Level 1080/23.98PsF],and [Tri-Level 1080/24PsF].

[Default] Restores to the default setting.

[Video Output Settings] (STORM 3G)

This is a setting for the monitor output device used for the capture or the output device used for tape output.

[Analog Output Settings] [Setup Level]
Sets the setup level (black level) of NTSC from [0IRE] or [7.5IRE].
0 IRE is used in Japan, and 7.5 IRE is used in North America.
[Component Level]
Selects the component level from [SMPTE] or [BETACAM].
[Component Gain]
Adjusts the output gain of the SD component.

[VITC Output] [Line 1]/[Line 2]
Sets the number of lines for VITC output in the input field of adopted video standard (NTSC/
PAL).

[Component Output Setting] [Multi Format]
HD/SD is switched automatically according to the input format.
[SD Only - YPbPr]
The downconverted video (component YPbPr) is output.
[SD Only - Y/C]
The downconverted video (S-Video) is output.

[Default] Restores to the default setting.
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[Audio Output Settings] (STORM 3G)

This is a setting for the monitor output device used for the capture or the output device used for tape output.

[Audio Monitor] Selects the audio channel to monitor.
[HDMI Audio Output Setting] Sets the output from the HDMI connector. Select whether to output the signals as 8 channels 

or to output them according to the channel settings specified for the analog 2 channels.
[Balanced Audio Output Settings] [Output Headroom[dB]]

Sets the headroom of the reference output level from [20], [18], [16], or [12].
[Output Level[dBm]]
Sets the reference output level from [+4], [0], [-3], [-6], or [-20].

[Audio Bitstream Settings] Sets how to handle digital audio signal when outputting SDI embedded audio.
The audio bitstream is output if playback data contains audio bitstream, and linear PCM data 
is output if it does not contain audio bitstream when [Auto] is selected.
The linear PCM data is output when [LPCM] is selected.
The AC-3 audio bitstream is output when [AC-3] is selected.
The Dolby-E audio stream is output when [Dolby-E] is selected.

[Default] Restores to the default setting.
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[Input Control Settings] (STORM 3G)

This is the setting for the input device used for capturing.

[Control Port] Not available.
[Control Channel] Selects to use RS-422 remote control or not.

[Use TC Input Terminal]
The TC terminal is prioritized to acquire the TC (timecode) information.

[Capture Preroll Time] Sets the preliminary operation time (preroll) from the start of capturing.
[Default] Restores to the default setting.

[Video Input Settings] (STORM 3G)

This is the setting for the input signal adjustment used for capturing.
The setting is available only for the component, S-video, or composite input.

[Brightness] Adjusts the brightness of video. It will become darker when the value is smaller, and brighter 
when the value is larger.

[Contrast] Adjusts the contrast of image. The contrast will be weaker when the value is smaller, and 
stronger when the value is larger.

[Hue] Adjusts the hue of video. Red will be stronger when the value is smaller, and green will be 
stronger when the value is larger.
 f This cannot be set for component input.
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[Saturation] Adjusts the deepness of the color. The color becomes lighter when the value is smaller, and 
deeper when the value is larger.
The image will become grayscale when set to 0 (minimum value).

[Setup Level] Sets the setup level (black level) for NTSC.
[Component] Selects the component level for NTSC.
[Gain Control] Sets the video luminance. [Manual] will set the luminance manually. [Automatic] will set the 

luminance to optimum automatically.
[Preserve Ancillary Data] Check this to append ancillary data such as closed caption during capturing.
[Default] Restores to the default setting.

[Analog Output Settings] (STORM Pro)

This is the setting for the monitor output device used for capturing.

[Balanced Audio Output Settings] [Output Headroom[dB]]
Sets the headroom of the reference output level from [20], [18], [16], or [12].
[Output Level[dBm]]
Sets the reference output level from [+4], [0], [-3], [-6], or [-20].

[Output Headroom[dB]] Sets the headroom from the reference output level from [20], [18], [16], or [12].
[Output Level[dBm]] Sets the reference output level from [+4], [0], [-3], [-6], or [-20].
[MON 1/2 Output Setting] Sets the output from the MON 1 terminal and MON 2 terminal. Selects whether to output from 

2ch of the audio monitor set by [Audio Monitor] in [System Settings], or from Ch5/Ch6 of the 
balanced audio.

[Analog Video Output Gain] Sets the output gain for the analog video output terminal. The value can be set between -64 
and 64.



Chapter 4   Setting — Setting an External Device

140

[Audio Input Settings] (STORM 3G/STORM Pro)

This is a setting for the input device used for the capture or the output device used for tape output.

[Balanced Audio Input Settings] [Input Headroom[dB]]
Sets the headroom from the reference input level from [20], [18], [16], or [12].
[Input Level[dBm]]
Sets the reference input level from [+4], [0], [-3], [-6], or [-20].
[600 ohm  Termination]
Check this option to enable 600 Ω terminator of the balanced audio input terminal.
This can be set for each channel individually.

[Audio Bitstream Settings] Sets the handling of the digital audio signal for SDI embedded audio input.
It will be saved as linear PCM data and handled as normal audio signal during editing when 
[LPCM] is selected.
It will be saved as AC-3 audio bitstream when [AC-3] is selected.
It will be saved as Dolby-E audio stream when [Dolby-E] is selected.

[Default] Restores to the default setting.

[Stereoscopic Settings] (STORM 3G)

This is a setting for the input device used for the capture or the output device used for tape output.
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[Stereoscopic Mode] Selects the stereoscopic processing format when the video for L side and R side in the project 
created with the stereoscopic edit mode is output.
The video for L side and R side is output as 2 streams when [L/R Dual Stream] is selected.
The video for L side only or the R side only is output when [L Only]/[R Only] is selected.
The videos of L side and R side are combined and output when [Side by Side]/[Top and 
Bottom]/[Line Interleave]/[Blend]/[Anaglyph]/[Difference]/[Split Grid] is selected.

[Follow stereoscopic preview mode] Outputs in the same format as the preview window display in the stereoscopic edit mode.
[Swap L/R] Check this to output with L side and R side inversed.
[Default] Restores to the default setting.

[Output Control Settings] (STORM 3G)

This is the setting for the output device used for output to tape.

[Control Port] Not available.
[Control Channel] Selects the terminal to control the device from the list.

The control status for the deck connected to the REMOTE terminal can be checked with the 
playback button, etc.

[VCR Constants] [VCR ID(V)]
Displays the VCR Constant 1 byte1 and byte2.
Displays the deck ID (including model/mode) for SONY decks.
[Check for Deck ID]
Click it to load VCR ID (deck ID) from the connected VCR.
[VCR]
Displays the deck name corresponding to the VCR ID. (Only the preset ID and VCR name) 
Displays all if multiple decks with the same ID are registered.
[Edit Delay]
Displays VCR Constant 1 Byte 6.
Enter manually if the deck is not in the preset.
[E-E Delay]
Displays VCR Constant 1 Byte 5.
Enter manually if the deck is not in the preset.
[Start Delay]
Displays VCR Constant 2 Byte 2 (Data 10 depending on the deck).
Enter manually if the deck is not in the preset.
[Load Default Presets]
Initializes the edit delay, E-E delay, and start delay with the preset values.

[Edit Settings] [Preroll Time]
Sets the preliminary operation time (preroll).
[Postroll Time]
Sets the post operation time (postroll).
[FirstEdit Pre-Rec Time]
Sets the draft (margin) length at FirstEdit (automatically record the control signal to be the 
reference point for editing at the top of the tape).

[Default] Restores to the default setting.
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Changing Device Presets
Change the settings of a registered device preset.

1) Select a preset in the device preset list, and click [Modify].
 f “[Device Preset] Screen” (w page 132)
 f [Preset Wizard] will start up. Operations from here on are the same as step 4) in “Registering Device Presets” onwards.
“Registering Device Presets” (w page 130)

1 Alternative
 f Right-click a preset in the device preset list, and click [Modify].

Deleting Device Presets
Delete a registered device preset.

1) Select a preset in the device preset list, and click [Delete].
 f “[Device Preset] Screen” (w page 132)

1 Alternative
 f Right-click a preset in the device preset list, and click [Delete].

2) Click [Yes].

Duplicating Device Presets
Duplicate a registered device preset.

1) Select and right-click a preset in the device preset list, and click [Copy].
 f “[Device Preset] Screen” (w page 132)

Importing Device Presets (Import)
Import device presets.

1) Right-click a blank area in the device preset list, and click [Import].
 f “[Device Preset] Screen” (w page 132)

2) Select a file, and click [Open].
 f The imported preset is displayed in the device preset list.

Exporting Device Presets (Export)
Export device presets.

1) Select and right-click a preset in the device preset list, and click [Export].
 f “[Device Preset] Screen” (w page 132)

2) Select a save destination and click [Save].
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Assigning Device Presets to Input Presets
If you assign device presets as input presets in advance, an assigned device preset can simply be called up at capture.

1) Select and right-click a preset in the device preset list, and click [Assign Input Preset] → [Input 
Preset 1] - [Input Preset 8].

 f “[Device Preset] Screen” (w page 132)
 f The selected device preset is assigned as an input preset, and is displayed as an input preset when [Capture] on the menu bar is clicked.

2
 f To cancel an assignment to an input preset, right-click a blank area in the [Device Preset] list, and click [Delete assignation] → preset 
name.

Setting External Device Used for Preview
Registers and manages hardware as preview device when editing while viewing an external monitor connected to the PC.

2
 f Setting other than for EDIUS may be required depending on the type of hardware. For details, visit our website.
“Our Website” (w page 494)

Setting Preview Devices
Before setting preview devices, connect the external device (e.g. monitor) used for preview to the PC, and turn on the power.
For more information on settings when using a Grass Valley product as a preview device, see the user manual included with the product.

1) Click [Settings] on the menu bar, and click [System Settings].

3 Note
 f If you use the restricted user profile, the system settings cannot be changed.
“Restricted user profile” (w page 128)

2) Click the [Hardware] tree, and click [Preview Device].

3) Set each item.

Preview device list Displays a list of preview devices. Click the preview device to use, and the device name will be 
prefixed with a check mark.
You can also uncheck preview devices not in use.
You can set the details of each device by clicking [Settings].
“[Settings - Stereoscopic Setting] Dialog Box” (w page 135)
For more information on settings when using a Grass Valley product, see the user manual 
included with the product.

[Use Pulldown Format when Available] Check this item to give priority to pulldown operation (2-3-2-3) regardless of the [Pulldown 
Type] setting in the current project settings. Try this setting when using a monitor that does not 
support 23.98p/29.97p/25p display.

[Display a warning message when the 
selected device does not support the 
current format]

When a preview device is not compatible with the video format in the current project settings, 
an alarm message will be displayed. When this item is unchecked, an alarm message will not 
be displayed.

3 Note
 f When a preview device is not compatible with the video format in the current project settings, an alarm message will be displayed and 
detailed settings cannot be changed. Reset the project settings to match the preview device.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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3 Note
 f Audio is output packed from the left in order starting from the smallest monitor number. When the number of output channels exceeds 
the number of channels that can be received by the monitor, the audio of the channels exceeding this limit is not output.

Checking Conversion Status of Output Video

The conversion status of output video can be checked with the icon indicated on the status bar of the timeline.
 f Moving the mouse cursor onto the icon will show the tooltip indicating the preview device in use and output format.

 r When video is output without conversion

XXXXXXXX

 r When video is not output from the hardware
The tooltip that appears when the mouse cursor is placed on the icon indicates the output format [None].

XXXXXXXX

2
 f While a video is being converted and output, the preview device in use and output format are indicated over the icon.

Detailed Setting for Preview Device

[Sync Settings] (STORM 3G)

The synchronization setting between the monitor output device used during editing and the Grass Valley hardware.
“[Sync Settings] (STORM 3G)” (w page 135)

[Video Output Settings] (STORM 3G)

The setting for a monitor output device used during editing.
“[Video Output Settings] (STORM 3G)” (w page 136)

[Analog Output Settings] (STORM Pro)

The setting for a monitor output device used during editing.
“[Analog Output Settings] (STORM Pro)” (w page 139)

[Audio Output Settings] (STORM 3G)

The setting for a monitor output device used during editing.
“[Audio Output Settings] (STORM 3G)” (w page 137)

[Stereoscopic Settings] (STORM 3G)

The setting for a monitor output device used during editing.
“[Stereoscopic Settings] (STORM 3G)” (w page 140)
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Placement Customization

Changing the Screen Layout
EDIUS standard layout can be customized for better usability. It is possible to change the size of the preview window, or the bin window, or 
combine the palettes. It is also possible to register the customized layout.

Registering Layouts
Register operation screen layouts after they have been laid out according to your preference or size.
Before you start operation, place the window or palette on the layout you want to register.

1) Click [View] on the menu bar, and click [Window Layout] → [Save current layout] → [New].

2) Enter a name, and click [OK].

2
 f 10 layouts can be saved. To register a new layout when 10 layouts are already registered, select the layout to be overwritten from among 
the registered layouts in step 2).

Renaming Layouts
You can rename registered layouts.

1) Click [View] on the menu bar, and click [Window Layout] → [Change Layout Name] → layout to 
change the name.

2) Enter a name, and click [OK].

Applying Layouts
Apply a registered layout to change the layout as you like.

1) Click [View] on the menu bar, and click [Window Layout] → [Apply Layout] → layout to apply.

2
 f Click [View] on the menu bar, and click [Window Layout] → [Normal] to restore the default layout.
 f Returning to the default layout: [Shift] + [Alt] + [L]

Deleting Layouts
Delete registered layouts.

1) Click [View] on the menu bar, and click [Window Layout] → [Delete Layout] → layout to delete.

2) Click [Yes].

Combining Bin Window/Source Browser Window with a Palette
Combine the bin window, source browser window, [Effect] palette, [Marker], palette, and [Information] palette in whatever way so the display 
area on the screen is utilized more effectively.
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1) Drag the palette tab onto the tab of the bin window or source browser window.

XXXX XXXX (0/4)

XXXXXX

100%

XXXX

XXX

XXXXXX

XX:

XXXXXX
XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

2/2 1

XXXXXX

XXXXXX

 f The palette is combined with the bin window or source browser window, and the tab is added. Click the tab to switch the display window.

2
 f You can freely combine the bin window or source browser window with any of the palettes. For example, 3 palettes can be combined into 
1 palette, or the bin window or source browser window can be combined with 3 palettes into 1 window.
“[Marker] Palette” (w page 41)
“[Effect] Palette” (w page 40)
“[Information] Palette” (w page 40)

 f To cancel a combination, drag the tab outside the frame.
 f Size of each window can be changed freely by moving the mouse cursor to the edge of a window and dragging it when the mouse cursor 
changes the shape.
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Screen Customization

Changing the Display of Operation Button
Add, delete and change the placement order of operation buttons that are displayed on screens.

Operation Button Settings

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [User Interface] tree, and click [Button].
 f The [Button] screen appears.
“[Button] Screen” (w page 148)

3) Select the area to customize from the list.

4) From the [Current Buttons] list, select the button one position below the insert position.

5) Select the button to add from the [Available Buttons] list, and click [>>].
 f The selected button is added to the [Current Buttons] list. When [Space] has been added, a space is added between the two buttons.
 f To delete a button, select the button to delete from the [Current Buttons] list and click [<<]. When [Space] has been deleted, the space 
between the two buttons is deleted.

 f To change the position of a button, select the button to move from the [Current Buttons] list and click [Up] or [Down]. Each click of these 
buttons moves the selected button one place up or down.

6) Click [OK].
 f You can continue to set other items by clicking [Apply].

1 Alternative
 f To add a button, select the button one place under the insertion position in the [Current Buttons] list, and double-click the button to add 
from the [Available Buttons] list.

 f To add a button, drag and drop the button to add from the [Available Buttons] list onto the [Current Buttons] list.
 f To delete a button, double-click the button to delete from the [Current Buttons] list.
 f To delete a button, drag and drop the button to delete from the [Current Buttons] list onto the [Available Buttons] list.
 f To change the position of a button, drag and drop the button in the [Current Buttons] list.

3 Note
 f If too many buttons are added to the center area of the Player and Recorder, only the buttons that can be shown within the area are 
displayed from the top of the list.
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[Button] Screen

(1) Area A B C D

A: [Player - File (Left)]
B: [Player - File (Center - Left)]
C: [Player - File (Center - Right)]
D: [Player - File (Right)]
 f During file operations, area settings can be customized by [Player - File (Area)], and during 
deck operations, area settings can be customized by [Player - Deck (Area)], respectively.

 f Areas A to D are the same for the Recorder, too.
[Bin]: Bin window operation buttons
[Timeline]: Timeline window operation buttons
[Effect]: [Effect] palette operation buttons
[Source Browser]: Source browser window operation buttons
[Mode Bar]: Mode bar operation buttons
[Marker]: [Marker] palette operation buttons

(2) [Available Buttons] [Category]
Select a category to narrow down [Available Buttons].
[Filter]
Enter a keyword to narrow down [Available Buttons].

(3) [Current Buttons] Displays the buttons to display.
(4) [>>]/[<<] Add/delete buttons to be displayed.
(5) [Up]/[Down] Change the position of buttons.
(6) [Back to default] Return settings to their defaults.

Changing the Display of Preview Window
The following explains how to change the display of the preview window.
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Switching Between Single Mode/Dual Mode
You can switch the preview window between the single mode or dual mode.

1) Click [View] on the menu bar, and click [Single Mode] or [Dual Mode].
 f The display of the preview window switches to single or dual mode.
“Preview Window” (w page 32)

2
 f To switch between the Player and Recorder in the single mode, click [Change to Player] or [Change to Recorder].

 f You can switch between the Player and Recorder by the following shortcut keys:
 g Switching to the Player: [Ctrl] + [Alt] + [P]
 g Switching to the Recorder: [Ctrl] + [Alt] + [R]
 g Switching to the Player/Recorder: [Tab]

Full Screen View of Preview Window
Video displayed in the preview window can be displayed in full screen view.
Assign in advance which video, such as Player or Recorder video, or video from a selected camera in the multicam mode, is to be displayed 
in full screen view on each monitor connected to your PC.
“[Monitor]” (w page 119)

3 Note
 f The occurrence of combing (vertical comb-like stripes) is normal when interlaced images are previewed in full screen view.
When previewing on a PC, the same quality as in hardware preview out cannot be assured. Since there is a difference between 
refresh rate of a PC monitor and the internal frame refresh rate of EDIUS, the same field may be displayed multiple times in the 
preview window and fields that should be displayed may not be displayed. Also, the same phenomenon may sometimes occur at a 
non-uniform display frequency depending on the performance of the CPU or GPU.

1) Click [View] on the menu bar, and click [Full Screen Preview] → monitor number.
 f When [All] is clicked, all monitors that have been set to full screen view at [Preview] in [User Settings] → [Monitor] can be displayed as full 
screen view.
“[Monitor]” (w page 119)

1 Alternative
 f Double-click the preview window.

2
 f Perform the following to cancel full screen view:

 g Click [View] on the menu bar, and click [Full Screen Preview] → monitor number.
 g Double-click the monitor set to full screen view.

Rotation Display of Preview Window
The preview window can be displayed rotated by 90 degrees.

1) Click [View] on the menu bar, and click [Rotate Preview] → [Right 90 Degrees] or [Left 90 Degrees].

2
 f Click [View] on the menu bar, and click [Rotate Preview] → [Standard] to return the window to its original state.
 f Rotation of the preview can be set to each individual sequence. To maintain rotation of the preview when a project is next opened, set 
rotation of the preview as desired to each sequence, and then save the project.

 f When a new project or sequence is created, the orientation of the preview window will be standard (i.e. rotation off).

Showing/Hiding Preview Window
Switch the show/hide setting for the safe area, center, and zebra preview.
You can change the information display settings from [Preview] in [User Settings] → [Overlay].
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“[Overlay]” (w page 120)

1) Click [View] on the menu bar, and click [Overlay] → an item to display.
 f The selected information is displayed in the preview window.

Example:

Player

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:10;00

clipXX

XXXXXXXXXXXXXXXXXXXX

(1) (2) (3)

(4)

(5)

(1) Clip/device name (capturing)/reel name (capturing)
(2) Safe area
(3) Center
(4) Zebra preview
(5) Marker comment display

1 Alternative
 f Showing/hiding safe area: [Ctrl] + [H]
 f Showing/hiding center: [Shift] + [H]

2
 f When [Marker] is selected as a display item, the clip marker comment is displayed on the Player only when the slider is directly above the 
clip marker. Also, on the Recorder, the sequence marker list is displayed only when the timeline cursor is directly above the sequence 
marker. Note, however, that these are not displayed during playback.

Showing/Hiding Status Area
Switch the show/hide setting for the status area.
You can change the settings of items displayed in the status area from [Preview] in [User Settings] → [On Screen Display].
“[On Screen Display]” (w page 120)

1) Click [View] on the menu bar, and click [On Screen Display] → [Status].
 f Select whether to display the status area not only on the PC screen but also on the external monitor. Click [View] on the menu bar, and 
click [On Screen Display] → [PC Monitor/External Output] or [PC Monitor].
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Example:

Player

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:10;00

2
 f When the status bar is displayed, a white triangle indicating the start or end frame is also displayed at the upper left or upper right corner 
of the safe area.

1 Alternative
 f Showing/hiding status area: [Ctrl] + [G]

Showing/Hiding Closed Caption
Switch the show/hide setting for closed caption.
The settings of closed caption can be changed in the [Closed Caption Settings] dialog box.
“Setting Closed Caption Display” (w page 152)

1) Click [View] on the menu bar, and click [On Screen Display] → [Closed Caption] → [On/Off].
 f When this menu item is checked, closed caption is displayed.
 f Select whether to display on not just the PC screen but also the external monitor. Click [View] on the menu bar, and click [On Screen 
Display] → [PC Monitor/External Output] or [PC Monitor].

2
 f Closed caption is displayed within the [Title Safe] area.
“[Overlay]” (w page 120)

 f Closed caption display supports MXF format files.
 f Closed caption is only displayed during playback.
 f Closed caption is only displayed when the settings including [Frame Size], [Frame Rate], and [Aspect Ratio] in the project settings match 
those of the source format.

 f If [Closed Caption On/Off] is displayed on the Player or Recorder as an operation button, you can switch show/hide setting of closed 
caption simply by clicking the button.
“Operation Button Settings” (w page 147)

 f Import of closed caption files is supported.
“Merging Closed Caption File and Registering” (w page 174)
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 f A sidecar file (closed caption file) can be exported besides an output file, or closed caption data can be embedded into the output file. The 
closed caption of a project alone can be exported as well.
“Exporting Closed Caption” (w page 447)

Setting Closed Caption Display

Set display of the closed caption.

1) Click [View] on the menu bar, and click [On Screen Display] → [Closed Caption] → [Settings].
 f The [Closed Caption Settings] dialog box appears.
“[Closed Caption Settings] dialog box” (w page 152)

2) Set each item and click [OK].

 r [Closed Caption Settings] dialog box

XXXXX

XXXXX

XXXXXX XXXXXX

Closed Caption Settings

Type

Stream

(1)
(2)

(1) [Type] Select the closed caption standard from [CEA-708] and [CEA-608].
(2) [Stream] Set the type of the closed caption.

When [CEA-708] is selected for [Type], select an item from [Service 1] to [Service 6].
When [CEA-608] is selected for [Type], select [CC1] or [CC3].

Control Area Settings
You can set the display item or the size of the timecode/shuttle/slider/buttons.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:10;00

(1)

(2)
(3)

(4)

(1) Shuttle
(2) Timecode
(3) Slider
(4) Button

1) Click [Settings] on the menu bar, and click [User Settings].
 f The [User Settings] dialog box appears.
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2) Click the [User Interface] tree, and click [Control].

3) Set each item.

[Show Timecode] Check the timecode items to display in the preview window, and set their size.
[Shuttle/Slider] Set the show/hide setting for the shuttle and slider in the preview window.
[Button] Set the show/hide setting and the size of the operation buttons on the preview window.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

Switching the Screen Display when Stopping Playback
You can switch the display of the preview window to each field when playback is stopped.

1) Click [View] on the menu bar, and click [Pause Field] → display method.

Showing/Hiding Alpha Channel
Turn the video with alpha channel to gray scale and display in the preview window.

1) Click [View] on the menu bar, and click [Show Alpha Channel].

Displaying Preview Window in Stereoscopic Edit Mode
You can switch the preview window display in the stereoscopic edit mode.

1) Click [View] on the menu bar, and select [Stereoscopic Mode] → a display method.
 f “Stereoscopic Processing Type” (w page 153)

Stereoscopic Processing Type

The following types of stereoscopic processing that displays stereoscopic video in a single frame are available.

[L Only] Display only the L side video (for left eye).
[R Only] Display only the R side video (for right eye).
[Difference] Display the color converted to the difference value between the L side and the R side video.
[Blend] Display video with the L side and the R side blended with 1:1 ratio.
[Top and Bottom] Display the L side video on the upper half of the frame and the R side video on the lower half.
[Anaglyph] Display the L side video in red and the R side video in blue.
[Line Interleave] Display the L side video on the upper line of the scanning line and the R side video on the 

lower line of the scanning line. Use this setting when displaying video on the 3D monitor with 
the polarization system.

[Side by Side] Display the L side video on the left half of the frame and the R side video on the right half.
[L/R Dual Stream] Display the stereoscopic video using NVIDIA 3D VISION or Intel Intru 3D.

This item can be used when your system supports NVIDIA 3D VISION or Intel Intru 3D. Check 
[Using NVIDIA 3D VISION/Intel InTru 3D] from [Preview] → [Monitor] in [User Settings].
“[Monitor]” (w page 119)

[Split Grid] Display the L side video and the R side video in the white and black area on the checkerboard 
respectively. Use this setting when displaying video on the DPL-based 3D monitor.

Changing the Display of Bin Window
The bin window consists of the folder view in which clips are stored, the clip view in which clips are displayed, and the metadata view in 
which clip metadata is displayed.
“Bin Window” (w page 38)
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Showing/Hiding Folder View
You can switch the show/hide setting for the folder view.

1) Click [Folder] in the bin.
 f Each click switches the show/hide setting for the folder view.
The folder view can also be set to hide by clicking [×].

XXXX XXXX (0/5)

1 Alternative
 f Showing/hiding folder view: [Ctrl] + [R]

Resizing Folder View/Clip View/Metadata View
You can resize the folder view/clip view/metadata view.

1) Drag the border between the folder view and clip view of the bin window, or the border between the 
clip view and the metadata view.

Example:

Border between folder view and clip view

XXXX XXXX (0/4) 100%

XXXX

Example:

Border between clip view and metadata view

XXX

XXXXXX XXXXXX

2
 f The show/hide setting for the metadata view can be switched by the following operations.

 g To hide the metadata view, drag the border between the clip view and metadata view down to the bottom of the bin window. To show 
the metadata view, drag the border upward from the bottom of the clip view.

XXX

 g Showing/hiding metadata view: [Ctrl] + [M]
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Clip View Display
Switch the display of clips in the clip view.

1) Click [View] in the bin.

 f Each click changes the display.
 g  : [Clip]
 g  : [Thumbnail]
 g  : [Tile]
 g  : [Detail]
 g  : [Icon]

Example:

If [Tile] is selected

(1) [In] In point of the clip or In point on the source timecode
(2) [Out] Out point of the clip or Out point on the source timecode
(3) [Dur] Duration of the clip or total length of the source

1 Alternative
 f Click the [View] list button to select the display method.
 f Right-click a blank area of the clip view and select [View] → display method.

2
 f The simple search bar is displayed at the bottom of the metadata view by pressing [F3] on the keyboard.
“Searching by the Simple Search Bar” (w page 214)

Bin Detailed Display Item Settings
Set items in the clip view.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [User Interface] tree, and click [Bin].

3) Set each item.
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[View] Set the information display items for each of the clip view displays.
[Thumbnail (Tooltip)]/[Tile (Tooltip)]
Set the items to be displayed when the mouse cursor is placed over clips in the bin, when the 
clip view display is set to [Clip]/[Tile].
[Detail]
Set the items to be displayed in the bin clip view when the clip view display is set to [Detail]/
[Icon].

[Folder Type] Set display items separately for [Normal Folder] and [Find Folder] ([Search results] folder).
[Columns] Check the display items.
[Up]/[Down] Sort the items.

Select an item, and move the selected item one place up or down with each click of [Up] or 
[Down].

[Width] Select an item, and enter a numerical value. This item can be set only when [View] is set to 
[Detail].

[Back to default] Return settings to their defaults.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].

1 Alternative
 f When the clip view display is set to [Detail] or [Icon], the following operations are possible:

 g Sorting items by dragging
 g Changing the item width by dragging its border
 g Changing display items by right-clicking

Changing the Display of Source Browser Window
The source browser window consists of the folder view in which external devices are displayed, the clip view in which clips are displayed, 
and the metadata view in which clip metadata is displayed.
“Source Browser Window” (w page 39)

Showing/Hiding Folder View
You can switch the show/hide setting for the folder view.

1) Click [Folder] in the source browser.
 f Each click switches the show/hide setting for the folder view.
The folder view can also be set to hide by clicking [×].

XXXX XXXXXX

1 Alternative
 f Showing/hiding folder view: [Ctrl] + [R]

Resizing Folder View/Clip View/Metadata View
You can resize the folder view/clip view/metadata view.

1) Drag the border between the folder view and clip view of the source browser window, or the border 
between the clip view and the metadata view.
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Example:

Border between folder view and clip view

XXXX XXXXXX 100%

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

Example:

Border between clip view and metadata view

XXXXXX

XXXXXX

XXXXXX

XXXXXX
XXXXXX

XX:

XXXXXX

XXX XXXXXX XXXXXX XXXXXX

2
 f The show/hide setting for the metadata view can be switched by the following operations.

 g To hide the metadata view, drag the border between the clip view and metadata view down to the bottom of the source browser window. 
To show the metadata view, drag the border upward from the bottom of the clip view.

XXX XXXXXX XXXXXX XXXXXX

XX:

 g Showing/hiding metadata view: [Ctrl] + [M]

Clip View Display
Switch the display of clips in the clip view.

1) Click [View] in the source browser.

 f Each click changes the display.
 g  : [Clip]
 g  : [Thumbnail]
 g  : [Tile]
 g  : [Detail]
 g  : [Icon]

1 Alternative
 f Click the [View] list button to select the display method.
 f Right-click a blank area of the clip view and select [View] → display method.

2
 f The simple search bar is displayed at the bottom of the metadata view by pressing [F3] on the keyboard.
“Searching by the Simple Search Bar” (w page 177)

 f When the clip view display is set to [Detail] or [Icon], the following operations are possible:
 g Sorting items by dragging
 g Changing the item width by dragging its border
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 g Changing display items by right-clicking

Changing the Color of Operation Screens
Change the color of operation screens such as windows or palettes as you like.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [User Interface] tree, and click [Window Color].

3) Set each item.

[Window Color] Specify RGB values to customize the screen color as you like. The specified color is displayed 
in the color sample.

[Back to default] Return settings to their defaults.

4) Click [OK].
 f You can continue to set other items by clicking [Apply].
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Shortcut Keys

Shortcut Keys
This section explains operation methods using shortcut keys and how to change keyboard shortcut assignments.

About Shortcut Keys
You can perform operations more effectively using combinations of keys on the keyboard (keyboard shortcuts), or combinations of mouse 
and key operations (mouse shortcuts).

Keyboard Shortcuts

Example:

Playback and stop
Press [Enter] on the keyboard while the preview window or timeline is active. This plays back (or stops) video.

Example:

Deletion of gaps (deletion of spaces between clips)
Click on the clip immediately following the space on the timeline, and press [Backspace] on the keyboard.

Mouse Shortcuts

Example:

Joint move
Drag the clip with the mouse with [Shift] and [Alt] on the keyboard held down.

Example:

Saving projects under different names
With [Shift] on the keyboard held down, click [Save Project] with the mouse.

Changing Keyboard Shortcut Assignments
Change shortcut keys assigned to the keyboard.

1) Click [Settings] on the menu bar, and click [User Settings].
 f The [User Settings] dialog box appears.

2) Click the [User Interface] tree, and click [Keyboard Shortcut].

3) Select the [Motion] items to change.

[Category] Select categories to narrow down the search of shortcut operations.
[Filter] Enter a keyword to narrow down the shortcut operations.
Operation list Displays operations searched by narrowing down categories in a list.
[Import] Import the contents of keyboard shortcut key assignments.
[Export] Export the contents of keyboard shortcut key assignments.
[Assign] Displays the keyboard to enable setting of key assignments.
[Not Assign] Change assigned shortcut key settings to [Not Assign].
[Duplicate] Copy shortcut keys assigned in [Motion]. [Assign] becomes [Not Assign].
[Delete] When a shortcut has been duplicated by [Duplicate], one of the shortcuts with the same 

[Motion] can be deleted.
[Back to default] Return key assignments to their default settings.

4) Click [Assign].
 f The [Key Assign] dialog box appears.
 f The [Key Assign] dialog box also appears by double-clicking the [Motion] item.
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5) Press the key to assign on the keyboard, and click [Close].
 f White keys indicate that they have no shortcuts assigned. If you click a key that has other operations assigned, a dialog box to confirm 
whether to change the current setting appears.

 f The shortcuts you have entered are displayed at the [Assign] item.

6) Set each item and click [OK].
 f You can continue to set other items by clicking [Apply].

2
 f Some key combinations sometimes cannot be assigned.
 f Customized shortcuts can be exported and imported into other environments installed with EDIUS.
 f The extension of exported files is *.eap. Both *.dat and *.eap files can be imported.
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Chapter 5
Importing Sources
This chapter explains how to import sources to EDIUS.
There are basically three ways to import sources, and each method differs according to where sources are imported from.
One method is to capture and import sources from DirectShow devices, such as web cameras and external devices stored with tape-based 
video recordings; others are to import files saved on your PC as sources, and to use the source browser to import sources from external 
devices stored with file-based video recordings.
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Capturing

Points to Be Checked before Capturing Sources
The following explains the checks to perform before capturing sources and precautions when connecting to external devices.

Registering External Devices that Interact with Device Presets
For cameras, decks, and other external devices used for capturing, register their connection information, video format for import and other 
information as device presets.
“Registering Device Presets” (w page 130)

Capture Operation Settings
Before setting, connect the external devices to synchronize the input signal. The following cases may occur depending on the 
characteristics of the input devices and the recording state of the tape:
 f Batch capture cannot be performed correctly.
 f Unnecessary files are generated by automatic division.
 f Unnecessary files are created at start of capture.

Capture settings can be checked and changed by [Application] in [System Settings] → [Capture].
“[Capture]” (w page 102)

Connecting to External Devices
Before capture, connect your PC to a camera or other external device to import the source from.

Capturing and Importing Sources 
This section explains how to capture and import sources from a DirectShow-based web camera, and how to capture analog sources.

3 Note
 f For cameras, decks, and other external devices used for importing sources, it is necessary to register their connection information, 
video format for import and other information as device presets in advance.
“Registering Device Presets” (w page 130)

1) Click [Capture] on the menu bar, and click [Select Input Device].
 f The [Select Input Device] dialog box appears, and the list of device presets registered in system settings is displayed.

2) Select a device preset, and click [OK].

3) Set the reel name, if necessary.
 f To set a reel name, uncheck [UserBit is used as a Reel No.] and enter a reel name. You can also select previously entered reel names 
from the list.

4) Click [OK].
 f The camera can now be operated by the Player operation buttons.
“Playback with Player Operation Buttons” (w page 187)

2
 f If you click a timecode in [Cur] on the Player, the [TC Jump] dialog box appears. Enter the timecode in [Destination] and click [Jump] to 
display the frame of the specified timecode.
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3 Note
 f When the source has been captured in MPEG TS format, the information of the preset reel name will not be recorded to the captured 
source file but to the project file. The information of the reel name set at capture will not be reflected even if that source file is opened 
in another project file after EDIUS is restarted.

5) Play back the source to capture, and set the In and Out points.
 f “Setting the In and Out Points” (w page 189)
 f There are other ways of specifying the range to capture.
“How to Specify the Capture Range” (w page 163)

2
 f To capture only the video part, click the [Set In Point] list button on the Player, and click [Set Video In] to set the In point. To set the Out 
point, click the [Set Out Point] list button on the Player, and click [Set Video Out Point].

 f To capture only the audio part, click the [Set In Point] list button on the Player, and click [Set Audio In Point] to set the In point. To set the 
Out point, click the [Set Out Point] list button on the Player, and click [Set Audio Out Point].

6) Click [Capture] on the Player.

 f Capturing starts. The [Capture] dialog box appears, and capturing ends automatically at the Out point.
 f To stop the capture midway, click [Stop].
 f The clip is registered to the bin.

1 Alternative
 f Same operations as steps 1) to 2) are available using the following methods.

 g Click [Capture] on the menu bar, and click [Device Preset Name] to display the device preset.
 g Click the device preset name ([Input Preset 1] to [Input Preset 8]) to display the device preset. (By default, [Input preset 2] to [Input 
Preset 8] are not displayed. Before performing the operation, set to display the buttons in the preview window.)
“Operation Button Settings” (w page 147)

 g Displaying the device preset assigned to the input preset 1: [F2]
 g Displaying the device preset assigned to the input preset 2: [F3]
 g Displaying the device preset assigned to the input preset 3: [F4]

 f Same operation as step 6) is available using the following methods.
 g Press [F9] on the keyboard after step 5).
 g Click the [Capture] list button on the Player, and click [Video and Audio].
 g Only the video part or audio part is captured when the [Capture] list button on the Player is clicked and [Video Only] or [Audio Only] is 
selected.

 g Click [Capture] on the menu bar, and click [Capture].
 g Click [Capture] on the menu bar, and click [Video Capture] or [Audio Capture].

2
 f Files can be automatically divided at capture.
“[Capture]” (w page 102)

 f During capture, you can add a marker with a comment to the source clip.
“Setting Clip Markers at Capture” (w page 280)

 f The batch capture function is supported only on models that can acquire the timecode. Some models may not support timecodes.
 f To change a reel name halfway through the process, for example, when swapping tapes, click [Capture] on the menu bar, and click [Reel 
No. Settings].

 f For EDIUS Workgroup, another EDIUS client on the same network can perform edit while recording by importing the captured data, while 
a source in AVI or MXF format is being captured.

3 Note
 f When the source has been captured in MPEG TS format, the information of the preset clip marker will not be recorded to the captured 
source file but to the project file. The information of the clip marker set at capture will not be reflected even if that source file is opened 
in another project file after EDIUS is restarted.
“Setting Clip Markers at Capture” (w page 280)

How to Specify the Capture Range
There are six ways as follows to specify the capture range (between In and Out points) in steps 5) to 6).
The timecode that is given priority at capture from among the timecodes at [In], [Out] and [Dur] on the Player is underlined.
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 r Open end capture
Capture starts when [Capture] is clicked without specifying the In and Out points, and ends when [Stop] is clicked.
Timecode display on the Player:

Cur 00:00:21;00 In - - : - - : - - ; - - Out - - : - - : - - ; - - Dur - - : - - : - - ; - - Ttl - - : - - : - - ; - -

 r In/Out capture
Specify the In/Out points.
Timecode display on the Player:

Cur 00:00:56;16 In 00:00:35;00 Out 00:00:54;18 Dur 00:00:19;18 Ttl - - : - - : - - ; - -

 r In/Dur capture
Specify the In point, then click the timecode in [Dur] on the Player, enter the duration, and press [Enter] on the keyboard.
* This method is used, for example, to capture from a tape of free run recordings with non-continuous timecodes.
Timecode display on the Player:

Cur 00:00:35;29 In 00:00:25;06 Out 00:00:35;06 Dur 00:00:10;00 Ttl - - : - - : - - ; - -

 r In capture
Capture ends when [Stop] is clicked after only the In point is specified.
Timecode display on the Player:

Cur 00:00:24;15 In 00:00:22;16 Out - - : - - : - - ; - - Dur - - : - - : - - ; - - Ttl - - : - - : - - ; - -

 r Out capture
Specify only the Out point, rewind to the capture start position, and click [Capture].
Timecode display on the Player:

Cur 00:00:33;27 In - - : - - : - - ; - - Out 00:00:31;27 Dur - - : - - : - - ; - - Ttl - - : - - : - - ; - -

 r Dur capture
Click the timecode at [Dur] on the Player without specifying the In and Out points, enter the duration, and press [Enter] on the keyboard. 
Click [Capture] to start capturing.
* This method is used, for example, to capture a line recording for a specified duration of time.
Timecode display on the Player:

Cur 00:01:09;05 In - - : - - : - - ; - - Out - - : - - : - - ; - - Dur 00:00:10;00 Ttl - - : - - : - - ; - -

2
 f In the case of an In/Out capture or In/Dur capture, the timecode to give priority to can be changed to a duration or Out point by clicking 
the [Out] or [Dur] letter on the Player.

 f All timecodes that have been set can be deleted by right-clicking the timecodes at [Dur] and clicking [Clear].

Capture of Stereoscopic Sources (L/R Separate Capture)
Capture stereoscopic sources where the L side and the R side are recorded separately, using the batch capture function.
To capture stereoscopic sources, register compatible device preset in advance. Select [Separate L/R Clips] from the [Stereoscopic] list in 
the [Input H/W, Format Settings] screen for device presets.
“Registering Device Presets” (w page 130)

1) Perform steps 1) to 10) in “Importing Sources All Together (Batch Capture)”.
 f “Importing Sources All Together (Batch Capture)” (w page 166)
After 9) or 10), the [Individual L/R capture] dialog box appears for each item of the batch capture list.
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2) Set a capture method for the R side source.
 f “[Individual L/R capture] Dialog Box” (w page 165)

3) Click [OK].
 f Capturing starts in the order of the L side source and the R side source, and the progress is displayed in [Status] of the [Batch Capture] 
dialog box. When capturing ends, the stereoscopic clip is registered to the bin.

2
 f If only the audio part in a stereoscopic source is batch captured, the WAV file will be created.

[Individual L/R capture] Dialog Box

[How to capture R clip] Select whether to capture the R side source from the same tape as the L side source, or to 
capture from another tape. To capture from the same tape, enter a timecode in [IN Offset].

[File Name] Set a suffix for file names of the L side and the R side.

 r Capturing stereoscopic sources using STORM 3G
To capture sources in the stereoscopic video format using STORM 3G, select a capture method from the following.

[Dual Stream] Record the L side and the R side of the input video to a single file with 2 streams maintained.
[L Only] Capture only L side of the input video.
[R Only] Capture only R side of the input video.
[Side by Side] Combine the L side and the R side of the input video so that the left half of the frame is L and 

the right half is R, and record them as a single file.
The recorded file is stored to the bin as a stereoscopic clip.

[Top and Bottom] Combine the L side and the R side of the input video so that the upper half of the frame is L 
and the lower half is R, and record them as a single file.
The recorded file is stored to the bin as a stereoscopic clip.

[Line Interleave] Combine the L side and the R side of the input video so that L is placed on the upper side of 
the scanning line and R is placed on the lower side, and record them as a single file.
The recorded file is stored to the bin as a stereoscopic clip.

[L/R 2 file output] Record the L side and the R side of the input video by 2 streams into 2 files simultaneously.
The recorded L and R side files are stored to the bin as stereoscopic clips.

[L/R 2 file output - Capture by turns] Use the batch capture function to capture the L side and the R side of the input video 
separately.
The recorded L and R side files are stored to the bin as stereoscopic clips. (The [L/R 2 file 
output - Capture by turns] setting is enabled while batch capturing. When capturing in a 
normal way, only the L side is captured.)

The capture operation with the settings of [Dual Stream], [L Only], [R Only], [Side by Side], [Top and Bottom], [Line Interleave], and [L/R 2 
file output] is the same as the normal capture operation.
The capture operation with the settings of [L/R 2 file output - Capture by turns] is the same as the normal batch capture operation.

2
 f The information of the L side (such as the reel name, user bit, recorded date and time, and timecode) is retained.
 f If you make the setting to automatically divide the file when captured, the file is divided according to the video and audio data of the L side 
when captured in the stereoscopic video format.

Importing from Device Not Possible to Deck Control
Analog sources recorded on video tape, etc. can be imported via Bay or A/D converter. It is also possible to import sources from the Web 
camera, microphone, etc., which is DirectShow-based.

3 Note
 f When analog sources are imported from an analog device or device connected by the HDMI terminal, the device cannot be controlled 
from EDIUS.

 f For external devices used for importing sources, it is necessary to register their connection information, video format for import and 
other information as device presets in advance.
“Registering Device Presets” (w page 130)

1) Locate the start point of the capture part on the external input device.
 f This operation is not required when capturing from a device such as Web camera or microphone.
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2) Click [Capture] on the menu bar, and click [Select Input Device].
 f The [Select Input Device] dialog box appears, and the list of the device presets registered in the system settings is displayed.

3) Select a device preset, and click [OK].

4) Set the reel name, if necessary.
 f To set a reel name, uncheck [UserBit is used as a Reel No.] and enter a reel name. You can also select previously entered reel names 
from the list.

5) Click [OK].

6) Click [Capture] on the Player.

 f Capturing starts.
 f Proceed to step 8) when capturing from the device such as Web camera, microphone, etc.

7) Play back the external input devices.

8) After finishing capturing of necessary parts, click [Stop] in the [Capture] dialog box.
 f When capturing is stopped, the captured clip is registered to the bin.

9) Stop the playback of external input devices.

1 Alternative
 f Same operations as steps 2) to 3) are available using the following methods.

 g Click [Capture] on the menu bar, and click [Device Preset Name] to display the device preset.
 g Click the device preset name ([Input Preset 1] to [Input Preset 8]) to display the device preset. (By default, [Input preset 2] to [Input 
Preset 8] are not displayed. Before performing the operation, set to display the buttons in the preview window.)
“Operation Button Settings” (w page 147)

 g Displaying the device preset assigned to the input preset 1: [F2]
 g Displaying the device preset assigned to the input preset 2: [F3]
 g Displaying the device preset assigned to the input preset 3: [F4]

 f Same operation as step 6) is available using the following methods.
 g Press [F9] on the keyboard after step 5).

3 Note
 f The source settings, such as bitrate or frame size, vary depending on your device.

Capturing Sources All Together

Importing Sources All Together (Batch Capture)
The following explains how to determine the directory to capture sources to in advance and import sources all together.

1) Click the [Add to Batch Capture List] list button on the Player.

2) Click [Batch Capture].
 f The [Batch Capture] dialog box appears.
“[Batch Capture] Dialog Box” (w page 168)
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1 Alternative
 f Click [Capture] on the menu bar, and click [Batch Capture].
 f Displaying the [Batch Capture] dialog box: [F10]

3) Select the device preset from the list at [Input Settings].

4) Set the reel name, if necessary.
 f To set a reel name, uncheck [UserBit is used as a Reel No.] and enter a reel name. You can also select previously entered reel names 
from the list.

3 Note
 f When the source has been captured in MPEG TS format, the information of the preset reel name will not be recorded to the captured 
source file but to the project file. The information of the reel name set at capture will not be reflected even if that source file is opened 
in another project file after EDIUS is restarted.

5) Play back the source to capture, and set the In and Out points.
 f When the In point is placed ahead of the Out point on the timeline, the text in that row is displayed in red. This area will not be captured.
“Setting the In and Out Points” (w page 189)

2
 f The In point and duration can also be specified as the capture range. After setting the In point, click the [Dur] timecode on the Player to 
enter the duration and then press [Enter] on the keyboard.

6) Click [Add to Batch Capture List] in the [Batch Capture] dialog box.

1 Alternative
 f Click [Add to Batch Capture List] on the Player.
 f Click the [Add to Batch Capture List] list button on the Player, and click [Video and Audio].
 f Only the video part or audio part is captured when the [Add to Batch Capture List] list button on the Player is clicked and [Video Only] or 
[Audio Only] is clicked.

 f Adding to batch capture list: [Ctrl] + [B]

7) Repeat steps 3) to 6).

8) Turn on the check buttons for the sources to capture from the list in the [Batch Capture] dialog box.
 f The check buttons are turned on immediately after the sources are added to the list.

XXXXXX

XXXXXX XXX XXXXXX XXXXXX XXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXX XXX

9) Click [Capture] in the [Batch Capture] dialog box.
 f If a reel name is not set in step 4), capturing starts and the progress is displayed in [Status] of the [Batch Capture] dialog box. The 
captured clip is registered to the bin.

 f If you set a reel name in step 4), proceed to step 10).

10) Insert a tape in your camera, and select the corresponding reel name from the [Please insert the 
tape, and select the reel name.] list.

 f The time required for capturing is indicated next to the reel name.

11) Click [OK].
 f Capture of the source corresponding to the selected reel name starts, and the progress is displayed in [Status] of the [Batch Capture] 
dialog box. The captured clip is registered to the bin.

 f If you set multiple reel names, repeat steps 10) to 11).
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[Batch Capture] Dialog Box

:XXX XXXXXX:XXX

XXXXXX

XXXXXX XXXXXX

XXXXXX

XXXXXX

XXXXXX XXX XXXXXX XXXXXX XXXXX

XXXXXX

XXXXXX :

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXX XXX

XXXXXX

XXXXX

XXX XXXXXXNo.

(1) (2) (3) (4)

(5)

(6)(7)
(8)(9)

(10)

(11)

(12)

(1) [Create new capture 
list]

Create a new batch capture list.

(2) [Load capture list] Import the saved batch capture list (ECL, CSV, RNL, ALE or FCL file).
(3) [Save capture list] Save the content of the batch capture list as a CSV file.
(4) [Add to Batch Capture 

List]
Add to the batch capture list.

(5) Source to be captured Check the sources to capture from the list.
(6) [Reel No.] Click this button to edit a reel name. If there is not even one batch capture list set with a reel 

name, the [Reel No.] items are not displayed in the dialog box.
(7) [In]/[Out]/[Duration] Display the In and Out points and duration of the source.

The timecode that is given priority at capture is underlined. To change the timecode that is 
given priority, select the source and right-click, and click [Change to In/Out capture] or [Change  
to In/Duration capture].
The numerical value can also be changed by clicking the timecode at [In]/[Out]/[Duration].

(8) [Type] Click and select the content to capture (both video and audio parts/video part only/audio part 
only).

(9) [File Name] Click this item to specify the file name and save destination of the source to capture. Click the 
folder icon to specify the save destination of the source to capture. You can also select multiple 
sources to specify the save destination.

(10) Number of sources and 
duration

Display the number of checked sources/total number of sources in list and each duration. 
During a capture, the duration available for capture, current disk space usage, and the number 
of file divisions are displayed.

(11) Clip marker During capture, add a marker with a comment to the source clip. A list of clip marker timecodes 
and comments is displayed. Multiple clip markers can be assigned. When the source has been 
captured in MPEG TS format, the information of the preset clip marker will not be recorded to 
the captured source file but to the project file. The information of the clip marker set at capture 
will not be reflected even if that source file is opened in another project file after EDIUS is 
restarted.
“Setting Clip Markers at Capture” (w page 280)

(12) [Input Settings] Click the list to select the device preset used for capture.
[Capture Settings]
Display the [System Settings] dialog box. You can check and change [Capture].

2
 f To delete the source to capture from the batch capture list, select and right-click the source, and click [Delete].
 f To select all sources in the batch capture list, select and right-click the source, and click [Select All].
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Saving Batch Capture Lists
You can save batch-captured sources as a list.

1) Click the [Add to Batch Capture List] list button on the Player.

2) Click [Batch Capture].
 f The [Batch Capture] dialog box appears.
“[Batch Capture] Dialog Box” (w page 168)

1 Alternative
 f Click [Capture] on the menu bar, and click [Batch Capture].
 f Displaying the [Batch Capture] dialog box: [F10]

3) Click [Save capture list].

4) Set a file name and save destination, and click [Save].

2
 f When “Mode1” is selected for the save format, hours/minutes/seconds/frames will be entered in a column. When “Mode2” is selected, 
hours/minutes/seconds/frames will be entered in each respective column.

Importing Batch Capture Lists
Import saved batch capture lists.
Batch capture lists can be imported in the following formats:
 f Batch capture list (*.ecl): Binary format file of batch capture list
 f CSV file (*.csv): Text format file containing data delimited by commas
 f RNL file (*.rnl): Files created by Grass Valley StormNavi, RexNavi, RaptorNavi, or EzNavi
 f ALE file (*.ale): Files equivalent to Avid Log Exchange batch capture list
 f FCL file (*.fcl): Files equivalent to Final Cut Pro batch capture list

3 Note
 f When a batch capture list other than a CSV file created with EDIUS has been imported, capture becomes In/Out capture, and video 
and audio parts are captured.

 f If you import the FCL file to EDIUS, the condition below must be met:
 g Files in which “Name”, “Rules”, “Start of media”, and “End of media” columns are described
 g Files with the “*.fcl” extension
 g Files exported by Final Cut Pro 6 or later

 f To import ALE files to EDIUS, “Name”, “Start”, “End”, or “Duration” columns must be described in the ALE file.

1) Click the [Add to Batch Capture List] list button on the Player.

2) Click [Batch Capture].
 f The [Batch Capture] dialog box appears.
“[Batch Capture] Dialog Box” (w page 168)

1 Alternative
 f Click [Capture] on the menu bar, and click [Batch Capture].
 f Displaying the [Batch Capture] dialog box: [F10]

3) Click [Load capture list].
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4) Select the extension of the file to import in [File of type], select the file and click [Open].
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Importing File

Importing File
To import a file saved on your PC to EDIUS, they must first be registered to the bin as a clip. The following explains how to register files or 
file formats that can be imported to EDIUS to the bin.

Registerable File Formats
The following lists the file formats that can be imported to EDIUS:
 f Operation is not guaranteed for all formats described in this section.

 r Video

3 Note
 f Some codecs may not support partial transfer.
 f Some video formats may not support partial transfer/trimming.

Format File extension
3GPP *.3gp, *.3g2, *.amc
AVCHD *.m2ts, *.mts
AVI*1 *.avi
Blackmagic RAW *.braw
Cinema RAW *.xml
Cinema RAW Light *.crm
DIF stream *.dif, *.dv
Flash Video *.f4v
H.265/HEVC *.mov, *.mp4
JPEG2000 *.mov
MPEG HDD MOVIE *.mod, *.tod
MPEG Program Stream*2 *.mpg, *.mpeg, *.m2p, *.mp2, *.vob, *.vro
MPEG Transport Stream *.m2t
MPEG Video Stream *.mpv, *.m2v
MP4 *.mp4, *.m4v
MXF*1 *.mxf
P2 (DV, DVCPRO, DVCPRO50, DVCPRO HD, AVC-Intra, AVC-LongG, AVC-Intra 
4K/2K)

*.xml, *.mxf

PNG *.mov
ProRes RAW *.mov
QT Animation *.mov
QuickTime Movie*1 *.mov
RED *.R3D
SONY HVR-DR60/HVR-MRC1 Meta file *.idx
Sony RAW *.xml, *.mxf
Sony X-OCN *.xml, *.mxf
TIFF *.mov
Transport Stream (MPEG-2, H.264) *.ts
Windows Media*1 *.wmv, *.asf
XAVC (XAVC Intra/XAVC Long GOP) *.xml, *.mxf
XAVC S *.xml, *.mp4
XDCAM (MPEG HD422, MPEG HD, MPEG IMX, DVCAM) *.xml, *.mxf
XDCAM EX *.mp4, *.avi, *.smi, *.xml
XF *.cif, *.mxf
XF-AVC *.mxf

*1 The codec may not be supported depending on the video format.
*2 Use the source browser to import VOB files if they cannot be imported.
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 r Audio

Format File extension
AAC *.aac, *.m4a
AIFF*1 *.aiff, *.aif
ALAC *.m4a
Dolby Digital (AC-3) *.ac3
Flac *.flac
MPEG Audio Layer-3*2 *.mp3
MPEG Audio Stream *.mpa, *.m2a
Ogg Vorbis file *.ogg
Opus *.opus
Wave *.wav
Windows Media Audio *.wma

*1 AIFF/AIFC files are PCM only.
*2 Some VBR are not supported.

 r Still image
Import of still images with sequential numbers is supported.

Format File extension
Cinema DNG *.dng
DPX (SMPTE 268M-2003) *.dpx
Flash Pix *.fpx
GIF (CompuServeGIF) *.gif
ICO *.ico, *.icon
JPEG *.jpg, *.jpeg
JPEG File Interchange Format *.jfif
Mac Pict *.pic, *.pct, *.pict
Maya IFF* *.iff
Multi-PictureFormat *.mpo
Photoshop *.psd
PNG (Portable Network Graphics) *.png
QuickTime Image *.qtif, *.qti, *.qif
Quick Titler *.etl, *.etl2
SGI *.sgi, *.rgb
Targa *.tga, *.targa, *.vda, *.icb, *.vst
TIFF *.tif, *.tiff
Windows Bitmap *.bmp, *.dib, *.rle
Windows Meta files *.wmf, *.emf
WMPhoto *.wdp

* Z-depth is not supported.

2
 f Electronic Arts IFF files (*.iff) are not supported on EDIUS.

 r Caption

Format File extension
Scenarist Closed Caption *.scc
MacCaption *.mcc

Registering a File to the Bin as a Clip
Select and register a source to the bin.
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1) Click [Add Clip] in the bin.

 f The [Open] dialog box appears.

2) Select a file and set the following items if necessary.

[Poster frame] Enter the timecode, or move the slider to the left and right to set the poster frame of the clip.
[Show properties] Check this item to display the [Clip Properties] dialog box and view clip properties.

“[Clip Properties] Dialog Box” (w page 203)
[Transfer to Project folder] Transfer the clip to the project folder.
[Sequence clip] Import the still image clips with sequential numbers in a single operation, and register them to 

the bin.
“Registering Consecutive Still Images” (w page 173)

[Detect captions file] Use this option to detect a closed caption file that corresponds to the selected file, merge it, 
and then register to the bin.
“Merging Closed Caption File and Registering” (w page 174)

[Name] To rename a clip registration in the bin, enter the new name of the clip.
[Comment] Enter a comment.
[Clip color] Color the display of clips.

3) Click [Open].

1 Alternative
 f Click [File] on the menu bar, and click [Add Clip]. Select the source from the [Add Clip] dialog box, and click [Open] to display the source 
clip on the Player. Click [Add Clip on Player to Bin] on the Player.

 f Double-click a blank area of the clip view, select the source from the [Open] dialog box, and click [Open].
 f Right-click a blank area in the clip view, and click [Add File]. Select the source from the [Open] dialog box, and click [Open].
 f Open the folder containing the sources in Explorer, and drag and drop the source to register onto a folder in the clip view or folder view.
“Registering Folders” (w page 174)

 f Press [Ctrl] + [O] on the keyboard, select the source from the [Open] dialog box, and click [Open].

2
 f You can also register sources displayed on the Player by dragging and dropping them onto the bin.
“Registering Clips Displayed on the Player to the Bin” (w page 192)

Registering Consecutive Still Images
Import the still image clips with sequential numbers in a single operation, and register them to the bin.

1) Click [Add Clip] in the bin.

 f The [Open] dialog box appears.

1 Alternative
 f Adding clips: [Ctrl] + [O]

2) Select the first of the consecutive files, check [Sequence clip], and click [Open].
 f All of the consecutive still image files in the same folder are registered as a single sequence clip to the bin.
 f As consecutive files are regarded as a single sequence clip, if a file is missing in the sequence, files with subsequent numbers will not be 
imported.

2
 f You can divide a sequence clip registered to the bin into individual still image clips, or use it again as a sequence clip.
“Canceling a Set Sequence” (w page 197)
“Joining Multiple Clips (Set as Sequence)” (w page 197)
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Merging Closed Caption File and Registering
You can detect a closed caption file that corresponds to the selected file, merge it, and then register to the bin.

1) Click [Add Clip] in the bin.

 f The [Open] dialog box appears.

1 Alternative
 f Adding clips: [Ctrl] + [O]

2) Select a file.
 f Select a file with which a closed caption file is to be merged.
 f Multiple files can be selected.

3) Check [Detect captions file], and click [Open].
 f A closed caption file that corresponds to the selected file will be detected, and then registered to the bin as a single clip.

2
 f A closed caption file to be merged must satisfy the following conditions.

 g A file with the same name as the selected clip except for the extension
 g A file that exists in the same folder as the selected clip
Note that a closed caption file in a separate folder may be detected for some files.

 f You can merge a caption clip with a video clip, or cancel merged clips in the bin.
“Merging a Caption Clip” (w page 201)
“Canceling Merged Caption Clip” (w page 202)

 f You can register a closed caption file alone to the bin by using the same procedure as when registering other files to the bin.

Registering Folders
Register a folder containing supported source formats with the folder structure held intact.

1) In the folder view of the bin, right-click the folder to register, and click [Open Folder].
 f The [Browse For Folder] dialog box appears.

2) Select a folder, and click [OK].

1 Alternative
 f Display the folder in Explorer, and drag and drop the folder to register onto the folder displayed in the clip view or folder view.

Source Browser
To import files saved on external devices in which file-based video or audio are recorded (e.g. AVCHD video camera, professional-use video 
camera, removable media such as SD memory card, XDCAM EX device) to EDIUS, perform the operations with the source browser. On the 
source browser, the folder structure of media is recognized automatically and the stored files are displayed quickly. You can also register the 
displayed clips to the bin or transfer the files to a PC.
Sources can be imported in the same way even when files on devices have been copied to the hard disk on the PC with the folder structure 
held intact.

3 Note
 f Sources cannot be imported from copy-protected discs.
 f Supports only the BDMV format BD.
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Formats Supported by Source Browser
The formats that can be viewed by the source browser are as follows:
The supported formats, codecs, and extensions depend on the files that can be imported.
 f Operation is not guaranteed for all formats described in this section.

Device Format/container Codec Source browser tree
AU-EVA1 MOV H.264/AVC [Removable Media]
AVCCAM AVCHD ― [Removable Media]

AVCHD Camera AVCHD ― [Removable Media]
Blu-ray*1 BDMV ― [Removable Media]

Cinema RAW/Cinema RAW 
Light

RMF Cinema RAW
[Cinema RAW]

CRM Cinema RAW Light

Cine Alta MXF
XAVC

[XDCAM]
MPEG HD422

CINEMA EOS
MOV Motion JPEG

[Removable Media]
AVCHD ―

DSLR
MOV H.264/AVC

[Removable Media]MP4 H.264/AVC
AVCHD ―

GoPro MP4 H.264/AVC [Removable Media]
Mobile SD-Video ― [Removable Media]

NXCAM AVCHD ― [Removable Media]

P2 MXF

DVCPRO25

[P2]

DVCPRO50
DVCPRO HD
AVC-Intra 50
AVC-Intra 100
AVC-Intra 200
AVC-LongG

RED R3D RED [RED]

Sony RAW/X-OCN MXF
Sony RAW

[Sony RAW]
Sony X-OCN

XAVC
MXF

XAVC Intra
[XDCAM]XAVC Long GOP

MP4 XAVC S

XDCAM MXF

DVCAM

[XDCAM]
MPEG IMX
MPEG HD

MPEG HD422
XDCAM EX MP4 XDCAM EX [XDCAM EX]

X Series MXF
XF-AVC

[XF]
MPEG-2

*1 Copy-protected files cannot be imported.

Showing/Hiding Source Browser Window
Switch the show/hide setting for the source browser window.

1) Click [View] on the menu bar, and click [Source Browser].

2
 f When the show/hide setting for the source browser window is switched, the show/hide setting for the bin window or palette tabs combined 
with the source browser window is also switched. To toggle the show/hide setting individually, release the association of the window and 
the palette.
“Combining Bin Window/Source Browser Window with a Palette” (w page 145)
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Source Browser Clip Display
In the source browser, source files are displayed as clips. Three types of clips are displayed: video clips, audio clips and still image clips.

Clip (2)

(1)

(1) Poster frame/thumbnail 
display

Displays a representative image of clip or thumbnail.

(2) Clip name Displays the clip name.

Selecting Clips
Clips are selected in the source browser in the same way as in the bin.
“Selecting Clips” (w page 208)

Sorting Clips
Clips are sorted in the source browser in the same way as in the bin.
“Sorting Clips” (w page 209)

Switching the Display Folder
Displayed folders are switched in the source browser in the same way as in the bin.
“Switching the Display Folder” (w page 212)

Checking Clip Properties
Clip details such as the frame rate and start timecode of clips can be checked.

2
 f Duration, file size and other clip properties can be checked when the clip view is switched to the detailed clip view.
“Clip View Display” (w page 157)

1) Select a clip in the clip view, and click [Properties] in the source browser.

 f The [Clip Properties] dialog box appears.
“[Clip Properties] Dialog Box” (w page 176)

1 Alternative
 f Right-click a clip and click [Properties].
 f Checking properties: [Alt] + [Enter]

2) Confirm the details, and click [OK].

[Clip Properties] Dialog Box

The displayed tab varies according to the type of clip.

[File] tab Check type, data size, and other details of files.
[Video] tab Check the start TC (timecode) and end TC, or image size, poster frame, aspect ratio, color 

space, color correspondence range, field order, codec, frame rate, and other information.
[Stereoscopic] tab If a clip is not a stereoscopic clip, divide a clip to handle it as a stereoscopic clip.

“Handling Non-Stereoscopic Clips as Stereoscopic Clips” (w page 201)
[Audio] tab Check the start and end TCs, or re-acquire wave information (waveform representation of 

audio).
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[Still image] tab Check the format or image size, duration, aspect ratio, color space, and color correspondence 
range.

[Extended] tab Check the expansion information of a file or clip. The details displayed differ depending on the 
clip type.

[Captions] tab Set whether or not the caption information is to be used.
If a closed caption file has been merged to the file, the saving destination of the currently 
referenced file can also be confirmed.
“Using Caption Information of Clip” (w page 202)

Searching by the Simple Search Bar
Clips are searched for by the simple search bar in the source browser in the same way as in the bin.
“Searching by the Simple Search Bar” (w page 214)

Importing Source Browser File by Copying
To import files saved on external devices in which file-based video or audio are recorded (e.g. AVCHD video camera, professional-use video 
camera, removable media such as SD memory card, XDCAM EX device) to EDIUS, perform the operations with the source browser.
Sources imported from the source browser are registered to the current folder on the bin at the same time that they are transferred to hard 
disk on the PC.

2
 f You can set the transfer destination used when importing files by clicking [Application] in [System Settings] → [Source Browser].
“[Source Browser]” (w page 103)

Points to Be Checked before Importing Sources
Source files can be imported easily from AVCHD video camera/removable media/XDCAM EX/P2/XDCAM/XF devices using the source 
browser.
Files can be checked immediately or transferred in the background by simply connecting a device or drive to your PC and inserting the 
storage media.
If you use Mync bundled with EDIUS, you can import clips registered in Mync or storyboards created with Mync to EDIUS.
 f “Importing from Digital Camera” (w page 177)
 f “Importing Sources from XDCAM EX Devices” (w page 178)
 f “Importing P2 Sources” (w page 179)
 f “Importing from XDCAM Devices” (w page 179)
 f “XDCAM Importer Settings” (w page 108)
 f “XDCAM Browser Settings” (w page 109)
 f “Importing RED Sources” (w page 180)
 f “Importing Cinema RAW or Cinema RAW Light Sources” (w page 181)
 f “Importing Sony RAW Sources” (w page 181)
 f “Importing XF Sources” (w page 182)
 f “Importing Stereoscopic Sources” (w page 182)
 f “Importing Clips or Other Sources Registered to Mync” (w page 183)

When each of the sources has been copied to the hard disk with the folder structure held intact, the sources can be imported simply from 
the source browser if the reference folder is set up in the system settings in advance.
 f “[Removable Media]” (w page 108)
 f “[XDCAM EX]” (w page 108)
 f “[P2]” (w page 107)
 f “XDCAM Browser Settings” (w page 109)
 f “RED Browser Settings” (w page 106)
 f “Cinema RAW Browser Settings” (w page 110)
 f “Sony RAW Browser Settings” (w page 111)
 f “[XF]” (w page 109)

Importing from Digital Camera
Sources can be imported from an AVCHD video camera or removable media such as SD memory card, memory stick and BD. Sources are 
registered to the bin at the same time that they are transferred to the PC.
Connect an AVCHD video camera or removable media to the PC, and check that the power is turned on. For more information on 
connection methods, see the manual for your device.
Sources can be imported in the same way even when files on devices have been copied to the hard disk on the PC with the folder structure 
held intact.



Chapter 5   Importing Sources — Importing File

178

2
 f Supported formats are AVCHD, BD, SD-Video, Memory Stick Video, and DCF (still images saved in digital camera file format). Only the 
BDMV format is supported for BD.

3 Note
 f Sources cannot be imported from copy-protected disks.

1) Click the [Removable Media] tree in the folder view of the source browser.
 f The drive connected to your PC is recognized, and is displayed in the folder view tree.

2) Insert the storage media into the drive.

3) Click the media name.
 f Information on the media is displayed in the clip view.
 f Folders are sometimes categorized by type in the layer under the drive depending on the connected device.

2
 f When files in the AVCHD video camera or removable media have been copied to the hard disk on the PC, right-click [Removable Media], 
and click [Open Folder] to specify the reference destination.
References can be deleted from the tree display by right-clicking a folder and clicking [Delete] only when they have been added from the 
tree display in the source browser. Actual folders are not deleted.

 f To update the information on media, right-click [Removable Media] and click [Refresh].

4) Select the file to import, and click [Add and Transfer to Bin] in the source browser.

 f Data transfer to the PC is started in the background at the same time that the file is registered to the bin as a clip.
“Checking the Progress of Background Jobs” (w page 183)

1 Alternative
 f Right-click the file to import, and click [Add and Transfer to Bin].

Importing Sources from XDCAM EX Devices
Register sources to the bin at the same time that they are transferred to the PC from SxS memory card.
Connect the XDCAM EX device to the PC, and check that the power is turned on.
Sources can be imported in the same way even when files on SxS memory cards have been copied to the hard disk on the PC with the 
folder structure held intact.

2
 f Sources in XDCAM EX 3D format can also be imported.
 f For sources recorded across multiple SxS memory card as a sequence clip, connect all sources to PC or import the folder in which the 
contents of the SxS memory cards are copied to the source browser, and register sources in the order from the first SxS memory card to 
the bin. Each clip is linked and registered as a sequence clip to the bin.

1) Click the [XDCAM EX] tree in the folder view of the source browser.

2) Click the drive.
 f Information on the SxS memory card is displayed in the clip view.

2
 f When files on the SxS memory card have been copied to the hard disk on the PC, right-click [XDCAM EX], and click [Open Folder] to 
specify the reference.
References can be deleted from the tree display by right-clicking a folder and clicking [Delete] only when they have been added from the 
tree display in the source browser. Actual folders are not deleted.

 f To update the information of the device, right-click [XDCAM EX] and click [Refresh].
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3) Select the clip to import, and click [Add and Transfer to Bin] in the source browser.

 f Data transfer to the PC are started in the background at the same time that the clip is registered to the bin.
“Checking the Progress of Background Jobs” (w page 183)

1 Alternative
 f Right-click the clip to import, and click [Add and Transfer to Bin].

2
 f Take clips are registered to the current folder of the bin as a sequence clip.

Importing P2 Sources
Register P2 sources to the bin at the same time that they are transferred to the PC.
Connect the P2 device to the PC, and check that the power is turned on.
P2 sources copied to the hard disk on the PC also can be imported in the same way. Copy sources with the folder structure in the device 
held intact.

2
 f Sources in 3D P2 format can also be imported. Insert two P2 cards into the slot.
“Importing Stereoscopic Sources” (w page 182)

3 Note
 f The drivers provided with the P2 device must be installed in advance.

1) Click the [P2] tree in the folder view of the source browser.

2) Click the drive or reference folder.
 f The P2 sources are displayed in the clip view.

2
 f Reference folders can be temporarily added in the folder view of the source browser. Right-click [P2] and click [Open Folder].
 f When references have been temporarily added in the source browser, they can be deleted by right-clicking a folder and clicking [Delete]. 
Actual folders are not deleted.

 f To update the information of references, right-click [P2] and click [Refresh].

3) Select the clip to import, and click [Add and Transfer to Bin] in the source browser.

 f Data transfer to the PC will be started in the background at the same time that the clip is registered to the bin.
“Checking the Progress of Background Jobs” (w page 183)

1 Alternative
 f Right-click the clip to import, and click [Add and Transfer to Bin].

2
 f Clip names registered to the bin are “user clip name” when a user clip name has been set to the P2 clip, and “clip name” when a user clip 
name has not been set.

 f When editing with EDIUS, P2 clips can be used in the same way as AVI clips. When editing from hard disk, realtime performance 
becomes the same as that of AVI files of the same format. When editing directly from the P2 drive, performance becomes 2 stream 
realtime in the case of DV, and 1 stream realtime in the case of DVCPRO50. (The above performances are based on the measurement by 
Grass Valley. CPU performance varies depending on your system.)

 f Partial transfer is available, where In and Out points are set to files on the P2 device and only required parts are transferred to the hard 
disk.
“Transferring Only Necessary Part” (w page 185)

Importing from XDCAM Devices
Register XDCAM sources to the bin at the same time that they are transferred to the PC.
Before importing sources from an XDCAM device, connect the XDCAM device to the PC, and check that the power is turned on.
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XDCAM sources copied to the hard disk on the PC and proxy clips recorded on USB memory also can be imported in the same way. When 
copying sources to hard disk on the PC, copy sources with the folder structure in the device held intact.
Import settings can be checked and changed by [Importer/Exporter] in [System Settings] → [XDCAM] → [Browser].
“XDCAM Browser Settings” (w page 109)

2
 f The SAM mode is supported.

3 Note
 f The drivers provided with the XDCAM device must be installed in advance.

1) Click the [XDCAM] tree in the folder view of the source browser.

2) Click the drive or reference folder.
 f The XDCAM sources are displayed in the clip view.

2
 f Reference folders can be temporarily added in the folder view of the source browser. Right-click [XDCAM] and click [Open Folder].
 f When references have been temporarily added in the source browser, they can be deleted by right-clicking a folder and clicking [Delete]. 
Actual folders are not deleted.

 f To update the information of references, right-click [XDCAM] and click [Refresh]. If it takes time to display the thumbnail for a clip, press 
[Esc] on the keyboard to stop refreshing of the list.

3) Select the clip to import, and click [Add and Transfer to Bin] in the source browser.

 f Data transfer to the PC is started in the background at the same time that the clip is registered to the bin.
“Checking the Progress of Background Jobs” (w page 183)

 f The clip can be edited with EDIUS even during transfer.

1 Alternative
 f Right-click the clip to import, and click [Add and Transfer to Bin] → a clip type.

2
 f Partial transfer is available, where In and Out points are set to files on the XDCAM device and only required parts are transferred to the 
hard disk. A message will appear if no connection has been made to the directory where the high-resolution data is saved when partial 
transfer is performed on the XDCAM clip. Insert the disk, and click [OK].
“Transferring Only Necessary Part” (w page 185)

Importing RED Sources
Register RED sources to the bin at the same time that they are transferred to the PC.
Connect the RED device to the PC, and check that the power is turned on.
RED sources copied to the hard disk on the PC also can be imported in the same way. Copy sources with the folder structure in the device 
held intact.

3 Note
 f The drivers provided with the RED device must be installed in advance.

1) Click the [RED] tree in the folder view of the source browser.

2) Click the drive or reference folder.
 f The RED sources are displayed in the clip view.

2
 f Reference folders can be temporarily added in the folder view of the source browser. Right-click [RED] and click [Open Folder].
 f When references have been temporarily added in the source browser, they can be deleted by right-clicking a folder and clicking [Delete]. 
Actual folders are not deleted.

 f To update the information of references, right-click [RED] and click [Refresh].
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3) Select the clip to import, and click [Add and Transfer to Bin] in the source browser.

 f Data transfer to the PC will be started in the background at the same time that the clip is registered to the bin.
“Checking the Progress of Background Jobs” (w page 183)

1 Alternative
 f Right-click the clip to import, and click [Add and Transfer to Bin].

Importing Cinema RAW or Cinema RAW Light Sources
You can register Cinema RAW or Cinema RAW Light sources to the bin at the same time that they are transferred to the PC.
This section explains the procedure to import a Cinema RAW source. Perform the same procedure to import a Cinema RAW Light source.
Connect the Cinema RAW device to the PC, and check that the power is turned on.
Cinema RAW sources copied to the hard disk on the PC also can be imported in the same way. Copy sources with the folder structure in the 
device held intact.

3 Note
 f The drivers provided with the Cinema RAW device must be installed in advance.

1) Click the [Cinema RAW] tree in the folder view of the source browser.

2) Click the drive or reference folder.
 f The Cinema RAW sources are displayed in the clip view.

2
 f Reference folders can be temporarily added in the folder view of the source browser. Right-click [Cinema RAW] and click [Open Folder].
 f When references have been temporarily added in the source browser, they can be deleted by right-clicking a folder and clicking [Delete]. 
Actual folders are not deleted.

 f To update the information of references, right-click [Cinema RAW] and click [Refresh].

3) Select the clip to import, and click [Add and Transfer to Bin] in the source browser.

 f Data transfer to the PC will be started in the background at the same time that the clip is registered to the bin.
“Checking the Progress of Background Jobs” (w page 183)

1 Alternative
 f Right-click the clip to import, and click [Add and Transfer to Bin].

Importing Sony RAW Sources
Register Sony RAW sources to the bin at the same time that they are transferred to the PC.
Connect the Sony RAW device to the PC, and check that the power is turned on.
Sony RAW sources copied to the hard disk on the PC also can be imported in the same way. Copy sources with the folder structure in the 
device held intact.

3 Note
 f The drivers provided with the Sony RAW device must be installed in advance.

1) Click the [Sony RAW] tree in the folder view of the source browser.

2) Click the drive or reference folder.
 f The Sony RAW sources are displayed in the clip view.

2
 f Reference folders can be temporarily added in the folder view of the source browser. Right-click [Sony RAW] and click [Open Folder].
 f When references have been temporarily added in the source browser, they can be deleted by right-clicking a folder and clicking [Delete]. 
Actual folders are not deleted.
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 f To update the information of references, right-click [Sony RAW] and click [Refresh].

3) Select the clip to import, and click [Add and Transfer to Bin] in the source browser.

 f Data transfer to the PC will be started in the background at the same time that the clip is registered to the bin.
“Checking the Progress of Background Jobs” (w page 183)

1 Alternative
 f Right-click the clip to import, and click [Add and Transfer to Bin].

2
 f Partial transfer is available, where In and Out points are set to files on the Sony RAW device and only required parts are transferred to the 
hard disk.
“Transferring Only Necessary Part” (w page 185)

Importing XF Sources
Register XF sources to the bin at the same time that they are transferred to the PC.
Connect the XF device to the PC, and check that the power is turned on.
XF sources copied to the hard disk on the PC also can be imported in the same way. Copy sources with the folder structure in the device 
held intact.

3 Note
 f The drivers provided with the XF device must be installed in advance.

1) Click the [XF] tree in the folder view of the source browser.

2) Click the drive or reference folder.
 f The XF sources are displayed in the clip view.

2
 f Reference folders can be temporarily added in the folder view of the source browser. Right-click [XF] and click [Open Folder].
 f When references have been temporarily added in the source browser, they can be deleted from the tree display by right-clicking a folder, 
and clicking [Delete]. Actual folders are not deleted.

 f To update the information of references, right-click [XF] and click [Refresh].

3) Select the clip or playlist to import, and click [Add and Transfer to Bin] in the source browser.

 f Data transfer to the PC is started in the background at the same time that the clip or playlist is registered to the bin.
“Checking the Progress of Background Jobs” (w page 183)

1 Alternative
 f Right-click the clip or playlist to import, and click [Add and Transfer to Bin].

2
 f Clips that have been recorded across multiple media are registered to the current folder on the bin as a sequence clip.
 f Partial transfer is available, where In and Out points are set to files on the XF device and only required parts are transferred to the hard 
disk.
“Transferring Only Necessary Part” (w page 185)

Importing Stereoscopic Sources
Register file-based stereoscopic sources to the bin at the same time that they are transferred to the PC.

Example:

To import sources in 3D P2 format

1) Insert two P2 cards into the slot.
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2) Click the [P2] tree in the folder view of the source browser.

3) Click the drive displayed as [Stereoscopic].
 f The stereoscopic sources are displayed in the clip view. The stereoscopic sources are marked with the “S” icon.

4) Select the clip to import in the [L] or [R] folder, and click [Add and Transfer to Bin] in the source 
browser.

 f Data transfer to the PC starts in the background at the same time that the stereoscopic clip is registered to the bin.
“Checking the Progress of Background Jobs” (w page 183)

2
 f If sources are imported from the drive that is not displayed as [Stereoscopic], the L side or the R side source will be imported separately.

Importing Clips or Other Sources Registered to Mync
You can import clips registered to Mync or storyboards created with Mync to EDIUS.
You can register catalogs/smart catalogs whose clips have been grouped with Mync directly to the bin.
You can also start up Mync from the source browser.
For more information on how to operate, refer to the manual of Mync.

2
 f You can change the view of folders and clips on the source browser from [Importer/Exporter] in [System Settings] → [Mync].
“[Mync]” (w page 109)

3 Note
 f Interaction with Mync is supported only for Mync that comes with EDIUS.

Checking the Progress of Background Jobs
The following explains how to check the progress of processing (background jobs) such as file transfer that is executed in the background 
and how to pause/restart processing.
The execution progress of background jobs can be checked on the status bar in the timeline window or the clip display.

Status Bar Display in Timeline Window

The status bar displays the number of background jobs and an icon indicating the current state of background jobs.

 r Executing
This is displayed when a background job is executing. The icon is also displayed when EDIUS is executing an automatic process job such 
as creation of seek information.

 r Standing by/suspended
This is displayed when there are no background jobs and when a background job has been canceled.

 r Paused
This is displayed when a background job is paused.
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Bin Clip Display

The icon indicating that the background job is executing is displayed, and progress is displayed as a progress bar and a percentage.

Example:

Clips registered in the bin are being transferred to the project folder.

Clip

H 38%

Transfer Status Detailed Display

In the [Background Job] dialog box, detailed transfer status can be checked, and the background jobs can be paused and deleted, for 
example.

1) Click [Show Background Job] in the source browser.

 f The [Background Job] dialog box appears.
“[Background Job] Dialog Box” (w page 184)

1 Alternative
 f Click [View] on the menu bar, and click [Background Job].

3 Note
 f The confirmation message for the background job process will appear if the sequence is imported or consolidated, or the project file is 
closed, for example, while there is still a background job that has not finished executing.
Click [Show Unfinished Job Info] to display the [Background Job] dialog box. Click [Quit Unfinished Jobs] to delete all jobs.

[Background Job] Dialog Box

Job list Displays jobs currently executing and waiting to be executed in a list.
To cancel execution of a job, select the job and right-click, and click [Stop] or [Stop All].
To delete a job, select the job and right-click, and click [Delete].
To pause or resume execution of a job, select the job and right-click, and click [Pause] or 
[Restart].

[Pause Background Jobs During 
Playback]

Check this item to pause the execution of the job while the Player or timeline is being played 
back.

[Pause]/[Resume] Pause or resume execution of all jobs by selecting and clicking the jobs.
[Close] Close the [Background Job] dialog box.

Closing the dialog box will not affect the executing state of the background jobs.

Directly Importing File with Source Browser
The following explains how to register sources on external devices that interact with the source browser directly to the bin or place them on 
the timeline without transferring them to your PC.

Directly Registering Sources to Bin from Various Devices
Directly register clips in various devices to the bin without transferring them to the hard disk on the PC.

1) Select a clip in the source browser, and click [Add to Bin].
 f For more information on referencing each device in the source browser, see the procedures for importing from respective devices in 
“Importing Source Browser File by Copying”.
“Importing from Digital Camera” (w page 177)
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“Importing Sources from XDCAM EX Devices” (w page 178)
“Importing P2 Sources” (w page 179)
“Importing from XDCAM Devices” (w page 179)
“Importing XF Sources” (w page 182)

1 Alternative
 f Right-click the clip to import, and click [Add to Bin].
 f Drag and drop the clip to import onto the bin.

3 Note
 f Clips become offline clips when the connection to the device is canceled.
“Restoring Offline Clips” (w page 90)

Directly Placing Sources on Timeline from Various Devices
Directly place clips on various devices on the timeline without transferring them to the hard disk on the PC.

1) Set the channel mapping for the tracks on which clips are placed.
 f “Setting Channel Mapping” (w page 230)

2) Move the timeline cursor to the position to place the clip.

3) Select a clip in the source browser, and click [Add to Timeline].
 f For more information on referencing each device in the source browser, see the procedures for importing from respective devices in 
“Importing Source Browser File by Copying”.
“Importing from Digital Camera” (w page 177)
“Importing Sources from XDCAM EX Devices” (w page 178)
“Importing P2 Sources” (w page 179)
“Importing from XDCAM Devices” (w page 179)
“Importing XF Sources” (w page 182)

1 Alternative
 f Right-click the clip to import, and click [Add to Timeline].
 f Drag and drop the clip to import onto the timeline.

3 Note
 f Clips become offline clips when the connection to the device is canceled.
“Restoring Offline Clips” (w page 90)

Transferring Only Necessary Part
Only necessary parts can be copied when Grass Valley HQ or DV codec AVI files, for example, are imported to the hard disk on the PC.

3 Note
 f Sources in removable media such as AVCHD video camera or digital camera and XDCAM EX sources cannot be partially copied and 
imported.

Automatic Partial Transfer at Addition to the Timeline/Registration to the Bin
You can set to automatically copy the data between In and Out points when importing a file on a device to the timeline or the bin after 
displaying that file on the Player and setting the In and Out points.
“Registering Clips on the Player to the Bin” (w page 192)
“Registering between In and Out Points to the Bin As a Separate Clip (Subclip)” (w page 193)



Chapter 5   Importing Sources — Importing File

186

“Setting In/Out Points and Placing Clips” (w page 235)

3 Note
 f Sources that are incompatible with partial transfer are not transferred by this operation, and are added directly to the bin/timeline.

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Source] tree, and click [Partial Transfer].

3) Select [Target Clip], and check the required items in [Auto Transfer].

[Target Clip] Select the source to be partially transferred.
When [Only from Removable Media] is selected, only clips directly referencing files on the 
device are targeted for partial transfer.
When [From Removable Media and Hard Drive] is selected, both clips directly referencing files 
on the device and clips referencing files on the hard disk are targeted for partial transfer. When 
[Exclude Project Folder Drive] is unchecked, clips under the project folder are also targeted for 
partial transfer.

[Auto Transfer] [When Added to the Timeline from Player]
Check this item to execute partial transfer when the clip displayed on the Player has been 
placed on the timeline.
[When Added to the Bin from Player]
Checking this item executes partial transfer when the clip displayed on the Player has been 
added to the bin.

[Margin] Set the margin to add.

4) Click [OK].

5) Display the file in the device on the Player, and set the In and Out points.

6) Operate the buttons to add the clip to the timeline/bin.

 f Partial transfer is executed automatically according to the settings made above.
 f Partially transferred files are saved in the “Transferred” folder under the project folder.

3 Note
 f Partial transfer is not executed automatically when a source has been dragged and dropped from the Player onto the timeline or bin.
 f When a source in BD is added to the timeline or bin, partial transfer sometimes is automatically executed with chapters taken as the In 
and Out points even if the In and Out points have not been set on the Player.

Transferring Only Necessary Parts
When clips are directly referencing files in each device, only parts currently in use can be batch-copied to hard disk.

1) Click [File] on the menu bar, and click [Partial Transfer] → an item.
 f Partial transfer is started in the background, and the transferred file is saved under the project folder.
 f To cancel a partial transfer, select and right-click the job in the [Background Job] dialog box, and click [Stop] or [Stop All].
“[Background Job] Dialog Box” (w page 184)

2
 f In the case of sources that are incompatible with partial transfer, a message is displayed so that you can select whether to transfer the 
entire source.

 f When a clip after partial transfer has become an offline clip, [Transfer the Missing Area] or [Undo transfer] can be selected from the 
[Restoration Method] list in the [Restore and Transfer Clips] dialog box.

 f When a clip partially transferred with EDIUS 5 is in use, it can be returned to its original clip.
Right-click the partially transferred clip, and click [Replace Partially Downloaded Clip with Original Clip]. When a clip directly referencing a 
file on a device has been partially transferred, the link destination is returned to the file on the device from the file after transfer.
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Playing Back Sources

Playing Back and Checking Source

Playback with Player Operation Buttons
You can play back or move sources in individual frame units using the operation buttons on the Player.
“Playing Back with Recorder Operation Buttons” (w page 292)
“Operation Button Settings” (w page 147)

1) Click [Play] on the Player.
 f Playback starts on the Player.

2) Click [Stop] on the Player.
 f Playback stops.

Player Operation Buttons

(1) (2) (3) (4) (5) (6) (7)

(1) [Stop] Stop playback.
[K], [Shift] + [↓]

(2) [Review] Rewind a source. Each click switches the playback speed in the reverse direction between 4 
times and 12 times.
[J]*1

(3) [Previous Frame] Each click rewinds one frame at a time in the reverse direction. Keeping this button clicked 
plays back the source at the same speed in the reverse direction. In the case of deck 
operation, rewind is performed one frame at a time.
[←]

(4) [Play] Play back the source in the forward direction. When this button is clicked during playback, 
playback pauses. Click again to restart playback.
[Enter], [Space]

(5) [Next Frame] Each click forwards one frame at a time in the forward direction. Keeping this button clicked 
plays back the source at the same speed in the forward direction. In the case of deck 
operation, forwarding is performed one frame at a time.
[→]

(6) [Fast Forward] Fast forward playback. Each click switches the fast forward playback speed between 4 times 
and 12 times.
[L]*2

(7) [Loop]*3 Repeatedly play back between In and Out points. If no In point is set, the source is repeatedly 
played back from the beginning, or if no Out point is set, the source is repeatedly played back 
to the end. If In and Out points have been set for audio, the source is played from the first In 
point to the last Out point, including the In and Out points for video.
[Ctrl] + [Space]

*1 Each press of [J] on the keyboard switches the rewind speed in 6 levels between 2 to 32 times. Press [L] to slow down the rewind speed. Press 
this key with the source paused to play back at the same speed in the reverse direction.

*2 Each press of [L] on the keyboard switches the fast-forward speed in 6 levels between 2 to 32 times. Press [J] to slow down the fast-forward 
speed. Press it while pausing to play back at the same speed in the forward direction.

*3 Loop playback cannot be set for external sources. [Loop] is replaced with [Pause].

3 Note
 f When using a deck, fast-forward and rewind operations may be limited depending on the deck. Also, [Loop] will function as pause.
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Playing Back with Shuttle/Slider
You can play back a source by dragging the shuttle or slider on the Player.

3 Note
 f Sources that have not been captured cannot be played back by the slider.

1) Drag the shuttle/slider.
 f A frame at the slider position is displayed on the Player.

Shuttle/Slider

(1) (2) (3) (4)

(1) Shuttle Drag the shuttle to the left and right to play back in the reverse and forward directions, 
respectively. Release dragging to return the shuttle to the center and pause playback. The 
playback speed can be selected in 21 levels both in the forward and reverse directions, from 
1/20 to 16 times.

(2) Slider Click any position on the position bar to move the slider and display the frame for that position. 
You can also drag the slider.

(3) Position bar Displays the timeline of the source displayed on the Player.
(4) [Switch Display Range] Switch the display range on the Player between In and Out points only or the entire source.

1 Alternative
 f Shuttle (fast forward): [Ctrl] + [L]
Each press of [Ctrl] + [L] on the keyboard switches the fast-forward speed in 12 levels from 1/16 to 32 times. Press [Ctrl] + [J] on the 
keyboard to slow down.

 f Shuttle (rewind): [Ctrl] + [J]
Each press of [Ctrl] + [J] on the keyboard switches the rewind speed in 12 levels from 1/16 to 32 times. Press [Ctrl] + [L] on the keyboard 
to slow down.

Playing Back with Mouse (Mouse Gesture)
You can play back a source by moving the mouse on the Player.

3 Note
 f Sources displayed in the deck mode cannot be played back with mouse operations.

1) Position the mouse cursor on the Player, and move the mouse as if to draw a circle, with the right 
mouse button clicked.

 f Draw the circle clockwise to playback in the forward direction, and counterclockwise in the reverse direction. The playback speed 
changes in proportion to the speed of the mouse action.
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1 Alternative
 f Place the mouse cursor on the Player, and rotate the mouse wheel.

Displaying Clips on the Player
Display clips registered to the bin or clips displayed in the source browser on the Player.

3 Note
 f Clips displayed in the source browser sometimes cannot be displayed on the Player depending on the external device or state of the 
clip.

1) Select a clip in the clip view, and click [Show in Player] in the bin or in the source browser.
Example:

Bin

Example:

Source browser

2) Click [Play] on the Player.

 f “Playback with Player Operation Buttons” (w page 187)

1 Alternative
 f Drag a clip, and drop it onto the Player screen.
 f Right-click a clip and click [Show in Player].
 f Double-click a clip.
 f Select a clip, and press [Enter].

Setting the In and Out Points on the Source
The following explains how to set In and Out points to sources.

3 Note
 f Operations other than setting and deleting the In and Out points cannot be performed on sources that have not been captured.

Setting the In and Out Points
Specify the In (start) and Out (end) points of the source. If the In and Out parts are specified in advance, only the part between those points 
can be captured or placed on the timeline.

(1) (2)

(1) Set the In point
(2) Set the Out point

1) Play back the source, and click [Set In Point] on the Player at the frame to set as the In point.



Chapter 5   Importing Sources — Playing Back Sources

190

2) Continue to play back the source, and click [Set Out Point] on the Player at the frame to set as the 
Out point.

1 Alternative
 f Click [Marker] on the menu bar, and click [Set In Point] or [Set Out Point].
 f Right-click the slider on the Player, and click [Set In Point] or [Set Out Point].
 f Click the timecode at [In] or [Out] on the Player, and enter the desired numerical value.
 f To set the In and Out points at the clip marker position, right-click the clip marker on the position bar on the Player, and click [Set In Point] 
or [Set Out Point].

 f Setting the In point: [I]
 f Setting the Out point: [O]

2
 f In the case of a clip registered to the bin or a clip displayed on the Player from the source browser, the positions of the In and Out points 
can be changed by dragging the In and Out sliders.

IN

 f When the Out point has been set before the In point, the position bar between In and Out points changes color to red and a part of the 
timecode on the Player is displayed in red.

 f The duration can be changed based on the set In and Out points. Click the timecode at [Dur] on the Player, and enter the desired 
numerical value.

 f If the In or Out point of the clip registered to the bin is added, changed or deleted, that operation will be automatically reflected on the clip 
in the bin. To leave behind the information of a clip before it is edited, register that clip to the bin as a different clip in advance.
“Registering between In and Out Points to the Bin As a Separate Clip (Subclip)” (w page 193)

 f From [User Settings] → [Application] → [Timeline], you can set whether the frame displayed in the preview window is to be included in the 
range of In and Out points.
“[Timeline]” (w page 115)

In/Out Point Settings for Video/Audio
Set In and Out points separately for video parts and audio parts of a video clip with audio.

3 Note
 f In and Out points cannot be set separately to video and audio of sources that have not been captured.

1) Click the video/audio mark on the timecode.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:15;06

 f Each click switches the video/audio mark display between on and off. Display the mark of the part you want to set In and Out points.

Example:

To set In and Out points to video

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:15;06

 f [Set In Point] ([Set Out Point]) on the Player changes to [Set Video In] ([Set Audio In Point]) or [Set Video Out Point] ([Set Audio Out 
Point]).
 g   ( ): Setting the In point of video (audio)
 g   ( ): Setting the Out point of video (audio)
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2) Play back the clip, and click [Set Video In] ([Set Audio In Point]) on the Player at the frame to set as 
the In point.

Cur 00:00:00;00 In 00:02:48;03 Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:15;06

 f The position bar is horizontally divided into two levels. The upper level is the video part, and the lower level is the audio part.

3) Continue to play back the source, and click [Set Video Out Point] ([Set Audio Out Point]) on the 
Player at the frame to set as the Out point.

1 Alternative
 f Click the [Set In Point] ([Set Out Point]) list button on the Player at the frame to set as the In point, and click [Set Video In] ([Set Audio In 
Point]). Click [Set Video Out Point] ([Set Audio Out Point]) at the frame to set as the Out point.

 f Click [Marker] on the menu bar, and click [Set Audio In Point] or [Set Audio Out Point].
 f Right-click the slider on the Player, and click [Set Video In] ([Set Audio In Point]) or [Set Video Out Point] ([Set Audio Out Point]).
 f Setting In/Out points for audio: [U]/[P]
 f To set the In and Out points for video or audio at the clip marker position, right-click the clip marker on the position bar on the Player, and 
click [Set Video In] ([Set Audio In Point]) or [Set Video Out Point] ([Set Audio Out Point]).

2
 f The video (audio) In and Out points can be adjusted by dragging the In slider or Out slider of the video (audio) part. If the slider for the 
video part has been dragged, the following is displayed.

IN

 f Place the mouse cursor on the left or right edge of the position bar, and the mouse cursor changes shape. Click at that position while 
holding down [Ctrl], and the position bar is horizontally divided into 2 levels. If the slider for the video part has been dragged, the following 
is displayed.

OUTOUT

 f When In and Out points have been set only for the video part or the audio part, you can place only the video (audio) part on the track. 
When In and Out points have been set for both video and audio parts, you can place both of the clips on the timeline as a single clip.

 f If the In and Out points of the video/audio of the clip registered to the bin is added, changed or deleted, that operation will be reflected 
automatically on the clip in the bin. To leave behind the information of a clip before it is edited, register that clip to the bin as a different clip 
in advance.
“Registering between In and Out Points to the Bin As a Separate Clip (Subclip)” (w page 193)

3 Note
 f When In and Out points have been set in the video (audio) part, information for the audio (video) part will not be recognized.

Playback between In and Out Points (Loop Playback)
Repeatedly play back between In and Out points of a clip. Playback starts from the current position of the slider.
“Playing Back with Shuttle/Slider” (w page 188)

3 Note
 f Loop playback cannot be performed on sources displayed in the deck mode.

1) Click [Loop] on the Player.

 f Playback starts from the current position of the slider.
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1 Alternative
 f Playback between In and Out points: [Ctrl] + [Space]

Moving to In and Out Points
Move the slider on the position bar to the In (Out) point.
“Playing Back with Shuttle/Slider” (w page 188)

1) Click the [Set In Point] ([Set Out Point]) list button on the Player.

2) Click [Go to In Point] ([Go to Out Point]).
 f To move to the In (Out) point of the video and audio parts, click [Go to Video In Point] ([Go to Video Out Point]) or [Go to Audio In Point] 
([Go to Audio Out Point]).

1 Alternative
 f Click [Set In Point] ([Set Out Point]) with [Shift] on the keyboard held down. The same operation can be performed by [Go to Audio In 
Point] ([Set Video Out Point]) or [Set Audio In Point] ([Set Audio Out Point]).

 f Right-click the slider on the Player, and click [Go to In Point] ([Go to Out Point]). To move to the In (Out) point of the video and audio parts, 
click [Go to Video In Point] ([Go to Video Out Point]) or [Go to Audio In Point] ([Go to Audio Out Point]).

 f Moving to In point: [Q]/[Shift] + [I]
 f Moving to Out point: [W]/[Shift] + [O]
 f Moving to In point of audio part: [Shift] + [U]
 f Moving to Out point of audio part: [Shift] + [P]

Deleting the In and Out Points
Delete the In (Out) point.

1) Click the [Set In Point] ([Set Out Point]) list button on the Player.

2) Click [Clear In Point] ([Clear Out Point]).

1 Alternative
 f In the case of captured sources displayed in the file mode, move the slider to the In (Out) point, and click [Set In Point] ([Set Out Point]) 
with [Shift] on the keyboard held down. The same operation can be performed by [Set Video In] ([Set Video Out Point]) or [Set Audio In 
Point] ([Set Audio Out Point]).

 f Right-click the slider on the Player, and click [Clear In Point] ([Clear Out Point]). To delete to the In (Out) point of the video and audio 
parts, click [Clear Video In Point] ([Clear Video Out Point]) or [Clear Audio In Point] ([Clear Audio Out Point]).

 f Deleting In point: [Alt] + [I]
 f Deleting Out point: [Alt] + [O]

Registering Clips Displayed on the Player to the Bin

Registering Clips on the Player to the Bin
Register clips displayed on the Player to the bin.
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3 Note
 f Sources displayed in the deck mode on the Player cannot be registered directly to the bin.
 f When a clip displayed on the Player is registered to the bin from the source browser, the registered clip will directly reference the 
source on the device. When the source is transferred to the PC at the same time that it is registered to the bin, perform [Add and 
Transfer to Bin] from the source browser, or partially transfer the source.
“Importing Source Browser File by Copying” (w page 177)
“Automatic Partial Transfer at Addition to the Timeline/Registration to the Bin” (w page 185)

1) Display clips on the Player.
 f “Displaying Clips on the Player” (w page 189)
 f Set the In and Out points, if necessary.

2) Click [Add Clip on Player to Bin] on the Player.

1 Alternative
 f Right-drag and drop the clip on the Player onto the bin, and click [Add clip(s)].
 f Adding clips on the Player to the bin: [Shift] + [Ctrl] + [B]

Registering between In and Out Points to the Bin As a Separate Clip (Subclip)
The range between In and Out points set to the clip can be copied as a subclip and registered to the bin.
Subclips reference the same source as the original clip (master clip).

3 Note
 f Subclips cannot be created from the sources displayed in the deck mode.
 f Subclips cannot be created from clips to which In and Out points have been set separately for the video part or audio part of a video 
clip with audio.

1) Display the clip on the Player, and set the In and Out points.
 f “Setting the In and Out Points” (w page 189)

2) Click [Add Subclip to Bin] on the Player.

 f The subclip is created in the name format “original clip name-sub 4-digit sequential number”, and is registered to the bin.

1 Alternative
 f Right-drag and drop the clip on the Player onto the bin, and click [Add subclip(s)].

2
 f The master clip also will be registered to the bin if the subclip has been created with the clip displayed directly on the Player from the 
source browser without being registered to the bin.

 f Set the margins to add when creating subclips by [Source] in [User Settings] → [Automatic Correction].
“[Automatic Correction]” (w page 121)

 f To release a subclip and return it to the master clip, right-click the subclip registered to the bin, and click [Change to Master Clip].



194

Chapter 6
Managing Sources
This chapter explains the operations to manage imported sources in the bin.
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Bin
Clips are registered to the bin for management.
The following explains how the bin window is displayed and the types of clips that can be registered.

Showing/Hiding the Bin Window
Switch the show/hide setting for the bin window.

1) Click [Toggle Bin Window Display] on the timeline.
 f Each click of [Toggle Bin Window Display] switches the show/hide setting.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

1 Alternative
 f Click [View] on the menu bar, and click [Bin].
 f Showing/hiding the bin window: [B]

2
 f When the show/hide setting for the bin window is switched, the show/hide setting of the palette tabs and the source browser window 
combined with the bin window is also switched. To toggle the show/hide setting individually, release the association of the window and the 
palette.
“Combining Bin Window/Source Browser Window with a Palette” (w page 145)

Types of Registerable Clips
The following shows the clips that can be registered to the bin.

Clips
The following types of clips can be registered to the bin: 
 f Video clips
 f Video subclips
 f Still image clips
 f Audio clips
 f Audio subclips
 f Color bar clips
 f Color matte clips
 f Title clips (clips created with title authoring software)
 f Timeline sequence clips
 f Sequence clips
 f Caption clips

2
 f A caption clip can be placed on the timeline and handled in the same way as other clips.
 f A closed caption file with multiple streams will become a single caption clip after being registered to the bin.
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Clip Display

Clip

(1)
(4)

(2) (3)

(1) Clip type : Video clip
: Video subclip
: Still image clip
: Audio clip
: Audio subclip
: Color bar clip, color matte clip
: Title clip
: Timeline sequence clip
: Sequence clip
: Caption clip

(2) Clips exist under 
project folder

This is displayed when a source file referenced by a clip is in the project folder.

(3) Clips exist on timeline This is displayed when a clip is placed on the timeline.
(4) Poster frame/thumbnail 

display
Displays a representative image of clip or thumbnail.

2
 f The poster frame, which is displayed when the clip view is shown as a clip, can be changed by simple mouse operation. Press and hold 
the mouse wheel button over the thumbnail, and move the mouse left or right. Release the mouse wheel to complete the change to the 
setting.

 f When a title file is already created, click [Add Clip] in the bin to display the [Open] dialog box, and open the file. When no title file is 
prepared, click [Add Title] in the bin, start up the title authoring software, and create a title file.
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Settings of Clips

Joining Multiple Video Clips All Together as a Single Clip
This section explains how to group multiple clips all together and set them as a single sequence clip, and how to ungroup single sequence 
clips.

Joining Multiple Clips (Set as Sequence)
Join multiple video clips all together as a single sequence clip.

1) Select and right-click the multiple clips in the bin, and click [Set as Sequence].
 f The created clip is registered in the bin as a sequence clip.
 f Clips set as a sequence take the name of the first joined clip as its clip name.

 f “Registering Consecutive Still Images” (w page 173)

2
 f Clips are joined in the sorting order of the bin.
 f Clips are joined with the In and Out point settings of the video part held by the original clip intact.

3 Note
 f Conditions for setting as a sequence are as follows:

 g The clip type, image size and aspect ratio of all clips must be matching.
 g For video, the field order and frame rate of all clips must be matching.
 g For audio, the sampling rate, quantization bitrate and number of channels of all clips must be matching.

Canceling a Set Sequence
Cancel joining of a sequence clip.

1) Right-click a sequence clip in the bin, and click [Cancel Sequence].
 f After the sequence is canceled, the clip name returns to the one before the clips are joined.

2
 f The In and Out point settings that were held by the clips before they were joined as a sequence are restored.

Creating Color Bar/Color Matte/Title Clip
The following explains how to create color bar clips, color matte clips and title clips.

Color Bar Clips
Create a color bar clip.
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1) Click [New Clip] in the bin.

2) Click [Color Bars].
 f The [Color Bars] dialog box appears.

3) Make the color bar settings, and click [OK].

1 Alternative
 f Right-click a blank area in the clip view, and click [New Clip] → [Color Bars].
 f Click [Clip] on the menu bar, and click [Create Clip] → [Color Bars].

2
 f You can change settings from the [Color Bars] dialog box by the following operations:

 g Right-click a color bar clip in the bin, and click [Edit].
 g Double-click a color bar clip in the bin.

 f You can also place a color bar clip on the timeline without registering it to the bin.
“Placing Special Clips on the Timeline” (w page 237)

Color Matte Clips
Create a color matte clip.

1) Click [New Clip] in the bin.

2) Click [Color Matte].
 f The [Color Matte] dialog box appears.

3) Click the color palette.
 f Set the color palette starting from the left.

 f The [Color Select] dialog box appears.
“[Color Select] Dialog Box” (w page 199)

4) Set the color.

5) Click [OK].
 f The screen returns to the [Color Matte] dialog box. To set a gradation, enter a numerical value of 2 or higher at [Colors] in the [Color 
Matte] dialog box, and repeat steps 3) to 5).

6) Set the direction of the gradation, and click [OK].
 f The gradation can be specified by, for example, entering the numerical value in degrees, rotating the mouse wheel or dragging the 
mouse.

1 Alternative
 f Right-click a blank area in the clip view, and click [New Clip] → [Color Matte].
 f Click [Clip] on the menu bar, and click [Create Clip] → [Color Matte].
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2
 f You can change settings from the [Color Matte] dialog box by the following operations:

 g Right-click the color matte clip in the bin, and click [Edit].
 g Double-click the color matte clip in the bin.

 f You can also place the color matte clip on the timeline without registering it to the bin.
“Placing Special Clips on the Timeline” (w page 237)

[Color Select] Dialog Box

XXXXXX XXXXXX

XXXXXX

XXXXXX

XXX :Cb :

XXX :Cr :

XXX :Y :

XXXXXX

(1) (2) (3) (4)

(5)

(6)

(7) (8)

(1) Color spectrum Drag the cursor to set the color difference (Cr, Cb).
(2) Luminance slider Drag the slider to set the luminance (Y).
(3) YCrCb value input field Enter a numerical value for brightness and color difference to set the color.
(4) Color palette Select a color from the standard color palette.
(5) RGB value input field Enter a numerical value for red (R), green (G) and blue (B) to set the color.
(6) Color picker Select the color from video displayed on the Player/Recorder. Click the color picker, and click 

the desired color in the video currently displayed on the Player/Recorder.
(7) [IRE Warning] Check this item to display the color spectrum and luminance slider in the limited range of 0 to 

100 IRE. The IRE value for the selected color is displayed under this check box.
(8) Preview box Display the preset color.

Title Clips
Create a title clip.

2
 f The existing titler can be changed from [Application] in [User Settings] → [Other].
“[Other]” (w page 117)

1) Click [Add Title] in the bin.

 f Quick Titler will start up.

2) Create the title clip.
 f “Quick Titler” (w page 388)

1 Alternative
 f Click [Clip] on the menu bar, and click [Create Clip] → [QuickTitler].
 f Right-click a blank area in the clip view, and click [Add Title].
 f Right-click a blank area in the clip view, and click [New Clip] → [QuickTitler].
 f Creating a title clip: [Ctrl] + [T]
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Creating Stereoscopic Clip

Selecting a File Used in Pair to Set as a Stereoscopic Clip
If either the L side clip (for left eye) or the R side clip (for right eye) is in the bin, select a file used in pair to make a single stereoscopic clip.

1) Select and right-click the clip to set as stereoscopic in the bin, and click [Set as Stereoscopic].
 f The [Stereoscopic setting] dialog box appears.
 f The following files are automatically searched: files which are placed in the same folder as the clip selected in step 1), have the same 
extension, and are allowed to be stereoscopic. The search result is displayed in [Select pair files] as a list.

2
 f If a clip that is transferred to a project folder, the folder in which the clip is saved before transfer will be searched.

2) Select a file from the [Select pair files] list.
 f Select a file to be used in pair based on the information such as [Similarity].

3) Set each item.

[Select pair files] Displays the information for the searched files.
If files to be used in pair do not exist, click [Browse folder] to change the search folder.
Click  in [Sync] to select the position to synchronize the L side and the R side clips. The 
setting will be reflected in the [Preview] display.
Every click switches the sorting order to be ascending or descending.

[Preview] Displays the L side clip at the left, and the R side clip at the right. Move the slider or enter the 
timecode in [Cur] to view video.
Click [Monitor preview] to view the stereoscopic video of the current position in the preview 
window.
 Click  to switch the L side and the R side videos.

4) Click [OK].

2
 f After setting as a stereoscopic clip, the clip markers which the L side and the R side clips contain are merged.
 f The length of the clip will be determined by the area with the frames on both the L side and the R side clips, after synchronizing the L side 
and the R side clips.

 f The capture margin will be set to the longer one of either the L side or the R side capture margin, after synchronizing the L side and the R 
side clips.

 f The clip length and information other than the capture margin of the L side clip will be carried over.
 f The In and Out points information of the L side and the R side clips will be deleted after setting as a stereoscopic clip.

Setting Separate L and R Clips in the Bin as Stereoscopic
If both the L side (for left eye) and the R side (for right eye) clips are in the bin, set them as a single stereoscopic clip.

1) Select and right-click the L side and the R side clip (or clips) to set as a stereoscopic clip in the bin, 
and click [Set as Stereoscopic].

 f The [Stereoscopic setting] dialog box appears.

2) Set each item.

[Stereoscopic clips] Displays information on the stereoscopic clip.
The clip name to be created as a stereoscopic clip is displayed in [Clip Name].
Click  in [Sync] to select the position to synchronize the L side and the R side clips. It will be 
reflected in the [Preview] display.
When multiple clips of the L and R sides are selected, click [Auto pairing] to automatically sort 
them so that clips with high degree of similarity are paired.

[Preview] Displays the L side clip at the left, and the R side clip at the right. Move the slider or enter the 
timecode in [Cur] to view video.
Click [Monitor preview] to view the stereoscopic video of the current position in the preview 
window.
 Click  to switch the L side and the R side video.
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3) Click [OK].

2
 f After setting as a stereoscopic clip, the clip markers which the L side and the R side clips contain are merged.
 f The length of the clip will be determined by the area with the frames on both the L side and the R side clips, after synchronizing the L side 
and the R side clips.

 f The capture margin will be set to the longer one of either the L side or the R side capture margin, after synchronizing the L side and the R 
side clips.

 f The clip length and information other than the capture margin of the L side clip will be carried over.
 f The In and Out points information of the L side and the R side clips will be deleted after setting as a stereoscopic clip.

Canceling Stereoscopic Clips
Cancel a stereoscopic clip to reset to 2 separate clips.

1) Select and right-click stereoscopic clip (or clips) in the bin, and click [Cancel Stereoscopic].

2
 f Clip markers are retained after canceling stereoscopic clips.
 f The In and Out points information will be deleted after canceling stereoscopic clips.

Setting Stereoscopic Clips as Sequence/Cancelling Sequence
Set multiple stereoscopic clips in the same format as a single sequence clip, or cancel the sequence clips.
The operation procedure is the same as for settings as sequence/canceling sequence.
“Joining Multiple Video Clips All Together as a Single Clip” (w page 197)

Creating Subclips from Stereoscopic Clips
Creating Subclips from Stereoscopic Clips
The operation procedure is the same as for the regular subclip creation.
“Registering between In and Out Points to the Bin As a Separate Clip (Subclip)” (w page 193)

Handling Non-Stereoscopic Clips as Stereoscopic Clips
Non-stereoscopic clips where video is divided by side-by-side or tom-and-bottom, etc. can be handled as stereoscopic clips.

1) Select and right-click a clip in the bin or source browser, and click [Properties].
 f The [Clip Properties] dialog box appears.

2) Click the [Stereoscopic] tab.

3) Check [Use as Stereoscopic clip], and select an item from the [Divide setting] list.

2
 f Check [Swap L/R] to switch the L side and the R side video.
 f The L side clip is displayed at the left of [Preview], and the R side clip is displayed at the right. Move the slider or enter the timecode in 
[Cur] to view video.

 f Click [Monitor preview] to view the stereoscopic video of the current position in the preview window.

4) Click [OK].

Creating a Clip Containing Caption Data

Merging a Caption Clip
You can merge a caption clip with a video clip in the bin.
 f The closed caption file formats supported on EDIUS are as follows.
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 g *.scc
 g *.mcc

 f Only video clips can be merged with caption clips.

1) Select a video clip and a caption clip in the bin, right-click on them, and click [Set as clip with 
captions].

 f The video clip and caption clip will be merged, and the caption clip will be hidden in the bin.

2
 f When you register a file to the bin as a clip, you can detect a closed caption file that corresponds to the file and merge it to the clip.
“Merging Closed Caption File and Registering” (w page 174)

Canceling Merged Caption Clip
You can cancel a caption clip merged with a video clip.

1) Right-click on a video clip which a caption clip has been merged with, and click [Cancel clip with 
captions].

 f The caption clip merged with the clip will be canceled, and the caption clip will appear in the bin.

Using Caption Information of Clip
You can set whether or not the caption information of a clip is to be used.

1) Select a clip and right-click on it in the bin, and click [Properties].
 f The [Properties] dialog box appears.

2) Click the [Captions] tab.

3) Check [Use Caption data].

4) Click [OK].

2
 f In [Caption File] on the [Captions] tab, you can confirm the saving destination of the currently referenced closed caption file.

Changing Clip Information and Content
This section explains how to check the information of the clip and change settings.

Correcting Properties
Change the clip frame rate or specify the start timecode in the [Clip Properties] dialog box.

1) Select a clip in the clip view, and click [Properties].

 f The [Clip Properties] dialog box appears.
“[Clip Properties] Dialog Box” (w page 203)

1 Alternative
 f Right-click a clip and click [Properties].
 f Correcting properties: [Alt] + [Enter]

2) Correct the settings, and click [OK].
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2
 f The properties of multiple clips can be corrected in a single operation depending on the items to correct.
“Correcting Multiple Clip Properties” (w page 204)

[Clip Properties] Dialog Box

The displayed tab varies according to the type of clip.

[File] tab Check type, data size and other details of files. You can also rename clips, rename reels, enter 
comments, and change the clip display color.

[Video] tab Check the start TC (timecode), end TC or image size. You can also change the start TC, poster 
frame, aspect ratio, color space, color correspondence range, field order, and frame rate.
To return the settings to their state at capture, click [Back to Default Settings].

[Stereoscopic] tab If a clip is not a stereoscopic clip, divide a clip to handle it as a stereoscopic clip.
“Handling Non-Stereoscopic Clips as Stereoscopic Clips” (w page 201)

[Audio] tab Check the start and end TCs, or re-acquire wave information (waveform representation of 
audio).

[Still image] tab Check the format or image size. You can also change duration, aspect ratio, color space, and 
color correspondence range.

[Extended] tab Check the expansion information of a file or clip. The details displayed differ depending on the 
clip type.

[Captions] tab Set whether or not the caption information is to be used.
If a closed caption file has been merged to the file, the saving destination of the currently 
referenced file can also be confirmed.
“Using Caption Information of Clip” (w page 202)

2
 f In [Color Space] in the [Video] tab, color spaces of clips are automatically recognized and displayed.
If the color space of a clip is not recognized automatically, you can change it manually by clicking the list button of [Color Space] in the 
[Video] tab.

Rename Clip
You can rename clips whose reference source and name are identical to the clip selected in the bin.
 f This setting is applied to clips in the bin and on the timeline.

1) Select and right-click on the clip to rename in the bin, and click [Rename Clip].

1 Alternative
 f Select a clip, and click the clip name.
 f Renaming after selecting a clip in the bin window: [F2]

2) Modify the name, and press [Enter] on the keyboard.

1 Alternative
 f Right-click a clip and click [Rename related clips]. Enter a name, select [Clips have same original asset and name same as the selected 
clip.], and click [OK].

Rename related clips
You can collectively rename clips with the same reference source in the bin or on the timeline.
You can also rename only the clip selected in the bin.

1) Select and right-click on the clip to rename in the bin, and click [Rename related clips].
 f The [Rename related clips] dialog box appears.
“[Rename related clips] Dialog Box” (w page 204)

2) Modify the name, and click [OK].
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[Rename related clips] Dialog Box

[Name] Enter a new clip name and select the renaming target.
[Current clip only.]
Rename only the selected clip.
 f This setting is applied to clips in the bin.

[Clips have same original asset and name same as the selected clip.]
Rename only clips with the same reference source and name as the selected clip.
 f This setting is applied to clips in the bin and on the timeline.

[All Clips have same original asset.]
Rename all clips with the same reference source as the selected clip.
 f This setting is applied to clips in the bin and on the timeline.

Correcting Multiple Clip Properties
When the clip view of the bin is set to [Detail] or [Icon], you can select multiple clips to rename the clips or change the clip display color as 
well as other settings at the same time.
The following items can be corrected in a single operation:
 f Clip name
 f Reel name
 f Comment
 f Clip display color
 f Frame rate
 f Aspect ratio
 f Field order
 f Color correspondence range
 f Color space
 f Dividing method

2
 f If an item you want to correct is not displayed, set the display item by [User Interface] in [User Settings] → [Bin].
“Bin Detailed Display Item Settings” (w page 155)

3 Note
 f If a selected clip contains an invalid setting, a warning message will appear to ask whether to continue changing the settings. If 
settings are changed as they are, changes will not be reflected in that clip.

Correcting Clip Names/Reel Names/Comments

You can edit the following multiple settings at one time.
 f Clip name
 f Reel name
 f Comment

1) Set the clip view of the bin to [Detail] or [Icon].
 f “Clip View Display” (w page 155)
 f This operation is not necessary when you modify the name of a clip.

2) Select and right-click the multiple clips whose properties are to be changed, and click [Rename 
Clip].

1 Alternative
 f Select multiple clips whose properties are to be changed, and click .
 f Select the multiple clips whose properties are to be changed, and click [F2] on the keyboard.

3) Press [Tab] on the keyboard, and select the items to correct.

4) Enter the new content.
 f When a clip name has been modified, branch numbers are added to clips in accordance with the entered clip name, in order from the one 
with the smallest number.

 f When a reel name and comment have been corrected, entered content is reflected on all selected clips.



Chapter 6   Managing Sources — Settings of Clips

205

2
 f When a clip name has been modified, the clips whose reference source and name are identical to the clip selected in the bin will be 
renamed.
This setting is applied to clips in the bin and on the timeline.

Correcting Clip Display Color, Frame Rate, Aspect Raito, Color Space, etc.

You can edit the following settings at one time.
 f Clip display color
 f Frame rate
 f Aspect ratio
 f Field order
 f Color correspondence range
 f Color space
 f Dividing method

1) Set the clip view of the bin to [Detail] or [Icon].
 f “Clip View Display” (w page 155)

2) Select the multiple clips whose properties are to be changed.

3)  Click , and select an item to correct.

2
 f  “*” to the right of item displayed by clicking  indicates that the setting is the default setting.
 f To return the frame rate, aspect ratio, field order, color space, and dividing method of multiple clips to the default setting of each clip, click 

 and select [Back to default].

Correcting the Settings Dialog Box
Change the settings for color bar, color matte, or title clip in the settings dialog box.

1) Right-click a color bar clip, color matte clip or title clip in the bin, and click [Edit].
 f The settings dialog box appears for color bar clips or color matte clips.
“Color Bar Clips” (w page 197)
“Color Matte Clips” (w page 198)

 f In the case of title clips, the title authoring software will start up.
“Quick Titler” (w page 388)

1 Alternative
 f Double-click a clip in the bin.
 f Select a clip in the bin, and press [Ctrl] + [Enter] on the keyboard.

Converting Files
AVCHD or HDV standard native files can be converted to AVI such as Grass Valley HQ codec and downconverted to SD image quality.

1) Right-click a clip in the bin, and click [Convert] → [File].
 f Multiple files can be converted in a single operation by selecting multiple clips and clicking [Convert] → [File(batch)].

2) Select the codec and image quality from the [Save as type] list, and click [Save].

2
 f If a stereoscopic clip is converted, it will convert to 2 stream AVI (1 file).

MPEG File Media Settings
For MPEG format clips, setting to ensure faster seeking of files can be changed for each clip.
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3 Note
 f [MPEG Media Settings] will not be displayed if the target file is not MPEG.

1) Right-click a clip in the bin, and click [MPEG Media Settings].
 f The [MPEG Media Settings] dialog box appears.
“[MPEG Media Settings] Dialog Box” (w page 206)

2) Set each item and click [OK].

1 Alternative
 f Right-click a clip placed on the timeline, and click [MPEG Media Settings].

2
 f The above settings can be changed on all MPEG files to be imported to EDIUS.
“[MPEG]” (w page 106)

[MPEG Media Settings] Dialog Box

[Use Accel. Seek] Set faster seeking of MPEG files. To speed up seeking, check this item first, and then check 
the following items if necessary.
[Create Seek Information in Background]
Collect the time stamp information of MPEG files at idling to speed up the seek.
[Save Seek Information to File]
Save the seek information as a reusable file.

[A/V Synchronization Using PTS] Some MPEG files have no valid PTS (time stamp information). Check this item to decode files 
that have no PTS.
Check this item to use the PTS (time stamp information) for synchronization of audio and video.

[Get timecode from GOP header] Some MPEG files may have timecode information in their header. Check this item to use 
timecode information.

H.264 Media Settings
You can set whether to acquire timecode information from Picture Timing SEI by each clip to H.264 codec clips.

3 Note
 f If the target file is not H.264 codec, [H.264 Media Settings] will not be displayed.

1) Right-click a clip in the bin, and click [H.264 Media Settings].
 f The [H.264 Media Settings] dialog box appears.

2) Set each item and click [OK].

[Get timecode from Picture Timing 
SEI]

Check this item to acquire the timecode information from Picture Timing SEI.

1 Alternative
 f Right-click a clip placed on the timeline, and click [H.264 Media Settings].

2
 f The above settings can be changed on all H.264 files to be imported to EDIUS.
“[AVCHD]” (w page 105)

Checking Clip Save Destinations
Display the save destination folder for the clip.

1) Right-click a clip in the bin, and click [Explorer].
 f Explorer starts up, and the save destination folder for the clip is displayed.
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Opening Files with Software
You can open a file with application software associated to the file, for example, by opening *.psd files in Photoshop.

1) Right-click a clip in the bin, and click [Open].
 f Open the file with the application software associated to the file.

2
 f You can open a clip placed on the timeline by the associated application software by the following operation:

 g Right-click a clip placed on the timeline, and click [Open].
 g Click a clip placed on the timeline, and click [Clip] on the menu bar → [Open].
 g Opening clips placed on the timeline: [Shift] + [Ctrl] + [P]
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Managing Clips

Operations in the Clip View
This section explains how to manage clips in the clip view, for example, by copying and pasting the selected clip.
“Clip View Display” (w page 155)

Selecting Clips
Select a clip in the clip view. The selected clip changes color.

1) Click a clip in the clip view.
 f To select multiple clips, drag the mouse to enclose the desired clips.

2
 f Click a clip with [Ctrl] held down on the keyboard to add or release selected clips one at a time. You can select a range of clips in a single 
operation by clicking the topmost clip of the range with [Shift] on the keyboard held down and then clicking the bottommost clip of the 
range.

 f Right-click any clip and a menu will appear so that you can perform various operations on the clip. This menu appears in the same way 
when multiple clips are enclosed by dragging with the right mouse button so that operations can be batch-performed on the clips selected 
in that range.

Copying Clips
Copy clips.

1) Select a clip, and click [Copy] in the bin.

 f You can then paste it.

1 Alternative
 f Right-click a clip and click [Copy].
 f Right-drag and drop the clip onto the copy destination folder, and click [Copy clips].
 f Copying clips: [Ctrl] + [C], [Ctrl] + [Insert] 

Cutting Clips
Cut clips. Cut clips are deleted from the bin.

1) Select a clip, and click [Cut] in the bin.

 f You can then paste it.

1 Alternative
 f Right-click a clip and click [Cut].
 f Cutting clips: [Ctrl] + [X]/[Shift] + [Delete]

Pasting Clips
Paste copied or cut clips.

1) Select a clip, and click [Copy] in the bin.
 f Clips can also be pasted by clicking [Cut].
“Copying Clips” (w page 208)
“Cutting Clips” (w page 208)
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2) Click [Paste] in the bin.
 f To paste to another folder, select a folder and click [Paste].

1 Alternative
 f Right-click a clip and click [Paste].
 f Right-click a blank area in the clip view, and click [Paste].
 f Pasting a clip: [Ctrl] + [V]

Registering from Timeline
Register clips placed on the track to the bin.

1) On the timeline, right-click the clip to register, and click [Add to Bin].
 f The clip is added to the bin.
 f When video and audio clips have been placed separately on the V and A tracks, respectively, all clips linked to the right-clicked clip are 
added to the bin as separate clips. To add only the right-clicked clip to the bin, cancel the link and then perform the desired operation on 
the clip.
“Group/Link Mode” (w page 227)
“Handling Only the Video Part or Audio Part of Clips Separately” (w page 241)

1 Alternative
 f Drag and drop clips to the bin.
 f Right-drag and drop the clip onto the bin, and click [Add clip(s)]. Click [Add subclip(s)] to add the clip to the bin as a subclip.
 f Select the clip, click [Clip] on the menu bar, and click [Add to Bin].
 f Double-click a clip to display on the Player, and drag and drop the clip from the Player to the bin.
 f Double-click the clip to display on the Player, and click [Add Clip on Player to Bin] on the Player.
 f Adding clips on the timeline to the bin: [Shift] + [B]

Deregistering Clips

1) Select a clip, and click [Delete] in the bin.

1 Alternative
 f Right-click a clip and click [Delete].
 f Deregistering clips: [Delete]

3 Note
 f Once you have deregistered clips, you cannot restore them (cannot undo deregistration).
 f Source files are not deleted even by deregistering clips from the bin.

Sorting Clips

2 3 1 1 2 3

“Bin Detailed Display Item Settings” (w page 155)

1) Right-click on a blank area in the clip view, and click [Sort].

2) Click the item names to sort.
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1 Alternative
 f When the detailed clip view is displayed, each click switches between ascending or descending order.

Color-coding Clips
Color-code clips displayed in the bin to classify them.

1) Right-click on a clip, and click [Clip Color].

2) Click the display color.

1 Alternative
 f Click [File] in the [Clip Properties] dialog box. Select the display color from the [Clip color] list.
“[Clip Properties] Dialog Box” (w page 203)

2
 f The display colors of multiple clips can be changed in a single operation.
“Correcting Multiple Clip Properties” (w page 204)

Transferring to the Project Folder
The following explains how to transfer files referenced by clips in the bin to the project folder.

3 Note
 f The following clips cannot be transferred to the project folder:

 g Non file-based clips such as color bar clips or color matte clips
 g Clips with an importer that does not support file transfer
 g Clips already transferred to the project folder

1) Select and right-click the clip, and click [Transfer to Project Folder].
 f You can select multiple clips.
 f Data transfer to the project folder is started in the background.
“Checking the Progress of Background Jobs” (w page 183)

 f The clip in the bin now references the file transferred to the project folder.

Transferring High-resolution Data
You can transfer high-resolution data of clips containing only proxy data to the project folder.

3 Note
 f The high-resolution data of the following clips cannot be transferred:

 g Clips other than video clips
 g Clips already containing high-resolution data

1) Select and right-click a clip, and click [Transfer HiRes].
 f You can select multiple clips.
 f Data transfer to the project folder is started in the background.
“Checking the Progress of Background Jobs” (w page 183)

 f The clip in the bin now references the file transferred to the project folder.
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Operations in the Folder View
You can register clips for individual folders to classify them. Folders can be added under the [root] folder in a hierarchical structure.
“Showing/Hiding Folder View” (w page 154)

2
 f The [root] folder cannot be moved or copied.
 f Folders independent from the [root] folder cannot be created.

Creating a Folder

1) Right-click the folder in the folder view, and click [New Folder].
 f A new folder is created on the layer under the selected folder.

2) Enter the folder name.

Moving Folders

1) Drag a folder, and drop it onto the destination folder.

1 Alternative
 f Right-drag and drop the folder to move onto the destination folder, and click [Move folder].

2
 f The [root] folder cannot be moved.

Duplicating Folders
Duplicate a folder.

1) Drag the folder in the folder view, and drop it onto the duplicate destination folder with [Ctrl] on the 
keyboard held down.

 f Registered clips are also copied.

1 Alternative
 f Right-drag and drop the folder to duplicate onto the destination folder, and click [Copy folder].

2
 f The [root] folder cannot be copied.

Deleting Folders
Delete a folder.

1) Select the folder to delete in the folder view, and click [Delete] in the bin.

 f A dialog box appears to confirm the deletion.
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2) Click [Yes].

1 Alternative
 f Select a folder, press [Delete] on the keyboard, and click [Yes].
 f Right-click the folder, and click [Delete] and then [Yes].

2
 f When the [root] folder has been right-clicked and [Delete All] has been clicked, all clips and folders in the [root] folder are deregistered.

3 Note
 f Once you delete a folder, you cannot restore it (cannot undo deletion).
 f When a folder is deleted, all clips in that folder and sub folders are also deregistered.

Switching the Display Folder
Switch the folder to be displayed.

1) Click the folder to be displayed in the folder view.
 f If the folder view is closed, right-click a blank space of the clip view and click [Go], and click the move destination folder name or [Up one 
Folder].

1 Alternative
 f Click [Move Up] in the bin to switch the folder.

 f Moving to a folder one place up: [Backspace]

Exporting/Importing Bin Information
This section explains how to export and import bin information, and export information registered to the bin to HTML.

Exporting Bins (Export)
Export bin information.

1) Right-click the folder to export in the folder view, and click [Export].
 f The [Save As] dialog box appears.

2) Set a file name and export destination, and click [Save].

3 Note
 f Bin information can be exported as a *.ezb file with the folder structure held intact.
 f *.ezb files with the same name at the export destination will be overwritten.

Importing Bins (Import)
Import bin information exported by EDIUS. Bin information can also be imported from other project files.

1) Right-click the folder in the folder view, and click [Import].
 f The [Open] dialog box appears.

2) Select a file to import, and click [Open].

3 Note
 f Bin information cannot be imported from project files with different frame rates.
 f Bin information sometimes cannot be imported correctly when it has been imported from a project file with different project settings.
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Exporting Registration Information (HTML Export)
Export the information of clips registered to the bin to HTML file.

1) Right-click the folder to output in the folder view, and click [Export Html].
 f The [Save As] dialog box appears.

2) Set a file name, export destination and other information, and click [Save].
 f Style sheets can also be used.

Searching for Clips Registered to the Bin
Clips registered to the bin can be searched according to search conditions set by the user. The search results are registered to the folder 
view as the [Search results] folder and can be browsed.

Searching in the Bin
Search clips registered to the bin. After a search is performed, the [Search results] folder is created.

1) Click the folder to be searched in the folder view.

2) Click [Search] in the bin.

 f The [Bin Search] dialog box appears.

1 Alternative
 f Right-click the folder to search in the folder view, and click [Search].
 f Searching in the bin: [Ctrl] + [F]

3) Select the search conditions at [Category] in [Search by].
 f The bin search dialog box changes to a category specific search dialog box.

4) Set the search conditions, and click [Add].
 f Multiple search conditions can be added.
 f The specified conditions are displayed in [List]. At the same time, clips matching the search conditions are displayed in the [Search 
results] folder.

5) Click [Close] in the [Search Bin] dialog box.

2
 f You can refine the search for clips in the [Search results] folder by the following operation:

 g Right-click the [Search results] folder, and click [Search In].
 g After selecting the [Search results] folder, perform steps 2) to 5) in “Searching in the Bin”.

 f To delete a search condition, select it from [List] and click [Remove].
 f To change a search condition, right-click the [Search results] folder, and click [Change Search Settings].
 f When [Search only current folder] is checked, only the currently selected folder is searched. Folders under the selected folder are 
excluded from the search.

 f By clicking [And] or [Or], you can also select to search for targets that match all additional search conditions or targets that match some of 
the additional search conditions.

 f When selecting [Folder selection] from [Category] in [Search by] to select the folder to search, all clips in the selected folder and folders 
lower down in its hierarchy are displayed. You can find the desired clip easily by performed a more refined search even if the folder 
structure is more complicated.

3 Note
 f The [Search results] folder cannot be moved.
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Searching by the Simple Search Bar
Search clips in folders by using the simple search bar. After the search ends, only clips that partially match the search text string among the 
clips in the folder are displayed in the clip view.

1) Click the folder to be searched in the folder view.

2) Press [F3] on the keyboard.
 f The simple search bar is displayed.

[Find] Enter the search text string. You can also select previous search text strings from the list.
[Condition] Select the search condition from the list.
[Display find condition] Switch the show/hide setting for the search conditions.
[Close find bar] Close the simple search bar to display all clips in the folder.

3) Set the search conditions, and press [Enter] on the keyboard.
 f Only clips that partially match the search text string among the clips in the folder are displayed in the clip view.

2
 f Text is not case-sensitive when a search is executed by the simple search bar.
 f A history of up to 20 of the last entered search text strings is saved to each profile.

Searching Unused Clips
Search clips that have not been used on the timeline.

1) Click the folder to be searched in the folder view.

2) Click [Search].

 f The [Bin Search] dialog box appears.

3) Select [Timeline reference] at [Category] in [Search by].

4) Select [Not used], and click [Add].

2
 f To delete the source file of clips not used on the timeline, right-click the clip and click [Delete File]. Source files can be deleted only when 
located under the project folder.

 f To deregister clips not used on the timeline, select the clip and click [Delete].
 f A green mark is displayed at the lower right of the clip display if clips are currently used on the timeline. This mark is not displayed for 
clips not used on the timeline.

clip_XXXX clip_XXXX

Deleting Search Results
Delete [Search results] folders that are no longer required.

1) Select the [Search results] folder, and click [Delete].

 f A dialog box appears to confirm the deletion.

2) Click [Yes].
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1 Alternative
 f Right-click the [Search results] folder, click [Clear], and then click[Yes].
 f Select the [Search results] folder, press [Delete] on the keyboard, and click [Yes].

2
 f The [Search results] folder cannot be restored once they have been deleted.

3 Note
 f When clips in [Search results] are deregistered individually, clips in the [root] folder and clips in folders under that are also deregistered 
accordingly. You cannot restore them (cannot undo deregistration).
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Chapter 7
Editing Operations
This chapter explains edit mode and track settings, and editing on the timeline.
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Timeline Settings

Tracks
You can add, delete, or move tracks. In addition, tracks can be muted or locked individually.
Tracks have several types, and the type of clips that can be placed on each type of track differ.
“Track Type” (w page 218)

2
 f The priority in the order of display is determined by the up/down position or type of tracks.
On video tracks (V/VA tracks), upper tracks have priority over lower tracks. T tracks have priority over video tracks (V/VA tracks).

2V
1V
1T A A A

A A A
If multiple T tracks are placed up and down, lower T tracks have priority.

2V
1V
1T
2T

A A A
B B B

A A AB B B
 f Caption clips have priority to other clips in the order of display regardless of the up/down position or type of tracks where they have been 
placed.

 f As to the clips with embedded closed caption data, the priority order for display is determined by the up/down position or type of tracks 
where they have been placed, in the same way as clips such as video clips.
Note that the closed caption of a clip on a lower track may be prioritized in the order of display depending on the layouter settings of a clip 
on an upper track.

Track Display
The following explains the descriptions of the track header and the types of tracks.

Track Header
You can make settings for each track simply on the track header, for example, to lock the track for preventing placed clips from moving or to 
set the track to exclusively play back audio.
You can set the following items in the track header.

2 V

1 T

1 A

2 A

3 A

4 A

V
A XXXXXX

A3
4

A5
6

A7
8

1 VA
V

A1
2(1)

(2)

(3)

(4)
(5)
(6)
(7)

(11)

(8)
(9)
(10)
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(1) Track patch When a clip is displayed on the Player or a clip is selected in the bin, the channel held by that 
clip (source channel) is displayed on the track patch. When a clip in the source browser is 
selected, the source channel is displayed on the track patch according to the channel map 
in the project settings. Also, the track patch position displays which track the source channel 
is mapped to when a clip is placed on the timeline by a shortcut key or button. The source 
channel mapping to each track can be changed.
“Setting Channel Mapping” (w page 230)

(2) Track panel Click this to switch the select/deselect setting for the track.
(3) Batch lock panel Click this to set sync-lock for all tracks on and off.

“Sync-lock (Synchronization)” (w page 225)
Right-click to lock the selected track.
“Locking Tracks” (w page 220)

(4) Audio expand button Click this button to display the rubber band for the audio.
[Alt] + [S]

(5) [Video Mute] When mute is set, the video part of the track is not played back. The video part and mixer area 
of the clip on a muted track is displayed in gray.
[Shift] + [W]

(6) [Audio Mute] When mute is set, the audio part of that track is muted. The audio part and volume/pan part of 
the clip on a muted track is displayed in gray.
[Shift] + [S]

(7) [Volume/Pan] Switch between the volume adjustment mode and the pan adjustment mode.
“Adjusting the Volume and Pan of a Clip” (w page 414)

(8) [Mixer] Switch the transparency adjustment mode on/off.
“Transparency” (w page 370)

(9) Mixer expand button Click this button to display the rubber band for the transparency.
[Alt] + [W]

(10) [Title] Switch the show/hide setting for the title. The title is not played back when it is set as hidden.
[Shift] + [W]

(11) Lock panel Click this to set sync-lock for a specific track on and off.
“Sync-lock (Synchronization)” (w page 225)
Right-click to lock the selected track.
“Locking Tracks” (w page 220)

2
 f Shortcut key operations are enabled on the selected track.

Track Type

Untitled

2 V

1 T

2 T

1 A

1 VA

2 A

3 A

4 A

V
A XXXXXX

(1)

(2)

(3)

(4)

(1) V track Place video, still image, title, color bar, color matte, and caption clip on this track. Video clips 
with audio are placed as video clips with the audio part disabled.

(2) VA track Place video, audio, still image, title, color bar, color matte, and caption clip on this track.
(3) T track Place video, still image, title, color bar, color matte, and caption clip on this track. Display 

priority is given to clips placed on the T track over V/VA tracks. Video clips with audio are 
placed as video clips with the audio part disabled.

(4) A track Place audio clip. Video clips with audio are placed as audio clips with the video part disabled.
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Customizing the Track Display
You can customize track width, height and track name.

Changing the Width of the Track Header
You can change the width of the track header.

1) Move the mouse cursor to the right edge of the track header, and drag when the mouse cursor 
changes shape.

1 T

2 VA

Changing the Track Height
You can change the height of the track. When the track is set higher, the thumbnails indicating clip frames are displayed larger.

1) Move the mouse cursor to the top or bottom edge of the track panel, and drag when the mouse 
cursor changes shape.

1 T

2 VA

1 Alternative
 f Right-click the track panel to change, and click [Height] → desired height.

2
 f You can also change the height of multiple tracks in a single operation. Select and right-click multiple track panels, and click [Height 
(Selected Tracks)] → desired height.

 f You can also adjust the height of all tracks in a single operation.
Right-click the sequence tab, select [Track Height] and click the desired height.
Newly added tracks from now on become the height set by this operation.

Renaming Tracks
You can rename tracks.

1 T

2 VA

(1)
(2)

(1) Track number
(2) Track name

1) Right-click the track panel to change, click [Rename] and enter the new name.

1 T

A1
2

VA
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2
 f The sort order of the tracks is always displayed as the track number.
 f Up to 30 characters can be used in the track name, and tracks with the same name also can be used. Track names that exceed the 
display range can be checked with the tooltip.

 f When a track is copied, the name also is copied.
 f The default track names are as follows:

 g Video track: V
 g Video/audio track: VA
 g Audio track: A
 g Title track: T

Track Operations
The following explains how to set and select tracks, and operations for changing numbers and moving tracks.

How to Set Tracks
The following content can be set in the [Project Settings] (Detailed Settings) dialog box.
You can also set the track settings for each sequence in the [Sequence settings] dialog box.
 f TC preset
 f TC mode
 f Total length of timeline
 f Number of tracks*

 f Audio channel map
* The number of tracks cannot be set in the sequence settings.
To set a track when creating a new project, see “Creating a New Project (Detailed Settings)”, and to change settings when editing a track, 
see “Changing the Project Setting (Detailed Settings)”.
“Creating a New Project (Detailed Settings)” (w page 58)
“Changing the Project Setting (Detailed Settings)” (w page 67)
To change settings for each sequence, see “Sequence Settings”.
“Sequence Settings” (w page 68)

Selecting Tracks
Select the track to be edited.

1) Click the track panel.
 f The selected track changes color.
 f When selecting multiple tracks, selected tracks can be added or canceled one track at a time by clicking the track panel with [Ctrl] on the 
keyboard held down.

 f You can select a range of tracks in a single operation by clicking the topmost track panel of the range with [Shift] on the keyboard held 
down and then clicking the bottommost track panel of the range.

 f All tracks can be selected by double-clicking the track panel.

1 Alternative
 f Selecting/deselecting tracks (1 to 8A): [Shift] + [1] - [8]
 f Selecting/deselecting tracks (1 to 8VA/V): [Shift] + [Ctrl] + [1] - [8]
 f Selecting/deselecting tracks (all audio tracks): [Shift] + [9] 
 f Selecting/deselecting tracks (all video tracks): [Shift] + [Ctrl] + [9]
 f Selecting/deselecting tracks (all tracks): [Shift] + [0], [Shift] + [Ctrl] + [0]

Locking Tracks
When a track is locked, the clip placed on the track can no longer be edited or moved.

1) Right-click the lock panel, and click [Track Lock].
 f “Track Header” (w page 217)
 f A diagonal line is displayed in locked tracks, and clips can no longer be edited, moved, or deleted. The ripple mode and sync-lock also 
are disabled.

 f To unlock a track, right-click the lock panel, and click [Track Unlock].
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2
 f Multiple tracks can also be unlocked in a single operation. To unlock tracks, right-click the batch lock panel, and click [Lock Selected 
Tracks].

Adding Tracks

1) Right-click the track panel, and click [Add] → an item.
 f “Track Header” (w page 217)

2) Enter the number of tracks to add.
 f To add VA tracks/A tracks, click [Channel map] and set the audio output channels of the additional tracks.
“Configuring Audio Channel Map” (w page 63)

3) Click [OK].

1 Alternative
 f Right-click a blank area of the track header, and select the track to add.

Duplicating Tracks

1) Right-click the track panel to duplicate, and click [Duplicate].
 f “Track Header” (w page 217)
 f The track is duplicated on top of the right-clicked track.

Moving Tracks

1) Click a track panel, and drag and drop onto the move destination.

00:00:00;00

2 V

V
A XXXXXX

1 VA
V

1 VA

1 Alternative
 f Right-click the track panel to move, and click [Move] → [Move Front] or [Move Back].

2
 f Tracks can be moved only between tracks of the same kind (video, audio, title track).
 f Multiple tracks cannot be selected and moved.
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Deleting Tracks

1) Right-click the track panel to delete, and click [Delete].
 f “Track Header” (w page 217)
 f Tracks on which clips are not placed are deleted at this time.

2) Click [OK].

2
 f Multiple tracks can also be deleted in a single operation. Select and right-click the track, and click [Delete (Selected Tracks)].

Timeline Display

Marking the Time Scale
You can mark the time scale with the In and Out points for setting the range to apply operations in and sequence markers to serve as the 
reference for moving tracks, etc.

00:00:05;00 00:00:05;00 00:00

(1) (2)

(3) (4) (3)

(1) Rendering options Display the required level of rendering for playing back the timeline in color by level.
“Color Coding of Time Scale” (w page 298)

(2) Timeline cursor Move the timeline cursor by dragging to the left or right.
(3) In/Out points Indicate the In and Out points of the timeline. The range to apply operations in can be restricted 

between In and Out points.
“Setting the In and Out Points on the Timeline” (w page 232)

(4) Sequence marker This is the mark to set on the timeline. An orange sequence marker becomes a chapter when 
exporting to DVD, etc. If you place the mouse cursor on the sequence marker, the timecode or 
comment on the sequence marker position is displayed (if it is set).
“Setting Sequence Markers” (w page 287)
“Sequence Marker Types” (w page 288)

Time Scale Settings
You can change the display unit for the time scale. The time scale can be displayed in the following units:
 f Frames, seconds, minutes
 f Fit (The display unit is automatically adjusted to fit the display range of the timeline window.)

(1) Time scale slider
(2) Time Scale Settings
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1) Click the list button at the time scale settings, and click the display unit.

 f Click [Fit] to adjust the time scale to display all clips on the timeline. Click [Undo] to return to the previously set display unit.

1 Alternative
 f Click the center of the time scale setting to switch the currently set display unit to [Fit].
 f Drag the time scale slider. Move the slider to the left to reduce the display unit, or to the right to increase it. The right end is [Fit].

 f Click . Click the left end to set a smaller display unit, or click the right end to set a larger display unit.

2
 f If a clip is on the timeline, you can fine-adjust the time scale settings in the range from [1 Frame] to [Fit] by dragging the time scale slider. 
The scale is indicated as “----” during fine-adjustment.

Moving the Display Range
You can move the range currently displayed on the timeline window.

1) Right-drag with [Alt] on the keyboard held down.
00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

XXXX

XXXX

XXXX

XXXX

1 Alternative
 f Move the slider at the bottom of the timeline window or the slider at the right of the track.

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00 00:00:30;00

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX

Fitting to a Desired Range
You can specify a desired view range on the timeline and fit to this range.
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1) Right-drag to enclose the range to fit to with [Shift] on the keyboard held down.
00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

Color-coding Clips on the Timeline
You can color-code clips placed on the timeline to categorize them.

1) Right-click a clip on the timeline, and click [Properties].
 f The [Clip Properties] dialog box appears.

1 Alternative
 f Select a clip, click [Clip] on the menu bar, and click [Properties].
 f Properties: [Alt] + [Enter]

2) Click the [File] tab, and select the desired color from the [Clip color] list.
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Switching the Editing Mode

Switching Mode when Placing/Moving Clips
You can switch clip operations when placing clips on the timeline or operations for linking clips on the track by the editing mode.

Insert/Overwrite Mode
In the insert mode, if a clip exists at the position where you place a clip, the new clip moves the existing clip backward and is inserted at the 
position in between.

In the overwrite mode, if a clip exists at the position where you place a clip, the new clip overwrites part of existing clip overlapped by the 
new clip.

1) Click [Toggle Insert/Overwrite Mode] on the mode bar.
 f Each click switches between the insert mode and the overwrite mode.

album1

V

 f  : Insert mode
 f  : Overwrite mode
 f The current mode (insert mode/overwrite mode) is displayed on the status bar of the timeline.

1 Alternative
 f Switch overwrite/insert mode: [Insert]

Sync-lock (Synchronization)
The result of track editing such as insertion or moving a clip affects other tracks, too, when sync-lock is set to a track.

Example:

When sync-lock is set to all three tracks and a clip has been added in the insert mode:
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1) Click the lock panel of the track to which sync-lock is set.
 f Each click switches between on and off.

Untitled

2 V

1 T

2 T

1 A

1 VA

2 A

3 A

4 A

V
A XXXXXX

 f To set sync-lock to all tracks, click the batch lock panel.

Untitled

2 V

1 T

2 T

1 A

1 VA

2 A

3 A

4 A

V
A XXXXXX

1 Alternative
 f Right-click the lock panel of the track to set sync-lock to, and click [Track Sync Lock]. To cancel, click [Track Sync Unlock].
 f Select the track to set sync-lock to, right-click the batch track panel, and select [Sync Lock Selected Tracks].

Ripple Mode
In the ripple mode, when a clip is deleted or trimmed, the subsequent clips move forward to prevent spaces from being formed on the 
timeline. When inserting a clip, you can move the subsequent clips while holding the space at the insert position.

2
 f All subsequent clips following the clip that is being edited between tracks set with sync-lock are interlocked.

Example:

When sync-lock is disabled on all three tracks and a clip has been inserted with the ripple mode on (insert mode)

Example:

When sync-lock is set on all three tracks and a clip has been inserted with the ripple mode on (insert mode)
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1) Click [Set Ripple Mode] on the mode bar.
 f Each click switches the mode on and off.

album1

V

 f The current mode (ripple on/ripple off) is displayed on the status bar of the timeline.

1 Alternative
 f Switching ripple mode: [R]

2
 f When the ripple mode is on, sequence markers can be linked to the timeline editing.
“Sync-Lock Setting of Sequence Marker” (w page 287)

Group/Link Mode
You can temporarily disable links or grouping of linked or grouped clips.

3 Note
 f The links of VA clips on VA tracks cannot be released by setting the group/link mode to off. By switching the group/link mode, the links 
of clips placed separately on the V and A tracks are targeted for this operation. When releasing the links of VA clips, release links 
individually.
“Unlinking Clips” (w page 241)

1) Click [Set Group/Link Mode] on the mode bar.
 f Each click switches the mode on and off.

album1

V

1 Alternative
 f Switching group/link mode: [Shift] + [L]

Event Snap Mode
Switch the enable/disable setting of the snap function.

2
 f You can set events to be used as the snap destination by [Application] in [User Settings] → [Timeline].
“[Timeline]” (w page 115)

1) Click [Snap to Event] on the mode bar.
 f Each click switches the mode on and off.

album1

V

Extend/Fix mode
When adding a transition or audio cross fades between clips, set whether to add without changing the length of the whole clip (extend mode) 
or add without changing the length of individual clips (fix mode).
“Clip Transition” (w page 363)
“Audio Cross Fade” (w page 365)
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 r Extend Mode
Even when adding/deleting a transition or an audio cross fades between clips, the length of the whole clip on the timeline remains 
unchanged.

 r Fix mode
When adding/deleting a transition or an audio cross fades between clips, the length of the whole clip on the timeline shortens (lengthens) by 
the amount that the transition/audio cross fades was applied.

Setting the Extend/Fix Mode

2
 f If you add [Toggle Extend Clips when Applying Transition/Cross Fade] as an operation button in advance to the timeline, you can switch 
between the extend/fix modes simply by clicking the button.
“Operation Button Settings” (w page 147)

Setting Extend Mode

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Application] tree, and click [Timeline].

3) Check [Extend Clips when Applying Transition/Cross Fade].

 r When transition/audio cross fade is set...
As In/Out points of left and right clips extend when a transition has been set or its length has been changed, the total length of clips on the 
timeline remains unchanged.

00:00:05;00 00:00:10;00 00:00 00:00:05;00 00:00:10;00 00:00
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3 Note
 f If a clip does not have a margin, transition/audio cross fades cannot be set (except for mixer area). You can extend the length of 
transitions by the margin of the clip.
“Margin of Clip” (w page 363)
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 r When transition/audio cross fade is deleted...
Clips contract by the extended amount due to the setting, and the total length of clips on the timeline remains unchanged.
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2
 f When one of the clips set with transition is deleted, the transition also is deleted at the same time. The length of the remaining clip 
changes, extending to the middle of the transition (the length including the extended amount when setting the transition).

Setting Fix Mode

1) Click [Settings] on the menu bar, and click [User Settings].

2) Click the [Application] tree, and click [Timeline].

3) Uncheck [Extend Clips when Applying Transition/Cross Fade].

 r When transition/audio cross fade is set...
Left and right clips overlap with each other by the preset transition amount. The total length of the whole clip on the timeline shortens.
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When the length of the transition has been changed, clips move to the left, and the length of the whole clip on the timeline changes 
according to the transition length.
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 r When transition/audio cross fade is deleted...
The length of the whole clip on the timeline lengthens by the preset transition amount.
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2
 f To move the clips of other tracks together, turn on sync-lock of the track to move together with the track containing the clip to which 
transition/audio cross fades has been added.
“Sync-lock (Synchronization)” (w page 225)
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Placing Clips

Setting Channel Mapping
Set which track the channel containing the source clip (source channel) should be mapped to when placing clips on the timeline. When 
performing editing operations such as placing clips or pasting them with shortcut keys, the clips are placed on a track according to the 
channel mapping setting.

Connecting/Disconnecting the Source Channel
Connect or disconnect the channel containing the source clip (source channel). Disconnected channels are not placed on the timeline.

1) Click and select the clip in the bin to be placed on the timeline.
 f The source channel is displayed in the track patch.
 f When a clip is displayed on the Player, it is displayed on the track patch in the same way.
 f When a clip in the source browser is selected, the source channels are displayed on the track patch according to the channel map in the 
project settings.

Example:

When the selected clip has video and audio 8 channels
The mapping is specified so that video and audio channels 1 and 2 are placed on the 1VA track, audio channels 3 and 4 on the 1A track, 
audio channels 5 and 6 on the 2A track, and audio channels 7 and 8 on the 3A track.
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2) Click on the track patch of the unnecessary source channel to disconnect it.
 f Each click connects/disconnects it alternately.

2
 f To change the destination to connect the source channel, drag and drop the track patch of the source channel to be changed to the new 
destination track patch.

 f To place an audio source channel as a monaural channel or stereo channel, right-click on the track patch of the audio and click [Audio 
Source Channel (Stereo)]. Each click switches between the monaural channel and stereo channel modes.

1 Alternative
 f Right-click the track patch of the source channel, and click [Connect Source Channel (Video) (Toggle)]([Connect Source Channel (Audio) 
(Toggle)]).

 f Connecting/disconnecting video source channel: [7]
 f Connecting/disconnecting audio source channel: [8]
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2
 f You can connect/disconnect multiple source channels all together. Click [Connect Source Channel (Video) - Toggle] or [Connect Source 
Channel (Audio) - Toggle].

Untitled
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 f As the default settings, 1st audio channel in each track is assigned to the 1st channel of the export destination, and 2nd audio channel is 
assigned the 2nd channel of the export destination.
“[Audio Channel Map] Dialog Box” (w page 64)

 f To place an audio source channel as a monaural channel or stereo channel, right-click on the track patch of the source channel and click 
[Audio Source Channel (Stereo)]. Each click switches between the monaural channel mode and stereo channel mode.
When the monaural channel mode is set:
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When the stereo channel mode is set:
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 f If you add [Audio Source Channel Mode (Stereo/Monoral)] to the mode bar as an operation button, you can switch the mode simply by 
clicking the button.
“Operation Button Settings” (w page 147)

 f Clips are played back in the channel mode set in the track patch even when the clips are played back on the Player.

Changing the Connection Destination of Source Channels

1) Select the source clip to be placed.
 f The source channel is displayed in the track patch.

2) Drag and drop the track patch of the desired source channel onto the track patch of the connection 
destination.
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2
 f When the desired source channel has been dragged and dropped onto the track patch to which an audio source channel is connected, 
the channel is switched.

 f To initialize source channel mapping, right-click the track patch of the source channel and click [Reset Source Channel Mapping].

Setting the In and Out Points on the Timeline

Setting the In and Out Points on the Timeline
By setting the In and Out points on the timeline, you can limit the range to apply operations to between In and Out points, or place clips 
referenced to the In and Out points.

(1) (2)

(1) Set the In point
(2) Set the Out point

1) Move the timeline cursor to the position to set the In point.

00:00:00;00 00:00:05;00
XXXXXX

2) Click [Set In] on the Recorder.

3) Move the timeline cursor to the position to set the Out point.

4) Click [Set Out] on the Recorder.

1 Alternative
 f Move the timeline cursor to the position to set the In and Out points, and right-click the time scale. Click [Set In Point] or [Set Out Point].
 f Move the timeline cursor to the position to set the In and Out points, and click [Marker] on the menu bar. Click [Set In Point] or [Set Out 
Point].

 f Move the slider on the Recorder to the position to set the In and Out points, and right-click the slider. Click [Set In Point] or [Set Out Point].
 f Setting In and Out points on the timeline: [I]/[O]

2
 f You can drag the In and Out point slider on the time scale to reposition the In and Out points.

00:00:05;005;00 00:00:05

 f When the Out point has been set before the In point, the time scale between In and Out points changes color to red and a part of the 
timecode on the Recorder is displayed in red.

 f When duration is entered at [Dur] on the Recorder in the preview window after an In point (or Out point) has been set, the Out point (or In 
point) is set according to the duration.

 f From [User Settings] → [Application] → [Timeline], you can set whether the frame displayed in the preview window is to be included in the 
range of In and Out points.
“[Timeline]” (w page 115)

Setting In and Out Points to Both Ends of Clips
Set the In and Out points of the timeline to both ends of a selected clip.
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1) Select a clip, click [Marker] on the menu bar, and click [Set In/Out Point to Selected Clip].
 f In and Out points are set to both ends of the clip.

00:00:05;00 00:00:10;00
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0:05;00 00:00:10

1 Alternative
 f Setting In and Out points to both ends of a selected clip: [Z]

Deleting the In and Out Points on the Timeline
You can delete In and Out points on the timeline.

1) Click the [Set In] ([Set Out]) list button on the Recorder.

2) Click [Clear In Point] ([Clear Out Point]).

1 Alternative
 f Right-click the time scale, and click [Clear In Point] ([Clear Out Point]).
 f Click [Marker] on the menu bar, and click [Clear In Point] ([Clear Out Point]).
 f Right-click the slider on the Recorder, and click [Clear In Point] ([Clear Out Point]).
 f Deleting In and Out Points on the timeline: [Alt] + [I]/[Alt] + [O]

2
 f You can delete In and Out points in a single operation by the following operation:

 g Right-click the time scale, and click [Clear In/Out Point].
 g Click [Marker] on the menu bar, and click [Clear In/Out Point].
 g Deleting In/Out points: [X]

Placing Clips

Placing Clips
You can place source clips on the timeline.
Clip operations at placement and placement results are dependent on the editing mode.
“Switching the Editing Mode” (w page 225)

1) Set the source channel mapping.
 f “Setting Channel Mapping” (w page 230)

2) Move the timeline cursor to the position to place the clip.

3) Select a clip from the bin, and click [Add to Timeline].

 f The clip is placed on the track with the position of the timeline cursor set as the In point.
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1 Alternative
 f Drag and drop a clip in the bin onto the timeline. Channels can be mapped to any desired track and clips can be placed according to the 
drop point regardless of the track patch setting.
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 f Right-click a clip in the bin, and click [Add to Timeline].
 f Play back a clip on the Player, and drag and drop the clip onto the timeline from the Player. Channels can be mapped to any desired track 
according to the drop point regardless of source channel mapping.

 f Play back a clip on the Player, and click [Insert to Timeline] or [Overwrite to Timeline].
 f Placing a clip displayed on the Player on the timeline: [E]
 f Set the source channel mapping, move the timeline cursor to the clip place point, and drag and drop the clip onto the Recorder.
 f Placing clips: [Shift] + [Enter]

2
 f You can place sources on the timeline without registering them to the bin.
Move the timeline cursor to the clip place point, right-click a track, and click [Add Clip]. Select the source from the [Open] dialog box, and 
click [Open].

Placed Clips

You can confirm that a filter or transition is set from the display of the clip placed on the track.
Triangular marks at both ends of the clip mean the start and end of the clip. Triangular marks are displayed when the clip has no margin.

XXXX
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A green line is displayed at the top of the clip when rendering has been performed. An orange line is displayed when filter, time effect, 
layouter, normalize, etc. has been set.

Example:

When effect has been set

XXXX

XXXX
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A frame is displayed as follows when a transition or audio cross fades is set between clips.
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A triangle is displayed as shown below in the mixer area when a track transition is set at the start point of a clip.

XXXX

XXXX

Clicking the audio expand button displays a rubber band and waveform for the volume, and clicking the mixer expand button displays a 
rubber band for the transparency.

XXXX

XXXX

“Adjusting the Volume and Pan of a Clip” (w page 414)
“Transparency” (w page 370)

Setting In/Out Points and Placing Clips
You can set In and Out points to clips, and place only the required part on a track.

1) Select a clip from the bin, and click [Show in Player].

 f The same operations can also be performed in the source browser.

2) Set the In and Out points to the clip.
 f “Setting the In and Out Points” (w page 189)

3) Set the source channel mapping.
 f “Setting Channel Mapping” (w page 230)

4) Move the timeline cursor to the position to place the clip.

5) Click [Insert to Timeline] on the Player.

 f The clip is placed on the track with the position of the timeline cursor set as the In point.
 f When [Overwrite to Timeline] is clicked, the clip is placed in the overwrite mode.

1 Alternative
 f After setting the In and Out points to the clip, drag and drop the clip from the Player to place it on the timeline.
 f Placing the clip displayed on the Player on the timeline: [E]

2
 f Divided and placed video and audio clips are set in groups.
“Ungrouping” (w page 242)

Placing Clips between In and Out Points on the Timeline (3 Point Editing)
Place clips between In and Out points on the timeline. Clips are placed by the length between In and Out points on the timeline.
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1) Select a clip from the bin, and click [Show in Player].

 f The same operations can also be performed in the source browser.
 f Check the video on the Player, and set the In and Out points, if necessary.
“Setting the In and Out Points” (w page 189)

2) Set the source channel mapping.
 f “Setting Channel Mapping” (w page 230)

3) Set the In and Out points to the timeline.
 f “Setting the In and Out Points on the Timeline” (w page 232)

4) Click [Insert to Timeline] on the Player.

 f The clip is placed trimmed to the length between In and Out points on the timeline. When the In point has been set, it is placed referenced 
to the In point.

 f The playback speed of the placed clip remains unchanged.
 f When [Overwrite to Timeline] is clicked, the clip is placed in the overwrite mode.

Placing the In and Out Points of Clips between In and Out Points on the Timeline (4 Point 
Editing)

Set the In and Out points to the clip, and place it between In and Out points on the timeline. The speed between In and Out points of the clip 
is adjusted automatically according to the length between In and Out points on the timeline.

1) Select a clip from the bin, and click [Show in Player].

 f The same operations can also be performed in the source browser.

2) Set the In and Out points to the clip.
 f “Setting the In and Out Points” (w page 189)

3 Note
 f Even if a margin is not assigned to a source, set the In and Out points to the start and end of the source. The editing mode becomes 
3-point editing when In and Out points are not set.

3) Setting the Source Channel Mapping
 f “Setting Channel Mapping” (w page 230)

4) Setting the In and Out Points to the Timeline
 f “Setting the In and Out Points on the Timeline” (w page 232)

5) Click [Insert to Timeline] on the Player.

 f The In and Out points of a clip are placed between In and Out points on the timeline.
 f When [Overwrite to Timeline] is clicked, the clip is placed in the overwrite mode.
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3 Note
 f When the duration between In and Out points on the timeline differs from that between In and Out points of the clip, the playback 
speed of the clip is adjusted automatically to stay between In and Out points on the timeline, with the range between In and Out points 
maintained.

Placing Special Clips on the Timeline
You can create color bar clips, color matte clips, and title clips on the timeline.

1) Click [Create Title] on the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

2) Click the clip to create.
 f When the In and Out points have not been set on the timeline, the clip is created at the position of the timeline cursor. The duration of the 
created clip can be set by [Source] in [User Settings] → [Duration].

 f When the In and Out points have been set on the timeline, the clip is created between In and Out points. You can set whether to create 
clips between In and Out points or at the cursor position by [Source] in [User Settings] → [Duration].
“[Duration]” (w page 121)

3 Note
 f When all source channels have been released (track patch all set to off), color bar clips, color matte clips and title clips cannot be 
created. Also, title clips cannot be created when the video source channel is released.
“Connecting/Disconnecting the Source Channel” (w page 230)

3) Edit the clip.
 f “Color Bar Clips” (w page 197)
 f “Color Matte Clips” (w page 198)
 f “Quick Titler” (w page 388)

1 Alternative
 f Right-click the track to create the clip on, and click [New Clip] → clip to create. The clip is placed at the right-clicked track regardless of 
the channel mapping settings.

2
 f Color matte bars, color mattes and title clips placed on the timeline can be edited by the following operation.

 g Select the clip to edit, and click [Clip] on the menu bar → [Edit].
 g Double-click the clip to edit.
 g Editing selected clip: [Shift] + [Ctrl] + [E]

Moving Clips
Drag a clip placed on the timeline, and drop it onto the destination. Clips can be moved to any desired position, including different tracks.

Selecting Multiple Clips
You can select all clips in the same track. You can also select all clips on the timeline.

1) Click the track panel to select the track.
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2) Right-click the timeline, and click [Select] → [Selected Tracks].
 f All clips on the selected track are selected.
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 f When [All Tracks] is clicked, all clips on the timeline are selected.

1 Alternative
 f Click a clip with [Ctrl] on the keyboard held down to add or remove the clip one at a time.
 f Specify the range including the clip by dragging from the start point to the end point on the timeline.
 f Click [Edit] on the menu bar, and click [Select] → [Selected Track] or [All Tracks].
 f Selecting all clips on the selected track: [Ctrl] + [A]
 f Selecting all clips on timeline: [Shift] + [A]

Moving Clips
You can move clips by dragging and dropping. You can also move multiple clips at the same time.
“Selecting Multiple Clips” (w page 237)

1) Select a clip, and drag and drop it at the destination.
00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00
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 f Clip operations at move and move results are dependent on the editing mode.
“Switching the Editing Mode” (w page 225)

 f When you select clips over multiple tracks and move them to the area where the corresponding type of track does not exist, a track is 
automatically added.
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Example:

When multiple clips on the 1VA track and 2VA track have been selected, and dragged and dropped to a track above
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1 Alternative
 f Right-drag the clip to the move destination, and click [Overwrite] or [Insert]. Clips can be moved in the overwrite mode or insert mode 
regardless of the editing mode.

3 Note
 f When you have selected multiple clips placed on different types of tracks and dragged across tracks, only clips placed between tracks 
of the same type move.
When multiple clips on the 1VA track, 1T track, and 1A track have been selected and dragged and dropped to a track above, the 
screen is displayed as follows.
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 f When only one of two clips set with a clip transition or audio cross fades is moved, only the selected clip moves and the transition is 
released.
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Moving a Selected Clip and Subsequent Clips
You can move a selected clip and the subsequent clips within the same track with each position maintained.

1) Select the starting clip of the clips to be moved, and drag it with [Shift] and [Alt] on the keyboard 
held down.

 f The mouse cursor changes shape, and clips following the selected clip move at the same time.
 f The clips of tracks set with sync-lock also are interlocked.
“Sync-lock (Synchronization)” (w page 225)

Searching for Clips on the Timeline in the Bin
You can specify conditions and search for clips in the bin which are placed on the timeline. The [Search results] folder is created in the 
folder view of the bin.

1) Select a clip to search from the timeline.

2) Click [Clip] on the menu bar, and click [Search Bin] → a search condition.
 f The [Search results] folder is created in the folder view of the bin and the clips that match the search conditions are displayed.

1 Alternative
 f Right-click a clip, and click [Search Bin] → search condition.

2
 f The [Search results] folder created once according to specified conditions starts searching clips that match the conditions each time it is 
opened and viewed. Clips newly registered to the bin also are targeted in the search.

 f You can refine the search or change search conditions in the bin for clips in the [Search results] folder.
“Searching in the Bin” (w page 213)
“Deleting Search Results” (w page 214)

 f When [Including Cursor (Recorder)] has been clicked in the search conditions, the name of the [Search results] folder is displayed by the 
source timecode.



Chapter 7   Editing Operations — Clip Operations

241

Clip Operations

Handling Only the Video Part or Audio Part of Clips Separately

2
 f Conditions for setting a link are as follows:

 g The clip is placed in the same track.
 g Part of the clip is overlapping.
 g The clip is referencing the same source.

 f When the group/link mode is switched, the video part and audio part of all clips in the sequence can be temporarily handled separately.
“Group/Link Mode” (w page 227)

 f When the start points of the video and audio clips set with a link are out-of-position, the number of frames that the clips are out by is 
displayed at the top of the clip.
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Unlinking Clips
The video and audio parts in a video clip on the VA track can be separated. By releasing the link, you can handle them as independent clips.

1) On the timeline, right-click the clip to unlink, and click [Link/Group] → [Unlink].

1 Alternative
 f Click [Clip] on the menu bar, and click [Link/Group] → [Unlink].
 f Unlinking: [Alt] + [Y]

Link Settings
Unlinked video clips and audio clips can be re-linked.

1) On the timeline, select the respective video and audio clips to be linked.

2) Right-click a clip, and click [Link/Group] → [Link].
 f The link is set, and you can handle it as a single clip.

1 Alternative
 f Click [Clip] on the menu bar, and click [Link/Group] → [Link].
 f Setting link: [Y]

Handling Multiple Clips as a Single Clip

2
 f When the group/link mode is switched, all groups in a sequence are temporarily ungrouped, and the video part and audio part of clips can 
be handled separately.
“Group/Link Mode” (w page 227)

Setting Groups
Handle multiple clips as a single group. You can group the clips over different tracks.

1) On the timeline, select the multiple clips to be grouped.

2) Right-click a clip, and click [Link/Group] → [Set Group].
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1 Alternative
 f Click [Clip] on the menu bar, and click [Link/Group] → [Set Group].
 f Setting group: [G]

Ungrouping
You can restore grouped clips to their original separate clips.

1) Right-click a clip in the group, and click [Link/Group] → [Ungroup].

1 Alternative
 f Click [Clip] on the menu bar, and click [Link/Group] → [Ungroup].
 f Ungrouping: [Alt] + [G]

Copying/Pasting Clips

Copying

1) Select a clip, and click [Copy] on the timeline.

Untitled

 f You can continue to paste and replace clips.

1 Alternative
 f Right-click a clip and click [Copy].
 f Click [Edit] on the menu bar, and click [Copy].
 f Copying: [Ctrl] + [C], [Ctrl] + [Insert]

Cutting
Cut clips. The cut clip is deleted from its current position.

1) Select a clip, and click [Cut (Follow Mode)] on the timeline.

Untitled

 f The editing result of a cut operation is dependent on the editing mode.
“Ripple Mode” (w page 226)
“Sync-lock (Synchronization)” (w page 225)

 f You can continue to paste and replace clips.

1 Alternative
 f Right-click a clip, and click [Cut] or [Ripple Cut].
 f Select a clip, click [Edit] on the menu bar, and click [Cut] or [Ripple Cut].
 f Cutting (mode-dependent): [Ctrl] + [X]
 f Cutting: [Shift] + [Delete]
 f Ripple cutting: [Alt] + [X]

Pasting
You can paste copied or cut clips to the timeline.

1) Select a clip, and copy or cut it.
 f “Copying” (w page 242)
 f “Cutting” (w page 242)

2) Select a track, and move the timeline cursor to the paste position.
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3) Click [Paste to Current Location] of the timeline.

Untitled

 f The clip is placed with the position on the timeline cursor set as the In point.

1 Alternative
 f Right click on the track to paste to, and click [Paste]. At this time, the clip will be pasted to the right-clicked track regardless of the 
currently selected track.

 f Click [Edit] on the menu bar, and click [Paste] → [Cursor].
 f Right click on any clip on the track to paste to, and click [Paste] → [Cursor]. At this time, the clip will be pasted to the position of the 
timeline cursor on the right-clicked track regardless of the currently selected track.

 f Pasting: [Ctrl] + [V]

2
 f A track is automatically added if there is no track at the paste destination.
 f If a clip exists at the destination position, it is divided at the position of the timeline cursor and the pasted clip overwrites the existing clip 
or is inserted between the divided clips.

Pasting to the In and Out Points of Clips
You can insert another clip at (or in front of) the In point or at (or behind) the Out point of a specific clip.

Example:

When pasting another clip to the Out point of the white clip

1) Select a clip, and copy or cut it.
 f “Copying” (w page 242)
 f “Cutting” (w page 242)

2) Click the clip to be used as the reference for pasting.

3) Click [Edit] on the menu bar, and click [Paste] → [Clip In] or [Clip Out].

[Clip In] Insert the clip at (or in front of) the In point of the selected clip.
[Clip Out] Insert the clip at (or behind) the Out point of the selected clip.

1 Alternative
 f Right-click the clip to be used as the reference for pasting, and click [Paste] → [Clip In] or [Clip Out].

Replace
You can replace a copied, cut or ripple cut clip.

1) Select a clip, and copy or cut it.
 f “Copying” (w page 242)
 f “Cutting” (w page 242)

2) Select a clip to replace, and click [Replace Clip (All)] on the timeline.

Untitled

 f All of the mixers and filters applied to the clip also are replaced.

1 Alternative
 f Right-drag on the desired clip to be replaced, and click [Replace].
 f Click the [Replace Clip (All)] list button, and click [All].
 f Right-click the clip to replaced, and click [Replace] → [All].
 f Click [Edit] on the menu bar, and click [Replace] → [All].
 f Replacing all: [Ctrl] + [R]
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3 Note
 f When the duration differs from that of the clip to be replaced by a copied or cut clip, the clip will automatically be trimmed referenced to 
the In point of the copied or cut clip. The playback speed remains unchanged.

Replace Parts
Only filters and mixers can be partially replaced.

1) Select a clip, and copy or cut it.
 f “Copying” (w page 242)
 f “Cutting” (w page 242)

2) Select the clip to replace.

3) Click the [Replace Clip (All)] list button on the timeline.

Untitled

4) Click the replace item.

1 Alternative
 f Right-drag on the desired clip to be replaced, and click [Replace parts] → replace items.
 f Click [Edit] on the menu bar, and click [Replace] → replace items.
 f Right-click the replace target clip, and click [Replace] → replace items.
 f Replacing the filter: [Alt] + [R]
 f Replacing the mixer: [Shift] + [Ctrl] + [R]
 f Replacing the clip: [Shift] + [R]
 f Replacing the clip with filter: [Shift] + [Alt] + [R]

Dividing Clips

Dividing Clips at the Timeline Cursor Position
You can divide clips at the timeline cursor position. After dividing a clip, you can handle its divided segments as independent clips.

1) Select the clips to be divided.
 f You can select multiple clips.

2) Move the timeline cursor to the position where the clip is to be divided.

3) Click [Add Cut Point (Selected Tracks)] of the timeline.

00:00:10;00 00:00:15;00 00:00:20;00

 f The clip is divided at the timeline cursor position.
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1 Alternative
 f Click the [Add Cut Point] list button, and click [Selected Tracks].
 f Right-click the clip where the cut point is to be added, and click [Add Cut Point] → [Selected Tracks]. By this operation, the right-clicked 
clip is divided at the timeline cursor position regardless of the currently selected track.

 f Click [Edit] on the menu bar, and click [Add Cut Point] → [Selected Tracks].
 f Adding cut point at current position (selected tracks): [C]

2
 f When the currently selected clip is at the timeline cursor position, that clip is divided regardless of the selected tracks.
 f By the following operation, you can divide the clips on all tracks at the timeline cursor position in a single operation.

 g Click the [Add Cut Point] list button, and click [All Tracks].
 g Right-click any clip, and click [Add Cut Point] → [All Tracks].
 g Click [Edit] on the menu bar, and click [Add Cut Point] → [All Tracks].
 g Adding cut point (all tracks): [Shift] + [C]

Dividing Clips at the In and Out Points
You can set the In and Out points on the timeline to divide the clip at a desired position.

1) Select the track where the clip to be divided is currently placed.
 f Multiple tracks also can be selected.
“Selecting Tracks” (w page 220)

2) Setting the In and Out Points to the Timeline
 f “Setting the In and Out Points on the Timeline” (w page 232)

3) Click the [Add Cut Point (Selected Tracks)] list button on the timeline.

00:00:10;00 00:00:15;00 00:00:20;00

4) Click [In/Out (Selected Tracks)].

1 Alternative
 f Right-click the desired clip on the track where the cut point is to be added, and click [Add Cut Point] → [In/Out (Selected Tracks)].
 f Select the track where the clip to divide is currently placed, click [Edit] on the menu bar, and click [Add Cut Point] → [In/Out (Selected 
Tracks)].

 f Adding cut point at In/Out points (selected tracks): [Alt] + [C]

2
 f When the currently selected clip is at the In or Out point, that clip is divided regardless of the selected tracks.
 f By the following operation, you can divide the clips on all tracks at the In and Out points on the timeline in a single operation.

 g Click the [Add Cut Point] list button, and click [In/Out (All Tracks)].
 g Right-click any clip, and click [Add Cut Point] → [In/Out (All Tracks)].
 g Click [Edit] on the menu bar, and click [Add Cut Point] → [In/Out (All Tracks)].
 g Adding cut point at In/Out points (all tracks): [Shift] + [Alt] + [C]

Combining Divided Clips
You can recombine divided clips.

1) Select 2 clips to be combined.

XXXX

XXXX

XXXX

XXXX
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2) Click the [Add Cut Point (Selected Tracks)] list button on the timeline.

00:00:10;00 00:00:15;00 00:00:20;00

3) Click [Remove cut points].
 f The 2 clips are combined, and can be handled as a single clip.

XXXX

XXXX

1 Alternative
 f Right-click a clip and click [Remove cut points].
 f Click [Edit] on the menu bar, and click [Remove cut points].
 f Deleting cut point: [Ctrl] + [Delete]

2
 f Three or more clips can be combined with the same operation.

3 Note
 f [Remove cut points] is available only when neighboring clips are referencing the same source.
 f When combining clips, if individual effects (e.g. video filter) or layouts have been applied to the clips before combining, the effect of 
clips placed to the leftmost side of the timeline are applied to clips after combining and other effects are deleted.

 f The two clips before combining cannot be combined if their playback speed is different. Also, the settings of clips from the second clip 
from the left and onwards are discarded if a time remap has been set.

 f When combining clips, the rubber band setting before combining is maintained. Note, however, that priority is given to the settings of 
subsequent clips when the rubber band points of the combined section are out-of-position.

Clip Enable/Disable
You can disable clips placed on the timeline. Disabled clips cannot be played back.

1) Right-click the clip to disable, and click [Enable/Disable].
 f Disabled clips are displayed in gray regardless of their type.

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

1 Alternative
 f Select the clip to disable, click [Clip] on the menu bar, and click [Enable/Disable].
 f Enabling/disabling clips: [0]

2
 f You can enable disabled clips by the same operation.
 f Disabled clips can be edited in the same way as enabled clips.

Deleting Clips

Deleting Clips/Ripples
Delete clips placed on the timeline.
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1) Select a clip, and click [Delete] or [Ripple delete] on the timeline.

00:00:05;00 00:00:10;00 00:00:15;00

 f The selected clip is deleted.
 f Regardless of the on/off setting of the ripple mode, when [Delete] is clicked, the selected clip is deleted, and when [Ripple delete] is 
clicked, all clips behind the deleted clip move forward together.

1 Alternative
 f Select a clip, click [Edit] on the menu bar, and click [Delete] or [Ripple delete].
 f Right-click the clip to delete, and click [Delete] or [Ripple delete].
 f Deleting clip (mode-dependent): [Delete]
 f Ripple deleting clip: [Alt] + [Delete]

Deleting/Ripple Deleting between In and Out Points on the Timeline
Delete the range of the clip between In and Out points on the timeline.

1) Setting the In and Out Points to the Timeline
 f “Setting the In and Out Points on the Timeline” (w page 232)

2) Click [Edit] on the menu bar, and click [Delete In/Out] or [Ripple Delete In/Out].
 f When [Delete In/Out] is clicked, all clips between In and Out points are deleted.
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 f When [Ripple Delete In/Out] is clicked, all clips between In and Out points are deleted, and clips behind the deleted clips are moved 
forward together.
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1 Alternative
 f Right-click the time scale, and click [Delete In/Out] or [Ripple Delete In/Out].
 f Right-click a track, and click [Delete In/Out] or [Ripple Delete In/Out].
 f Deleting between In and Out points on the timeline (mode-dependent): [D]
 f Ripple deleting between In and Out Points on the timeline: [Alt] + [D]

2
 f When only the In point has been set, the range of the clip after the In point is deleted, and when only the Out point has been set, the 
range of the clip from the beginning of the timeline to the Out point is deleted.

Deleting/Ripple Deleting Only Video/Audio Clips
Delete only the video part or audio part of video clips with audio.

1) Select a clip.

2) Click [Edit] on the menu bar, and click [Delete Parts] → an item.
Example:

When deleting video clips

XXXX

XXXX XXXX

1 Alternative
 f Right-click a clip and click [Delete Parts] → an item.
 f Unlink the clip, select only the video clip or audio clip, and delete/ripple delete.
“Unlinking Clips” (w page 241)
“Deleting Clips/Ripples” (w page 246)

 f Once the clips are dragged and placed on the A track (V track), the video (audio) part is disabled.
 f Deleting video clip only (mode-dependent): [Alt] + [V]
 f Deleting video clip only (mode-dependent): [Alt] + [A]

Deleting Gaps (Blanks)
Delete blank spaces between clips, and move clips behind forward.
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1) Right-click the gap to be deleted, and click [Delete Gap].
 f The gap is deleted, and the clips behind are connected to the previous clip.
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1 Alternative
 f Select the clip behind the gap to delete, and press [Shift] + [Alt] + [S] or [Backspace] on the keyboard.
 f Select the clip behind the gap to delete, and click [Edit] → [Delete Gap] → [Selected Clip] on the menu bar.
 f Move the timeline cursor to the position of the gap to delete, select a track and click [Edit] → [Delete Gap] → [Cursor] on the menu bar.
 f To delete multiple gaps at a time, select multiple gaps behind the gap to delete and perform the operation above.

2
 f When sync-lock is set to on, the length of clips including linked tracks becomes the shortest by moving forward as a result of deleting the 
gap. Ripple delete does not function if there are no gaps on other tracks.
When deleting the gap of A with sync-lock set to on, the screen is displayed as follows.
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Deleting the gap A is limited to the gap length of B.

Playback Speed Adjustment

2
 f When [Speed] or [Time Remap] is set, menu items to be displayed when each item is set is checked.

3 Note
 f When the playback speed of clips is changed, ancillary data will be deleted.

Changing the Speed of the Whole Clip
You can change the playback speed of clips.
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1) Right-click a clip, and click [Time Effect] → [Speed].
 f The [Speed] dialog box appears.
“[Speed] Dialog Box” (w page 250)

1 Alternative
 f Click [Clip] on the menu bar, and click [Time Effect] → [Speed].
 f Changing the speed of the whole clip: [Alt] + [E]

2) Set each item and click [OK].
 f An orange line is displayed on clips whose speed has been changed.

2
 f The speed of multiple clips placed on separate clips can be changed in a single operation. A message is displayed if the speed change 
cannot be set depending on the combination of clips.

3 Note
 f The playback speed cannot be changed for split trimmed clips on the VA track. To change the speed, unlink the clip.
“Split Trim” (w page 271)
“Unlinking Clips” (w page 241)

[Speed] Dialog Box

(1) [Speed] [Direction]
Select the playback direction of the clips.
[Rate]
Enter the ratio to the original speed (100%).
Since the speed is changed referenced to the In point, when [Change the Clip Duration on 
Timeline] is unchecked, the upper limit of Rate that can be entered changes according to the 
margin on the Out point side of the source clip. When there is no margin on the Out point side, 
a Rate greater than 100% cannot be entered.

(2) [Change the Clip 
Duration on Timeline]

Check this item to change the duration of clips on the timeline according to the speed (value 
of [Rate]) of the clip. The duration of the clip can be entered at [Duration] to change the speed. 
When this item is unchecked, the speed can be changed without changing the duration of the 
clip on the timeline.

(3) [Field Option] The [Field Option] dialog box appears.
“[Field Option] Dialog Box” (w page 254)

Partially Changing Playback Speed (Time Remap)
You can alter the speed of any part of a clip.
You can remap a particular frame of a clip to a different position of the timeline. The remaining frames are automatically interpolated, and 
as a result the speed of the previous/next frames is changed. The In point of a clip, the frame of the Out point and the overall length remain 
unchanged.

1) Right-click a clip, and click [Time Effect] → [Time Remap].
 f The [Time Remap] dialog box appears.
“[Time Remap] Dialog Box” (w page 252)

1 Alternative
 f Click [Clip] on the menu bar, and click [Time Effect] → [Time Remap].
 f Partially changing playback speed: [Shift] + [Alt] + [E]
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2) Drag the timeline cursor.

3) Click [Add Key / Delete] at the position to add a key.
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 f The key is added in the key setting field.
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1 Alternative
 f Right-click the [Time Remap] dialog box and click [Add Key] to add a key to the position of the timeline cursor.
 f Right-click the [Time Remap] dialog box and click [Delete Key] to delete the key from the position of the timeline cursor.

4) Move the mouse cursor over the key, and drag to the left or right.

00:00:03;00

clip01   Org[In:00:05:26;18 Out:00:05:32;01 Dur:00:00:05;13

XXXX: 00:00:05;27

- - : - - : - - ; - -

00:00:04;00 00:00:05;00 00:00:06;00 00:00

00:05:29;10

XXXXXXXXX XXX
XXXXXX

XXXXXXXX

XXX

XXX

 f The frame of the clip also can be dragged to the left or right.
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1 Alternative
 f Moving the timeline cursor to the top frame of the clip: [Home]
 f Moving the timeline cursor to the last frame of the clip: [End]
 f Moving the timeline cursor to the previous frame: [←]
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 f Moving the timeline cursor to the next frame: [→]
 f Moving key/frame to 1 frame before: [,] (This is enabled when the key setting field or a clip is focused, and the timeline cursor is moved to 
the key or the frame.)

 f Moving key/frame to 1 frame behind: [.] (This is enabled when the key setting field or a clip is focused, and the timeline cursor is moved to 
the key or the frame.)

 f Focusing on the key setting field: [↑]
 f Focusing on the clip: [↓]

5) Click [Playback] or [Loop Playback] to check the video.

00:00:04;00 00:00:05;00 00:00:06;00 00:00

XXX

 f The video is displayed on the Recorder.

2
 f When you right-click the [Time Remap] dialog box and click [Information] to uncheck, the thumbnail displayed at the top and end of the 
clip, and the timecode can be set to hidden.

 f When you right-click the [Time Remap] dialog box and click [Timeline Time] to uncheck, the top frame of the clip can be changed to 
“00:00:00;00”.

 f When you right-click the [Time Remap] dialog box and click [Original Source Time] to uncheck, the timecode that takes the In point of the 
clip as “00:00:00;00” is displayed.

 f Even clips with no key added are set with one key each at the beginning and end.
 f As the default time remap setting, the speed of set keys onward is changed smoothly. If you want to maintain a fixed playback speed in a 
certain range, set the key to that range, right-click the key on the In point side, and click [Linear]. The key changes shape from diamond-
shaped to square.

00:00:04;00 00:00:04;00

If you right-click a key set with linear change and click [Speed], a dialog box for entering the playback speed appears.

[Time Remap] Dialog Box

(1) Key frame edit buttons  : Add a key at the position of the timeline cursor. If a key is placed at the position of the 
timeline cursor, the key is deleted.
Add: [Insert], [V]
Delete: [Delete]
: Move the timeline cursor to the previous key.

[Page up], [A], [Ctrl] + [←]
: Move the timeline cursor to the next key.

[Page down], [S], [Ctrl] + [→]

 : Play back the clip from the position of the timeline cursor to the end of the clip. When it is 
clicked during playback, playback pauses.

 : Repeatedly play back the clip. When it is clicked during playback, playback pauses.
(2) [Initialize] Click [Initialize] and click [Yes] to delete all added keys and restore the defaults.
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(3) Timecode (Timeline) Directly enter the value to specify which place on the timecode of the timeline the key at the 
timeline cursor position is to be placed. The timecode is displayed when the timeline cursor is 
moved to the key.

(4) Timecode (Clip) Directly enter the value to specify which place on the timecode of the clip the key at the 
timeline cursor position is to be placed.

(5) Key setting field This space is used for setting the key. A green line is displayed at parts where the speed has 
not been changed.

(6) Time difference display 
area

This space displays the values of the time difference that occurs when keys are added as a 
connected line.

(7) Clips Display the line connecting the key and the corresponding frame on a position on the clip.
(8) [Field Option] The [Field Option] dialog box appears.

“[Field Option] Dialog Box” (w page 254)
(9) [Full Range] Display all margin sections of the clip. Checking this item when trimming or a cut operation has 

been performed after setting the time remap can display the keys of the cut section.
(10) [Enable] Switch the enable/disable setting for the time remap setting. Uncheck this item to disable the 

setting.

One Frame at a Time Playback (Freeze Frame)
Stop and play back the In or Out points of the clip. Clips can be stopped for not just the length of the clip but also the first half or second half 
from a desired frame.

3 Note
 f Freeze frame can be set to video clips on the timeline.
 f The freeze frame setting is deleted when a clip set with a freeze frame is added from the timeline to the bin.

2
 f Any desired range of clips can also be frozen by time remap. Add keys to determine the range to freeze, and move to the position to stop 
the 2 key frames on the clip side.
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1) Right-click a clip, and click [Time Effect] → [Freeze Frame] → [Setup].

1 Alternative
 f Click [Clip] on the menu bar, and click [Time Effect] → [Freeze Frame] → [Setup].

2) Check [Enable freeze frame] in the [Freeze Frame] dialog box.

3) Select the fix position, and click [OK].
 f When the In point is selected, the frame of the In point is freeze-framed for the length of the clip, and when the Out point is selected, the 
frame of the Out point is freeze-framed for the length of the clip.

2
 f When a clip set with freeze frame enabled is trimmed, operation changes as follows depending on the fix position.

 g When the In point side of a clip with a fixed In point is trimmed, the displayed frame also moves matched to the trimming. Operation is 
not affected when the Out point side has been trimmed.

 g When the Out point side of a clip with a fixed Out point is trimmed, the displayed frame also moves matched to the trimming. Operation 
is not affected when the In point side has been trimmed.
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Freeze-framing the First Half or Second Half from a Desired Frame

1) Move the timeline cursor to the frame to freeze.

2) Right-click a clip, and click [Time Effect] → [Freeze Frame] → [Before Cursor] or [After Cursor].
 f The selected clip is cut at the timeline cursor position, and freeze frame is set to clips before or after the cursor. When freeze frame 
has been set after a cursor, the fix position becomes the In point, and when freeze frame has been set before a cursor, the fix position 
becomes the Out point.

1 Alternative
 f Click [Clip] on the menu bar, and click [Time Effect] → [Freeze Frame] → [Before Cursor] or [After Cursor].

3 Note
 f Freeze frame cannot be set when the timeline cursor is located at a transition between clips.

Field Options
You can set processing options for reducing flicker, for example, when slow motion has been set.

1) Select a clip.
 f Multiple clips can be selected and set in a single operation.

2) Click [Clip] on the menu bar, and click [Time Effect] → [Field Option].
 f The [Field Option] dialog box appears.
“[Field Option] Dialog Box” (w page 254)

1 Alternative
 f Right-click a clip and click [Time Effect] → [Field Option].

3) Set each item and click [OK].

[Field Option] Dialog Box

XXXXXX
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(1) [Interpolation Method] [Nearest neighbor]
The length of the clip is adjusted by skipping frames or continuously displaying the same frame.
[Frame blending]
Adjacent frames are composed and a new frame is automatically generated to interpolate 
between the frames.
[Optical flow]
The motion in adjacent frames are analyzed by pixels and a new frame is automatically 
generated so that the motion of the subject is played back smoothly.
Click the list button to set the quality of [Optical flow].
Select [Custom] to set [Advanced Matching] and [Accuracy] separately.
 f [Advanced Matching]
Use [Advanced Matching] that analyzes detailed matching between images to recognize 
more detailed characteristics, which will separate the foreground and background sharply.
Enabling [Advanced Matching] may cause specific artifacts. If it happens, uncheck 
[Advanced Matching].
“Optical flow” (w page 255)

 f [Accuracy]
Set the accuracy of analysis.
Accuracy of analysis can be selected from four levels from [Low] to [High]. Higher accuracy 
will take more time for analysis, but decreases smoky artifacts specific to the optical flow.

(2) [Processing Option] Set the processing option to reduce flicker during slow motion. Set [Deinterlace when speed is 
below 100%] when video is affected by the scanning line and flickers when a slower playback 
speed has been set.

(3) [Save as default] Click this item to save the current settings as defaults. When a clip is placed on the timeline, 
the default [Field Option] is always applied.

2
 f If real time playback is not possible after [Optical flow] is applied, using the Draft Preview mode is helpful.
“Draft Preview” (w page 302)

 f GPU acceleration is not supported.

High-Quality Slow Motion
By applying optical flow, an image interpolation technique, the video can be converted into a slow motion video with higher quality and 
smoother motion when the clip playback speed has been decreased due to setting change in [Speed] of [Time Effect].

 r Optical flow
Optical flow is a technique to generate new images to interpolate between images, by analyzing subtle motion between images and 
estimating spatially smooth motion. It enables to realize high-quality slow motion and smooth frame conversion.

3 Note
 f For video like the following, high-quality slow motion effects may not be fully obtained.

 g Video with extremely high speed and long distance movement
 g Video in which subjects cross each other
 g Video that includes a building window, fence, or regular pattern like a horizontal striped T shirt
Enabling [Advanced Matching] for [Optical flow] may cause specific artifacts.

After applying high-quality slow motion, play back the video to check if the subject is mixed with the background or the images are 
distorted.

1) Right-click a clip on the timeline, and click [Time Effect] → [Speed].
 f The [Speed] dialog box appears.
“[Speed] Dialog Box” (w page 250)

2) Set each item.
 f To decrease the playback speed, change [Rate] in [Speed] to lower than 100%.
 f Check [Change the Clip Duration on Timeline] to change the duration of clips on the timeline according to the speed (value of [Rate]) of 
the clip.

3) Click [Field Option].
 f The [Field Option] dialog box appears.
“[Field Option] Dialog Box” (w page 254)
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4) Select [Optical flow] for [Interpolation Method], and click the list button to set the quality.

XXXXXX

2
 f If [Optical flow] has been selected for [Interpolation Method], selecting [None] for [Processing Option] will make the playback smoother.

5) Click [OK].

6) Click [OK].
 f An orange line is displayed on a clip whose speed has been changed.

2
 f [Optical flow] can also be used for progressive/interlace (P/I) conversion or frame rate conversion.
If a progressive source is placed on an interlace timeline with the same frame rate (for example, 29.97p source is placed on the 59.94i 
timeline), the video can be played back smoothly due to P/I conversion in [Optical flow].
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Video Layout

Transforming/Rotating Video
The layouter can be used to divide the screen, and video images can be placed or rotated in each screen, or keys can be set to each screen 
and assigned functions.
You can also use the motion tracking feature to make the image on the other track to follow a moving subject or to adjust the image so that 
the moving subject always appear on the center of the angular field.

2
 f The layout of text objects in title clips also can be set.
“Layout Settings” (w page 401)

 f For projects having a video quantization bitrate of 10-bit, layouts are processed with 10-bit precision retained.

Editing Layouts

1) Click on a video part of a clip, and double-click [Layouter] in the [Information] palette.
 f “Showing/Hiding [Information] Palette” (w page 377)
 f The [Layouter] dialog box appears.
“[Layouter] Dialog Box” (w page 258)

1 Alternative
 f Click [Clip] on the menu bar, and click [Layouter].
 f Right-click the video part of the V/VA clip on the timeline, and click [Layouter].
 f Starting up layouter: [F7]

2
 f You can resize the [Layouter] dialog box by moving the cursor to a corner or an edge of the dialog box and dragging the mouse when the 
cursor shape changes. You can also click [Maximize] to maximize the window size.

 f The display area can be adjusted by moving the cursor to the bottom of the preview or parameter and dragging when the mouse cursor 
changes shape.

 f When the mouse is right-clicked in the crop view or transform preview, the menu appears, and you can select tools or switch tabs.
 f When the preview or anchor is dragged while [Shift] on the keyboard held down in the crop preview or transform preview, it can be moved 
limiting to X or Y axis.

2) Edit the layout.
 f “[Crop] tab” (w page 259)
 f “[Transform] tab” (w page 259)
 f “[Tracking] tab” (w page 260)
 f “[Parameter] tab” (w page 260)

3 Note
 f When the 2D mode has been switched to the 3D mode during editing, editing details are carried over to the 3D mode. When the 3D 
mode has been switched to the 2D mode, the parameter values of items that cannot be edited in the 2D mode are discarded.

3) Click [OK].
 f An orange line is displayed on clips set with the layouter.

2
 f When the layouter has been edited, its settings can be registered to the [Effect] palette as original effects (user preset effects). Effects 
registered like this can be exported and imported to EDIUS on other PCs.
“Registering Effects to [Effect] Palette” (w page 383)
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[Layouter] Dialog Box
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TransformCrop PresetParameter

Layouter

(1)

(17)

(16)

(18) (19)

(2) (4) (8) (9)(6)(5)(3) (13)(10) (11) (12)(7) (14) (15)

(1) [Crop] tab Display the crop preview.
(2) [Transform] tab Display the layout preview.
(3) [Tracking] tab Display the tracking preview.
(4) Mode buttons*1  : Switch to 2D mode. Video can be moved or rotated on two dimensions.

 : Switch to 3D mode. Video can be moved or rotated on three dimensions.
(5) Guide indication*1 Switch the show/hide setting for guides such as centerline and safe area.
(6) Tool buttons : When the [Crop] or [Transform] tab is selected, drag the mouse to move the screen or 

perform handle operations.
When the [Tracking] tab is selected, select or move the path. Dragging the handle can zoom in 
and out or rotate the path.

 : Drag the mouse to expand or contract the screen. From the drag start point, drag to the 
right to expand screens, and drag to the left to contract.

 : Drag the mouse to move the display area.
(7) Drawing buttons*2 : Drag the mouse to draw a rectangle. Drag the mouse with [Shift] on the keyboard held 

down to draw a square.
: Drag the mouse to draw an ellipse. Drag the mouse with [Shift] on the key board held 

down to draw a circle.
(8) [Undo]/[Redo]  : Undo an operation.

[Ctrl] + [Z]

 : Redo the undone operation.
[Ctrl] + [Y]

(9) [Tracking]*2 Select a tracking method and start tracking.
(10) [Centering] Center the display area which was moved by the pan tool.
(11) [Fit] Fit the expanded/contracted display to the display range of the preview screen.
(12) Zoom factor Change the zoom factor by entering a value or selecting a value from the list.
(13) [Parameter] tab Edit crops and transforms.
(14) [Preset] tab Save edited layouts and apply them to other clips.

“Saving Editing Details as Presets” (w page 264)
(15) Switch display  : Switch parameters to % display (% display compatible items only).

 : Switch parameters to pixel display (pixel display compatible items only).
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(16) Preview Display the preview image in accordance with the selected tab.
Selecting a path shows a handle or anchor to modify the path, which enables intuitive editing 
operations.
Right-clicking on the screen displays the menu that is same as the operation buttons on the 
upper part of the [Layouter] dialog box.

(17) Key frame timeline Set the key frame to apply change to crops and transforms. The length of the timeline is the 
duration of the clip currently being edited.
“Setting Key Frames” (w page 266)

(18) [Save as default] Click this item to save the current settings as defaults. When a clip is placed on the timeline, 
the default layout is always applied.

(19) [Reset all] Click this button to return the layouter settings to their defaults. To return the layout to the 
settings before they were changed, apply [Default] in the preset.

*1 Available only when the [Transform] tab is selected.
*2 Available only when the [Tracking] tab is selected.

 r [Crop] tab
Specify the display range by moving the cursor to an operation handle at the four corners or the center of a side and dragging.

 r [Transform] tab
Reflect edited parameter details in the preview. You can also edit parameters by dragging handles inside the preview.

(1)

(2)

(3)
(4)

(5)

(1) Stretch handles Move the cursor to the operation handles at the corners and at the middle of the lines to zoom 
in and out the path.

(2) Guide Display the underscan, overscan, title safe, and horizontal/vertical centerlines. You can switch 
the show/hide setting by clicking [Guide].

(3) Rotation handle Move the cursor and drag the rotation handle to rotate the image.
In the 3D mode, green part rotates around the Y axis, red part rotates around the X axis, and 
blue part rotates around the Z axis. With rotation on the preview screen, the X/Y/Z axes are the 
values for video, and with rotation by direct entry of numerical values to parameters, the X/Y/Z 
axes are the values for the display.

(4) Preview Display the results of editing parameters.
The display position can be changed by dragging the preview.
In the 3D mode, the display position can be moved in three dimensions in each of the X, Y and 
Z axis directions by dragging the arrow.

(5) Anchor Display the reference point of video. This point is a reference point for the rotation center and 
for stretching. Drag with [Ctrl] on the keyboard held down to change the position.
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 r [Tracking] tab
You can edit the shape that specifies the field of the tracking subject.

(2)

(1)

(3)

(1) Stretch handles Move the cursor to the operation handles at the corners and at the middle of the lines to zoom 
in and out the path.

(2) Anchor Indicate the reference point of the path. This point is a reference point for the rotation center 
and for stretching. Drag with [Ctrl] on the keyboard held down to change the position.

(3) Rotation handle Move the cursor and drag the rotation handle to rotate the image.

 r [Parameter] tab
Enter numerical values or edit using the sliders or controls.
You can switch the show/hide setting for the sliders and controls by clicking the expand button on each editing menu.
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Click [Set default parameters] to set the layout where settings in edit menus are saved as defaults.
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Also, the display unit can be switched by clicking when a blue triangle mark is displayed in the respective value input field.
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When the preview screen is edited, the editing details are reflected in parameters.

[Source crop] Specify the crop range. In the % display, enter the crop ratio for each of the top/bottom/left/
right parts with the width and height of the original clip as 100%. In the pixel display, enter the 
number of pixels to clip. This can also be edited by dragging the slider to the left and right.
[Auto adjust anchor]
Check this item to change the anchor position according to the crop amount. When this item is 
unchecked, the anchor does not move even if the crop values are changed.

[Anchor] Set the reference position of the video. Set the anchor position by entering X and Y (in the 3D 
mode, X, Y and Z) with the origin at the center of the source video before it is cropped.
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[Position] Set the layout position of the video after cropping by directly entering a numerical value or by 
moving to the safe area.
X, Y/X, Y, Z
Set where the anchor is to be placed by entering X and Y (in the 3D mode, X, Y and Z) with the 
origin at the center of the frame.
Area selection
Select the area to be fitted to with the fit position buttons from the list.
Fit position buttons
Move the anchor to the upper left, upper edge, upper right, left edge, center, right edge, lower 
left, lower edge, and lower right of the cropped display area, and place video aligned to the 
respective position of the guide selected at area selection.
During editing in the 3D mode, when the Z value has been changed by the position setting, 
video is placed at the position of the guide corresponding to depth.

[Stretch] Set the scale of the video after cropping by entering a numerical value or clicking the fit button.
X, Y
Enter the scale with the size of the video after cropping as 100%.
Stretch fit button
Expand/contract video after cropping to fit the height or width of the screen.
 When  is clicked, video becomes the maximum size in which the entire video image can be 
displayed.
[Preserve frame aspect]
Check this item to expand/contract video with the aspect ratio of the original image maintained.
[Ignore pixel aspect]
Perform pixel mapping at actual size with no relation to the pixel aspect ratio.
[Resampling method]
Select the resampling mode when video is transformed for a clip currently being edited.
“[Resampling method] in the [Parameter] Tab” (w page 261)

[Rotate] Rotate the video after cropping.
The angle can be rotated by entering a numerical value or moving the cursor to a control and 
dragging when the mouse cursor changes shape.

[Perspective] Set perspective by entering a numerical value or dragging the slider to the left and right.
In the 2D mode, [Perspective] is not displayed.

[Stereoscopic] Displayed only in the stereoscopic edit mode.
[Lens separation]
Set the distance between the cameras on the L and R sides. The distance is a relative value 
with the height of the frame as 100%.
[Zero parallax]
Set the distance from the close plane to the plane free from parallax.

[Opacity and color] Enter the opaque ratios for the source and its background, respectively. 0% is transparent and 
100% is opaque.
This can also be edited by dragging the slider to the left and right.
[Color of background]
Set the the background color. Click the color box to open the [Color Select] dialog box.
“[Color Select] Dialog Box” (w page 199)

[Edge] Attach a frame to video after cropping.
[Color]
Check this item to enable the color edge. Enter the edge width in pixels. This can also be 
edited by dragging the slider to the left and right.
Click Color box to specify the edge color.
“[Color Select] Dialog Box” (w page 199)
[Soft]
Check this item to apply blur to the edge. Enter a blur width in pixels. This can also be edited by 
dragging the slider to the left and right.
[Round corner]
Check this item to round the corners of edges.
[Side]
Select from the outside, inside or both sides of edges to apply [Color]/[Soft] to.

[Drop shadow] When [Enable drop shadow] is checked, a drop shadow can be attached to video after 
cropping. Enter numerical values for [Distance] or [Opacity] and [Soften]. This can also be 
edited by dragging the slider to the left and right.
The drop shadow direction can be set by entering an angle at [Angle] or moving the cursor to a 
control and dragging when the mouse cursor changes shape.
Click Color box to specify the drop shadow color.
“[Color Select] Dialog Box” (w page 199)

 r [Resampling method] in the [Parameter] Tab
[Resampling method] can be selected from the following options.

(1) [Current project setting]
(2) [Bilinear (Fast  Smooth)]
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(3) [Area Average (Fast  Sharp)]
(4) [Bicubic]
(5) [Lanczos 2 (Best for interlaced picture)]
(6) [Lanczos 3 (Hi-Quality)]
(7) [Lanczos 3 Smoother (Best for motion graphics)]
(8) [Lanczos 3 Sharper (Best for progressive picture)]

See the following table for the resampling methods of (2) to (8). The number of . indicates the processing ability to process the 
corresponding events.
 f For zooming in

Defocus Alias Overshoot Calculation speed
(2) .. .. ..... .....

(3) ..... . ..... .....

(4) .... ... .. ...

(5) .... .... .... ...

(6) .... ..... ... ...

(7) .... ..... ... ...

(8) .... ..... ... ...

 f For zooming out

Defocus Alias Overshoot Calculation speed
(2) .. .... ..... ....

(3) ... .. ..... ....

(4) .... ... ... ...

(5) ... ... .... ...

(6) .... .... ... ..

(7) ... ..... ... ..

(8) ..... ... ... ..

Motion Tracking ([Layouter])
You can use two types of motion tracking using [Layouter].
Use [Anchor Mode (this layer)] to adjust the image so that the moving subject always appears on the center of the screen.
Use [Chase Mode (lower layer)] to make the image on the other track to follow a moving subject.

1) Place clips on tracks accordingly depending on the type of motion tracking.
 f When you use [Anchor Mode (this layer)], place a clip which contains the subject on one track.
 f When you use [Chase Mode (lower layer)], two tracks are used.
Place a clip which contains the subject on a lower track, and place a still image on an upper track to make it to follow the movement of the 
subject, as well as other clips such as title.

2) Click on a video part of a clip, and double-click [Layouter] in the [Information] palette.
 f When you use [Chase Mode (lower layer)], double-click [Layouter] of the clip placed on the upper track.

2/2 1

XXXXXX

Information

Layouter

 f The [Layouter] dialog box appears.
“[Layouter] Dialog Box (Motion Tracking)” (w page 264)
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3) Click the [Tracking] tab.

TrackingTransformCrop

Layouter

 f A shape appears in the center of the preview image.

4) Click the tacking mode selection button to select a tracking mode.

XXXXXTrackingTransformCrop

Layouter

Chase Mode (lower layer)
Anchor Mode (this layer)

 f Select either [Anchor Mode (this layer)] or [Chase Mode (lower layer)] for the tracking mode.
[Anchor Mode (this layer)] sets the subject on the selected clip as the tracking subject. Make adjustments so that the tracking subject 
always appears on the center of the screen.
[Chase Mode (lower layer)] sets the subject on the clip placed on the lower track as the tracking subject. Make adjustments so that the 
image on the upper track follows the subject to be tracked.

 f When an analysis result already exists, a message appears to make you to select whether to switch the tracking mode.

1 Alternative
 f Right-click on the preview image, and click [Tracking Mode] → [Anchor Mode (this layer)]/[Chase Mode (lower layer)].

5) Move the timeline cursor to the top frame.

6) Adjust the size and position of the shape to suit the tracking subject.
 f Click a drawing button to create a new shape. When a new shape is created, the existing shape will be deleted.

7) Click [Track Forward] in [Tracking].

XXXXX

XXXXX

XXX

Tracking
Layouter

 f Tracking in the forward direction starts and a key frame will be set frame by frame. A progress bar is displayed to indicate the progress of 
the analysis.

 f The anchor path will be displayed in the preview image of the [Tracking] tab.
 f Tracking will end automatically at the last frame of the clip.
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Reset allSave as default

Tracking
Layouter

8) Play back the timeline to view the video.
 f Click on the [Transform] tab, and adjust the position and size as necessary.

9) Click [OK].
 f The [Layouter] dialog box will be closed.

2
 f Set key frames can be adjusted frame by frame.
 f The unit of time scale display on the [Layouter] dialog box can be adjusted in the time scale settings or by the time scale slider.
 f For the interpolation method, only [Hold] is available.
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 f The position and size of the shape will not be saved. They will be maintained only while the [Layouter] dialog box is displayed.
 f If tracking has stopped in the middle, set the key frame manually in the same way as motion tracking for [Mask].
“If Automatic Tracking Has Been Disrupted” (w page 363)

[Layouter] Dialog Box (Motion Tracking)
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TransformCrop PresetParameter

Layouter

(2)(1)

(5) (6) (7)(4)(3)

(1) Tracking mode 
selection button

Select a tracking mode.

(2) [Tracking] Select a tracking method and start tracking.
(3) [Track Reverse] Tracks in the reverse direction from the timeline cursor position and sets key frames.

Tracking will end automatically at the top frame of the clip.
[Ctrl] + [,]

(4) [Track Previous Frame] Tracks one frame in the reverse direction from the timeline cursor position and sets key frame.
[,]

(5) [Tracking Option] This setting is only used for analysis.
[Position]
Tracks the position of the object. The default value is ON.
[Scale]
Tracks the size of the object. The default value is ON.
[Rotation]
Tracks the rotation of the object. The default value is ON.
[Distortion]
Tracks the distortion of the object (aspect ratio and shear). The default value is ON.

(6) [Track Next Frame] Tracks one frame in the forward direction from the timeline cursor position and sets key frame.
[.]

(7) [Track Forward] Tracks in the forward direction from the timeline cursor position and sets key frames.
Tracking will end automatically at the last frame of the clip.
[Ctrl] + [.]

Saving Editing Details as Presets

1) Select a clip, start up layouter, and edit the layout.

2) Click the [Preset] tab.
 f “[Preset] Tab” (w page 265)

3) Click [New], and click [Yes].
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4) Enter a preset name and comment, and click [OK].

2
 f When the layouter has been edited, its settings can be registered to the [Effect] palette as original effects (user preset effects). Effects 
registered like this can be exported and imported to EDIUS on other PCs.
“Registering Effects to [Effect] Palette” (w page 383)

 f When a preset is selected in the preset list, and [Save] is clicked, select whether to overwrite save comment edits or editing details or 
save them as a new preset. To overwrite save, click [OK] without renaming the preset, and click [Yes].

[Preset] Tab

(1) [New] Save the current editing details as a new preset.
(2) [Save] Save the current editing details.
(3) [Delete] Delete the currently selected preset.
(4) [Apply] Select and apply the preset.
(5) Preset list Displays currently saved presets in a list.
(6) Comment Display the comment of the currently selected preset.

Editing Layout with Preset Applied

1) Select a clip, and start up layouter.

2) Click the [Preset] tab.
 f “[Preset] Tab” (w page 265)

3) Select a preset, and click [Apply].

1 Alternative
 f In the preset list, double-click the preset to apply.

4) Click [OK].
 f An orange line is displayed on clips set with the layouter.
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Changing Layouts along the Time Axis

Setting Key Frames
When a key frame is set, you can change the layout along the timeline.

1) Select a clip, and start up layouter.
 f Set the key frame on the timeline in layouter.

XX XXXXXXXXXXXXXXX XXXXXX
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(1) (2) (3) (4)

(5)

(6)

(8) (9)

(7)

(1) Time scale settings Click this to toggle the specified display unit and [Fit].
Click the left arrow to reduce the display unit, or click the right arrow to increase the display 
unit.

(2) Time scale slider Drag the slider to the left and right to adjust the time scale display unit. Move the slider to the 
left to reduce the display unit, or to the right to increase it. The right end is [Fit].

(3) Playback/Tool buttons  : Play back the timeline on the Recorder.

 : Repeatedly play back the clip currently being edited.

 : Undo an operation.
[Ctrl] + [Z]

 : Redo the undone operation.
[Ctrl] + [Y]

 : Switch the changes of each parameter to the chart view. In the chart view, the timeline is 
represented by a chart display of the selected key. The parameters can be edited by moving 
the keys up and down.
The numerical values and gradations of the Y axis can be changed by entering numerical 
values.
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(4) Time scale for key 
frame

Display a scale with the unit selected in the time scale setting on the timeline.
Right-click the time scale and click [Timeline Timecode] to display the timecode of the timeline 
or click [Zero base Timecode] to display the timecode with the beginning of the clip as 0.
If a sequence marker is set for the position where the clip is placed, right-click the time scale 
and click [Go to Previous Sequence Marker] or [Go To Next Sequence marker] to move the 
timeline cursor to the previous or next sequence marker.

(5) Enable/Disable Unchecking the item disables the parameter settings. To set a key frame, check [Layouter].
(6) Expand button Click this button to configure detailed settings for each item.

The layout can be edited by entering a numerical value or moving the mouse to a control and 
dragging when the mouse cursor changes shape.

(7) [Add Default Key] Click this item to set the key frame of the items for each parameter in the layout (in an 
unchanged state) set as the [Default] in the preset at the timeline cursor position.
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(8) Key frame setting Click  in the center to set a key frame on the position of the timeline cursor. When the 
timeline cursor is located over the key frame, the key frame will be deleted.
Click the left and right arrow to move to the previous and next key frame.

(9) Key frame timeline When a layout is edited at the timeline cursor position, a key frame is automatically added.
Also, when parameter items are expanded, parameters can be edited by dragging the key 
frame up or down.

2) Check [Layouter] items.
 f Key frame settings are enabled.

3) On the timeline for the key frame, move the timeline cursor to the position to which the initial key 
frame is set.

4) Edit the layout.
 f A key frame is automatically added. If it is not added, click [Add Key / Delete] in the key frame settings.

XXXXX
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XXXXX

5) Move the timeline cursor to the position to add the next key frame, and edit the layout.
 f A key frame is automatically added. Repeat step 5) if necessary.

2
 f Key frames can be set without moving the timeline cursor by right-clicking the position to set the key to and clicking [Add].
 f When the timeline is right-clicked and [Default] is clicked, the key frame is set to the right-clicked position on the layout currently set to 
[Default] in the preset (i.e. without any changes made to the layout).

 f To delete a key frame, right-click the key frame and click [Delete].
 f When the item name of a parameter is right-clicked and [Clear parameter of (item)] is clicked, all key frames for that item are deleted.
 f Parameter items can be expanded, and copy, paste and other edit operations can be performed by right-clicking on the key frame.
 f Parameter items can be expanded, and the method of interpolation can be changed by right-clicking the key frame. Select from [Hold] 
(fix layout up to next key frame), [Line] (change intuitively) and [Bezier] (change smoothly). The key changes shape when the interpolation 
method is changed.

 f Parameter items can be expanded, and the parameters of the key frame can be edited by setting to chart display The interpolation curve 
can also be edited by dragging handles when the interpolation method is [Bezier].

 f All set keys can be selected by right-clicking the timeline and clicking [Select All].
 f Key frames can be added to the position of the timeline cursor by double-clicking the preview.
 f When [Shift] + [V] on the keyboard are pressed, a key frame is added to all parameters with a valid key frame setting at the timeline 
cursor position.

 f When [V] on the keyboard is pressed, a key frame is added to the currently selected parameter at the timeline cursor position.

6) Click [OK].
 f An orange line is displayed on clips set with the layouter.
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Trimming Clips
Trimming function allows fine adjustments of In and Out points of a clip placed on the timeline while viewing the video on a window. You can 
also move the boundary between clips and In and Out points of video/audio separately.
Trimming operation is performed by cut points. Clicking on a point near the In or Out point of a clip shows yellow and green lines. The yellow 
line appears at the currently selected point, and the green line appears on a point to be changed by the trimming operation.
There are three major methods of trimming. Dragging a cut point in the standard mode, switching to the trim mode and operating on the 
dedicated window that appears, and using shortcut keys.

About the Trim Mode
You can switch to the trim mode to perform editing to fine-adjust video in 1 frame units or 10 frame units by button operation. Trimming is 
also possible in the standard mode by dragging the mouse.

Switching to the Trim Mode

1) Click [Mode] on the menu bar, and click [Trimming Mode].
 f The preview window switches from the standard mode to the trim mode.

Dur 00:00:09;17
Dur 00:00:09;17

Out 00:00:09;17
Out 00:06:09;00

00:00:00;00
00:00:00;00

00:00:00;00
00:00:00;00

In 00:00:09;17
In 00:00:00;24

Dur 00:00:05;20
Dur 00:00:05;20

-10-10 -1-1 +1+1 +10+10

 f The current trimming type is displayed on the status bar of the timeline window.

1 Alternative
 f Switching to the trim mode: [F6]

2
 f The trim mode can be switched to the standard mode by the following operation.

 g Click [Mode] on the menu bar, and click [Normal Mode].
 g Click [Switch to Normal Mode] on the lower right of the trim mode screen.
 g Press [F6] on the keyboard again.
 g Switching to standard mode: [F5]
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About the Trim Window
Buttons exclusively for trimming and the preview are displayed in this window. When the trim mode button is clicked, the cut point 
corresponding to the trim mode is automatically selected. Trimming can also be performed more accurately by entering numerical values to 
the timecode for trimming.

Cur 00:00:00;00 00:00:00;00Dur 00:00:09;17
Dur 00:00:09;17

Out 00:00:09;17
Out 00:06:09;00

00:00:00;00
00:00:00;00

00:00:00;00
00:00:00;00

In 00:00:09;17
In 00:00:00;24

Dur 00:00:05;20
Dur 00:00:05;20

-10-10 -1-1 +1+1 +10+10

(3) (4) (5) (6) (7) (8) (9) (10) (11) (12) (13)(14) (15) (16) (17) (18) (19)

(1)

(2)

(1) Preview window Switch the display to 1/2/4 screens depending on the trimming operation.
(2) Timecode Display the timecode of the In or Out point of the clip to edit. You can also change the trimming 

position by directly entering a numerical value.
(3) [Previous Frame] Move to the previous frame.

[←]
(4) [Play] Play the timeline in the forward direction. When this button is clicked during playback, playback 

pauses.
[Enter]

(5) [Next Frame] Move to the next frame.
[→]

(6) [Move to Previous Edit 
Point (Trim)]

Move the focus of the cut point and timeline cursor to the edit point (cut point) on the left of the 
current cut point position.
[Page up]

(7) [Trim (-10 frames)]  Adjust the trimming position in -10-frame units.
[Shift] + [,]

(8) [Trim (-1 frame)]  Adjust the trimming position in -1-frame units.
[,]

(9) [Play the Event Area] Repeatedly play back the area around the focused cut point. Click it again to stop.
[/]

(10) [Trim (1 frame)] Adjust the trimming position in +1-frame units.
[.]

(11) [Trim (10 frames)] Adjust the trimming position in +10-frame units.
[Shift] + [.]

(12) [Move to Next Edit Point 
(Trim)]

Move the focus of the cut point and timeline cursor to the edit point (cut point) on the right of the 
current cut point position.
[Page down]

(13) [Trim Mode (In Point)] Switch to the trim mode (In point). Only the In point can be selected.
(14) [Trim Mode (Out Point)] Switch to the trim mode (Out point). Only the Out point can be selected.
(15) [Trim Mode (Slide)] Switch to the trim mode (slide). Only the cut point of the slide trim can be selected.
(16) [Trim Mode (Slip)] Switch to the trim mode (slip). Only the cut point of the slip trim can be selected.
(17) [Trim Mode (Roll)] Switch to the trim mode (rolling). Only the cut point of the rolling trim can be selected.
(18) [Trim Mode (Transition)] Switch to the trim mode (transition). Only the transition (clip transition, track transition)/audio 

cross fades can be selected.
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(19) [Switch to Normal 
Mode]

Switch the trim mode to the standard mode.
[F5]

* Sometimes there are no cut points that can be moved to on the selected tracks, or the cut point is sometimes disabled depending on the operation 
button.

“Entry of Values” (w page 43)

Trimming Type
The following explains the features of each trimming type. For details on methods of operation, see the respective page.
“Trimming on the Timeline” (w page 274)
“Trimming on the Preview Window” (w page 275)
“Trimming by Entering the Timecode” (w page 276)
“Trimming by Shortcut Keys” (w page 277)

In point trim/Out point trim
Change the In and Out points of clips placed on the timeline.
The edit result is dependent on the edit mode.
“Switching the Editing Mode” (w page 225)

Example:

When the Out point side of the clip has been trimmed by a shortcut key (rippled mode off)
00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

In the Overwrite Mode

If you extend a clip, the subsequent clips shorten. If you extend the clip longer than the subsequent clips, all subsequent clips will be 
overwritten.

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXX

XXXX

2
 f Even if the ripple mode is off or the overwrite mode is set, neighboring clips can be fixed to prevent subsequent clips from being 
overwritten by mistake during trimming.
“[Timeline]” (w page 115)
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In the Insert Mode

If you extend a clip, the subsequent clips are shifted backward.
00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXX

XXXX

2
 f You can move a clip together with all the subsequent clips.
“Moving a Selected Clip and Subsequent Clips” (w page 240)

 f You can trim the Out point of the clip by the following operation.
 g Select and right-click a clip, and click [Duration]. In the [Duration] dialog box, enter the playback time from the In point.
 g Select the clip and press [Alt] + [U] on the keyboard. In the [Duration] dialog box, enter the playback time from the In point.

Ripple Trim
Change the In and Out points with the positional relationship with other clips maintained. Trimming is performed with the ripple mode on. 
Even if the ripple mode is off, ripple trimming is possible by using combinations of shortcut keys and keyboard operation.
“Ripple Mode” (w page 226)

Example:

When trimming the Out point side of the clip
00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXX

XXXX

Split Trim
You can trim only the video section or audio section of video clips with audio.

2
 f When the ripple mode is on, you cannot perform trimming if there is no gap between the trimming clip and the subsequent clip. Also, 
trimming can be performed by the length of the gap if the gap is shorter than the trimming clip.
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Example:

When trimming the Out point side of a video clip with audio (video part)
00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXX

XXXX

Slide Trim
Shift the start and end points of the neighboring clips forward and backward. The total length of the previous and subsequent clips remains 
unchanged.

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXX

XXXX

2
 f You cannot perform trimming if there is no margin between the trimming clip and the adjacent clips. When trimming clips with margins, 
trimming can be performed by the length of the margin of the clip.

Slip Trim
You can change the area of the clip to use, without changing the length or position of the clip. The length or position of the neighboring clips 
remain unchanged.

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX
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2
 f You cannot perform trimming if the trimming clip has no margin. When trimming clips with margins, trimming can be performed by the 
length of the margin of the clip.

Rolling Trim
Shift the start and end points of the previous and subsequent clips without changing the length of specific clips.

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

XXXX

Adjust the range to be used while checking the video displayed on the preview window.

2
 f You cannot perform trimming if the neighboring clip has no margin. When trimming clips with margins, trimming can be performed by the 
length of the margin of the clip.

Trimming Transitions/Audio Cross Fades
You can trim the length of transitions (clip transitions, track transitions)/audio cross fades in the same way as clips.

Example:

When trimming the Out point of a clip transition:
00:00:03;00 00:00:06;00 00:00:09;00

00:00:03;00 00:00:06;00 00:00:09;00

XXXX

XXXX

XXXX

XXXX

Example:

Track transition
00:00:03;00 00:00:06;00 00:00:09;00

XXXX

XXXX

XXXX

XXXX

-00:00:00;28
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Both edges of a transition/audio cross fades can also be trimmed at the same time.
00:00:06;00 00:00:09;00

XXXX

XXXX

2
 f You can change the length of the title mixer by dragging in the same way as for the clips.
 f You can extend the clip transition/audio cross fades by the margin of the clip.
 f You can change the default duration value.
“Changing Duration of Effect” (w page 366)

Trimming Operation Methods

Trimming on the Timeline
You can perform trimming while still in the standard mode by selecting and dragging a cut point. The edit result of trimming is dependent on 
the edit mode.
“Switching the Editing Mode” (w page 225)
The trimming type changes according to how the In and Out points are selected and keyboard combinations.
For details on respective trimming methods, see the respective page.
“In point trim/Out point trim” (w page 270)
“Ripple Trim” (w page 271)
“Split Trim” (w page 271)
“Slide Trim” (w page 272)
“Slip Trim” (w page 272)
“Rolling Trim” (w page 273)

1) Select the cut point of the trimming clip.
 f The cut point for each trimming type is selected as follows:

In point trim Click the In point of the clip.
Out point trim Click the Out point of the clip.
Ripple trim Click [Shift] + In point or Out point.
Ripple trim (split) Click [Alt] + [Shift] + In point or Out point.
Slide trim Click [Ctrl] + [Shift] + In point or Out point.
Slide trim (split) Click [Ctrl] + [Alt] + [Shift] + In point or Out point.
Split trim Click [Alt] + In point or Out point.
Slip trim Click [Ctrl] + [Alt] + center of the clip.
Rolling trim Click [Ctrl] + [Shift] + center of the clip.
Transition trim Click the In or Out point of transition (clip transition, track transition)/audio cross fades.
Transition trim (both edges) Click [Shift] + clip transition/audio cross fade.

2
 f Ripple trimming is also possible with the ripple mode off.

2) Move the mouse cursor to the cut point or clip, and drag to the left and right when the mouse cursor 
changes shape.

 f Adjust the range to be used while checking the video displayed on the preview window.
 f The mouse cursor changes shape according to the trim mode.

In point trim/Out point trim
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Ripple trim

Ripple trim (split)

Slide trim

XXXX XXXX

XXXX

X

Slide trim (split)

XXXX XXXX

XXXX

Split trim

Slip trim

XXXX XXXX

XXXX

X

Rolling trim

XXXX XXXX

XXXX

X

Transition trim

XXXX

XXXXTransition trim (both edges)

Trimming on the Preview Window
You can perform trimming by dragging the mouse on the preview window in the trim mode.

3 Note
 f The trim mode (transition) is not available in the preview window.

1) Click [Mode] on the menu bar, and click [Trimming Mode].
 f The preview window switches from the standard mode to the trim mode.

2) Select the trimming clip.

3) Click the respective button at [Trimming Mode] in the trim window, and select the cut point.

-10-10 -1-1 +1+1 +10+10

 f The cut point changes color to green or yellow, and trimming is enabled.
“In point trim/Out point trim” (w page 270)
“Ripple Trim” (w page 271)
“Split Trim” (w page 271)
“Slide Trim” (w page 272)
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“Slip Trim” (w page 272)
“Rolling Trim” (w page 273)

4) Move the mouse cursor to the preview window, and drag to the left and right when the cursor 
changes shape.

 f Adjust the range to be used while checking the video displayed on the preview window.
 f The mouse cursor changes shape according to the trim mode.
In point trim: 
Out point trim: 
Slide trim: 
Slip trim: 
Rolling trim: 

Trimming by Entering the Timecode
In the trim mode, the sequence timecode and the source timecode are displayed in the preview window, and you can execute trimming by 
entering numerical values.

1) Click [Mode] on the menu bar, and click [Trimming Mode].
 f The preview window switches from the standard mode to the trim mode.

2) Select the trimming clip.

3) Click the respective button at [Trimming Mode] in the trim window, and select the cut point.

-10-10 -1-1 +1+1 +10+10

 f The cut point changes color to green or yellow, and trimming is enabled.
“In point trim/Out point trim” (w page 270)
“Ripple Trim” (w page 271)
“Split Trim” (w page 271)
“Slide Trim” (w page 272)
“Slip Trim” (w page 272)
“Rolling Trim” (w page 273)

4) Enter the timecode.
 f Move the mouse cursor to the timecode at the bottom of the trim window, and the mouse cursor changes shape. If you click in this state, a 
blue line is displayed under the timecode and numerical values can be entered.
“Entry of Values” (w page 43)

00:00:00;00
00:00:00;00

In 00:00:12;10 Dur 00:00:08;23
Dur 00:00:08;23

+10+10

In 00:01:40;10

 f “Timecode of Trim Window” (w page 276)

5) Press [Enter] on the keyboard.
 f Adjust the range to be used while checking the video displayed on the preview window.

Timecode of Trim Window

Cur 00:00:27;03 Dur 00:00:04;23
Dur 00:00:04;23

Out 00:00:12;15
Out 00:00:05;06

00:00:00;00
00:00:00;00

--:--:--;--00:00:00;00
00:00:00;00

In 00:00:12;15
In 00:00:00;16

Dur 00:00:01;13
Dur 00:00:01;13

(6) (4) (2) (1) (3) (5) (7)

-10-10 -1-1 +1+1 +10+10

The upper level is the timecode of the sequence, and the lower level is the timecode of the source. Numerical values can be entered in 
either level for trimming.

(1) Number of frames moved from focused cut point
(2) Timecode of the focused cut point (Out point of clip)
(3) Timecode of the focused cut point (In point of clip)
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(4) Length of clip to be trimmed (clip on Out point side)
(5) Length of clip to be trimmed (clip on In point side)
(6) Timecode at timeline cursor
(7) Length of transition/audio cross fades to be trimmed

* The items displayed may differ depending on the size of the preview window.

Example:

Slide trimming

XXXX
XXXX

XXX
XXXX

XXXX
XXXX

XXX
XXXX

(4)

(2) (3)

(1)

(5)

(4) (5)

(2) (3)

Trimming by Shortcut Keys
The In and Out point sides of the timeline cursor can be trimmed by shortcut keys.
You can perform trimming from the In point up the timeline cursor by [N] on the keyboard and from the timeline cursor up to the Out point by 
[M].The trimming type changes according to the keyboard combination.

:00;00
XX

00:00:05;00 00:00:10;00 00:00:15;00

XXX

X

XXXX

XXXX

XXXX

XXXX

N M

1) Select the clip to be trimmed.
 f You can also perform trimming on a selected transition (clip transition, track transition) and audio cross fades. To trim a track transition, 
select the mixer.

2) Move the timeline cursor to the trimming position.

3) Press a key on the keyboard to perform trimming.

In point trim [N]
Out point trim [M]
Ripple trim (In point side) [Alt] + [N]
Ripple trim (Out point side) [Alt] + [M]
Slide trim (In point side) [Ctrl] + [Alt] + [N]
Slide trim (Out point side) [Ctrl] + [Alt] + [M]
Split trim (In point side) [Shift] + [N]
Split trim (Out point side) [Shift] + [M]

2
 f Ripple trimming is also possible with the ripple mode off.
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Example:

When the Out point side of the clip has been trimmed by slide trim ([Ctrl] + [Alt] + [M])

:00;00
XX

00:00:05;00 00:00:10;00 00

XXXX

XXX XXXX

XXXX

XXXX

:00;00
XX

00:00:05;00 00:00:10;00 00

XXXX

XXX

XXXX

XXXX

XXXX

XXXX
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Markers

Setting Marker to Source

Displaying the [Clip Marker] List
Display the [Clip Marker] list in the [Marker] palette.

1) Click [Toggle Palette Display] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

2) Click [Marker].

1 Alternative
 f Click [View] on the menu bar, and click [Palette] → [Marker].
 f The [Effect], [Information], and [Marker] palettes can be shown/hidden together by clicking [View] on the menu bar and then clicking 
[Palette] → [Show All] or [Hide All].

 f Showing/hiding palette: [H]
“Showing/Hiding [Effect] Palette” (w page 336)
“Showing/Hiding [Information] Palette” (w page 377)

2
 f If you switch the show/hide setting for the [Marker] palette, the setting for the bin window, source browser window, and palette tab 
associated to the [Marker] palette is also switched. To switch the show/hide setting individually, release the association of the window and 
the palette.
“Combining Bin Window/Source Browser Window with a Palette” (w page 145)

3) Click [Toggle Sequence Marker/Clip Marker] in the [Marker] palette.
 f Each click switches between the [Clip Marker] list and the [Sequence Marker] list.
“Displaying the [Sequence Marker] List” (w page 285)

XXXX:2
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[Clip Marker] List

(1) [Toggle Sequence 
Marker/Clip Marker]

Switch between the [Clip Marker] list and the [Sequence Marker] list.

(2) [Set Marker] Add the clip marker to the position the slider on the Player.
(3) [Set Marker In/Out] Add the clip marker with range to between In and Out points of the clip currently displayed on 

the Player.
(4) [Go to Previous 

Marker]/[Go to Next 
marker]

Move to the previous/next clip marker.

(5) [Clear Marker] Select and delete a clip marker from the clip marker list.
(6) [Import Marker List] Import a clip marker list.
(7) [Export Marker List] Export the clip marker list as a CSV file.
(8) Clip marker list Display the timecode or comment of the set clip marker.

Click [Color] to change the color of the clip marker.
“Changing Color of Clip Marker” (w page 284)

3 Note
 f The [Clip Marker] list displays the clip marker information of clips currently displayed on the Player when the focus is on the Player and 
the clip marker information of clips currently displayed on the timeline when the focus is on the Recorder.

Setting Clip Markers at Capture
You can set markers to source clips while sources are being captured.
 f The color of the clip marker that can be set at the time of capturing is orange. Clip markers in other colors cannot be set.

1) Start the source capture.
 f “Capturing and Importing Sources” (w page 162)
 f “Importing Sources All Together (Batch Capture)” (w page 166)

2) At the scene to which the clip marker is to be set, click [Add Marker] in the [Capture] dialog box.
 f The list of set markers is displayed. Enter a comment, if necessary.

2
 f Multiple clip markers can be added by shortcut keys by the following operation. At the scene to add the clip marker to, press [V] on the 
keyboard, and enter the comment as required. To continue to add clip markers in scenes, press [Ctrl] + [M] on the keyboard, and enter the 
comment as required.
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Setting Clip Markers
You can set clip markers to source clips registered to the bin and to the source currently displayed on the Player.
 f The default color of clip marker is orange. The color of clip markers can be changed on the [Clip Marker] list.
“Changing Color of Clip Marker” (w page 284)

1) Display the source on the Player.
 f “Displaying Clips on the Player” (w page 189)

2) Move the slider on the Player to the clip marker setting position.
 f “Playing Back with Shuttle/Slider” (w page 188)

3) Click [Set Marker] in the [Clip Marker] list.
 f “[Clip Marker] List” (w page 280)
 f The clip marker is displayed for slider on the Player, and the timecode of the clip marker is displayed in the [Clip Marker] list.

XXXX:

XXX XXX XXX XXX XXXXXX XXXXXX

001 00:00:00;00

1 Alternative
 f Click [Marker] on the menu bar, and click [Add Marker].
 f Right-click the clip marker list, and click [Set Mark].
 f Right-click the slider on the Player, and click [Set clip marker/Clear clip marker (Toggle)].
 f Setting clip markers: [V]

2
 f You can move marker positions by the following operation.

 g Click the timecode at [In] in the [Clip Marker] list, and enter the desired numerical value.
 g Drag the clip marker on the position bar on the Player with [Ctrl] on the keyboard held down.

 f You can enter comments at the same time you are setting clip markers.
Click [Marker] on the menu bar, and click [Edit Marker] to enter the comment.
“Entering Comments to Clip Markers” (w page 283)

3 Note
 f When the focus is on the Recorder, clip markers cannot be set.
 f Additions, deletions and edits made to clip markers are automatically reflected on clips in the bin. To leave behind the information of a 
clip before it is edited, register that clip to the bin as a different clip in advance.
“Registering between In and Out Points to the Bin As a Separate Clip (Subclip)” (w page 193)
When you add, delete, and edit the clip marker with a clip on the timeline displayed on the Player, register it to the bin as another clip, if 
necessary.
“Registering Clips on the Player to the Bin” (w page 192)

 f Clip markers cannot be set in the [Sequence Marker] list.

Setting Clip Markers with Range
You can set clip markers with range to source clips registered to the bin and to the source currently displayed on the Player.
 f The default color of clip marker is orange. The color of clip markers can be changed on the [Clip Marker] list.
“Changing Color of Clip Marker” (w page 284)

1) Display the source on the Player.
 f “Displaying Clips on the Player” (w page 189)
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2) Set the In and Out points to source clips.
 f “Setting the In and Out Points” (w page 189)

3) Click [Set Marker In/Out] in the [Clip Marker] list.
 f “[Clip Marker] List” (w page 280)
 f The clip marker with range is set to the slider on the Player, and the timecode and duration of the In and Out points of the clip marker are 
displayed on the [Clip Marker] list.

XXXX:

XXX XXX XXX XXXXXX XXXXXX

001 00:06:02;11 00:06:04;15 00:00:02;04

XXX

1 Alternative
 f Right-click the clip marker list, and click [Set Mark In/Out].
 f Right-click the slider on the Player, and click [Set clip marker In/Out].
 f Click [Marker] on the menu bar, and click [Add Marker to In/Out Point].

2
 f In step 1), the clip marker with range is set with the start of the clip as the In point when the In point has not been set and with the end of 
the clip as the Out point when the Out point has not been set.

 f You can change the range of the clip marker by clicking [In], [Out] in the [Clip Marker] list or the timecode in [Duration] and entering the 
numerical value.
“Entry of Values” (w page 43)

 f You can move the marker position by dragging the clip marker with range on the position bar on the Player with [Ctrl] on the keyboard held 
down.

 f Only the clip marker of the In point is displayed as the clip marker with range when that clip marker is not focused.

3 Note
 f Clip markers with range cannot be set when the position of the In points of video and audio differ or when the position of the Out points 
of video and audio differ.

 f When the focus is on the Recorder, clip markers cannot be set.
 f Additions, deletions and edits made to clip markers are automatically reflected on clips in the bin. To leave behind the information of a 
clip before it is edited, register that clip to the bin as a different clip in advance.
“Registering between In and Out Points to the Bin As a Separate Clip (Subclip)” (w page 193)
When you add, delete, and edit the clip marker with a clip on the timeline displayed on the Player, register it to the bin as another clip, if 
necessary.
“Registering Clips on the Player to the Bin” (w page 192)

 f Clip markers cannot be set in the [Sequence Marker] list.

Deleting Clip Markers
You can delete set clip markers.

1) Display a clip set with a clip marker on the Player.
 f “Displaying Clips on the Player” (w page 189)

2) Select the clip marker to delete from a clip marker list in the [Clip Marker] list.

3) Click [Clear Marker] in the [Clip Marker] list.
 f “[Clip Marker] List” (w page 280)

1 Alternative
 f Drag the clip marker to delete from the clip marker list, and drop it outside the [Clip Marker] list.
 f Right-click on a clip marker to delete from the clip marker list, and click [Clear Marker].
 f Right-click on the clip marker on the position bar on the Player, and click [Clear clip marker].
 f Move the slider on the Player to the clip marker to delete, right-click the slider, and click [Set clip marker/Clear clip marker (Toggle)].
 f Move the slider on the Player to the clip marker to delete, click [Marker] on the menu bar, and click [Clear Mark] → [Cursor].
 f Click [Delete] in the [Edit Marker] dialog box for the clip marker.
“Entering Comments to Clip Markers” (w page 283)
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2
 f You can also delete all clip markers in the clip marker list in a single operation by the following operation.

 g Click [Marker] on the menu bar, and click [Clear Mark] → [All].
 g Deleting all markers: [Shift] + [Alt] + [V]

3 Note
 f When the focus is on the Recorder, clip markers cannot be deleted.

Showing/Hiding Clip Markers
You can switch the show/hide setting for set clip markers for both the display on the Player and the display on the timeline.

1) Click [Marker] on the menu bar, and click [Show Clip Markers] → [Player] or [Timeline].
 f When this item is checked, the clip marker or comment is displayed. This is no longer displayed when this item is unchecked.

Also, the clip marker is displayed on clips on the timeline when [Timeline] is clicked to check it. This is no longer displayed when this item 
is unchecked.

XXXX
XXXX

XXXX
XXXX

2
 f Only comments for clip markers can also be hidden. Click [View] on the menu bar, and uncheck [Marker] in [Overlay].
“Showing/Hiding Preview Window” (w page 149)

 f Only the clip marker of the In point is displayed as the clip marker with range when that clip marker is not focused.

Using Markers

Entering Comments to Clip Markers
You can add a comment to clip markers that have been set.

1) Display a clip set with a clip marker on the Player.
 f “Displaying Clips on the Player” (w page 189)

2) Right-click on the clip marker on the position bar, and click [Edit Clip Marker].
 f When multiple clip markers are set on the same position on the position bar, [Edit Clip Marker] is not available.

3) In the [Edit Marker] dialog box, enter a comment and click [OK].
 f Entered comments are displayed on the Player when the slider is moved to the clip marker. When a clip marker with range has been set, 
the comment is displayed while the slider on the Player is in the In and Out point range of the clip marker.
Comments are displayed on the Player also during playback. However, comments displayed during playback are only those of clip 
markers with range.

1 Alternative
 f Click the [Comments] field in the [Clip Marker] list.
 f Right-click the clip marker list, and click [Edit Marker].
 f Move the slider on the Player to the clip marker, click [Marker] on the menu bar, and click [Edit Marker]. Note that if multiple clip markers 
are set on the same position on the position bar, [Edit Marker] is not available.

 f Comment carriage return: [Ctrl] + [Enter]
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2
 f You can also edit entered comments by the same operation.
 f Additions, deletions and edits made to clip markers are automatically reflected on clips in the bin. To leave behind the information of a clip 
before it is edited, register that clip to the bin as a different clip in advance.
“Registering between In and Out Points to the Bin As a Separate Clip (Subclip)” (w page 193)
When you add, delete, and edit the clip marker with a clip on the timeline displayed on the Player, register it to the bin as another clip, if 
necessary.
“Registering Clips on the Player to the Bin” (w page 192)

 f When a clip set with a clip marker has been placed on the timeline, the comment is displayed on the Recorder when the timeline cursor is 
moved to the position of the clip marker. When a clip marker with range has been set, the comment is displayed on the Recorder while the 
timeline cursor is between In and Out points of the clip marker.
Comments are displayed on the Player also during playback. However, comments displayed during playback are only those of clip 
markers with range.

3 Note
 f When the focus is on the Recorder, comments cannot be entered to clip markers.

Changing Color of Clip Marker
The set color of clip markers can be changed.

1) Display a clip set with a clip marker on the Player.
 f “Displaying Clips on the Player” (w page 189)

2) On the [Clip Marker] list, click [Color] of a clip marker to change the color and select a desired color.
 f Selecting multiple clip markers can change the color at once.

2
 f The color of the clip marker that can be set are [Orange], [Red], [Yellow], [Blue], [Pink], and [Purple].
 f If you add the setting button of each color of clip marker to the [Clip Marker] list, you can set the clip markers of specific color simply by 
clicking the button.
“Operation Button Settings” (w page 147)

Moving to the Clip Marker Position
You can jump to the position of set clip markers.

1) Click [Go to Previous Marker] or [Go to Next marker] in the [Clip Marker] list.
 f “[Clip Marker] List” (w page 280)
 f The clip marker moves forward or backward.
 f When the focus is on the Player, the slider moves to the position of the clip marker set to that clip.
 f When the focus is on the Recorder, the timeline cursor moves in order to the positions of the clip markers for clips selected on the 
timeline.

1 Alternative
 f In the clip marker list, double-click on the [No.] field of the clip marker on the position to move to.
 f Right-click the clip marker list, and click [Go to Previous Marker] or [Go to Next marker].
 f Moving to previous/next clip marker position: [Ctrl] + [←]/[Ctrl] + [→]

Importing Clip Marker Lists (Import)
You can import clip marker list files in XML or CSV format.

1) Display the clip at the import destination on the Player.
 f “Displaying Clips on the Player” (w page 189)

2) Click [Import Marker List] in the [Clip Marker] list.
 f “[Clip Marker] List” (w page 280)

3) In the [Open] dialog box, select an XML or CSV file, and click [Open].
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1 Alternative
 f Click [Marker] on the menu bar, and click [Import Marker List].
 f Right-click the clip marker list, and click [Import Marker List].

3 Note
 f When the focus is on the Recorder, clip marker lists cannot be imported.
 f The color of all clip markers imported in the CSV format is orange.
 f XML format files cannot be imported to EDIUS version 9.2 and earlier.

Exporting Clip Marker Lists (Export)
You can export a clip marker list in the [Clip Marker] list to an XML or CSV file.

1) Display the clip, from which the clip marker list should be exported, on the Player.
 f “Displaying Clips on the Player” (w page 189)

2) Click [Export Marker List] in the [Clip Marker] list.
 f “[Clip Marker] List” (w page 280)

3) In the [Save As] dialog box, specify a file name and save destination.

4) Select the output format, and click [Save].

1 Alternative
 f Click [Marker] on the menu bar, and click [Export Marker List].
 f Right-click the clip marker list, and click [Export Marker List].

2
 f If the exported file is to be used on version 9.2 or earlier, save it in “Ver.2” or “Ver.3”.
 f If it is to be used on version 9.3 or later, save it in “Ver.4” that supports exporting information of [Color].

3 Note
 f When the focus is on the Recorder, clip marker lists cannot be exported.
 f Exporting [Color] information is not supported for CSV format files. All clip markers exported in CSV format will be orange clip markers.

Setting Marker to Timeline

2
 f When exported to DVD/BD, orange sequence markers become chapters and comments become chapter titles. Chapter titles can be 
edited at the time of export.

Displaying the [Sequence Marker] List
Display the [Sequence Marker] list in the [Marker] palette.

1) Click [Toggle Palette Display] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

2) Click [Marker].

1 Alternative
 f Click [View] on the menu bar, and click [Palette] → [Marker].
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 f The [Effect], [Information], and [Marker] palettes can be shown/hidden together by clicking [View] on the menu bar and then clicking 
[Palette] → [Show All] or [Hide All].

 f Showing/hiding palette: [H]
“Showing/Hiding [Effect] Palette” (w page 336)
“Showing/Hiding [Information] Palette” (w page 377)

2
 f If you switch the show/hide setting for the [Marker] palette, the setting for the bin window, source browser window, and palette tab 
associated to the [Marker] palette is also switched. To switch the show/hide setting individually, release the association of the window and 
the palette.
“Combining Bin Window/Source Browser Window with a Palette” (w page 145)

3) Click [Toggle Sequence Marker/Clip Marker] in the [Marker] palette.
 f Each click switches between the [Sequence Marker] list and the [Clip Marker] list.
“Displaying the [Clip Marker] List” (w page 279)

XXXX:2

3 Note
 f When the focus is on the Player in the preview window, the list cannot be switched to the [Sequence Marker] list. Switch to this list 
after selecting the Recorder.

[Sequence Marker] List

(1) [Toggle Sequence 
Marker/Clip Marker]

Switch between the [Clip Marker] list and the [Sequence Marker] list.

(2) [Set Marker] Add a sequence marker at the timeline cursor position.
(3) [Set Marker In/Out] Add a sequence marker with range to between In and Out points on the timeline.
(4) [Go to Previous 

Marker]/[Go to Next 
marker]

Move to the previous/next sequence marker.

(5) [Clear Marker] Select and delete a sequence marker from the sequence marker list.
(6) [Import Marker List] Import a sequence marker list.
(7) [Export Marker List] Export the sequence marker list as a CSV file.
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(8) Sequence marker list Display the timecode or comment of the set sequence marker.
Check [Anchor] to cancel linking the sequence marker to the timeline editing even in the sync-
lock mode.
“Sync-Lock Setting of Sequence Marker” (w page 287)
Click [Color] to change the color of the sequence marker.
“Changing Color of Sequence Marker” (w page 290)

Setting Sequence Markers
You can set a sequence marker on the timeline, and jump to the marker position or add a comment.
 f The default color of sequence marker is orange. The color of sequence markers can be changed on the [Sequence Marker] list.
“Changing Color of Sequence Marker” (w page 290)

3 Note
 f When exported to DVD/BD, only orange sequence markers are recognized as chapters. Sequence markers in other colors are not 
recognized as chapters.

1) Move the timeline cursor to the position to set a sequence marker.

2) Click [Set Marker] in the [Sequence Marker] list.
 f “[Sequence Marker] List” (w page 286)
 f The sequence marker is set to the time scale, and the timecode of the sequence marker is displayed in the [Sequence Marker] list.

XXXX:

00:00:04;0002;00 00:00 XXX In Out XXXXXX XXXXXX

001

XXXXXXXXX

00:00:04;15

1 Alternative
 f Right-click the time scale, and click [Set Sequence marker/Clear Sequence marker (Toggle)].
 f Click [Marker] on the menu bar, and click [Add Marker].
 f Right-click the sequence marker list, and click [Set Mark].
 f Setting sequence markers: [V]

2
 f You can move marker positions by the following operation.

 g Click the timecode at [In] in the [Sequence Marker] list, and enter the desired numerical value.
 g Drag the sequence marker on the time scale.

 f You can enter comments at the same time you are setting sequence markers.
Click [Marker] on the menu bar, and click [Edit Marker] to enter the comment.
“Entering Comments to Sequence Markers” (w page 289)

3 Note
 f Sequence markers cannot be set in the [Clip Marker] list.

Sync-Lock Setting of Sequence Marker
When the ripple mode of the timeline is on, sequence markers can be linked to the timeline editing.
“Ripple Mode” (w page 226)

1) Uncheck [Anchor] in the [Sequence Marker] list.
 f Anchor setting is set to off.

XXXX:2

XXX

002

In Out XXXXXX XXXXXX

00:00:14;24

001 00:00:09;08

XXXXXXXXX
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2) Click [Marker] on the menu bar, and click [Sync-Lock Sequence Marker - Toggle].
 f It is set to on. When it is set to on, a check mark appears on the menu item.

2
 f If you add [Sync-Lock Sequence Marker - Toggle] to the mode bar as an operation button, you can switch the sync-lock setting of 
sequence markers simply by clicking the button.
“Operation Button Settings” (w page 147)

Sequence Marker Types
Shapes of sequence markers change to the following depending on the anchor setting, etc.
“Sync-Lock Setting of Sequence Marker” (w page 287)

Type Status
Anchor setting on (orange)

Anchor setting off (orange)

Setting Sequence Markers with Range
You can set a sequence marker with range between In and Out points on the timeline.
 f The default color of sequence marker is orange. The color of sequence markers can be changed on the [Sequence Marker] list.
“Changing Color of Sequence Marker” (w page 290)

3 Note
 f Sequence markers with range become chapters at export to DVD/BD.

1) Setting the In and Out Points to the Timeline
 f “Setting the In and Out Points on the Timeline” (w page 232)

2) Click [Set Marker In/Out] in the [Sequence Marker] list.
 f “[Sequence Marker] List” (w page 286)
 f The sequence marker with range is set to the time scale, and the timecode and duration of the In and Out points of the sequence marker 
are displayed on the [Sequence Marker] list.

00:00:04;0002;00 00:00

XXXX:

XXX In Out XXXXXX XXXXXX

001

XXXXXXXXX

00:00:03;16 00:00:06;00 00:00:02;14

1 Alternative
 f Right-click the sequence marker list, and click [Set Mark In/Out].
 f Click [Marker] on the menu bar, and click [Add Marker to In/Out Point].

2
 f When an In point has not been set in step 1), the start of the timeline is set as the In point of the sequence marker with range. Also, when 
an Out point has not been set, the Out point at the end clip on the timeline is set as the Out point of the sequence marker with range.

 f You can change the range of the sequence marker by clicking [In], [Out] in the [Sequence Marker] list or the timecode at [Duration] and 
entering the numerical value.
“Entry of Values” (w page 43)

 f You can change the duration of sequence markers by dragging the In or Out point of the sequence marker with range on the time scale.
00:00:10;0005;00 00:00

You can also move sequence markers by dragging the line section between In and Out points while holding down [Ctrl] on the keyboard.
00:00:10;0005;00 00:00

 f Only the sequence marker of the In point is displayed as the sequence marker with range when that sequence marker is not focused.
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3 Note
 f Sequence markers cannot be set in the [Clip Marker] list.

Deleting Sequence Markers

1) Select the sequence marker to delete from the sequence marker list at the [Sequence Marker] list.

2) Click [Clear Marker] in the [Sequence Marker] list.
 f “[Sequence Marker] List” (w page 286)

1 Alternative
 f Drag the sequence marker to delete from the sequence marker list, and drop it outside the [Sequence Marker] list.
 f Right-click a marker in the sequence marker list, and click [Clear Marker].
 f Right-click a sequence marker on the time scale, and click [Clear Sequence Marker] → [Current Sequence Marker].
 f Move the timeline cursor to the sequence marker on the time scale, click [Marker] on the menu bar, and click [Clear Mark] → [Cursor].
 f Move the timeline cursor to the sequence marker on the time scale, right-click and click [Set Sequence marker/Clear Sequence marker 
(Toggle)].

 f Click [Delete] in the [Edit Marker] dialog box for the sequence marker.
“Entering Comments to Sequence Markers” (w page 289)

 f Deleting sequence markers: [Delete]

2
 f You can also delete all sequence markers in a single operation by the following operation.

 g Right-click the sequence marker on the time scale, and click [Clear Sequence Marker] → [All].
 g Click [Marker] on the menu bar, and click [Clear Mark] → [All].
 g Deleting all markers: [Shift] + [Alt] + [V]

Using Sequence Markers

Entering Comments to Sequence Markers
You can add a comment to sequence markers that have been set.

2
 f When exporting to DVD/BD, sequence marker comments become chapter titles. Chapter titles can be edited at export to DVD/BD.

1) Right-click a sequence marker on the time scale, and click [Edit Sequence marker].
 f When multiple sequence markers are set on the same position on the time scale, [Edit Sequence marker] is not available.

2) In the [Edit Marker] dialog box, enter a comment and click [OK].
 f Entered comments are displayed on the Recorder when the slider is moved to the sequence marker. When a sequence marker with 
range has been set, the comment is displayed while the timeline cursor of the Recorder is on a position between In and Out points of the 
sequence marker.
Comments are displayed on the Recorder also during playback. However, comments displayed during playback are only those of 
sequence markers with range.

1 Alternative
 f Click the [Comment] field in the [Sequence Marker] list.
 f Right-click the sequence marker list, and click [Edit Marker].
 f Move the timeline cursor to the sequence marker on the time scale, click [Marker] on the menu bar, and click [Edit Marker]. Note that if 
multiple sequence markers are set on the position of the timeline cursor, [Edit Marker] is not available.

 f Comment carriage return: [Ctrl] + [Enter]

2
 f You can also edit entered comments by the same operation.
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Changing Color of Sequence Marker
The set color of sequence markers can be changed.

1) On the [Sequence Marker] list, click [Color] of a sequence marker to change the color and select a 
desired color.

 f Selecting multiple sequence markers can change the color at once.

2
 f The color of the sequence marker that can be set are [Orange], [Red], [Yellow], [Blue], [Pink], and [Purple].
 f If you add the setting button of each color of sequence marker to the [Sequence Marker] list, you can set the sequence markers of 
specific color simply by clicking the button.
“Operation Button Settings” (w page 147)

 f When data is exported using the [F4V] exporter, the [Color] information of markers are not maintained.

Moving to Sequence Marker Positions
You can jump to the position of set sequence markers.

1) Click [Go to Previous Marker] or [Go to Next marker] in the [Sequence Marker] list.
 f “[Sequence Marker] List” (w page 286)
 f The timeline cursor moves to the front and back sequence markers.

1 Alternative
 f In the sequence marker list, double-click on the [No.] field of the sequence marker on the position to move to.
 f Right-click the sequence marker list, and click [Go to Previous Marker] or [Go to Next marker].
 f Right-click the time scale, and click [Go to Previous Sequence Marker] or [Go To Next Sequence marker].The timeline cursor moves to 
the previous or next sequence marker.

 f Click [Marker] on the menu bar, and click [Go to Previous Sequence Marker] or [Go to Next Sequence Marker].
 f Double-click a sequence marker on the time scale.
 f Moving to sequence marker positions: [Shift] + [Page up]/[Shift] + [Page down]

Importing Sequence Marker Lists (Import)
You can import sequence marker list files in XML or CSV format.

1) Click [Import Marker List] in the [Sequence Marker] list.
 f “[Sequence Marker] List” (w page 286)

2) In the [Open] dialog box, select an XML or CSV file, and click [Open].

1 Alternative
 f Click [Marker] on the menu bar, and click [Import Marker List].
 f Right-click the time scale, and click [Import Sequence Marker List].
 f Right-click the sequence marker list, and click [Import Marker List].

3 Note
 f When the focus is on the Player, sequence marker lists cannot be imported.
 f The color of all sequence markers imported in the CSV format is orange.
 f XML format files cannot be imported to EDIUS version 9.2 and earlier.

Exporting Sequence Marker Lists (Export)
You can export sequence marker list in the [Sequence Marker] list to an XML or CSV file.

1) Click [Export Marker List] in the [Sequence Marker] list.
 f “[Sequence Marker] List” (w page 286)

2) In the [Save As] dialog box, specify a file name and save destination.
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3) Select the output format, and click [Save].

1 Alternative
 f Click [Marker] on the menu bar, and click [Export Marker List].
 f Right-click the time scale, and click [Export Sequence marker list].
 f Right-click the sequence marker list, and click [Export Marker List].

2
 f If the exported file is to be used on version 7.3 or earlier, save it in “Ver.2”.
If it is to be used on version 7.4 or later, save it in “Ver.3” that supports exporting information of [Anchor].

 f If it is to be used on version 9.3 or later, save it in “Ver.4” that supports exporting information of [Anchor] and [Color].

3 Note
 f Exporting [Color] information is not supported for CSV format files. All sequence markers exported in CSV format will be orange 
sequence markers.
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Playing Back Timelines

Playing Back Timelines

Playing Back by Scrubbing
You can drag the timeline cursor forwards and backwards and move to the position to confirm on the timeline.

1) Drag the timeline cursor forwards and backwards.
 f The timeline cursor moves, and its frame is displayed on the Recorder.

:00;00
XX

00:00:05;00 00:00:10;00 00:00:15;00

XXXX

XXXX

XXXX

XXXX

2
 f When Recorder-related operations are being performed in the dual mode, a blue line is displayed around the Recorder.
 f When the start frame of the timeline is displayed, a white triangle is displayed in the upper left corner.

Playing Back with Recorder Operation Buttons
You can play back or move clips in individual frame units by using the operation buttons on the Recorder.
“Playback with Player Operation Buttons” (w page 187)
“Operation Button Settings” (w page 147)

1) Click [Play] on the Recorder.
 f Playback starts on the Recorder.

2) Click [Stop] on the Recorder.
 f Playback stops.

1 Alternative
 f Playing back Recorder: [Enter]

Recorder Operation Buttons

(1) (2) (3) (4) (5) (6) (7) (8) (9) (10) (11) (12) (13)

(1) [Set In] Set the In point to any position on the timeline.
[I]
“Setting the In and Out Points on the Timeline” (w page 232)

(2) [Set Out] Set the Out point to any position on the timeline.
[O]
“Setting the In and Out Points on the Timeline” (w page 232)
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(3) [Stop] Stop playing back the timeline.
[K], [Shift] + [↓]

(4) [Review] Rewind the timeline. Each click switches the playback speed in the reverse direction between 4 
times and 12 times.
[J]*1

(5) [Previous Frame] Each click rewinds the timeline one frame at a time in the reverse direction. Keeping this button 
clicked plays back the source at the same speed in the reverse direction.
[←]

(6) [Play] Play the timeline in the forward direction. When this button is clicked during playback, playback 
pauses. Click again to restart playback.
[Enter], [Space]

(7) [Next Frame] Each click advances the timeline one frame at a time in the forward direction. Keeping this 
button clicked plays back the source at the same speed in the forward direction.
[→]

(8) [Fast Forward] Fast forward the timeline. Each click switches the playback speed in the forward direction 
between 4 times and 12 times.
[L]*2

(9) [Loop] Repeat playback between In and Out points of the timeline. If no In point has been set, 
playback is repeated from the beginning of the timeline, and if no Out point has been set, 
playback is repeated until the end of the timeline. The entire timeline can also be played back 
as a loop.
[Ctrl] + [Space]

(10) [Previous Edit Point] Move the timeline cursor to the edit point (e.g. the border of clip, In and Out points of the 
timeline) at the left side of the timeline cursor position.
[A], [Ctrl] + [←]

(11) [Next Edit Point] Move the timeline cursor to the edit point at the right side of the timeline cursor position.
[S], [Ctrl] + [→]

(12) [Play the Current Area] Play back the area before and after the timeline cursor.
(13) [Export] Display output (import) related menus.

*1 Each press of [J] on the keyboard switches the rewind speed in 6 levels between 2 to 32 times. Press [L] to slow down the rewind speed. Press 
this key with the source paused to play back at the same speed in the reverse direction.

*2 Each press of [L] on the keyboard switches the fast-forward speed in 6 levels between 2 to 32 times. Press [J] to slow down the fast-forward 
speed. Press it while pausing to play back at the same speed in the forward direction.

2
 f When playback processing is slow, try the following operations.

 g Use the draft preview.
“Draft Preview” (w page 302)

 g Click [Play] with [Shift] on the keyboard held down. (Playback is performed after the data is temporarily stored in the playback buffer. 
The playback buffer can be changed by [Application] in [System Settings] → [Playback].)
“[Playback]” (w page 101)

 g Render clips or a part of the timeline.
“Rendering only Overload/Load Areas” (w page 299)
“Rendering Clips/Transitions” (w page 301)

 f To move the timeline cursor to the start and end of the timeline, press [Home] and [End] on the keyboard, respectively.
 f Moving 10 frames back: [Shift] + [←]
 f Moving 10 frames forward: [Shift] + [→]

Playing Back with Shuttle/Slider
You can play back a clip by dragging the shuttle or slider on the Recorder.
“Control Area Settings” (w page 152)

1) Drag the shuttle/slider.
 f A frame at the slider position is displayed on the Recorder.

1 Alternative
 f Shuttle (fast forward): [Ctrl] + [L] 
Each click of [Ctrl] + [L] on the keyboard switches the fast-forward speed in 12 levels between 1/16 to 32 times. Press [Ctrl] + [J] on the 
keyboard to slow down.

 f Shuttle (rewind): [Ctrl] + [J] 
Each click of [Ctrl] + [J] on the keyboard switches the rewind speed in 12 levels between 1/16 to 32 times. Press [Ctrl] + [L] on the 
keyboard to slow down.
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Shuttle/Slider

(1) (2) (3)

(1) Shuttle Drag the shuttle to the left and right to play back in the reverse and forward directions, 
respectively. Release dragging to return the shuttle to the center and pause playback.
The playback speed can be selected in 21 levels both in the forward and reverse directions, 
from 1/20 to 16 times.

(2) Sliders Click any position on the position bar to move the slider and display the frame for that position. 
You can also drag the slider.

(3) Position bar Indicates the timeline on the Recorder.

Playing Back with Mouse (Mouse Gesture)
You can play back a clip by moving the mouse on the Recorder.

1) Position the mouse cursor on the Recorder, and move the mouse as if to draw a circle, with the right 
mouse button clicked.

 f Draw the circle clockwise to playback in the forward direction, and counterclockwise in the reverse direction. The playback speed 
changes in proportion to the speed of the mouse action.

1 Alternative
 f Place the mouse cursor on the Recorder, and rotate the mouse wheel.

Playing Back between In and Out Points on the Timeline (Loop Playback)
Repeat playback between In and Out points of the timeline.

1) Setting the In and Out Points to the Timeline
 f “Setting the In and Out Points on the Timeline” (w page 232)

2) Click [Loop] on the Recorder.

 f Playback is repeated between In and Out points of the timeline.
 f Playback starts from the current position of the timeline cursor.

1 Alternative
 f Loop playback: [Ctrl] + [Space]

3) Click [Stop] on the Recorder.
 f Playback stops.
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Playing Back the Area around the Timeline Cursor
You can play back the area around the timeline cursor.

1) Move the timeline cursor to the point from which you want to start playing back.

2) Click [Play the Current Area] on the Recorder.

 f You can repeatedly play back the area around the timeline cursor.

3) Click [Stop] on the Recorder.
 f Playback stops.

2
 f You can also play back around the nearest cut point placed before the timeline cursor for the specified duration. Click the [Play the 
Current Area] list button, and click [Play around Cut Point (1 Sec)], [Play around Cut Point (2 Sec)] or [Play around Cut Point (3 Sec)].

 f You can set the preliminary operation time (Preroll) at [Preview] in [User Settings] → [Playback].
“[Playback]” (w page 118)

Displaying a Desired Scene Quickly

Jumping to In and Out Points on the Timeline
You can jump to In and Out points on the timeline.

1) Click the [Set In] ([Set Out]) list button on the Recorder.

2) Click [Go to In Point] ([Go to Out Point]).
 f “Setting the In and Out Points on the Timeline” (w page 232)

1 Alternative
 f Click [Marker] on the menu bar, and click [Go to In Point] ([Go to Out Point]).
 f Right-click the slider on the Recorder, and click [Go to In Point] ([Go to Out Point]).
 f Right-click the time scale, and click [Go to In Point] ([Go to Out Point]).
 f Right-click the timeline cursor, and click [Go to In Point] ([Go to Out Point]).
 f Jumping to the In and Out points on the timeline: [Q]/[W]

Entering the Timecode to Jump to
You can jump to a specified position on the timeline by entering the numerical values for the timecode at that position.

1) Click on the Recorder.

2) Enter the timecode with the numerical keypad on the keyboard.
Example:

When “1000” is entered

Cur 10;00 In 00:00:01;
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3) Press [Enter] on the keyboard.
 f The timeline cursor moves.

00:00:05;00 00:00:10;00 0

2
 f Enter “+” or “-” at the beginning of the number with the numerical keypad, and the timeline cursor will jump forward or backward by the 
entered number.
“Entry of Values” (w page 43)

Match Frame
This function acquires the timecode of the frame displayed on the Player (or Recorder), and jumps to the position matching the timecode on 
the timeline (or Player). For example, you can use match frame when switching the video image of an interview to another video image of 
the same interview which was recorded from a different angle using 2 cameras, to smoothly switch the image cuts without any interruption 
in motion or sound. Match frame is available even for source video taken from equipment that can be controlled on a deck.

Jumping from Player to Timeline
After acquiring the timecode of the clip displayed on the Player, jump to the corresponding position on the timeline clip and display it on the 
Recorder.
The timeline cursor is jumped to the timeline position matching the timecode of the specified source.

1) Play back a clip on the Player, and display the frame to be jumped to.

2) Click [Match Frame (Player to Recorder)] on the Player.

 f The timeline cursor moves, and the matching frame is displayed on the Recorder.

1 Alternative
 f Jumping from Player to the timeline: [Ctrl] + [F]

2
 f By default, [Match Frame (Player to Recorder)] is not displayed. Before performing the operation, set to display the buttons on the Player.
“Operation Button Settings” (w page 147)

 f Clips containing the timecode of the frame currently displayed on the Player can be searched in the bin by the following operation.
 g Click [Clip] on the menu bar, and click [Search Bin] → [Including Cursor (Player)].
 g Searching bin (Player TC): [Shift] + [Ctrl] + [F]

Jumping from the Timelines to Source Clip
Display the matching frame of the source clip at the timeline cursor position on the Player.
Match frame is possible on decks if the source is from a deck, or match frame is possible on files if the source is a file.

1) Select the track where the target clip is placed.
 f “Selecting Tracks” (w page 220)

2) Move the timeline cursor to display the frame to be jumped to on the Recorder.

3) Click [Clip] on the menu bar, and click [Match Frame] → [Display Source Clip].
 f The matching frame is displayed on the Player.

1 Alternative
 f Displaying source clip: [Alt] + [F]
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2
 f When the source currently displayed on the Player is a file, [Match Frame (Recorder to Player)] performs match frame on that file. When 
the source is from a deck, match frame is performed on the deck.

 f When the source currently displayed on the Player is a file, [Match Frame (Recorder to Source)] displays the clip currently selecting match 
frame on the timeline, and performs match frame. When the source is from a deck, match frame is performed on the deck.

 f You can search for clips with timecodes of the timeline clips in the bin by the following operation. The [Search results] folder is created in 
the folder view of the bin.
 g Click [Clip] on the menu bar, and click [Search Bin] → [Including Cursor (Recorder)].
 g Searching clips at the timeline cursor position in the bin: [Shift] + [F]

“Searching for Clips on the Timeline in the Bin” (w page 240)
 f The clip can be displayed on the Player by clicking and selecting the clip on the timeline and performing the following operation.

 g Click [Clip] on the menu bar, and click [Show in Player].
 g Displaying selected clip on the Player: [Shift] + [Y]

 f In scenes set with a transition, 2 clips overlap each other on the same track. To execute the match frame function on overlapping clips, 
you can set the clip to acquire the timecode in before or after the clip.
“[Match Frame]” (w page 116)

Synchronizing the Player and the Timeline (Gang Mode)
Switch to the gang mode to synchronize the cursor positions or In and Out points of the Player and the timeline.

3 Note
 f Sources displayed in the deck mode cannot be synchronized.

Switching to the Gang Mode

1) Click [Set Gang Mode] on the Player.
 f Each click switches the mode on and off.

2
 f By default, [Set Gang Mode] is not displayed. Before performing the operation, set to display the buttons on the Player.
“Operation Button Settings” (w page 147)

Synchronizing Cursor Positions

1) Move the slider on the Player to the position to be synchronized.

2) Move the timeline cursor to the position to be synchronized.

3) Click the [Set Gang Mode] list button on the Player.

4) Confirm that [Cursor] is checked.

5) Switch to the gang mode.
 f “Switching to the Gang Mode” (w page 297)
 f The cursors of the Player and the timeline are synchronized based on the current cursor position. The cursor positions to be synchronized 
can be changed by the following operation. After unchecking [Cursor] and moving the cursor of the Player or the timeline, check [Cursor] 
again.
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Synchronizing the In and Out Points

1) Set the In (Out) point on the Player to the position to be synchronized.

2) Set the In (Out) point on the timeline to the position to be synchronized.

3) Click the [Set Gang Mode] list button on the Player.

4) Click [In] ([Out]) to check the item.

5) Switch to the gang mode.
 f “Switching to the Gang Mode” (w page 297)
 f The In (Out) points of the Player and the timeline are synchronized based on the current In (Out) point position. The In (Out) point 
positions to be synchronized can be changed by the following operation. After unchecking [In] ([Out]) and changing the In (Out) point of 
the Player or the timeline, check [In] ([Out]) again.

Smooth Playback
If multiple effects and titles has been added, real time processing may not catch up the timeline playback.
This real time processing is delayed due to the heavy data loaded on the playback operation. While playback is performed, the lines of the 
parts where rendering is required are displayed in red (overloaded) or in orange (loaded).
Performing rendering enables smoother playback.

Color Coding of Time Scale
Realtime processing sometimes cannot keep up when playing back a timeline. The line of the part judged as requiring rendering when 
playing back changes color.
The line colors indicate the following states.

00:00:05;00 00:00:10;00 00:00:15;00

Line color Timeline state
No line No clip exists.
Blue A clip matching the project settings is placed.
Light blue Playback is keeping up. (Rendering is sometimes required.)
Orange Rendering option (load area)
Red Rendering is required (overload area).
Pink Rendering job has already been registered to the Render Service, or rendering is in process in 

the background.
Green Already rendered

2
 f Rendering is judged based on the remaining buffer set by [Application] in [System Settings] → [Render], and a red line is displayed for 
overload areas when the remaining buffer is less than the preset value.
“[Render]” (w page 102)

 f Rendering is enabled even if the clip becomes out-of-position by a ripple delete, for example.
 f In the following cases, the color of the line of the time scale returns to the state before the rendering process started.

 g The rendering job has been canceled by operation from GV Job Monitor.
 g The rendering process has failed.
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3 Note
 f Tracks with mute set to video parts cannot be rendered.
 f It is recommended to export the file using the exporter if you need to use rendered clips.
“Exporting in File Formats” (w page 427)

 f When rendering is performed, a temporary file is created in the “rendered” folder. Make sure that there is enough disk space for 
temporary files before starting rendering.
“Manually Deleting Temporary Files” (w page 301)

Rendering Overload Areas of the Entire Sequence
Render all the areas that are judged as overload (red) in the entire sequence.

1) Click the [Render In/Out (Render Overload Area)] list button on the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

2) Click [Render Sequence] → [Render Overload Area].
 f The rendering job will be registered to the Render Service, and the color of the line of the time scale changes to pink.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f When the rendering process has been completed, the color of the line of the time scale changes to green.

1 Alternative
 f Click [Render] on the menu bar, and click [Render Sequence] → [Render Red Area].
 f Rendering overload areas on the entire sequence: [Shift] + [Ctrl] + [Q]

2
 f Overload (red) and load (orange) areas on the entire sequence can be rendered at a time by the following operation.

 g Click the [Render In/Out (Render Overload Area)] list button, and click [Render All] → [Render Loaded Area].
 g Click [Render] on the menu bar, and click [Render Sequence] → [Render Orange Area].
 g Rendering (load areas) on the entire sequence: [Shift] + [Ctrl] + [Alt] + [Q]

 f When In and Out points have been set on the timeline, only the range between the In and Out points can be rendered.
“Rendering Overload Areas between In and Out Points” (w page 300)

 f After rendering process has started, if the project is edited in a way that the range to be rendered changes, the rendering job will be 
canceled.

Rendering Overload Areas in the Entire Project
Render all areas that are judged as overload (red) in the entire project that comprises multiple sequences.

1) Click [Render] on the menu bar, and click [Render Entire Project] → [Render Red Area].
 f The rendering job will be registered to the Render Service, and the color of the line of the time scale changes to pink.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f When the rendering process has been completed, the color of the line of the time scale changes to green.

2
 f Overload (red) and load (yellow) areas in the entire project can be rendered at a time. Click [Render] on the menu bar, and click [Render 
Entire Project] → [Render Orange Area].

 f After rendering process has started, if the project is edited in a way that the range to be rendered changes, the rendering job will be 
canceled.

Rendering only Overload/Load Areas
Render only the areas that are judged as overload (red) or load (orange).
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1) Right-click the line of overload (red) or load (orange) areas on the time scale, and click [Render].
 f The rendering job will be registered to the Render Service, and the color of the line of the time scale changes to pink.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f When the rendering process has been completed, the color of the line of the time scale changes to green.

2
 f After rendering process has started, if the project is edited in a way that the range to be rendered changes, the rendering job will be 
canceled.

Rendering Overload Areas between In and Out Points
Render areas judged as overload (red) between In and Out points on the timeline.

1) Setting the In and Out Points to the Timeline
 f “Setting In/Out Points and Placing Clips” (w page 235)

2) Click [Render In/Out (Render Overload Area)] on the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

 f The rendering job will be registered to the Render Service, and the color of the line of the time scale changes to pink.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f When the rendering process has been completed, the color of the line of the time scale changes to green.

1 Alternative
 f Click [Render] on the menu bar, and click [Render In/Out] → [Render Red Area].
 f Click the [Render In/Out (Render Overload Area)] list button, and click [Render In/Out] → [Render Overload Area].
 f Right-click the time scale, and click [Render In/Out] → [Render Overload Area].
 f Rendering overload areas between In and Out points: [Ctrl] + [Q]

2
 f All areas judged to be red, orange and light blue between In and Out points can be rendered by the following operation.

 g Click [Render] on the menu bar, and click [Render In/Out] → [All].
 g Click the [Render In/Out] list button, and click [Render In/Out] → [All].
 g Right-click the time scale, and click [Render In/Out] → [All].
 g Rendering between In and Out points (all): [Shift] + [Alt] + [Q]

 f Overload (red) and load (orange) areas between In and Out points can be rendered at a time by the following operation.
 g Click [Render] on the menu bar, and click [Render In/Out] → [Render Orange Area].
 g Click the [Render In/Out (Render Overload Area)] list button, and click [Render In/Out] → [Render Loaded Area].
 g Right-click the time scale, and click [Render In/Out] → [Render Loaded Area].
 g Rendering between In and Out points (load area): [Ctrl] + [Alt] + [Q]

 f After rendering process has started, if the project is edited in a way that the range to be rendered changes, the rendering job will be 
canceled.

Rendering Around the Timeline Cursor Position
Render only overload areas (red) or load areas (orange) around the timeline cursor position.

1) Move the timeline cursor to the area to be rendered.

2) Click [Render] on the menu bar, and click [Render Cursor Area].
 f The rendering job will be registered to the Render Service, and the color of the line of the time scale changes to pink.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f Areas of the same line color on the time scale are rendered around the timeline cursor position. When there is a transition in same-color 
lines, the rendered area becomes the area up to the In or Out point of the transition.
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 f When the rendering process has been completed, the color of the line of the time scale changes to green.

00:00:10;00 00:00:10;00 00:00:10;00

2
 f After rendering process has started, if the project is edited in a way that the range to be rendered changes, the rendering job will be 
canceled.

Rendering Clips/Transitions
Perform rendering in individual clip or transition units.

3 Note
 f If you perform clip rendering on a clip with alpha effect, alpha information will no longer be applied.
 f Keys, transparencies or transitions between tracks (effects set in the mixer area) cannot be rendered. In this case, take the alternate 
method to render a part of the timeline.

1) Right-click the clip to be rendered, and click [Render].
 f To render a transition, right-click the transition and click [Render].
 f The rendering job will be registered to the Render Service, and pink lines appear on the clip.
When a transition has been rendered, the lines at the center of the transition change to pink.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f When the rendering process has been completed, the lines on the clip change to green.
When a transition has been rendered, the lines at the center of the transition change to green.

Example:

When a clip has been rendered

XXXX
XXXX

XXXX
XXXX

XXXX
XXXX

Example:

When a clip transition has been rendered

XXXX
XX

XXXX
XX

XXXX
XX

1 Alternative
 f Click [Render] on the menu bar, and click [Render selected clip/transitions].
 f Rendering clips/transitions: [Shift] + [G]

2
 f If the clip or transition to be rendered is edited after rendering process has started, the rendering job may be canceled.

Manually Deleting Temporary Files
Manually delete temporary files that are created during rendering.
Temporary files for rendering are saved temporarily in the “rendered” folder created in the project folder. Temporary files that are not 
referenced by a project are automatically deleted when the project ends, however, it is recommended to manually delete them when the 
“rendered” folder increases in size.

1) Click the [Render In/Out (Render Overload Area)] list button on the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00
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2) Select [Delete Render Files] and click [Files that are not Used] or [All Files].

1 Alternative
 f Click [Render] on the menu bar, and click [Delete Temporary Render Files] → [Files Not Used] or [All Files].
 f Deleting unused files: [Alt] + [Q]

3) Click [Yes].

2
 f Set when to automatically delete invalid rendering files (i.e. files not referenced by a project) at [Application] in [System Settings] → 
[Render].
“[Render]” (w page 102)

 f A temporary file is created in the following cases: 
 g When a clip has been exported from the timeline
 g When part of the timeline has been rendered
 g When a clip has been rendered

3 Note
 f The temporary files created in the “rendered” folder can be operated (e.g. renamed, deleted or copied). However, temporary files 
referenced from a project, such as [Render In/Out], cannot be operated.

Exporting Still Image Clips from the Timeline
Video images in the selected preview window (Player/Recorder) can be exported as still image clips and registered to the bin.

Example:

To export the frame displayed on the Recorder as a still image

1) On the Recorder, display frames to be saved as still images.

2) Click [Create a Still Image (Save as)] on the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

 f The [Save As] dialog box appears.

3) Set a file name, save destination, and [Save as type], and then click [Save].
 f The still image is saved in the specified folder, and the still image clip is registered to the bin.

1 Alternative
 f Exporting still image clips from the timeline: [Ctrl] + [T]
 f Click [Clip] on the menu bar, and click [Create a Still Image]. The still image is saved in the same folder as the project, and the still image 
clip is registered to the bin.

2
 f Still images are saved as side-by-side in the stereoscopic edit mode.
 f Video from a deck also can be saved as still image clips.
 f The aspect ratio of still images sometimes is output different from that of the original image depending on the frame size. To output 
correctly, set to correct the aspect ratio. The settings of still images to export can be changed by [Importer/Exporter] in [System Settings] 
→ [Still Image].
“[Still Image]” (w page 105)

Draft Preview

Changing Image Quality for Preview

Reducing image resolution or bit depth for preview improves the performance of real time playback. Although the preview image quality 
becomes lower, it reduces the load on PC and you can edit data comfortably.
Make use of this feature when you apply heavy-load effects such as [Mask] and [Layouter], or when you play the timeline where high-
resolution clips such as 4K are placed.
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1) Click [Preview Quality] on the menu bar, and select an item.
 f The image quality of the preview window will be changed according to the selected item.

[Full] Previews video without changing the resolution and bit depth.
[Full 8bit] Previews video with the original resolution maintained but with the bit depth changed to 8-bit.

This is displayed only for projects with video quantization bitrate of 10-bit.
[1/2] Previews video in 1/2 of the original resolution.
[1/4] Previews video in 1/4 of the original resolution.
[1/8] Previews video in 1/8 of the original resolution.
[1/16] Previews video in 1/16 of the original resolution.

2
 f Click [Settings] on the menu bar, go through [User Settings] → [Preview] → [Playback], and add the check mark for [Show full quality 
when Paused], to enable preview in the original image quality when playback is paused.

 f When proxy editing is started while [Preview Quality] is set to [Full] or [Full 8bit], the setting is automatically changed to [1/2]. When proxy 
editing is started while [Preview Quality] is set to lower than [1/2], the setting is maintained. After proxy editing is finished, [Full] is applied 
for [Preview Quality], regardless of the original setting.

3 Note
 f Depending on the [Preview Quality] setting, the timecode or level meter in the status area may not be displayed.

 r Playing Back Video with Effects Applied Smoothly
When heavy-load effects such as [Mask] or [Layouter] are applied on a clip, real time processing may not catch up and the timeline may not 
be played back smoothly.
Draft preview can be used in such a case. Although the preview image quality becomes lower, it does not take time for converting resolution 
or bit depth, and the timeline can be played back quickly. If you need to check image details, adding the check mark for [Show full quality 
when Paused] can let you check the image in the original quality when playback is paused.
“Changing Image Quality for Preview” (w page 302)

 r Playing Back 4K Video Smoothly
Draft preview is effective in playback of timeline where the data amount is large due to a case such as heavy usage of high quality 4K image 
clips.
For example, when [1/2] is selected for [Preview Quality], 4K (3840x2160) video is displayed in the image quality equivalent to Full HD 
(1920x1080). If you edit video on a notebook PC, selecting [1/4] and previewing in full screen can maintain an adequate image quality.
By using the draft preview, you can handle high-quality image sources regardless of the performance of your PC.
 f Draft preview functions effectively in the following commonly used formats.
Sony RAW, Cinema RAW, Cinema RAW Light, Avid DNxHD/Avid DNxHR, Apple ProRes, RED, Motion JPEG, JPEG, Grass Valley HQX



Chapter 7   Editing Operations — Sequences

304

Sequences

Creating New Sequence

What Are Sequences?
A single timeline included in a project is called a “sequence”.
A single project can be comprised of multiple sequences, and a sequence can be selected and edited by clicking the sequence tab. 
Sequences are registered as “TL (timeline) sequence clip” to the bin and they can be edited like clips.
Nest sequence is the function for placing a certain sequence within other sequences in the same way as a clip for editing.

Example:

When “Sequence 2” is placed in the 1VA track of sequence 1

You can open and edit the clip in “Sequence 2”, which is placed in Sequence 1, in the timeline window.

2
 f Right-click the sequence tab to display the menu for changing the sequence setting or closing the sequence. Right-click the sequence tab 
of the sequence to be set.

Creating New Sequences
Create a new sequence.

1) Click [Create New Sequence] of the timeline.

album1

 f A blank sequence is created in the timeline window, and a timeline sequence clip also is registered to the bin at the same time.

 f To select a sequence, click the sequence tab.
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1 Alternative
 f Click [File] on the menu bar, and click [New] → [Sequence].
 f Right-click a blank area in the clip view of the bin, and click [New Sequence]. In this case, a blank timeline sequence clip is registered to 
the bin but not displayed in the timeline window.
“Opening the Sequence to Edit” (w page 305)

 f Creating new sequence: [Shift] + [Ctrl] + [N]

2
 f You can change sequence settings.
“Sequence Settings” (w page 68)

 f You can sort the order of sequence tabs by dragging and dropping the tabs.
 f You can rename sequences by right-double-clicking the sequence tab.

Editing Sequences

Opening the Sequence to Edit
Open and edit timeline sequence clips in the timeline window.

1) Double-click a timeline sequence clip in the bin or on the timeline.
 f The sequence tab is displayed in the timeline window. Click the sequence tab to select the sequence to edit.

2
 f Edits are reflected in the timeline sequence at the place destination when the timeline sequence clip is edited. Not, however, that the 
length of the timeline sequence at the place destination remains unchanged. The display changes as follows when there is not enough 
clip length left after editing:

XXXX

XXXX

(1) (2)

(1) is gray and no clips are present in the total length of the sequence.
(2) is gray and no clips are present extending over the total length of the sequence.

 f The total length can be changed in the sequence settings.
“Sequence Settings” (w page 68)

 f You can import timeline sequences created in other projects.
“Importing Sequence (Sequence Import)” (w page 75)

1 Alternative
 f Right-click a timeline sequence clip in the bin, and click [Open Sequence].

Closing Sequences

1) Right-click the sequence tab, and click [Close This Sequence].

1 Alternative
 f Click [View] on the menu bar, and click [Close Sequence] → [Active Sequence].

2
 f You can close all but one of currently displayed sequences by the following operation.

 g Right-click the sequence tab to leave behind, and click [Close All Other Sequences].
 g Click the sequence tab to leave behind, and click [View] → [Close Sequence] → [All Sequences except Active Sequence] on the menu 
bar.

 f You cannot close all sequences displayed in the timeline window.
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Effectively Editing Clips Using the Nest Sequence Function

Registering Clips on the Timeline to the Bin as Sequences
You can register clips between In and Out points placed on the timeline to the bin. You can also select a clip to register to the bin as a 
timeline sequence clip.

1) Setting the In and Out Points to the Timeline
 f “Setting the In and Out Points on the Timeline” (w page 232)
 f Select a clip when registering a clip on the timeline to the bin as a timeline sequence clip.

2) Click [Edit] on the menu bar, and click [Add Sequence to Bin] → [In/Out] or [Selected Clip].
 f When [In/Out] is clicked, the range between In and Out points is registered to the bin as the timeline sequence clip, and when [Selected 
Clip] is clicked, the selected clip is registered.

2
 f You can convert a video clip between In and Out points on the timeline to a sequence to place on a track. After setting the In and Out 
points to the timeline, click [Edit] on the menu bar, and click [Set Between In/Out as Sequence]. The clip between In and Out points is 
placed on the track as a sequence, and the timeline sequence clip is registered also to the bin at the same time. If there is no space to 
place a clip on the track, a new V track is added.

 f Active sequences in the timeline window can be registered to the bin as timeline sequence clips by the following operation.
 g Right-click the sequence tab, and click [Add to Bin].
 g Click [Edit] on the menu bar, and click [Add Sequence to Bin] → [All].

Creating Blank Timeline Sequence Clips on Tracks
You can place a blank timeline sequence clip in advance at the sequence insert position.

1) Move the timeline cursor to the position to create the timeline sequence clip.

2) Right-click the track to create the sequence at, and click [New Sequence].
 f A blank timeline sequence clip is placed on the track with the position of the timeline cursor set as the In point. It is also registered to the 
bin at the same time.

Duplicating Sequences
You can duplicate timeline sequence clips in the bin. Create a sequence with the same content but using a different name.

1) Right-click a timeline sequence clip in the bin, and click [Duplicate Sequence].
 f Duplicated clips are named after the original clips and are appended with a sequential number.

Placing Sequences within Other Sequence (Nest Sequence)
You can place a timeline sequence clip within another timeline sequence.

1) Set the source channel mapping.
 f “Setting Channel Mapping” (w page 230)

2) Move the timeline cursor to the position to place the clip.
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3) Select a timeline sequence clip from the bin, and click [Add to Timeline].

 f The timeline sequence clip (gray) in the bin is placed on the other sequence.

1 Alternative
 f Directly drag and drop a timeline sequence clip in the bin onto the timeline.
 f Right-click on a timeline sequence clip in the bin, and click [Add to Timeline].
 f Play back a timeline sequence clip on the Player, and click [Insert to Timeline] or [Overwrite to Timeline].
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Multicam Editing
In multicam editing, you can place clips including videos recorded by multiple cameras on the timeline along with the time axis and perform 
cut editing by switching scenes while playing back the clips simultaneously.
You can play back and edit videos of multiple clips up to 16 on the screen simultaneously.
After performing cut editing, you can also place only the selected clips on a single track.
 f Multicam editing can be performed while in the multicam mode.

Setting the Sync Point to Place Clips
You can select a sync point as the reference point to be used when multiple clips are placed, and then place clips on the timeline.
A sync point can be selected from [Timecode], [Audio], [Clip Marker] , [Clip In], etc.
When a synchronized clip is to be placed, you can select either to create a new sequence or to use the currently active sequence.
 f To place a clip in the bin to the currently active sequence, click on the sequence tab of the sequence to be synchronized to activate it in 
advance.

 f To execute [Audio (Around the Marker)] or [Clip Marker] for [Sync Point], set a clip marker on each clip in advance. To place a clip in the 
bin to the currently active sequence, set a sequence marker on the sequence to be synchronized in advance.

1) Select and right-click the multiple clips in the bin, and click [Multicam Sync].
 f The [Multicam Sync] dialog box appears.
“[Multicam Sync] Dialog Box” (w page 309)

 f When you place a clip in the bin to the currently active sequence, you can select only one clip in this step.

2) Select a reference sync point from the [Sync Point] list.
 f When you select [Audio (Around the Marker)] or [Clip Marker], set [Marker].

3) Select [New Sequence] or [Active Sequence] for [Target Sequence] of [Output].
 f Select a sequence on which the synchronized clips are to be placed.
Selecting [New Sequence] will create a new sequence in accordance with the current project settings.
Selecting [Active Sequence] will synchronize the currently active sequence with the clip selected in the bin. Clips will be added to the 
currently active sequence.

 f When you select [New Sequence], set [Sequence Name] and [Audio Channel].

4) Click [OK].
 f The clip will be placed on the timeline.
 f If [Audio] or [Audio (Around the Marker)] has been selected for [Sync Point], clicking [OK] will start analysis of audio data. The progress of 
the analysis process will be displayed, and clips will be placed after completion of the analysis.

 f The sequence on which the clips are placed differs depending on the setting of [Target Sequence].
 f When [New Sequence] has been selected for [Target Sequence], multicam mode is set to the sequence.

 g Clips placed on the timeline are displayed in the multi-camera screen on the Recorder.
The number of the multi-camera screens on the Recorder is determined automatically according to the number of clips selected in the 
bin.
“Changing the Number of Screens” (w page 313)

 g The camera switch point is automatically set to the In and Out points of each clip. To change the camera switch point, overwrite it.
“Setting the Camera Switch Point during Playback” (w page 315)

2
 f The currently active sequence and the sequence clip selected in the bin can be synchronized.
Note that the following sequence clips cannot be synchronized with the currently active sequence.
 g A sequence clip which is identical to the currently active sequence
 g A sequence clip which includes the currently active sequence

3 Note
 f When a clip is placed on the timeline by a drag and drop operation or by clicking [Add to Timeline] for a clip selected in the bin, the clip 
cannot be placed using the sync point as the reference point.

 f Selecting [Active Sequence] for [Target Sequence] will synchronize the currently active sequence with the clip selected in the bin. 
When the clip selected in the bin is placed on the timeline, the positions of clips which have already been placed on the timeline are 
maintained. Therefore, the clip selected in the bin may be trimmed on the In point side, or the clip may not be placed.
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[Multicam Sync] Dialog Box

XXX XXXXXX

(1)

(2)

XXXXX

XXXXXXXXXXXXXXXXXXXX

XXXXX

XXXXX
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XXXX

Target Sequence New Sequence

Audio Channel

Sequence Name

Active Sequence

Output

Comment

Color
Marker

Timecode

Rec Time

Additional information on audio synchronization

Sync Point

Sync setting

Multicam Sync

(1) [Sync setting] Sets a sync point or marker to be the reference for synchronization.
“[Sync setting]” (w page 309)

(2) [Output] Makes settings of the sequence on which the synchronized clips are to be placed.
[Target Sequence]
 f When [New Sequence] has been selected
A new sequence is created in accordance with the current project settings. Multicam mode 
will be set to the created sequence.

 f When [Active Sequence] has been selected
The currently active sequence and the clip selected in the bin are synchronized. The 
synchronized clips will be added to the currently active sequence. The mode of the sequence 
(standard mode/multicam mode) will not be changed.
 g A clip cannot be placed on an empty sequence.
 g If [Audio (Around the Marker)] or [Clip Marker] has been selected for [Sync Point], the clip 
marker of the clip selected in the bin and the sequence marker set on the sequence will be 
the reference points for synchronization.

[Sequence Name]
Enter the name of the sequence.
[Audio Channel]
Select the audio channel from [Monaural] and [Stereo].

[Sync setting]

(1)
(2)

(3)

XXXXX

XXXXXX

XXXX

Comment

Color
Marker

Timecode

Rec Time

Additional information on audio synchronization

Sync Point

Sync setting

Multicam Sync
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(1) [Sync Point] Select a sync point as the reference point for clips to be placed.
[Timecode]
Places clips on the timeline according to the start timecode of each clip.
[Rec Time]
Places clips on the timeline according to the recording time of each clip.
[Audio]
Analyzes audio data of every entire clip, and determines an optimal sync point automatically. 
Clips are placed on the timeline according to those sync points.
“Audio Sync” (w page 310)
[Audio (Around the Marker)]
Analyzes audio data of each clip in the range of 10 seconds before and after the clip marker 
set on each clip, and determines an optimal sync point automatically. Clips are placed on the 
timeline according to those sync points. By limiting the analysis area to the range around the 
marker, the time for analysis will be shortened significantly.
A marker to be the reference point can be set by [Marker].
 f If [Active Sequence] has been selected for [Target Sequence], the clip marker of the clip 
selected in the bin and the sequence marker set on the sequence will be the reference points 
for analysis.

 f If a clip or sequence has no marker to be subject to synchronization, the entire clip or 
sequence will be analyzed.

“Audio Sync” (w page 310)
[Clip Marker]
Places clips on the timeline according to the clip marker position of each clip.
A marker to be the reference point can be set by [Marker].
 f If [Active Sequence] has been selected for [Target Sequence], the clip marker of the clip 
selected in the bin and the sequence marker set on the sequence will be the reference points 
for synchronization.

[Clip In]
Places clips on the timeline according to the In point of the clip. If a clip has no In point, the top 
of the clip will be the reference point.
 f If [Active Sequence] has been selected for [Target Sequence], the In point of the sequence 
will be the reference point for synchronization.

[Clip Out]
Places clips on the timeline according to the Out point of the clip. If a clip has no Out point, the 
end of the clip will be the reference point.
 f If [Active Sequence] has been selected for [Target Sequence], the Out point of the sequence 
will be the reference point for synchronization.

(2) [Marker] Sets [Color] and [Comment] of the clip marker or sequence marker to be the reference point for 
synchronization.
 f The marker with the exact same color as selected in [Color] and the text string as set in 
[Comment] will be subject to synchronization.

 f The settings can be changed by selecting [Audio (Around the Marker)] or [Clip Marker] in 
[Sync Point].

[Color]
Select the color of the marker to be the reference point for synchronization.
[Comment]
Enter the text string which exactly matches that of [Comments] for the marker to be the 
reference point for synchronization.

(3) [Additional 
information on audio 
synchronization]

Sets the data to be used in analysis of audio sync.
[Rec Time]
Check this item to use the [RecDate/Time] data of the clip in analysis.
[Timecode]
Check this item to use the [Start TC] data of the clip in analysis.
This setting is applied to free run source clips. However, if [Start TC] of a free run source clip 
is “00:00:00;00”, the clip is treated as a rec run source, and its [Start TC] data is not used in 
analysis.

Audio Sync
The audio sync function analyzes audio data such as video clip and audio clip, and automatically determines an optimal sync point to 
synchronize them.
There are two major methods of audio sync, [Audio] and [Audio (Around the Marker)].
[Audio] analyzes audio data of every entire clip.
[Audio (Around the Marker)] analyzes audio data of each clip in the range of 10 seconds before and after the clip marker set on each clip. By 
limiting the analysis area to the range around the marker, the time for analysis will be shortened significantly.

 r Preparation
To execute [Audio (Around the Marker)] in [Sync Point], set a clip marker on each clip in advance. The marker position functions as a 
reference point for the range of audio data analysis. An analysis is performed in the range of 10 seconds before and after the marker.
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2
 f If a clip in the bin is placed onto the currently active sequence, the clip marker of the clip selected in the bin and the sequence marker set 
on the sequence will be the reference points for analysis.

Example:

To set a clip marker to be the reference point for analysis

1) Set a clip marker on a clip to be used for multicam editing.
 f Set a clip marker on a position of a characteristic sound that is commonly included in all the clips, such as the start of music.
“Setting Clip Markers” (w page 281)

2) Set [Color] and [Comments] for the clip marker of each clip.
 f Set [Color] and [Comments] of the clip marker to be the reference point of analysis.
The clip marker with the exact same setting as that for [Marker] in the [Multicam Sync] dialog box will be analyzed.
“Changing Color of Clip Marker” (w page 284)
“Entering Comments to Clip Markers” (w page 283)

 f Even if [Comments] is not entered, synchronization will be performed.

2
 f To place a clip in the bin onto the currently active sequence, set a sequence marker on the sequence to be synchronized in advance, and 
then set [Color] and [Comments].
“Changing Color of Sequence Marker” (w page 290)
“Entering Comments to Sequence Markers” (w page 289)

Synchronization by Audio Sync Function

This section describes how to synchronize clips using the audio sync function.
 f To place a clip in the bin to the currently active sequence, click on the sequence tab of the sequence to be synchronized to activate it in 
advance.

 f To execute [Audio (Around the Marker)] in [Sync Point], set a clip marker on each clip in advance. To place a clip in the bin to the currently 
active sequence, set a sequence marker on the sequence to be synchronized in advance.

1) Select and right-click the multiple clips in the bin, and click [Multicam Sync].
 f The [Multicam Sync] dialog box appears.
“[Multicam Sync] Dialog Box” (w page 309)

 f When you place a clip in the bin to the currently active sequence, you can select only one clip in this step.

2) Select [Audio] or [Audio (Around the Marker)] from the [Sync Point] list.
 f If you execute [Audio], proceed to step 4).

3) For [Marker], set [Color] and [Comment] of the marker to be the reference point for analysis.
 f Set [Color] and [Comment] which exactly match those of the marker set for each clip in advance.

4) For [Additional information on audio synchronization], check the data to be used in analysis.

5) Select [New Sequence] or [Active Sequence] for [Target Sequence] of [Output].
 f Select a sequence on which the synchronized clips are to be placed.
Selecting [New Sequence] will create a new sequence in accordance with the current project settings when the audio data analysis is 
completed.
Selecting [Active Sequence] will synchronize the output audio in the currently active sequence with the clips selected in the bin. Clips will 
be added to the currently active sequence.

 f When you select [New Sequence], set [Sequence Name] and [Audio Channel].

6) Click [OK].
 f The analysis of audio data will start. The progress of the analysis process will be displayed, and clips will be placed on the sequence 
when the analysis is completed.

2
 f After [Audio (Around the Marker)] has been selected for [Sync Point], if a clip or sequence has no marker to be subject to synchronization, 
the entire clip or sequence will be analyzed.
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 f If the number of audio channels exceeds the maximum limit of output channels in the project settings, the excess of the audio channels 
will not be placed in the sequence.
If the number of audio channels in a clip exceeds the maximum limit that can be placed, a message will appear before the analysis of 
audio data starts. Click [Continue] to delete the audio channels that exceed the maximum limit for output, and then place the clip in the 
sequence.

 r To automatically distinguish different scenes and separate sequence
If [Audio] or [Audio (Around the Marker)] has been selected for [Sync Point], multiple sequences may be created, in such a case when 
multiple groups with different sync points are detected in audio data analysis.
For example, if a performance by a band is recorded in multi-camera recording by three cameras, in which four songs are performed and 
recording is stopped on each camera every time a song is finished.
When the recorded data is imported to EDIUS, 12 clips will be registered to the bin. If you select all the 12 clips in the bin and execute audio 
sync, automatic distinction of scenes will be performed based on the sync point information obtained from analysis.
After the analysis is completed, four sequences, each including three clips, will be created.

2
 f Clips that have an identical reel name will not be analyzed for each other. Clips with an identical reel name are placed on the same track 
on the sequence.

 f In case multiple sequences are created, the sequence names are given as follows.
The following are examples of three sequences created when [Sequence Name] of [Output] is set to “Multicam1” in the [Multicam Sync] 
dialog box.
 g The name of the first sequence: “Multicam1”
 g The name of the second sequence: “Multicam1(2)”
 g The name of the third sequence: “Multicam1(3)”

Switching to the Multicam Mode
You can switch the mode of the currently active sequence to the multicam mode.

1) Click [Mode] on the menu bar, and click [Multicam Mode].
 f The preview window switches from the standard mode to the multicam mode.
 f When the preview window is displayed in the dual mode, the left side is the divided screen corresponding to the number of cameras, and 
the right side is the master (selected camera).

 f When the preview window is displayed in the single mode, the screen is the divided screen corresponding to the number of cameras. The 
screen can also be set to display only the master.
“Setting the Multicam Display” (w page 313)

 f [Camera mapping] is displayed on the track panel of the timeline window.

5 V

V
A

C5

XXXXXX

4 V C4

3 V C3

2 V C2

1 VV C1

1 Alternative
 f Switching to the multicam mode: [F8]

2
 f When the mode is switched to the multicam mode with clips placed on the timeline, the camera switch point is automatically set to the In 
and Out points of each clip. To change the camera switch point, overwrite it.
“Setting the Camera Switch Point during Playback” (w page 315)

 f When the preview window is displayed in the single mode, the display can be switched between the selected camera only display and the 
divided screen. Click [Mode] on the menu bar, and click [View Multicam] → [Show Only the Selected Camera in Single Monitor Mode].

 f The multicam mode can be switched to the standard mode by the following operation.
 g Click [Mode] on the menu bar, and click [Normal Mode] or [Multicam Mode].
 g Press [F8] on the keyboard again.
 g Switching to standard mode: [F5]

 f Operations on clips or tracks in the multicam mode are the same as in the standard mode, however, shortcut keys differ from those in the 
standard mode.
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3 Note
 f The multicam mode ends and the mode changes to the standard mode when the following operations are performed during multicam 
editing.
 g Switching to the Player during editing in the single mode
 g Displaying clips on the Player during editing in the dual mode
 g Opening the effect or layouter setting dialog box

Changing the Number of Screens
You can switch the number of multicamera screens on the Recorder.

1) Click [Mode] on the menu bar, and click [Number of Cameras] → an item.

Changing the Assigned Camera
You can change the camera assigned to each track.
When clips have been placed on the timeline in the multicam mode, cameras are assigned in the track number order of V/A tracks 
containing clips.

1) Click [Camera mapping] on the track panel of the V/A track.
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1 VV C1

2) Click the camera to assign to the selected track.
 f Click [Unmap] to release the assignment set to the selected track.
 f Click [Default] to initialize all camera assignments set to the tracks. Cameras will be reassigned in order of track numbers of the V track. 
Camera assignment to the A track will be released.

2
 f [Camera mapping] is displayed only in the multicam mode.
 f Tracks not assigned a camera are not displayed in the multicam mode.
 f You can change camera assignments during editing.
 f You can switch the display/hide setting for the track name at the upper left of each screen of the multicam mode. Click [Mode] on the 
menu bar, and click [View Multicam] → [Display Track Name] to uncheck the item.

Setting the Multicam Display
Set the preview display during editing in the multicam mode.

1) Click [Mode] on the menu bar, and click [View Multicam] → an item.
 f On items are checked.

[Skipped Frames] Increase the skipped frames to reduce the load on the system during playback.
[Apply Video Filter] Batch-switch the disabled (on)/enabled (off) setting of the video filter applied to clips. 

Temporarily disabling the video filter can reduce the load on the system during playback.
[Display Track Name] Switch the show/hide setting for track names assigned to the divided screen.
[Display Only the Selected Camera on 
Full Screen Preview  (Auto)]

When this item is on, only the video of the selected camera (master) is displayed in displays 
whose full screen view setting is set to [Auto].
When this item is off, the divided screen is displayed.
“[Monitor]” (w page 119)
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[Output the Selected Camera to 
External Monitor]

When this item is on, only the video of the selected camera (master) is displayed on the 
external monitor.
When this item is off, the divided screen is displayed.

[Show Only the Selected Camera in 
Single Monitor Mode]

This item is enabled when the preview window is in the single mode. When this item is on, only 
the video of the selected camera (master) is displayed.

Setting the Camera Switch Point and Selecting the Camera
Set the camera switch point as the trigger to switch cameras, and select clips to use.
 f Switch the mode to the multicam mode in advance.
“Switching to the Multicam Mode” (w page 312)

Setting Track to be Controlled with Camera Switch Point
You can set tracks to be controlled with the camera switch point in the multicam mode.
 f Operations to add, move, and delete camera switch point as well as to switch the selected camera can be controlled with this function.

1) Click [Mode] on the menu bar, and click [Multicam Switching] → an item.

[Cut Video] Set the track to be controlled with the camera switch point to the V track only.
[Cut Audio] Set the track to be controlled with the camera switch point to the A track only.
[Cut Video and Audio] Set the track to be controlled with the camera switch point to both of the V and A tracks.

 f The current mode is displayed on the status bar of the timeline.

2
 f [Cut Video] is set by default.
 f If you add the buttons of [Multicam Switching] to be displayed on the mode bar and timeline as operation buttons, you can switch the track 
to be controlled with the camera switch point simply by clicking a button.
“Operation Button Settings” (w page 147)

 f If you assign the buttons of [Multicam Switching] to keyboard shortcuts, you can switch the track to be controlled with the camera switch 
point by keyboard shortcuts.
“Changing Keyboard Shortcut Assignments” (w page 159)

Setting the Camera Switch Point
Set the camera switch point as the trigger to switch cameras.
 f Before performing an operation, check the setting of [Multicam Switching]. In [Multicam Switching], you can specify the track(s) to be 
controlled with the camera switch point.
“Setting Track to be Controlled with Camera Switch Point” (w page 314)

1) Move the timeline cursor to the position to set the camera switch point.

2) Right-click the time scale, and click [Add Cut Point/Clear Cut Point (Toggle)].
 f The camera switch point is set at the timeline cursor position, and a cut point is added to the clip on the switch point.

:00;00 00:00:05;00 00:00:10;00 00:00:15;00

:00;00 00:00:05;00 00:00:10;00 00:00:15;00

XXX XXXX

XXX XXXXXXX XXXX XXXX

 f Repeat steps 1) and 2), to set the camera switch point. The enable/disable setting of clips to use can be set by switching the selected 
camera.
“Switching the Selected Camera” (w page 316)
“Clip Enable/Disable” (w page 246)
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1 Alternative
 f Double-click the time scale at the position to set the camera switch point.
 f Double-click the camera video of each track.
 f Setting camera switch point: [0]

2
 f The same operations can also be performed during playback.
 f The track(s) to be switched when switching the camera will be determined according to the camera numbers specified on the V and A 
tracks.

Setting the Camera Switch Point during Playback
You can set the camera switch point during playback. Playback operations are the same as in the standard mode.
The following explains operations in the divided screen in the multicam mode. When display of only the selected camera in the single mode 
has been set, operate using the numerical keypad on the keyboard.
“Multicam Editing by Shortcut Keys” (w page 317)
 f Before performing an operation, check the setting of [Multicam Switching]. In [Multicam Switching], you can specify the track(s) to be 
controlled with the camera switch point.
“Setting Track to be Controlled with Camera Switch Point” (w page 314)

1) Move the timeline cursor to the position to start playback.

2) Click the camera video of the clip to be enabled first.

3) Click [Play] on the Recorder.

4) Click the camera video of the clip to be enabled at the video switching position.
 f The camera switch point is set to the timeline cursor position. When playback stops, a cut point is added to the clip on the camera switch 
point.

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00

XXXX XXXX

XXXX XXXX XXXX

XXXX

2
 f Any camera switch point which is placed between the first up to the playback stop point is deleted.
 f When setting the camera switch point during playback, you can set not to delete the camera switch points that playback has passed 
through. Click [Mode] on the menu bar, and click [Overwrite Cut Point] to uncheck the item.
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Moving Camera Switch Points
You can delete camera switch points.
 f Before performing an operation, check the setting of [Multicam Switching]. In [Multicam Switching], you can specify the track(s) to be 
controlled with the camera switch point.
“Setting Track to be Controlled with Camera Switch Point” (w page 314)

1) Drag the camera switch point.
00:00:10;00 00:00:15;00 00:

XXXX

XXXX

 f During dragging, the images of the previous and next frames of the camera switch point are displayed on the camera of the respective 
track on the Recorder.

1 Alternative
 f Click the clip boundary, and perform a slide trim.
“Trimming Operation Methods” (w page 274)

 f Place the mouse cursor on the Recorder with [Shift] on the keyboard held down, and rotate the mouse wheel. The master at the position 
of the camera switch point being moved and the video of each track are displayed on the Recorder. Check the video, and release [Shift] at 
the position to place the camera switch point to place the point at the move destination.

2
 f If you have moved through other camera switch points, the camera switch points in between are deleted.
 f Move the camera switch point set to the Out point of a clip to trim the clip.

Deleting Camera Switch Points
You can delete camera switch points.
 f Before performing an operation, check the setting of [Multicam Switching]. In [Multicam Switching], you can specify the track(s) to be 
controlled with the camera switch point.
“Setting Track to be Controlled with Camera Switch Point” (w page 314)

1) Move the timeline cursor to a camera switch point to delete.

2) Right-click the time scale, and click [Add Cut Point/Clear Cut Point (Toggle)].
 f The camera switch point is deleted, and clips are merged. The enable/disable settings of clips when a camera switch point is deleted are 
dependent on the previous clip.
The camera switch point cannot be deleted when the camera switch point set to the In and Out points of a clip which has no margin.

1 Alternative
 f Right-click the camera switch point to delete, and click [Add Cut Point/Clear Cut Point (Toggle)].
 f Double-click the camera switch point.

2
 f To delete all camera switch points on the time scale, right-click the time scale, and click [Delete All Cut Points].
 f To delete camera switch points between the In and Out points on the timeline, right-click the time scale, and click [Delete Cut Points 
between In/Out].

Switching the Selected Camera
You can change the clips to acquire after setting the camera switch points.
The following explains operations in the divided screen in the multicam mode. When display of only the selected camera in the single mode 
has been set, operate using the numerical keypad on the keyboard.
“Multicam Editing by Shortcut Keys” (w page 317)
 f Before performing an operation, check the setting of [Multicam Switching]. In [Multicam Switching], you can specify the track(s) to be 
controlled with the camera switch point.
“Setting Track to be Controlled with Camera Switch Point” (w page 314)

1) Move the timeline cursor on the clip to switch the selected camera while the timeline is stopped.
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2) Click the camera video to set as the selected camera from among the camera videos of each track.

 f The clips of the selected camera are enabled, and others are disabled.

Example:

When switching the selected camera of the clip at the timeline cursor position from [C1] to [C3]
:00;00 00:00:05;00 00:00:10;00 00:00:15;00

:00;00 00:00:05;00 00:00:10;00 00:00:15;00
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2
 f When the timeline cursor is moved over the clip to switch the selected camera, and the camera video of each track currently displayed on 
the Recorder is double-clicked, the camera switch point can be set and the selected camera can be switched at the same time.

Multicam Editing by Shortcut Keys
You can set the camera switch point and selected the camera using the numeric keypad. When only the selected camera is displayed in the 
single mode, perform multicam editing using shortcut keys. The following shows shortcut key operations and camera numbers assigned to 
each key.

Camera No. Corresponding Numeric Keypad Operation
1 [1]
2 [2]
3 [3]
4 [4]
5 [5]
6 [6]
7 [7]
8 [8]
9 [9]
10 [Alt] + [0]
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Camera No. Corresponding Numeric Keypad Operation
11 [Alt] + [1]
12 [Alt] + [2]
13 [Alt] + [3]
14 [Alt] + [4]
15 [Alt] + [5]
16 [Alt] + [6]

Switching the Selected Camera Simultaneously with Setting of the Camera Switch Point

 f Before performing an operation, check the setting of [Multicam Switching]. In [Multicam Switching], you can specify the track(s) to be 
controlled with the camera switch point.
“Setting Track to be Controlled with Camera Switch Point” (w page 314)

1) Move the timeline cursor to the point to switch the camera.

2) Press the numeric keypad corresponding to the camera to switch to with [Ctrl] on the keyboard held 
down.

Switching the Selected Camera Simultaneously with Setting of the Camera Switch Point during 
Playback

1) Play back the timeline, and press the numeric keypad corresponding to the camera selected at the 
time of switching.

 f The camera switch point is set to the timeline cursor, and the camera video is switched.

Switching the Selected Camera

1) Move the timeline cursor over the clip to switch the selected camera.

2) Press the numeric keypad corresponding to the camera to switch to.

Playing Back around the Camera Switch Point
You can playback around a camera switch point to confirm the video. You can also confirm video in the same way by regular playback 
operation.

1) Click the [Play the Current Area] list button on the Recorder.

2) Click the playback method.

[Play around Cut Point] Play back around the camera switch point which is nearest and placed before the timeline 
cursor.

[Play around Cut Point (1 Sec)] Play back around for the specified length.
[Play around Cut Point (2 Sec)]
[Play around Cut Point (3 Sec)]
[Play around Cut Point - Show only 
Selected Camera]

Display only videos of the selected camera. Play back around the camera switch point which is 
nearest and placed before the timeline cursor.
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[Play around Cut Point (1 Sec) - Show 
only Selected Camera]

Display only videos of the selected camera. Play back around for the specified length.

[Play around Cut Point (2 Sec) - Show 
only Selected Camera]
[Play around Cut Point (3 Sec) - Show 
only Selected Camera]

 f You can repeatedly play back around the camera switch point.

2
 f You can set the preliminary operation time (Preroll) at [Preview] in [User Settings] → [Playback].
“[Playback]” (w page 118)

 f You cannot set the camera switch point while playing around a camera switch point. Set the camera switch point by regular playback 
operation.
“Setting the Camera Switch Point during Playback” (w page 315)

Copying Only the Selected Clips to Track
Group together the clips of the selected camera and copy them to one track.
Extract enabled clips from the track where the camera is assigned, and copy them to the specified track.
 f Switch the mode to the multicam mode in advance.
“Switching to the Multicam Mode” (w page 312)

1) Click [Mode] on the menu bar, and click [Compress to a Single Track].
 f The [Compress selected clips] dialog box appears.

2) Select the tracks to copy the selected clips from the [Select output track] list.
 f Check [Apply between In/Out] to acquire selected clips between In and Out points on the timeline.

3) Click [OK].
 f Selected clips are copied to the specified track. When other clips are already placed on the specified part, select whether to overwrite 
clips.

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

XXXX XXXX

XXXX XXXX

XXXX XXX XXX

XXXX XXXX XXXX XXX XXX

XXXX XXXX XXXX XXX

2
 f If multiple enabled clips are placed between the camera switch points, priority is given to the camera point with the larger number.
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Proxy Editing

Editing Using Proxy Files
In this mode, proxy data that has been optimized for editing, for example, by lowering image quality from the original high-resolution data is 
used. You can proceed with editing more effortlessly since the load placed on the CPU during editing can be lightened.
When only the proxy or source including the proxy has been checked out for checkout field editing, the project automatically opens in the 
proxy mode.
“Field Editing a Project” (w page 87)

2
 f From [System Settings] → [Application] → [Proxy], you can set the size of proxy files to be created at the time of checkout.
“[Proxy]” (w page 101)

Switching to the Proxy Mode

1) Click [Mode] on the menu bar, and click [Proxy Mode].
 f When the proxy mode is set to on, a check mark appears on the menu item, and “proxy mode” is displayed on the status bar of the 
timeline.

 f By default, when the mode is switched to the proxy mode, a proxy will be created for every clip used on the current project in the 
background. A proxy is named “clip name including extension.proxy.mov”, and is saved in the same directory as the source file.
Proxies are created using the Render Service.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f The setting to prevent a proxy from being automatically generated can be changed by [Application] in [User Settings] → [Proxy Mode].
“[Proxy Mode]” (w page 116)

 f In the proxy mode, clips reference the proxy. When the proxy has been moved to a different directory, the clip becomes an offline clip.

2
 f The default proxy mode setting is off.
 f If the proxy cannot be saved to the same directory as the source file when the proxy is generated, it will be saved to the “Transferred” 
folder under the project folder.

 f When the mode is switched to the proxy mode, clips that already have a proxy use that proxy and a new proxy is not generated.
 f The proxy mode can be simply switched to by displaying the [Proxy Mode] operation button on the timeline or mode bar.
“Operation Button Settings” (w page 147)

Creating Proxy Files
Create a proxy from clips (high-resolution) in the bin or on the timeline.

3 Note
 f Proxies of the following clips cannot be created:

 g Clips other than video clips
 g Still image clips
 g Title clips
 g Caption clips
 g Clips already containing a proxy
 g Clips with alpha channel
 g Partially transferred clips

2
 f A proxy file can be set to be automatically generated at capture. Set [Proxy File] to [Hires and Proxy files] at [Input H/W, Format Settings] 
in the device preset used for capture.
“[Input H/W, Format Settings] Screen” (w page 132)

1) Click [File] on the menu bar, and click [Create Proxy] → an item.
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2) Click [Yes].
 f The rendering job will be registered to the Render Service.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f A proxy is named “clip name including extension.proxy.mov”, and is saved in the same directory as the source file. Clips are set to 
reference proxies.

2
 f A proxy of any clip currently registered to the bin can be generated. Right-click the clip in the bin window, and click [Create Proxy]. The 
progress of generation of the proxy is displayed in the thumbnail of the proxy.

 f If the proxy cannot be saved to the same directory as the source file when the proxy is generated, it will be saved to the “Transferred” 
folder under the project folder.

Editing Using Camera Proxy Files
In EDIUS, original proxy files recorded in the P2 or XDCAM camera can be used. You can also utilize functions such as “Proxy originated 
editing” that allows to use an untransferred clip or temporary editing clip (proxy source) while editing and replace it with the actual editing 
clip (high-resolution source) before final export.

2
 f Formats that allow switching between high-resolution and proxy editing sources are as follows.

 g Sony: XDCAM, XAVC, XAVC S
 g Panasonic: P2

 f Formats that can be used in proxy originated editing are as follows.
 g Sony: XDCAM, XAVC, XAVC S
 g Panasonic: P2, sub-recording format by Panasonic cameras
 g Canon: XF-AVC, Cinema RAW Light

Editing Flow by Switching Between High-resolution and Proxy Sources

1) From the source browser, import sources (such as P2 or XDCAM) containing a proxy file.
 f High-resolution/Proxy is displayed in the area of High-resolution/Proxy of the bin, because sources have a property of a high-resolution 
and proxy.
“Importing P2 Sources” (w page 179)

2) Switch to the proxy mode and edit.
 f “Switching to the Proxy Mode” (w page 320)

3) Replace the proxy source with a high-resolution clip and export the edited clip.

Proxy Originated Editing Flow
The flow of proxy originated editing is as follows.

1) Import proxy sources.
 f Untransferred clips or temporary editing clips are registered in the bin.
 f “Importing Proxy Sources” (w page 321)

2) Edit the timeline using the untransferred clips or temporary editing clips.
 f “Editing Timeline” (w page 322)

3) Replace the untransferred clips or temporary editing clips with the actual editing clips.
 f “Replacing with the Actual Editing Clip” (w page 323)

Importing Proxy Sources

There are two methods to import proxy sources.
 f “Importing from Source Browser” (w page 322)
 f “Importing from [Open] Dialog Box” (w page 322)
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 r Importing from Source Browser

1) Connect media that contain proxy sources to the PC.

2) In the folder view of the source browser, click the medium to view, and then click on the drive or 
reference folder.

 f The operation differs depending on the medium.
“Importing Source Browser File by Copying” (w page 177)

 f Sources on the medium are displayed in the clip view.

3) Right-click on a proxy source clip to import, and click [Add and Transfer to Bin].
 f Data transfer to the PC will be started in the background at the same time that the clip is registered to the bin.
 f The clip will become an untransferred clip and will be recognized as a source that has only proxy data (not transferred to high-resolution 
data).

clip_XXXXX

P

(1)

(2)

(1) Icon for untransferred clips
(2) Icon that indicates proxy data

 r Importing from [Open] Dialog Box

1) Transfer proxy source files to the local disk on the explorer or other means.
 f The following files are recognized as proxy files.

 g P2: MOV and MP4 files in the “PROXY” folder
 g XDCAM: MXF files in the “Sub” folder
 g XAVC: MP4 files in the “Sub” folder
(MXF proxy files in the MPEG HD422 format cannot be handled as temporary editing clips.)

 g XAVC S: MP4 files in the “SUB” folder

2) Register the proxy source clips to the bin.
 f “Registering a File to the Bin as a Clip” (w page 172)
 f The clips will become temporary editing clips. Since they are recognized as high-resolution sources, the icon indicating proxy will not be 
displayed.

clip_XXXXX

(1)

(1) Icon for temporary editing clips

Editing Timeline

1) Place the imported untransferred clips or temporary editing clips on the timeline.
 f On the status bar of the timeline window, a message will appear to indicate that untransferred clips or temporary editing clips are used.

Example:

When imported from the source browser
The icon indicating untransferred clips is displayed with the number.

XXXX1
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Example:

When imported from the [Open] dialog box
The icon indicating temporary editing clips is displayed with the number.

XXXX1

Replacing with the Actual Editing Clip

Replace the untransferred clips or temporary editing clips with the actual editing clips as follows.
 f “Replacing Using [Transfer HiRes]” (w page 323)
 f “Replacing Using the [Restore and Transfer Clips] Dialog Box” (w page 323)
 f “Replacing Using the Source Browser” (w page 323)
 f “Replacing While Exporting (For Untransferred Clips)” (w page 324)
 f “Replacing While Exporting (For Temporary Editing Clips)” (w page 324)

 r Replacing Using [Transfer HiRes]
Replace untransferred clips in the bin individually to the actual editing clip.
 f This procedure is only available when proxy sources have been imported from the source browser.

1) Right-click a clip in the bin, and click [Transfer HiRes].
 f The [Disc Request - Background Job] dialog box appears.

2) Connect media that contain the actual editing clips to the PC.
 f Data transfer to the project folder is started in the background.
 f The clip in the bin now references the file transferred to the project folder.

 r Replacing Using the [Restore and Transfer Clips] Dialog Box
In the [Restore and Transfer Clips] dialog box, specify the actual editing clips for the untransferred or temporary editing clips and replace 
them individually.

1) Display the [Restore and Transfer Clips] dialog box.
 f “Restoring an Offline Clip” (w page 90)

2) Select a clip from [Clip list], and select either [Transfer HiRes] or [Relink (select file)] from the 
[Restoration Method] list.

 f Select [Transfer HiRes] for untransferred clips or select [Relink (select file)] for temporary editing clips.

3) In the [Open] dialog box, select the actual editing clip file, and click [Open].

4) Click [OK].
 f The [Restore and Transfer Clips] dialog box closes and the untransferred clips or temporary editing clips are replaced with the actual 
editing clips.

 r Replacing Using the Source Browser

1) Connect media that contain the actual editing clips to the PC.

2) In the folder view of the source browser, click the medium to view, and then click on the drive or 
reference folder.

 f The operation differs depending on the medium.
“Importing Source Browser File by Copying” (w page 177)

 f Sources on the medium are displayed in the clip view.

3) When the message is displayed indicating that the actual editing clip corresponded to the 
untransferred clip or the temporary editing clip is found, click [Yes].

 f The [Restore and Transfer Clips] dialog box appears with [Restoration Method] and [Restore file] preconfigured.
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4) Click [OK].
 f The [Restore and Transfer Clips] dialog box closes and the untransferred clips or temporary editing clips are replaced with the actual 
editing clips.

 r Replacing While Exporting (For Untransferred Clips)
The procedure for untransferred clips imported from the source browser is as follows.

1) Click [Export] on the Recorder.

2) Click [Print to File].
 f The [Print to File] dialog box appears.
“[Print to File] Dialog Box” (w page 430)

3) Select an exporter, and click [Export].

4) Configure export details and confirm the file name, saving destination, etc.
 f A message appears to indicate that temporary editing clips are used.

5) Click [Yes].
 f The [Restore and Transfer Clips] dialog box appears.

6) Click [OK].
 f The [Disc Request - Background Job] dialog box appears.

7) Connect media that contain the actual editing clips to the PC.
 f Data transfer to the project folder is started in the background.
 f Repeat step 7) as necessary.
When all untransferred clips have been replaced with the actual editing clips, the export operation starts automatically.

 r Replacing While Exporting (For Temporary Editing Clips)
The procedure for temporary editing clips imported from the[Open] dialog box is as follows.

1) Click [Export] on the Recorder.

2) Click [Print to File].
 f The [Print to File] dialog box appears.
“[Print to File] Dialog Box” (w page 430)

3) Select an exporter, and click [Export].

4) Configure export details and confirm the file name, saving destination, etc.
 f A message appears to indicate that temporary editing clips are used.

5) Click [Yes].
 f The [Restore and Transfer Clips] dialog box appears.

6) Select a clip from [Clip list], and select [Relink (select file)] from the [Restoration Method] list.

7) In the [Open] dialog box, select the actual editing clip file, and click [Open].

8) Repeat steps 6) to 7) as necessary to specify the actual editing clips to be restored.

9) Click [OK].
 f The [Restore and Transfer Clips] dialog box closes and the temporary editing clips are replaced with the actual editing clips. The export 
operation starts automatically.
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3D Editing

About the Stereoscopic Edit Mode
In the stereoscopic edit mode, stereoscopic processed video can be output to the monitor, and stereoscopic clips can be edited and 
exported to file by the exporter for stereoscopic editing.

2
 f Stereoscopic clips that can be edited by EDIUS are as follows:

 g 3DA1 (Panasonic)
 g MVC (Sony, Panasonic, JVC)
 g 3D P2 (Panasonic)
 g 3D clips taken by a 3D conversion lens, for example

Notes on Stereoscopic Editing
Inadequate 3D video may affect the health of viewers, so take care of output results.
According to 3D Consortium “3DC Safety Guidelines”, it is recommended to avoid the situation where the disparity on the display exceeds 
the distance between the right and left eyes (50 mm for children).
In Hollywood 3D movies, the comfortable range of disparity should be shorter than approximately 2% of the screen horizontal width.
For details of safe and comfortable 3D contents creation, see 3D Consortium “3DC Safety Guidelines” (English).
 f http://www.3dc.gr.jp/english/index.html

For commercial use, inquire about supply standards to clients.

Stereoscopic Edit Workflow
The following explains the stereoscopic edit workflow.

1) Set [Stereoscopic Editing] to [ON] in the [Project Settings] (Detailed Settings) dialog box.
 f “Creating a New Project (Detailed Settings)” (w page 58)
 f “Creating a New Project after Start-up” (w page 65)
 f “Changing the Project Setting (Detailed Settings)” (w page 67)
 f [Stereoscopic Editing] is displayed on the status bar. The stereoscopic edit mode is set.

2) Set a preview window or preview device.
 f “Setting External Device Used for Preview” (w page 143)
 f “Displaying Preview Window in Stereoscopic Edit Mode” (w page 153)

3) Import stereoscopic sources.
 f “Capture of Stereoscopic Sources (L/R Separate Capture)” (w page 164)
 f “Importing Stereoscopic Sources” (w page 182)

4) If necessary, set separate clips of the L side (for left eye) and the R side (for right eye) as 
stereoscopic.

 f “Creating Stereoscopic Clip” (w page 200)

5) Adjust video drift in stereoscopic clips.
 f “Stereoscopic Adjustment” (w page 357)
 f “Applying Video Filters to L or R Side Only” (w page 379)

6) Export the project.
 f “Exporting Stereoscopic Project” (w page 448)
 f “Exporting Stereoscopic Projects to Tape” (w page 461)
 f “Exporting to Disc” (w page 455)

2
 f When the stereoscopic edit mode has been switched to the standard mode, only the L side video of stereoscopic clips is output to the 
monitor.
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 f When the stereoscopic edit mode has been switched to the standard mode, only the L side of the effects applied to the stereoscopic clip 
are applied. Effects applied to only the R side are invalid.
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Undoing Operations/Redoing Undone 
Operations

Undoing Operations (Undo)
You can undo the performed operations, or return to the previous status.

1) Click [Undo] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

 f Executed operations are undone, and the timeline cursor and the In and Out points return to their original positions.

1 Alternative
 f Undoing operations: [Ctrl] + [Z]

2
 f Click the [Undo] list button to display a history of operations executed so far, and select the operation to undo. This history is saved for 
each individual sequence.

 f Though the number of undos is basically unlimited, the history will be deleted starting with the oldest record if the system runs out of 
memory.

3 Note
 f Operations and settings in the bin window cannot be undone.

Redoing Canceled Operations (Redo)
You can redo canceled operations that have been executed by undo.

1) Click [Redo] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

 f Executed operations are undone, and the timeline cursor and In and Out points are repositioned.

1 Alternative
 f Redoing canceled operation: [Ctrl] + [Y], [Shift] + [Ctrl] + [Z]

2
 f Click the [Redo] list button to display a history of operations undone so far, and select an operation to redo. This history is saved for each 
individual sequence.
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Checking Color

Checking Color Data
Even a video finely displayed on a PC monitor may cause problems like highlight/shadow detail loss when actually displayed on a TV 
monitor. Although the best solution is to edit the video while checking an environment where the final video is screened or confirming the 
screening rules, in many cases, editing must be performed without such environment and rules. In such cases, use the vector scope, 
waveform or histogram to check the brightness and colors of the image displayed in the preview window, and perform the editing process.

[Videoscope]
Vector scope, waveform and histogram can be used to monitor the brightness and colors, allowing fine adjustment of detailed parts that 
cannot be seen by eyes.

Example:

To check recorder image

1) Move the timeline cursor to display the image to check the color data on Recorder.

2) Click [Toggle Videoscope Display] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

 f The [Videoscope] dialog box appears.
“[Videoscope] Dialog Box” (w page 328)

1 Alternative
 f Click [View] on the menu bar, and click [Videoscope].

3 Note
 f Displaying vector scope/waveform/histogram increases the CPU loading. Display them only when required.

[Videoscope] Dialog Box

The following screenshot is an example of the [Videoscope] dialog box divided into four windows.
 f The conventional analog-based design was changed into a digital-based design.
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 f The conventional [Line] function of [Vector Scope/Waveform] was discontinued.

X 

- XXXXXX 
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XX 

XXX.XX 
XXX.XX 
XXX.XX 

XX.XX 
nits XX.XX 

XX 

XX 

Videoscope

Line Select

Cursor

Vectorscope Scale ScaleInten Waveform Inten

Histogram Scale ScaleGain Waveform Inten

(1) (2) (3) (4) (5) (6) (7) (8)

(9)

(13)

(10)

(11)

(12)

(1) Videoscope switching Switch the view between vector scope/waveform/histogram.
(2) View mode Set the display color and zoom ratio of the vector scope, waveform mode (Y/YCbCr/RGB), and 

display color (Y only).
 f Not available for histogram.

(3) [Inten]/[Gain] Adjust the luminance of the vector scope/waveform, and the gain of histogram.
(4) [Scale] Adjust the brightness of the scale.
(5) Vector scope Display the color distribution of the image displayed on the preview window. The circle 

represents the color circle, and the distance from the center represents the saturation.
(6) Showing/hiding sidebar Switch show/hide of the sidebar that has information area or other items including [Line Select].
(7) Display view Switch the display view between vector scope/waveform/histogram.
(8) Waveform Display chroma and luminance levels of the image on the preview window.
(9) Information area Display coordinate values on the screen (X, Y), as well as values of IRE, nits, YCbCr, and 

RGB.
(10) [Line Select] Display the information of a Y-axis (vertical) position. Check this item, click , and then click a 

position on the preview window. You can also directly enter the scanning line.
The box shows the Y coordinate value of that position, and the display of the vector scope/
waveform/histogram are fixed to the color data of that position.
Even after you uncheck the item, the last display of the vector scope/waveform/histogram is 
reproduced when you check the item box again.

(11) [Cursor] Add a line with desired luminance level to the waveform and histogram.
Select the check box and directly enter the luminance level (unit: nits). An yellow dashed line 
appears.

(12) L/R switch In the stereoscopic edit mode, this is displayed when the video of both the L and R sides are 
displayed in the preview window. The vector scope/waveform/histogram only on the L or R side 
is displayed.

(13) Histogram Show the brightness distribution of the image displayed on the preview window by RGB. The 
horizontal axis indicates brightness, and the vertical axis indicates the number of pixels by 
color brightness.

Example:

Measure the color balance using a vector scope
Measure the color bar recorded in the source clip using the [Videoscope] dialog box.
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For 75% color bar, if the dot indicating color distribution is largely away from the center of  with [Zoom 100%] display mode setting, the 
setting may not be appropriate. Check the setting.

Example:

Measure the luminance with waveform to check if it is within the appropriate range
 f The graduation on the left of the scale (%) indicates the value of IRE. The graduation on the right of the scale (nits) indicates the value of 
luminance level.

When you place a white color matte clip created in the safe color range on the timeline and measure it in the [Videoscope] dialog box, 
IRE100 appears. (The position of (1))
“Color Matte Clips” (w page 198)
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In the case of black color matte clips created in the safe color range, IRE0 appears. (at the position of (2)) Adjustment is not necessary 
when IRE is a minus value.
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If the luminance is high, the following screen is displayed.

If the luminance is low, the following screen is displayed.

If IRE needs to be restricted in a range 0% to 100%, see “Video Signal Level Restriction”.
“Video Signal Level Restriction” (w page 471)

Example:

Measure and check if the brightness distribution is appropriate using the histogram
 f The graduation under the scale indicates the value of IRE.

Pixels distributed widely without right and left unevenness indicates appropriate brightness.

Pixels are concentrated to the left or right if highlight/shadow detail loss occurs.
Following illustration shows that the pixels are concentrated to the left and shadow detail loss occurs.
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GV Job Monitor
In EDIUS, processes such as file export are registered to the Render Service as rendering jobs. Rendering jobs registered to the Render 
Service are processed in a sequential order of the predetermined priority. By using the Render Service, you can continue other editing work 
on EDIUS while rendering jobs are being processed.
On GV Job Monitor, you can check the progress or status of those rendering processes, or you can cancel rendering jobs.
The following processes are registered to the Render Service as rendering jobs.
 f Export of file
 f Batch export
 f Partial rendering
 f Clip rendering
 f Generation of wave information (waveform representation of audio)
 f Creation of proxy files

2
 f The priority of rendering process is determined by the order of registration to the Render Service or the stage of [Priority]. If multiple 
rendering jobs have the same stage of [Priority], the one registered to the Render Service earlier will be prioritized.
However, the following rendering jobs will be prioritized regardless of the order of registration to the Render Service or the stage of 
[Priority]. When the following rendering jobs are registered to the Render Service, processes of other rendering jobs will be paused.
 g Partial rendering
 g Clip rendering
 g Generation of wave information (waveform representation of audio)
 g Creation of proxy files

3 Note
 f For file conversion in the bin, the conventional rendering method will be applied.
 f When a heavy-load editing work is performed on EDIUS, rendering jobs may be paused temporarily.

Starting up and Exiting GV Job Monitor

Starting up GV Job Monitor

1) Click [Tools] on the menu bar, and click [GV Job Monitor].
 f GV Job Monitor will start up.
“GV Job Monitor Screen Configuration” (w page 333)

1 Alternative
 f Double-click the GV Job Monitor icon on the status bar.

 r GV Job Monitor Icon Indication
The GV Job Monitor icon is constantly displayed on the status bar of the timeline window.

XXXXXXXX

 f Double-clicking the icon will start GV Job Monitor.
 f The icon color turns to purple while a file is being exported or a batch export rendering job is being processed. When the process has 
been completed, the icon color returns to its original state.

Exiting GV Job Monitor

1) Click [File] on the GV Job Monitor menu bar, and click [Exit].

1 Alternative
 f Right-click the GV Job Monitor icon on the task bar, and click [Exit GV Job Monitor].
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GV Job Monitor Screen Configuration
On GV Job Monitor, you can check the progress of rendering processes, or you can cancel rendering jobs.
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(1) (2) (3) (4) (5) (6) (7) (8)

(9)

(10)

(11)

(12)

(1) GV Job Monitor menu 
bar

Perform general operations for GV Job Monitor.

(2) [Restart] Resume the job selected on the job list.
(3) [Pause] Pause the job selected on the job list.
(4) [Stop] Stop the job selected on the job list.
(5) [Cancel] Cancel the job selected on the job list. The canceled job will be moved to the list of completed 

jobs.
(6) [Properties] Display the properties of the job selected on the job list or list of completed jobs.
(7) [Job priority up]/[Job 

priority down]
Move up the [Priority] of the job selected on the job list. For [Priority], three stages of [High], 
[Normal] and [Low] can be set.

(8) [Settings] Set [Error notification] and [View].
“[Settings] Dialog Box” (w page 333)

(9) Job list Display the active job and jobs in standby status.
The remaining time of the process and the progress status can be viewed.
 f Right-clicking on a job displays a menu with which you can perform operations in the same 
way as the GV Job Monitor menu bar.

(10) [Error]/[Info] Set the details to be displayed on the list of completed jobs.
Check [Error] to display jobs on which errors occurred.
Check [Info] to display successfully rendered jobs and canceled jobs.

(11) List of completed jobs Display the history of executed jobs.
The history is maintained for 7 days.

: Succeeded rendering job
: Job on which an error occurred
: Canceled job

 f Right-clicking on a job displays a menu with which you can display a file of processed job on 
the Player or add the file to the bin. The menu is available only when EDIUS is running. Jobs 
that have the right-click menu are file export, batch export and proxy file generation jobs.

(12) [Search] Enter keywords to refine the search on the list of completed jobs.

2
 f You can change the display window size of the job list and the list of completed jobs.
Move the mouse cursor onto the two-lined slider at the border between the job list and the list of completed jobs. When the shape of the 
cursor changes, drag upward or downward.

[Settings] Dialog Box

[Error notification]
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[Error notification setting] Select the error to be notified.
 f The error notification will be indicated in accordance with the setting of your Windows.

[Notify errors of all jobs]
All errors are notified.
When the error occurs, a notification appears on the PC screen.
[No error notification]
Errors are not notified.

[View]

[Job List] Select jobs to be displayed on the job list and the list of completed jobs.
[All]
All jobs are displayed.
[Export/Batch Export]
Only file export and batch export jobs are displayed.
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Chapter 8
Effect
This chapter explains how to apply various effects, including filters and transitions.
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[Effect] Palette

Effect
The [Effect] palette lists the effects you can use.

Showing/Hiding [Effect] Palette
You can show or hide the [Effect] palette.

1) Click [Toggle Palette Display] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

2) Click [Effect].
 f The [Effect] palette appears.
“[Effect] Palette” (w page 336)

1 Alternative
 f Click [View] on the menu bar, and click [Palette] → [Effect].
 f The [Effect], [Information] and [Marker] palettes can be shown/hidden by clicking [View] on the menu bar and clicking [Palette] → [Show 
All] or [Hide All].

 f Showing/hiding palette: [H]
“Showing/Hiding [Effect] Palette” (w page 336)
“Displaying the [Clip Marker] List” (w page 279)
“Displaying the [Sequence Marker] List” (w page 285)

2
 f If you toggle the [Effect] palette display, all of the bin window, source browser window, and palette tab associated to the [Effect] palette 
toggle their display accordingly. To toggle the show/hide setting individually, release the association of the window and the palette.
“Combining Bin Window/Source Browser Window with a Palette” (w page 145)

[Effect] Palette
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(1) [Hide Effect View] Click this button to display the folder view only.
(2) [Move up one folder] Display the folder in the upper level than the one selected in the folder view.
(3) [Folder Link] Set up the effect folders frequently used to open these folders quickly.

“Folder Shortcuts” (w page 385)
(4) [Add to Timeline] Add the selected effect to a clip on the timeline. Click the [Add to Timeline] list button and you 

can also select the position to add.
(5) [Delete] Delete the user preset effect.

“Deleting Effects from [Effect] Palette” (w page 383)
(6) [Property] Display the contents of the selected effect.

“Properties of Effects” (w page 338)
(7) [View] Each click changes the display. Click the [View] list button to select the display method.
(8) [lock] Lock the effect folder to prevent the folder structure from being changed.

“Folder Structure of [Effect] Palette” (w page 384)
(9) Folder view Display the effect folder in tree structure.
(10) Effect view Display the contents of effects in the selected folder. Select the effect with animation to display 

with animation.

Showing/Hiding Effect View

You can show or hide the effect view.

1) Click [Hide Effect View] in the [Effect] palette.
 f The effect view is hidden.

Effect Types
There are 4 available effects.

Plug-in Base Effect

Base effects initially stored which cannot be deleted from the [Effect] palette. Plug-in base effects include video filter, audio filter, transition, 
audio cross fade, title mixer, and key.

System Preset Effect

These are initially stored and customized plug-in base effects. You cannot delete them from the [Effect] palette. “S” is displayed on their 
icons.

User Preset Effect

Effects registered by the user. These effects can be customized (by adjusting the parameters, combining multiple effects, or renaming) and 
saved. “U” is displayed on their icons.
“Registering Effects to [Effect] Palette” (w page 383)

Default Effect

Effects used in the default setting. You can set these effects only for transition, audio cross fade, and title mixer.
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“Changing Default Effects” (w page 366)

Properties of Effects
You can check the effect with animation. You can also change the property of user preset effects.

1) Select an effect and click [Property] in the [Effect] palette.

 f The [Property] dialog box appears.

1 Alternative
 f Right-click the effect and click [Property].

2
 f You can check the transitions in animation by selecting an effect in the effect view.
 f You can change the property of user preset effects. You can only edit the user preset effects. (Application of effects to the L or R sides 
cannot be changed.)

How to Apply Effects
Simply drag and drop an effect on the [Effect] palette to the clip on the timeline to apply the effect. The following procedure explains how to 
apply video filter as an example. Transitions and keyers can be applied in the same way.

Example:

To select from [VideoFilters]

1) Click the [Effect] tab and display the [Effect] palette.

2) In the folder view of the [Effect] palette, click the [Effect] tree, and click [VideoFilters].
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3) Drag and drop the effect to be applied onto a clip (video part) on the timeline.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00

Untitled
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Clips with video filter applied are displayed with an orange line.

3 Note
 f Drag and drop the video filter to the video part of a clip on the V/VA track, and drag and drop the transition to the part where a clip 
shifts to another or the mixer part of In/Out point of a clip.

 f Drag and drop the audio filter to the audio part of a clip on the A/VA track, and drag and drop the audio cross fade to the audio part 
where a clip shifts to another.

 f Drag and drop the title mixer to the mixer part of the In/Out point of a clip on the T track.
 f Drag and drop the keyer to the mixer part of a clip on the V/VA track.

1 Alternative
 f Right-click on an effect in the [Effect] palette, and click [Add to Timeline].
 f While the effect view is displayed, select a clip or mixer part on the timeline, select an effect in the [Effect] palette, and click [Add to 
Timeline] in the effect view. For some effects, you can click the [Add to Timeline] list button to specify [In], [Out], and [Both].

 f Select a clip or mixer on the timeline, and drag an effect from the [Effect] palette and drop it onto the [Information] palette. Some effects 
cannot be applied.

2
 f When applying a clip transition or audio cross fade, you can specify the position to apply, including [In], [Out] and [Both], as well as 
[From], [Center] and [To] for each effect.

 f Click the list button of [View] in the [Effect] palette to select the display method of the effect view.

Placing the mouse cursor over an effect in the effect view displays simple description of the effect.

How to Adjust Effects
Adjust effects applied on clips on the timeline from the [Information] palette.
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1) Click the part of a clip where effects are applied on the timeline.
 f The applied effects are displayed in the effect list on the [Information] palette.

2) Click on the name of the effect to be adjusted on the [Information] palette, and click [Open Setup 
Dialog].

 f The dialog box for effect detailed settings appears.

1 Alternative
 f Double-click on an effect name in the [Information] palette.

2
 f Unchecking the check box at the left of the effect name temporarily disables the applied effect.

3) Adjust or set each item.
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Setting Effects

Adjusting Color/Brightness (Color Correction)
You can adjust the color tone to match the previous/next video, or adjust the brightness by correcting color cast, highlight detail loss, and 
shadow detail loss. The following filters are provided for color correction.

 r [3-Way Color Correction]
Correct colors for shadow (black), intermediate (gray), and highlight (white).
“Adjusting 3-Way Color Correction” (w page 342)

 r [YUV Curve]
Adjust luminance (Y), blue color difference (U), and red color difference (V) on the chart. You can make a fine adjustment to balance the 
shadow and highlight.
Keys can be added for the YUV curve but interpolation animation between keys is not available.
“Adjusting the YUV Curve” (w page 343)

 r [Color Balance]
Adjust chroma, luminance, contrast, and color tone with the slider.
“Adjusting Color Balance” (w page 345)

 r [Color Wheel]
Move the pointer to adjust the color density, or rotate the wheel to adjust the color tone.
“Adjusting Color Wheel” (w page 346)

 r [Monotone]
Make the video monotone.
“Adjusting Monotone” (w page 347)

 r [Primary Color Correction]
Adjust the brightness and color by applying color grading on a clip shot in the Log format.
“Adjusting Primary Color Correction” (w page 348)

1) In the folder view of the [Effect] palette, click the [VideoFilters] tree.

2) Click the [Color Correction] tree to display filters.

3) Drag and drop the filter to use to the clip on the timeline.
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1 Alternative
 f Select the clip on the timeline, right-click the filter in the [Effect] palette, and click [Add to Timeline].
 f Right-drag an effect and drop it to the clip, and click [Add] or [Replace].
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Adjusting 3-Way Color Correction

1) Display the [Information] palette, and double-click [3-Way Color Correction].
 f “Checking/Adjusting Effects” (w page 378)
 f The [3-Way Color Correction] dialog box appears.
“[3-Way Color Correction] Dialog Box” (w page 342)

2) Adjust the balance of each color and click [OK].

3 Note
 f Colors appear differently depending on the monitor. Therefore, when exact color adjustment is necessary, output the video to the 
monitor on which the final video is screened.

 f If the completed video is broadcasted on TV, adjust the colors within the range of the regulations.
 f If you check [Safe Color] in [Color Balance] or [Color Wheel] of color correction, the upper or lower limit of brightness and color can be 
adjusted within a certain range.

[3-Way Color Correction] Dialog Box

(1) [Black Balance]/
[Gray Balance]/[White 
Balance]

Drag a point in each color to correct colors for shadow (black balance), intermediate (gray 
balance), and highlight (white balance).
Drag the point of color wheel to adjust the hue, or move the slider to adjust saturation and 
contrast.

(2) [Limit] Correct colors in the specified range.
Check [Hue], [Saturation], and [Luminance] to specify the range to adjust. You can set the 
effect range by entering a value directly in each field or dragging the triangle slider, or grating/
slant parts.

A

B C
A: Range to apply 100% adjustment
B: Range where you increase the adjustment volume gradually
C: Range where you decrease the adjustment volume gradually
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(3) [Key display] View which range is applied with the effects by setting [Limit]. The area with the effects applied 
100% is displayed in white; 0% in black.

(4) [Histogram display] Display a calculated histogram for each of hue, saturation, and luminance.
(5) [ColorPicker] Select a color from the displayed image on the Player or the Recorder.
(6) Preview setting “Preview setting” (w page 344)
(7) Key frame setting “Key frame setting” (w page 345)
(8) [Default] Click [Default] in each balance frame to reset only the parameters related to that balance to 

their default values.
Click [Default] at the bottom of the window to delete all the keys and reset the parameters to 
their default values.

Adjusting Colors Entirely

1) Display the [Information] palette, and double-click [3-Way Color Correction].
 f The [3-Way Color Correction] dialog box appears.
“[3-Way Color Correction] Dialog Box” (w page 342)

2) Click the color to correct from Color Picker.
 f When you click [Black], an adjustment is made so that the color obtained in the color picker should be black. Similarly, an adjustment is 
made so that it should be gray or white when you select [Gray] or [White], respectively.

 f If you click [Auto], the color is determined based on the brightness of the obtained color. For example, the color is adjusted for white when 
a bright color is obtained.

3) Click the part to correct in Recorder.
 f The color is automatically corrected. You can also adjust the color by using the color wheel point, or the sliders of saturation and contrast.

Example:

When correcting a color-casted white table
Click [White] in Color Picker, and click a point on the table in the image.

Correcting Only One Part

You can define the range to apply the correction, when adjusting the color tone of skin.

1) Display the [Information] palette, and double-click [3-Way Color Correction].
 f The [3-Way Color Correction] dialog box appears.
“[3-Way Color Correction] Dialog Box” (w page 342)

2) Click [Color range] in Color Picker.

3) Click the part to correct in Recorder.
 f Click additional points with [Shift] on the keyboard held down to include the color of the points to the currently specified range.

4) Correct the color.

Adjusting the YUV Curve

1) Display the [Information] palette, and double-click [YUV Curve].
 f “Checking/Adjusting Effects” (w page 378)
 f The [YUV Curve] dialog box appears.
“[YUV Curve] Dialog Box” (w page 344)

2) Adjust the YUV curve and click [OK].
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[YUV Curve] Dialog Box

(1) YUV curve Drag the line on each chart to adjust Y, U, and V. The value on the bottom left of the Y curve 
indicates the input value and output value.

(2) [Spline]/[Linear] Select the line of the chart (curve or straight).
(3) [Default] Click [Default] of each chart to restore the defaults for each Y, U, and V value and add them as 

the keys.
Click [Default] at the bottom of the window to delete all the keys and reset the chart to its initial 
values.

(4) [Safe Color] Check this item to make an automatic adjustment to keep the video signal within the YUV color 
space.

(5) Preview setting “Preview setting” (w page 344)
(6) Key frame setting Adjust the YUV curve chart for each key frame. The field option for the key will be [Hold], and 

no change along the time axis is allowed.
For how to set a key frame, see “Key frame setting”.
“Key frame setting” (w page 345)

2
 f Although Safe Color clips a range of luminance 16-235 and chroma 16-240, and the chroma is not automatically included in the safe area, 
it is calculated to include luminance/chroma within IRE0-100.

Common Settings in Color Correction

 r Preview setting
You can lay and compare the image applied color correction and the original image.

(1) [Use current screen to 
show filter effect]

Fix the screen with the timeline cursor position when comparing filter effects.

(2) Check the filter effects Set the segmentation of the screen when checking the result of the filter.
(3) Filter apply screen ratio Set the screen ratio to display the video with the filter applied when comparing the result of the 

filter.
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 r Key frame setting
You can change the parameters of color correction along the time axis, and play it to check the result.

(1) Time scale slider Drag the slider to the left and right to adjust the time scale display unit. Move the slider to the 
left to reduce the display unit, or to the right to increase it. The right end is [Fit].

(2) Playback/Tool buttons  : Play back the timeline on the Recorder.
 : Repeatedly play back the clip currently being edited.
 : Undo an operation.
[Ctrl] + [Z]
 : Redo the undone operation.
[Ctrl] + [Y]
 : Switch the changes of each parameter to the chart view. In the chart view, the timeline is 
represented by a chart display of the selected key. The parameters can be edited by moving 
the keys up and down.
The numerical values and gradations of the Y axis can be changed by entering numerical 
values.

-60.0

60.0
0.0

(3) Time scale for key 
frame

Display a scale with the unit selected in the time scale setting on the timeline.
Right-click the time scale and click [Timeline Timecode] to display the timecode of the timeline 
or click [Zero base Timecode] to display the timecode with the beginning of the clip as 0.
If a sequence marker is set for the position where the clip is placed, right-click the time scale 
and click [Go to Previous Sequence Marker] or [Go To Next Sequence marker] to move the 
timeline cursor to the previous or next sequence marker.

(4) Time scale settings Click here to toggle the specified display unit and [Fit].
Click the left arrow to reduce the display unit, or click the right arrow to increase the display 
unit.

(5) Expand button Click this button to configure detailed settings for each item.
You can edit the parameters by moving the cursor to a value input or control and dragging it 
when the mouse cursor shape changes.

(6) Enable/Disable Unchecking the item disables the parameter settings. To configure a key frame, check the 
effect name.

(7) [Add Default Key] Click this item to set the default key frames of each parameter item at the timeline cursor 
position.

(8) Key frame setting Click  in the center to set a key frame on the position of the timeline cursor. If the timeline 
cursor is on the key frame, the key will be deleted.
Click the left and right arrow to move to the previous and next key frame.

(9) Key frame timeline Automatically add a key frame when you edit an effect at the timeline cursor.
If you expand each parameter item, you can edit the parameter by dragging key upward or 
downward.

2
 f Right-click the timeline for key or key frame to display a menu to add/delete keys or switch the method of interpolation between key 
frames. You can select the interpolation method from [Hold], [Line], and [Bezier].

 f When the item name of a parameter is right-clicked and [Clear parameter of (item)] is clicked, all key frames for that item are deleted.
 f When [Shift] + [V] on the keyboard are pressed, a key frame is added to all parameters with a valid key frame setting at the timeline 
cursor position.

 f When [V] on the keyboard is pressed, a key frame is added to the currently selected parameter at the timeline cursor position.

Adjusting Color Balance

1) Display the [Information] palette, and double-click [Color Balance].
 f “Checking/Adjusting Effects” (w page 378)
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 f The [Color Balance] dialog box appears.
“[Color Balance] Dialog Box” (w page 346)

2) Adjust the color balance and click [OK].

[Color Balance] Dialog Box

(1) Sliders Move the slider to adjust each item.
(2) [Safe Color] Check this item to make an automatic adjustment to keep the video signal within the YUV color 

space.
(3) Preview setting “Preview setting” (w page 344)
(4) Key frame setting “Key frame setting” (w page 345)
(5) [Default] Click this button to restore the default settings for all the sliders.

2
 f Although Safe Color clips a range of luminance 16-235 and chroma 16-240, and the chroma is not automatically included in the safe area, 
it is calculated to include luminance/chroma within IRE0-100.

Adjusting Color Wheel

1) Display the [Information] palette, and double-click [Color Wheel].
 f “Checking/Adjusting Effects” (w page 378)
 f The [Color Wheel] dialog box appears.
“[Color Wheel] Dialog Box” (w page 347)

2) Adjust the color wheel and click [OK].
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[Color Wheel] Dialog Box

(1) Color wheel point Slide this point to adjust the color density (chroma). Chroma increases as the point moves to 
the outline of the circle.

(2) Wheel Drag and rotate it to adjust the color tone.
(3) [Bright]/[Contrast] Adjust the luminance and contrast by moving the sliders.
(4) [Safe Color] Check this item to make an automatic adjustment to keep the video signal within the YUV color 

space.
(5) Preview setting “Preview setting” (w page 344)
(6) Key frame setting “Key frame setting” (w page 345)
(7) [Default] Click this button to delete all the keys and restore the default settings for the wheel and color 

wheel point.

2
 f Although Safe Color clips a range of luminance 16-235 and chroma 16-240, and the chroma is not automatically included in the safe area, 
it is calculated to include luminance/chroma within IRE0-100.

Adjusting Monotone

1) Display the [Information] palette, and double-click [Monotone].
 f “Checking/Adjusting Effects” (w page 378)
 f The [Monotone] dialog box appears.
“[Monotone] Dialog Box” (w page 348)

2) Adjust the monotone and click [OK].
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[Monotone] Dialog Box

(1) Sliders Adjust the color tone by moving the slider.
(2) Key frame setting “Key frame setting” (w page 345)

Adjusting Primary Color Correction
You can adjust the brightness and color by applying color grading on a clip shot in the Log format.
[Primary Color Correction] has predefined color space profiles that support Log formats for each of the camera manufacturers.
When a clip is recognized by its metadata as a Log file, [Primary Color Correction] filter will automatically select an optimal color space and 
adjust the brightness and colors.
You can also select the color space manually.
Alternatively, you can register LUT files (*.cube) to [Primary Color Correction] and apply to clips.
You can obtain preferred brightness and colors by fine adjusting the parameters.
“What is Log?” (w page 348)
“What is LUT?” (w page 348)

3 Note
 f Some Log formats may not be supported.
 f Some LUT files may not be supported.

 r What is Log?
Log is a shooting format that can maintain wide dynamic range.
For videos shot in the Log format, color grading is essential. By performing color grading on a shot video with lower contrast, wider color 
tone range can be realized to reproduce realistic images that are closer to what it actually looks like.
Even under conditions where highlight/shadow detail loss is likely to occur, shooting in the Log format will help in correcting the details later 
without deteriorating the image quality.
“Reproducing Clouds Where Highlight Detail Loss Has Occurred” (w page 352)
“Adjusting the Brightness of a Person Where Shadow Detail Loss Has Occurred Due to Backlight” (w page 352)

 r What is LUT?
LUT (Look Up Table) is a standard profile for color space conversion. You can apply it to adjust the brightness and color on video shot in the 
Log format.

Adjusting with [Primary Color Correction]

Example:

To adjust the brightness and colors of a source shot in the Log format (S-Log source)

 r Preparation
 f Create a project (QFHD 3840x2160 29.97p, 10-bit).
 f Import the S-Log source file in the source browser, register it to the bin, and place the clip on the timeline.

1) In the folder view of the [Effect] palette, click the [Effect] tree.
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2) Click the [VideoFilters] tree, and click [Color Correction].

 f A list of [Color Correction] effects is displayed in the effect view.

3) Drag and drop [Primary Color Correction] to the clip (video part) on the timeline.
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 f Clips with the [Primary Color Correction] effect applied (video part) are displayed with an orange line.
 f When a clip is recognized as a Log file, an optimal color space will be applied automatically to adjust the brightness and color. You can 
view the result of the applied color space in the preview window.

 f If a color space has not been applied automatically, you can open the [Primary Color Correction] dialog box to apply a color space 
manually. To apply a color space manually or finely adjust the brightness and colors, proceed to step 4).

4) Display the [Information] palette, and double-click [Primary Color Correction].

 f The [Primary Color Correction] dialog box appears.
“[Primary Color Correction] Dialog Box” (w page 350)

5) Click the list button of [Source] in [Color Space] and select a color space that is optimal for the 
source shot in the Log format.

 f If the color space was selected automatically, this operation is not necessary.

6) While viewing the video in the preview window, make fine adjustment to the parameters.

7) Click [OK].
 f The [Primary Color Correction] dialog box is closed.

2
 f If real time playback is not possible after [Primary Color Correction] is applied, using the Draft Preview mode is helpful.
“Draft Preview” (w page 302)
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 r [Primary Color Correction] Dialog Box
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(1) [Color Space] [Source]
Select a color space to apply to the clip.
[Destination/LUT]
Select a color space or LUT to apply when exporting.
Click [LUT Settings] on the right of [Destination/LUT] to display the [LUT Settings] dialog box. 
Configure settings of LUT, such as registering/unregistering LUT.
“Registering LUT” (w page 353)
[Base]
Enable settings for color space conversion format.
 f If [Display light] is selected
This conversion format does not change the tone of video displayed on the display after 
conversion. [Display light] is set by default.

 f If [Scene light] is selected
This conversion format has been used for Version 8.32 or older. It applies the tone specific to 
the color space selected for [Destination/LUT] to the video.

[HDR/SDR Gain]
Set the gain value to be applied when the color space of either HDR or SDR is converted to/
from the other.
In some conditions, the brightness of the reference white of HDR may differ from that of SDR. 
In this case, a video converted from HDR to SDR will appear brighter, and that converted from 
SDR to HDR will appear darker.
Setting [HDR/SDR Gain] will apply the gain value when the color space of either HDR or SDR 
is converted to/from the other, preventing the variation in brightness.
Set the gain value to the conversion value for the display light. Select an item from [Disable], 
[Current project setting], [0.00 dB], [3.00 dB], [6.00 dB], [6.15 dB], [9.00 dB] and [12.00 dB]. 
Select [6.15 dB] to comply with ITU-R BT.2408.
The content in [Current project setting] will be determined in accordance with the [HDR/SDR 
gain] setting in the project settings.
You can also directly enter a value (unit: dB) within a range from “0.00” to “20.00”.
 f [Current project setting] is set by default.
 f If LUT is selected for [Destination/LUT], this setting will not be applied.
 f For details on [HDR/SDR gain], the information will be released in the FAQ on our website.
“Our Website” (w page 494)

[Tone mapping]
This setting is applied to conversion in which the dynamic range of the color space gets 
smaller, such as when a HDR source is used as SDR.
Setting [Disable] will not apply the tone mapping. Areas with brightness that exceeds the 
luminance range of SDR will be replaced to 100% white. Setting [Soft Clip] will compress the 
high-luminance areas to show smooth gradation so that they will not be clipped easily.
The content in [Current project setting] will be determined in accordance with the [Tone 
mapping] setting in the project settings.
 f [Current project setting] is set by default.
 f If LUT is selected for [Destination/LUT], this setting will not be applied.

(2) [Exposure] Adjusts the brightness.
Increasing or decreasing the numeric value by 25 will increase or decrease the brightness 
equivalent to 1 stop in aperture.

(3) [White Balance] [Temperature]
Adjusts the color temperature.
[Tint]
Adjusts the tint.

(4) [Lift] Locks the highlight area and adjust the brightness of the shadow area.
(5) [Gamma] Adjusts the brightness of intermediate tone area.
(6) [Gain] Locks the shadow area and adjust the brightness of the highlight area.
(7) [Saturation] Adjusts the saturation.
(8) [Curve] Adjusts the hue and saturation using the tone curves.

[Curve Detail]
Moves the five points of [Curve] set by the luminosity level vertically and horizontally to adjust 
the brightness.

(9) [Set default 
parameters]

Click [Set default parameters] on the right of each item to restore the default setting for the 
item.
Click [Set default parameters] on the bottom of the dialog box to restore the default settings for 
all items.

(10) Preview setting Aligns the video of a clip to which primary color correction is applied and the other clips to 
compare the colors.

(11) [Undo] Undoes an operation.
(12) [Redo] Redoes an undone operation.
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2
 f The types and sort order of color spaces that are displayed when the list button of [Source]/[Destination/LUT] in [Color Space] is clicked 
can be changed in [Application] in [System Settings] → [Color Space].
“[Color Space]” (w page 99)

Example When [Primary Color Correction] is Applied

 r Reproducing Clouds Where Highlight Detail Loss Has Occurred
For landscape shooting, “highlight detail loss” may cause the blue sky to appear in all white or the clouds and distant mountains to be 
merged with each other.
Standard shooting format has limited dynamic range compared to that of the Log format. With an improper exposure setting, highlight detail 
loss occurs, causing the color tones exceeding the upper limit of the dynamic range to be lost and all replaced by white.
Thus, video shot in the standard format may not be able to reproduce the realistic image quality of material texture, etc. even if applying 
post-shooting color corrections, because the light condition is adjusted and recorded at the time of shooting.
The Log format has wider dynamic range and enables recording of the range for the tone of light that could normally be recorded as white 
in the standard shooting. By performing color grading on a Log source, the color tone of areas where highlight details have been lost can be 
reproduced and video with realistic details like film images can be obtained.
 f The following procedure shows an example of primary color correction.

1) Perform steps 1) to 5) in “Adjusting with [Primary Color Correction]”.
 f “Adjusting with [Primary Color Correction]” (w page 348)

2) Click [Toggle Videoscope Display] on the timeline.
 f The [Videoscope] dialog box appears.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

3) While viewing the waveform, adjust [Gain] in the [Primary Color Correction] dialog box in the minus 
direction.

 f While locking the shadow area, adjust the brightness of the highlight areas.

4) In [Curve], drag the second point from the upper right to finely adjust the brightness of the highlight 
area.

 f Move the mouse cursor onto the point until the point turns red, then you can adjust the position of the point.

 r Adjusting the Brightness of a Person Where Shadow Detail Loss Has Occurred Due to Backlight
When shot with sunset or light in the background, the image of a person in the video may be dark because of the backlight, resulting in 
“shadow detail loss”. In the same way as “highlight detail loss”, post-shooting color correction of such a video may not be possible as 
intended.
If the source is shot in the Log format, the color tone of areas where shadow details have been lost can be reproduced by performing color 
grading.
 f The following procedure shows an example of primary color correction.

1) Perform steps 1) to 5) in “Adjusting with [Primary Color Correction]”.
 f “Adjusting with [Primary Color Correction]” (w page 348)
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2) Click [Toggle Videoscope Display] on the timeline.
 f The [Videoscope] dialog box appears.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

3) While checking the waveform, adjust [Lift] in the [Primary Color Correction] dialog box in the plus 
direction.

 f While locking the highlight area, adjust the brightness of the shadow areas.

4) In [Curve], drag the second point from the lower left to finely adjust the brightness of the shadow 
area.

 f Move the mouse cursor onto the point until the point turns red, then you can adjust the position of the point.

Registering LUT

LUT files (*.cube) that are provided by camera manufacturers can be registered to [Primary Color Correction] to apply to clips.
 f Prepare the LUT files (*.cube) on your PC in advance.

1) Display the [Primary Color Correction] dialog box.
 f Apply [Primary Color Correction] to a clip on the timeline, and double-click [Primary Color Correction] in the [Information] dialog box.

2) Click [LUT Settings] on the right of [Destination/LUT].

XXXXXXX

XXXXXXX

Primary Color Correction

Color Space

Source

Destination/LUT

 f The [LUT Settings] dialog box appears.
“[LUT Settings] Dialog Box” (w page 354)
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3) Click [Register new LUT].

XXXXXX XXXXXX

XXXXXXXXXX
XXXXXXXXXX
XXXXXXXXXX
XXXXXXXXXX
XXXXXXXXXX

LUT Settings

Registered LUT

Save LUT information to the project file.

 f The [Open] dialog box appears.

4) Select a LUT file to register, and click [Open].
 f The [Setting for LUT] dialog box appears.

5) Set the range of LUT for [Input]/[Output].
 f Select the range to which LUT is to be associated at the time of input or output from [Full] or [Video].

[Full] Associate the RGB value 0 to 100% of LUT to the entire range including super black and super 
white.

[Video] Associate the RGB value 0 to 100% of LUT to the range of reference black to reference white 
of video (video range).

3 Note
 f The setting of range differs depending on the LUT file. For details, contact the provider of your LUT file.

6) Click [OK].
 f The selected LUT is added to [Registered LUT] in the [LUT Settings] dialog box.
The range setting values selected in 5) will be displayed on the right of the LUT name.

7) Click [OK].

 r [LUT Settings] Dialog Box

XXXXXX XXXXXX

XXXXXXXXXX
XXXXXXXXXX
XXXXXXXXXX
XXXXXXXXXX
XXXXXXXXXX

(2)

(3)

(1)

(5)(4)

LUT Settings

Registered LUT

Save LUT information to the project file.

(1) [Registered LUT] Displays the list of registered LUT.
(2) [Save LUT information 

to the project file.]
Check this item to save the information of the LUT file to the project file.
Even when the project file is imported in a different environment from that where the file was 
created, it can be used with the registered LUT.
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(3) [Move up]/[Move down] Sorts LUT.
Selecting LUT from [Registered LUT] and clicking [Move up] or [Move down] move up or down 
the selected LUT.

(4) [Register new LUT] Click this item to display the [Open] dialog box that allows to register the LUT file.
(5) [Remove LUT from list] Unregisters a LUT selected in [Registered LUT].

2
 f If the project file is imported and used in another environment, checking on [Save LUT information to the project file.] is recommended.
If it is unchecked, the used LUT file must be registered when the project file is imported in another environment.
Be sure to check it when you use EDIUS XRE/GVRE.

 f The LUT process in [Primary Color Correction] is based on input LUT.
 f The LUT file format supported in [Primary Color Correction] is only “No shaper LUT” in the *.cube formats of DaVinci Resolve.
 f The results may differ between when the color space is converted with [Primary Color Correction] and when an equivalent LUT file 
provided by a camera manufacturer is applied, because camera manufacturers make their own adjustments in the file. For details on LUT 
file settings, the information will be released in the FAQ on our website.
“Our Website” (w page 494)

 f The entire LUT data imported from a file is not saved in an effect preset. Therefore, the LUT cannot be referred to (when LUT is not 
registered or saved in the project file), a proper operation will not be performed, which makes clips on the timeline to appear checkered in 
red and black.

Applying LUT

Apply registered LUT to clips.

1) Display the [Primary Color Correction] dialog box.
 f Apply [Primary Color Correction] to a clip on the timeline, and double-click [Primary Color Correction] in the [Information] dialog box.

2) Click the [Destination/LUT] list button in [Color Space], and click a LUT to apply.

XXXXXXX

XXXXXXX

Primary Color Correction

Color Space

Source

Destination/LUT

 f The LUT is applied, and brightness and color are adjusted.
You can view the result of the applied LUT in the preview window. Move the timeline cursor to show the frame that includes the 
adjustment result.

 f Make fine adjustment of parameters as necessary.

3) Click [OK].
 f The [Primary Color Correction] dialog box is closed.

Video Filter
You can add such effects as reducing flicker or make the image stereoscopic like a lithograph to the whole video.

1) In the folder view of the [Effect] palette, click the [VideoFilters] tree and display the filters.
 f Check the filter details in the description in the property, or by trying to apply the filter.

2) Drag and drop the filter to use to the clip on the timeline.

1 Alternative
 f Select a clip on the timeline. Select an effect in the [Effect] palette, and click [Add to Timeline].
 f Select a clip on the timeline. Right-click an effect in the [Effect] palette, and click [Add to Timeline].
 f Select an effect in the [Effect] palette, and right-drag it to the clip on the timeline, and click [Add] or [Replace].

Audio Filter
You can make such adjustment to audio part as reducing noise or emphasizing human voice.
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1) In the folder view of the [Effect] palette, click [AudioFilters] and display the filters.
 f Check the filter details in the description in the property, or by trying to apply the filter.

2) Drag and drop the filter to use to the clip on the timeline.

1 Alternative
 f Select a clip on the timeline. Select an effect in the [Effect] palette, and click [Add to Timeline].
 f Select a clip on the timeline. Right-click an effect in the [Effect] palette, and click [Add to Timeline].
 f Select an effect in the [Effect] palette, and right-drag it to the clip on the timeline, and click [Add] or [Replace].

Camera Shake Correction

[Stabilizer]
Correct the camera shake by image processing.

1) In the folder view of the [Effect] palette, click the [VideoFilters] tree and display the filters.

2) Drag and drop [Stabilizer] to the clip on the timeline.
 f Analysis of the video motion of the clip starts in the background.
“[Background Job]” (w page 116)

1 Alternative
 f Select a clip on the timeline. Select [Stabilizer] in the [Effect] palette, and click [Add to Timeline].
 f Select a clip on the timeline. Right-click [Stabilizer] in the [Effect] palette, and click [Add to Timeline].
 f Select [Stabilizer] in the [Effect] palette, right-drag it to the clip on the timeline, and click [Add] or [Replace].

3) Play back a clip to check the video.
 f For the part where analysis is completed, the camera shake correction is performed on the spot during playback. Change the camera 
correction setting after step 4), if necessary.

4) Display the [Information] palette, and double-click [Stabilizer].
 f The [Video Stabilizer] dialog box appears.
“[Video Stabilizer] Dialog Box” (w page 356)

5) Configure the settings and click [OK].

[Video Stabilizer] Dialog Box

[Smoothness] Move the slider to adjust the smoothness level of the video motion.
Items set to [Off] are not corrected.
[Translate]
Adjust correction level for vertical and horizontal shake.
[Scale]
Adjust correction level for zoom-in and zoom-out shake.
[2D Rotate]
Adjust correction level for rotation shake.
[3D Rotate]
Adjust correction level for perspective shake.
[Rolling Shutter]
Adjust correction level for distortion of the rolling shutter.

[Auto Trimming] Check this item to enlarge the video automatically in order not to make a gap at the edge of the 
video after correcting the video.
You can also enter a value for enlargement factor.

[Preview] Display the corrected video on the entire screen or at the left/right/upper/lower screen, and 
compare with the original video. Click the button to select where to display the video.
You can enter a value for the ratio to display the corrected video against the entire screen.
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Stereoscopic Adjustment

[Stereoscopic Adjuster]
Adjust drift between the video of the L and R sides of the stereoscopic clip.
Leave the drift only in the horizontal direction for the L side and R side videos. Adjust the video so that no drift exists in the vertical or 
rotation direction.
Before operation, read “Notes on Stereoscopic Editing”.
“Notes on Stereoscopic Editing” (w page 325)

1) In the folder view of the [Effect] palette, click the [VideoFilters] tree and display the filters.

2) Drag and drop [Stereoscopic Adjuster] to the clip on the timeline.

1 Alternative
 f Select a clip on the timeline. Select [Stereoscopic Adjuster] in the [Effect] palette, and click [Add to Timeline].
 f Select a clip on the timeline. Right-click [Stereoscopic Adjuster] in the [Effect] palette, and click [Add to Timeline].
 f Select [Stereoscopic Adjuster] in the [Effect] palette, and right-drag it to the clip on the timeline, and click [Add] or [Replace].

3) Display the [Information] palette, and double-click [Stereoscopic Adjuster].
 f [Stereoscopic Adjuster] appears.
“[Stereoscopic Adjuster]” (w page 357)

4) Configure the settings and click [OK].
 f When drift of left, right, top and bottom tilting is large, adjust by a combination of the [Rectify + FIT] and [Horizontal] settings.
 f Clips with stereoscopic processing applied are displayed with an orange line.

[Stereoscopic Adjuster]

[Rectify] Drift between left-eye and right-eye video is automatically adjusted. Select the item to be used 
as the reference for automatic adjustment from the list. When [Rectify] is selected, the center of 
[Rectify left] and [Rectify right] is set.

[Fit Frame] The trimming position where the black frame disappears when video is adjusted is 
automatically set.

[Horizontal] Placement of the left-eye and right-eye video in the horizontal direction is adjusted.
Click [Delete] on the keyboard to restore the default setting for the slider.

[Mask L]/[Mask R] The left edge ([Mask L]) and right edge ([Mask R]) of the video is masked in black.
Click [Delete] on the keyboard to restore the default setting for the slider.

[Auto Trimming] Check this item to automatically adjust the scale so that the black frame that appears when 
video is adjusted disappears. The [Trimming] and [Fit Frame] settings are disabled.

[Trimming] Adjust the video trimming position.
Click [Delete] on the keyboard to restore the default setting for the slider.

[Flip(Left eye)]/[Flip(Right eye)] Checking [Horizontal] inverts the video around the horizontal axis. Checking [Vertical] inverts 
the video around the vertical axis.

Key frame timeline Key frame can be set to adjust video along the time axis.
“Key frame setting” (w page 345)

[Initialize] Click this button to restore the default settings for all the parameters.

Range-Restricted Effects/Multiple Filters
You can combine and set multiple video filters to one clip.
User preset effects or system preset effects are also available.
 f [Mask]
 f [Chrominance]
 f [Combine Filters]
 f [Blend Filters]

This section explains how to apply the mask filter for an example. For other filters, check the filter details in the description in the property, or 
by trying to apply the filter.
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Mask Filter
You can apply a video filter to outside and inside of any range. You can also move the mask position in the key frame according to the video.

1) In the folder view of the [Effect] palette, click the [VideoFilters] tree and display the filters.

2) Drag and drop [Mask] to the clip on the timeline.

1 Alternative
 f Select a clip on the timeline. Select [Mask] in the [Effect] palette, and click [Add to Timeline].
 f Select a clip on the timeline. Right-click [Mask] in the [Effect] palette, and click [Add to Timeline].
 f Select [Mask] in the [Effect] palette, and right-drag it to the clip on the timeline, and click [Add] or [Replace].

3) Display the [Information] palette, and double-click [Mask].
 f The [Mask] dialog box appears.
“[Mask] Dialog Box” (w page 358)

4) Configure the mask and click [OK].
 f Clips with the mask specified are displayed with an orange line.

[Mask] Dialog Box

(1) Tool buttons : Select or move the path. Dragging the handle can zoom in and out or rotate the path. Click 
the list button and select the shape edit tool to edit the path by dragging the path vertex or the 
handle.
 : Drag the mouse to expand or contract the screen. From the drag start point, drag to the 
right to expand the screen, and drag to the left to contract.
 : Drag the mouse to move the display area.

(2) Drawing buttons  : Drag the mouse to draw a rectangle. Drag the mouse with [Shift] on the keyboard held 
down to draw a square.
 : Drag the mouse to draw an ellipse. Drag the mouse with [Shift] on the key board held 
down to draw a circle.
 : Draw a free shape using Bezier curve.

(3) [Undo]/[Redo]  : Undo an operation.
 : Redo the undone operation.

(4) Edit buttons Cut, copy, paste, and delete a selected path.
(5) [Tracking] Select a tracking method and start tracking.

“Batch Tracking of Multiple Paths” (w page 362)
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(6) Function menu [Apply Mask]
Switch the enable/disable setting for mask temporarily.
[Background]
Switch the show/hide setting for the transparent grid if the transparency is set for outside and 
inside of the mask.
[Motion Path]
Switch the show/hide setting for the path if the position is changed by key frame and the setting 
is enabled.
[Grid]
Switch the show/hide setting for the grid.
[Guide]
Switch the show/hide setting for the underscan, overscan, title safe, horizontal/vertical center 
line.
[Stereoscopic]
Displayed only in the stereoscopic edit mode. The display can be switched to L side only, R 
side only or to the L and R sides blended.

(7) [Centering] Center the display area which was moved by the pan tool.
(8) [Fit] Fit the expanded/contracted display to the display range of the preview screen.
(9) Zoom factor Change the zoom factor by entering a value or selecting a value from the list.
(10) Preview Display a preview of the image being edited.

Select a path to display a handle or anchor to modify the path.
(11) Stretch handles Move the cursor to the operation handles at the corners and at the middle of the lines to zoom 

in and out the path.
(12) Anchor Indicate the reference point of the path. This point is a reference point for the rotation center 

and for stretching. Drag with [Ctrl] on the keyboard held down to change the position.
(13) Rotation handle Move the cursor and drag the rotation handle to rotate the image.
(14) Key frame timeline Set a key frame to apply a movement to the mouse position.

“Key frame setting” (w page 345)
(15) Window layout Toggle the window layouts between [Normal], [Preview], and [Multi]. Select [Preview] to hide 

the parameters and key frame timeline to enlarge the preview. Select [Multi] for a multi-monitor 
view.
* [Multi] option is not displayed for a single monitor system.

(16) [Inside]/[Outside] Set video filters for outside and inside the path.
[Opacity]
Use these settings to configure the transparency inside and outside of the path.
[Filter]
Check this item to enable the video filters set inside and outside the path.
 : Click this button to select a video filter.
 : Click this button to configure the video filter setting for outside and inside the path.
[Strength]
The strength of video filter effects can be set.

(17) [Edge] Use these settings to specify colors and blur to the path. If there are multiple paths, the edge 
settings are applied to all the paths. Individual setting is not allowed.
[Color]
Check this item to enable the color edge. Enter an edge width in [Width] in pixels. Click Color 
box to specify the edge color.
“[Color Select] Dialog Box” (w page 199)
Enter the edge transparency in percentage.
[Soft]
Check this item to blur the edge. Enter a blur width in [Width] in pixels.
[Side]
Apply the color and soft (blur) widths for outside and inside (or both) the path.

(18) [Shape] For the selected path, change the various settings including the position by entering a value. 
You can select multiple paths to change in batch. To select multiple paths, click the paths or 
drag the mouse with [Shift] on the keyboard held down to enclose the paths.
[Anchor]
Specify the reference position of the path. With the path center as the origin, specify the 
anchor position by entering values to X and Y.
[Position]
Specify the path position. With the frame center as the origin, specify where to place the 
anchor position by entering values to X and Y.
[Scale]
Enter a zoom factor for zoom in and out. Click  to enable or disable the fixed aspect ratio.
[Rotation]
Enter an angle to rotate the image.

2
 f You can resize the [Mask] dialog box by moving the cursor to a corner or an edge of the dialog box and dragging the mouse when the 
cursor shape changes. You can also click [Maximize] to maximize the window size.

 f Move the cursor to the bottom of the preview window and drag the mouse when the cursor shape change to adjust the display area.
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 f Right-click the preview to display a menu to select a tool or change the zoom factor. Right-click and click [Zoom] → [Fit] to fit the frame 
to the preview window. When you move the frame using the pan tool, right-click the frame and click [Centering] to place the frame to the 
center.

 f When the selected path or anchor is dragged while [Shift] on the keyboard held down, it can be moved limiting to X or Y axis.
 f Double-click the preview to add a key frame on the timeline cursor position when the parameter of the key frame setting is enabled.

Motion Tracking ([Mask])
This feature utilizes the mask function to automatically track specific parts of the subject in motion and apply [VideoFilters] effects such as 
[Mosaic].
Multiple paths can be tracked at the same time.

Example:

To apply [Mosaic] to the face of a person approaching

1) In the folder view of the [Effect] palette, click the [Effect] tree.

2) Click [VideoFilters].

 f A list of [VideoFilters] effects is displayed in the effect view.

3) Drag and drop [Mask] to the clip (video part) on the timeline.
 f Clips with the [Mask] effect applied (video part) are displayed with an orange line.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00

Untitled

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00 00:00:30;00
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XXXX XXXX
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XXXXXXX

XXXXXXX
XXXXXXX

XXX XXXXX XXXXX XXXXX

XXXXX XXXXX XXXXX

XXXXX XXXXX XXXXX

XXXXX XXXXX XXXXX

XXXXX XXXXX XXXXX

4) Display the [Information] palette, and double-click [Mask].

 f The [Mask] dialog box appears.
“[Mask] Dialog Box (Motion Tracking)” (w page 362)

5) Move the timeline cursor to the top frame.
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6) Click the draw button of ellipse and encircle the person's face with an ellipse.

7) Check [Filter] for [Inside], click , and select [Mosaic].

 f Click  to set the details of [Mosaic].
 f You can view the result of the applied video filter in the preview window.

8) Click [Track Forward] in [Tracking].

 f Tracking in the forward direction starts and a key frame will be set frame by frame. A progress bar is displayed to indicate the progress of 
the analysis.

 f The anchor path will be displayed in the preview of the [Mask] dialog box.
 f Tracking will end automatically at the last frame of the clip.

9) Play back the timeline to view the video.

10) Click [OK].
 f The [Mask] dialog box is closed.

2
 f Set key frames can be adjusted frame by frame.
 f The unit of time scale display on the [Mask] dialog box can be adjusted in the time scale settings or by the time scale slider.
 f There are two types of interpolation methods, [Hold] and [Linear].
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[Mask] Dialog Box (Motion Tracking)

(1) [Tracking] Select a tracking method and start tracking.
Multiple paths can be tracked at the same time.
“Batch Tracking of Multiple Paths” (w page 362)

(2) [Track Reverse] Tracks in the reverse direction from the timeline cursor position and sets key frames.
Tracking will end automatically at the top frame of the clip.
[Ctrl] + [,]

(3) [Track Previous Frame] Tracks one frame in the reverse direction from the timeline cursor position and sets key frame.
[,]

(4) [Tracking Option] [Position]
Tracks the position of the object. The default value is ON.
[Scale]
Tracks the size of the object. The default value is ON.
[Rotation]
Tracks the rotation of the object. The default value is ON.
[Distortion]
Tracks the distortion of the object (aspect ratio and shear). This item can be set only when 
[Position], [Scale] and [Rotation] are all set to ON. The default value is ON.

(5) [Track Next Frame] Tracks one frame in the forward direction from the timeline cursor position and sets key frame.
[.]

(6) [Track Forward] Tracks in the forward direction from the timeline cursor position and sets key frames.
Tracking will end automatically at the last frame of the clip.
[Ctrl] + [.]

Batch Tracking of Multiple Paths

You can select and track multiple paths at the same time.

1) Perform steps 1) to 7) in “Motion Tracking ([Mask])”.
 f “Motion Tracking ([Mask])” (w page 360)
 f Draw multiple paths in advance.

2) While pressing [Shift] on the keyboard, select multiple paths.

3) Click [Tracking] on the tool bar, and click a tracking method.

XXXXX

 f Tracking for multiple paths starts at one time and finishes automatically at the last frame.
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4) Play back the timeline to view the video.

If Automatic Tracking Has Been Disrupted

Tracking may be disrupted in the middle when an obstacle blocks the subject being tracked or when the motion is too fast.
This section explains how to set the key frames manually on the frames from the one where automatic tracking has been disrupted to the 
one where automatic tracking can be resumed.
You can also track in the reverse direction using [Track Reverse].

1) Perform steps 1) to 8) in “Motion Tracking ([Mask])”.
 f “Motion Tracking ([Mask])” (w page 360)
 f Tracking has been disrupted in the middle. Automatic tracking cannot be continued. Set key frames manually up to the frame where 
automatic tracking can be resumed.

2) Set key frames manually.
 f To set a key frame frame by frame, click [Track Next Frame]. Adjust the path position and size as necessary.
 f To set a key frame at a desired position, move the timeline cursor to the position to set the key frame and then adjust the path position and 
size. A key frame is added automatically when you edit the path. Repeat this step as necessary.

 f To delete key frames collectively, drag the mouse upward to select the key frames and press [Delete] on the keyboard.

3) Move the timeline cursor to the position to start automatic tracking, and click [Track Forward] again.
 f Automatic tracking resumes.

4) Play back the timeline to view the video.

5) Click [OK].
 f The [Mask] dialog box is closed.

Transition
The following explains the transition and audio cross face between clips.

Margin of Clip
The margin of the clip is the video outside the range between In and Out points. Black triangular mark at both ends of the clip means the top 
(end) of each clip.
When both clips have no margin

XXXX

XXXX

XXXX

XXXX

When there is a margin at the end of front clip and at the beginning of back clip

XXXX

XXXX

XXXX

XXXX

In the extend mode, to add transition/audio cross fade between two clips, both clips need margins. If there is no margin, switch to the fix 
mode or create margins by trimming or other operations.
“Extend/Fix mode” (w page 227)
“Trimming Clips” (w page 268)

Clip Transition
You can add a transition between 2 clips.
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1) Select a transition in the [Effect] palette, and drag and drop it to the joint of clips.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00
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 f The timeline display changes as shown below. The default audio cross fade is simultaneously added.
“Changing Default Effects” (w page 366)

XXXXXXXX
XXXX XXXX

1 Alternative
 f Select a clip on the timeline and select a transition from the [Effect] palette. Click the [Add to Timeline] list button and click an item. If you 
click [Add to Timeline] instead of the list button, the transition is applied to both the In and Out points of the selected clip.

 f Select a clip on the timeline. In the [Effect] palette, right-click a transition, and click [Add to Timeline] → an item.
 f Select a transition in the [Effect] palette, right-drag it to the clip on the timeline, and click [Add] or [Replace]. Click [Custom] to specify the 
duration and the position at which the transition is applied.

2
 f By [Application] in [User Settings] → [Timeline], you can set so that the default audio cross fade should not be applied when the transition 
is applied.
“[Timeline]” (w page 115)

 f In the extend mode, the clip border after setting the transition is displayed as a green line (cut point).
“Setting Extend Mode” (w page 228)

 f A clip transition on the timeline can be applied to the joint of other clips by dragging and dropping.
 f Use the GPU of your PC to apply more complex and high-quality GPUfx transitions. If the [GPU] folder is not displayed, view the error 
information by [Effect] in [System Settings] → [GPUfx].
“[GPUfx]” (w page 112)

Track Transition
You can apply a transition to a video in the part where the video moves to another clip on another track.

1) Select a transition in the [Effect] palette, and drag and drop it to the mixer of clips.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00
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XXXXX XXXXX XXXXX

XXXXX XXXXX XXXXX

XXXXX XXXXX XXXXX

XXXXXXX
XXXXXXX
XXXXXXX

 f The effect is applied at the beginning (or the end) of the clip.

XXXXXXXX
XXXX XXXX
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1 Alternative
 f Select a mixer of the clip on the timeline, and select a transition in the [Effect] palette. Click the [Add to Timeline] list button and click an 
item. If you click [Add to Timeline] instead of the list button, the transition is applied to both the In and Out points of the selected clip.

 f Select a mixer of the clip on the timeline. In the [Effect] palette, right-click a transition, and click [Add to Timeline] → an item.
 f Select a transition in the [Effect] palette and right-drag it to the mixer of the clip on the timeline, and click [Add] or [Replace]. Click 
[Custom] to specify the duration and the position at which the transition is applied.

2
 f A track transition on the timeline can be applied to other mixer areas by dragging and dropping the mixer area.

Audio Cross Fade
You can add an audio cross fade between 2 clips.

1) Select an audio cross fade in the [Effect] palette, and drag and drop it to the joint of clips.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00
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 f The timeline display changes as shown below.

XXXXXXXX
XXXX XXXX

1 Alternative
 f Select a clip on the timeline, and select an audio cross fade from the [Effect] palette. Click the [Add to Timeline] list button and click an 
item. If you click [Add to Timeline] instead of the list button, the audio cross fade is applied to both the In and Out points of the selected 
clip.

 f Select a clip on the timeline. In the [Effect] palette, right-click an audio cross fade, and click [Add to Timeline] → an item.
 f Select an audio cross fade in the [Effect] palette, right-drag it to the clip on the timeline, and click [Add] or [Replace]. Click [Custom] to 
specify the duration and the position at which the audio cross fade is applied.

2
 f You can set the default transition not to be applied, when applying audio cross fade.
“[Timeline]” (w page 115)

 f In the extend mode, the clip border after setting the audio cross fade is displayed as a green line (cut point).
“Setting Extend Mode” (w page 228)

 f An audio cross fade on the timeline can be applied to the joint of other clips by dragging and dropping.

Applying Default Effects
You can easily add effects by selecting clips on the timeline and clicking the button. In this case, effects set as default are applied.
The default effects are set as shown below.
Transition: Dissolve
Audio cross fade: Linear → linear
Title mixer: Fade

1) Move the timeline cursor to the point to apply the effect.
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2) Click [Set Default Transition] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

 f The effect is applied to the position on the timeline cursor.
 f Select a clip and click the [Set Default Transition] list button to select the position where you apply the effect.

1 Alternative
 f Default effect settings: [Ctrl] + [P]

Changing Default Effects
You can change transition, audio cross fade, or title mixer, to be applied by default.

1) Right-click an effect to set as default in the [Effect] palette, and click [Set as Default Effect].
 f “D” s displayed on the icons of effect set as default.

Changing Duration of Effect
You can change the duration of an effect.
Durations of the transition and audio cross fade on the timeline can be changed by trimming.
“Trimming Clips” (w page 268)

Changing Duration of Effect
You can set the default value for duration when applying transition or audio cross fade.

1) Right-click in the [Effect] palette, select [Duration] and click an effect.

2) Enter a duration and click [OK].

Blending
You can composite multiple video by overlaying.

2
 f When you composite videos, the videos are displayed in the order of the alignment on the track. Overlay the track with the video to apply 
the composition (A) on the track with the video to be the background (B).

Blend
You can composite 2 video.

1) In the folder view of the [Effect] palette, click the [Keyers] tree.
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2) Click the [Blend] tree, and drag and drop the composition to be applied on the mixer area of the clip.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00
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XXXXX XXXXX XXXXX
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 f Check the composition details in the description in the property, or by trying to apply the composition.
 f Clips with key effects applied are displayed with an orange line.

XXXX
XXXX

1 Alternative
 f Select a mixer of the clip on the timeline. Select an effect in the [Effect] palette, and click [Add to Timeline].
 f Select a mixer of the clip on the timeline. Right-click an effect in the [Effect] palette, and click [Add to Timeline].
 f Select an effect in the [Effect] palette and right-drag it to the mixer of the clip on the timeline, and click [Add] or [Replace].

Key
You can overlay a video onto another, and display the lower video through the upper video. The keys include [Chromakey] to transmit 
specific color and [Luminancekey] to transmit specific brightness.

1) In the folder view of the [Effect] palette, click the [Keyers] tree.

2) Drag and drop [Chromakey] ([Luminancekey]) onto the mixer area of the clip.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00
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 f Clips with key effects applied are displayed with an orange line.

1 Alternative
 f Select a mixer of the clip on the timeline. Select an effect in the [Effect] palette, and click [Add to Timeline].
 f Select a mixer of the clip on the timeline. Right-click an effect in the [Effect] palette, and click [Add to Timeline].
 f Select an effect in the [Effect] palette and right-drag it to the mixer of the clip on the timeline, and click [Add] or [Replace].

Key Settings

1) Click the mixer area of the clip with the key applied and display the [Information] palette.
 f “Showing/Hiding [Information] Palette” (w page 377)
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2) Click [Chromakey] ([Luminancekey]) and click [Open Setup Dialog].
 f The [Chromakey] ([Luminancekey]) dialog box appears.
“[Chromakey] Dialog Box” (w page 368)
“[Luminancekey] Dialog Box” (w page 369)

1 Alternative
 f Double-click [Chromakey] ([Luminancekey]) in the [Information] palette.
 f Drag and drop [Chromakey] ([Luminancekey]) in the [Information] palette onto [Open Setup Dialog].
 f Right-click [Chromakey] ([Luminancekey]) in the [Information] palette and click [Open Setup Dialog].

3) Configure the settings and click [OK].

[Chromakey] Dialog Box

 r [Key Setting] tab

(1) Display switching Check [Key display] to display a part available to cut out in black. Check [Histogram display] to 
display the histogram.

(2) Color selection Select a color to transmit from the window.
You can select a color (key color) to transmit by 4 methods.

(3) [Auto Fit] Click this button to automatically define keyer settings appropriate for the selected key color.
(4) [Detail] Define the detailed keyer settings.
(5) [Rectangle] Apply chromakey to a particular range.
(6) [Cancel Color] Add the key color and its opposite color onto the border part where the key color and other 

colors are bounded so that a natural composite image can be created.
(7) [Autofit tracking] Check [Enable] to adjust the key color variation automatically.
(8) [CG Mode] Check this item to set the parameter for CG.
(9) [Linear Cancel Color] Check this item to resolve the bleeding of the blue screen or green screen or the discoloration 

by reflections.
(10) [Soft Edge] Check this item to blur the border of the background image and overlaid image.
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 r [KeyFrame Setting] tab

(1) [Fade Setting] Check [Enable] to add fade effects to In and Out of the area applied with chromakey. Duration 
can be set to each of In and Out.

(2) [KeyFrame Setting] Check [Enable] to increase or decrease the effect of chromakey.
Click the line to add key frame, and drag the point to set. Field option can be set from either 
linear or curve.

[Luminancekey] Dialog Box

 r [Key Setting] tab

(1) [Refresh Histogram] Click this button to refresh the histogram.
(2) [Auto Fit] Click this button to automatically define keyer settings appropriate for the selected key color.
(3) [Bypass] Switch the image applied with the luminancekey and the original image.
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(4) Setting range to apply Set the range to apply by entering a value directly in each field or dragging the triangle slider, 
or grating/slant parts.

A

B C

A: Range to apply 100%
B: Range to increase the effect of luminancekey gradually
C: Range to decrease the effect of luminancekey gradually
Select the form to show increase or decrease of the effect in range B and C (slope).

(5) [Rectangle Enable] Set the range to set the luminancekey. The area outside the range becomes all transparent and 
the track image below is displayed through.
Select [Outside Rect. Enable] to apply the luminancekey only within the range.

(6) [Invert] Invert the range with the luminancekey applied.
(7) [All calculation] Check this item to calculate all the area including the range specified with the [Rectangle 

Enable] settings.

 r [Key Frame Setting] tab

(1) [Fade Setting] Check [Enable] to add fade effects to In and Out of the area applied with luminancekey. 
Duration can be set to each of In and Out.

(2) [KeyFrame Setting] Check [Enable] to increase or decrease the effect of luminancekey.
Click the line to add key frame, and drag the point to set. Set either linear or curve.

Transparency
You can overlay a video onto another, and transmit the upper video to display lower video, by changing the transparency of one of the 
videos.

1) Click the expand button of the mixer of the track panel where the clip whose transparency is to be 
changed is placed.

1 VA
V

A1
2

XXXXXX
XXXXXX

MIX

2) Click [Mixer].
1 VA

V

A1
2

XXXXXX
XXXXXX

MIX
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3) Click the rubber band to set the key frame.
1 VA

V

A1
2

XXXXXX
XXXXXX

MIX

4) Drag up and down to adjust the transparency.
1 VA

V

A1
2

XXXXXX
XXXXXX

MIX

 f The transparency is displayed on lower left on the timeline. The video becomes completely transparent when the transparency is 0%.
1 VA

V

A1
2

1 T

1 A

2 A

3 A

4 A

XXXXXXXXXXXXXXXX60.00%

XXXXXX
XXXXXX

MIX

 f Clips with transparency applied are displayed with an orange line.

2
 f To finely adjust the rubber band, drag it with [Ctrl] on the keyboard held down.
 f To change the whole rubber band, drag the line while pressing [Shift] key of the keyboard.
 f The operation procedure to adjust or delete the key frame with value entry is the same as in the audio rubber band.
“Adjusting by Entering Values” (w page 416)
“Initializing/Deleting Rubber Band Points” (w page 416)

[Fade In]/[Fade Out]
You can set [Fade In] to make the video appear gradually, or [Fade Out] to make the video disappear gradually.

1) Select a clip to set fade in/fade out.
 f You can select multiple clips on separate tracks.

2) Move the timeline cursor to the end position of the fade in effect (or the start position of the fade out 
effect).

3) Click [Fade In] or [Fade Out] on the timeline.

XXXXXXXX

 f The mixer area with [Fade In] or [Fade Out] applied is displayed with an orange line.



Chapter 8   Effect — Setting Effects

372

 f You can view the settings of the audio and video parts by clicking the audio expand button or mixer expand button on the track panel. A 
key frame is added to the position to which [Fade In] or [Fade Out] is set.

1 VA
V

A1
2

2 V

XXXXXX

XXXXXX

PAN

MIX

XXXXXX

00:00:00;00 00:00:05;00 00V
A XXX

XXXXXX

2
 f To delete the [Fade In] or [Fade Out] effect, delete both the audio part and the video parts.

 g To delete the video part, select and right-click a clip, and click [Delete Parts] → [Mixer] → [Transparency].
 g To delete the audio part, select and right-click a clip, then click [Delete Parts] → [Audio Rubber Band] → [Volume].

3 Note
 f [Fade In] or [Fade Out] is not shown in the default setting. Define the setting to display the button on the timeline in advance.
“Operation Button Settings” (w page 147)

Setting Fade-in/Fade-out to Video or Audio Parts Individually

You can set fade in or fade out effects to the video or audio parts individually.

1) Select a clip to set fade in/fade out.
 f You can select multiple clips on separate tracks.

2) Move the timeline cursor to the end position of the fade in effect (or the start position of the fade out 
effect).

3) Click the [Fade In] or [Fade Out] list button on the timeline.

XXXXXXXX

4) Click [Video clip only] or [Audio clip only].

1 Alternative
 f Release the link mode and specify fade in/fade out.
“Group/Link Mode” (w page 227)
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Alpha Channel
You can add a clip with transparency information as an alpha channel (data area with transparency information) of another clip. The effect 
makes the image to look like being masked, and you can overlay the image onto the image to be the background.

(1)

(2)

(1) This is the image to be added with the alpha channel. It is called “Fill”.
(2) This is the image to be added to the “Fill” as the alpha channel. It is called “Key”.

You can apply the clip to be the “Key” like a mask as the alpha channel of “Fill”. Overlay the created clip to an image to be the background to 
composite the clip.

3 Note
 f The function is not supported when “Fill” and “Key” have differences in the following items. (The aspect ratio and field order can be 
checked from the [Information] palette.)
 g Image size
 g Frame rate
 g Aspect ratio
 g Field order (Except for the combinations of top field first/progressive and bottom field first/progressive. The combination of top field 
first/bottom field first is not supported.)

 g Clip with no duration defined

1) Register clips to be “Fill” or “Key” to the bin.

XXXX XXXX/XXXX (0/3)

XXXX

100%

XXXX

2) Select 2 clips in the bin.

3) Right-click the 2 clips, and click [Convert] → [Alpha matte].
 f The [Save As] dialog box appears.

4) Set the file type, convert format, or “Fill” and “Key” assignation.

[Save as type] Specify a codec. The available file format differs depending on the specification (HD/SD) and 
other factors.

[Fill Key(F)] Specify which image to be “Fill” (or “Key”) from the 2 images.
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[Convert format] Specify which element of the clip selected as “Key” to be applied as the alpha channel.
[Alpha matte]
Select this item when the clip selected as “Key” includes an alpha channel, and the alpha 
channel is applied as the alpha channel for “Fill”.
[Alpha matte (invert)]
Select this item when the clip selected as “Key” includes an alpha channel, and the alpha 
channel is inverted and applied to the alpha channel for “Fill”.
[Luminance matte]
Select this item when applying the luminance lever (0% to 100%) of the clip selected as “Key” 
is applied to the alpha channel for “Fill”. Luminance level 100% is transparency 100%.
[Luminance matte (invert)]
Select this item when applying the luminance lever (0% to 100%) of the clip selected as “Key” 
is applied to the alpha channel for “Fill”. Luminance level 0% is transparency 100%.

[Repeat last frame] Check this item to complement by repeating the last frame in “Key” clip (or the alpha channel), 
when the duration of the “Fill” clip is shorter than that of “Key” clip.

5) Click [Save].
 f Click [Cancel] to cancel the saving procedure.
 f The created clip is automatically registered in the bin window when saving is completed.

XXXX XXXX/XXXX (0/4)

XXXX

100%

XXXX

6) Composite the clips by laying them on the timeline.
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[Track Matte]
Generate alpha (transparency information) from the clip placed on the timeline as a matte clip, and multiply it by alpha of the clip placed as a 
source clip. In addition, you can place it overlaying the background image.

1) Place a clip to use as a matte clip on a track.

2) Place a clip to use as a source clip on a track on the matte clip.

3) In the folder view of the [Effect] palette, click the [Keyers] tree.
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4) Drag and drop [Track Matte] to the mixer area of the clip.

Cur 00:00:00;00 In -- : -- : -- ; -- Out -- : -- : -- ; -- Dur -- : -- : -- ; -- Ttl 00:00:00;00
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 f Clips with key effects applied are displayed with an orange line.

1 Alternative
 f Select a mixer of the clip on the timeline. Select an effect in the [Effect] palette, and click [Add to Timeline].
 f Select a mixer of the clip on the timeline. Right-click an effect in the [Effect] palette, and click [Add to Timeline].
 f Select an effect in the [Effect] palette and right-drag it to the mixer of the clip on the timeline, and click [Add] or [Replace].

5) Display the [Information] palette.
 f “Showing/Hiding [Information] Palette” (w page 377)

6) Click [Track Matte], and click [Open Setup Dialog] in the [Information] palette.
 f The [Track Matte] dialog box appears.
“[Track Matte] Dialog Box” (w page 376)

1 Alternative
 f Double-click [Track Matte] in the [Information] palette.
 f Drag [Track Matte] in the [Information] palette and drop it on [Open Setup Dialog].
 f Right-click [Track Matte] in the [Information] palette, and click [Open Setup Dialog].

7) Configure the settings and click [OK].

8) Place a background clip on the track beneath the matte clip and compose.
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3 Note
 f If there is no clip to be the matte clip beneath the source clip, track matte setting is not applied.
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[Track Matte] Dialog Box

[Matte] [Luminance]
Use the matte clip luminance (16 - 235) as alpha (0 - 100%) and multiply it by the source clip 
alpha.
[Alpha]
Multiply the matte clip alpha by the source clip alpha.

[Invert] Invert alpha generated from the matte clip and multiply.

Title Effect
You can apply effects to the titles as well.

Title Mixer
You can apply effects on In and Out of title clips.

1) In the folder view of the [Effect] palette, click the [TitleMixers] tree.

2) Drag and drop a title mixer onto the mixer area of the clip.
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 f A title mixer can be set individually on In and Out points.
 f The timeline display changes as shown below.

XXXX

 f Check the title mixer details in the description in the property, or by trying to apply the effect.
“Properties of Effects” (w page 338)

1 Alternative
 f Select a mixer of the clip on the timeline. Select an effect in the [Effect] palette, and click [Add to Timeline].
 f Select a mixer of the clip on the timeline. Right-click an effect in the [Effect] palette, and click [Add to Timeline].
 f Select an effect in the [Effect] palette and right-drag it to the mixer of the clip on the timeline, and click [Add] or [Replace].

2
 f When placing the title clip, you can add the default title mixer automatically by setting at [Source] in [User Settings] → [Duration].
“[Duration]” (w page 121)

 f - You can change the length after placing on the timeline.
“Trimming Clips” (w page 268)
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Operation for Effects

Checking/Adjusting Effects
Check, adjust, or delete effects applied to a clip.

Showing/Hiding [Information] Palette
The selected clips and effects are displayed in the [Information] palette.

1) Click [Toggle Palette Display] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

2) Click [Information].
 f The [Information] palette appears.
“[Information] Palette” (w page 377)

1 Alternative
 f Click [View] on the menu bar, and click [Palette] → [Information].
 f The [Information], [Effect] and [Marker] palettes can be shown/hidden by clicking [View] on the menu bar and clicking [Palette] → [Show 
All] or [Hide All].

 f Showing/hiding palette: [H]
“Showing/Hiding [Effect] Palette” (w page 336)
“Displaying the [Clip Marker] List” (w page 279)
“Displaying the [Sequence Marker] List” (w page 285)

2
 f If you toggle the [Information] palette display, all of the bin window, source browser window, and palette tab associated to the [Information] 
palette toggle their display accordingly. To toggle the show/hide setting individually, release the association of the window and the palette.
“Combining Bin Window/Source Browser Window with a Palette” (w page 145)

[Information] Palette
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(1) Information area Display information such as the file name or duration. The displayed contents differ depending 
on the part selected on the timeline.

(2) Effect list Display applied effects in a list.
For a clip with a video part, [Layouter] is displayed. Double-click an item to display the 
[Layouter] dialog box for cropping and transformation.
“Video Layout” (w page 257)
The number on the upper left of the list shows the number of available effects/number of 
applied effects.
“Enabling and Disabling Effects” (w page 379)

(3) [Open Setup Dialog] Display a settings dialog box to adjust each effect or the [Layouter] dialog box.
(4) [Delete] Delete the effect. [Layouter] items cannot be deleted.
(5) L/R switch Displayed only in the stereoscopic edit mode. Effects can be applied to L side only, R side only 

or to both the L and R sides.
“Applying Video Filters to L or R Side Only” (w page 379)

(6) Enable/Disable Temporarily disable the layouter or effect settings. Uncheck this item to disable the settings.

Checking/Adjusting Effects
You can check or adjust the applied effect from the [Information] palette.

1) Click the area with effects applied on the timeline.
 f “Parts Where Effects Are Applied” (w page 378)
 f A list of the applied effects is displayed in the [Information] palette.

2) Click an effect name on the effect list in the [Information] palette, and click [Open Setup Dialog].
 f A settings dialog box to adjust each effect appears.

1 Alternative
 f Double-click an effect name on the palette.
 f Drag and drop the effect name onto [Open Setup Dialog] in the palette.
 f Right-click an effect name in the palette and click [Open Setup Dialog].

3) Adjust the effect.
 f For adjustment of effects, refer to the procedures to apply each effect.

2
 f You can specify a name to and save an adjusted parameter in the [Effect] palette.
“Registering Effects to [Effect] Palette” (w page 383)

Parts Where Effects Are Applied

 r VA track

XXXXXXXX
XXXX XXXX

XXXX

(6)(5)(3)(2)(1) (4)

(1) Key
(2) Track Transition
(3) Audio filter
(4) Clip transition
(5) Audio cross fade
(6) Video filter, layouter
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 r V track

XXXX XXXX

(2) (3)

(1)

(1) Video filter, layouter
(2) Key
(3) Clip transition

 r A track

XXXX XXXX

(1) (2)

(1) Audio filter
(2) Audio cross fade

 r T track

XXXX

(1)

(1) Title mixer

Enabling and Disabling Effects
You can temporarily disable the layouter or effects.

1) Click the area with effects applied on the timeline.
 f “Checking/Adjusting Effects” (w page 378)

2) Uncheck the item in the effect list in the [Information] palette.

 f Check this item to enable the effect, and uncheck to disable the effect.

1 Alternative
 f Right-click an effect name in the palette and click [Enable/Disable].
 f Select an effect name in the palette, and press [Ctrl] + [F] key.

Applying Video Filters to L or R Side Only
In the stereoscopic edit mode, video filters can be applied to the L or R side only.
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1) Click the area with video filters applied on the timeline.
 f “Checking/Adjusting Effects” (w page 378)

2) Click L or R on the L/R switch on the [Information] palette.
 f Each click of the switch toggles between enabled/disabled.

1 Alternative
 f Right-click an effect name in the palette and click [Stereoscopic] → [Left only], [R only] or [L-R].

2
 f In the standard mode, if there is a video filter already applied to the L or R side only, the “!” icon is displayed on the [Information] palette.

Deleting Effects
You can delete the applied effects.

Deleting Effects Using Timeline

Example:

To delete a filter

1) Select a clip with the effect applied.

2) Click [Edit] on the menu bar, and click [Delete Parts] → [Filter] → an item.

1 Alternative
 f Right-click a clip, and click [Delete Parts] → [Filter] → an item.
 f Right-click the mixer area with the effect applied and click [Delete].
 f Clip transition: [Shift] + [Alt] + [T]
 f Audio cross fade: [Ctrl] + [Alt] + [T]
 f Key: [Ctrl] + [Alt] + [G]
 f Transparency: [Shift] + [Ctrl] + [Alt] + [G]
 f Video filter: [Shift] + [Alt] + [F]
 f Audio filter: [Ctrl] + [Alt] + [F]
 f Deleting all transitions: [Alt] + [T]
 f Deleting all filters: [Shift] + [Ctrl] + [Alt] + [F]

Deleting Effects Using [Information] Palette

1) Click the area with effects applied on the timeline.
 f “Checking/Adjusting Effects” (w page 378)

2) Click an effect name on the effect list in the [Information] palette, and click [Delete].
 f “[Information] Palette” (w page 377)

1 Alternative
 f Drag the effect name out of the palette.
 f Right-click an effect name and click [Delete].
 f Select an effect to delete and press [Delete] key of the keyboard.

2
 f When you set the transition or audio cross fade, green line (cut point) is displayed. This is the border for the transition before setting. If 
you delete the transition or audio cross fade, the Out point of the front clip and the In point of the back clip move back to the cut point.

XXXXXXXX
XXX XXXX

XXXXXXXX
XXX XXXX
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Applying the Adjusted Effect to Another Clip
You can copy effects applied to a particular clip, or replace them with other effects from other clips.

Copying Effects
You can copy adjusted effects applied to a clip, and then apply it to other clips with their original settings.

1) Click the area with effects applied on the timeline.
 f “Checking/Adjusting Effects” (w page 378)

0;00 00:00:20;00 00:00:25;00 00:00:30;00

XXXX XXXX
XXXX XXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

1/1 1XXXX

2) Drag and drop the effect in the effect list in the [Information] palette to the copy destination.

0;00 00:00:20;00 00:00:25;00 00:00:30;00

XXXX XXXX
XXXX XXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

1/1 1XXXX

Copying Transition

1) Click a transition specified on the timeline, and click [Copy] of the timeline.

Untitled

2) Select the clip on which to paste the transition.
 f If you want to paste a transition to the point of the timeline cursor, click the track on which the clip is placed and move the timeline cursor 
to the position to paste the transition.

3) Click the [Set Default Transition] list button.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

4) Click the clip paste method.
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1 Alternative
 f Drag and drop an effect applied to the clip onto the timeline to other clips.

Replacing Effects
Copy an adjusted filter or mixer applied to a clip, and use it to replace a filter or mixer on other clips.

1) Click a clip with a filter or mixer applied, and click [Copy].

Untitled

2) Click the clip to be the paste destination.

3) Click the [Replace Clip (All)] list button on the timeline.

Untitled

4) Click [Filter] or [Mixer].

1 Alternative
 f Select a clip to paste, click [Edit] on the menu bar, and click [Replace] → [Filter] or [Mixer].
 f Right-drag a clip with a filter or mixer applied to a clip to be pasted, and click [Replace parts] → [Filter] or [Mixer].
 f Drag a mixer with effects to copy and drop it onto the destination mixer.
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Preset

Registering Presets
You can register customized effects to [Effect].

Registering Effects to [Effect] Palette
You can adjust an existing effect to create an original effect (user preset effect) and register it to the [Effect] palette. You can also register 
multiple effects as one effect.

1) Click the area applied with an effect to be registered.

2) Click the folder to register the effect in the [Effect] palette.
 f You can also create a new folder.
“Creating Folder in [Effect] Palette” (w page 384)

3) Right-click the effect name to register in the [Information] palette, and click [Save as Current User 
Preset].

 f The effect is registered in the folder in the [Effect] palette. “U” appears on the icon of the registered effects.
“User Preset Effect” (w page 337)

4) Enter a name.

1 Alternative
 f From the effect list in the [Information] palette, drag and drop the effect name onto a folder in the [Effect] palette.

2
 f You can register multiple effects simultaneously. Select multiple effects and right-click them. Click [Save as Current User Preset] to 
register the selected multiple effects as one effect, or click [Save as Separate User Preset] to register them as separate effects.

Deleting Effects from [Effect] Palette
Delete the user preset effect.

1) Select the user preset effect to delete in the [Effect] palette, and click [Delete].
 f If you want to delete a folder including the effect, select the folder and click [Delete].

2) Click [Yes].

1 Alternative
 f Right-click the user preset effect to delete in the [Effect] palette, and click [Delete].
 f Select a user preset effect to delete and press [Delete] key of the keyboard.

3 Note
 f You cannot delete the plug-in base effects and system preset effects.
 f If the selected folder includes effects other than the user preset effects, only the user preset effects are deleted.
 f If the selected folder includes folders registered as a folder shortcut, a confirmation dialog box appears. Click [OK] to delete the folder.
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Customizing [Effect] Palette
You can rename effects and folders, or change the folder structure.

Creating Folder in [Effect] Palette
You can create a new folder in the [Effect] palette.

1) Right-click a folder in the [Effect] palette and click [Create New Folder].
 f A new folder is created under the selected folder.

2) Enter a name.

Renaming Effects
You can change the name of an effect or a folder.

1) Right-click an effect or a folder and click [Change Name].

1 Alternative
 f Click the name of the effect or folder.
 f Right-click an effect and click [Properties]. Change the name in the [Properties] dialog box and click [OK].

2) Enter a name.

2
 f You cannot rename the plug-in base effects and system preset effects.

Folder Structure of [Effect] Palette
You can sort effects or folders, or change the folder structure. Or you can lock them not to move by mistake.

Fixing Folder Structure

1) Click [lock] in the [Effect] palette.

 f Each click on [lock] switches the lock on and off.

3 Note
 f When you select [Back to default], the settings return to the default even after [lock] is enabled.
“Initializing [Effect] Palette” (w page 385)

Changing Folder Structure

2
 f Before making an operation, click [lock] to disable the lock.
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1) Drag and drop an effect or folder to the destination.

Folder Shortcuts
You can quickly open the frequently used folders by assigning them to folder shortcut.

Setting with Effect View

1) Select a folder to set as a shortcut.

2) Click [Folder Link] in the [Effect] palette.

3) Click [Add Link].
 f The selected folder is added to the list.

2
 f You can assign up to 8 folders to a folder shortcut.

Deleting Folder Shortcuts

1) Click [Folder Link] in the [Effect] palette.

2) Click [Arrange].
 f The [Arrange] dialog box appears.

3) Select a shortcut to delete and click [Delete].
 f Click [Close] to finish the operation.

Initializing [Effect] Palette
You can reset the [Effect] palette to the default.

1) Right-click the [Effect] palette, and click [Back to default].
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2) Click [OK].

3 Note
 f When you select [Back to default], the settings return to the default even after [lock] is enabled.

Import/Export
You can export the effect you created and import to other EDIUS, or import effects created by EDIUS.

Exporting Effects (Export)
You can export and save user preset effects. The extension of the saved file is “*.tpd”.

1) Right-click the effect or folder to export in the [Effect] palette, and click [Export].
 f The [Save As] dialog box appears.

2) Set a file name and save destination, and click [Save].

Importing Effects (Import)
You can read the effect file with the extension “*.tpd” as user preset effect.

1) Right-click the folder to import the user preset effect in the [Effect] palette, and click [Import].

2) Select a file, and click [Open].
 f A new folder is created in the selected folder, and the imported effect is registered to the folder.

2
 f Effects for audio can also be imported by registering the VST plug-in.
“VST Plug-in Registration” (w page 113)
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Chapter 9
Title
This chapter explains how to use the Quick Titler software for creating a title and manipulating a title clip with EDIUS.
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Quick Titler

Starting up and Exiting Quick Titler

Creating a New Title
Quick Titler starts up automatically when you create a title clip with EDIUS. If started up from the timeline, the created title is placed on the 
timeline, and if started up from the bin, the title is registered in the bin.

2
 f The existing titler can be changed from [Application] in [User Settings] → [Other].
“[Other]” (w page 117)

 f You can also start up Quick Titler independently by double-clicking QuickTitler.exe. However, it cannot be started up on the PC without 
EDIUS license.

 f To check the version information for Quick Titler, click [Version Info], or click [Help] on the Quick Titler menu bar → [Quick Titler Version 
Information].

Creating a Title Clip on the Timeline

1) Move the timeline cursor to the position in which to create a title clip.

2) Click [Create Title] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

3) Select a track to create a title.
 f Quick Titler will start up.
 f The created title clip is placed on the timeline, and also simultaneously registered in the bin.
 f If In and Out points have not been set on the timeline, when a title is created and saved, the title clip is placed on the selected track at the 
position of the timeline cursor. The default duration can be set from [Source] in [User Settings] on EDIUS → [Duration].
“[Duration]” (w page 121)

 f If In and Out points have been set on the timeline, the title clip is placed between In and Out points on the selected track when a title 
is created and saved. Even if In and Out points have been set, you can also configure the settings in order to place the title clip with a 
default duration.
“[Duration]” (w page 121)

1 Alternative
 f Right-click the track on which to place the title clip, and click [New Clip] → [QuickTitler].
 f Starting up Quick Titler: [T]

3 Note
 f If the video source channel has been deleted, you cannot select [Create Title in Video Channel Track].
“Connecting/Disconnecting the Source Channel” (w page 230)

Registering a Title Clip in the Bin without Placing on the Timeline

1) Click [Add Title] in the bin.

 f Quick Titler will start up.

1 Alternative
 f Click [Clip] on the EDIUS menu bar, and click [Create Clip] → [QuickTitler].
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 f Right-click a blank area in the clip view of the bin window, and click [Add Title].
 f Right-click a blank area in the clip view of the bin window, and click [New Clip] → [QuickTitler].

Exiting Quick Titler
This section explains how to exit Quick Titler.

2
 f Quick Titler exits when you save the title clip currently being edited.

1) Click [File] on the Quick Titler menu bar, and click [Close].

1 Alternative
 f Click [×] in the Quick Titler window.

2) Click [Yes].
 f Click [No] if you do not want to save the title clip. Click [Cancel] to cancel the operation.

About the Quick Titler Screen Configuration

About the Screen
The following explains the Quick Titler screen.
The Quick Titler screen mainly consists of a screen for the creation/editing of objects, a properties panel for setting the color and effects, 
and a style list that displays preset styles.

Quick Titler Screen

XXXXXX
XXXXXX XXX XXX XXX XXX XXX XXX

XXXXXXX

XXXXXXX
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XXXXX XXXXX XXXXX XXXXX XXXXX
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XXXXX XXX XXX

(5)(4)
(1)
(2)

(3)

(6) (7) (8) (9)

(1) Quick Titler menu bar Perform general operations for Quick Titler.
(2) File tool bar Operation buttons for new file creation/saving, copying/deleting, style registration and preview.
(3) Object tool bar Operation buttons for selection, text entry and creation/alignment of objects.
(4) Object creating screen Edit a title.
(5) Title object property 

bar
Set the properties of a selected text object. [Background Properties], [Text Properties],[Image 
Properties],[Object Properties] will be displayed respectively.

(6) Status bar Displays a simple description of an operation button or menu, keyboard status and text object 
location.

(7) Title object style bar Displays a list of the styles that can be applied to a currently selected text object.
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(8) Layout bar Align a text object to the center/title safe area/overscan area. Not displayed at the start-up for 
the first time.
“Showing/Hiding Bars” (w page 390)

(9) Text entry bar Enter text. Not displayed at the start-up for the first time. Text can also be entered directly in 
the object creating screen.
“Showing/Hiding Bars” (w page 390)

2
 f Click [Preview Mode] or press [Ctrl] + [Shift] + [F3] on the keyboard to switch between the high resolution and low resolution of the 
preview.

 f Press [F5] on the keyboard to switch focus between the object creating screen, title object property bar and title object style bar.
 f If Quick Titler is started up independently, [Video settings] in [Background Properties] will be enabled. Set the video format, frame size 
and aspect ratio of the title to be created.

Showing/Hiding Bars
You can switch the show/hide setting for the title object property bar and title object style bar, etc.

1) Click [View] on the Quick Titler menu bar, and click a bar to hide/show.
 f When a bar is checked it will be shown, and if unchecked, it will be hidden.

Moving Bars
You can place the title object property bar and title object style bar where you want.

1) Drag a bar to move and drop it in its destination.
 f Bars will be moved into a position indicated by a white frame that appears during dragging.

XXXXXX
XXXXXX XXX XXX XXX XXX XXX XXX

XXXXXXX

XXXXXXX

XXXX

XXXX
XXXX

XXXX
XXXX

XXXX
XXXX
XXXX
XXXX
XXXX

XXXX

XXXX
XXXX

XXXX

...

XX

XXXXXX
XXXXXX XXX XXX XXX XXX XXX XXX

XXXXXXX



Chapter 9   Title — Quick Titler

391

 f If dropped into a position indicated with a thick white frame, the bar will float as a new window.
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Creating/Saving Title Clip

Creating a New Title Clip
When Quick Titler is started up from an EDIUS timeline, a new title clip is created automatically. This section describes how to create a new 
title clip during Quick Titler editing or after start-up.

1) Click [File] on the file tool bar.

1 Alternative
 f Click [File] on the Quick Titler menu bar, and click [New].
 f Creating a new title clip: [Ctrl] + [N]

Opening a Title Clip
You can open and edit an existing title clip.

1) Click [Open] on the file tool bar.

2) Select a file, and click [Open].

1 Alternative
 f Click [File] on the Quick Titler menu bar, and click [Open].
 f Opening a title clip: [Ctrl] + [O]
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2
 f When you click [File] on the Quick Titler menu bar, up to 4 of the most recently edited title clips are displayed. Click the file name to open 
the file.

 f When you double-click a title clip on the EDIUS timeline or in the bin, a titler starts up and the file is opened.

Exporting a Still Image
You can export a title you have created, including the background, as a still image.

1) Click [File] on the Quick Titler menu bar, and click [Export].
 f The [Save As] dialog box appears.

2) Select the save destination, file name and file format, and click [Save].

Overwrite Saving
You can overwrite save a title clip during editing.

3 Note
 f When using multiples of the same title clip on a timeline, editing one of the title clips will update the content of all the title clips. If you 
want to edit only one title clip out of multiple same title clips, save it in another name.

1) Click [Save] on the file tool bar.

 f Save the title clip and exit Quick Titler.

1 Alternative
 f Click [File] on the Quick Titler menu bar, and click [Save].
 f Overwrite saving: [Ctrl] + [S]

2
 f When [Save] is clicked, the file is saved in the “title” folder present in the folder where the project file is saved. The file name will be “Year, 
month and day saved-4-digit sequential number.etl”.

 f If you start up Quick Titler independently to edit a title and click [Save], the file will be saved in another name.

Saving in Another Name
You can save a title clip being edited with a given name.

1) Click [File] on the Quick Titler menu bar, and click [Save As].
 f The [Save As] dialog box appears.

2) Enter a file name, select a file format from the [Save as type] list, and then click [Save].
 f Save the title clip and exit Quick Titler.
 f For the file format, *.etl or *.etl2 can be selected.
If *.etl2 is set as the file format, the same rendering result can be obtained for titles that have been created with different DPI.
If you want to prioritize the compatibility with titles created in Version 8.5 and earlier, set it to the conventional file format (*.etl).

2
 f If you double-click a title clip on the timeline to start up Quick Titler and then save in another name, only the title clip opened with the 
double-click will be updated, while a new title clip will be registered in the bin.

Automatic Saving in Another Name
You can automatically save the title clip being edited with a given name.



Chapter 9   Title — Quick Titler

393

3 Note
 f When Quick Titler has been started up independently, you cannot save automatically with another name.

1) Click [Auto save as] on the file tool bar.

 f The title clip will be saved with the file name “Year, month and day saved-4-digit sequential number.etl”.

1 Alternative
 f Click [File] on the Quick Titler menu bar, and click [Auto save as].
 f Automatic saving in another name: [Ctrl] + [Shift] + [S]

2
 f If you double-click a title clip on the timeline to start up Quick Titler and then save in another name, only the title clip opened with the 
double-click will be updated, while a new title clip will be registered in the bin.

Creating Text Object

Entering Text
This section explains how to enter text.

1) Click [Horizontal Text] on the object tool bar.

 f If you click and hold down [Horizontal Text], you can select [Vertical Text].

2) Click on the object creating screen.
 f The text cursor appears on the object creating screen.

3) Enter text using the keyboard.
 f You can also display a text input bar to edit text.
“Showing/Hiding Bars” (w page 390)

1 Alternative
 f Click [Insert] on the Quick Titler menu bar, and click [Text] → [Horizontal] or [Vertical].
 f Right-click with nothing selected, and click [Insert] → [Text] → [Horizontal] or [Vertical].
 f Right-click a text box and click [Edit text].

2
 f You can input text by importing text files.
“Importing External Files” (w page 396)

Formatting Settings
You can change the text format such as the font or text size.
Settings such as font or text decoration can be changed under [Font] on the text properties bar. Text format settings can be applied at the 
character or level or at the line level.

1) Select the text string or text box to be formatted.
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2
 f Kerning, Font, Default size, Bold, Italic and Underline can be applied at the character level. To apply to specific characters, drag along the 
desired character string to select it. When no specific character string is selected, format settings can be applied to an entire selected text 
box. You can change leading at the line level. To apply leading to a specific line, place the cursor in the desired line. To set leading for an 
entire text, select the text box.

2) Set the text format using text properties.

[X], [Y] Specify the position of a text box.
[Width]/[Height] Specify the size of a text box. The character size will also be increased/decreased to fit in a 

text box. Check [Fix aspect ratio] to fix the aspect ratio.
[Kerning] Enter a value. Set a value in the range of -300% to 300%.
[Leading] Enter a value. Considering that a leading value of “0” is 100%, set a value in the range of 

-300% to 300%.
[Font] Select the font.
[Size] Select the character size.
[Horizontal], [Vertical] Select between horizontal or vertical.
[Bold]/[Italic]/[Underline] Click a button to apply a Bold, Italic or Underline effect to text strings.
[Left Tab]/[Center]/[Right Tab] Specify the alignment of a text string. For vertical text, [Top], [Center] or [Bottom] can be 

selected.

Creating Images
You can select and place your desired image from those provided on the title object style bar.

1) Click [Image] on the object tool bar.

 f Style chips are displayed on the title object style bar.
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2) Click the style chip you want to create.

3) Click or drag the object creating screen.
 f An image will be placed in the selected style.
 f Drag the image to the desired size.
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1 Alternative
 f Click [Insert] on the Quick Titler menu bar, and click [Image].
 f Right-click with nothing selected, and click [Insert] → [Image].

2
 f To place any still image, after step 3), click [...] of the [File] tree on the image properties bar and select a file.

Creating Graphics
You can create your desired graphics.

1) Click [Rectangle], [Ellipse] or [IsoscelesTriangle] on the object tool bar.
 f Clicking and holding a button of a shape will let you select a rounded rectangle, circle or right-angled triangle.

2) Click or drag the object creating screen.
 f The shape will be placed.
 f Drag the shape to the size you want the shape to be.

1 Alternative
 f Click [Insert] on the Quick Titler menu bar, and click the type of shape to be created.
 f Right-click with nothing selected, and click [Insert] → shape type.

3) Set the style.
 f Use the object properties bar to set the style such as color or border.
“Applying Effects to Text Object” (w page 403)

 f In the title object style bar, double-click the style chip you want to apply.
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Creating Lines
You can create straight or polygonal lines.
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1) Click [Line] on the object tool bar.
 f If you click and hold down [Line], you can select [Continuous line].

2) Click or drag the object creating screen.
 f The line will be placed.
 f Drag on the screen to the length you want the line to be.
 f If [Continuous line] was selected, click the start point → click the corner points → double-click the final point on the line.

1 Alternative
 f Click [Insert] on the Quick Titler menu bar, and click [Line] → [Line] or [Continuous line].

3) Set the style.
 f Click the [Style] tree on the object properties bar, and then select a line type and shape of start/end point from the list.
 f You can also select other settings like color or border.
“Applying Effects to Text Object” (w page 403)

 f In the title object style bar, double-click the style chip you want to apply.
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Importing External Files
You can import text files or image files by dropping them on the object creating screen.

2
 f The following file formats can be imported.

 g Text file: TXT
 g Image file: BMP, GIF, JPEG, PNG, TIFF, TARGA, PSD, EMF

1) Drag and drop the file you want to import from your desktop or a folder onto the object creating 
screen.

 f For image files, clicking [Original size] under [Transform] on the image properties bar resizes the image to its original size.
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1 Alternative
 f For images, create an image, and then select the image files by clicking [...] of the [File] tree on the properties bar.
 f For text, put the cursor in a text box, click [Insert] on the Quick Titler menu bar, and then click [Text] → [File]. Select a text file in the 
[Open] dialog box.

Text Object Operations

Copying
You can copy a text object.

1) Select a text object, and click [Copy] on the file tool bar.

 f You can then paste it.

1 Alternative
 f Right-click a text object and click [Copy].
 f Click [Edit] on the Quick Titler menu bar, and click [Copy].
 f Copying: [Ctrl] + [C]

Cutting
You can cut a text object.

1) Select a text object, and click [Cut] on the file tool bar.

 f You can then paste it.

1 Alternative
 f Right-click a text object and click [Cut].
 f Click [Edit] on the Quick Titler menu bar, and click [Cut].
 f Cutting: [Ctrl] + [X]

Pasting
You can paste a copied or cut text object.

1) Copy or cut a text object.
 f “Copying” (w page 397)
 f “Cutting” (w page 397)

2) Click [Paste] on the file tool bar.

 f A copied or cut text object will be pasted in the same position as the original text object.

1 Alternative
 f Right-click a text or object and click [Paste].
 f Click [Edit] on the Quick Titler menu bar, and click [Paste].
 f Pasting: [Ctrl] + [V]

2
 f A copied or cut text object can be pasted onto another title clip.
 f When you have dragged along a text to select it then copy or cut it, the text can then be pasted at the cursor position when in text editing 
mode. The text can only be pasted when in text editing mode.

 f When a text box is selected then copied or cut, it cannot be pasted when in text editing mode.
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Deleting
You can delete a text object.

1) Select a text object, and click [Delete] on the file tool bar.

1 Alternative
 f Right-click a text object and click [Delete].
 f Click [Edit] on the Quick Titler menu bar, and click [Delete].
 f Deleting: [Delete]

Resizing a Text Object
You can resize a text object.
You can adjust a text object size by dragging the edge of the object frame.

(1) (2)

(1) (2)

(1) Center point handle
(2) Operation handle

1) Place the mouse cursor over an operation handle.

2) When the mouse cursor changes shape, start to drag.

Changing by Entering Values

You can specify size from the [Transform] tree on the properties bar.

1) Select a text object and enter values for [Width] and [Height].
 f Check [Fix aspect ratio] to fix the aspect ratio.
 f For images, click [Original size] to return an image to its original size.

Rotating a Text Object
You can rotate a text object.
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To rotate a text object, drag a corner of the object frame.

(1) (2)

(1) (2)

(1) Center point handle
(2) Operation handle

1) While holding down the [Ctrl] key, place the mouse cursor over an operation handle.
 f If you move the mouse cursor over a center point handle, the mouse cursor shape changes, and you can drag to move the axis of 
rotation. To return the rotation axis to the center point, click the background to deselect the selected text object.

2) When the mouse cursor changes shape, start to drag.

2
 f Rotating while holding down the [Shift] key rotates the text object in 15-degree increments. Rotating while holding down the [Alt] key 
rotates the text object around the center of opposite corners.

Undoing Operations/Redoing Undone Operations
You can undo a performed operation or redo an undone operation. Up to 10 undos and 10 redos are recorded. You can select to undo/redo 
an operation from the list of recorded operations.

1) Click [Undo] or [Redo] on the file tool bar.

1 Alternative
 f Undoing operation: [Ctrl] + [Z]
 f Redoing undone operation: [Ctrl] + [Y]

2
 f Clicking the [Undo] or [Redo] list button displays a list of 10 operations performed. You can select how many operations to undo or redo.

Adjusting Position of Text Object

2
 f EDIUS can be used to configure the layout of a title clip.
“Layout Settings” (w page 412)

Moving a Text Object
You can move a text object.
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1) Click a text object and, after the mouse cursor changes shape, drag it.

Changing by Entering Values

You can specify the position from [Transform] on the properties bar.

1) Select a text object and enter values for [X] and [Y].

Aligning a Text Object
You can align text objects.

Alignment to the Vertical/Horizontal Center

1) Select the text objects to be aligned.
 f Multiple text objects can be selected with the selection tool by clicking them while holding down the [Ctrl] key on the keyboard.

2) Click [Center (vertically)] or [Center (horizontally)] on the object tool bar.

1 Alternative
 f Click [Layout] on the Quick Titler menu bar, and click [Center in screen] → [Vertical] or [Horizontal].
 f Right-click a text object, and click [Layout] → [Center in screen] → [Vertical] or [Horizontal].

Alignment to a Reference Text Object

1) Select the text objects to be aligned.
 f Multiple text objects can be selected with the selection tool by clicking them while holding down the [Ctrl] key on the keyboard.

2) Right-click the text object, click [Next Object] and then select a text object to be used as a reference 
for alignment.

 f The text object with an operation handle displayed at its border is the selected text object (active object).
 f You can switch the active object by clicking [Next Object].
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3) Click [Left Tab] on the object tool bar.
 f If you click and hold down [Left Tab], you can select between [Right Tab], [Top], [Bottom], [Center (vertically)] and [Center (horizontally)].

1 Alternative
 f Click [Layout] on the Quick Titler menu bar, and click [Align] → an item.
 f Right-click a text object, and click [Layout] → [Align] → an item.

2
 f When multiple text objects are selected, you can apply Align Left, Align Right, Align Top, Align Bottom, Align Center (vertically), and Align 
Center (horizontally).

Uniform Horizontal/Vertical Alignment

1) Select the text objects to be aligned.
 f Multiple text objects can be selected with the selection tool by clicking them while holding down the [Ctrl] key on the keyboard.

2) Click [Align at top and bottom] on the object tool bar.
 f If you click and hold down [Align at top and bottom], you can select [Align at right and left].

1 Alternative
 f Click [Layout] on the Quick Titler menu bar, and click [Same space] → an item.
 f Right-click a text object, and click [Layout] → [Same space] → an item.

2
 f Align vertically and align horizontally can be applied when 3 or more text objects are selected.

Layout Settings
You can align text and objects to fit the center, title safe area or overscan area.

1) Show the layout bar.
 f “Showing/Hiding Bars” (w page 390)
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2) Select a text object and then click where to place it using the layout bar.
 f Multiple text objects can be selected with the selection tool by clicking them while holding down the [Ctrl] key on the keyboard.

(1)
(2)
(3)

(1) Overscan
(2) Title safe area
(3) Center

Switching the Order of Text Objects
You can switch the order of text and objects.

1) Select the text and objects you want to switch the order of.

2) Click [Front] on the object tool bar.
 f If you click and hold down [Front], you can select [Back], [Move to Top] or [Move to Bottom].

1 Alternative
 f Click [Layout] on the Quick Titler menu bar, and click [Order] → an item.
 f Right-click a text object, and click [Layout] → [Order] → an item.

Showing/Hiding Grid and Safe Area
You can display a grid or safe area on the object creating screen to use as a guide when moving text objects.

1) Click [Line Grid] or [Title Safe Area] on the object tool bar.
 f If you click and hold down [Line Grid], you can select [Dot Grid].

1 Alternative
 f Click [View] on the Quick Titler menu bar, and click [Grid] → [Dot Grid] or [Line Grid].
 f Click [View] on the Quick Titler menu bar, and click [Title Safe Area].

2
 f If Quick Titler starts up from EDIUS, the 4:3 title safe area will also be displayed when [4:3] for the 16:9 screen guide line is set to be 
displayed through [Preview] in [User Settings] → [Overlay].
“[Overlay]” (w page 120)
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Displaying a Background
You can import EDIUS Recorder images or any still images to be the background of the object creating screen to use as a guide when 
positioning text objects.
Clicking the background will display the background properties.

1) Click the [Background] tree on the background properties bar, and then select an item to be 
displayed as background.

2
 f If you have selected [Still Image], click [...] and select a still image in the [Select Background File] dialog box.
 f Even if a background is set as the background in the background properties of QuickTitler, the background is not used in the title clip. 
The background set in the background properties is available as the background for the edit screen. To output an edited title with a 
background, export a still image.
“Exporting a Still Image” (w page 392)

Applying Effects to Text Object

2
 f EDIUS can be used to apply effects such as fade-in/fade-out.
“Applying a Title Mixer” (w page 410)

 f You can apply effects using the properties bar. A text, image or shape properties bar will be displayed depending on whether text, an 
image or shape is selected. The text properties bar is used here for demonstration purposes. Your screen may differ depending on what 
you have selected.

Color Settings
You can set the color of text and shapes. You can also apply a gradation effect.

3 Note
 f You cannot change the color for images.

1) Select the text or shape in which to change the color.

2) Click the [Fill color] tree on the properties bar.

3) Click the color palette.

 f The [Color Select] dialog box appears.
“[Color Select] Dialog Box” (w page 199)

4) Specify a color.

3 Note
 f When [Texture File] is checked, the color change is not applied to the text or shape.
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Gradation Settings

1) Select a text or shape in which to apply gradation.

2) Click the [Fill color] tree on the properties bar.

3) Enter the number of colors used for the gradation in [Color].
 f Up to 7 colors can be used.

4) Click the color palette.
 f The [Color Select] dialog box appears.
“[Color Select] Dialog Box” (w page 199)

5) Specify a color.

6) Repeat steps 4) and 5) for the number of specified colors.

7) Adjust the color gradation by entering a value in [Direction] or by dragging the arrow figure.

Transparency Settings
You can adjust the transparency of a text object in order to see the background behind it.

1) Select the text object of which to adjust transparency.

2) Click the [Fill color] tree on the properties bar.

3) Move the [Transparency] slider to adjust transparency.

Pasting Texture
You can paste a texture file onto a text object.
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1) Select a text object in which to paste texture.

2) Click the [Fill color] tree on the properties bar.
 f To paste the texture on the edge (border), click the [Edge] tree (for objects, click the [Border / Line Shape] tree).

3) Check [Texture File], and click [...].

4) Select the image file to be pasted, and click [Open].

2
 f File formats that can be used for texture mapping are as follows: 

 g Windows Bitmap (*.bmp, *.dib, *.rle)
 g GIF format (*.gif)
 g JPEG format (*.jpeg, *.jpg)
 g PNG format (*.png)
 g TIFF format (*.tiff, *.tif)
 g Windows Extended Metafile (*.emf, *.wmf)
 g Photoshop format (*.psd)
 g Targa format (*.tga, *.targa, *.vda, *.icb, *.vst)

Edge (Border) Settings
You can set the color of or paste a texture to text and object borders.

1) Select a text object on which to apply an edge (border).

2) Click the [Edge] tree on the properties bar, and check it.
 f [Borders] is displayed on the image properties bar, [Border / Line Shape] is displayed on the object properties bar.

3) Click the color palette.

 f The [Color Select] dialog box appears.
“[Color Select] Dialog Box” (w page 199)

4) Specify a color.

5) Enter a value in [Hard width] to specify a width for the edge (border).

6) Enter a value in [Soft width] to specify the blur for the edge (border).

2
 f You can also set gradation, paste a texture or adjust transparency.
“Gradation Settings” (w page 404)
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“Pasting Texture” (w page 404)
“Transparency Settings” (w page 404)

Shadow Settings
You can apply shadow to text objects.

1) Select a text object on which to apply shadow.

2) Click the [Shadow] tree on the properties bar, and check it.

3) Click the color palette.

 f The [Color Select] dialog box appears.
“[Color Select] Dialog Box” (w page 199)

4) Specify a color.

5) Enter a value in [Hard width] to specify a width for the shadow.

6) Enter a value in [Soft width] to specify the blur for the shadow.

7) Move the [Horizontal] and [Vertical] sliders to adjust the position of the shadow.

8) Move the [Transparency] slider to adjust the shadow transparency.

2
 f A gradation effect can be applied to a shadow.
“Gradation Settings” (w page 404)

Emboss Settings
An emboss effect can be applied to text objects.

3 Note
 f You cannot apply an emboss effect to images.
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1) Select a text or shape where emboss is applied.

2) Click the [Emboss] tree on the properties bar, and check it.

3) Click [Inside] or [Outside].
 f For shapes, [Inside] and [Outside] are displayed.

4) Enter values for [Angle] and [Edge Height] to specify the degree of emboss.

5) Set the light source position.

Blur Settings
You can apply a blur effect to text object borders.

1) Select a text object on which to apply blur.

2) Click the [Blur] tree on the properties bar, and check it.

3) Move the sliders to adjust the blur.
 f Move the slider or enter a value for following properties; [Text / Edge] to apply the blur to a text string and the edge, [Edge] to apply to the 
edge only, and [Shadow] to apply to the shadow only.

 f [Image / Border], [Border] and [Shadow] are displayed on the image properties bar.
 f [Shape / Border], [Border] and [Shadow] are displayed in the object properties bar.

Roll/Crawl Settings
You can set an action that moves a text object horizontally/vertically.
Clicking the background will display the background properties.

1) When the background properties bar is displayed, select an action from the [Title type] list.

[Title type] Select an action for the text. Roll moves vertically and crawl moves horizontally.
[Number of pages] Displays the number of pages that the text object moves across, where 1 page represents the 

range of the display area. A vertical scroll bar appears for 2 or more pages. A white dotted line 
is shown at page breaks, though it is not shown in the actual video.

2
 f Roll/crawl settings such as the start point or end point are performed from the timeline in EDIUS.
“Detailed Title Settings” (w page 410)

 f The roll/crawl speed depends on the number of pages and the length of the title clip. Shorten the length of the title clip for a quick roll/
crawl. Extend the length of the title clip for a slow roll/crawl. Set the title clip length on the timeline in EDIUS.

Registering Edited Effect

Applying a Style
Effects can be applied to the title simply by applying registered style chips.

1) Select the text object on which to apply a style.
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2) Double-click the style chip on the title object style bar you want to apply.
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1 Alternative
 f Select the style chip to be applied, click [Style] on the Quick Titler menu bar, and then click [Apply Style].
 f Select the style chip to be applied, right-click the text object and then click [Style] → [Apply Style].

Registering a Style
You can register the effect applied to a text object as a style chip.

1) Select the text object on which effects have been applied.

2) Click [New Style] on the file tool bar.

1 Alternative
 f Click [Style] on the Quick Titler menu bar, and click [Save As New Style].
 f Right-click a text object on which effects have been applied, and click [Style] → [Save As New Style].
 f Right-click the title object style bar and click [Save As New Style].

3) Enter a file name and click [OK].

2
 f If the style name exists, the style cannot be registered. Register with a different name.

Changing the Style Name
You can change the name of a created style chip.

1) Select the style chip to have its name changed.

2) Click [Style] on the Quick Titler menu bar, and click [Change Style Name].

1 Alternative
 f Right-click the registered style chip, and click [Change Style Name].

3) Enter a new name.
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2
 f You can only change the names of registered style chips.

Deleting a Style
You can delete a created style chip.

1) Select a style chip to be deleted.

2) Click [Style] on the Quick Titler menu bar, and click [Delete Style].

1 Alternative
 f Right-click the registered style chip, and click [Delete Style].

2
 f You can only delete registered style chips.
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Setting Effects

Applying a Title Mixer
You can apply various effects for showing or hiding the title.
Effects available to be applied to a title clip are saved in the title mixer of the [Effect] palette.

1) Select a particular effect from title mixers in the [Effect] palette.

2) Drag the effect to the mixer area below a title clip that is placed on the timeline.
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Untitled

00:00:00;00 00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00 00:00:30;00

XXXX XXXX
XXXX XXXX

XXXX

2 V

1 VA

V
A

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX

XXXXXX XXXXXX

XXXXXX XXXXXX1 T

XXXXXXXXXX
XXXXXXX

XXX XXXXX XXXXX XXXXX

XXXXX XXXXX

XXXXXXX
XXXXXXX
XXXXXXX
XXXXXXX
XXXXXXX
XXXXXXX

 f Move the timeline cursor over the title clip to confirm the effects applied.

1 Alternative
 f Select the mixer area of a title clip. Right-click the desired title mixer on the [Effect] palette, click [Add to Timeline], and then click the 
position in which to add it from [In], [Out], and [Both].

 f Select the mixer area of a title clip, and then drag and drop the desired title mixer from the [Effect] palette onto the effect list of the 
[Information] palette.

2
 f When placing a title clip, the default title mixer is set automatically. You can change the automatic setting of the title mixer from [Source] in 
[User Settings] → [Duration].
“Changing Default Effects” (w page 366)
“[Duration]” (w page 121)

Detailed Title Settings
You can set whether to resize a title clip to fit the project frame size. Also, if a roll/crawl movement is applied for a title clip, you can set 
whether to start from outside the screen or inside the screen.

1) Right-click the title clip, and click [Title detail setting].
 f The [Title detail setting] dialog box appears.

[Title detail setting] Dialog Box

[Resize title] Select whether to resize a title clip to fit the screen.
[Auto]
Displays the title clip at the same size as the frame size according to project settings. The title 
clip will resize to fit the project setting even if, after a title clip has been placed on the timeline, 
the frame size is then changed in the project setting.
[Don't resize(Title size)]
Displays the title clip at the same size as the frame size when the title was created. The title 
clip will not resize to fit the project setting if the frame size in the project setting is changed after 
a title clip has been placed on the timeline.
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[Roll/Crawl setting] [Start]
Select from the list where to start movement of a text object.
[Outside] starts movement of a text object from off the screen.
[Inside] starts movement of a text object from within a screen as the text object resides inside 
the 1st page of the screen.
With [Position] you enter the position where a roll/crawl starts in the entry field on the right.
[End]
Select from the list where to end movement of a text object.
[Outside] continues roll/crawl until all text objects have left the screen.
[Inside] ends roll/crawl at the last page of the text object at the time point displayed in the 
screen.
With [Position] you enter the position where the last page of the text objects completes its roll/
crawl in the entry field on the right.
[In]
Enter the number of frames a text object is held for until it starts to move.
[Out]
Enter the number of frames a text object is held for after roll/crawl.

2
 f Roll/crawl settings can only be changed if roll/crawl is applied to the text in a title clip. Roll/crawl settings cannot be changed if the title 
type is [Still Image]. For details on title types, see “Roll/Crawl Settings”.
“Roll/Crawl Settings” (w page 407)
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Title Position Adjustment

Layout Settings
You can adjust the title position as displayed on the screen from the title clip placed on the timeline.

1) Right-click the title clip, and click [Layouter].
 f The [Layouter] dialog box appears.
“[Layouter] Dialog Box” (w page 412)

2) Set the title layout, and click [OK].
 f The layout is saved.

[Layouter] Dialog Box

(1) Layout preview Displays the setting a preview
(2) Horizontal guide, 

Vertical guide
Indicates the horizontal, vertical or center.

(3) Title frame Indicates the edge of the created title.
(4) [Title Safe] Check this item to display the title safe area.
(5) Position fit Fit the title frame to the center or to the corner of the area selected with [Basic Area].
(6) [Basic Area] Select the area to be fitted to with the fit position buttons from the list.
(7) Position entry fields Enter X, Y values to specify the position.
(8) Horizontal fit Fit the title to the horizontal center.
(9) Vertical fit Fit the title to the vertical center.
(10) [Overscan] Check this item to display the overscan area.
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Chapter 10
Audio
This chapter explains how to adjust the volume on a clip/track and how to add narration, etc.
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Volume/Pan Adjustment
You can add background music and sound effect, adjust parts of the audio volume, and perform other audio editing.
In addition to the audio clips placed on the A tracks, the volume of the audio part of clips placed on the VA tracks can be adjusted.

Adjusting the Volume and Pan of a Clip

Adding a Rubber Band Point
Two rubber bands are displayed on audio clips placed on the timeline; a volume rubber band (orange line) used to adjust volume and a pan 
rubber band (blue line) used to change the L/R stereo balance. Rubber band points can be added to adjust the shape of the rubber band.

1) Click the expand button for the audio on the track panel.
 f The track expands and the rubber band and the waveform are displayed. For stereo audio, a waveform is displayed in each channel.

1 VA
V

A

VOL
PAN

XXXX

XXXX1
2

1 Alternative
 f Expanded display of audio: [Alt] + [S]

2) Click [Volume/Pan].
 f Clicking it switches between Volume, Pan and Lock.
“Volume/Pan Rubber Band” (w page 414)

3) Click on a rubber band in the position where you want to apply a change.
 f A point is added that is used to adjust the volume or pan.

1 Alternative
 f Right-click a rubber band in the position you want to add a point, then click [Add/Delete].

Volume/Pan Rubber Band

 r Volume rubber band (orange line)
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 r Pan rubber band (blue line)
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Adjusting the Rubber Band
You can adjust the volume and pan of a clip. You can also adjust the volume and the pan along to the time axis by adjusting the shape of the 
relevant rubber band.
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Adjusting Using a Point

1) Display the volume rubber band or the pan rubber band, and add a rubber band point.
 f “Adding a Rubber Band Point” (w page 414)

2) Drag the point vertically or horizontally.
 f Fine adjustments can be made by dragging the point with [Ctrl] on the keyboard held down.
 f You can adjust the whole rubber band by dragging the point with [Alt] on the keyboard held down.

 r For volume points
Drag a point upwards to increase the volume, and downwards to decrease the volume.
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 r For pan points
Drag a point upwards or downloads to adjust the L/R balance of the stereo. Drag the point upward to spread the sound to the left side, and 
downward to spread the sound to the right side.
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Adjusting between 2 Points

1) Display the volume rubber band or the pan rubber band, and add a rubber band point.
 f “Adding a Rubber Band Point” (w page 414)

2) Drag the rubber band between 2 points up or down with [Shift] on the keyboard held down.
 f The pointer shape will change to shift the rubber band up or down between the 2 points.
 f Fine adjustments can be made by dragging with [Shift] + [Ctrl] on the keyboard held down.
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Also, by dragging with [Alt] on the keyboard held down, you can automatically add a new point between the 2 other points and move it 
in parallel. You can set how many frames within 2 points at either end an automatically added point is placed using [Source] in [User 
Settings] → [Duration].
“[Duration]” (w page 121)

Adjusting a Whole Rubber Band

1) Display the volume rubber band or the pan rubber band.
 f “Adding a Rubber Band Point” (w page 414)

2) Drag a rubber band or rubber band point up or down with [Shift] + [Alt] on the keyboard held down.
 f The pointer shape will change and the whole rubber band can be adjusted.
 f All other other points will move proportionately according to the amount the selected rubber band or point is varied.
 f Fine adjustments can be made by dragging with [Ctrl] on the keyboard held down.
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Adjusting by Entering Values
You can adjust a rubber band by entering values.

1) Display the volume rubber band or the pan rubber band.
 f “Adding a Rubber Band Point” (w page 414)

2) Right-click a rubber band point, and click a method by which to adjust.

[Go] Adjust the volume or timecode of a selected point.
[Move two aligning points] Move the rubber band that is between a selected point and the next point to the right of the 

selected point horizontally and in proportion according to the amount the selected point is 
varied.
“Adjusting the Rubber Band” (w page 414)

[Add points and move] Add 2 new points between the selected point and the next point to the right, and move the 
rubber band between the 2 added points horizontally and in proportion according to the amount 
the 2 added points are varied.
“Adjusting the Rubber Band” (w page 414)

[Move All] Move other points in proportion according to the amount the selected point is varied.
[Move All On Scale] Adjust the volume of all points proportionally.

[Shift] + [Alt] + [Y]

 f The value input dialog box appears.

3) Enter values.
 f “Entry of Values” (w page 43)

4) Click [OK].

Setting the Pan Rubber Band to the Center
The sound level can be adjusted to make L/R equal.

1) Display the pan rubber band.
 f “Adding a Rubber Band Point” (w page 414)

2) Right-click the pan rubber band, and click [Center].
 f All rubber band points are deleted and the rubber band is centered.
 f Clicking [L] or [R] will delete all rubber band points and adjust the rubber band to L or R.

Initializing/Deleting Rubber Band Points
You can delete or initialize a specific rubber band.

Deleting All Rubber Band Points in a Clip

1) Display the volume rubber band or the pan rubber band.

2) Right-click the rubber band, and click [Delete All].
 f All points are deleted and the entire rubber band is initialized.

Example:

For [Volume]
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1 Alternative
 f Right-click a clip, and click [Delete Parts] → [Audio Rubber Band] → [Volume] or [Pan].
 f Select a clip, click [Edit] on the menu bar, and click [Delete Parts] → [Audio Rubber Band] → [Volume] or [Pan].
 f Deleting a volume rubber band: [Shift] + [Alt] + [H]
 f Deleting a pan rubber band: [Ctrl] + [Alt] + [H]

2
 f The following procedures initialize only the position of a rubber band, leaving rubber band points in place on the rubber band.

 g Right-click a rubber band, and click [Initialize All].
 g Initializing rubber band: [Shift] + [Ctrl] + [U] (Perform procedure after selecting the desired rubber band.)

Deleting a Selected Rubber Band Point

1) Display the volume rubber band or the pan rubber band.
 f “Adding a Rubber Band Point” (w page 414)

2) Right-click a rubber band point, and click [Add/Delete].

1 Alternative
 f Select a rubber band point and press [Delete] on the keyboard.

Audio Mixer

Adjusting with the Audio Mixer
By using the audio mixer, you can adjust the volume and pan of the track or clip on the timeline, or the clip being played on the preview 
window while playing it back. The level meter display can be switched between peak meter and VU meter.
When the fader is operated with learning, after a point is added to the rubber band the point can be edited.
“Adjusting the Rubber Band” (w page 414)

Volume Adjustment

1) Click [Toggle Audio Mixer Display] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

 f The [Audio Mixer] dialog box appears. The meter displayed (peak meter or VU meter) is the meter used in the [Audio Mixer] dialog box the 
last time it was closed.
“[Audio Mixer] Dialog Box” (w page 418)

1 Alternative
 f Click [View] on the menu bar, and click [Audio Mixer].

2) Click [Settings], and click [Peak meter] or [VU meter].
 f Display the peak meter to adjust momentary sounds and other sounds difficult for humans to hear, and display the VU meter to adjust 
sounds as they are heard by humans.

3) Click the operation setting for the track for which the volume is to be adjusted, and select an item.
 f To adjust the volume of an entire track click the master operation setting and click [Master].
 f To adjust the volume on individual tracks click the operation setting for each track and select what is to be adjusted ([TrackNo] or [Clip]).
 f To adjust using the learning function, select the learning mode from [Latch], [Touch] and [Write].

4) Move the timeline cursor to the position to start playing, and click [Play] in the [Audio Mixer] dialog 
box.
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5) Drag the fader to adjust volume.
 f When operating in learning mode points are added to the rubber band of a clip. To redo an adjustment, either overwrite in [Write] mode or 
delete an entire rubber band.
“Deleting All Rubber Band Points in a Clip” (w page 416)

1 Alternative
 f Volume adjustment (1 dB increments): [↑]/[↓]
 f Volume adjustment (0.1 dB increments): [Shift] + [↑] /[Shift] + [↓]

2
 f An optional fader controller can be used to operate the fader. See the manual included with the product for instructions on use.

 r [Audio Mixer] Dialog Box
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(3)
(2)

(1)

(8)

(7)

(9)

(1) Pan control Control the pan.
(2) [Mute]/[Solo] Toggle mute on a track.

“Playing/Muting a Specific Track Only” (w page 420)
(3) [Gang] Connect to a fader.

“Adjusting while Maintaining Volume Difference” (w page 420)
(4) Level meter Displays a level meter.
(5) [Settings] [Peak meter]

Check momentary changes in the audio signal visually. The gradation is displayed as a full 
scale.
[VU meter]
Displays the average volume of an audio signal. The audio signal can be checked in a display 
that shows what is close to what is heard by the human ear. The gradation is displayed as an 
audio reference scale.
[Keep operation setting]
Even if playback is stopped during learning, learning mode (operation setting) is maintained 
and the operation setting does not return to off.
Closing the [Audio Mixer] dialog box returns the [Keep operation setting] setting to off.
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(6) Operation setting Switch the volume adjustment learning mode (operation setting) or the subject of volume/pan 
adjustment from the list.
Setting to any of [Latch], [Touch] or [Write] sets the learning mode so points are added to the 
rubber band. Pan cannot be adjusted in learning mode.
The master operation setting can be only [Master] or [Off].
[Master]
Adjust the volume of a whole track.
[Track]
Update individual tracks with pan control and fader operations. Learning is not implemented.
[Clip]
The clip where the timeline cursor is positioned is updated with pan control and fader 
operations.
The rubber band is updated with operations. If a rubber band point is set, pan updates as 
“Move All” and volume updates as “Move All On Scale”. However, if the value is -∞ at the 
beginning of the operation, the setting will be updated as “Move All”.
Learning is not implemented.
[Off]
Lock the pan control and fader.
[Latch]
Implement learning from the time point where the fader starts to be dragged up to where 
playback is ended.
[Touch]
Implement learning from the position where you start dragging the fader until it is released. 
Release the mouse to return the fader to the original volume automatically.
[Write]
Implement learning through the entire playback.
Differing from [Latch] or [Touch], all the previously used volume values are overwritten 
regardless of dragging/releasing the fader.

(7) Level over indicator Illuminate when the level is over. Click to turn the light off.
(8) Fader Drag up and down to adjust the volume.
(9) [Play] Play the timeline from the timeline cursor position.

Pan Adjustment

1) Click [Toggle Audio Mixer Display] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

 f The [Audio Mixer] dialog box appears.
“[Audio Mixer] Dialog Box” (w page 418)

1 Alternative
 f Click [View] on the menu bar, and click [Audio Mixer].

2) Click the operation setting for the track for which the pan is to be adjusted, and select [Track] or 
[Clip].

 f Click [Track] to adjust pan on each track and click [Clip] to adjust pan for each clip at the timeline cursor position.

3) Move the mouse cursor over the pan control and drag when the mouse cursor changes shape.
1 VA

R28.8

C

L R

 f Dragging up or to the right adjusts to the right side, and dragging down or to the left adjusts to the left side.

1 Alternative
 f Pan adjustment (1 dB increments): [←]/[→]
 f Pan adjustment (0.1 dB increments): [Shift] + [←] /[Shift] + [→]
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2
 f When you right-click the [Audio Mixer] dialog box of an individual track and click [Reset], the volume and pan settings, connection 
settings, mute/solo settings and operation mode of the track are reset. To reset the settings of all tracks, right-click the [Audio Mixer] 
dialog box and click [Reset All].

 f Performing [Reset] or [Reset All] does not reset the volume or pan settings for clips.
 f The [Audio Mixer] dialog box size can be adjusted. Move the cursor to the left or right edge of the [Audio Mixer] dialog box and when the 
cursor shape changes, drag to adjust the size. After adjusting the size, the [Audio Mixer] dialog box will display at the same size upon 
reopening.

Adjusting while Maintaining Volume Difference
The controllers for fader and pan adjustment can be linked across multiple tracks.
Three link patterns can be set: [Gang1] (yellow), [Gang2] (red) and [Gang3] (blue).

1) Click [Gang] on each track to be adjusted simultaneously in the [Audio Mixer] dialog box.
 f The fader color changes according to the color of each [Gang].

2) Adjust single fader (controller) from among the linked faders (controllers).

 f Tracks with faders in the same color are adjusted while maintaining the differences between each volume.

2
 f Before operating the fader (controller), from among the linked tracks, set [Operation] for the tracks you want to link to other than [Off].

Playing/Muting a Specific Track Only
Audio playback can be restricted to a specific track. Specific tracks can also be muted.
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1) In the [Audio Mixer] dialog box, click [Mute] or [Solo] for the track (or tracks) to be played.
 f Clicking [Mute] will mute selected tracks. Click [Solo] to play back audio of the selected track only.

1 A

0.0

C

L R

2 A

0.0

C

L R

1 VA

0.0
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L R

(1)(2)

(1) Mute
(2) Solo

Normalization

Normalizing Audio Level of Multiple Clips (Normalization)
You can set a reference audio level for multiple desired clips and adjust the audio levels together. When normalize is applied to multiple 
clips, the gain value is adjusted to adjust each clip to a proper audio level.
“Checking and Changing the Gain Value of Clips” (w page 421)

2
 f Normalize cannot be applied to the following clips.

 g Timeline sequence clips
 g Clips being edited with a time difference
 g Proxy clips

 f During normalization processing, how much time is used as a sample from which to calculate an output value can be set. You can change 
the setting from [Source] in [User Settings] → [Automatic Correction].
“[Automatic Correction]” (w page 121)

1) Select the clips to be normalized.

2) Click [Clip] on the menu bar, and click [Normalize].
 f The [Normalize] dialog box appears.

1 Alternative
 f Right-click a clip and click [Normalize].

3) Enter the audio level to be used as reference, and click [OK].
 f The initial level setting will be the [Audio reference level] in the project setting.
 f When normalize is applied, an orange line will be displayed in the area below the audio part of the clip.

Checking and Changing the Gain Value of Clips
The gain value of clips can be checked and changed.

1) Select the clip for which the gain value will be confirmed or changed.

2) Click [Clip] on the menu bar, and click [Properties].
 f The [Properties] dialog box appears.

1 Alternative
 f Right-click a clip and click [Properties].
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3) Click the [Audio] tab.
 f The gain value of the clip is displayed next to [Gain].

4) Enter a gain value, and click [OK].

2
 f The normalize gain value can also be confirmed in the detailed display of the bin and the [Information] palette.
 f When a clip on which the gain value has been changed on the timeline is registered in the bin, the changed gain value will be maintained.
 f The change in gain will not be updated if, for example, you display the clip on the Player and remap it to the timeline from the Player after 
changing the gain value of each clip on the timeline as the followings.
(1) For an audio 1ch and video 2ch clip, map the V channel and A1 channel to the 1VA track, and A2 channel to the 1A track.
(2) Change the gain of the 1VA track clip to 5 dB, and the gain of the 1A track clip to 10 dB.
(3) Display the clip of the 1VA track on the Player with double-click.
(4) Place the clip on the Player again with the same mapping setting (mapping the V channel and A1 channel to the 1VA track, and A2 
channel to the 1A track).
At this time, the gain value of the clip placed in the 1VA track is 5 dB, but the change in the gain value of the clip placed in the 1A track is 
not reflected, and it becomes 0 dB.

Partially Adjusting Volume

Showing Waveforms
To conceal noise, etc., operate while viewing the waveform.

1) Click the expand button for the audio on the track panel.
 f The track is expanded and the audio rubber band and the waveform are displayed. For stereo audio, a waveform is displayed in each 
channel. You can detect noise, etc. by reviewing the waveform range and the sound actually being played back.

1 VA
V
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VOL
PAN

XXXX

XXXX1
2

2
 f The waveform display can be changed from [Application] in [User Settings] → [Timeline].
“[Timeline]” (w page 115)

Reducing Momentary Noise (V-mute Function)
Fade in or fade out before and after a single central point to conceal noise, etc.

1) Select the track where the clip to be V-muted is placed.
 f “Selecting Tracks” (w page 220)

2) Move the timeline cursor to a position where the volume is zero.
 f Confirm the shape of the waveform display, and adjust the position of the timeline cursor.

3) Right-click the clip on which V-mute is to be applied, and click [V-Mute].
 f The volume at the position of the timeline cursor becomes zero, and four points are added on the volume rubber band with the timeline 
cursor at their center.

00:00:00;00 00:00:02;00 00:00:04;00

XXXX

XXXX
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1 Alternative
 f V-mute settings: [Shift] + [V]

2
 f After setting V-mute, drag a point on the volume rubber band left and right for fine adjustment of mute duration.
“Adjusting the Rubber Band” (w page 414)

 f The default duration for V-mute can be changed from [Source] in [User Settings] → [Duration].
“[Duration]” (w page 121)
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Adding and Editing Audio

Adding Narration and Sound Effects

Addition of Speech with Voice Over
Voice over is a function for adding narration or sound effects while previewing a timeline clip. You can add audio (sound effect) while 
previewing a scene.

3 Note
 f For microphones or other voice entry devices the device preset must be set in advance.
“Registering Device Presets” (w page 130)

1) Map the audio channel and set an In point at the position in which to place the audio.
 f “Setting Channel Mapping” (w page 230)
 f “Setting the In and Out Points on the Timeline” (w page 232)

2) Click [Toggle Voice Over Display] of the timeline.

00:00:05;00 00:00:10;00 00:00:15;00 00:00:20;00 00:00:25;00

 f The [Voice Over] dialog box appears.

1 Alternative
 f Click [Capture] on the menu bar, and click [Voice Over].

3) Select a preset from the [Device Preset] list.
 f The device preset must be set in advance. The preset cannot be selected if only one preset is registered.
“Registering Device Presets” (w page 130)

4) Adjust the volume of the source data with the [Volume] slider.
 f Adjust the level meter visually so that the volume does not exceed 0 dB.

5) Select [Track] from the [Output] list.

[Bin] Add the audio clip only to the bin.
[Track] Add the audio clip both to the A track specified in step 1) and to the bin.

6) Enter a file name, and click [...] to specify the save destination.

7) Click [Start].
 f The white circle in the upper left of the Recorder blinks to start the count down. The white circle turns red when recording starts. If there is 
an audio clip on the export destination track, the audio on the track will mute at the same time as audio recording begins.

2
 f The time taken between clicking [Start] and the start of recording changes according to the time set in [Application] in [System Settings] 
→ [Margin] in [Capture], and [Preview] in [User Settings] → [Preroll Time] in [Playback].

8) Click [End].
 f Clip playback and audio data creation are stopped and a dialog box appears to confirm whether to add the created file.
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9) Click [Yes].
 f The audio clip is placed and data saved.

2
 f The white line on the right side of the level meter changes to red when the volume exceeds 0 dB. Clicking the line returns it to its original 
setting.

 f If playback of the timeline does not stop in time, recording is also stopped.

Playback with Shifted Audio

Offset of Audio
The timing of video and audio playback can be adjusted by sample increments.

1) Select a clip, and click [Clip] on the menu bar → [Audio Offset].
 f Multiple clips can also be selected.
 f The [Audio Offset] dialog box appears.
“[Audio Offset] Dialog Box” (w page 425)

1 Alternative
 f Right-click a clip and click [Audio Offset].

3 Note
 f Audio offset cannot be applied if multiple clips of differing sampling rate are selected.

2) Select the direction of movement and enter the offset.

3) Click [OK].
 f When offset has been applied to a clip, the offset value is displayed in blue at the start of the clip.

XXXX
+20 Samples XXXX

 f Waveforms will also update with the applied audio offset.

2
 f If the link between video and audio is not in sync, the number of frames they are out of sync will be displayed with priority.
“Unlinking Clips” (w page 241)

[Audio Offset] Dialog Box

[Direction] Select whether to delay the audio compared to video, or advance the audio compared to video.
[Offset] Enter a value by which to delay or advance. Values can be entered by sample increments or 

seconds.
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Chapter 11
Export
This chapter explains methods of exporting projects on which editing is complete.
You can export projects in a variety of file formats, as well as to disc media such as DVD or BD.
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Exporting in File Formats

Points to Be Checked before Exporting a File
This section describes the settings to confirm before export, and matters to know in advance when exporting a file with an exporter.

Marker Settings
To export only one part of an edited video, make sure to specify the export range using [Set In] and [Set Out] on the Recorder.
To add a chapter, make sure that an orange sequence marker is set to the desired position in advance.
“Setting the In and Out Points on the Timeline” (w page 232)
“Setting Sequence Markers” (w page 287)

Export Formats
When exporting a file with an exporter, you can export using the same setting as in the project settings, or export with a format that differs 
from the project settings.
“Exporting with Exporter” (w page 429)
“Exporting in a Format that Differs from the Project Settings” (w page 432)
The following file formats are available for export.
 f Operation is not guaranteed for all formats described in this section.

 r Video

3 Note
 f Some formats may not support codec.
 f Depending on the device specifications and compatibility, playback and output on the device may not be supported.

Format/container Codec File extension Exporter Page
AG-3DA1 AVCHD *.m2ts [AVCHD (Dual Card 3D) 

Writer]
443

AVCHD ― *.m2ts [AVCHD] 442
[AVCHD Writer]

AVCHD 3D ― *.m2ts [AVCHD 3D]
[AVCHD 3D Writer]

AVI Grass Valley HQ *.avi [Grass Valley HQ AVI] 435
Grass Valley HQX [Grass Valley HQX AVI]
Grass Valley Lossless [Grass Valley Lossless]
DV [DV AVI]
DVCPRO50 [DVCPRO50 AVI]
DVCPRO HD [DVCPRO HD AVI]
Uncompressed (RGB) [Uncompressed RGB AVI]
Uncompressed (RGBA) [Uncompressed RGBA AVI]
Uncompressed (UYVY) [Uncompressed UYVY AVI]
Uncompressed (YUY2) [Uncompressed YUY2 AVI]
Uncompressed (v210) [Uncompressed v210 AVI]

Blu-ray H.264/AVC *.m2ts [Blu-ray]*1 436, 455
Blu-ray 3D H.264/AVC *.m2ts [Blu-ray 3D]*1 436
DVD*1 MPEG-2 ― ― 455
Flash Video H.264/AVC *.f4v [F4V] 441
H.264/AVC H.264/AVC *.mp4 [H.264/AVC] 437
H.265/HEVC H.265/HEVC *.mp4 [H.265/HEVC]*2 437

[H.265/HEVC (NVIDIA)]*3

HDV MPEG-2 Transport Stream *.m2t [HDV] ―
iPod H.264/AVC *.mp4 [iPod] 437
MP4 H.264/AVC *.mp4 [H.264/AVC] 437
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Format/container Codec File extension Exporter Page
MPEG-2 Program Stream MPEG-2 *.mpg, *.m2p [MPEG2 Program Stream] 439
MPEG-2 Video Elementary 
Stream

MPEG-2 *.m2v [MPEG2 Elementary 
Stream]

MXF DNxHD*5 *.mxf [DNxHD MXF] ―
DNxHR*5 [DNxHR MXF]
DNxHR 444*5 [DNxHR 444 MXF]

P2 AVC-Intra 50 *.xml + *.mxf [HD P2 Clip] 444
AVC-Intra 100
AVC-Intra 200
AVC-LongG [AVCUltra P2 Clip]
AVC-Intra 4K/2K 422
DV [P2 Clip]
DVCPRO25
DVCPRO50
DVCPRO HD [HD P2 Clip]

P2 3D AVC-Intra 50 *.xml + *.mxf [HD P2 3D Clip] 444
AVC-Intra 100

PlayStation Portable H.264/AVC *.mp4 [PlayStation Portable] 437
QuickTime Grass Valley HQ *.mov [Grass Valley HQ MOV] 436

Grass Valley HQX [Grass Valley HQX MOV]
H.264/AVC [H.264/AVC MOV]
H.265/HEVC [H.265/HEVC MOV]
ProRes [ProRes MOV]
ProRes 4444 [ProRes 4444 MOV]
JPEG2000 [JPEG2000 MOV]
Motion JPEG [Motion JPEG MOV]
PNG [PNG MOV]
QT Animation [QT Animation MOV]
H.265/HEVC [H.265/HEVC MOV 

(NVIDIA)]
DNxHD [DNxHD MOV]
DNxHR [DNxHR MOV]
DNxHR 444 [DNxHR 444 MOV]
DV [DV MOV]
DVCPRO25 [DVCPRO25 MOV]
DVCPRO50 [DVCPRO50 MOV]
DVCPRO HD [DVCPRO HD MOV]

WindowsMedia ― *.wmv [WindowsMediaVideo] 429
XAVC XAVC Intra *.xml + *.mxf [XAVC] 446

XAVC Long GOP
XAVC S*4 *.xml + *.mp4 [XAVC S] 446

XDCAM DVCAM *.xml + *.mxf [XDCAM DV] 445
MPEG IMX [XDCAM MPEG IMX]
MPEG HD [XDCAM HD]
MPEG HD422 [XDCAM HD 422]

XDCAM EX DVCAM *.xml + *.mp4 [XDCAM EX DV] 443
MPEG HD [XDCAM EX]

XDCAM EX 3D MPEG HD *.xml + *.mp4 [XDCAM EX 3D]

*1 To export to a disc, select [Burn to disc] from [Export] on the Recorder.
*2 Quick Sync Video (Intel Core i series CPU (6th generation or later)) that supports H.265/HEVC encoding is required.
*3 A graphics board manufactured by NVIDIA which supports H.265/HEVC encoding is required.

For the supported graphics boards, visit our website.
“Our Website” (w page 494)

*4 To load medium where a file has been exported to the camera, perform [Restore Media] on the camera. Thumbnails cannot be displayed on the 
camera.

*5 It can be supported by using options.
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 r Audio

Format/container File extension Exporter Page
AAC *.m4a [Advanced Audio Coding (AAC)] 435
AIFF *.aif, *.aiff [PCM AIFF]
ALAC *.m4a [Apple Lossless]
Dolby Digital (AC-3) *.ac3 [Dolby Digital (AC-3)]
MPEG-1 Audio Elementary Stream *.mpa [MPEG2 Elementary Stream]
Sony/Sonicfoundry Wave64 *.w64 [Sony/Sonicfoundry Wave64]
Vorbis *.ogg [Vorbis]
Wave *.wav [PCM WAVE]
Windows Media Audio *.wma [WindowsMediaAudio]

 r Still image

Format/container File extension Exporter Page
JPEG File Interchange Format *.jfif [Still Image] 441
JPEG *.jpg, *.jpeg
Mac Pict *.pic, *.pct, *.pict
Photoshop *.psd
PNG (Portable Network Graphics) *.png
QuickTime Image *.qtif, *.qti, *.qif
SGI *.sgi, *.rgb
Targa *.tga, *.targa, *.vda, *.icb, *.vst
TIFF *.tif, *.tiff
Windows Bitmap *.bmp, *.dib, *.rle

 r Caption

Format/container File extension Exporter Page
Scenarist Closed Caption *.scc [Scenarist Closed Caption (.scc) 

file]
447

MacCaption *.mcc [MacCaption (.mcc) file]

Registering Export Settings
Exporter settings can be registered as a preset. The exporter settings can also be registered in combination with the conversion settings 
used to export in a format that differs from the project settings. Once registered, an exporter preset can be easily called upon.
“Creating Exporter Presets” (w page 450)

Exporting with Exporter
You can select the file format to export in, allowing for export in various formats.

Example:

Exporting in the Windows Media Video format.

1) Click [Export] on the Recorder.

2) Click [Print to File].
 f The [Print to File] dialog box appears.
“[Print to File] Dialog Box” (w page 430)
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1 Alternative
 f Click [File] on the menu bar, and click [Export] → [Print to File].
 f Exporting to file: [F11]

3) Click [Windows Media] on the category tree.
 f A list of exporters is displayed in [Windows Media].

4) Click [WindowsMediaVideo], and click [Export].
 f The [WindowsMediaVideo] dialog box appears.
“[WindowsMediaVideo] Dialog Box” (w page 432)

5) Configure the export settings.

6) Enter a file name, select the save destination and click [Save].
 f The rendering job will be registered to the Render Service. An indication appears on the PC screen to notify that rendering will be started.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f The color of the GV Job Monitor icon on the status bar turns to purple while a file export rendering job is being processed.
When the rendering process has been finished, an indication appears on the PC screen to notify that rendering has been finished. The 
color of the icon on the status bar returns to its original state.
“GV Job Monitor Icon Indication” (w page 332)

 f Even if the project file is closed before the rendering process is completed, the process of the rendering job will be continued.
 f To register the exported file to the bin, right-click on the rendering job in the list of completed jobs on GV Job Monitor, and then click [Add 
to Bin].

2
 f After step 3), the procedure differs according to the selected exporter. Perform operations according to the on-screen instructions.
 f Clicking [Open] on the notification of start/finish of file export will start up GV Job Monitor. Clicking [Close] will close the notification.
 f The notification for start/finish of file export will be indicated in accordance with the setting of your Windows.

[Print to File] Dialog Box
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(1) Category tree Select a category to narrow down the exporter options.
[Current default]
Display the default exporters.
[Recently used]
Display exporters in a list in the order of most recently used first.
[My presets]
Display the exporter presets registered by the user in a list.
[All]
Display all exporters in a list. You can narrow the exporter options by selecting a category by 
format.

(2) Exporter/Preset list Display the exporters within a selected category in a list.
[Preset]
Display exporter presets stored as default and exporter presets stored by the user.
“Creating Exporter Presets” (w page 450)
“Deleting Exporter Presets” (w page 451)
“Exporting Exporter Presets (Export)” (w page 451)
 : Video exporter
Indicates exporters to export a file that includes a video element.
 : Audio exporter
Indicates exporters to export an audio element.
 : A preset where conversion is performed
Check [Enable Conversion] to display all exporter presets including exporter presets with a 
format that differs from the project settings.
“Exporting in a Format that Differs from the Project Settings” (w page 432)
“Creating Exporter Presets” (w page 450)

(3) [Search] Search the exporters.
(4) [Export Between In and 

Out]
Check this item to export only between In and Out points of the timeline.

(5) [Enable Conversion] Check this item to enable conversion processing used to export in formats that differ from the 
project settings.
“Exporting in a Format that Differs from the Project Settings” (w page 432)

(6) [Captions] Select the export method of closed captions. Selectable items differ depending on the selected 
exporter.
 f The closed caption alone can be exported to a file as well.

“Exporting Closed Caption” (w page 447)
(7) [Job setting] File export rendering jobs are registered to the Render Service. Set [Priority] of the rendering 

jobs and a comment to show on GV Job Monitor.
“GV Job Monitor” (w page 332)
[Priority]
Set [Priority] of the rendering jobs.
For [Priority], three stages of [High], [Normal] and [Low] can be set.
[Comment]
Enter a comment.
The entered comment is displayed on [Comment] on the job list or the list of completed jobs in 
the [GV Job Monitor] dialog box.

(8) [Stereoscopic] Displayed only in the stereoscopic edit mode. Select the format of stereoscopic processing 
from the list. Selectable items differ according to the selected exporter.
[L/R Dual Stream] exports the video of the L and R sides to a single dual stream-compatible 
file.
[Left only]/[Right only] exports video of the L or R side only to a single file.
[Side by Side]/[Top and Bottom]/[Line Interleave]/[Blend]/[Anaglyph]/[Difference] composites 
and exports the video of the L and R sides to a single file.
“Stereoscopic Processing Type” (w page 153)
[Separate Left and Right] outputs the video of the L and R sides separately to two different 
files.

(9) [Advanced] Click the expand button to configure conversion processing when exporting in a format that 
differs from the project settings.
“[Print to File] (Detailed Settings) Dialog Box” (w page 433)

(10) [Display Timecode] Check this item to export with a timecode shown on-screen.
(11) [Export in 16bit/2ch] Check this item to perform export in 16-bit/2ch regardless of the audio format of the project 

settings or selected exporter preset. It is convenient to leave it checked when a multi-channel 
project is to be exported and used with software by another manufacturer.

(12) [Save as default] Save four items for [Current default].
“Registering Exporter Configuration as Default Exporter” (w page 449)
The saved exporters are displayed in [Current default] of the category tree. Also, clicking 
[Export] on the Recorder and selecting [Print to File (Default Exporter)]/[Add to Batch Export 
(Default Exporter)] → default exporter to use can select the saved default exporter easily.
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(13) Preset operation 
buttons

 : [Save preset]
Register the exporter selected in the exporter/preset list together with the conversion 
processing configured under [Advanced] as an exporter preset.
“Creating Exporter Presets” (w page 450)
 : [Delete preset]
Delete the exporter preset selected in the exporter/preset list.
“Deleting Exporter Presets” (w page 451)
 : [Import preset]
Import exporter presets.
“Importing Exporter Presets (Import)” (w page 451)
 : [Export preset]
Export the exporter preset selected in the exporter/preset list.
“Exporting Exporter Presets (Export)” (w page 451)

(14) [Add to Batch List] Add the specified range to the batch list.
“Registering Ranges to Be Exported in a Batch List” (w page 451)

2
 f To export a multi-channel project to use with software by another manufacturer, either check [Export in 16bit/2ch] or select an exporter in 
16-bit/2ch audio format.

[WindowsMediaVideo] Dialog Box

[Video settings] [Mode]
[CBR] is a fixed transfer mode. It encodes with a constant bitrate regardless of movement or 
image complexity. Enter a value for [Bitrate].
[CBR (2-pass)] performs encoding after an analysis for movement and image complexity.
[VBR (quality based)] is a variable transfer mode of direct conversion. The allotted bitrate is 
varied according to movement and image complexity. Enter a value for [Quality].
[VBR (2-pass)] is a variable transfer mode. The allotted bitrate is varied after an analysis of 
movement and image complexity. Enter the average bitrate in [Bitrate], and maximum bitrate in 
[Max].
[Frame rate]
Check this item to change the frame rate (1-60 fps). To set to 29.97 fps, enter “2997”.
[Picture size]
The image size can be set by selecting from the list. Checking [Square pixel] sets the image 
aspect ratio at 1:1. Check this if the video is made vertically long or horizontally long by the 
playback device.
[Quality setting]
Move the slider depending on the relative importance of [frame rate  (0)] (prioritizes smooth 
movement) and [image quality  (100)].

[Audio settings] [Mode]
[CBR] is a fixed transfer mode. It encodes with a constant bitrate regardless of audio 
complexity. Select a bitrate from the [Bitrate] list.
[CBR (2-pass)] performs encoding after an analysis for audio complexity.
[VBR (quality based)] is a variable transfer mode. The allotted bitrate is varied according to 
audio complexity. Select an average bitrate from the [Quality] list.

Exporting in a Format that Differs from the Project Settings
You can use an exporter to export to file in a format that differs from the project settings.

1) Click [Export] on the Recorder.

2) Click [Print to File].
 f The [Print to File] dialog box appears.
“[Print to File] Dialog Box” (w page 430)

1 Alternative
 f Click [File] on the menu bar, and click [Export] → [Print to File].
 f Exporting to file: [F11]
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3) Click a category in the category tree, and check [Enable Conversion].
 f All exporters and exporter presets where the export format differs from the project settings are displayed. Exporter presets where 
conversion processing is to be performed will have a “→” symbol on their icon.

4) Select an exporter, and click the expand button in [Advanced].
 f Exporter presets stored as default can also be selected.
 f The [Print to File] (Detailed Settings) dialog box appears.
“[Print to File] (Detailed Settings) Dialog Box” (w page 433)

5) Set the details of the format to be exported.

2
 f Clicking [Save as default] saves the current settings. Clicking [Export] on the Recorder and selecting [Print to File (Default Exporter)] → 
default exporter to use can select the exporter easily.
“[Print to File] Dialog Box” (w page 430)

 f You can save the current settings as a preset.
“Creating Exporter Presets” (w page 450)

6) Click [Export], and configure according to the on-screen instructions.

7) Enter a file name, select the save destination and click [Save].
 f The rendering job will be registered to the Render Service. An indication appears on the PC screen to notify that rendering will be started.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f The color of the GV Job Monitor icon on the status bar turns to purple while a file export rendering job is being processed.
When the rendering process has been finished, an indication appears on the PC screen to notify that rendering has been finished. The 
color of the icon on the status bar returns to its original state.
“GV Job Monitor Icon Indication” (w page 332)

 f Even if the project file is closed before the rendering process is completed, the process of the rendering job will be continued.
 f To register the exported file to the bin, right-click on the rendering job in the list of completed jobs on GV Job Monitor, and then click [Add 
to Bin].

2
 f After step 6), the procedure differs according to the selected exporter. Perform operations according to the on-screen instructions.
 f Clicking [Open] on the notification of start/finish of file export will start up GV Job Monitor. Clicking [Close] will close the notification.
 f The notification for start/finish of file export will be indicated in accordance with the setting of your Windows.

[Print to File] (Detailed Settings) Dialog Box

If an exporter preset was selected in step 4), you will switch to the export format settings of that exporter preset.

 r Setting [Change Video Format]

×

：

Checking [Change Video Format] exports files converting to the video format set in the following items.
“*” in the right field of a setting indicates that the setting agrees with the project settings.
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(1) Video profile list Display a list of commonly used video formats. When you select a video format from the list, 
[Frame Size] and other items will switch to the selected video format settings.

(2) [Frame Size] Select a frame size from the list. Select [Custom] to enter a setting value in pixels.
(3) [Aspect Ratio] Select an aspect ratio from the list. If you select [Custom Display Aspect] or [Custom Pixel 

Aspect Ratio], you can set the aspect ratio by entering values. If you have set a customized 
aspect ratio, make sure to select a conversion method from the aspect ratio conversion setting.

(4) Aspect ratio conversion 
settings

If the aspect ratio set in [Aspect Ratio] differs from the project settings, select which method to 
use to convert the aspect ratio from the list.
“Setting the Aspect Ratio Conversion” (w page 434)

(5) [Crop Overscan Area] Check this item to convert the aspect ratio after cropping with the overscan size. The overscan 
size differs according to the project settings.

(6) [Frame Rate] Select a frame rate from the list. If you have set a customized frame rate, be sure to select a 
conversion method in the frame rate conversion settings.

(7) Frame rate conversion 
settings

If the frame rate set in [Frame Rate] differs from the project settings, select from the list which 
conversion to perform.
If you select [Frame blending], supplemental frames will be interpolated by combining the 
frame before and after each supplemental frame. If you select [Nearest frame], the nearest 
frame will be used to make supplementary frames.

(8) [Field Order] Select a field order from the list. If you select [Auto], the optimum perceived field order will be 
selected automatically.

(9) [Default TC Mode] Select whether the video to be exported displays the drop frame timecode or the non drop 
frame timecode as default.

(10) [Channel] This can be set when an exporter to which the alpha channel is retained and can be output to 
is selected.
Select whether to output only the color channel or to output the color channel and the alpha 
channel.

 r Setting [Change Audio Format]
Checking [Change Audio Format] changes the audio format so it is exported with the below-described items. However, if [Export in 
16bit/2ch] has been checked, the [Channels] and [Bit Depth] settings will be fixed.
“*” in the right field of a setting indicates that the setting agrees with the project settings.

[Channels] Select the number of channels from the list. If the selected number of channels is fewer than 
the project setting, the channels will be exported in order from 1ch. Select [2ch] to export a 
multi-channel project to be used with software of another company.

[Sampling Rate] Select a sampling rate from the list.
[Bit Depth] Select an audio quantization bitrate from the list. Select [16bit] to export a multi-channel project 

to be used with software of another company.
[Export Audio] Check this item to export the audio part.
[Generating Waveform Cache] Check this item to create waveform cache (waveform representation of audio).

 r [Remove Ancillary data] setting
This can be set when a compatible exporter is selected. Check this item to export with ancillary data removed. This setting does not affect 
the export of closed captions.

3 Note
 f Even if it is unchecked, when the frame size, after the frame rate or aspect ratio is corrected, is different from that of the project 
settings, ancillary data will be removed.

 f Configure the ancillary data export setting in conjunction with [Preserve Ancillary data] in the sequence setting.
“Sequence Settings” (w page 68)

Setting the Aspect Ratio Conversion

For the items in the list of the aspect ratio conversion setting to be set in the [Print to File] (Detailed Settings) dialog box, what follows are 
example descriptions of converting a 16:9 screen to a 4:3 screen, and a 4:3 screen to a 16:9 screen.
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Item Original screen →
Converted screen

Description

Letter box / Side panel 16:9 → 4:3 The 16:9 screen is displayed in the center of a 4:3 screen, and a letter box effect is 
added above and below.

4:3 → 16:9 The 4:3 screen is displayed in the center of a 16:9 screen, and side panels are added at 
the edges.

Side cut / Crop top and 
bottom

16:9 → 4:3 The left and right sides of the 16:9 screen are cropped to fit the 16:9 screen to a 4:3 
screen size.

4:3 → 16:9 The top and bottom parts of the 4:3 screen are cropped to fit the 4:3 screen to a 16:9 
screen size.

Anamorphic 16:9 → 4:3 The 16:9 screen is compressed horizontally to fit a 4:3 screen size. The frame aspect 
ratio is not conserved.

4:3 → 16:9 The 4:3 screen is stretched horizontally to fit a 16:9 screen size. The frame aspect ratio 
is not conserved.

Semi-letter box 
(14:9/13:9)

16:9 → 4:3 The 16:9 screen is cropped to a 14:9 or 13:9 screen size, displayed in the center of a 
4:3 screen and a letter box effect is added above and below.

4:3 → 16:9 The 4:3 screen is cropped to a 14:9 or 13:9 screen size, displayed in the center of a 
16:9 screen and side panels are added at the edges.

AVI Format
The compression format can be selected to export a project as an AVI file.

1) Click a codec of [AVI] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Select an exporter, and click [Export].

2
 f For the items for the Grass Valley HQ AVI and Grass Valley HQX AVI codec settings, see the description given for the [Settings - Grass 
Valley HQ]/[Settings - Grass Valley HQX] dialog box in [System Settings].
“[Settings - Grass Valley HQ]/[Settings - Grass Valley HQX] Dialog Box” (w page 133)

 f If [Use MSDV codec] is checked when the [DV AVI] exporter has been selected, it will export as AVI with the MSDV codec.

3) Set a file name and save destination, and click [Save].

Audio Format
You can export just the audio of a project.
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1) Click [Audio] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)
 f To export as Windows Media Audio, click [Windows Media] in the category tree.

2) Select an exporter, and click [Export].

3) Set a file name and save destination, and click [Save].

2
 f If the [Dolby Digital (AC-3)] exporter has been selected, select a bitrate from the [Format] list.
 f If the [WindowsMediaAudio] exporter has been selected, select the transfer mode. If [CBR] (fixed transfer mode) has been selected, 
select a bitrate from the [Bitrate] list. If [VBR (quality based)] (variable transfer mode) has been selected, select a bitrate from the [Quality] 
list.

QuickTime Format
You can export a project in MOV format that can be played back as a QuickTime movie.

2
 f If one of the following exporters is used for export when [Color Space] in [Project Settings] is set to [BT.2020/BT.2100 HLG] or [BT.2020/
BT.2100 PQ], HDR metadata will be added at the time of export.
 g [Grass Valley HQX MOV]
 g [Grass Valley HQ MOV]
 g [H.264/AVC MOV]
 g [H.265/HEVC MOV]
 g [H.265/HEVC MOV (NVIDIA)]
 g [ProRes MOV]
 g [ProRes 4444 MOV]
 g [DNxHD MOV]
 g [DNxHR MOV]
 g [DNxHR 444 MOV]

1) Click [QuickTime] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Select an exporter, and click [Export].

3) Select a file format from the [Save as type] list, and click [Settings].
 f [Settings] may be unavailable depending on the file format.
 f If the exporter is [ProRes MOV], set the codec in [ProRes CODEC settings].
Select an item from [ProRes 422 HQ], [ProRes 422], [ProRes 422 LT] and [ProRes 422 Proxy].

 f If the exporter is [ProRes 4444 MOV], set the codec in [ProRes CODEC settings].
There is only one setting item, [ProRes 4444].

 f If the exporter is [JPEG2000 MOV] or [QT Animation MOV], set [Video] and [Audio]. [Quality] for video and [Codec] for audio can be set.
 f For the detailed items when [H.264/AVC MOV] and [H.265/HEVC MOV] are set for the exporter, see the descriptions given for the [Basic 
Settings] tab/[Extended Settings] tab in “MP4 Format”.
“MP4 Format” (w page 437)

 f If the exporter is [DNxHD MOV], set [Bitrate].
 f If the exporter is [DNxHR MOV] or [DNxHR 444 MOV], set [Format] and [VBR].

4) Configure the export settings, enter a file name and click [Save].

2
 f For the items for the Grass Valley HQ and Grass Valley HQX codec settings, see the description given for the [Settings - Grass Valley 
HQ]/[Settings - Grass Valley HQX] dialog box in [System Settings].
“[Settings - Grass Valley HQ]/[Settings - Grass Valley HQX] Dialog Box” (w page 133)

 f See the QuickTime player help for more information on the detailed settings for each file export.

BD Format
You can export to an MPEG 2 format file (*.m2ts) for BD.
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1) Click [H.264/AVC] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Click [Blu-ray], and click [Export].
 f The [Blu-ray] dialog box appears.
“[Blu-ray] Dialog Box” (w page 437)

3) After setting the export details, specify a file name and save destination and click [Save].

[Blu-ray] Dialog Box

 r [Basic Settings] tab

[Video settings] [Profile]
Set the profile. The selectable profiles will differ dependent on the frame size to be exported.
[Bit Rate Type]
[CBR] assigns a constant number of bits. Although noise, etc. may be present, the encoding 
process is made quicker.
[VBR] changes the assigned bitrate according to the complexity of the movement or image 
quality. Compared with [CBR], the media volume can be used more efficiently, and this enables 
more consistent image quality overall.
[Average]
Set this item if [CBR] or [VBR] has been selected as the bitrate type. You can either select from 
the list or enter values directly.
[Max]
Set this item if [VBR] has been selected as the bitrate type. You can either select from the list 
or enter values directly.
[Quality]
Select the image quality from the list.
[Use Hardware Encoder]
Check this item to output video using hardware encoding such as Quick Sync Video. 
Unchecking this item will output video using H.264 software encoder that enables high-quality 
and high-speed encoding.
In an environment where hardware encoding is not available, [Use Hardware Encoder] will not 
be displayed. The encoder for output will be fixed to H.264 software encoder.

[Audio settings] [Format]
Select the audio compression format from the list.
 f For [Dolby Digital (AC-3)]
If the number of audio channels in the project settings is 7ch or more, the 7th channel and 
later are discarded, and the project is output with 5.1ch - 1ch:L, 2ch:R, 3ch:C, 4ch:LFE, 
5ch:Ls, and 6ch:Rs. If the number of audio channels in the project settings is 5ch or less, all 
except 1/2ch are discarded and the project is output with 2ch.

 f For [Linear PCM]
If the number of audio channels in the project settings is 8ch, output is with 8ch; if the 
number is 6ch/7ch, output is with 6ch; if the number is 4ch/5ch, output is with 4ch: and if the 
number is 3ch, output is with 2ch.

[Bit Rate]
Select a bitrate from the list.

 r [Extended Settings] tab

[GOP Structure] Select the GOP structure.
[Picture Count] Set the GOP length.
[Number of Reference Frames] Set up to how many frames to consider when motion estimation is performed.
[Multi Slice] Check this item to divide 1 frame into 4 parts. If the decoder supports multi-slicing, the 

decoding may be made quicker.
[Entropy Coding Mode] Select the H.264 encoding mode.
[Bit Depth] Video quantization bitrate is fixed at [8].
[Chroma Format] Pixel format of YUV is fixed at [4:2:0].

MP4 Format
Projects can be exported in MP4 format files (*.mp4).
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2
 f If [Bit Depth] is set to [10] in the [Extended Settings] tab at the time of export, the file will be exported in 10-bit.
 f If one of the following exporters is used for export when [Color Space] in [Project Settings] is set to [BT.2020/BT.2100 HLG] or [BT.2020/
BT.2100 PQ], HDR metadata will be added at the time of export.
 g [H.264/AVC]
 g [H.265/HEVC]
 g [H.265/HEVC (NVIDIA)]

 f Export in H.265/HEVC is available by using Quick Sync Video. The [H.265/HEVC] exporter can be used only on an environment 
equipped with Intel Core i series CPU (6th generation or later).
Note that the 6th generation CPUs do not support export of project in 4:2:0 10-bit.

 f Export in H.265/HEVC is available by using a graphics board manufactured by NVIDIA. The exporter for [H.265/HEVC (NVIDIA)] can be 
used only on an environment equipped with a graphics board manufactured by NVIDIA.
For the supported graphics boards, visit our website.
“Our Website” (w page 494)

1) Click [H.264/AVC] or [H.265/HEVC] on the category tree of the [Print to File] dialog box.
 f “Exporting with Exporter” (w page 429)

2) Select an exporter, and click [Export].
 f Select either [H.264/AVC], [PlayStation Portable], [iPod], [H.265/HEVC] or [H.265/HEVC (NVIDIA)] as an exporter.

3) After setting the export details, specify a file name and save destination and click [Save].
 f “Export Settings Dialog Box in MP4 Format” (w page 438)

Export Settings Dialog Box in MP4 Format

The setting items will differ depending on the exporter.

 r [Basic Settings] tab

[Video settings] [Profile]
Set the profile. The selectable profiles will differ depending on the frame size to be exported.
[Bit Rate Type]
[CBR] assigns a constant number of bits. Although noise, etc. may be present, the encoding 
process is made quicker.
[VBR] changes the assigned bitrate according to the complexity of the movement or image 
quality. Compared with [CBR], the media volume can be used more efficiently, and this enables 
more consistent image quality overall.
[Average]
Set this item if [CBR] or [VBR] has been selected as the bitrate type. You can either select from 
the list or enter values directly.
[Max]
Set this item if [VBR] has been selected as the bitrate type. You can either select from the list 
or enter values directly.
[Quality]
Select the image quality from the list.
[Use Hardware Encoder]
Check this item to output video using hardware encoding such as Quick Sync Video. 
Unchecking this item will output video using H.264 software encoder that enables high-quality 
and high-speed encoding.
In an environment where hardware encoding is not available, [Use Hardware Encoder] will not 
be displayed. The encoder for output will be fixed at H.264 software encoder.

[Audio settings] [Format]*1

The audio compression format will be fixed at [AAC].
[Bit Rate]
Select a bitrate from the list.

*1 If the exporter is [H.264/AVC MOV] or [H.265/HEVC MOV] for [QuickTime], you can also select [Linear PCM].

 r [Extended Settings] tab

[GOP Structure] Select the GOP structure.
[Picture Count] Set the GOP length.
[Number of Reference Frames] Set the maximum number of frames to be taken into consideration in motion estimation.
[Multi Slice] Check this item to divide 1 frame into 4 parts. If the decoder supports multi-slicing, the 

decoding may be made quicker.
[Entropy Coding Mode] Select the H.264 encoding mode.
[Adjust bitrate by pixels per sec] Check this item to adjust the bitrate in accordance with the number of pixels per second.
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[Bit Depth] Select a video quantization bitrate from the list.
[Chroma Format] Select a YUV pixel format from the list.
[MP4 Option] Select [Fast Start] to add moov at the start of the file, set it as Fast Start, and export it.

Select [Fragmented] to export the file in Fragmented MP4 format.
If you do not use [Fast Start] and [Fragmented], select [None].

[Audio Option]*1 Select [Multi Channels] to output the channels as center, right or left.
Select [Multi Tracks] to output multiple streams of 2ch channel. When 6 or more channels are 
output, all channels can be output using this option.
If you check [Apply bitrate per track], the audio bitrate of each track will be applied to the bitrate 
set for [Audio settings] in the [Basic Settings] tab. This setting is only applied when [Multi 
Tracks] has been selected.

*1 Available only when [Format] of [Audio settings] in the [Basic Settings] tab is set to [AAC].

3 Note
 f If [Bit Depth] is set to [10], or [Chroma Format] is set to [4:2:2], hardware encoding cannot be performed even when [Use Hardware 
Encoder] check box is selected in [Video settings].

Uploading HDR video to YouTube

This section describes how to export files recognized as HDR video on YouTube.
 f The following procedure shows an example.

1) Create a project.
 f Create a project with the following project settings.

 g [Video Preset]: [QFHD 3840 x 2160 59.94p]
 g [Video Bit Depth]: [10bit]
 g [Color Space]: [BT.2020/BT.2100 PQ]

2) Register a clip in the Log format to the project, and place the clip on the timeline.

3) Apply [Primary Color Correction] to the clip.
 f If the clip is not recognized as Log file, set the color space manually.
 f Performing color grading in the [Primary Color Correction] dialog box, if necessary.
 f “Adjusting with [Primary Color Correction]” (w page 348)

4) Click [Print to File].

5) Click [H.264/AVC] or [H.265/HEVC] on the category tree of the [Print to File] dialog box.

6) Select [H.264/AVC MP4 3840x2160 59.94p 10bit] or [H.265/HEVC MP4 3840x2160 59.94p 10bit] from 
[Preset] of exporter.

7) Click [Export] and specify the file name and save destination, and click [Save].
 f When the exported file is uploaded to YouTube, the file is recognized as HDR video. For details, visit the website of YouTube.

MPEG-2 Format
Projects can be exported as an MPEG-2 format file.

1) Click [MPEG] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Click [MPEG2 Elementary Stream] or [MPEG2 Program Stream], and click [Export].
 f The [MPEG2 Elementary Stream] dialog box or the [MPEG2 Program Stream] dialog box appears.
“[MPEG2 Elementary Stream] / [MPEG2 Program Stream] Dialog Box” (w page 440)

3) Configure the video and audio settings, specify a file name and save destination and click [Save].
 f If [MPEG2 Elementary Stream] has been selected, click [Select], set the audio and video export destinations, and click [OK].
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[MPEG2 Elementary Stream] / [MPEG2 Program Stream] Dialog Box

 r [Basic Settings] tab
The setting items displayed may differ in part depending on the exporter.

[Video settings] [Segment Encode]
Check this item to export a clip of a raw source without re-encoding.
This increases the output speed.
[Size]
Select an image quality.
[Quality/Speed]
Select quality from the list. The higher the quality, the more time it takes to be encoded.
[Bit Rate]
Select a bitrate type.
[CBR] sets a fixed transfer rate, allocating a fixed number of bits during the encoding process. 
Select a bitrate from the [Average(bps)] list. You can also enter a value directly.
[VBR] sets a variable transfer rate, altering the number of assigned bits according to the 
complexity of the movement or image quality. Compared with [CBR], the media volume can be 
used more efficiently, and this enables more consistent image quality overall. Select a bitrate 
from the [Average(bps)] and [Maximum(bps)] lists. You can also enter a value directly.

[Audio settings] [Format]
Select the audio compression format from the list.
[Channel]
Select from [Stereo], [Dual Channel] or [Joint Stereo]. [Stereo] is normal stereo that records 
separately on the left and right sides. If there is a large difference between the left and right 
audio, compared to stereo that saves audio with a greater focus on one side, [Dual Channel] 
records totally independently so that there is no bias in sound quality to one side. Select to 
enter narration in 2 languages, etc. [Joint Stereo] improves audio quality and compression ratio 
when recording left and right audio separately by automatically using a single channel that 
combines the audio when the left and right sides are the same or one more channel when the 
left and right audio are different.
[Bit Rate]
Select a bitrate from the list.

 r [Extended Settings] tab

[Video settings] [Field Order]
For interlace, a field order can be selected.
[Chroma Format]
Select a YUV pixel format from the list.
[Profile & Level]
Select a profile & level. If [Chroma Format] is [4:2:0] and [4:2:2], the profile will be set to Main 
Profile and 422Profile, respectively. The level for SD image quality will be Main Level, and 
the level for HD image quality will be High Level. The profile & level changes according to the 
format selected in [Chroma Format].
[GOP Structure]
For MPEG, a certain number of frames is considered as a group, and operations such as 
compression/enlargement and cut editing are performed on a GOP basis. A GOP comprises 
“I frame”, “P frame” and “B frame”. The I frame allows images to be reproduced independently, 
the P frame is for recording and reproducing only the differences with the preceding image, 
and the B frame reproduces images from the differences in the preceding and following 
images. Select I, P and B frame patterns of the GOP from the list. Normally, select [IBBP].
[I-Frame Only] is comprised of only I-pictures. Editing is made easier, but the amount of data 
increases in size.
[Picture count]
Set the number of frames included in a group.
[Closed GOP]
Check this item to complete information within each GOP. Although the amount of data 
increases, the video can be re-edited using software that supports GOP-based editing. 
Normally, leave this item unchecked.
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[Audio settings] [Emphasis]
Select from the list for high-frequency compensation that saves while emphasizing the high 
range. With [None], there is no high-frequency compensation. [50/15 us] is an emphasis 
setting employed by some audio CDs, etc. [CCITT J.17] is a telecommunications standard 
recommended by CCITT.
[Protection]
The “protection_bit” indicates whether redundancy is added to an audio stream in order to 
make error detection and correction possible. Check this item to change it to “1”, indicating that 
redundancy is being added. Uncheck this item to change it to “0”, indicating that redundancy is 
not being added.
[Original Flag]
Check this item to change the “original_copy” bit to “1”, indicating the original copy. If it is 
unchecked, it becomes “0”, indicating a duplication.
[Copyright Flag]
Check this item to change the “copyright” bit to “1”, indicating that the copyright is protected. If 
it is unchecked, it becomes “0”, indicating there is no copyright.

Still Image Format
You can export the timeline as still image files.

1) Click [Other] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Click [Still Image], and click [Export].

3) Specify a file name and export destination, and select the export format.
 f A sequential number will be added based on the file name entered.

[Advanced] Change the aspect ratio correction or export field settings. The settings for [Still Image] in 
[System Settings] will be the initial values.
“[Still Image]” (w page 105)

2
 f For example, if “Still1” is entered as the file name, the exported image files will become “Still1”/“Still2”/“Still3”... and if “Still5” is entered as 
the file name, the exported image files will become “Still5”/“Still6”/“Still7”..., etc. If a number is not added at the end of the file name, an 
8-digit sequential number will be added automatically.

4) Click [Save].
 f The video is exported as still images.

Flash Video (F4V) Format
Projects can be exported in F4V format for Flash.

2
 f If [Color Space] is set to [BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ] in [Project Settings], HDR metadata will be added at the time 
of export.

1) Click [H.264/AVC] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Click [F4V], and click [Export].
 f The [F4V] dialog box appears.
“[F4V] Dialog Box” (w page 441)

3) After setting the export details, specify a file name and save destination and click [Save].

[F4V] Dialog Box

 r [Basic Settings] tab



Chapter 11   Export — Exporting in File Formats

442

[Video settings] [Profile]
Set the profile. The selectable profiles will differ depending on the frame size to be exported.
[Bit Rate Type]
[CBR] assigns a constant number of bits. Although noise, etc. may be present, the encoding 
process is made quicker.
[VBR] changes the assigned bitrate according to the complexity of the movement or image 
quality. Compared with [CBR], the media volume can be used more efficiently, and this enables 
more consistent image quality overall.
[Average]
Set this item if [CBR] or [VBR] has been selected as the bitrate type. You can either select from 
the list or enter values directly.
[Max]
Set this item if [VBR] has been selected as the bitrate type. You can either select from the list 
or enter values directly.
[Quality]
Select the image quality from the list.
[Use Hardware Encoder]
Check this item to output video using hardware encoding such as Quick Sync Video. 
Unchecking this item will output video using H.264 software encoder that enables high-quality 
and high-speed encoding.
In an environment where hardware encoding is not available, [Use Hardware Encoder] will not 
be displayed. The encoder for output will be fixed at H.264 software encoder.

[Audio settings] [Format]
The audio compression format will be fixed at [AAC].
[Bit Rate]
Select a bitrate from the list.

 r [Extended Settings] tab

[GOP Structure] Select the GOP structure.
[Picture Count] Set the GOP length.
[Number of Reference Frames] Set the maximum number of frames to be taken into consideration in motion estimation.
[Multi Slice] Check this item to divide 1 frame into 4 parts. If the decoder supports multi-slicing, the 

decoding may be made quicker.
[Entropy Coding Mode] Select the H.264 encoding mode.
[Adjust bitrate by pixels per sec] Check this item to adjust the bitrate in accordance with the number of pixels per second.
[Bit Depth] Video quantization bitrate is fixed at [8].
[Chroma Format] Pixel format of YUV is fixed at [4:2:0].

 r [Metadata] tab

[Export sequence marker as cue 
point]

Check this item to export sequence markers as cue points for Flash. Select the name of the 
type of cue point.

[Metadata] Export is possible with metadata appended.
Select an item from the [Name] list, and enter metadata at [Value].

[Import] Import XMP format (*.xmp) metadata. This is reflected in the [Metadata] setting.
[Export] Export the settings made at [Metadata] in XMP format.

AVCHD Format
AVCHD streams can be easily exported to an SD memory card or memory stick. A file can be exported to any desired save destination.
If exporting to removable media, make sure to connect the SD memory card or memory stick to the PC before export.

2
 f If you want to edit a menu, etc. use Disc Burner to write the project to DVD or BD.
“Exporting to Disc” (w page 455)

3 Note
 f If you try to export a file to the internal hard disk or internal memory of an AVCHD video camera or a removable disk to play it back on 
the AVCHD video camera, export or playback may not be available on some cameras.

 f You cannot write AVCHD streams from EDIUS directly to a DVD-R or BD.
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1) Click [AVCHD] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Select an exporter, and click [Export].
 f To write to removable media, click [AVCHD Writer] or [AVCHD 3D Writer], and proceed to step 3).
 f To export to an AVCHD format file without writing to removable media, click [AVCHD] or [AVCHD 3D], and proceed to step 5).

3 Note
 f Depending on the type of save destination, a warning message may be displayed saying that data will become unrecognizable. Be 
sure to create a backup before export, as required.

3) Select [Drive] in [Destination].
 f The SD memory card or memory stick connected to the PC will be recognized as an external drive.

2
 f You can select [Folder] and click [Select] to export an AVCHD stream to a specific location on the PC.

4) Select [SD Memory Card] or [Memory Stick / HDD Camera] in [Format].
 f Select according to the media being used.

5) Configure each item in the [Basic Settings] tab and [Extended Settings] tab.
 f For the setting items, see the descriptions given for the [Basic Settings] tab/[Extended Settings] tab in “BD Format”.
“BD Format” (w page 436)

6) Click [OK].
 f For [AVCHD] or [AVCHD 3D], set a file name and save destination, and click [Save].

2
 f If a stream file size exceeds 2 GB, the file will be split up and exported.

Exporting in 3DA1 Format
Projects can be exported in the 3DA1 format to an SD/SDHC memory card. A file can be exported to any desired save destination.
If exporting to an SD/SDHC memory card, make sure to connect the memory card to the PC before export.

1) Click [AVCHD] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Click [AVCHD (Dual Card 3D) Writer], and click [Export].

3) Set the export destination for the L side and the R side in [Destination 1] and [Destination 2] 
respectively.

 f To export to a camera, select [Drive], and set the export destination from the list.
 f To export to the hard disk on the PC, select [Folder], and click [Select] to set the export destination.

4) Configure each item in the [Basic Settings] tab and [Extended Settings] tab.
 f For the setting items, see the descriptions given for the [Basic Settings] tab/[Extended Settings] tab in “BD Format”.
“BD Format” (w page 436)

5) Click [OK].

XDCAM EX Format
Projects can be exported to an SxS memory card or an SDHC memory card in the XDCAM EX format.
Connect a device to the PC, and check the power is turned on.
Files can also be exported to the PC hard disk.
You can also export in the XDCAM EX 3D format.
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3 Note
 f Be sure to format the SxS memory card with the XDCAM EX device or a device that supports XDCAM EX 3D in advance.

1) Click [XDCAM] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Select an exporter, and click [Export].
 f Select either [XDCAM EX], [XDCAM EX DV] or [XDCAM EX 3D] as the exporter.

3) Set the export destination, quality, metadata, etc., and click [OK].
 f The setting items will differ depending on the exporter.

Example:

If [XDCAM EX] has been selected.

[Destination] Select whether to export to an SxS memory card, to export to an SDHC memory card, or to 
save to a local folder. A file is exported in a folder structure.
If [Sony - SxS Memory Card] or [JVC - SDHC Memory Card] is selected, select a card from the 
list.
If [Automatically select the next card when card is full.] is checked, when free space runs out 
on the SxS memory card selected as the export destination, an SxS memory card with free 
space will be selected automatically and exported to. If it is unchecked, a dialog box will be 
displayed to select the export destination.
If [Folder] has been selected, click [...] and specify a save destination.

[Segment Encode] Check this item to export a clip of a raw source without re-encoding. This increases the output 
speed.

[ClosedGOP] Check this item to complete information within each GOP. Although the amount of data 
increases, the video can be re-edited using software that supports GOP-based editing.

[Audio/Stereo] Check this item to export the audio as a stereo track. This is only displayed when the audio 
channel is 2ch.

[Mode] Select an image quality mode (SP or HQ).
[Quality/Speed] Select quality from the list. The higher the quality, the more time it takes to be encoded.
Metadata Add metadata such as title and comments to clips to be exported.

2
 f If [XDCAM EX 3D] has been selected as the exporter, the operations are subject to the following restrictions.

 g If [Sony - SxS Memory Card] has been selected for [Destination], only memory cards in two slots on the L side can be recognized on 
the PC due to the specifications of Sony memory camcorder. Insert memory cards into the slots on the L side. After exporting, reinsert 
the cards into the slots on the R side.

 g If the free space runs out on the export destination drive during an export operation, the [Select Memory Card Drive] dialog box 
appears. However, when [Destination] is [Folder] or when batch export is being performed, this dialog box does not appear.

 g If [Folder] is selected for [Destination], the export destination for L and R cannot be set to the same location.
 f When exporting has been performed by splitting up the export onto multiple SxS memory cards, the place exported to will be registered in 
the bin as sequence clips. However, if one of the SxS memory cards is not attached during registration, it will not be registered in the bin.

“[Select Memory Card Drive] Dialog Box” (w page 444)

[Select Memory Card Drive] Dialog Box

[Memory Card]: [L]/[R] Select the next memory card drive.
[OK] Click this item after selecting a drive or after replacing a memory card.

P2 Format
You can export a project to a P2 card.
Connect the P2 device to the PC, and check that the power is turned on.
Files can also be exported to the PC hard disk.

2
 f If data is to be exported by the AVC-Intra or AVC-Ultra codec and [Color Space] is set to [BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 
PQ] in [Project Settings], HDR metadata will be added at the time of export.
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3 Note
 f Make sure that the P2 device drivers are already installed.
 f Audio will be exported in 16-bit format audio, even if the project preset is set to 24-bit format audio.

1) Click [P2] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Select an exporter, and click [Export].
 f Select from [P2 Clip], [HD P2 Clip], [HD P2 3D Clip] or [AVCUltra P2 Clip] for the exporter. Exporters that do not support the project 
settings will not be displayed.

3) Set the export destination, user clip name, codec, etc., and click [OK].
 f The setting items will differ depending on the exporter.

2
 f Metadata, such as the created by and capture information, can be imported from another P2 clip. Click [Load Metadata] and select the 
XML file to be imported.

 f If there is no more free space in the export destination or if the clip consists of files with a size exceeding 4 GB in total, the clip will be split 
up and exported.
If [Automatically select the next card when card is full.] is checked, when the clip is split, a P2 card drive that has free space will be 
selected automatically and exported to. If it is unchecked, when the clip is split, a dialog box will appear to select the export destination.

 f If exporting at 720p, the export frames must be even frames. If a confirmation message appears, select a processing method.
 f If a DVCPRO HD export format and the settings content for an EDIUS project preset differ, the export data will be stretched before export 
so that the frame rate and the field order correspond to each other.

XDCAM Format
With the XDCAM exporter, you can output a project as an MXF file, and upload it to an XDCAM device.
MXF files can also be exported to the PC hard disk.

2
 f Files can also be exported to the XDCAM Memory drive (SxS memory card formatted with an XDCAM device).

3 Note
 f Be sure to format the SxS memory card with an XDCAM device in advance.
 f Files cannot be exported to an SxS memory card formatted in the XDCAM EX format.
 f Proxy files will not be exported.

1) Click [XDCAM] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Select an exporter, and click [Export].
 f Select from [XDCAM DV], [XDCAM HD], [XDCAM HD 422], [XDCAM HD 720P] or [XDCAM MPEG IMX] for the project image size.
 f Exporters that do not support the project settings will not be displayed.

3) Set the export destination, clip name, etc., and click [OK].
 f The setting items will differ depending on the exporter.

Example:

If [XDCAM HD] has been selected.

[Destination] Select whether to export to an XDCAM drive or to a desired PC folder. A file is exported in a 
folder structure.
If [XDCAM Drive] was selected, select a Drive from the list.
If [Folder] was selected, click [Select] and specify a save destination.

[Clip Name] Set the file name to be exported.
[Auto (C****)]
If it is checked, a file name will be set automatically. To set a preferred file name, remove the 
check from [Auto (C****)] and enter a name in [Clip Name]. (“Clip Naming” must be set as 
“Free” on the XDCAM drive.)
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[Segment Encode] Check this item to export a clip of a raw source without re-encoding. This increases the output 
speed.

[Bit Rate] Select a bitrate from the list.
[Quality/Speed] Select a quality.
[ClosedGOP] Check this item not to use the B-picture at the GOP border as reference across GOPs. 

Although the amount of data increases, the video can be re-edited using software that 
supports GOP-based editing, as the information is completed within each GOP.

[Audio Format] Select the audio format to export.

2
 f If a clip is exported that does not include high-resolution or proxy data, a dialog box will appear to set the processing before export. Select 
a processing method and click [OK].

 f If [XDCAM MPEG IMX] was selected, 3 lines (black) will be added above and below the 720x480 video to be exported as Even (Top Field 
First).
Also, 720x576 (Odd) video will be shifted by 1 line to be exported as Even (Top Field First).

XAVC S Format
You can export a project to an XQD memory card in the XAVC S format.
Connect a device to the PC, and check that the power is turned on.
Files can also be exported to the PC hard disk.

2
 f If [Color Space] is set to [BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ] in [Project Settings], HDR metadata will be added at the time 
of export.

3 Note
 f Be sure to format the XQD memory card with an XAVC S device in advance.

1) Click [XAVC] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Click [XAVC S], and click [Export].

3) Set the export destination, clip name, etc., and click [OK].

[Destination] Select whether to export to an XAVC S device or to a desired PC folder. A file is exported in a 
folder structure.
If [Memory Card] is selected, select a device from the list.
If [Folder] is selected, click [...] and specify a save destination.

[Video settings] [Bit Rate]
Select a bitrate from the list.
[Quality]
Select an image quality.
[Use Hardware Encoder]
Check this item to output video using hardware encoding such as Quick Sync Video. 
Unchecking this item will output video using H.264 software encoder that enables high-quality 
and high-speed encoding.
In an environment where hardware encoding is not available, [Use Hardware Encoder] will not 
be displayed. The encoder for output will be fixed to H.264 software encoder.

[Audio settings] Select the audio format of the video to be exported.
Metadata Add metadata such as title and comments to clips to be exported.

XAVC Format
With the XAVC exporter, you can export a project and upload it to an XDCAM device.
Files can also be exported to the PC hard disk.

2
 f Files can also be exported to the XDCAM Memory drive (SxS memory card formatted with an XDCAM device).
 f If [Color Space] is set to [BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ] in [Project Settings], HDR metadata will be added at the time 
of export.
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3 Note
 f Be sure to format the SxS memory card with an XDCAM device in advance.
 f Files cannot be exported to an SxS memory card formatted in the XDCAM EX format.

1) Click [XAVC] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Click [XAVC], and click [Export].

3) Set the export destination, clip name, etc., and click [OK].

[Destination] Select whether to export to an XDCAM drive or to a desired PC folder. A file is exported in a 
folder structure.
If [XDCAM Drive] was selected, select a drive from the list.
If [Folder] was selected, click [Select] and specify a save destination.

[Clip Name] Set the file name to be exported.
[Auto (C****)]
If it is checked, a file name will be set automatically. To set a preferred file name, remove the 
check from [Auto (C****)] and enter a name in [Clip Name]. (“Clip Naming” must be set as 
“Free” on the XDCAM drive.)

[Format] Select the format to export.
[Quality/Speed] Select quality and speed.
[Audio Channels] Select the number of audio channels.

AAF Format
You can export a project in an AAF file.

1) Click [Other] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Click [AAF Project Exporter], and click [Export].

3) Set a file name and export destination, specify [Preset], and then click [Save].
 f “[Project Exporter (AAF)] Dialog Box” (w page 79)
 f If you want to check the preset settings or change export settings, click [Detail].
“[AAF Export Detail Settings] Dialog Box” (w page 79)

Exporting Closed Caption

Exporting a Project Containing Closed Caption Data

You can export a project that contains closed caption to a file.
A sidecar file (closed caption file) can be exported besides an output file, or closed caption data can be embedded into the output file.
 f Closed caption data on upper tracks will be prioritized in export.

1) Select an exporter in the category tree in the [Print to File] dialog box.
 f “Exporting with Exporter” (w page 429)

2) Select the export method from the list on the left of [Captions].

[None] A file will be exported with the closed caption data removed.
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[Sidecar File] A normal file and sidecar file (closed caption file) are exported separately. Select the export 
method of the closed caption file from the list on the right.
 f The closed caption file formats supported for export are as follows.

 g *.scc
 g *.mcc

 f An exported closed caption file will be named as “Output file name.Container name.scc” or 
“Output file name.Container name.mcc”.

 f If the conditions below are satisfied, two closed caption files will be exported.
 g [Scenarist Closed Caption (.scc) file] has been selected for the export format.
 g The output file has information on both CC1 and CC3 for CEA-608.

In this case, the file names will be “Output file name.Container name.scc” (CC1) and “Output 
file name_cc3.Container name.scc” (CC3).

[Burn into Video] A file will be exported with the closed caption displayed on the screen. In the exported file, 
closed caption will always be displayed.
 f The standard and type set for the closed caption display will be applied to the closed caption 
to be exported.
“Setting Closed Caption Display” (w page 152)

[Embed in File] Closed caption data is embedded in the output file and output as a single file.
 f This item can be selected when a file is exported in the MXF format.
 f This item does not appear when [Preserve Ancillary data] in the sequence settings has been 
disabled.

 f Ancillary data including closed caption data will be exported from the position of frame 0 on 
the timeline regardless of existence of closed caption data.

3) Click [Export].

4) Set the export contents, and click [Save] or [OK].
 f The export contents differ depending on the selected exporter. See the explanation for the respective exporter.

3 Note
 f If [Sidecar File] or [Embed in File] has been selected for [Captions], changing [Frame Rate] in the [Print to File] (Detailed Settings) 
dialog box will disable export of closed caption.

 f If [Sidecar File] has been selected for [Captions], exporting with the following exporters will output a sidecar file (closed caption file), 
but will not register it to the bin.
 g Exporters in the [Audio] category
 g [Still Image]

 f If one of the exporters in the category [AVCHD] has been selected, [Sidecar File] cannot be selected for [Captions]. Also, if files are to 
be exported to an XDCAM device using the [XDCAM] exporter, [Sidecar File] cannot be selected.

 f The [Remove Ancillary data] setting in the [Print to File] (Detailed Settings) dialog box does not affect the export of closed captions.
 f Some combination of input and output formats may cause change of data format or defects in output file.
 f Closed caption data are not re-encoded. The input data will be output as they are.
 f MCC Version 2 can be imported. However, the option parameters will not be evaluated.
 f The 608 ancillary data packets (DID=61h and SDID=02h) are not supported.

Exporting Closed Caption File Alone

You can export the closed caption of a project alone to a file.

1) Click [Captions] in the [Print to File] dialog box category tree.
 f “Exporting with Exporter” (w page 429)

2) Select an exporter, and click [Export].

3) Set a file name and saving destination, and click [Save].

Exporting Stereoscopic Project
Projects created in the stereoscopic edit mode can be exported to file.
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Exporting L/R to a File

Export the data of the L and R sides of the project to a file.

1) Select an exporter in the category tree in the [Print to File] dialog box.
 f “Exporting with Exporter” (w page 429)

2) Select one of [L/R Dual Stream], [Left only], [Right only], [Side by Side], [Top and Bottom], [Line 
Interleave], [Blend], [Anaglyph], or [Difference] from the [Stereoscopic] list.

 f [L/R Dual Stream] exports the video of the L and R sides to a single dual stream-compatible file.
 f [Left only]/[Right only] exports video of the L or R side only to a single file.
 f [Side by Side]/[Top and Bottom]/[Line Interleave]/[Blend]/[Anaglyph]/[Difference] combine and export the video of the L and R sides to a 
single file.
“Stereoscopic Processing Type” (w page 153)

3) Click [Export].

4) Set the export contents, and click [Save] or [OK].
 f The export contents differ depending on the exporter. See the explanation for the respective exporter.

Exporting L/R to Separate Files

You can output the video of the L and R sides separately to two different files.

1) Select an exporter in the category tree in the [Print to File] dialog box.
 f “Exporting with Exporter” (w page 429)

2) Select [Separate Left and Right] from the [Stereoscopic] list.

3) Click [Export].
 f The export settings screen appears.

4) Set a file name and export destination for the L and R sides.
 f “L/R file name common settings” (w page 449)
 f “L/R Export Destination Common Settings” (w page 449)

5) Set the export details in the dialog box in step 4).
 f The export details differ depending on the exporter. See the explanation for the respective exporter.

6) Click [Save] or [OK].

 r L/R file name common settings

[File Name L]/[File Name R] Click [Browse], and specify save destination. The files for the L and R sides are saved to the 
same folder.

[Suffix] Set the suffix of the file name for the L and R sides.

 r L/R Export Destination Common Settings

[Destination L]/[Destination R] Click [Browse], and specify each export destination for the files for the L and R sides.

Registering Exporter Configuration as Default Exporter
Click [Export] on the Recorder and select [Print to File (Default Exporter)] or [Add to Batch Export (Default Exporter)] to register a default 
exporter that can be selected by simple operation. The exporter settings can also be registered in combination with the conversion settings 
used to export in a format that differs from the project settings. Four exporters can be registered.
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Creating Default Exporter
Register exporter configuration as a default exporter.

1) Select an exporter in the [Print to File] dialog box.
 f “Exporting with Exporter” (w page 429)
 f Configure the conversion settings with the purpose of registering the conversion settings, which export in a format that differs from the 
project settings, as a preset.
“Exporting in a Format that Differs from the Project Settings” (w page 432)

2) Click the [Save as default] list button in the [Print to File] dialog box, and click a number to which the 
default exporter is to be registered → [Save].

 f The exporter is registered as a default exporter.

1 Alternative
 f Selecting an exporter in the [Print to File] dialog box and then clicking [Save as default] registers the exporter to [1] of [Current default].

2
 f When you click [Current default] in the category tree, all user-registered default presets are displayed in the exporter/preset list.
 f You can rename exporters registered as [Current default]. Click the [Save as default] list button in the [Print to File] dialog box, click the 
number of the exporter to rename → [Rename], and edit the name.

Deleting Default Exporter
Registered default exporters can be deleted.

1) Click the [Save as default] list button in the [Print to File] dialog box, and click a default exporter to 
be deleted → [Delete].

 f The default exporter will be deleted.

Registering Exporter Settings as Preset
You can register frequently used exporter settings as presets. The exporter settings can also be registered in combination with the 
conversion settings used to export in a format that differs from the project settings.

Creating Exporter Presets
An exporter setting can be registered as an exporter preset.

1) Select an exporter in the [Print to File] dialog box.
 f “Exporting with Exporter” (w page 429)
 f Configure the conversion settings with the purpose of registering the conversion settings, which export in a format that differs from the 
project settings, as a preset.
“Exporting in a Format that Differs from the Project Settings” (w page 432)

2) Click [Save preset] in the [Print to File] dialog box.
 f [Preset Dialog] will be displayed.

3) Enter an exporter preset name in [Preset name], and configure the export details.
 f The export contents differ depending on the exporter.

2
 f You can enter your preferred description in [Description]. It will be displayed at the exporter/preset list in the [Print to File] dialog box.

4) Click [OK].
 f The created preset is registered in the exporter/preset list.

2
 f When you click [My presets] in the category tree, all user-registered exporter presets are displayed in the exporter/preset list.
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 f To change the settings of an already-created exporter preset, select the exporter preset to be changed, click [Save preset] and change 
the settings.

Deleting Exporter Presets
You can delete the exporter presets that you have created.

1) Select the exporter preset to be deleted in the [Print to File] dialog box.
 f “Exporting with Exporter” (w page 429)

2) Click [Delete preset] in the [Print to File] dialog box.

3) Click [Yes].

2
 f Only exporter presets that have been registered by the user can be deleted.

Importing Exporter Presets (Import)
You can import exporter presets.

1) Click [Import preset] in the [Print to File] dialog box.
 f “Exporting with Exporter” (w page 429)

2) Select a file, and click [Open].

2
 f When you click [My presets] in the category tree, imported exporter presets are displayed in the exporter/preset list.

Exporting Exporter Presets (Export)
You can export the exporter presets that you have created.

1) Select an exporter preset in the [Print to File] dialog box.
 f “Exporting with Exporter” (w page 429)

2) Click [Export preset] in the [Print to File] dialog box.

3) Enter a file name, select the save destination and click [Save].

2
 f Exportable presets are the user-registered exporter presets, default exporters, and recently used exporters.

Exporting Multiple Sequences/Ranges Together
You can register exporters and ranges to be exported as a batch list, to export multiple ranges together that have been registered as a batch 
list.

Registering Ranges to Be Exported in a Batch List
You can specify exporters and ranges to be exported and register them in a batch list.

1) Set the In and Out points of a range to be exported.
 f “Setting the In and Out Points on the Timeline” (w page 232)
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2) Select an exporter in the [Print to File] dialog box, and click [Add to Batch List].
 f “Exporting with Exporter” (w page 429)

3 Note
 f If an exporter that does not support batch export has been selected, [Add to Batch List] will become disabled and you cannot add it to 
the batch list.

1 Alternative
 f After setting the In and Out points of a range to be exported, click [Export] on the Recorder, and click [Add to Batch Export].
 f After setting the In and Out points of a range to be exported, right-click the time scale and click [Add to Batch Export].
 f After setting the In and Out points of a range to be exported, click [File] on the menu bar, and click [Export] → [Add to Batch Export].
 f After setting the In and Out points of a range to be exported, right-click in the export list of the [Batch Export] dialog box and click [New].
“[Batch Export] Dialog Box” (w page 453)

3) After setting the export details, specify a file name and export destination and click [Save] or [OK].
 f Click [Save] or [OK] to register in the batch list.
 f The export contents differ depending on the exporter.
 f If you want to add multiple ranges from within a single project to the batch list, repeat the operations to set In and Out points and add to 
the batch list.

2
 f After setting the In and Out points of a range to be exported, you can right-click the time scale and select [Add to Batch Export (Default 
Exporter)] → a default exporter to use. After setting the In and Out points of a range to be exported, you can also click [Export] on the 
Recorder and select [Add to Batch Export (Default Exporter)] → a default exporter to use.
The file name and save destination are automatically set as follows. (When no default exporter is set or when [Export] is disabled, [Add to 
Batch Export (Default Exporter)] cannot be selected.)
 g File name: Exp MonthDay_000 (3-digit sequential number) + extension
 g Save destination: Project folder

“[Print to File] Dialog Box” (w page 430)
 f After setting the In and Out points of a range to be exported, if you right-click the time scale and click [Add to Batch Export (Project 
format)], the specified range is added to the batch list with the format specified in [Render format] of the [Project Settings] (Detailed 
Settings) dialog box. In this case, the file name and destination are set automatically as shown below: [Add to Batch Export (Project 
format)] cannot be selected when [Export] is disabled.
 g File name: Exp MonthDay_000 (3-digit sequential number) + extension
 g Save destination: Project folder

“[Project Settings] (Detailed Settings) Dialog Box” (w page 59)
 f The content of the batch list can be changed in the [Batch Export] dialog box.

Exporting Multiple Ranges Together (Batch Export)
You can export multiple ranges registered in the batch list together.

1) Click [Export] on the Recorder.

2) Click [Batch Export].
 f The [Batch Export] dialog box appears.
“[Batch Export] Dialog Box” (w page 453)

1 Alternative
 f Click [File] on the menu bar, and click [Export] → [Batch Export].

3) Check the item to be exported, and click [Export].
 f The rendering job will be registered to the Render Service. When registration to the Render Service has been completed, the checkbox in 
the [Batch Export] dialog box will be unchecked. An indication appears on the PC screen to notify that rendering will be started.
Registered rendering jobs are processed in the background in a sequential order of the predetermined priority. The progress of the 
rendering process can be checked on GV Job Monitor.
“GV Job Monitor” (w page 332)

 f The color of the GV Job Monitor icon on the status bar turns to purple while a batch export rendering job is being processed.
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 f Even if the project file is closed before the rendering process is completed, the process of the rendering job will be continued.
When the rendering process has been finished, an indication appears on the PC screen to notify that rendering has been finished. The 
color of the icon on the status bar returns to its original state.
“GV Job Monitor Icon Indication” (w page 332)

 f To register the exported file to the bin, right-click on the rendering job in the list of completed jobs on GV Job Monitor, and then click [Add 
to Bin].

2
 f After setting the In and Out points of a range to be exported, you can register a new range for export by right-clicking on the export list 
and clicking [New].

 f If you right-click the export list and click [Select All], you can select all ranges registered for export. Check one of multiple selected items 
to check all the selected items.

 f If you right-click an item on the export list and click [Change Exporter], you can change the exporter. You can change the exporter for 
multiple selected items. However, if those items include an exporter for which the file name cannot be set, such as the P2 exporter, 
changes will be applied to all selected exporters excluding that exporter.

 f Clicking [Open] on the notification of start/finish of file export will start up GV Job Monitor. Clicking [Close] will close the notification.
 f The notification for start/finish of file export will be indicated in accordance with the setting of your Windows.

3 Note
 f If you delete a sequence registered in the batch list from both the timeline and bin, the batch list will become disabled and will be 
displayed in red.

 f If you change the sequence settings or project settings of a sequence registered in the batch list, the changes will also be applied in 
the batch list. If changes are made that mean an exporter can no longer be used, the exporter is displayed in red in the batch list and 
its export cannot be performed.

[Batch Export] Dialog Box

(1) [Add to Batch Export] When this button is clicked while a range to be exported is selected, the [Print to File] dialog 
box appears. An item is added to the batch list when you configure export settings.

(2) [Add to Batch Export 
(Default Exporter)]

When this button is clicked while a range to be exported is selected, an item is added to the 
batch list.
The exporter will be set to [1] in [Current default].

(3) [Add to Batch Export 
(Project format)]

When this button is clicked while a range to be exported is selected, an item is added to the 
batch list.
The rendering format will be set to [Render format] in the project settings.

(4) [Delete Batch Export 
item]

When this button is clicked while an item is selected on the list, the item is deleted from the 
batch list.
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(5) Export list Displays the batch list to which items have been added, where you can check and change the 
export content. Check the items to be exported.
[Sequence]
Displays sequence names.
[In]/[Out]/[Duration]
Click the values to edit them. If the Out point is set before the In point or the In point exceeds 
the clip range, it is displayed in red and export cannot be performed.
[Stereoscopics processing]
 Click  to change the format of stereoscopic processing. Selectable items differ depending 
on the selected exporter.
[Show TC]
Check this item to export sequences with their timecodes displayed.
[Waveform Cache]
Check this item to create waveform cache (waveform representation of audio). This setting may 
not be available depending on the selected exporter.
[Exporter]
Click on the icon to the right of the exporter name column to display the [Print to File] dialog 
box.
“[Print to File] Dialog Box” (w page 430)
[File Size]
Displays the file size. If the total size of the file to be exported exceeds the free space in the 
export destination, a warning dialog box may appear and the export cannot be performed.
The displayed file size is only a guide. The size of the file to be exported will change dependent 
on the video content and the selected exporter.
[File Name]
Click on the icon to the right of the file name column to change the file name, export destination 
and export content.

(6) [Export]/[Cancel] Start an export.
The button changes to [Cancel] during export, and click it to cancel the export.

(7) [Close] Close the [Batch Export] dialog box.

Deleting Registered Ranges from the Batch List
You can delete ranges registered in the batch list.

1) Click [Export] on the Recorder.

2) Click [Batch Export].
 f The [Batch Export] dialog box appears.
“[Batch Export] Dialog Box” (w page 453)

3) Select an item to delete and click [Delete Batch Export item].

2
 f If you remove the check from export range items in the [Batch Export] dialog box, you can exclude those items from the export without 
deleting the items.
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Exporting to Disc

Exporting to DVD/BD
You can export a project as a disc image file to be written to DVD/BD.
Regardless of the details of the project settings, you can start up Disc Burner and write the project to DVD or BD. Even projects in 
progressive formats (such as 60p) can be written to DVD/BD by changing the export format on Disc Burner.

3 Note
 f If format conversion is performed at export, the image quality will be affected.

Exporting to Disc
You can write a project to a DVD/BD. You can create title and chapter menus, as well as set the background of the menu screen and buttons 
displayed on the screen.

2
 f To export only one part of an edited video, make sure to specify the export range using a [Set In] and [Set Out] on the Recorder.
“Setting the In and Out Points on the Timeline” (w page 232)

 f To add a chapter, make sure that an orange sequence marker is set to the desired position in advance.
“Setting Sequence Markers” (w page 287)

3 Note
 f When exporting to disc, you will need sufficient free space on the HDD.
 f You will also need a drive that supports writing to DVD/BD.
 f If packet writing software of another company is installed/running on your PC, you cannot export to DVD/BD from EDIUS.

1) Click [Export] on the Recorder.

2) Click [Burn to disc].
 f Disc Burner starts up.

1 Alternative
 f Click [File] on the menu bar, and click [Export] → [Burn to disc].
 f Exporting to DVD/BD: [Shift] + [F11]

2
 f Clicking [Return] ends the settings, and returns to EDIUS. If you return to EDIUS and save the project, the settings of “Exporting to Disc” 
will also be saved.

3) Click the [Basic] tab, and set the disc type or codec.
 f “[Basic] Tab” (w page 456)

4) Click the [Movie] tab, and set the movie to be exported to disc.
 f “[Movie] Tab” (w page 456)

5) Click the [Style] tab, and set the style for the menu screen.
 f “[Style] Tab” (w page 456)

6) Click the [Edit] tab to edit the menu.
 f “[Edit] Tab” (w page 457)
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7) Click the [Write] tab to set the export settings.
 f “[Write] Tab” (w page 458)

8) Click [Create Disc].
 f Start writing to disc.
 f When you perform format conversion at export, in the confirmation dialog box that appears, click [Yes].

[Basic] Tab

[Disc] Select the type of disc to be exported to from the list.
[Format]
Select the format to export.
To export in the same format as the original project settings, select the format with the 
indication [(No conversion)].
The formats that can be selected are as follows. The displayed formats differ depending on the 
project settings.
 f If [DVD] has been selected for [Disc]
720x480 59.94i, 720x576 50i

 f If [Blu-ray] has been selected for [Disc]
1920x1080 59.94i, 1920x1080 50i, 1920x1080 23.98p, 1440x1080 59.94i, 1440x1080 50i, 
1280x720 59.94p, 1280x720 50p, 720x480 59.94i, 720x576 50i

[Codec] When exporting to BD, select the codec.
[Menu] Select [Use Menu] to create a disc with a menu screen.

3 Note
 f If the project setting is the NTSC standard such as 59.94i, the export format for the PAL standard such as 50i cannot be selected. 
Likewise, if the project setting is the PAL standard, the export format for the NTSC standard cannot be selected.

[Movie] Tab

[Disc Information] Displays the number and file size of the titles to be added and the available disc space.
[Media] Select the type of disc to be exported to from the list.
[Movie] Displays the added titles.

[Settings]
Displays the settings dialog box used to change the bitrate.
“[Title setting] dialog box” (w page 456)
[Delete]
Remove titles from the list. Does not delete the original file.
[Up]/[Down]
Change the order of titles.

[Add File] Click this button to display the [Add Title] dialog box. Select a file, and click [Open].
[Add Sequence] Click this button to display the [Select Sequence] dialog box. Check the sequence to be added 

and click [OK].

 r [Title setting] dialog box

[Automatic] Uncheck this item to set the format and bitrate for video and audio.
[Prohibit Operations During Playback] Disable operations such as moving chapters or fast-forwarding by the user during title 

playback.
[Display Timecode] Add a timecode to the video if the title is a sequence. The type of timecode can be set at 

[Application] in [User Settings] → [Timeline].
“[Timeline]” (w page 115)

[Stereoscopic] Stereoscopic processing is possible on sequences titled EDIUS only when exporting in MPEG-
2 format in the stereoscopic edit mode. Select the format of stereoscopic processing from the 
list.
“Stereoscopic Processing Type” (w page 153)

[Style] Tab

[Auto Layout] Set the placement of the buttons. Uncheck [Auto] to select the number of buttons to place from 
the [Row] and [Horizontal] lists.
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[Aspect Ratio] Select the size of the menu screen. If [BD] is selected for [Disc], you cannot select [4:3].
[Frame Rate] If [BD] is selected for [Disc], you can change the frame rate of the menu. Normally, there is no 

need to change the frame rate.
[No Chapter Buttons] Check this item to use thumbnails as chapter buttons.
[No Chapter Menu (Only One Chapter)] If there is only one chapter, only the title menu will be created.
[No Title Menu (Only One Title)] If there is only one title, only the chapter menu will be created with no title menu. Not displayed 

when there are multiple titles.
[Cursor style] Select the shape of the selection cursor displayed on the menu screen.
Style list Select a design for the menu screen from the list. The styles are classified in each tab 

according to type.

2
 f You can download and add a style.
Click [Help] on the menu bar, and click [Download DVD Menu Style] to download the setup file in the msi format. Double-click the setup 
file to add a style to the style list in the [Style] tab of Disc Burner.

 f If you have update from the version EDIUS 8 or earlier, a message prompting download of the setup file may appear to add a style. Follow 
the on-screen instructions to add a style.

[Edit] Tab

)

)

)

)

)
)

(1) Edit screen Displays a preview of the menu screen. Items can be edited directly, such as by clicking a title 
to enter text or moving or resizing pictures. If you double-click or right-click an item or picture 
then click [Setting], the [Menu Item Settings] dialog box appears.
“[Menu Item Settings] Dialog Box” (w page 458)

(2) Page selection Select the page of the menu to be edited from the list. Click the buttons to display the previous 
or next page.

(3) Edit buttons  : Undo an operation to return to the previous state.
 : Redo the undone operation.
 : Display lines as guidance.
 : Display a preview as viewed on TV.
 : Save the layout of the current page (background image, position of page labels, position of 
title buttons, position of page buttons).
 : Reflect a saved page layout to the current page.

(4) [Motion Menu] Check this item to set a video as the menu background. Set the video to be used at the 
[Picture] tab in the [Menu Item Settings] dialog box.
“[Menu Item Settings] Dialog Box” (w page 458)
[Length]
Enter the length of the motion menu. The maximum length is 1 minute.
[Fade In]/[Fade Out]
Check this item to add In/Out effects to the motion menu.
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(5) Item list Displays the items shown in the edit screen as a list. If you click an item in the list, a red frame 
appears around the selected item in the edit screen. If you double-click or right-click an item or 
picture then click [Setting], the [Menu Item Settings] dialog box appears.
“[Menu Item Settings] Dialog Box” (w page 458)

(6) [Setting] Select an item and click this button to display the [Menu Item Settings] dialog box.
“[Menu Item Settings] Dialog Box” (w page 458)

(7) Item position/size Change the position and size of an item by entering values.
 : Display lines as guidance using a selected item as reference.
 : Fix the aspect ratio of a selected item.

2
 f Multiple items can be selected by clicking items with the [Shift] key on the keyboard held down. If you right-click with multiple items 
selected, you can choose align top, align left, etc. by selecting [Placement].

 f You can add an item or picture by right-clicking on the item list. You can delete an item or picture by right-clicking an added item or picture 
and clicking [Remove Item].

[Menu Item Settings] Dialog Box

 r [Item] → [Text] tab

(1) Text field Enter the text to be displayed.
(2) Text settings Set the font, text size, decoration, and text position within the item display frame.
(3) Color settings Select from [Solid Color], [Gradation Color] or [Texture File]. Clicking [Color] displays the [Color 

Select] dialog box.
“[Color Select] Dialog Box” (w page 199)
To select a texture file, click [...] and select a file.

 r [Item] → [Picture] tab

Preview Display a preview with the current settings.
[Change] Click this item to change the image to be used for the thumbnail. Move the timeline cursor in 

EDIUS and click [Set].
[Set Image File] Import an image file or sequence to use for thumbnails. Check this item and click [select image 

file] to select a file, or click [Select Sequence] to select a sequence.
[Zoom] Change the zoom factor for an image by moving the position bar or by entering a value.

 r [Effect] → [Frames] tab

[Add Effects] Check this item to apply effects such as a frame or shadow to thumbnails. If you selected 
[Picture Frame], click [...] and select a file to use as a frame.

[Write] Tab

 r [Output] tab
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[Settings] Set the number of discs to write to and the volume label.
Drive information Set which drive to use and the write speed.
[Enable Detailed Settings] Check this item to add setting items.

[Folder Settings]
Specify the folder in which to save files (such as MPEG and disc image files) that are created 
for the purpose of making a disc.
[Compile disc image to folder]
Check this item to create only the disc image file, without writing it to disc media.
[Create Disc and Also Export as Image File]
Check this item to prevent deletion of the disc image file after the disc image file has been 
written to disc media. Check this item to save the disc image file on the HDD.
[Verify Disc After Creating]
Check this item to verify that data can be read correctly after having been written to media.
[Number of Drives]
Simultaneously write to a specified number of multiple drives. The settings tab for each drive is 
displayed in the drive information.

2
 f To create multiple discs with the same content, after 1 disc is created change the disc and continue the disc creation.
 f The disc image file that remains when [Create Disc and Also Export as Image File] is checked is overwritten upon export of another 
movie. If you need that disc image file, either change the folder settings or move the file from the save destination.

 r [Option] tab

[First play command] Select the action performed when a created disc is inserted into a disc player.
[Command after playing movie] Select the action performed after a playback of one title.
[Command after playing the last 
movie title]

Select the action performed after a playback of all titles.

Writing a Disc Image File to a Disc
You can write disc image files to disc.
You can write saved disc image files to disc. Make sure that the disc image file is saved to a preferred folder.

1) Click [Tools] on the menu bar, and click [Disc Burner].

1 Alternative
 f Click [Tools] in the bin window, and click [Disc Burner].

2) Select the folder where the disc image file is saved, and click [OK].

3) Configure the export settings.

[Media] Select the type of media to export to from the list.
[Settings] Set the number of discs to write to and the volume label.
Drive information Set which drive to use and the write speed.
[Image Folder] Select the folder in which the disc image file is saved. If outputting to DVD, be sure to specify 

a folder that contains a “VIDEO_TS” folder and “AUDIO_TS” folder. If outputting to BD, make 
sure to specify a folder that contains a “BDMV” folder and “CERTIFICATE” folder.

[Verify Disc After Creating] Check this item to verify that data can be read correctly after having been written to media.
[Number of Drives] Simultaneously write to a specified number of multiple drives. The settings tab for each drive is 

displayed in the drive information.

2
 f To create multiple discs with the same content, after 1 disc is created change the disc and continue the disc creation.

4) Click [Create Disc].
 f Start writing to disc.
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Exporting to Tape
To export a project to tape, hardware that supports tape output is required.
In this section, an example using Grass Valley hardware (STORM 3G) is described.

2
 f For the supported hardware, visit our website.
“Our Website” (w page 494)

Exporting to VTR
You can output data to VTR devices.

3 Note
 f You need to register the export destination VTR device as a device preset in advance.
“Registering Device Presets” (w page 130)

 f Output cannot be performed if the output format of the registered device preset for the VTR device differs from the format of the 
current project setting.

1) Connect STORM 3G to a VTR device using an SDI cable and RS-422 cable.
 f Configure the VTR device in advance so that it can be controlled remotely with RS-422.

2) Click [Export] on the Recorder.

3) Click [Print to Tape] or [Print to Tape (Display Timecode)].

1 Alternative
 f Click [File] on the menu bar, and click [Export] → [Print to Tape] or [Print to Tape (Display Timecode)].
 f Exporting to tape: [F12]

2
 f In an environment where the hardware that supports tape output cannot be used, [Print to Tape] and [Print to Tape (Display Timecode)] 
will not be displayed.

 f If the message [There is no output preset to match the project settings.] is displayed, reconfigure the formats of the project setting and the 
device preset.

4) Select a device preset, and click [Next].
 f The device presets that can perform export with the current project settings will be displayed.

5) Cue up to the position to start writing on tape.

2
 f To specify the position to start writing on tape, check [Rec In] and enter the timecode. If you click [Cue Up], the tape will cue up to the 
position of the entered timecode.

6) Click [Next].

7) Confirm the details, and click [Export].
 f Timeline playback and export start.
 f The [Print To Tape] dialog box disappears when the export finishes.

2
 f Click [Cancel] to abort the export.
 f If In and Out points have been set on the timeline, that range will be exported.
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Exporting Stereoscopic Projects to Tape
To export projects created in the stereoscopic edit mode to tape, you must first register the corresponding device preset. Set the export 
method in the [Output H/W, Format Settings] screen for device presets.
“[Output H/W, Format Settings] Screen” (w page 134)

Combining L/R and Exporting to Tape
Combine and export the video of the L and R sides of the project to tape.
Select the following items in the [Settings - Stereoscopic Setting] dialog box for device preset.
 f [L Only]
 f [R Only]
 f [Side by Side]
 f [Top and Bottom]
 f [Line Interleave]
 f [Blend]
 f [Anaglyph]
 f [Difference]
 f [Split Grid]

The operation procedure is the same as regular export to tape.
“Exporting to VTR” (w page 460)

Exporting L/R to Separate Tape
Export the video of the L and R sides of the project to separate tape.
Select [Yes] in [Stereoscopic   Separate L/R Clips] for device presets.

1) Perform steps 1) to 7) in “Exporting to VTR”.
 f “Exporting to VTR” (w page 460)
 f After step 7), the message [Insert L tape] will be displayed.

2) Insert the tape for the L side into the camera, and click [OK].
 f Export of L side data is started.
 f When export ends, the message [Insert R tape] is displayed.

3) Insert the tape for the R side into the camera, and click [OK].
 f Export of R side data is started.
 f The [Print To Tape] dialog box disappears when the export finishes.

2
 f Click [Cancel] to abort the export.
 f If In and Out points have been set on the timeline, that range will be exported.
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Chapter 12
Appendix
This chapter explains support and other information.



Chapter 12   Appendix — License Management

463

License Management

Serial Number Management

Starting up GV LicenseManager
GV LicenseManager is used for serial number management.

3 Note
 f To use GV LicenseManager, it must be executed in the environment where EDIUS is installed. The following description are examples 
for Windows 10.
The operation may differ depending on the type or version of OS on your PC.

1) Click the Windows logo at the lower left of the start screen to display the start menu, and click 
[Grass Valley] → [GV LicenseManager].

 f The [GV LicenseManager] starts up and the [License List] dialog box appears.
“[License List] Dialog Box” (w page 463)

1 Alternative
 f Right-click the GV LicenseManager icon in the task bar, and click [License List].
 f Double-click the GV LicenseManager icon in the task bar.

2
 f To exit GV LicenseManager, right-click the GV LicenseManager icon on the task bar, and click [Exit].

[License List] Dialog Box

XXXXX
XXXXX
XXXXX

XXXXX
XXXXX

XXXXX
XXXXX

XXXXX
XXXXX

XXXXX

XXX XXX XXX

(1)(2) (3) (4) (5)(6) (7) (8)(9) (10)

(1) [Online activation] Register the serial number.
“Activating EDIUS” (w page 47)

(2) [Online deactivation] Return licenses on the EDIUS terminal in the online environment to the activation server.
“Moving License in Online Environment” (w page 464)

(3) [Offline Activation  
Create ID File]

Create an ID file to activate licenses on the EDIUS terminal in the offline environment.
“Registering License (Offline Activation)” (w page 465)

(4) [Offline Activation  
Register Activation 
File]

Register the license activation file acquired from the activation server to the EDIUS terminal in 
the offline environment.
“Registering License (Offline Activation)” (w page 465)

(5) [Offline Deactivation  
Create ID File]

Create an ID file to deactivate licenses on the EDIUS terminal in the offline environment.
“Unregistering License (Offline Activation)” (w page 464)

(6) [Offline Deactivation  
Register Activation 
File]

Register the license deactivation file acquired from the activation server to the EDIUS terminal 
in the offline environment.
“Unregistering License (Offline Activation)” (w page 464)

(7) [Online Repair] This item is not available.
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(8) [Offline Repair  Create 
ID File]

This item is not available.

(9) [Offline Repair  
Register Repair File]

This item is not available.

(10) [Settings] Click this button for various settings.
“[Settings] Dialog Box” (w page 464)

[Settings] Dialog Box

[Use floating license server] Check this item to use EDIUS with a floating license. Enter [Server address] and [Port number].
[Show License Expiration Warning] Set the timing to display a warning message for license expiration.
[Administrator Password] Restrict license activation/deactivation operations to the administrator.

Check this item and enter the administrator password.

2
 f Part of the serial number can be displayed in the [License List] dialog box.
In the [License List] dialog box, right-click the product to confirm the serial number, and then click [Confirm part of serial number].

Moving License in Online Environment
The following explains how to move licenses between EDIUS terminals in the online environment.

1) Start up GV LicenseManager on the move source EDIUS terminal.
 f “Starting up GV LicenseManager” (w page 463)

2) Select products to deactivate licenses in the [License List] dialog box.

3) Click [Online deactivation], and click [Yes].
 f Access the activation server automatically and deactivate the licenses.

4) Start up EDIUS on the move destination EDIUS terminal.

5) Enter the serial number, and click [Register].
 f The license authentication is performed.

6) A message appears, and click [OK].

3 Note
 f eID activation is not necessary when unregistering the serial number.
 f To register the serial number to a new PC on which EDIUS is to be used, online activation of eID is required.

Transferring License in Online Environment
Move licenses between offline EDIUS terminals via another PC in the online environment.
 f To transfer a license in the offline environment, a storage device such as USB memory device is necessary.
This section describes the procedure to transfer a license using a USB memory device.

3 Note
 f To register the serial number to a new PC on which EDIUS is to be used, online activation of eID is required.

Unregistering License (Offline Activation)

Deactivate your license on the EDIUS terminal in the offline environment.

1) Connect a USB memory device to the PC where EDIUS is installed.
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2) Start up GV LicenseManager.
 f “Starting up GV LicenseManager” (w page 463)

3) Click [Offline Deactivation  Create ID File].

4) Select the USB memory device as the export destination in the [Destination for ID File] dialog box, 
and click [Select Folder].

5) A confirmation message appears, then click [OK].

6) Disconnect the USB memory device, and connect it to a PC that is connected to the Internet.

7) Open the USB memory device on the explorer and double-click GVDeactivation.exe.

8) A message [Do you wish to deactivate the license?] appears, then click [Yes].

9) A confirmation message appears, then click [OK].
 f Disconnect the USB memory device.

10) Connect the USB memory device to the previous EDIUS terminal, and start up GV LicenseManager.

11) Select products to deactivate licenses in the [License List] dialog box.

12) Click [Offline Deactivation  Register Activation File].

13) Open the USB memory device, specify “Response.key”, and then click [Open].

14) A confirmation message appears, then click [OK].

15) Check that EDIUS has been removed from the license list on the [License List] dialog box, and then 
exit GV LicenseManager.

3 Note
 f eID activation is not necessary when unregistering the serial number.

Registering License (Offline Activation)

Activate your license on the EDIUS terminal in the offline environment.

1) Connect a USB memory device to the PC where EDIUS is installed.

2) Start up GV LicenseManager.
 f “Starting up GV LicenseManager” (w page 463)

3) Click [Offline Activation  Create ID File].

4) Enter the serial number of EDIUS, and click [OK].

5) Select the USB memory device as the export destination in the [Destination for ID File] dialog box, 
and click [Select Folder].

6) A confirmation message appears, then click [OK].
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7) Disconnect the USB memory device from the PC, and connect it to a PC that is connected to the 
Internet.

8) Open the USB memory device on the explorer and double-click GVActivation.exe.

9) A message [Do you wish to activate the license?] appears, then click [Yes].

10) A confirmation message appears, then click [OK].
 f Disconnect the USB memory device.

11) Connect the USB memory device to the PC where EDIUS is installed, and start up GV 
LicenseManager.

12) Click [Offline Activation  Register Activation File].

13) Open the USB memory device, specify “Response.key”, and then click [Open].

14) A confirmation message appears, then click [OK].

15) Check that EDIUS has been activated and registered to the list on the [License List] dialog box, and 
then exit GV LicenseManager.

3 Note
 f When you use EDIUS for the first time after registering the license, online activation of eID is required.

EDIUS System Reporter

About EDIUS System Reporter

Collect necessary information for detecting troubles on EDIUS.
When EDIUS has been shut down abnormally or does not respond, EDIUS system reporter will be displayed.

 r [EDIUS System Reporter] Dialog Box

[Create System Report] Click this item to display a dialog box for file saving, and set the save destination to create a 
system report.

2
 f You can also create a system report from the Windows start menu by starting EDIUS System Reporter.
Click the Windows logo at the lower left of the start screen to display the start menu, and click [Grass Valley] → [EDIUS X System 
Reporter].
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Edit Workflow and Various Settings
This section explains the workflows to edit videos with EDIUS and their relation to various settings. For the general overview and 
relationship diagram, see the list of the setting descriptions.
“List of Setting Descriptions” (w page 98)
If you use a regular user profile, the settings for the editing environment can be changed anytime.

2
 f In EDIUS, both the administrator who configures the environment and the operator who performs the editing tasks in mind, a new 
restricted user profile with a limited access is introduced to prevent system settings. If access restriction is not required, use the regular 
user profile.

Editing Workflow
Video editing workflow is as follows. Settings/operations for source import and export differ depending on the device or media you use.

1. Prepare for editing.
Prepare sources such as shot video, pictures, and background music, and check the 
structure of a work and the final output format.

2. Start up EDIUS.
Start up EDIUS. At the first start-up, specify a folder to save projects (edited video files).
“Installation/Activation” (w page 45)
“Startup” (w page 53)

3. Create a project.
When working with EDIUS, the largest work unit is the project file. Configure the project 
settings according to the final output format of your work and shooting format of video. A 
project file contains information including edit histories and video formats.
“Creating a Project” (w page 56)

4. Import sources.
Import movie files saved on your PC or video files recorded in a device such as camera to 
your PC.
“Importing Sources” (w page 161)

5. Edit video.
Place sources on the timeline along the time axis. Edit the sources by applying video effects, 
adding screen texts (titles) such as tickers, etc.
 f Editing on the timeline
“Editing Operations” (w page 216)

 f Audio editing
“Audio” (w page 413)

 f Applying effects
“Effect” (w page 335)

 f Creating titles
“Title” (w page 387)

6. Export video.
Export the project in a format that suits the objective.
“Export” (w page 426)
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Editing Environment Configuration (Restricted users cannot perform 
this task)

Create New Project Presets → Start up Dialog Box or System Settings
Create and register a project preset.
“Creating New Project Presets at Initial Start-up” (w page 56)
“Project Preset/Project Template” (w page 69)
* A restricted user can change and use the content of the preset, but cannot create a new preset. Before you start editing using the restricted user 

profile, ensure to create a preset.

Create New Device Presets → System Settings
To use a camera or deck to import sources or export projects, create and register the device as a device preset. A device preset is required 
for each device as well as for each format and file type to import and export.
“Using a Device” (w page 130)
* A restricted user cannot create or change a device preset. Before you start editing using the restricted user profile, ensure to create a preset with 

the device, stream type and format,

Other Editing Environment Settings → System Settings
 f Configure connection settings and detailed settings to use a preview monitor and/or input controllers including a fader.
 f Register the plug-in effects.
 f Configure other processes including the capture and rendering.

“[System Settings]” (w page 99)

Create New Profile → System Settings
If you want to change the editing environments for different projects or use the restricted user profile to perform editing tasks, you can 
register the device preset described above and other editing environment settings as a profile.
If you use the restricted user profile, you need a restricted user profile for each PC used by a restricted user.
The profiles can be managed through network.
“Editing Environment Management” (w page 125)

Creating a New Project

Create a New Project → Project Settings
Select a project preset or project template, and open a project. The content of the project preset can be changed in the project settings.
“Creating a New Project (Simple Settings)” (w page 57)
“Creating a New Project (Detailed Settings)” (w page 58)

Importing Sources

Capturing Sources from Cameras or Decks
Select a device preset and capture sources. A device preset must be created in the system settings before capturing.
“Capturing” (w page 162)

Copying File-Based Sources
You can use the source browser to copy source files from BD and other devices* including AVCHD video cameras, P2, and XDCAM by 
simple operations. Files can be browsed by simply connecting a device or drive to your PC and inserting the storage media.
“Source Browser” (w page 174)
* You can register the target in the system settings if you want to browse files previously copied to the hard disks.
“[Importer/Exporter]” (w page 104)
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Editing Timelines

Configure TC Presets and Channel Maps → Sequence Settings or Project Settings
Configure TC presets and channel maps for each sequence. The default value for a new sequence can be changed in the project settings.
“Sequence Settings” (w page 68)
“Changing the Project Setting (Detailed Settings)” (w page 67)

Customize Editing Environment → User Settings
Customize various settings including the folder to save the project files, timeline settings, information displayed in preview, as well as 
buttons and windows. Keyboard shortcut and input controller settings can be imported and exported. These settings are recorded in the 
user profile in use, and changed settings are reflected instantly.
“[User Settings]” (w page 115)
“Screen Customization” (w page 147)
“Registering Profiles” (w page 125)

Editing Video Layouts
Edit the video layout using the layouter. The edited content can be saved as a preset in the layouter or registered as a user preset effect to 
the effect palette to export.
“Video Layout” (w page 257)
“Preset” (w page 383)

Editing Effects
Edit existing effects and register and export as a user preset effect to the effect palette.
“Preset” (w page 383)

Export

Export to File → Exporter
Select an exporter and export to different file types. The exporter settings can be registered and exported as a preset.
“Exporting in File Formats” (w page 427)
“Creating Exporter Presets” (w page 450)

Export to Devices
To export video to a device such as VTR using a Grass Valley hardware product, a device preset must be configured.
“Using a Device” (w page 130)
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Project Format
Set the project format according to the format of sources to be used and the final export format. In EDIUS, you can register formats that you 
frequently use as project presets, and start a project quickly.
Registration of project presets can be easily performed by simply selecting preset formats of video and audio.
“Creating New Project Presets at Initial Start-up” (w page 56)
“Creating a New Project (Simple Settings)” (w page 57)
You can also create projects in any formats that are not registered as project presets.
“Creating a New Project (Detailed Settings)” (w page 58)

Resolution Frame rate Typical use
4096x2160 (DCI 4K) 24p etc. Digital cinema, video for events, etc.
3840x2160 (4K UHDTV, QFHD) 60p etc.
2432x1366 (2.5K) 30p etc.
2048x1080 (2K) 60p etc.
1920x1080 (Full HD) 60p, 59.94i, etc. Blu-ray, HDCAM-SR, etc.
1600x1200 (UXGA) 30p etc. PC monitor, etc.
1440x1080 (HD) 59.94i etc. Terrestrial digital broadcasting, HDV, etc.
1280x1080 (HD) 59.94i etc. DVCPRO HD, etc.
1280x720 (HD) 30p etc. HDV, etc.
1024x768 (XGA) 30p etc. PC monitor, etc.
800x600 (SVGA) 30p etc. PC monitor, etc.
720x576 (PAL, SECAM, SD) 50p etc. DVD, analog broadcasting, DV, DVCPRO, 

etc.
720x480 (NTSC, SD) 59.94i etc. DVD, analog broadcasting, DV, DVCPRO, 

etc.
640x480 (VGA) 30p etc. PC monitor, etc.
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Video Signal Level Restriction
 r IRE range

Video signal level is indicated by IRE with the normal range from 0% to 100%. However, even a small deviation from the normal range will 
cause the video signal clipped due to inexistence of the supported code, which sometimes causes troubles in actual operations. Therefore, 
signal allocation is being performed in the range that includes marginal parts called “super white” and “sub black”, and thus, IRE range is 
approximately -7% to +109%.

 r Automatic adjustment using [Safe Color]
To restrict the IRE range to 0% - 100% at final output after editing and other works have been completed, [Color Balance] in [Color 
Correction] can be used.
Checking [Safe Color] in the [Color Balance] dialog box restricts each signal of YCbCr so that its IRE range is to be within the range 0% - 
100%.
“Adjusting Color Balance” (w page 345)
After automatic adjustment by [Safe Color] has been performed, some part may not be within the 0% - 100% range in the RGB waveform of 
[Videoscope]. This occurs after conversion of YCbCr signals restricted within 0% - 100% range into RGB signals, in which some parts are 
out of the 0% - 100% range of RGB signal.

2
 f Unless a codec that outputs RGB signals, such as uncompressed RGB, is used as the output format, output will be performed in YCbCr 
signals which has the range 0% - 100%.

 r Restricting IRE range of RGB signals
If you need to maintain the 0% - 100% range also when data of RGB signals is displayed, adjustment can be performed using primary color 
correction.
Use [Curve] in the primary color correction and set as in the figure below, to make RGB signals within the 0% - 100% range.
“Adjusting with [Primary Color Correction]” (w page 348)

2
 f If RGB signals are restricted within the range 0% - 100%, YCbCr signals will also be within the range 0% - 100%, which does not require 
adjustment by [Safe Color] of [Color Balance].

 f The setting values for [Highlights] and [Shadows] correspond to IRE 100% and 0% respectively. Since [Lights], [Midtones], and [Darks] 
are not affected by the signal level restrictions, their parameters can be modified to adjust the tone.
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Keyboard Shortcuts
Keyboard shortcuts are listed by operation category.

[Edit]
Operation Shortcut key
[Copy] [Ctrl] + [Insert]

[Ctrl] + [C]
[Cut (Follow Mode)] [Shift] + [Delete]

[Ctrl] + [X]
[Paste Transition (In Point)] [Shift] + [Alt] + [K]
[Paste Transition (Out Point)] [Alt] + [K]
[Paste Transition] [Ctrl] + [Alt] + [K]
[Paste to Current Location] [Ctrl] + [V]

[Shift] + [Insert]
[Ripple Cut] [Alt] + [X]
[Redo] [Ctrl] + [Y]

[Shift] + [Ctrl] + [Z]
[Undo] [Ctrl] + [Z]
[Insert Copied Clip to Timeline] [Shift] + [[]
[Insert to Timeline] [[]
[Overwrite Copied Clip to Timeline] [Shift] + []]
[Overwrite to Timeline] []]

[View]
Operation Shortcut key
[Scroll Up] [Shift] + [Ctrl] + [Page up]
[Scroll Down] [Shift] + [Ctrl] + [Page down]
[Scroll Right] [Ctrl] + [Page down]
[Scroll Left] [Ctrl] + [Page up]
[Toggle Bin Window Display] [B]
[Toggle Status] [Ctrl] + [G]
[Display Thumbnail] [Alt] + [H]
[Toggle Center (Line Display)] [Shift] + [H]
[Toggle Safe Area Display] [Ctrl] + [H]
[Toggle Palette Display] [H]
[Layout Normal] [Shift] + [Alt] + [L]
[Focus Menu] [Shift] + [F1]
[Toggle Batch Capture List On/Off] [F10]
[Help]* [F1]

* The “Help” keyboard shortcut cannot be customized.

[Timeline]
Operation Shortcut key
[Delete Gap] [Backspace]

[Shift] + [Alt] + [S]
[Switch to Previous Sequence] [Shift] + [Ctrl] + [Tab]
[Switch to Next Sequence] [Ctrl] + [Tab]
[Move Cursor to End of Timeline] [End]
[Move to Start] [Home]
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Operation Shortcut key
[Previous Edit Point] [Ctrl] + [←]

[A]
[Next Edit Point] [Ctrl] + [→]

[S]
[Change Time Scale (Fit)] [Ctrl] + [0]
[Change Time Scale (1 frame)] [Ctrl] + [1]
[Change Time Scale (5 frame)] [Ctrl] + [2]
[Change Time Scale (1 sec)] [Ctrl] + [3]
[Change Time Scale (5 sec)] [Ctrl] + [4]
[Change Time Scale (15 sec)] [Ctrl] + [5]
[Change Time Scale (1 min)] [Ctrl] + [6]
[Change Time Scale (5 min)] [Ctrl] + [7]
[Change Time Scale (15 min)] [Ctrl] + [8]
[Change Time Scale (1 hour)] [Ctrl] + [9]
[Ripple Delete (Between In/Out)] [Alt] + [D]
[Delete (Between In/Out) - Follow Mode] [D]
[Display Source Clip] [Alt] + [F]
[Search Bin for Clips that Contains Current Source Timecode] [Shift] + [Ctrl] + [F]
[Search Bin for Clips that Contain Current Source Timecode from Timeline Clip] [Shift] + [F]
[Match Frame (Recorder to Source)] [F]
[Create New Sequence] [Shift] + [Ctrl] + [N]
[New Project] [Ctrl] + [N]
[Open Project (Monitor/Timeline)] [Ctrl] + [O]
[Save Project] [Ctrl] + [S]
[Save As] [Shift] + [Ctrl] + [S]
[Create a Still Image] [Ctrl] + [T]
[Change Time Scale (Undo)] [Ctrl] + [U]
[Edit Transition (In)] [Shift] + [Alt] + [U]
[Edit Transition (Out)] [Ctrl] + [Alt] + [U]
[Initialize Rubber Band Setting] [Shift] + [Ctrl] + [U]
[Move All Rubber Band Points on Scale] [Shift] + [Alt] + [Y]
[Zoom In Time Scale] [Ctrl] + [Num +]
[Zoom Out Time Scale] [Ctrl] + [Num -]
[Nudge (-10 frames)] [Shift] + [Ctrl] + [ ,]
[Nudge (-1 frame)] [Ctrl] + [ ,]
[Nudge (+10 frames)] [Shift] + [Ctrl] + [ .]
[Nudge (+1 frame)] [Ctrl] + [ .]
[Play the Event Area] [/]

[Preview]
Operation Shortcut key
[Toggle Player/Recorder] [Tab]
[Playback (With Buffer)] [Shift] + [Space]

[Shift] + [Enter]
[Play/Stop] [Space]

[Enter]
[Loop Playback] [Ctrl] + [Space]
[Previous Frame] [←]
[Back (10 frames)] [Shift] + [←]
[1 Frame Forward] [→]
[Forward (10 frames)] [Shift] + [→]
[Pause] [Shift] + [↓]

[Ctrl] + [K]
[K]

[Add Clip to Timeline] [E]
[Jog (Rewind)] [Ctrl] + [J]
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Operation Shortcut key
[Review] [J]
[Jog (Forward)] [Ctrl] + [L]
[Cue] [L]
[Change to Player] [Ctrl] + [Alt] + [P]
[Change to Recorder] [Ctrl] + [Alt] + [R]
[TC Jump (+)] [Num +]
[TC Jump (-)] [Num -]
[Play the Cursor Area] [Ctrl] + [/]

[Preview - Player]
Operation Shortcut key
[Add Clip on Player to Bin] [Shift] + [Ctrl] + [B]
[Match Frame (Player to Recorder)] [Ctrl] + [F]

[Preview - Recorder]
Operation Shortcut key
[Add Clip to Timeline] [Shift] + [Ctrl] + [O]
[Print to DVD/BD] [Shift] + [F11]
[Print to File] [F11]
[Print to Tape] [F12]

[Trim]
Operation Shortcut key
[Move to Previous Edit Point (Trim)] [Page up]
[Move to Next Edit Point (Trim)] [Page down]
[Split Slide Trim (In Point)] [Shift] + [Ctrl] + [Alt] + [N]
[Split Slide Trim (Out Point)] [Shift] + [Ctrl] + [Alt] + [M]
[Split Trim (In Point)] [Shift] + [N]
[Split Trim (Out Point)] [Shift] + [M]
[Split Ripple Trim (In Point)] [Shift] + [Alt] + [N]
[Split Ripple Trim (Out Point)] [Shift] + [Alt] + [M]
[Slide Trim (In Point)] [Ctrl] + [Alt] + [N]
[Slide Trim (Out Point)] [Ctrl] + [Alt] + [M]
[Trim (In Point)] [N]
[Trim (Out Point)] [M]
[Ripple Trim (In Point)] [Alt] + [N]
[Ripple Trim (Out Point)] [Alt] + [M]
[Trim (-1 frame)] [ ,]
[Trim (-10 frames)] [Shift] + [ ,]
[Trim (1 frame)] [ .]
[Trim (10 frames)] [Shift] + [ .]
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[Clip]
Operation Shortcut key
[Clip Properties] [Alt] + [Enter]
[Enable/Disable Clip] [0]
[Remove cut points] [Ctrl] + [Delete]
[Set Transition (1 sec)] [Alt] + [1]
[Set Transition (2 sec)] [Alt] + [2]
[Set Transition (3 sec)] [Alt] + [3]
[Set Transition (4 sec)] [Alt] + [4]
[Set Transition (5 sec)] [Alt] + [5]
[Add to Bin] [Shift] + [B]
[Add Cut Point (In/Out) - All Tracks] [Shift] + [Alt] + [C]
[Add Cut Point (In/Out) - Selected Tracks] [Alt] + [C]
[Add Cut Point (All Tracks)] [Shift] + [C]
[Add Cut Point (Selected Tracks)] [C]
[Time Remap] [Shift] + [Alt] + [E]
[Speed] [Alt] + [E]
[Edit of Clip] [Shift] + [Ctrl] + [E]
[Ungroup] [Alt] + [G]
[Set Group] [G]
[Initialize Volume Settings on Audio Rubber Band] [Shift] + [Alt] + [H]
[Open the Original File of a Clip] [Shift] + [Ctrl] + [P]
[Set Transition (In Point)] [Shift] + [Alt] + [P]
[Set Transition (Out Point)] [Alt] + [P]
[Set Default Transition] [Ctrl] + [P]
[Replace Clip (All)] [Ctrl] + [R]
[Replace Clip Only] [Shift] + [R]
[Replace Clip and Filter] [Shift] + [Alt] + [R]
[Replace Filter on Selected Clip] [Alt] + [R]
[Replace Mixer on Selected Clip] [Shift] + [Ctrl] + [R]
[Create Title in Video Channel Track] [T]
[Duration] [Alt] + [U]
[V Mute] [Shift] + [V]
[Unlink Clip] [Alt] + [Y]
[Link] [Y]
[Display in Player] [Shift] + [Y]
[Layouter] [F7]

[Clip - Delete]
Operation Shortcut key
[Ripple delete] [Alt] + [Delete]
[Delete (Follow Mode)] [Delete]
[Delete Audio of Selected Clip (Follow Mode)] [Alt] + [A]
[Delete Video of Selected Clip (Follow Mode)] [Alt] + [V]
[Delete All Filters on Selected Clip] [Shift] + [Ctrl] + [Alt] + [F]
[Delete Audio Filter on Selected Clip] [Ctrl] + [Alt] + [F]
[Delete Video Filter on Selected Clip] [Shift] + [Alt] + [F]
[Delete Key on Selected Mixer Track] [Ctrl] + [Alt] + [G]
[Delete Transparency on Selected Mixer Track] [Shift] + [Ctrl] + [Alt] + [G]
[Delete Pan Settings on Audio Rubber Band] [Ctrl] + [Alt] + [H]
[Delete Transitions for All Selected Clips] [Alt] + [T]
[Delete Clip Crossfade] [Ctrl] + [Alt] + [T]
[Delete Clip Transition] [Shift] + [Alt] + [T]
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[Clip - Select]
Operation Shortcut key
[Clear Focus] [Shift] + [Esc]
[Add Focus] [Alt] + [Space]
[Toggle Focus] [Shift] + [Ctrl] + [Alt] + [Space]
[Select a Clip to Forward] [Alt] + [Page up]
[Select a Clip to Back] [Alt] + [Page down]
[Select From the Timeline Cursor to End (All Tracks)] [Shift] + [End]
[Select From the Timeline Cursor to End (Selected Tracks)] [Ctrl] + [End]
[Select Timeline Start to the Cursor (All Tracks)] [Shift] + [Home]
[Select From Timeline Start to the Cursor (Selected Tracks)] [Ctrl] + [Home]
[Toggle Focus to Left] [Ctrl] + [Alt] + [←]
[Move Focus to Left] [Shift] + [Ctrl] + [Alt] + [←]
[Add Focus to Left] [Shift] + [Alt] + [←]
[Move Focus to Left] [Alt] + [←]
[Toggle Focus to Up] [Ctrl] + [Alt] + [↑]
[Move Focus to Up] [Shift] + [Ctrl] + [Alt] + [↑]
[Add Focus to Up] [Shift] + [Alt] + [↑]
[Move Focus to Up] [Alt] + [↑]
[Toggle Focus to Right] [Ctrl] + [Alt] + [→]
[Move Focus to Right] [Shift] + [Ctrl] + [Alt] + [→]
[Add Focus to Right] [Shift] + [Alt] + [→]
[Move Focus to Right] [Alt] + [→]
[Toggle Focus to Down] [Ctrl] + [Alt] + [↓]
[Move Focus to Down] [Shift] + [Ctrl] + [Alt] + [↓]
[Add Focus to Down] [Shift] + [Alt] + [↓]
[Move Focus to Down] [Alt] + [↓]
[Select All Clips (All Tracks)] [Shift] + [A]
[Select All Clips (Selected Tracks)] [Ctrl] + [A]

[Track]
Operation Shortcut key
[Track Height (High)] [Ctrl] + [↑]
[Track Height (Low)] [Ctrl] + [↓]
[Move Track Patch (Up)] [↑]
[Move Track Patch (Down)] [↓]
[Connect Source Channel (All) - Toggle] [Shift] + [Ctrl] + [Delete]
[Sync-Lock Track (All) - Toggle] [Shift] + [Ctrl] + [Alt] + [0]

[Shift] + [Alt] + [0]
[Select Track (All Tracks) - Toggle] [Shift] + [Ctrl] + [0]

[Shift] + [0]
[Sync-Lock Track (1A) - Toggle] - [Sync-Lock Track (8A) - Toggle] [Shift] + [Alt] + [1] - [8]
[Sync-Lock Track (1VA/V) - Toggle] - [Sync-Lock Track (8VA/V) - Toggle] [Shift] + [Ctrl] + [Alt] + [1] - [8]
[Connect Source Channel (A1) - Toggle] - [Connect Source Channel (A8) - Toggle] [1] - [4]
[Connect Source Channel (A12) - Toggle] [5]
[Connect Source Channel (A34) - Toggle] [6]
[Select Track (1A) - Toggle] - [Select Track (8A) - Toggle] [Shift] + [1] - [8]
[Select Track (8VA/V) - Toggle] [Shift] + [Ctrl] + [1] - [8]
[Sync-Lock Track (Audio) - Toggle] [Shift] + [Alt] + [9]
[Sync-Lock Track (Video) - Toggle] [Shift] + [Ctrl] + [Alt] + [9]
[Connect Source Channel (Audio) - Toggle] [Shift] + [K]

[8]
[Select Track (All Audio Tracks) - Toggle] [Shift] + [9]
[Select Track (All VA/V Tracks) - Toggle] [Shift] + [Ctrl] + [9]
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Operation Shortcut key
[Connect Source Channel (Video) - Toggle] [Shift] + [J]

[7]
[Toggle Lock (Selected Tracks)] [Alt] + [L]
[Audio Mute] [Shift] + [S]
[Video Mute] [Shift] + [W]
[Extend Audio Track Display] [Alt] + [S]
[Extend Mixer Track Display] [Alt] + [W]
[Toggle Waveform] [Ctrl] + [W]

[Marker]
Operation Shortcut key
[Move Cursor to Previous Sequence Marker] [Shift] + [Page up]
[Move Cursor to Next Sequence Marker] [Shift] + [Page down]
[Clear In Point] [Alt] + [I]
[Set In Point] [I]
[Go to In Point] [Shift] + [I]

[Q]
[Clear Out Point] [Alt] + [O]
[Set Out Point] [O]
[Go to Out Point] [Shift] + [O]

[W]
[Set Audio Out Point] [P]
[Go to Audio Out Point] [Shift] + [P]
[Set Audio In Point] [U]
[Go to Audio In Point] [Shift] + [U]
[Shift Cut Point to Cursor (Transition)] [Shift] + [Ctrl] + [T]
[Clear All Markers] [Shift] + [Alt] + [V]
[Set Marker] [V]
[Clear In/Out Point] [X]
[Set In/Out Point on Current Clip] [Shift] + [Z]
[Set In/Out Point to Focused Area] [Z]

[Mode]
Operation Shortcut key
[Toggle Insert/Overwrite Mode] [Insert]
[Set Group/Link Mode] [Shift] + [L]
[Set Ripple Mode] [R]
[Switch to Normal Mode] [F5]
[Switch to Trim Mode] [F6]

[Mode - Multicam]
Operation Shortcut key
[Multicam] [F8]
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[Capture]
Operation Shortcut key
[Capture] [F9]
[Add to Batch Capture List] [Ctrl] + [B]
[Input Preset 1] [F2]
[Input preset 2] [F3]
[Input Preset 3] [F4]

[Render]
Operation Shortcut key
[Render] [Shift] + [G]
[Render In/Out (Render Loaded Area)] [Ctrl] + [Alt] + [Q]
[Render In/Out (All)] [Shift] + [Alt] + [Q]
[Render In/Out (Render Overload Area)] [Ctrl] + [Q]
[Delete Temp Files] [Alt] + [Q]
[Render All (Render Loaded Area)] [Shift] + [Ctrl] + [Alt] + [Q]
[Render All (Render Overload Area)] [Shift] + [Ctrl] + [Q]
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Effects List
2
 f Hovering the mouse cursor over an effect in the [Effect] palette displays a simple description of the effect.

[VideoFilters]
Besides the following effects, frequently used effects, such as video filter for old movies, are registered as system presets.

[Color Correction]
Includes video filters for color adjustment, such as 3-Way color correction and YUV curve.
“Adjusting Color/Brightness (Color Correction)” (w page 341)

[Anti Flicker]
Reduces screen flicker. Effective for images with little motion.

[Emboss]
Makes a three-dimensional monotone image like a lithograph. You can set the direction and depth of the shadow.

[Old Movie/Film]
Makes an image look like an old film.

[Chrominance]
Specifies a color as the key color, and apply a specific filter to the inside, edge or outside.

[Sharpness]
Sharpens the outline of objects and makes an image look as if it is a higher resolution.

[Stabilizer]
Correct the camera shake by image processing.

[Strobe/Freeze]
Creates an effect like a strobe light flashing.

[Soft Focus]
Applies an effect like a mist that softens the video.

[Select channel]
Switches the output of a clip with alpha channel to key output or fill output.
“Alpha Channel” (w page 373)

[Tunnel Vision]
Makes an image look like it is in a tunnel. It is effective when used in combination with [Loop Slide].
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[Video Noise]
Adds noise.

[Blur]
Makes an image look blurred.

[Blend Filters]
Blends two video filters in any respective proportion. The blend ratio can be set to change along the time axis by setting a key frame.

[Mask]
Applies a video filter to the inside or outside of a given range. Using the pass, the application range can be rectangular, elliptical, or any 
shape.
You can also use motion tracking. It automatically tracks specific parts of a subject in motion and apply an effect.
“Motion Tracking ([Mask])” (w page 360)

[Matrix]
Applies a preferred set matrix to every pixel, to blur or sharpen an image. It is effective when exporting images in MPEG format that have a 
lot of movement.

[Mirror]
Reverses an image.

[Median]
Balances an image to be smooth to decrease the noise component. Increasing the threshold value gives a paintbrush effect.

[Mosaic]
Applies a mosaic to an image. It is effective when used on parts of an image in combination with [Mask].

[Motion Blur]
Applies the [Blur] effect to moving objects only. This effect can be applied when the whole image moves on the screen such as during a pan 
or tilt movement.

[Raster Wipe]
Transforms an image to become wavelike.

[Loop Slide]
Slides an image as if it is connected above, below, left or right.

[Block Color]
Displays an image in monochrome. It is effective when used on parts of an image in combination with [Mask].

[Pencil Sketch]
Makes an image look like its outline was traced with a pencil.

[Stereoscopic Adjuster]
Adjusts the stereoscopic image.
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[Smooth Blur]
Applies an effect where the focal point seems blurred while suppressing discoloration.

[Combine Filters]
Sets up to 5 filters simultaneously. You can also set multiple filters without using [Combine Filters], though the synergistic effect of multiple 
filters may not appear if you do not use [Combine Filters].(For example, when applying multiple filters in an area specified using a [Mask] or 
[Chrominance] filter.)

[Gaussian Blur]
Applies a defocusing effect in higher quality than [Blur] and [Smooth Blur].

[Transform]
Sets cropping, zoom-in/out, movement, rotation, etc. of the image.

[AudioFilters]
Besides the following effects, frequently used effects, such as enhancement for high-pitched sound/low-pitched sound and audio filter for 
echo, are registered as system presets.

[Graphic Equalizer]
Sets the frequency properties by adjusting the master fader or the fader of each frequency range.

[Delay]
Creates an echo-like effect by repeating the same sound at different levels or with a time difference.

[Tone Controller]
Sets the intensity of low pitch sound and high pitch sound.

[High-pass Filter]
Cuts the frequency region below a set frequency.

[Parametric Equalizer]
Emphasizes or de-emphasizes sound of a certain frequency.

[Panpot  Balance]
Maps the audio signal input from channels on the left and right to the left, right or center. The input level and the output balance can also be 
set for the left and right channels.

[Pitch Shifter]
Adjusts the audio pitch.

[Low-pass Filter]
Cuts the frequency region above a set frequency.
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[Transitions]

2
 f Click a transition in the [Effect] palette and select an animation to display the animation and confirm its movement.

[2D]
Planar movement transitions. You can also call upon and apply a preset from the settings dialog box of each transition.

[Clock]

Transitions the video with a movement like the hands on a clock.

[Circle]

Transitions the video with an expanding circle.

[Stripes]

Transitions the video in striped parts.

[Stretch]

Transitions while expanding video B.

[Slide]

Transitions by inserting video B from a specified direction.

[Dissolve]

Gradually transitions from video A to video B. This is set as the default transition in the initial settings.

[Blind Slide]

Transitions by inserting video B in stripes from the left and right sides (top and bottom sides).

[Blind Wipe]

Video B is revealed in stripes that slide in from left and right sides (top and bottom sides).

[Block]

Video B is revealed in blocks that snake around video A.

[Blind Push]

Video A is slid out and video B slides into the screen in stripes that move towards the left and right sides.

[PushStretch]

Transitions in a way where video B appears to push video A off the screen.

[Box]

Transitions the video with an expanding rectangle.

[Border Wipe]

Transitions by sliding video B in from a specific direction.
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[3D]
Three-dimensional movement transitions. You can also call upon and apply a preset from the settings dialog box of each transition.

[3D Dissolve]

In addition to a normal dissolve, you can set the light, shadow, movement, etc.

[Cube Spin]

A cube with video A and video B displayed on its sides rotates to transition from video A to video B.

[Single Door]

Transitions the video with a door opening movement.

[Sphere]

Video A becomes a sphere and flies away.

[Double Door]

Transitions the video as if a double door opens.

[Two Pages]

Transitions to video B by peeling away video A as if on 2 sheets of paper.

[Peel Away]

Peels away video A as if on 1 sheet of paper.

[Peel Over]

Transitions to video B by peeling away video A as if on 1 sheet of paper with video B on its reverse.

[Four Pages]

Transitions to video B by peeling away video A as if on 4 sheets of paper.

[Fly Away]

Video A flies away to reveal video B.

[Flip Over]

Transitions the video by flipping it over.

[Blinds]

Turns over video A in stripes as if a set of blinds to reveal video B on the reverse.

[Page Peel]

Transitions by peeling over the video.

[GPU]
High quality and complex transitions that use the GPU (Graphics Processing Unit) can be set. A large number of presets are included in the 
[GPU] effect folder. If you want to set parameters to create a new transition, they can be set and applied from the [Advanced] folder.
The settings dialog box of each transition contains [Design] settings to adjust the direction of movement, angle of incidence of light and 
the like, and [Time] settings to specify a key frame and adjust movement along the time axis. These settings can be used to apply complex 
movement and effects.
You can set the antialiasing and image quality when GPUfx is applied, from [Effect] in [System Settings] → [GPUfx].



Chapter 12   Appendix — Effects List

484

If [GPU] is not displayed in the [Effect] palette, or if the transitions do not move, confirm the system environment and the error information 
from [Effect] in [System Settings] → [GPUfx].
“[GPUfx]” (w page 112)
“Clip Transition” (w page 363)
To display GPUfx transition, click the [Transitions] tree in the folder view of the [Effect] palette, and click the [GPU] tree.

3 Note
 f GPUfx cannot be used if video memory on your PC is smaller than 256 MB. The [GPU] folder also will not be displayed on the [Effect] 
palette.

 f To use GPUfx transition, an operating environment that satisfies certain conditions is required. For details on operating environment, 
see the Grass Valley website.
“Our Website” (w page 494)

2
 f If you have applied an effect in the [Advanced] folder, you may not be able to check the results of an effect with default settings. Either 
adjust the applied effect or apply a preset.
“Checking/Adjusting Effects” (w page 378)

 r Adjusting GPUfx transition
The following procedure explains how to adjust [Explosion] in the [Advanced] folder as an example. For how to apply GPUfx transition, see 
“Transition”.
“Transition” (w page 363)

1) Click the transition to which GPUfx has been applied.
 f “How to Adjust Effects” (w page 339)

2) Select [Explosion] in the [Information] palette, and click [Open Setup Dialog].
 f The [Explosion] dialog box appears.
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3) Set each item.
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----

(1) (2)

(3)

(1) [Design] Display a setting screen to adjust the motion or lighting. Use [Divide] to change the fragment 
size, use [Spread] to change the spread of fragments, and perform other operations.
Also set key frames to change the motion of video along the time axis.

(2) [Time] Display the setting screen to set the key frame and apply changes to the motion along the time 
axis.

(3) Controller Drag up and down to adjust.

4) Click [OK].

[Accordion]

Transitions by folding the video like an accordion.

[Album]

Transitions the video as if folding over a stiff page in a book.

[Extend]

Transitions the video by stretching it.

[Explosion]

Transitions by applying an effect where it looks as if the video has exploded.

[Cube Tube]

Transitions the video by rotating it on a three-dimensional cube.
The effect cannot be checked with default settings. Make sure to change the parameters after applying the effect.

[Clapper Board]

Transitions the video with a movement like a clapper board.

[Sphere]

Transitions the video while turning the video into a sphere.
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[Tube]

Transitions the video while turning the video into a pipe shape.

[Twist]

Transitions the video by twisting it.

[Two Pages]

Transitions by peeling the video in 2 directions.

[Transform]

Transitions the video with a variety of freeform transformations.
The effect cannot be checked with default settings. Make sure to change the parameters after applying the effect.

[Door]

Transitions the video with a door opening movement.

[Peel]

Transitions the video by peeling it.

[Folder]

Transitions the video by folding it.

[Four Pages]

Transitions by peeling the video in 4 directions.

[FlyingAway]

Transitions the video by flying it away.

[FlyingIn]

Transitions the video by flying it in.

[Flip Over]

Transitions the video by flipping it over.

[Blind Wave]

Transitions the video by splitting it into tiles/stripes and turning it over.

[Ripple]

Transitions the video while applying a wave-like effect.

[Rotation]

Transitions the video while rotating it.

[Advanced]

Applies a basic movement and configure the settings as you wish.

[SMPTE]
Applies SMPTE standard transitions.
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[Alpha]

[Alpha Custom Map]

A transition that is like dissolve, except you can apply unevenness to the dissolve or change the direction, rotation, speed, etc.

[AudioCrossFades]
The illustrations represent the change in volume in the area where the audio cross fade has been applied.

[Cut out/in]

[Cut out/Spline in]

[Cut out/Linear in]

[Spline out/Cut in]

[Spline out/in]

[Linear out/Cut in]
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[Linear out/in]
This is set as the default audio cross fade in the initial settings.

[TitleMixers]
Applies changes to how a title appears or disappears. Different effects can be applied to the In side and the Out side.
Parameters can only be changed for [Soft Slide] and [Soft Wipe].

[Slide A]
The title enters the screen from outside the screen, and exists the screen in the selected direction.

[Slide B]
The title slides within a rectangle in the selected direction. The rectangle includes all text frames and other objects placed when creating the 
title.

[Soft Slide]
The title enters the screen from outside the screen in the selected direction, sliding up to a rectangular range. The borders are blurred 
during In and Out.

[Soft Wipe]
The title appears during a wipe in the selected direction. The wipe borders are blurred.

[Fade Slide A]
Slide A is moved while dissolving.

[Fade Slide B]
Slide B is moved while dissolving.

[Laser]
The title appears as if projected by a laser. The opposite movement is performed during Out.

[Wipe]
The title appears during a wipe in the selected direction.

[Wipe Vertical]
The title appears during a wipe in a vertical direction.

[Wipe Horizontal]
The title appears during a wipe in a horizontal direction.

[Fade]
The same as the dissolve effect. This is set as the default title mixer in the initial settings.
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[Blur]
The title dissolves while becoming blurred.

[Keyers]
Blends multiple videos on top of one another.

[Blend]
Blends 2 videos on top of each other. Video A is the 1VA video and video B is 2VA, where video B is blended on top of video A.
The above images are examples of blending the blue gradation as video A (background) and the red gradation as video B (foreground).
The following images are examples of blending the skydiving image as video A (background) and the image of the airplane flying above a 
lake as video B (foreground).

 r Original images

Video B
(foreground)
Key application side

Video A
(background)

[Overlay]

The blending creates a darker area where the background is dark due to a multiplying effect, and a brighter area where the background is 
light due to a screening effect.
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[Screen]

Since the pixels are negated, multiplied then negated again, the image becomes brighter.

[Soft Light]

Applies a multiplication and screening effect, making the background darker where the foreground is dark, and the background lighter where 
the foreground is light.

[Hard Light]

Blending of where the foreground is dark makes the image darker due to a multiplying effect, and blending of where the foreground is light 
makes the image lighter due to a screening effect.

[Vivid Light]

Blending of where the foreground is light lowers the contrast and makes the image lighter, and blending of where the foreground is dark 
increases the contrast and makes the image darker.
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[Pin Light]

Replaces parts that are light in the foreground with a darker part, and replaces parts that are dark in the foreground with lighter parts.

[Linear Light]

Increases the brightness of parts that are bright in the foreground, and lowers the brightness of parts that are dark in the foreground.

[Multiply]

Multiplies the colors and so makes the image darker.

[Addition]

Adds the colors and so makes the image brighter.
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[Difference]

Displays colors that have been converted into an absolute value from the difference between the background and foreground.

[Lighter]

Compares the background and foreground, and displays the brighter color.

[Darker]

Compares the background and foreground, and displays the darker color.

[Subtract]

Subtracts the foreground from the background so parts of the foreground that are bright become dark.
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[Color Burn]

Leaves the background color as it is and darkens parts that are superimposed.

[Color Dodge]

Leaves the background color as it is and brightens parts that are superimposed.

[Exclusion]

Displays colors that have been converted to an exclusive OR for the background and foreground.

[Chromakey]
Displays the lower video through a specific color.
“Key” (w page 367)

[Track Matte]
Produces an alpha channel according to the luminance of the lower image, which is multiplied to the alpha channel of the clip to which track 
matte is applied.
“[Track Matte]” (w page 374)

[Luminancekey]
Displays the lower video through a specific brightness.
“Key” (w page 367)
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Grass Valley Product Support
For technical assistance, to check on the status of a question, or to report a new issue, contact Grass Valley Product Support via e-mail, the 
Web, or by phone or fax.

Web Technical Support
To access support information on the Web, visit the product support Web page on the Grass Valley Web site. You can download software or 
find solutions to problems by searching our Frequently Asked Questions (FAQ) database.

 r World Wide Web:
http://www.grassvalley.com/support/

 r Contact Customer Support
http://www.grassvalley.com/support/contact/
* Please select “Support for Professional Products” tab.

Phone Support
Use the following information to contact product support by phone during business hours. After hours phone support is available for 
warranty and contract customers.

United States/Americas +1 801 222 5204
Europe, United Kingdom, Africa and The Middle East +44 (0) 20 8867 6305
Asia (except Japan and Korea) +86 21 5869 8668

Authorized Support Representative
To locate the support representative for your country, visit the following Product Support Web page on the Grass Valley Web site.
 f http://www.grassvalley.com/support/

Our Website
The latest information of our products including this product are released on the Grass Valley website. Visit our website to download the 
latest drivers, utilities, applications, product manuals (online or PDF) or to see FAQs, for your better editing environment.
 f http://www.grassvalley.com/
 f http://www.ediusworld.com/



EDIUS X Pro Topic Library
September 15, 2020

Copyright © 2020 Grass Valley. All rights reserved.


	EDIUS X Pro Topic Library
	Notice to Reader
	Manual Explanation
	DANGER
	Health Precautions
	Copyright

	Contents
	1 EDIUS
	EDIUS
	EDIUS X Pro

	Operating Environment/Specifications
	Operating Environment
	OS
	CPU
	Memory

	Other Specifications
	Graphics
	Hard Disk
	Optical Drive
	Sound Card
	Display
	Internet Environment
	Support


	Comparison Table for Functions of Each EDIUS X Product
	Grass Valley HQX Codec
	Screen Configuration
	EDIUS Screen Configuration
	Layout in Dual Monitor
	Layout in Single Monitor

	Preview Window
	Dual Mode
	Single Mode
	Menu Bar
	Player
	Recorder

	Timeline Window
	Time Scale Settings/Track Header
	Track Type

	Bin Window
	Source Browser Window
	Palette Window
	[Information] Palette
	[Effect] Palette
	[Marker] Palette


	Entry of Values
	Entering Values Using Keyboard and Mouse
	Direct Input of Value
	Offset Input
	Setting with Arrow Keys
	Entering with Mouse Wheel



	2 Installation
	Installation/Activation
	Before Installation
	Creating eID

	Installing EDIUS
	Activating EDIUS

	Uninstallation
	eID Web
	[Login]
	[News]
	[Licence List]
	[EDIUS]
	[Mync]
	[My account]

	[Log out] 
	User Registration
	User Registration



	3 Startup/Project
	Startup
	How to Start up
	[Start Project] Dialog Box

	Initial Start-up

	Exit
	Exiting Project
	Exiting EDIUS

	Creating a Project
	Creating a New Project
	Project Preset
	Project Template

	Creating New Project Presets at Initial Start-up
	Creating a New Project (Simple Settings)
	Creating a New Project Using Project Preset/Project Template
	Creating a New Project Using Existing Project as Template
	[Project Settings] (Simple Settings) Dialog Box

	Creating a New Project (Detailed Settings)
	[Project Settings] (Detailed Settings) Dialog Box
	Detailed Settings for Codec
	Configuring Audio Channel Map
	Creating Audio Channel Map Preset
	Switching Audio Channel Map Presets
	Deleting Audio Channel Map Preset
	Importing Audio Channel Map Preset (Import)
	Exporting Audio Channel Map Preset (Export)

	Creating a New Project after Start-up

	Changing the Project Setting
	Changing the Project Setting (Simple Settings)
	Changing the Project Setting (Detailed Settings)
	Sequence Settings
	[Sequence settings] Dialog Box


	Project Preset/Project Template
	Creating a Project Preset
	[Project Preset] Screen
	[Project Settings] Dialog Box (for creating new project presets)

	Simple Creation of Project Presets
	Deleting Project Presets/Project Templates
	Copying Project Presets
	Changing Project Presets
	Importing Project Presets (Import)
	Exporting Project Presets (Export)

	Saving a Project
	Overwrite Saving
	Saving in Another Name
	Saving as Project Template
	[Save As Template] Dialog Box

	Auto Save/Backup

	Importing/Exporting a Project
	Restarting a Project (At Startup)
	Restarting a Project (After Startup)
	Importing Sequence (Sequence Import)
	[Import Sequence] Dialog Box

	Consolidating Project (Consolidate Project)
	[Consolidate Project] Dialog Box
	Deleting Clips Not Used in Project from Bin

	Exporting AAF Files (AAF Export)
	[Project Exporter (AAF)] Dialog Box
	[AAF Export Detail Settings] Dialog Box

	Exporting EDL Files (EDL Export)
	Items to Be Exported
	[EDL Exporter Detailed Settings] Dialog Box
	Splitting Clips to Handle Separately

	Importing AAF Files (AAF Import)
	Importing EDL Files (EDL Import)
	[EDL Importer Detailed Settings] Dialog Box

	Importing Final Cut Pro XML Files (FCP XML Import)
	Importing P2 PLAYLIST (P2 PLAYLIST Import)
	Importing XDCAM Files (XDCAM Import)

	Field Editing a Project
	Checking Out Projects (Check-out)
	[Check Out] Dialog Box

	Editing at the Checkout Destination
	Returning Checked Out Projects (Check-in)
	[Check In] Dialog Box

	Canceling Checkout

	Restoring Offline Clips
	Restoring the Source Link
	Restoring an Offline Clip
	Re-link and Restoration
	Capturing and Restoring
	Searching File by Reel Number to Restore

	Restoring Clip That Cannot Reference Part of a Clip
	Restoring Partial Offline Clips
	Restoring Temporary Editing Clips



	4 Setting
	List of Setting Descriptions
	Relationship between Project Settings/Sequence Settings/Device Preset

	[System Settings]
	[Application]
	[Color Space]
	[Proxy]
	[Playback]
	[Capture]
	[Render]
	[Profile]
	[Project Preset]
	[Source Browser]
	[File export]
	[Check for updates]

	[Hardware]
	[Importer/Exporter]
	[AVCHD]
	[Still Image]
	[RED]
	[MPEG]
	[MXF]
	[P2]
	[Removable Media]
	[XDCAM EX]
	[XDCAM]
	[XF]
	[Mync]
	[Cinema RAW]
	[HEVC]
	[Sony RAW]
	[ProRes RAW]

	[Effects]
	[GPUfx]
	[VST Plug-in Bridge]
	[Color Correction]

	[Input Controller]
	[Fader]/[Jog Device]


	[User Settings]
	[Application]
	[Timeline]
	[Match Frame]
	[Background Job]
	[Proxy Mode]
	[Project file]
	[Other]

	[Preview]
	[Playback]
	[Monitor]
	[On Screen Display]
	[Overlay]

	[Source]
	[Duration]
	[Automatic Correction]
	[Restore Offline Clip]
	[Partial Transfer]

	[Input Controller]
	Fader/Jog Controller


	Editing Environment Management
	Switching an Editing Environment with Profile
	Registering Profiles
	Changing Profiles
	Duplicating Profiles
	Deleting Profiles
	Switching Profiles
	Importing Profiles (Import)
	Exporting Profiles (Export)

	Managing Editing Environments on the Server
	Creating a Shared Profile
	Using Shared Profiles on Local Terminals


	Setting an External Device
	Using a Device
	Capturing and Recording using a Camera or a VTR
	Capture and Monitor Output Using a Hardware
	Supported Hardware

	Registering Device Presets
	[Device Preset] Screen
	Detailed Setting of Device Preset

	Changing Device Presets
	Deleting Device Presets
	Duplicating Device Presets
	Importing Device Presets (Import)
	Exporting Device Presets (Export)
	Assigning Device Presets to Input Presets
	Setting External Device Used for Preview
	Setting Preview Devices
	Detailed Setting for Preview Device


	Placement Customization
	Changing the Screen Layout
	Registering Layouts
	Renaming Layouts
	Applying Layouts
	Deleting Layouts
	Combining Bin Window/Source Browser Window with a Palette


	Screen Customization
	Changing the Display of Operation Button
	Operation Button Settings

	Changing the Display of Preview Window
	Switching Between Single Mode/Dual Mode
	Full Screen View of Preview Window
	Rotation Display of Preview Window
	Showing/Hiding Preview Window
	Showing/Hiding Status Area
	Showing/Hiding Closed Caption
	Control Area Settings
	Switching the Screen Display when Stopping Playback
	Showing/Hiding Alpha Channel
	Displaying Preview Window in Stereoscopic Edit Mode

	Changing the Display of Bin Window
	Showing/Hiding Folder View
	Resizing Folder View/Clip View/Metadata View
	Clip View Display
	Bin Detailed Display Item Settings

	Changing the Display of Source Browser Window
	Showing/Hiding Folder View
	Resizing Folder View/Clip View/Metadata View
	Clip View Display

	Changing the Color of Operation Screens

	Shortcut Keys
	Shortcut Keys
	About Shortcut Keys
	Changing Keyboard Shortcut Assignments



	5 Importing Sources
	Capturing
	Points to Be Checked before Capturing Sources
	Registering External Devices that Interact with Device Presets
	Capture Operation Settings
	Connecting to External Devices

	Capturing and Importing Sources 
	How to Specify the Capture Range
	Capture of Stereoscopic Sources (L/R Separate Capture)
	Importing from Device Not Possible to Deck Control

	Capturing Sources All Together
	Importing Sources All Together (Batch Capture)
	Saving Batch Capture Lists
	Importing Batch Capture Lists


	Importing File
	Importing File
	Registerable File Formats
	Registering a File to the Bin as a Clip
	Registering Consecutive Still Images
	Merging Closed Caption File and Registering
	Registering Folders

	Source Browser
	Formats Supported by Source Browser
	Showing/Hiding Source Browser Window
	Source Browser Clip Display
	Selecting Clips
	Sorting Clips
	Switching the Display Folder
	Checking Clip Properties
	Searching by the Simple Search Bar

	Importing Source Browser File by Copying
	Points to Be Checked before Importing Sources
	Importing from Digital Camera
	Importing Sources from XDCAM EX Devices
	Importing P2 Sources
	Importing from XDCAM Devices
	Importing RED Sources
	Importing Cinema RAW or Cinema RAW Light Sources
	Importing Sony RAW Sources
	Importing XF Sources
	Importing Stereoscopic Sources
	Importing Clips or Other Sources Registered to Mync
	Checking the Progress of Background Jobs

	Directly Importing File with Source Browser
	Directly Registering Sources to Bin from Various Devices
	Directly Placing Sources on Timeline from Various Devices

	Transferring Only Necessary Part
	Automatic Partial Transfer at Addition to the Timeline/Registration to the Bin
	Transferring Only Necessary Parts


	Playing Back Sources
	Playing Back and Checking Source
	Playback with Player Operation Buttons
	Playing Back with Shuttle/Slider
	Playing Back with Mouse (Mouse Gesture)
	Displaying Clips on the Player

	Setting the In and Out Points on the Source
	Setting the In and Out Points
	In/Out Point Settings for Video/Audio
	Playback between In and Out Points (Loop Playback)
	Moving to In and Out Points
	Deleting the In and Out Points

	Registering Clips Displayed on the Player to the Bin
	Registering Clips on the Player to the Bin
	Registering between In and Out Points to the Bin As a Separate Clip (Subclip)



	6 Managing Sources
	Bin
	Showing/Hiding the Bin Window
	Types of Registerable Clips
	Clips
	Clip Display


	Settings of Clips
	Joining Multiple Video Clips All Together as a Single Clip
	Joining Multiple Clips (Set as Sequence)
	Canceling a Set Sequence

	Creating Color Bar/Color Matte/Title Clip
	Color Bar Clips
	Color Matte Clips
	Title Clips

	Creating Stereoscopic Clip
	Selecting a File Used in Pair to Set as a Stereoscopic Clip
	Setting Separate L and R Clips in the Bin as Stereoscopic
	Canceling Stereoscopic Clips
	Setting Stereoscopic Clips as Sequence/Cancelling Sequence
	Creating Subclips from Stereoscopic Clips
	Handling Non-Stereoscopic Clips as Stereoscopic Clips

	Creating a Clip Containing Caption Data
	Merging a Caption Clip
	Canceling Merged Caption Clip
	Using Caption Information of Clip

	Changing Clip Information and Content
	Correcting Properties
	Rename Clip
	Rename related clips
	Correcting Multiple Clip Properties
	Correcting the Settings Dialog Box
	Converting Files
	MPEG File Media Settings
	H.264 Media Settings
	Checking Clip Save Destinations
	Opening Files with Software


	Managing Clips
	Operations in the Clip View
	Selecting Clips
	Copying Clips
	Cutting Clips
	Pasting Clips
	Registering from Timeline
	Deregistering Clips
	Sorting Clips
	Color-coding Clips

	Transferring to the Project Folder
	Transferring High-resolution Data
	Operations in the Folder View
	Creating a Folder
	Moving Folders
	Duplicating Folders
	Deleting Folders
	Switching the Display Folder

	Exporting/Importing Bin Information
	Exporting Bins (Export)
	Importing Bins (Import)
	Exporting Registration Information (HTML Export)

	Searching for Clips Registered to the Bin
	Searching in the Bin
	Searching by the Simple Search Bar
	Searching Unused Clips
	Deleting Search Results



	7 Editing Operations
	Timeline Settings
	Tracks
	Track Display
	Track Header
	Track Type

	Customizing the Track Display
	Changing the Width of the Track Header
	Changing the Track Height
	Renaming Tracks

	Track Operations
	How to Set Tracks
	Selecting Tracks
	Locking Tracks
	Adding Tracks
	Duplicating Tracks
	Moving Tracks
	Deleting Tracks

	Timeline Display
	Marking the Time Scale
	Time Scale Settings
	Moving the Display Range
	Fitting to a Desired Range

	Color-coding Clips on the Timeline

	Switching the Editing Mode
	Switching Mode when Placing/Moving Clips
	Insert/Overwrite Mode
	Sync-lock (Synchronization)
	Ripple Mode

	Group/Link Mode
	Event Snap Mode
	Extend/Fix mode
	Setting the Extend/Fix Mode
	Setting Extend Mode
	Setting Fix Mode


	Placing Clips
	Setting Channel Mapping
	Connecting/Disconnecting the Source Channel
	Changing the Connection Destination of Source Channels

	Setting the In and Out Points on the Timeline
	Setting the In and Out Points on the Timeline
	Setting In and Out Points to Both Ends of Clips
	Deleting the In and Out Points on the Timeline

	Placing Clips
	Placing Clips
	Setting In/Out Points and Placing Clips
	Placing Clips between In and Out Points on the Timeline (3 Point Editing)
	Placing the In and Out Points of Clips between In and Out Points on the Timeline (4 Point Editing)
	Placing Special Clips on the Timeline

	Moving Clips
	Selecting Multiple Clips
	Moving Clips
	Moving a Selected Clip and Subsequent Clips

	Searching for Clips on the Timeline in the Bin

	Clip Operations
	Handling Only the Video Part or Audio Part of Clips Separately
	Unlinking Clips
	Link Settings

	Handling Multiple Clips as a Single Clip
	Setting Groups
	Ungrouping

	Copying/Pasting Clips
	Copying
	Cutting
	Pasting
	Pasting to the In and Out Points of Clips
	Replace
	Replace Parts

	Dividing Clips
	Dividing Clips at the Timeline Cursor Position
	Dividing Clips at the In and Out Points
	Combining Divided Clips

	Clip Enable/Disable
	Deleting Clips
	Deleting Clips/Ripples
	Deleting/Ripple Deleting between In and Out Points on the Timeline
	Deleting/Ripple Deleting Only Video/Audio Clips
	Deleting Gaps (Blanks)

	Playback Speed Adjustment
	Changing the Speed of the Whole Clip
	Partially Changing Playback Speed (Time Remap)
	One Frame at a Time Playback (Freeze Frame)
	Field Options
	High-Quality Slow Motion


	Video Layout
	Transforming/Rotating Video
	Editing Layouts
	Motion Tracking ([Layouter])
	Saving Editing Details as Presets
	Editing Layout with Preset Applied

	Changing Layouts along the Time Axis
	Setting Key Frames


	Trimming Clips
	About the Trim Mode
	Switching to the Trim Mode
	About the Trim Window

	Trimming Type
	In point trim/Out point trim
	Ripple Trim
	Split Trim
	Slide Trim
	Slip Trim
	Rolling Trim
	Trimming Transitions/Audio Cross Fades

	Trimming Operation Methods
	Trimming on the Timeline
	Trimming on the Preview Window
	Trimming by Entering the Timecode
	Trimming by Shortcut Keys


	Markers
	Setting Marker to Source
	Displaying the [Clip Marker] List
	Setting Clip Markers at Capture
	Setting Clip Markers
	Setting Clip Markers with Range
	Deleting Clip Markers
	Showing/Hiding Clip Markers

	Using Markers
	Entering Comments to Clip Markers
	Changing Color of Clip Marker
	Moving to the Clip Marker Position
	Importing Clip Marker Lists (Import)
	Exporting Clip Marker Lists (Export)

	Setting Marker to Timeline
	Displaying the [Sequence Marker] List
	Setting Sequence Markers
	Sync-Lock Setting of Sequence Marker
	Sequence Marker Types
	Setting Sequence Markers with Range
	Deleting Sequence Markers

	Using Sequence Markers
	Entering Comments to Sequence Markers
	Changing Color of Sequence Marker
	Moving to Sequence Marker Positions
	Importing Sequence Marker Lists (Import)
	Exporting Sequence Marker Lists (Export)


	Playing Back Timelines
	Playing Back Timelines
	Playing Back by Scrubbing
	Playing Back with Recorder Operation Buttons
	Playing Back with Shuttle/Slider
	Playing Back with Mouse (Mouse Gesture)
	Playing Back between In and Out Points on the Timeline (Loop Playback)
	Playing Back the Area around the Timeline Cursor

	Displaying a Desired Scene Quickly
	Jumping to In and Out Points on the Timeline
	Entering the Timecode to Jump to
	Match Frame
	Jumping from Player to Timeline
	Jumping from the Timelines to Source Clip
	Synchronizing the Player and the Timeline (Gang Mode)

	Smooth Playback
	Color Coding of Time Scale
	Rendering Overload Areas of the Entire Sequence
	Rendering Overload Areas in the Entire Project
	Rendering only Overload/Load Areas
	Rendering Overload Areas between In and Out Points
	Rendering Around the Timeline Cursor Position
	Rendering Clips/Transitions
	Manually Deleting Temporary Files
	Exporting Still Image Clips from the Timeline
	Draft Preview


	Sequences
	Creating New Sequence
	What Are Sequences?
	Creating New Sequences

	Editing Sequences
	Opening the Sequence to Edit
	Closing Sequences

	Effectively Editing Clips Using the Nest Sequence Function
	Registering Clips on the Timeline to the Bin as Sequences
	Creating Blank Timeline Sequence Clips on Tracks
	Duplicating Sequences
	Placing Sequences within Other Sequence (Nest Sequence)


	Multicam Editing
	Setting the Sync Point to Place Clips
	[Multicam Sync] Dialog Box
	Audio Sync
	Switching to the Multicam Mode
	Changing the Number of Screens
	Changing the Assigned Camera
	Setting the Multicam Display

	Setting the Camera Switch Point and Selecting the Camera
	Setting Track to be Controlled with Camera Switch Point
	Setting the Camera Switch Point
	Setting the Camera Switch Point during Playback
	Moving Camera Switch Points
	Deleting Camera Switch Points
	Switching the Selected Camera
	Multicam Editing by Shortcut Keys
	Playing Back around the Camera Switch Point

	Copying Only the Selected Clips to Track

	Proxy Editing
	Editing Using Proxy Files
	Switching to the Proxy Mode
	Creating Proxy Files

	Editing Using Camera Proxy Files
	Editing Flow by Switching Between High-resolution and Proxy Sources
	Proxy Originated Editing Flow


	3D Editing
	About the Stereoscopic Edit Mode
	Notes on Stereoscopic Editing
	Stereoscopic Edit Workflow


	Undoing Operations/Redoing Undone Operations
	Undoing Operations (Undo)
	Redoing Canceled Operations (Redo)

	Checking Color
	Checking Color Data
	[Videoscope]


	GV Job Monitor
	Starting up and Exiting GV Job Monitor
	Starting up GV Job Monitor
	Exiting GV Job Monitor

	GV Job Monitor Screen Configuration
	[Settings] Dialog Box



	8 Effect
	[Effect] Palette
	Effect
	Showing/Hiding [Effect] Palette
	Effect Types
	Properties of Effects
	How to Apply Effects
	How to Adjust Effects


	Setting Effects
	Adjusting Color/Brightness (Color Correction)
	Adjusting 3-Way Color Correction
	Adjusting the YUV Curve
	Adjusting Color Balance
	Adjusting Color Wheel
	Adjusting Monotone
	Adjusting Primary Color Correction

	Video Filter
	Audio Filter
	Camera Shake Correction
	[Stabilizer]

	Stereoscopic Adjustment
	[Stereoscopic Adjuster]

	Range-Restricted Effects/Multiple Filters
	Mask Filter
	Motion Tracking ([Mask])

	Transition
	Margin of Clip
	Clip Transition
	Track Transition
	Audio Cross Fade
	Applying Default Effects
	Changing Default Effects

	Changing Duration of Effect
	Changing Duration of Effect

	Blending
	Blend
	Key
	Key Settings
	Transparency
	[Fade In]/[Fade Out]
	Alpha Channel
	[Track Matte]

	Title Effect
	Title Mixer


	Operation for Effects
	Checking/Adjusting Effects
	Showing/Hiding [Information] Palette
	Checking/Adjusting Effects
	Enabling and Disabling Effects
	Applying Video Filters to L or R Side Only
	Deleting Effects

	Applying the Adjusted Effect to Another Clip
	Copying Effects
	Replacing Effects


	Preset
	Registering Presets
	Registering Effects to [Effect] Palette
	Deleting Effects from [Effect] Palette


	Customizing [Effect] Palette
	Creating Folder in [Effect] Palette
	Renaming Effects
	Folder Structure of [Effect] Palette
	Fixing Folder Structure
	Changing Folder Structure

	Folder Shortcuts
	Setting with Effect View
	Deleting Folder Shortcuts

	Initializing [Effect] Palette
	Import/Export
	Exporting Effects (Export)
	Importing Effects (Import)



	9 Title
	Quick Titler
	Starting up and Exiting Quick Titler
	Creating a New Title
	Exiting Quick Titler

	About the Quick Titler Screen Configuration
	About the Screen
	Showing/Hiding Bars
	Moving Bars

	Creating/Saving Title Clip
	Creating a New Title Clip
	Opening a Title Clip
	Exporting a Still Image
	Overwrite Saving
	Saving in Another Name
	Automatic Saving in Another Name

	Creating Text Object
	Entering Text
	Formatting Settings
	Creating Images
	Creating Graphics
	Creating Lines
	Importing External Files

	Text Object Operations
	Copying
	Cutting
	Pasting
	Deleting
	Resizing a Text Object
	Rotating a Text Object
	Undoing Operations/Redoing Undone Operations

	Adjusting Position of Text Object
	Moving a Text Object
	Aligning a Text Object
	Layout Settings
	Switching the Order of Text Objects
	Showing/Hiding Grid and Safe Area
	Displaying a Background

	Applying Effects to Text Object
	Color Settings
	Transparency Settings
	Pasting Texture
	Edge (Border) Settings
	Shadow Settings
	Emboss Settings
	Blur Settings
	Roll/Crawl Settings

	Registering Edited Effect
	Applying a Style
	Registering a Style
	Changing the Style Name
	Deleting a Style


	Setting Effects
	Applying a Title Mixer
	Detailed Title Settings
	[Title detail setting] Dialog Box


	Title Position Adjustment
	Layout Settings
	[Layouter] Dialog Box



	10 Audio
	Volume/Pan Adjustment
	Adjusting the Volume and Pan of a Clip
	Adding a Rubber Band Point
	Adjusting the Rubber Band
	Adjusting by Entering Values
	Setting the Pan Rubber Band to the Center
	Initializing/Deleting Rubber Band Points

	Audio Mixer
	Adjusting with the Audio Mixer
	Adjusting while Maintaining Volume Difference
	Playing/Muting a Specific Track Only

	Normalization
	Normalizing Audio Level of Multiple Clips (Normalization)
	Checking and Changing the Gain Value of Clips

	Partially Adjusting Volume
	Showing Waveforms
	Reducing Momentary Noise (V-mute Function)


	Adding and Editing Audio
	Adding Narration and Sound Effects
	Addition of Speech with Voice Over

	Playback with Shifted Audio
	Offset of Audio



	11 Export
	Exporting in File Formats
	Points to Be Checked before Exporting a File
	Marker Settings
	Export Formats
	Registering Export Settings

	Exporting with Exporter
	[Print to File] Dialog Box
	[WindowsMediaVideo] Dialog Box
	Exporting in a Format that Differs from the Project Settings
	AVI Format
	Audio Format
	QuickTime Format
	BD Format
	MP4 Format
	MPEG-2 Format
	Still Image Format
	Flash Video (F4V) Format
	AVCHD Format
	Exporting in 3DA1 Format
	XDCAM EX Format
	P2 Format
	XDCAM Format
	XAVC S Format
	XAVC Format
	AAF Format
	Exporting Closed Caption
	Exporting Stereoscopic Project

	Registering Exporter Configuration as Default Exporter
	Creating Default Exporter
	Deleting Default Exporter

	Registering Exporter Settings as Preset
	Creating Exporter Presets
	Deleting Exporter Presets
	Importing Exporter Presets (Import)
	Exporting Exporter Presets (Export)

	Exporting Multiple Sequences/Ranges Together
	Registering Ranges to Be Exported in a Batch List
	Exporting Multiple Ranges Together (Batch Export)
	Deleting Registered Ranges from the Batch List


	Exporting to Disc
	Exporting to DVD/BD
	Exporting to Disc

	Writing a Disc Image File to a Disc

	Exporting to Tape
	Exporting to VTR
	Exporting Stereoscopic Projects to Tape
	Combining L/R and Exporting to Tape
	Exporting L/R to Separate Tape



	12 Appendix
	License Management
	Serial Number Management
	Starting up GV LicenseManager
	Moving License in Online Environment
	Transferring License in Online Environment
	EDIUS System Reporter


	Edit Workflow and Various Settings
	Editing Workflow
	Editing Environment Configuration (Restricted users cannot perform this task)
	Create New Project Presets → Start up Dialog Box or System Settings
	Create New Device Presets → System Settings
	Other Editing Environment Settings → System Settings
	Create New Profile → System Settings

	Creating a New Project
	Create a New Project → Project Settings

	Importing Sources
	Capturing Sources from Cameras or Decks
	Copying File-Based Sources

	Editing Timelines
	Configure TC Presets and Channel Maps → Sequence Settings or Project Settings
	Customize Editing Environment → User Settings
	Editing Video Layouts
	Editing Effects

	Export
	Export to File → Exporter
	Export to Devices


	Project Format
	Video Signal Level Restriction
	Keyboard Shortcuts
	[Edit]
	[View]
	[Timeline]
	[Preview]
	[Preview - Player]
	[Preview - Recorder]
	[Trim]
	[Clip]
	[Clip - Delete]
	[Clip - Select]
	[Track]
	[Marker]
	[Mode]
	[Mode - Multicam]
	[Capture]
	[Render]

	Effects List
	[VideoFilters]
	[Color Correction]
	[Anti Flicker]
	[Emboss]
	[Old Movie/Film]
	[Chrominance]
	[Sharpness]
	[Stabilizer]
	[Strobe/Freeze]
	[Soft Focus]
	[Select channel]
	[Tunnel Vision]
	[Video Noise]
	[Blur]
	[Blend Filters]
	[Mask]
	[Matrix]
	[Mirror]
	[Median]
	[Mosaic]
	[Motion Blur]
	[Raster Wipe]
	[Loop Slide]
	[Block Color]
	[Pencil Sketch]
	[Stereoscopic Adjuster]
	[Smooth Blur]
	[Combine Filters]
	[Gaussian Blur]
	[Transform]

	[AudioFilters]
	[Graphic Equalizer]
	[Delay]
	[Tone Controller]
	[High-pass Filter]
	[Parametric Equalizer]
	[Panpot  Balance]
	[Pitch Shifter]
	[Low-pass Filter]

	[Transitions]
	[2D]
	[3D]
	[GPU]
	[SMPTE]
	[Alpha]

	[AudioCrossFades]
	[Cut out/in]
	[Cut out/Spline in]
	[Cut out/Linear in]
	[Spline out/Cut in]
	[Spline out/in]
	[Linear out/Cut in]
	[Linear out/in]

	[TitleMixers]
	[Slide A]
	[Slide B]
	[Soft Slide]
	[Soft Wipe]
	[Fade Slide A]
	[Fade Slide B]
	[Laser]
	[Wipe]
	[Wipe Vertical]
	[Wipe Horizontal]
	[Fade]
	[Blur]

	[Keyers]
	[Blend]
	[Chromakey]
	[Track Matte]
	[Luminancekey]


	Grass Valley Product Support
	Web Technical Support
	Phone Support
	Authorized Support Representative
	Our Website




